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Preface

 Changes in Ver.1.10.5
The following features have been added or changed in Clip Studio Paint Ver.1.10.5.

Changes to Clip Studio Paint Debut, PRO, and EX

Menu
 "New"

[Record timelapse] has been added to the bottom of the [New] dialog in [File] menu > [New]. When turned on, you can record a timelapse.

 Timelapse

[Timelapse] has been added to the [File] menu. You can now create a recording of your production process. For details, see Clip Studio 

TIPS.

 "Export webtoon*"

[Export webtoon] has been added to the [File] menu. You can divide the canvas into specific sizes and export them as .jpg or .png files.

 "On-screen area (webtoon)*"

[On-screen area (webtoon)] has been added to the [View] menu. The visible areas of the webtoon when viewed on smartphones will be 

highlighted on the canvas.

 "On-screen area settings (webtoon)*"

[On-screen area settings (webtoon)] has been added to the [View] menu. You can set the aspect ratio of the webtoon on-screen area set-

tings.

Changes made to Clip Studio Paint PRO/EX

Menu
 "New">"New dialog box (Webtoon) [PRO/EX]*"

[Webtoon] has been added to [Use of work] in the [New] dialog in [File] menu > [New]. You can optimize your settings for vertical scroll-

ing content such as webtoons.

With EX, you can split your Webtoon into multiple pages and edit each page separately.

 "Canvas Properties [PRO/EX]"

[Record timelapse] has been added to the [Canvas Properties] dialog in [Edit] > [Canvas Properties]. When turned on, you can record a 

timelapse.

Tool Palettes
 "Sub tool palette">"Sub tool Palette Menu"

[Import sub tool] now supports Photoshop brush files (extension: .abr).

New functions to Clip Studio Paint in Ver.1.10.5 are marked with a * in the text.
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Changes in Clip Studio Paint EX

Menu
 "New">"New dialog box (Show all comic settings) [PRO/EX]"

[View] has been added to the [New] dialog. You can set the page display to [Page-by-page] or [Webtoon]. Settings will change according 

to the selected view.

 "Export multiple pages [EX]">".pdf(PDF format)"

 You can now export PDF files on Windows / macOS.

 When exporting a PDF file, you can now select [Split spread pages] in the [Batch export] dialog. Spread You can also export without 

splitting the page.

 "Import">"Batch import [EX]"

[View] has been added to the [Create story folder] dialog. You can set the page display to [Page-by-page] or [Webtoon]. Settings will 

change according to the selected view.

 "Change basic page settings"

[Record timelapse] has been added to the [Change basic page settings] dialog in [Story] > [Change basic page settings]. When turned on, 

you can record a timelapse.

 "Change basic work settings"

[Record timelapse] has been added to the [Change basic work settings] dialog in [Story] > [Change basic work settings]. When turned on, 

you can record a timelapse.

 "Change basic work settings">"Change basic work settings Dialog Box (Webtoon)*"

[Webtoon] has been added to [Use of work] in the [Change basic work settings] dialog in [Story] menu >  [Change basic work settings]. 

You can optimize your settings for vertical scrolling content such as webtoons.

 "Change basic work settings">"Change basic work settings Dialog Box (Show all comic settings)"

[View] has been added to the [Change basic work settings] dialog in [Story] > [Change basic work settings]. You can set the page display 

to [Page-by-page] or [Webtoon]. Settings will change according to the selected view.

 "Page Manager Layout [Windows/macOS/Tablet]">"Auto-scroll*"

[Auto-scroll] has been added to the [Story] menu > [Page Manager Layout]. You can also set whether or not the [Story] window scrolls 

along with your current canvas.

 "View*">"Page-by-page"/"Webtoon"

[View] has been added to the [Story] menu. You can toggle the [Story] window display setting between [Page-by-page] and [Webtoon].

 "Webtoon reading direction*"

[Webtoon reading direction] has been added to the [Story] menu. In the [Story] window, you can select [Left-to-right] or [Right-to-left] as 

the webtoon reading direction.
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 Differences in Functionality between EX and PRO
With Clip Studio Paint EX, you can use the functions below in addition to all of the functions available in Clip Studio
Paint PRO.

Menu
 "New"

 Allows you to configure the number of pages, story information, binding point and start page for a manga or comic file.

 You can set story information when [Animation] is selected from [Use of work].

 "Open"

Allows you to import ComicStudio book files (extension: cst) and CLIP STUDIO name files (extension: csnf).

 "Export (Single Layer)"

[Output range] can be configured in the [Export] dialog box.

 "Export multiple pages [EX]"

 Works created in Clip Studio Paint can be exported in Kindle format. Exported files from Clip Studio can be published for Kindle.

 This allows you to export works from Clip Studio Paint as EPUB data. Saved files can be published as e-books. You can optimize 

data for kindle when exporting EPUB data.

 Works created as a fanzine can be output to a printing vendor for printing. The 3D Preview for Binding can also be used to check 

what the created work will look like when bound.

 [Output range] can be configured in the [Export] dialog box.

 "Export animation">"Export animation cels [EX]"

Allows you to export individual cels in general image format.

 "Export animation">"Exposure sheet [EX]"

You can export exposure sheets in CSV format or digital exposure sheet information format (extension: xdts).

 "Export animation">"OpenToonz Scene File [Windows/macOS] [EX]"

Cels and timelines created in Clip Studio Paint can be exported for OpenToonz.

 "Import">"Batch import [EX]"

Allows you to specify multiple image files and import them to each page file as a layer.

 "Import">"Continuous Scan [Windows/macOS] [EX]"

Allows you to use a commercial scanner to scan images continuously and import them to each page file as layers.

 "Import">"Exposure sheet [EX]"

You can import digital exposure sheet information format files (extension: xdts) to Clip Studio Paint.

 "Batch process [EX]"

Allows you to run menu commands/auto actions for a specified page file in one go.

 "Print Settings [Windows/macOS]"

 Supports dual page printing and two-page spread printing.

 [Output range] can be configured in the [Print Settings] dialog box.

 "Print [Windows/macOS]"

Supports multi-page printing.

For details on Clip Studio Paint EX, see “Clip Studio.net.”
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 "Preferences [Windows]">"Edit text [EX]"

You can configure settings relating to the story editor in the [Preferences] dialog.

 "Remove tone (Technology preview) [EX]"

The tones of the selected layer can be removed or converted to grayscale.

 "Story Menu [EX]"

The [Story] menu allows you to manage comic or manga files made of multiple pages. You can manage how to display a page file, add 

pages, manage the manga or comic story information, and so on. You can also display the [Page Management] window.

For how to operate the [Page Management] window, also see "Explanation: Page Management [EX]".

 "Timeline">"Change frame rate"

When changing the frame rate (number of frames per second) from the frame rate that was set up when creating the canvas, you can 

change the total number of frames without changing the playback time of the animation.

 "Timeline">"Apply Toei Animation Digital Exposure Sheet information to current exposure sheet [EX] [Windows/iPad]"

You can open the Toei Animation Digital Exposure Sheet and use the vertical exposure sheet to edit the contents of the [Timeline] palette. 

In the Toei Animation Digital Exposure Sheet, you can edit the total number of frames, the timing of cels being displayed, and the camera 

instructions.

 "Timeline">"Load changes to Toei Animation Digital Exposure Sheet [EX] [Windows]"

Changes made to the Toei Animation Digital Exposure Sheet can be loaded into Clip Studio Paint.

 "LT conversion of layer [EX]"

Allows you to separate color images and 3D layers into outlines (line drawings) and tones and convert each of them into different layers. It 

allows you to obtain manga-like expressions with tone gradient.

Layer Property Palette
 "Extract line [EX]"

Allows you to extract outlines from a selected layer. Furthermore, clicking [Execution of LT conversion of layer] allows you to separate a 

selected layer into outlines (line drawings) and tones and convert each of them into different layers while keeping [Extract line] settings.

Timeline palette
 "Functions of Timeline Palette"

You can set a value before 0 for [Start frame]. You can also set a value after 24 for [End frame].

All Sides View Palette
 "All Sides View Palette [EX]"

You can now use the [All Sides View] palette when editing a 3D layer. When a 3D layer is selected, it is possible to view a 3D material 

from four directions at the same time. When placing a 3D material, it is possible to adjust the position of the camera and focal point, as 

well as the position the of the 3D material.
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 Differences in Functionality between DEBUT and EX/
PRO

There are some functions that are not available in Clip Studio Paint DEBUT. Clicking the icon on the [Command Bar] opens the Web browser 

showing an introduction to the Clip Studio Paint PRO functions, where you can check about functions not available in Clip Studio Paint 

DEBUT.

Upgrading to CLIP STUDIO PAINT PRO/EX will enable you to add functions useful for drawing illustrations and manga.For details on how 

to upgrade to CLIP STUDIO PAINT PRO/EX, see "CLIP STUDIO.NET".

 Initial Configuration of Tools
This update contains changes to the initial tool configuration. If you are using a previous version of Clip Studio Paint,
the tool configuration in your version may differ from this manual. If you cannot find a tool, see the table below.

Previous Configuration Current Configuration

Contour line paint "Gradient Tool" > "Contour line paint"

[Figure] tool > [Frame Border] "Frame border tool [PRO/EX]"

[Figure] tool > [Create ruler] "Ruler tool [PRO/EX]"

[Text] tool > [Text] > [Ellipse balloon] "Balloon Tool [PRO/EX]" > "Create balloon"

[Text] tool > [Text] > [Curve balloon] "Balloon Tool [PRO/EX]" > "Create balloon"

[Text] tool > [Text] > [Balloon pen] "Balloon Tool [PRO/EX]" > "Create balloon"

[Text] tool > [Text] > [Balloon tail] "Balloon Tool [PRO/EX]" > "Create balloon"

[Text] tool > [Text] > [Thought balloon tail] "Balloon Tool [PRO/EX]" > "Create balloon"

[Text] tool > [Flash] "Balloon Tool [PRO/EX]" > "Flash"

[Brush] tool > [Oil paint] "Brush Tool" > "Thick paint"

[Blend] tool > [Soothing watercolor] "Brush Tool" > "Watercolor" > "Soothing watercolor"

[Blend] tool > [Running color on fiber] "Brush Tool" > "Watercolor" > "Soothing watercolor"
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Introduction

 Before You Read This Guide
Thank you for choosing Clip Studio Paint. The following describes points to keep in mind when reading this guide.

Regarding This Guide
This guide is a manual that aims to introduce users to the features of Clip Studio Paint. It describes functions of the menu, palettes, tools, and so 

on.

For details on the [Tool Property] palette, including the [Sub Tool Detail] palette, refer to the CLIP STUDIO PAINT Tool Setting Guide.

Notations in This Guide
This guide (including data) has been prepared and edited based on the product program available as of December 2020 and may differ from the 

actual product program specifications.

Signs
This guide uses signs to indicate explanations related to operations. The signs have the following meanings.

References
References to other parts of this guide as well as other documents are indicated by using "" (double quotation marks).

About OS notation
Clip Studio Paint operation may differ depending on your device. In such case, it will be written as follows.

If a function differs depending on the OS or device, the OS or product will be mentioned. Clip Studio Paint for Galaxy is included in Android 

devices.

Indicates items that may be easily mistaken or matters to be aware of when using Clip Studio Paint.

Indicates tips and supplementary information useful when using Clip Studio Paint.

Windows Computers running Windows are referred to as Windows. This also applies to tablet PCs equipped with Windows.

macOS Computers running macOS are referred to as macOS.

Tablet
iPad devices / Android tablets / Chromebooks are referred to as tablets. Clip Studio Paint for Galaxy applies here 

as well.

Smartphones
iPhone devices and Android smartphones are referred to as smartphones. Clip Studio Paint for Galaxy (smart-

phone version) applies here as well.
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About Operations Described in This Guide
Operations in this guide are described based on the Windows version unless otherwise noted.

For other operating systems, please read as follows. By doing so, all operations will have the same meaning across all operating systems.

About the product grade
Clip Studio Paint is available in three editions: DEBUT, PRO, and EX. This guide describes the operating procedure of all three editions. Func-

tions restricted to an edition are marked with a symbol indicating the edition.

Resetting to original installation settings
In the case a problem occurs while working with Clip Studio Paint, you can reset it to the original installation settings.

When using Windows/macOS
Launch Clip Studio, then click [PAINT] while holding down the Shift key to display the screen where you can select items to reset to the origi-

nal installation settings. By selecting items and clicking [OK], the selected items' settings will be deleted and reverted to their initial state.

When using an iPad/iPhone
Tap the OS's [Settings] > [Clip Studio], and turn [Initialization start-up] on. A prompt to select which items to reset will appear the next time 

you launch Clip Studio Paint. By selecting items and clicking [OK], the selected items' settings will be deleted and reverted to their initial state.

When using Android/Chromebook
Press and hold the Clip Studio icon from the home screen. When the menu is displayed, tap [Reset to original defaults]. A prompt to select 

which items to reset will appear the next time you launch Clip Studio Paint. By selecting items and clicking [OK], the selected items' settings 

will be deleted and reverted to their initial state.

 On tablets and smartphones, the edge keyboard is available for key commands. For details on how to use the 

edge keyboard, see "Using the edge keyboard"

 For shortcut keys on tablets and smartphones, please connect a keyboard.

Windows macOS iPad/iPhone
Galaxy/Android/Chrome-

book

The Alt key The [Option] key The [Option] key The Alt key

The Ctrl key The Command key The Command key The Ctrl key

The Enter key The [Return] key The [Return] key The Enter key

The Backspace key The Delete key The Delete key The Backspace key

Right click (mouse button)
Mouse click while holding 

down Control

 Tap while pressing the 

Ctrl key

 Long press with finger.

Long press with finger.

Unmarked Indicates a function available in Clip Studio Paint DEBUT, PRO and EX.

[DEBUT] Indicates a function available only in Clip Studio Paint DEBUT.

[PRO] Indicates a function available only in Clip Studio Paint PRO.

[EX] Indicates a function available only in Clip Studio Paint EX.
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Trademarks and Copyrights
 CELSYS, CLIP STUDIO, CLIP, QUMARION, IllustStudio and Comic Studio are trademarks or registered trademarks of CELSYS, Inc.

 Microsoft, Windows, and Surface are trademarks or registered trademarks of the Microsoft Corporation in the United States and other 

countries.

 Mac, macOS, iPad and iPhone are trademarks or registered trademarks of Apple Inc. in the United States and other countries. The iPhone 

trademark is used under license from AIPHONE CO., LTD.

 iOS is a trademark or registered trademark of Cisco System Inc. in the United States and other countries and is used under license.

 Google, Android, Chrome, Chrome OS, and Chromebook are trademarks or registered trademarks of Google LLC.

 Galaxy is the trademark or registered trademark of Samsung Electronics Co.,Ltd.

 Wacom is a registered trademark of Wacom Co., Ltd.

 QUMA is a registered trademark of SoftEther Corporation.

 Adobe, the Adobe logo, Adobe Reader and Photoshop are trademarks of Adobe Systems Incorporated in the United States and other coun-

tries.

 Amazon, Kindle, Kindle Direct Publishing and the Kindle Direct Publishing logo are trademarks of Amazon.com, Inc. and affiliated com-

panies.LINE is the trademark or registered trademark of Line Corporation.

 All other company names and product names described herein are trademarks or registered trademarks of their respective holders.

 No part of this guide (including data) may be reproduced or copied in any form or by any means without permission from the copyright 

holder, except when so required by law.

About AI features
When using the following features, the image data is uploaded to an AI server that interprets the data and processes the image.

Data is managed in the following way when using AI features.

 When using these features, personal information such as the product serial number or Clip Studio account will not be uploaded to the 

server.

 After the process is complete, the uploaded data and the generated data are completely deleted from the server, and Celsys does not retain 

any such data.

 Celsys temporarily retains the User data and resulting data until the function's process is complete and the data is deleted. During this 

period, all intellectual rights to the data is retained by the user. The image data is not released outside of Celsys.

Pose Scanner

 "Pose Scanner (image) (Technology preview)"

 "Pose Scanner (camera) [Tablet/Smartphone]"

 "Pose Scanner (photo library/storage) [Tablet/Smartphone]"

Remove tones
 "Delete tones from selected layer"

 "Change tones to grayscale"

Colorize

 "Colorize all"

 "Use hint image and colorize"

 "Use more advanced settings"
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Introduction

 Drawing Illustrations with Clip Studio Paint
The following is an introduction to the functions used for drawing a simple color illustration with Clip Studio Paint.

 To create a new canvas (file) → "New"

 To select a tool → "Tool Palette"

 To draw with pencil touch > "Pencil Tool"

 To erase a drawn line → "Eraser Tool"

 To create a new layer → "New Raster Layer"

Create a new layer for inking.

 To select a layer → "Select the layer"

 To draw with pen touch → "Pen Tool"

 To adjust pen thickness → "Tool property Palette"

 When taking a break on an ongoing illustration, be sure to save it. If you quit without saving, the illustration on 

the canvas will be lost. To save the file, select [File] menu > [Save].

 You can change the canvas view to make drawing easier. To change the canvas scale, see "Zoom Tool". To 

zoom in/out the canvas or change its display position, see "Move Tool".

The [Eraser] tool can also erase lines drawn with the [Pen] tool, etc. Furthermore, by selecting [Edit] menu > 

[Undo], you can cancel the last operation.

Pencilling
Draw a draft to have an overall image of the illustration.

Inking
Ink over based on the draft. This step is called inking.

Create a layer for inking, and create the line drawing.
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 To hide a layer → "Switching Show/Hide for a Layer"

Hide the draft layer to make coloring easier.

 To create a new layer → "New Raster Layer"

 To select a layer → "Select the layer"

 To select a color → "Color Wheel Palette"/"Color Set Palette"

To select a color, you can use the [Color Wheel] palette or the [Color Set] palette.

 To fill a closed area → "Fill Tool"

 Creating a fill in monochrome layer and filling it allows you to change colors easily. For details, see "Fill [PRO/EX]".

 Creating a gradient layer allows you to add a gradient effect to an illustration. For details, see "Gradient layer [PRO/EX]".

 To create a new layer → "New Raster Layer"

Creates a new layer to add shadows and highlights.

 To select a layer → "Select the layer"

 To change the stacking order of a layer → "Changing the Stacking Order of a Layer"

The stacking order of a layer can be changed with the [Layer] palette. Shadows and highlights must be placed above the colored layers 

while backgrounds must be placed below the colored layers.

To fill other layers while keeping the line drawing layer, select [All layers] for [Refer multiple] on the [Tool Prop-

erty] palette and select the [Fill] tool.

If the drawn content is not shown on the canvas, move the layer upwards. Changing the order in which layers are 

stacked may solve the problem.

Coloring
Paint the illustration.

As with inking, create a new layer for coloring.

Finishing and Saving
Add shadow and highlight to add depth to the illustration.

Finally, paint the background. Save the data when the illustration  

 is complete.
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 To select a color → "Color Wheel Palette"/"Color Set Palette"

Select the color for shadows and highlights from the [Color Wheel] and [Color Set] palettes.

 To draw highlights and shadows → "Pen Tool"/"Airbrush Tool"

Using the [Airbrush] tool allows you to add Although a blur effect.

 To paint the background → "Fill Tool"

 To tone a layer → "Layer Property Palette [PRO/EX]"

You can tone a layer using [Toning] on the [Layer Property] palette.

 To save a file → "Save"

 To open a previously saved file → "Open"
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 Drawing Comics with Clip Studio Paint
The following is an introduction to functions used for drawing a simple color comic with Clip Studio Paint.

 To create a new canvas (file) → "New"

 To select a tool → "Tool Palette"

 To draw with pencil touch > "Pencil Tool"

 To erase a drawn line → "Eraser Tool"

 To create balloons and input text → "Explanation: Balloons and Text"

 Pages can be added to or deleted from a manga file. To adjust the number of pages, see "Add Page" / "Delete Page". [EX]

 Changing [Unit of length] to "mm" for [Ruler/Unit] > [Unit] in the Preferences dialog box will enable you to con-

figure the canvas as if you were configuring an original piece of paper for print. For details, see "Preferences 

[Windows]" > "Ruler/Unit".

 Be sure to save your work when taking a break from it. If you quit without saving, the manga drawn on the can-

vas will be lost. To save the file, select [File] menu > [Save].

 You can change the canvas view to make drawing easier. For details on how to change the canvas' scale, see 

"Zoom Tool". For details on zooming in/out of the canvas or changing its display position, see "Move Tool".

 The manga file allows for 2-page spreads. For how to create two-page spreads, see "Combine Pages". [EX]

Paneling
Decide the layout of the panels; that is, the blueprint of the manga.

Roughly draw the storyline and place balloons and words.
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 To lay out panels → "Explanation: Comic Frame Division [PRO/EX]"

 To create a new layer → "New Raster Layer"

Create a new layer for pencilling.

 To select a layer → "Select the layer"

 To draw with pencil touch → "Pencil Tool"

 To adjust the line thickness → "Tool property Palette"

 To hide a layer → "Switching Show/Hide for a Layer"

Hide the draft layer to make coloring easier.

 To create a new layer → "New Raster Layer"

 To select a layer → "Select the layer"

 To draw with pen touch → "Pen Tool"

 To rotate the canvas and draw a line → "Move Tool"

 To change the shape and size of a balloon → "Explanation: Balloons and Text"

Even if you draw on a layer whose expression color is monochrome or gray, you can replace black with any color 

by using the [Layer color] function. This is useful to reduce the load on your computer. Layer color is configured 

in the [Layer Property] palette. For details, see "Functions of Layer Property Palette".

Frame Cut and Pencilling
Cut frames based on the paneling to draw the draft.

Create a draft layer and draw the draft.

Inking
Ink over based on the draft. This step is called inking.

Create a layer for inking, and create the line drawing.
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 To hide a layer → "Switching Show/Hide for a Layer"

 To create a new layer → "New Raster Layer"

 To select a layer → "Select the layer"

 To create a selection → "Marquee Tool"/"Auto select Tool"

 To create a fill in monochrome layer → "Fill [PRO/EX]"

Create fill in monochrome layers in areas where you want to stack mesh tone or fill in one color.

 To create a gradient layer → "Gradient layer [PRO/EX]"

 To tone a layer → "Layer Property Palette [PRO/EX]"

Turning on [Tone] on the [Layer Property] palette adds tone to a layer.

 Changing [Unit of length] to "mm" for [Ruler/Unit] > [Unit] in the Preferences dialog box will enable you to con-

figure the canvas as if you were configuring an original piece of paper for print. For details, see "Preferences 

[Windows]" > "Ruler/Unit".

 Be sure to save your work when taking a break from it. If you quit without saving, the manga drawn on the can-

vas will be lost. To save the file, select [File] menu > [Save].

 You can change the canvas view to make drawing easier. For details on how to change the canvas' scale, see 

"Zoom Tool". For details on zooming in/out of the canvas or changing its display position, see "Move Tool".

Filling and Toning
Fill in one color and add tone.

Create fill in monochrome layers.

Paint areas to be toned.

Create gradient layers for areas where gradation effect will be added.
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 To create a new layer → "New Raster Layer"

 To select a layer → "Select the layer"

 To change the layer stacking order → "Changing the Stacking Order of a Layer"

 To use a ruler → "Explanation: Ruler [PRO/EX]"

With rulers, you can draw complicated effect lines easily.

Finishing and Saving
Add effect, highlighting and sound effects to finish the manga.

Save the data when the manga is complete.
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 Drawing Animated Illustrations with Clip Studio 
Paint

The following is an introduction to functions used for drawing a simple animated illustration with Clip Studio Paint.

Prepare to create a moving illustration
Before creating a moving illustration, create a new file and decide on the cel (layer) structure.

 To create a new canvas (file) → "New" >"New dialog box (Illustration) [PRO/EX]", "New Dialog Box [DEBUT]"

 To overlap cels → "New animation layer"

 To create a cel → "New animation cel"

 To create cels using layers for specific purposes → "New Layer"

 To organize cels and animation folders → "New Layer Folder"/"Create folder and insert layer"

Draw on the cels
For information on how to draw cels, see "Drawing Illustrations with Clip Studio Paint" & "Drawing Comics with Clip Studio Paint".

 To draw cels → "Pencil Tool"/"Pen Tool"/"Eraser Tool"

 To color cels → "Fill Tool"

 To refer to other cels when drawing → "Animation Cels palette"

 To change the angle or position of reference cels →"Light Table Layer Operation" >"Using the light table tool"

 To show the previous or next cel → "Enable onion skin"

You can configure various settings in "New dialog box (Animation) [PRO/EX]" to create a full animation. You can 

also set [Story Information] in EX. EX also allows you to create long animations over 24 frames long.

Animation folders are folders for managing animation cels. Layers and layer folders in an animation folder are 

treated as cels creating the movement of the animation. For details, see "Explanation: Animation folders and 

cels".

 Layer folders are convenient when creating layers for each process of each cel, such as the draft, inking and 

coloring. Each layer folder created in an animation folder is treated as one cel.

 If you want to roughly divide processes such as layout, drafts and creation of the video, create an animation 

folder for each process in a layer folder.

If you cannot draw on a cel, check if it is specified in the [Timeline] palette.

Cels cannot be drawn or edited if they are not specified. Specify the cels in the [Timeline] palette.

For details on how to specify cels, see "Cel specification operations" > "Specify the cel".
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Check movement
Check the movement of drawn cels and adjust it via the [Timeline] palette.

 To check a moving illustration → "Play/Stop"

 To check the movement of an animation using the mouse → "Operating the timeline editing tools"

 To change the allocation of cels → "Change the cel specification position"

 To change the cel numbers → "Specify other cels"

 To delete unneeded cels → "Delete the cel specification"

Export to a file
Export the moving illustration.

 To save a file → "Save"

 To export as an image sequence → "Image sequence"

 To export as an animated GIF → "Animated GIF"

 To export as a movie file → "Movie"
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Menu
This chapter introduces the menu functions in Clip Studio Paint.

 CLIP STUDIO PAINT Menu [macOS/Tablet]

 App Settings menu [smartphone]

 File Menu

 Edit Menu

 Story Menu [EX]

 Animation menu

 Layer Menu

 Select Menu

 View Menu

 Filter Menu

 Window Menu [Windows/macOS/Tablet]

 Help Menu
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Menus

 CLIP STUDIO PAINT Menu [macOS/Tablet]
When using the Tablet version of Clip Studio Paint, click the Clip Studio Paint icon to show the [CLIP STUDIO PAINT]
menu.

About Clip Studio Paint [macOS/Tablet]
Displays the product information of your Clip Studio Paint. There, you can check information such as the version of your Clip Studio Paint.

Version information [macOS/Tablet]
Displays Clip Studio Paint's version information and license details.

Preferences [macOS/Tablet]
Opens the [Preferences] dialog box. Here you can adjust Clip Studio Paint settings for layers, tools, performance, and more.

Preferences can be set on macOS and Tablet in the same way as for Windows, except for a few items. For details on how to set preferences, see 

"Preferences [Windows]".

Shortcut Settings  [macOS/Tablet]
Shortcuts can be set for menu items, tools, and brush sizes. Settings can be set on macOS and Tablet in the same way as for Windows. For 

details on how to set shortcuts, see "Shortcut settings dialog box".

Modifier Key Settings [macOS/Tablet] [PRO/EX]
You can use modifier keys to quickly switch tools, change your brush size, and more. The Command, Option, Shift, and Space keys, the mouse 

wheel, right click, and tail switch can be assigned to tools individually or in combination.

When using a Tablet, you can also assign operations to gestures such as single swipes and long presses.

Settings can be set on macOS and Tablet in the same way as for Windows. For details on how to assign modifier keys, see "Modifier key set-

tings [Windows] [PRO/EX]".

Command Bar Settings [macOS/Tablet] [PRO/EX]
You can customize the Command Bar by adding or removing commands.

Settings can be set on macOS and Tablet in the same way as for Windows. For details on customizing the Command Bar, see "Command bar 

settings [Windows] [PRO/EX]".

Tab-Mate Controller [macOS]
Assigns Clip Studio Paint operations to the Tab-Mate Controller. Furthermore, it assigns commands to the Tab-Mate Controller [Quick Menu].

Settings can be set on macOS in the same way as for Windows. For details on assigning operations to the Tab-Mate Controller, see "Tab-Mate 

Controller [Windows]".

CLIP STUDIO TABMATE [macOS/Android/Chromebook]
Assigns Clip Studio Paint operations to the Clip Studio TABMATE. You can also set up tool rotations with the Clip Studio Tabmate so you can 

switch between tools or functions by pressing a button.

Settings can be set on macOS, Android and Chromebook in the same way as for Windows. For details, see "CLIP STUDIO TABMATE [Win-

dows]".
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Pen Pressure Settings [macOS/Tablet]
Adjusts the pen pressure sensitivity when using a tablet.

Settings can be set on macOS and Tablet in the same way as for Windows. For details, see "Pen Pressure Settings [Windows]".

Wacom stylus [iPad]
You can use a iPad-compatible Wacom stylus pen.

Enable Wacom stylus settings
Connect or disconnect a Wacom stylus pen.

Wacom Stylus Settings
Sets your dominant hand and hand position.

When the [Wacom Stylus Settings] dialog box opens, select your dominant hand and hand position when using your Wacom stylus pen.

QUMARION [macOS] 
Set up a QUMARION device to use with Clip Studio Paint, and import or export calibration data.

Settings can be set on macOS in the same way as for Windows. For details, see "QUMARION [Windows]".

Open CLIP STUDIO [macOS/Tablet]
The companion application CLIP STUDIO will appear. When using a Tablet, the CLIP STUDIO dialog box will appear. Clip Studio is a tool 

and service that aims to support creative activities.

Quit CLIP STUDIO PAINT [macOS]
Closes Clip Studio Paint.

For more information on connecting your Wacom stylus, please refer to its instruction manual.

Macs with Apple M1 chips do not support the QUMALION.
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 App Settings menu [smartphone]
This section describes the functions of the [App Settings] menu. Tap [Menu] > [App Settings] to display the menu.

Preferences
Select the [App Settings] menu > [Preferences] dialog box to display the [Preferences] dialog box.

Here you can adjust Clip Studio Paint settings for layers, tools, performance, and more. Settings are switched from the above pull-down menu.

Setting can be set in the same way as for Windows, except for a few items. For details on customizing the Command Bar, see "Preferences".

Command Bar Settings
Tap [Menu], then select the App Settings] menu > [Command Bar Settings] to set items displayed on the Command Bar. For details on custom-

izing the Command Bar, see "Command Bar Settings".

Palette Bar Settings
Tap [Menu], then select the [App Settings] menu > [Palette Bar Settings] to set items displayed on the Palette Bar. For details on customizing 

the Command Bar, see "Palette Bar Settings".

Edit Bar Settings
Tap [Menu], then select the [App Settings] menu > [Edit Bar Settings] to set items displayed on the Edit Bar. For details on customizing the 

Command Bar, see "Edit Bar Settings".

Layout Settings
Tap [Menu], then select the [App Settings] menu > [Layout Settings] to allocate bars and buttons on the CLIP STUDIO PAINT screen. For 

details on customizing the Command Bar, see "Layout Settings".
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Shortcut Settings
Tap [Menu], then select the [App Settings] menu > [Shortcut Settings] to set shortcuts for menu items, tools and brush sizes. Settings can be set 

on macOS and Tablet in the same way as for Windows. For details on how to use, see "Shortcut settings dialog box".

Modifier Key Settings
Tap [Menu] and select [App Settings] menu > [Modifier Key Settings]. Here, you can assign operations such as switching tools and changing 

brush size to Modifier keys or Modifier key combinations. Modifier keys include the [Command], [Option], [Shift], and [Space] keys. If you 

are using a Smartphone, you can also assign operations to single swipes and long presses. Settings can be set on macOS and Tablet in the same 

way as for Windows. For details on customizing the Command Bar, see "Modifier key settings [Windows] [PRO/EX]".

CLIP STUDIO TABMATE [Android]
Assigns Clip Studio Paint operations to the Clip Studio TABMATE. You can also set up tool rotations with the Clip Studio Tabmate so you can 

switch between tools or functions by pressing a button.

Settings can be set on Android in the same way as for Windows. For details, see "CLIP STUDIO TABMATE [Windows]".

Pen Pressure Settings
Tap [Menu], then select the [App Settings] menu > [Pen Pressure Settings] to adjust pen pressure sensitivity.

For details on customizing the Command Bar, see "Adjust pen pressure settings".

Wacom stylus [iPhone]
You can use an iPhone-compatible Wacom stylus.

Enable Wacom stylus settings
Tap [Menu], then select the [App Settings] menu > [Wacom Stylus] > [Enable Wacom stylus settings] to connect or disconnect a Wacom stylus.

Wacom Stylus Settings
Tap [Menu], then select [App Settings] menu > [Wacom Stylus] > [Wacom Stylus Settings] to set dominant hand and position when using a 

Wacom stylus.

When the [Wacom Stylus Settings] dialog box opens, select your dominant hand and hand position when using your Wacom stylus pen.

Open CLIP STUDIO
Tap [Menu], then select the [App Settings] menu > [Open CLIP STUDIO] to display the [CLIP STUDIO] dialog box. Clip Studio is a tool and 

service that aims to support creative activities.

Version information
Tap [Menu], then select the [App Settings] menu > [Version information] to display the screen for checking the CLIP STUDIO PAINT version.

For more information on connecting your Wacom stylus, please refer to its instruction manual.
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Menus > File Menu > New
 File Menu
The [File] menu contains file input/output operations. This section describes the commands in the [File] menu.

New
Opens the [New] dialog box.

Here you can set up new canvases and page files for creating illustrations, comics, or animations.

Select an option in [Use of work] to display settings for each type of project.

Illustration [PRO/EX]

Displays settings for creating an illustration project. This includes settings for moving illustra-

tions in addition to standard illustrations. For information on each setting, see "New dialog 

box (Illustration) [PRO/EX]".

Webtoon [PRO/EX]*
Displays settings for creating a webtoon. For information on each setting, see "New dialog 

box (Webtoon) [PRO/EX]*".

Comic [PRO/EX]
Displays settings for creating a comic or manga project. For information on each setting, see 

"New dialog box (Comic) [PRO/EX]".

Printing of fanzine[EX]
Displays settings for creating fanzine printing data. For information on each setting, see "New 

dialog box (Printing of fanzine) [EX]".

Show all comic settings [PRO/EX]
Displays all settings for new illustration and comic projects. For information on each setting, 

see "New dialog box (Show all comic settings) [PRO/EX]".

Animation [PRO/EX]
Displays settings for creating an animation. For information on each setting, see "New dialog 

box (Animation) [PRO/EX]".

The [Use of work] option is not available in DEBUT. For details on the [New] dialog box in DEBUT, see "New Dialog 

Box [DEBUT]".

Use of work
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New dialog box (Illustration) [PRO/EX]
These are the settings that appear when [Illustration] is selected as the [Use of work].

A. File name
Enter a save name for your file.

B. Preset

(1) Preset

You can select a canvas size from the list.

(2) Register to preset

Registers the current settings in the dialog box as [Preset]. Clicking the button opens the [Register to preset] dialog box. In the dialog box, 

set the preset name and settings to be included in the preset, then click [OK].

(3) Delete preset

You can delete presets selected from the [Preset] list.

If you change the settings of a preset, the selected option will automatically change to [Custom].

For details on the [Register to preset] dialog box, see "Register to preset Dialog Box".
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C. Unit
Select a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.

D. Canvas
Adjust various canvas settings, ncluding size and resolution.

(1) Swap width/height

Swaps the width and height of the canvas.

(2) Width

Sets the width of the canvas.

(3) Height

Sets the height of the canvas.

(4) Default size (Canvas size)

Allows you to select a width and height from default sizes.

(5) Resolution

Sets the resolution of the canvas. Click the drop-down button next to it to select a value.

(6) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(7) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

You can only delete presets that you have registered yourself. Default presets cannot be deleted.

The expression color [Monotone] from Ver.1.2.1 and earlier will be converted into the following [basic expression 

color] and [drawing color].

 Basic expression color: Gray

 Drawing color: Only black

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.
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Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(8) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(9) Paper color

You can set a color for the Paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to change the color 

of the Paper layer.

(10)Template

Allows you to create a page file with an imported template. Select the checkbox and click the button to open the [Template] dialog box. 

Specify the template to import to the page file in the dialog box.

(11) Specified template

Clicking this button opens the [Template] dialog box. Specify the template to import to the page file in the dialog box.

E. Create moving illustration
You can create an animated illustration and set the number of animation cels.

(1) Create moving illustration

Turn this on to display the settings for creating an animated illustration.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

 For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click [Paper Layer] in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the [Paper Layer].

 For details on the [New] dialog box in DEBUT, see "Advanced settings of color Dialog Box".

If a template has previously been specified, the template title will appear as a button beside the checkbox. Click 

this button to open the [Template] dialog box.

For details on the settings in the [Template] dialog box, see "Template Dialog Box [PRO/EX]".
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(2) Number of cels

Allows you to set the number of cels. Sets Up to 24 pages. Click the drop-down icon to select the number of cels by length in seconds.

(3) Playback time

The playback time is shown based on the number of cels and the frame rate.

(4) Frame rate

Sets the number of cels (images) per second. For example, if a frame rate of [8fps] is set, 8 cels will be played in one second.

F. Record timelapse *
When enabled, starts recording a timelapse whenever a new canvas is created. If you save the file in Clip Studio format (extension: .clip), 

the timelapse will be saved with the file. For more detail on timelapses, see Clip Studio TIPS.

 In the [Number of cels] setting, you set the total playback time as well as the number of cels. You can change 

the number of cels after creating the canvas by adjusting the number of cels in the [Timeline] palette. For 

details, see "Operating the Timeline Palette".

 You can adjust the number of cels per second with the [Frame rate] setting.
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New dialog box (Webtoon) [PRO/EX]*
These are the settings that appear when [Webtoon] is selected as the [Use of work].

A. File name
Enter a save name for your file.

When creating a work with multiple pages in EX, this will be the name of the page management file (extension: cmc). The entered file 

name will also be used as the name of the management folder.

B. Save to [EX]
Specifies the location where the management folder will be created. Click [Browse] to specify the location. This option appears when 

[Page settings] is turned on.

C. Preset

(1) Preset

Selects the finish size and resolution from a list of options.

In EX, works made of multiple pages are stored inside a management folder as the management file and separate 

Clip Studio format files for each page. For details, see "Regarding Management File and Page Files".

If you change the settings of a preset, the selected option will automatically change to [Custom].
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(2) Register to preset

Registers the current settings in the dialog box as [Preset]. Clicking the button opens the [Register to preset] dialog box. In the dialog box, 

set the preset name and settings to be included in the preset, then click [OK].

(3) Delete preset

You can delete presets selected from the [Preset] list.

D. Unit
The unit for setting the width and height of the canvas. In this window, the unit is fixed as px.

E. Canvas
Adjust various canvas settings, ncluding size and resolution.

(1) Swap width/height

Swaps the width and height of the canvas.

(2) Width

Sets the width of the canvas.

(3) Height

Sets the height of the canvas.

(4) Resolution

Sets the resolution of the canvas. Click the drop-down button next to it to select a value.

(5) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

For details on the [Register to preset] dialog box, see "Register to preset Dialog Box".

You can only delete presets that you have registered yourself. Default presets cannot be deleted.

The expression color [Monotone] from Ver.1.2.1 and earlier will be converted into the following [basic expression 

color] and [drawing color].

 Basic expression color: Gray

 Drawing color: Only black
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(6) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(7) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(8) Paper color

You can set a color for the Paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to change the color 

of the Paper layer.

(9) Template

Allows you to create a page file with an imported template. Select the checkbox and click the button to open the [Template] dialog box. 

Specify the template to import to the page file in the dialog box.

(10)Specified template

Clicking this button opens the [Template] dialog box. Specify the template to import to the page file in the dialog box.

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

 For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click [Paper Layer] in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the [Paper Layer].

 For details on the [New] dialog box in DEBUT, see "Advanced settings of color Dialog Box".

If a template has previously been specified, the template title will appear as a button beside the checkbox. Click 

this button to open the [Template] dialog box.

For details on the settings in the [Template] dialog box, see "Template Dialog Box [PRO/EX]".
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F. Page settings [EX]

(1) Page settings

When enabled, allows you to manage webtoons as multiple files. You can set how the work is divided using [Number of page divisions] 

and [Number of pages].

(2) Number of page divisions

When enabled, the canvas height will be divided by the number set in [Number of page divisions] and exported as separate files.

(3) Number of pages

When enabled, creates canvases based on the specified size and number of pages specified in [Number of pages].

G. Record timelapse *
When enabled, starts recording a timelapse whenever a new canvas is created. If you save the file in Clip Studio format (extension: .clip), 

the timelapse will be saved with the file. For more detail on timelapses, see Clip Studio TIPS.

Similar to multiple page works, a management file and multiple image files in Clip Studio format (extension: .clip) will 

be stored in a [Management folder]. For details, see "Regarding Management File and Page Files".
CLIP STUDIO PAINT Instruction Manual 32

https://tips.clip-studio.com/q/articles/4000


Menus > File Menu > New
New dialog box (Comic) [PRO/EX]
These are the settings that appear when [Comic] is selected as the [Use of work].

A. File name
Enter a save name for your file.

When creating a work with multiple pages in EX, this will be the name of the page management file (extension: cmc). The entered file 

name will also be used as the name of the management folder.

B. Save to [EX]
Specifies the location where the management folder will be created. Click [Browse] to specify the location. This option appears when 

[Multiple pages] is turned on.

In EX, you can change settings for multiple pages, cover pages, story information, and the folio after creating the 

file. To learn about these settings, see "Change basic work settings".

In EX, works made of multiple pages are stored inside a management folder as the management file and separate 

Clip Studio format files for each page. For details, see "Regarding Management File and Page Files".
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C. Preset

(1) Preset

Selects the finish size and resolution from a list of options.

(2) Register to preset

Registers the current settings in the dialog box as [Preset]. Clicking the button opens the [Register to preset] dialog box. In the dialog box, 

set the preset name and settings to be included in the preset, then click [OK].

(3) Delete preset

You can delete presets selected from the [Preset] list.

D. Unit
The unit for setting the width and height of the canvas. In this window, the unit is fixed as mm.

If you change the settings of a preset, the selected option will automatically change to [Custom].

For details on the [Register to preset] dialog box, see "Register to preset Dialog Box".

You can only delete presets that you have registered yourself. Default presets cannot be deleted.
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E. Manga draft settings > Binding (finish) size
Adjust the settings for creating the comic canvas.

(1) Swap width/height

Swaps the width and height of the canvas.

(2) Width

Horizontal length to print.

(3) Height

Vertical length to print.

(4) Default size (finish size)

Allows you to select a width and height for the finish size from default sizes.

(5) Bleed width

Sets the [Bleed width]. You can select from [5mm] or [3mm].

The bleed width is a margin to compensate for misaligned trimming of the edges of the pages. To print to the edge of the page, draw up to 

the bleed width area.

The area between the bleed border (the first border from the edge) and the finish border (the second border from the edge) is the bleed area.

Cropped border

Bleed width
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(6) Resolution

Sets the resolution of the page. When the basic expression color is set to [Monochrome], you can choose from 600dpi or 1200dpi. When 

the basic expression color is set to [Color] or [Gray], you can choose from 350dpi or 600dpi.

(7) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(8) Drawing colors

Sets the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(9) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(10)Template

Allows you to create a page file with an imported template.

Select the checkbox and click the button to open the [Template] dialog box. Specify the template to import to the page file in the dialog 

box.

(11) Specified template

Clicking this button opens the [Template] dialog box. Specify the template to import to the page file in the dialog box.

The expression color [Monotone] from Ver.1.2.1 and earlier will be converted into the following [basic expression 

color] and [drawing color].

 Basic expression color: Gray

 Drawing color: Only black

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

 For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

If a template has previously been specified, the template title will appear as a button beside the checkbox. Click 

this button to open the [Template] dialog box.

For details on the settings in the [Template] dialog box, see "Template Dialog Box [PRO/EX]".
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(12)Align crop mark [EX]

Set whether or not to align crop marks on two-page spreads.

When turned off, crop marks are created at the position where the paper edges of the left and right pages match.

When turned on, the crop marks are combined by aligning the positions of the cropped border. The position of the cropped border on the 

left and right pages can be adjusted in [Gap].

F. Setting for fanzine [EX]
(1) Check whether to export fanzine printing data

Turn this on to check whether the file can be exported as fanzine printing data. If the data cannot be exported as fanzine printing data, a 

message will appear when you click the [OK] button in the [New] dialog box.

G. Multiple pages [EX]
You can create a work consisting of multiple pages and configure settings such as the number of pages and binding direction.

(1) Multiple pages

Turn this on to create a file with multiple pages.

(2) Number of pages

Sets the number of pages to create. Click the drop-down button next to it to select the amount.

(3) Combine into two-page spreads

Turn this on to connect sets of left and right pages as two-page spreads.

(4) Binding point

Selects the direction in which to bind the book. Select either [Left binding] or [Right binding].

(5) Start page

Set which side to put the first page.

 When starting with a left page, select [From left].

 When starting with a right page, select [From right].

The [Align crop mark] setting is available when [Combine into two-page spreads] is turned on under [Multiple 

pages].

 If [Cover page] is turned on, enter the total number of pages including the cover page and back page.

 The numbers of pages that can be selected depend on the settings.

Generally, [Left binding] is used for Western-style comics, and [Right binding] is used for Japanese-style manga.

The [Start page] setting is not available when [Cover page] is turned on.
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H. Cover page [EX]
You can add a cover page and configure settings such as the drawing colors and resolution.

(1) Cover page

Turn this on to add cover pages to a work and adjust settings such as the drawing colors and resolution.

(2) Resolution

Set the resolution of the cover page. When the basic expression color is set to [Monochrome], you can choose from 600dpi or 1200dpi. 

When the basic expression color is set to [Color] or [Gray], you can choose from 350dpi or 600dpi.

(3) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(4) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

The expression color [Monotone] from Ver.1.2.1 and earlier will be converted into the following [basic expression 

color] and [drawing color].

 Basic expression color: Gray

 Drawing color: Only black

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

 For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

Basic expression color: Color / Template: Off Basic expression color: Monochrome / Template: On
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(5) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(6) Paper color

You can set a color for the Paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to change the color 

of the Paper layer. This option is available when the basic expression color is set to [Color].

(7) Cover page layout

Set the placement of the front and back cover pages. You can select whether to create the front and back cover pages as a spread or to print 

them as separate pages.

(8) Specify spine width

Set the spine width if the cover pages are to be printed as a spread. Turn this option to specify the width.

(9) Template

You can apply a template to the cover page. Select the checkbox and click the button to open the [Template] dialog box. Specify the tem-

plate to import to the cover page in the dialog box.

(10)Specified template

Clicking this button opens the [Template] dialog box. Select the template to import to the cover page from the dialog box.

I. Story information [EX]
Enter information such as the story name, number of stories, subtitle, author, and page numbers. This information is displayed outside the 

bleed border, in the non-printable area. These are optional settings, so you can skip items that aren't relevant.

(1) Story name

Enter a title for the work. The pull down menu shows options for where to place the story name.

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click the Paper layer in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the Paper layer.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

If the checkbox is not checked, the spine width will automatically be calculated. However, this value may differ 

from the actual spine width depending on the paper used for the body pages.

If a template has previously been specified, the template title will appear as a button beside the checkbox. Click 

this button to open the [Template] dialog box.

For details on the settings in the [Template] dialog box, see "Template Dialog Box [PRO/EX]".
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(2) Number of stories

When turned on, you can enter the number of stories in the work.

(3) Subtitle

Enter a subtitle for the comic or manga.

(4) Author

Enter the name of the author or author group. The pull down menu shows options for where to place the author name.

(5) Page number

Turn this on to add page numbers. The pull down menu shows options for where to place the page numbers. You can change the starting 

number with the [Start number] setting.

J. Folio [EX]
Adjust settings for the page numbers that are shown when the pages are bound.

(1) Start number

Enter the starting page number.

(2) Color

Choose a color for the page numbers. You can select from black or white.

(3) Put edges

Turn this on to add a border around the page numbers. In the input field on the right, set the thickness of the border.

(4) Folio

Turn this on to show the page numbers on the printed page. The pull down menu shows options for where to place the page numbers.

(5) Format

Set the text to be added before and/or after the page number, if any. Input the text in the fields on the left and right, respectively.

(6) Gap with default border

Set the gap between the folio and the default border. A larger value increases the size of the gap.

(7) Font

Select the font to use for the page numbers.

(8) Size

Set the font size for the page numbers.

(9) Blind folio

When turned on, hidden page numbers are indicated at the bottom of the gutter (the side where the book is bound). Settings such as font 

and size cannot be set for [Blind folio].

K. Record timelapse *
When enabled, starts recording a timelapse whenever a new canvas is created. If you save the file in Clip Studio format (extension: .clip), 

the timelapse will be saved with the file. For more detail on timelapses, see Clip Studio TIPS.
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New dialog box (Printing of fanzine) [EX]
These are the settings that appear when [Printing of fanzine] is selected as the [Use of work].

A. File name
Enter a file name for the management file (extension: cmc). The entered file name will also be used as the name of the management folder.

B. Save to
Specify the location where the files and management folder will be created. Click [Browse] to specify the location.

C. Preset

(1) Preset

Select the finish size and the expression color of the cover page and body pages (main text) from a list of options.

In EX, you can change settings for multiple pages, cover pages, story information, and the folio after creating the 

file. To learn about these settings, see "Change basic work settings".

Works made of multiple pages are stored inside a management folder as the management file and separate Clip 

Studio format files for each page. For details, see "Regarding Management File and Page Files".
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(2) Register to preset

Registers the current settings in the dialog box as [Preset]. Clicking the button opens the [Register to preset] dialog box. In the dialog box, 

set the preset name and settings to be included in the preset, then click [OK].

(3) Delete preset

You can delete presets selected from the [Preset] list.

D. Unit
The unit for setting the width and height of the canvas. In this window, the unit is fixed as mm.

E. Manga draft settings > Binding (finish) size
Configure settings related to body pages of fanzines.

(1) Width

Horizontal length to print.

(2) Height

Vertical length to print.

(3) Default size (finish size)

Select a width and height for the finish size from default sizes.

If you change the settings of a preset, the selected option will automatically change to [Custom].

For details on the [Register to preset] dialog box, see "Register to preset Dialog Box".

You can only delete presets that you have registered yourself. Default presets cannot be deleted.
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(4) Bleed width

Sets the [Bleed width]. You can select from [5mm] or [3mm]. Selecting a printing place in [Fanzine printing vendor] automatically sets the 

[Bleed width] recommended by the printing place.

The bleed width is an extra margin to compensate for misaligned trimming of the edges of the pages. To print to the edge of the page, draw 

up to the bleed width area.

The area between the bleed border (the first border from the edge) and the finish border (the second border from the edge) is the bleed area.

(5) Resolution

Set the resolution of the page. If a printing place is selected in [Fanzine printing vendor], you can select from resolutions recommended by 

the printing vendor.

When [General-purpose settings] is selected, the following resolutions can be set.

 When the basic expression color is set to [Monochrome], you can choose from 600dpi or 1200dpi.

 When the basic expression color is set to [Gray], you can choose from 350dpi or 600dpi.

 When the basic expression color is set to [Gray], the resolution will be set to 350dpi.

(6) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

The expression color [Monotone] from Ver.1.2.1 and earlier will be converted into the following [basic expression 

color] and [drawing color].

 Basic expression color: Gray

 Drawing color: Only black

Cropped border

Bleed width
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(7) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(8) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(9) Template

Allows you to create a page file with an imported template.

Select the checkbox and click the button to open the [Template] dialog box. Specify the template to import to the page file in the dialog 

box.

(10)Specified template

Clicking this button opens the [Template] dialog box. Specify the template to import to the page file in the dialog box.

F. Setting for fanzine
Configures settings related to printing fanzines.

(1) Fanzine printing vendor

Select the name of the printing vendor from which to request printing. When you select a printing vendor, you can select from resolutions 

recommended by that printing vendor.

This option will be set as [General-purpose settings] if there are no applicable companies.

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

 For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

If a template has previously been specified, the template title will appear as a button beside the checkbox. Click 

this button to open the [Template] dialog box.

For details on the settings in the [Template] dialog box, see "Template Dialog Box [PRO/EX]".
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(2) Home Page

The URL of the website of the printing place selected in [Fanzine printing vendor]. Click the URL to launch your web browser and display 

the website of the printing vendor. This item is not displayed if [General-purpose settings] is selected.

G. Multiple pages
You can set the number of pages and binding direction of fanzines.

(1) Number of pages

Sets the number of pages to create. Click the drop-down button next to it to select the amount. Once you enter a number of pages, a break-

down of the pages will appear on the right side. The number of body pages is the total number of pages minus the cover pages (four pages).

(2) Binding point

Selects the direction in which to bind the book. Select either [Left binding] or [Right binding].

 The [Fanzine printing shop] setting can be changed in the [Story] menu → [Change basic work settings]. For 

details, see "Change basic work settings".

 [Fanzine printing vendor] is a Japanese langauge only service. Fanzine printing vendor cannot be selected in 

other language versions of Clip Studio Paint.

It is recommended to set the number of pages according to the numbers of pages written in the fee table of the 

printing vendor. You have not specified a printing vendor, it is a good idea to set the number of body pages as a 

multiple of 4. This is because many printing vendors print in batches of 4 or 8 pages.

Generally, [Left binding] is used for Western-style comics, and [Right binding] is used for Japanese-style manga.
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H. Cover page
You can configure settings for the cover page such as the drawing color and resolution.

(1) Resolution

Set the resolution of the cover page. If a printing place is selected in [Fanzine printing vendor], you can select from resolutions recom-

mended by the printing vendor.

When [General-purpose settings] is selected, the following resolutions can be set.

 When the basic expression color is set to [Monochrome], you can choose from 600dpi or 1200dpi.

 When the basic expression color is set to [Gray], you can choose from 350dpi or 600dpi.

 When the basic expression color is set to [Gray], the resolution will be set to 350dpi.

(2) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(3) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

The expression color [Monotone] from Ver.1.2.1 and earlier will be converted into the following [basic expression 

color] and [drawing color].

 Basic expression color: Gray

 Drawing color: Only black

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

 For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

Basic expression color: Color / Template: Off Basic expression color: Monochrome / Template: On
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(4) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(5) Paper color

You can set a color for the Paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to change the color 

of the Paper layer. This option is available when the basic expression color is set to [Color].

(6) Cover page layout

Set the placement of the front and back cover pages. You can select whether to create the front and back cover pages as a spread or to print 

them as separate pages.

(7) Specify spine width

Set the spine width if the cover pages are to be printed as a spread. Turn this option to specify the width.

If the checkbox is not checked, the spine width will automatically be calculated. If a [Fanzine printing vendor] is selected, the spine width 

is set according to the paper used by the printing vendor.

(8) Template

You can apply a template to the cover page. Select the checkbox and click the button to open the [Template] dialog box. Specify the tem-

plate to import to the cover page in the dialog box.

(9) Specified template

Clicking this button opens the [Template] dialog box. Select the template to import to the cover page from the dialog box.

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click the Paper layer in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the Paper layer.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

The actual spine width may differ from the automatically calculated number depending on the paper used for the 

body pages. Confirm the spine width with your printing place if using special paper for the body pages.

If a template has previously been specified, the template title will appear as a button beside the checkbox. Click 

this button to open the [Template] dialog box.

For details on the settings in the [Template] dialog box, see "Template Dialog Box [PRO/EX]".
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I. Story information
Enter the story name and author name. This information is displayed outside the bleed border, in the non-printable area. These are optional 

settings, so you can skip items that aren't relevant.

(1) Story name

Enter a title for the work. The pull down menu shows options for where to place the story name.

(2) Author

Enter the name of the author or author group. The pull down menu shows options for where to place the author name.

J. Folio
Adjust settings for the page numbers that are shown when the pages are bound.

(1) Folio

Turn this on to show the page numbers on the printed pages. The pull down menu shows options for where to place the page numbers.

(2) Format

Set the text to be added before and/or after the page number, if any. Input the text in the fields on the left and right, respectively.

(3) Font

Select the font to use for the page numbers.

(4) Size

Set the font size for the page numbers.

(5) Blind folio

When turned on, hidden page numbers are indicated at the bottom of the gutter (the side where the book is bound). Settings such as font 

and size cannot be configured for [Blind folio].

K. Record timelapse *
When enabled, starts recording a timelapse whenever a new canvas is created. If you save the file in Clip Studio format (extension: .clip), 

the timelapse will be saved with the file. For more detail on timelapses, see Clip Studio TIPS.
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New dialog box (Show all comic settings) [PRO/EX] 
These are the settings that appear when [Show all comic settings] is selected as the [Use of work].

In EX, you can change settings for multiple pages, cover pages, story information, and the folio after creating the 

file. To learn about these settings, see "Change basic work settings".
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A. File name
Enter a save name for your file.

When creating a work with multiple pages in EX, this will be the name of the page management file (extension: cmc). The entered file 

name will also be used as the name of the management folder.

B. Save to [EX]
Specifies the location where the management folder will be created. Click [Browse] to specify the location. This option appears when 

[Multiple pages] is turned on.

C. Preset

(1) Preset

Select the finish size and resolution from a list of options. Registered presets can also be selected when other items are selected in [Use of 

work].

(2) Register to preset

Registers the current settings in the dialog box as [Preset]. Clicking the button opens the [Register to preset] dialog box. In the dialog box, 

set the preset name and settings to be included in the preset, then click [OK].

(3) Delete preset

You can delete presets selected from the [Preset] list.

D. Unit
Select a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.

In EX, works made of multiple pages are stored inside a management folder as the management file and separate 

Clip Studio format files for each page. For details, see “Regarding Management File and Page Files”.

If you change the settings of a preset, the selected option will automatically change to [Custom].

For details on the [Register to preset] dialog box, see "Register to preset Dialog Box".

The preset list for [Show all comic settings] includes presets for other types of projects. This means that if a pre-

set registered for another [Use of work] is deleted, the preset will be deleted from this list as well.

You can only delete presets that you have registered yourself. Default presets cannot be deleted.
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E. Canvas
Adjust settings related to the canvas.

(1) Swap width/height

Swaps the width and height of the canvas (page).

(2) Width

Horizontal length to print.

(3) Height

Vertical length to print.

(4) Resolution

Sets the resolution of the canvas (pages). Click the drop-down button next to it to select a value.

(5) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(6) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

 When [Manga draft settings] is turned off, the canvas size will be the final size.

 When [Manga draft settings] is turned on, the [Binding (finish) size] will be the final size when bound in a book.

The expression color [Monotone] from Ver.1.2.1 and earlier will be converted into the following [basic expression 

color] and [drawing color].

 Basic expression color: Gray

 Drawing color: Only black

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.
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Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(7) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(8) Paper color

Turn this on to choose the color of the paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to 

change the color of the Paper layer.

(9) Template

Allows you to create a page file with an imported template.

Select the checkbox and click the button to open the [Template] dialog box. Specify the template to import to the page file in the dialog 

box.

(10)Specified template

Clicking this button opens the [Template] dialog box. Specify the template to import to the page file in the dialog box.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

 For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click the Paper layer in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the Paper layer.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

If a template has previously been specified, the template title will appear as a button beside the checkbox. Click 

this button to open the [Template] dialog box.

For details on the settings in the [Template] dialog box, see "Template Dialog Box [PRO/EX]".
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F. Manga draft settings
Turn this on to add crop marks, default border (inner), cropped border, bleed border and safety margin to the canvas. After setting up sizes 

for the bleed border, default border and safety margin, these guidelines can be displayed on the canvas.

G. Manga draft settings > Binding (finish) size
This sets the border at which the edge of the pages will be trimmed for binding after printing. Drawings within these dimensions will be 

printed. You can also add an extra safety margin to deal with misaligned trimming of the printed pages. These options appear when 

[Manga draft settings] is turned on.

(1) Width

Horizontal length to print.

(2) Height

Vertical length to print.

Safety margin

Default border

Bleed width

Canvas

Bleed

Cropped border

Cropped border

Bleed width
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(3) Bleed width

Add an extra margin to compensate for misaligned trimming of the edges of the pages. To print to the edge of the page, draw up to the 

bleed width area.

The area between the bleed border (the first border from the edge) and the finish border (the second border from the edge) is the bleed area.

(4) Default size (Cropped border)

Allows you to select a width and height for the finish size from default sizes.

H. Manga draft settings > Default border (inner) size
This is a reference border for laying out frames. There are two ways of specifying the default border: by size and position, or by margin. 

This option appears when [Manga draft settings] is turned on.

(1) Default size (Default border)

Allows you to select a width and height for the default border from default sizes.

Bleed width Cropped border

Bleed

Bleed area is the area

between the bleed border and

the cropped border.

Default border
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(2) How to specify default border

You can choose how to specify the size and position of the default border. The options vary depending on the default border settings.

(3) Default border settings

Sets the size and position of the default border. The options vary depending on the method of specifying the border.

Set size

Adjust the size and position of the default border.

Set margin

Adjust the default border based on the distance from the edges of the cropped border.

Set size Adjust the size and position of the default border.

Set margin Adjust the default border based on the distance from the edges of the paper.

Width Width of the default border.

Height Length of the default border.

X offset Horizontal position of the default border.

Y offset Vertical position of the default border.

 When [X offset] is 0, the default border will be located in the center of the finish border horizontally.

 When [Y offset] is 0, the default border will be located in the center of the finish border vertically.

Top Specifies the upper side of the default border as the distance from the top of the cropped border.

Bottom Specifies the lower side of the default border as the distance from the bottom of the cropped border.

Inside
Specifies the right or left side of the default border as the distance from the direction of the binding 

point.

Outside
Specifies the right or left side of the default border as the distance from the outer edge of the page (oppo-

site side to the binding point).
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I. Manga draft settings > Safety margin
Turn this on to add a safety margin to the canvas. When printing magazines and books with different aspect ratios, the position of the bleed 

border changes depending on the format. The safety margin indicates the print-safe area for both magazines and books. Usually, publishers 

and printing companies specify its position.

J. Align crop mark [EX]
Sets whether or not to align crop marks on two-page spreads.

When turned off, crop marks are created at the position where the paper edges of the left and right pages match.

When turned on, the crop marks are combined by aligning the positions of the cropped border. The position of the cropped border on the 

left and right pages can be adjusted in [Gap].

K. Setting for fanzine [EX]
(1) Check whether to export fanzine printing data

Turn this on to check whether the file can be exported as fanzine printing data. If the data cannot be exported as fanzine printing data, a 

message will appear when you click the [OK] button in the [New] dialog box.

Top Specifies the upper side of the safety margin as the distance from the top of the cropped border.

Bottom Specifies the lower side of the safety margin as the distance from the top of the cropped border.

Inner
Specifies the left/right side of the safety margin as the distance from the cropped border on the binding 

side.

Outside
Specifies the left/right side of the safety margin as the distance from the cropped border on the outer side 

of the page.

The [Align crop mark] setting is available when [Combine into two-page spreads] is turned on under [Multiple 

pages].
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L. Multiple pages [EX]
You can create a work consisting of multiple pages and configure settings such as the number of pages and binding direction.

(1) Multiple pages

Turn this on to create a file with multiple pages.

(2) Number of pages

Sets the number of pages to create. Click the drop-down button next to it to select the amount.

(3) View *

You can choose from the following views. The settings and [Story] window will change depending on the view.

(4) Combine into two-page spreads

Turn this on to connect sets of left and right pages as two-page spreads.

(5) Binding point

Selects the direction in which to bind the book. Select either [Left binding] or [Right binding].

(6) Start page

Sets which side to put the first page.

 When starting with a left page, select [From left].

 When starting with a right page, select [From right].

 If [Cover page] is turned on, include the cover page when setting the number of pages.

 The numbers of pages that can be selected depend on the settings.

Page-by-page Pages will be optimized for works with page turns such as bound books.

Webtoon Pages will be optimized for vertical scrolling works such as webtoons.

You can set it up by selecting [Page-by-page] under [View].

 Generally, [Left binding] is used for Western-style comics, and [Right binding] is used for Japanese-style 

manga.

 You can set it up by selecting [Page-by-page] under [View].

 The [Start page] setting is not available when [Cover page] is turned on.

 You can set it up by selecting [Page-by-page] under [View].
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M. Cover page [EX]
Add a cover page and adjust settings, including drawing colors and resolution.

(1) Cover page

Turn this on to add a cover page to your work and show the canvas and layout settings.

(2) Resolution

Sets the resolution of the cover page. Click the drop-down button next to it to select a value.

(3) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(4) Drawing colors

Sets the drawing color if the basic expression color is set to either [Gray] or [Monochrome]. You can set the drawing color by selecting one 

of the black and white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

The expression color [Monotone] from Ver.1.2.1 and earlier will be converted into the following [basic expression 

color] and [drawing color].

 Basic expression color: Gray

 Drawing color: Only black

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

 For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

Basic expression color: Color / Template: Off Basic expression color: Monochrome / Template: On
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(5) Default frequency

Specifys the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set 

to [Gray] or [Monochrome].

(6) Paper color

This appears when the basic expression color is set to [Color]. It allows you to choose the color of the paper layer. Click the color indicator 

to open the [Color settings] dialog box. Specify a color to change the color of the Paper layer.

(7) Cover page layout

Sets the placement of the front and back cover pages. You can select whether to create the front and back cover pages as a spread or to 

print them as separate pages.

(8) Specify spine width

Sets the spine width if the cover pages are to be printed as a spread. Turn this option to specify the width.

(9) Template

Applies a template to the cover page. Select the checkbox to open the [Template] dialog box. Specify the template to import to the cover 

page in the dialog box.

(10)Specified template

Clicking the template title button opens the [Template] dialog box. If you want to modify your template choice, click on a different tem-

plate to import it to the cover page in the dialog box.

N. Story information [EX]
Enter information such as the story name, number of stories, subtitle, author, and page numbers. This information is displayed outside the 

bleed border, in the non-printable area. These are optional settings, so you can skip items that aren't relevant.

(1) Story name

Enter a title for the work. The pull down menu shows options for where to place the story name.

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click the Paper layer in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the Paper layer.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

If the checkbox is not checked, the spine width will automatically be calculated. However, this value may differ 

from the actual spine width depending on the paper used for the body pages.

If a template has previously been specified, the template title will appear as a button beside the checkbox. Click 

this button to open the [Template] dialog box.

For details on the settings in the [Template] dialog box, see "Template Dialog Box [PRO/EX]".
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(2) Number of stories

When turned on, you can enter the number of stories in the work.

(3) Subtitle

Enter a subtitle for the comic or manga.

(4) Author

Enter the name of the author or author group. The pull down menu shows options for where to place the author name.

(5) Page number

Turn this on to add page numbers.The pull down menu shows options for where to place the page numbers.You can change the starting 

number with the [Start number] setting.

O. Folio [EX]
Adjusts settings for the page numbers that are shown when the pages are bound.

(1) Start number

Enter the starting page number.

(2) Color

Choose a color for the page numbers.You can select from black or white.

(3) Put edges

Turn this on to add a border around the page numbers.In the input field on the right, set the thickness of the border.

(4) Folio

Turn this on to show the page numbers on the printed page. The pull down menu shows options for where to place the page numbers.

(5) Format

Set the text to be added before and/or after the page number, if any. Input the text in the fields on the left and right, respectively.

(6) Gap with default border

Set the gap between the folio and the default border.A larger value increases the size of the gap.

(7) Font

Select the font to use for the page numbers.

(8) Size

Set the font size for the page numbers.

(9) Blind folio

When turned on, hidden page numbers are indicated in the lower part of the gutter (the side where the book is bound). Settings such as font 

and size cannot be configured for [Blind folio].

P. Record timelapse *
When enabled, starts recording a timelapse whenever a new canvas is created. If you save the file in Clip Studio format (extension: .clip), 

the timelapse will be saved with the file. For more detail on timelapses, see Clip Studio TIPS.
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New dialog box (Animation) [PRO/EX]
These are the settings that appear when [Animation] is selected as the [Use of work].

A. File name
Enter a save name for your file.

B. Save to
Specifies the location where the management folder will be created. Click [Browse] to specify the location. This option appears when 

[Manage files using folders] is turned on.

You can also change some settings after creating the file. To learn more, see "Change basic page settings" and 

"Change basic work settings".

When [Set file name automatically] is turned on, the file names will be created automatically based on the option 

chosen in the drop-down box.
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C. Preset

(1) Preset

Select the finish size and resolution from a list of options.

(2) Register to preset

Registers the current settings in the dialog box as [Preset]. Clicking the button opens the [Register to preset] dialog box. In the dialog box, 

set the preset name and settings to be included in the preset, then click [OK].

(3) Delete preset

You can delete presets selected from the [Preset] list.

D. Unit
Select a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.

E. Size of output frame
Set the size and resolution of the output frame on the canvas.

(1) Width

Sets the width of the output frame.

When using a folder, the project files will be saved in a management folder as the management file (.cmc) and sep-

arate Clip Studio format files for each page. For details, see "Regarding Management File and Page Files".

If you change the settings of a preset, the selected option will automatically change to [Custom].

For details on the [Register to preset] dialog box, see "Register to preset Dialog Box".

You can only delete presets that you have registered yourself. Default presets cannot be deleted.

For details on the output frame, see "Explanation: Animation cels terminology [PRO/EX]".
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(2) Height

Sets the height of the output frame.

(3) Resolution

Sets the resolution of the canvas. Click the drop-down button next to it to select a value.

F. Title-safe area
Turn this on to set a title-safe area on the canvas. Set the distance of the title-safe area from the top, bottom, left and right edges of the out-

put frame (margin).

G. Overflow frame
Turn this on to set a overflow frame on the canvas. Overflow frames are useful for creating cuts that move horizontally or vertically across 

the canvas.

(1) How to add an overflow frame

Set how to specify the overflow frame. The width and height are specified differently depending on this setting.

(2) Width

Sets the width of the overflow frame.

(3) Height

Sets the height of the overflow frame.

For details on title-safe areas, see "Explanation: Animation cels terminology [PRO/EX]".

For details on overflow frames, see "Explanation: Animation cels terminology [PRO/EX]".

Specified scale Specify a scale based on the size of the output frame.

Specified size Specify measurements for the width and height.

Effect frame

Reference frame
Up

Bottom

Left Right
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(4) Reference point

Specifys the position of the reference point (output frame) in relation to the overflow frame.

(5) Offset X

When the overflow frame is larger than the output frame, moves the output frame horizontally.

(6) Offset Y

When the overflow frame is larger than the output frame, moves the output frame vertically.

H. Blank space
Sets the blank space around the overflow frame. If there is no overflow frame, the blank space will be added around the output frame.

Enter values in [Up], [Down], [Left], and [Right] to add blank space.

I. Story information [EX]
Enter information such as the story name, number of stories, and file name.

(1) Story name

Enter a name for the story. The pull down menu shows options for where to place the story name. This information is displayed in the 

blank space.

(2) Number of stories

Enter the number of stories.

(3) Set file name automatically

Turn this on to create file names automatically. Files will be named according to the option selected from the drop-down menu.

(4) Manage files using folders

Turn this on to manage multiple files in folders.

Reference frame

Up

Bottom

Left Right
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J. Timeline
Configure settings such as the timeline name and frame rate.

(1) Timeline name

Enter a name for the timeline.

(2) Frame rate

Enter a frame rate for the timeline.

(3) Playback time

Enter the playback time. You can use the drop-down menu to select how to display frames on the Timeline. The box for inputting the play-

back time will change depending on the selected option.

(4) Scene number

Enter the scene number.

(5) Cut number

Enter the cut number.

(6) Division line

Set up the lines that divide the Timeline. Division lines will be shown at the specified frame interval (for example, after every five frames).

(7) Set timeline name automatically

When active, the [Timeline name] is set automatically. It will be named according to the option selected from the drop-down menu.

The timeline name can be changed after creating the canvas. For details on how to change the name, see "Manage 

timeline".

The frame rate (fps) is the maximum number of images that can be displayed in one second to run the animation. 

For example, if a frame rate of 30 is set, up to 30 images (cels) can be shown each second. Typical frame rates for 

TV animation are 24fps or 30fps.

Frame number (starting 

from 1), Frame number 

(starting from 0)

Set the number of frames for the entire timeline. For example, if the frame rate is 30 fps and you 

would like to make a 4-second animation, enter "120" (30 frames x 4 seconds). The difference 

between [Frame number (starting from 1)] and [Frame number starting from 0)] is the start num-

ber of the frames.

Seconds + frame
Set the playback time in seconds. To add frames after the specified number of seconds, enter the 

number of frames to be added.

Time code
Set the playback time in minutes and seconds. To add frames after the set number of seconds, 

enter the number of frames to be added.
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(8) Image interpolation

You can select the method for interpolating the colors of pixels when transforming a cel or image material using keyframes.

K. Template
Turn this on to display the [Template] dialog, which allows you to select a template (layer configuration) for cuts and cels.

Cut templates are applied after confirming the settings in the [New] dialog box. Cel templates are applied when cel is created by selecting 

[Animation] > [New animation cel].

L. Record timelapse *
When enabled, starts recording a timelapse whenever a new canvas is created. If you save the file in Clip Studio format (extension: .clip), 

the timelapse will be saved with the file. For more detail on timelapses, see Clip Studio TIPS.

Smooth edges (bilinear)
This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). However, outlines may become blurred depending on the image.

Hard edges (nearest neighbor)

When interpolating the image, the pixels in the image are duplicated. Since the colors are 

not affected by neighboring pixels, outlines (boundaries between colors) remain sharp. 

However, outlines may become jagged depending on the image.

Clear edges (bicubic)

This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). This method results in stronger outlines compared to the [Smooth outline 

(bilinear method)] setting. However, white noise may appear around outlines depending 

on the image.

High accuracy (average colors)

The average colors of the original pixels are strictly calculated and contained for each 

pixel after the transformation. Scaling up makes the line sharper and scaling down makes 

the line smoother. Even detailed lines can be preserved when scaling the image down. 

However, this method can result in blurred outlines and can take a long time to process 

depending on the image.
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New Dialog Box [DEBUT]
You can configure the following settings in the [New] dialog box in DEBUT.

A. File name
Enter a save name for your file.

B. Preset

(1) Preset

Select the finish size and resolution from a list of options.

(2) Register to preset

Registers the current settings in the dialog box as [Preset]. Clicking the button opens the [Register to preset] dialog box. In the dialog box, 

set the preset name and settings to be included in the preset, then click [OK].

(3) Delete preset

You can delete presets selected from the [Preset] list.

If you change the settings of a preset, the selected option will automatically change to [Custom].

For details on the [Register to preset] dialog box, see "Register to preset Dialog Box".

You can only delete presets that you have registered yourself. Default presets cannot be deleted.

A

B C

D

E

F
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C. Unit
Select a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.

D. Canvas
Adjust settings related to the canvas.

(1) Swap width/height

Swaps the width and height of the canvas (page).

(2) Width

Horizontal length to print.

(3) Height

Vertical length to print.

(4) Default size (Canvas size)

Allows you to select a width and height from default sizes.

(5) Resolution

Sets the resolution of the canvas. Click the drop-down button next to it to select a value.

(6) Paper color

Turn this on to choose the color of the paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to 

change the color of the Paper layer.

In DEBUT, the maximum canvas size is 10000 (height) x 10000 (width) pixels.

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click the Paper layer in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the Paper layer.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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E. Create moving illustration
You can create an animated illustration and set the number of animation cels.

(1) Create moving illustration

Turn this on to display the settings for creating an animated illustration.

(2) Number of cels

Allows you to set the number of cels. Sets Up to 24 pages. Click the drop-down icon to select the number of cels by length in seconds.

(3) Playback time

The playback time is shown based on the number of cels and the frame rate.

(4) Frame rate

Set the number of cels (images) per second. For example, if a frame rate of [8fps] is set, 8 cels will be played in one second.

F. Record timelapse *
When enabled, starts recording a timelapse whenever a new canvas is created. If you save the file in Clip Studio format (extension: .clip), 

the timelapse will be saved with the file. For more detail on timelapses, see Clip Studio TIPS.

 In the [Number of cels] setting, you set the total playback time as well as the number of cels. You can change 

the number of cels after creating the canvas by adjusting the number of cels in the [Timeline] palette. For 

details, see "Operating the Timeline Palette".

 You can adjust the number of cels per second with the [Frame rate] setting.
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Template Dialog Box [PRO/EX]
This dialog box appears when [Template] or [Specified template] is clicked. Here you can choose a template to load.

(1) Search box

Enter keywords to search for a template.

(2) Tag list

A list of tags assigned to materials. Click a tag button to display materials from the [Material list].

(3) Material list

A list of template materials. Click a template material to load the settings.

(4) Large thumbnails

Shows the materials as large thumbnails.

(5) Small thumbnails

Shows the materials as small thumbnails.

(6) List

Shows the materials as thumbnails with material details.

Templates can be added from the [Edit] menu > [Register Material] > [Template]. For details, see "Register Layer 

as Template Material".
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Register to preset Dialog Box
This dialog box appears when you click the [Register to preset] icon. Select the items to register to the preset.

(1) Preset name

Enter a name for the preset.

(2) Items to be included in preset

Select the settings you would like to save in the preset.

 The [Page settings], [Cover page settings] and [Folio settings] items are only available in EX. 

 [Basic expression color], [Template], [Frame rate], [Shot template] and [Cel template] items are only available 

in PRO and EX.

 The width, height, unit, and manga draft settings are always saved to the preset.

 [Size of output frame], [Title-safe area], [Overflow frame] and [Blank space] are always registered when [Ani-

mation] is set as the [Use of work].

When [Animation] is set as the [Use of work]
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Explanation: What Are the Default Border, Cropped Border and Bleed Border? [PRO/EX]
In Clip Studio Paint, the default border is the border for frames, while the cropped border and bleed border indicate the edges for trimming. 

These are collectively called “inside dimensions.”

(1) Paper size

This is the size of the entire canvas.

(2) Default border

This is a reference border for laying out frames.

(3) Cropped border

This is the line at which the pages will be trimmed for binding after printing. Anything within this area will be printed.

(4) Bleed border

This is the extra margin to deal with misaligned [Cropped border] lines when trimming the edges of the pages. Draw up to the bleed area 

to print to the edge of the pages.

Bleed width Cropped border

Bleed

Bleed area is the area

between the bleed border and

the cropped border.
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Explanation: Animation cels terminology [PRO/EX]
Animation frames are displayed when [Animation] is selected for [Use of work].

(1) Output frame

The output area when exporting a movie.

(2) Title-safe area

The part of the video that is shown can depend on the dimensions of the device on the which the animation is played. This frame sets the 

area of the animation that will be visible in all environments. All essential elements should be drawn within this frame.

(3) Overflow frame

The entire drawing area. This can be created much larger than the output frame so that you can add camera work.

(4) Blank space

An extra margin around the output frame and overflow frame.

Create New from Clipboard [Windows/macOS/iPad/iPhone]
Create a new canvas at the same size as the image saved to the clipboard, and import the image.

Create new from app clipboard  [Android/Chromebook]
A new canvas can be created from an image copied to the clipboard in Clip Studio Paint by selecting the [File] menu > [Create new from app 

clipboard].

A canvas will be created according to the size of the clipboard image, along with the image.

A larger area than the output frame or overflow frame may be displayed in some cases depending on the editing 

and playback environment. To draw to the edge of the screen, include the blank space.

[Create New From Clipboard] is available regardless of whether a canvas is already open.
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Create new file from photo library [iPad/iPhone]
Select the [File] menu > [Create new from photo library] to display the OS photo library.

Select a photo from your photo library to create a new canvas containing that photo.

Create new from device storage [Android/Chromebook]
This imports images from the device's storage into Clip Studio Paint to be edited.

Select [File] menu > [New from Storage] to select a file from the OS file management screen and open it.

Here you can edit BMP, JPEG, PNG, and TIFF file formats. Files other than these cannot be opened in Clip Studio Paint. If any other file type 

is selected, a message will display.

The selected photo is duplicated in Clip Studio Paint as a new file. Photos in your library remain unaltered.

 To edit a Folder in Clip Studio Paint, it needs to be saved in Clip Studio Paint’s work folder.

 If you want to import Clip Studio Format (extension: clip) or Adobe Photoshop Document (extension: psd) files 

into Clip Studio Paint, please refer to "Importing files from storage into Clip Studio Paint".

 When using a Samsung Galaxy Series device, tapping a BMP, JPEG, PNG, TIFF, or a compressed ZIP file in My 

Files will display an [Open in App] option which you can use to open these files in Clip Studio Paint.
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Open
Select [File] menu > [Open] to open a file.

When using Windows/macOS/Android/Chromebook, the [Open] dialog box is displayed. Select a file from the dialog box.

When using an iPad/iPhone, the OS Files app is displayed. Select a file from the Files app.

 CLIP STUDIO FORMAT (extension: clip), CLIP STUDIO PAINT format (extension: lip), IllustStudio documents (extension: xpg), Com-

icStudio page files (extension: cpg), BMP, JPEG, PNG, TIFF, Targa, Adobe Photoshop documents (extension: psd), the Adobe Photoshop 

big document format (extension: psb), ibisPaint work files (extension: ipv), and kakooyo! work files (extension: kako). Opens kakooyo! 

work files (extension: kako).

 EX can also open CLIP STUDIO PAINT EX management files (extension: cmc) and ComicStudio work files (extension: cst) and CLIP 

STUDIO name files (extension: csnf).

 When importing an IllustStudio document or ComicStudio page file, some layers may not be imported cor-

rectly. For details, see "Importing IllustStudio/ComicStudio Documents [Windows/macOS] [PRO/EX]". [PRO/

EX]

 Opening a ComicStudio work file (extension: cst) displays the [Create story folder] dialog box. Specify a loca-

tion for the management folder to convert the ComicStudio book file into a Clip Studio Paint management file 

(extension: cmc) and page files (extension: clip). For details on page management in Clip Studio Paint, see 

"Explanation: Page Management [EX]".

 IllustStudio documents (extension: xpg), ComicStudio page files (extension: cpg), and ComicStudio work files 

(extension: cst) cannot be imported on tablets/smartphones/Macs with M1 chips.

 IllustStudio documents (extension: xpg), ComicStudio page files (extension: cpg), and ComicStudio work files 

(extension: cst) cannot be imported when using DEBUT.

 In DEBUT, CMYK color files can be imported only if they are saved in CLIP STUDIO PAINT format (extension: 

clip). CMYK color files saved in the following formats cannot be imported: BMP, JPEG, PNG, TIFF, Targa, Adobe 

Photoshop Document (extension: psd), and Adobe Photoshop Big Document (extension: psb).

 When using DEBUT, the tone layers of ibisPaint work files (extension: ipv) are rasterized in Clip Studio Paint. 

Also, the selected layer cannot be imported.

 When DEBUT or PRO is used to open a file in CLIP STUDIO FORMAT (extension: clip) where the timeline is 

enabled, the timeline will be displayed as read-only if there are more than 25 frames in the timeline or if a neg-

ative number is set as the start frame.When using EX for iPad or iPhone, a message may be displayed when 

selecting a CLIP STUDIO PAINT EX management file (extension: cmc) from a location other than the CLIP STU-

DIO app folder. Follow the instructions in the message to open the file.

 When using a Tablet/Smartphone, files with ver.1.5 compatible 3D layers cannot be edited.

 When using a Tablet/Smartphone, the "CLIP STUDIO PAINT EX PDF Input/Output Plug-in" cannot be used.

 You can select and open multiple files from the [Open] dialog box.

 CMYK format images can be opened in the following formats: TIFF (extension: tif), JPEG (extension: jpg), 

Adobe Photoshop Document (extension: psd), or Adobe Photoshop Big Document (extension: psb) format. 

[PRO/EX]

 Images in CMYK format are converted into RGB format when opened. To display images in the CMYK color 

space, turn on [Preview] from the [View] menu > [Color profile]. [PRO/EX]

 To save an open image in CMYK format, go to the [File] menu > [Save Duplicate]/[Export (Single Layer)]/

[Export (Single Layer)], then specify .tif (TIFF), .jpg (JPEG), .psd (Photoshop Document), or .psb (Photoshop 

Big Document) formats and select [CMYK color] as the expression color. For details on these settings, see 

"[Export settings] Dialog Box" and "[Export settings] Dialog Box (for Photoshop Document and Photoshop 

Big Document)". [PRO/EX]

 To open a page file in EX, select the management file (cmc) or page file (extension: clip) in the [Open] dialog 

box. For details, see "Opening a Multi-Page File".When you open an ibisPaint work file (extension: ipv) in Clip 

Studio Paint, the canvas size, resolution, layer information, and title are kept. However, tone layers may appear 

differently to how they are displayed in ibisPaint.
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Importing IllustStudio/ComicStudio Documents [Windows/macOS] [PRO/EX]
Clip Studio Paint supports the following IllustStudio document and ComicStudio page file layers. Some layers can be imported but not edited.

IllustStudio/ComicStudio

layer
Clip Studio Paint layer Remarks

Raster layer (1 bit)
Raster Layer

(Monochrome (Black))

Raster layer (2 bits)
Raster Layer

(Monochrome (Black and White))

Raster layer (8 bits) 
Raster Layer

(Gray (Only Black)) 

If [Tonization] or [Pseudo tone] is set for 

[Color reduction method] in ComicStudio, the 

layer will be imported with [Tone] on the 

[Layer Property] palette turned on.

Raster layer (32 bits) Raster layer (color)

Vector layer (2 bits)
Vector layer

(Monochrome (Black and White))

The shape of the image may change when 

imported.

To prevent shapes from changing, go to [Pref-

erences] > [File] and turn on [Rasterize vec-

tor].
Vector layer (32 bits) Vector layer (color)

Base Layer Raster Layer

Reference layer Reference layer

Text layer Text layer

If text is edited in Clip Studio Paint, it is 

replaced with Clip Studio Paint's text. 

Furthermore, the following text layer settings 

will not be maintained.

 [Edge]

 [Text/Background color]

 [TateChuYoko (Horizontal in Vertical)]

 Options

In addition to those listed above, the text may 

be substantially different due to differences in 

text specifications and so on.

Balloon layer

(Ruler balloon)

Balloon layer

(Including balloon and text)

In the cases below, the balloon is imported as a 

balloon layer and the text is imported as a text 

layer:

 The color of the balloon line is not black

 The color of the balloon fill is not white

 The balloon is inside a text layer

Balloon layer

(Raster balloon)

 Image material layer (Balloon)

 Text layer (Text)

Patterned tone layer Image material layer

[Normal] tone Fill layer
[Tone] on the [Layer Property] palette is 

turned on.
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[Gradient] tone Gradient layer
[Tone] on the [Layer Property] palette is 

turned on.

[Background] tone Image material layer
[Tone] on the [Layer Property] palette is 

turned on.

Frame folder Frame border folder

In the cases below, a raster layer will be added 

immediately above the frame border folder, 

and the border drawn there.

 [Rasterize vector] is enabled in the [Pref-

erences] dialog box

When

 When the frame is double-lined

If the border is outside the red line indicating 

the frame range, the [Frame folder] will be 

duplicated to handle the frame range as one 

frame border.

Layer folder Layer folder

3D workspace folder Layer folder 3D material cannot be edited.

3D preview layer Raster layer 3D material cannot be edited.

Clipping folder Layer folder + Clip to layer below

Clip to Layer Below Clip to Layer Below

Filter layer (Brightness/Contrast)
Tonal Correction layer (Brightness/

Contrast)

Filter layer (Tone curve) Tonal Correction layer (Tone curve)

Filter layer (Level correction)
Tonal Correction layer (Level correc-

tion)

Filter layer (Inverse)/

Inverse layer

Tonal Correction layer (Reverse gradi-

ent) 

Filter layer (Mask (Whole area hid-

den))
Layer mask

Filter layer (Mask (Whole area dis-

played))/Mask layer
Layer mask

Filter layer (Gradient map) Correction layer (Gradient map)

Filter layer (Hue/Saturation/Luminos-

ity)

Tonal Correction layer (Hue/Satura-

tion/Luminosity)

Filter layer (Texture) Image material layer + Overlay texture

Filter layer (Color balance) Tonal Correction layer (Color balance)

Saturated line layer Raster layer Saturated lines cannot be edited.

Stream line layer Raster layer Stream lines cannot be edited.

IllustStudio/ComicStudio

layer
Clip Studio Paint layer Remarks
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In DEBUT
This section covers some important points when importing files created by PRO/EX versions in DEBUT.

Layers imported as uneditable layers

In DEBUT, the following layers are imported as uneditable layers.

 Gray/monochrome raster layer

 Vector layer

 Frame border folder

 Balloon layer

 Fill layer

 Gradient layer

 Selection layer

 Tonal Correction layer

 Layer including ruler

 Layer with [Edge] set on the [Layer Property] palette

 Layer with [Tone] set on the [Layer Property] palette

 Layer with [Expression color (preview)] displayed in [Expression color] on the [Layer Property] palette

Canvases imported as uneditable canvases

In DEBUT, you cannot edit the canvas if any of the following layers or canvases are imported.

Vanishing Point Layer Raster layer Vanishing point cannot be edited.

Sub ruler layer Deleted
When there are drawings on the ruler, the ruler 

is converted into a raster layer.

Ruler layer Deleted

Selection layer (1 bit) Selection layer

Selection layer (8 bits) Selection layer

Paper layer Paper layer

Guide layer Deleted

Grid layer Deleted

Crop mark/Default border layer Crop mark/Default border Not displayed on the [Layer] palette.

Border ruler layer Raster layer (gray)

 When you import an ComicStudio page file, a white paper layer will be added.

 Content made with ComicStudio's [Work] menu > [Edit Memo] will not be applied.

 When text entered in the Story Editor of ComicStudio EX is shown in the Story Editor of Clip Studio Paint EX, 

the text order may be changed.

IllustStudio/ComicStudio

layer
Clip Studio Paint layer Remarks
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 Tonal Correction layer

 The expression color of the canvas is [Monochrome]

 The timeline has more than 25 frames

 A negative number is set as the start frame of the timeline

Other points to consider

 You can edit text layers and image material layers regardless of the expression color.

 In DEBUT, you cannot use the layer color or draft layers options, but layers with these settings can be edited.

 Crop marks, default borders, and grids will not be displayed.

 Canvases larger than 10000 x 10000 pixels cannot be imported.
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Recent
Displays a list of recently used files. Select a file to open and edit.

Close
Select the [File] menu > [Close] to close the current file.

Save
Select the [File] menu > [Save] to overwrite and save the current file.

When saving for the first time, a dialog box will appear to specify the file name and save location. If you are using a Smartphone, it is saved in 

the Clip Studio [Documents] folder.

You can save files in the following formats: CLIP STUDIO FORMAT (extension: clip), CLIP STUDIO PAINT format (extension: lip), BMP, 

JPEG, PNG, TIFF, Targa, Adobe Photoshop Document (extension: psd) and Adobe Photoshop Big Document (extension: psb).

 Clip Studio Paint format files (extension: lip) can be saved in Ver.1.5.0 and later without changing the exten-

sion. However, these files cannot be opened in versions earlier than 1.5.0.

 Files saved in CLIP STUDIO FORMAT (extension: clip) cannot be opened in Clip Studio Paint Ver.1.5.0 or ear-

lier.

 Work created as ibisPaint work files (extension: ipv) cannot be overwritten. You can save these as a new file in 

CLIP STUDIO FORMAT (extension: clip).
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Save as
Selecting [File] menu > [Save as] saves the file as a new file under a different name.

You can save files in the following formats: CLIP STUDIO FORMAT (extension: clip), management file (extension: cmc), BMP, JPEG, PNG, 

TIFF, Targa, Adobe Photoshop Document (extension: psd) and Adobe Photoshop Big Document (extension: psb).

For multi-page works, the management file can be saved under a different name and the entire work can be saved in a different folder.

Display the [Page Manager] window and click [Save as] to display the [Create story folder] dialog. Specify the save folder, enter the folder 

name (management file name) and click [OK] to save a duplicate of the work in a different folder.

[Create story folder] Dialog Box

(1) Location to create story folder

Specifies the location where the management folder will be created. Click [Browse] to specify the location.

(2) Management folder

Enter a name for the management folder.

(3) Management file

Displays the management file name (extension: cmc).

Files saved in CLIP STUDIO FORMAT (extension: clip) cannot be opened in Clip Studio Paint Ver.1.5.0 or earlier.

The [Location to create story folder] cannot be changed when using iPad iOS12 or earlier.

 Select the [File] menu > [Export (Single Layer)] to save in BMP, JPEG, PNG, TIFF or Targa. This allows you to 

set whether or not to output the [Draft] layer, as well as the size settings and scaling process. For details, see 

"Export (Single Layer)".

 If a multi-page work contains files in CLIP STUDIO PAINT format (extension: lip), those files are saved in CLIP 

STUDIO FORMAT (format: clip) Files saved in CLIP STUDIO FORMAT (extension: clip) cannot be opened in 

Clip Studio Paint Ver.1.5.0 or earlier.
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Save Duplicate
Save the data of the current canvas as a duplicate in a different file format.

You can save files in the following formats: CLIP STUDIO FORMAT (extension: clip), BMP, JPEG, PNG, TIFF, Targa, Adobe Photoshop Doc-

ument (extension: psd) and Adobe Photoshop Big Document (extension: psb).

For Adobe Photoshop Document (extension: psd) and Adobe Photoshop Big Document (extension: psb), you can set expression color and ICC 

profile embedding. For details on these dialog box settings, see "[Export settings] Dialog Box (for Photoshop Document and Photoshop Big 

Document)".

[Export settings] Dialog Box (for Photoshop Document and Photoshop Big Document)

(1) Output image [PRO/EX]

When exporting images, you can select whether to include the drafts, crop marks, default border, text, story information, folio, camera 

paths, and safety margins. The checked items will be exported.

(2) Expression color

Set the expression color of the image to output. You can select from [Gray], [RGB color] and [CMYK color (PRO/EX)].

(3) Advanced settings of color [PRO/EX]

Opens the [Advanced settings of color] dialog box. In addition to crop marks, default border, and safety margins, you can also set the color 

for exporting the camera and transformed camera paths.

For details on the [Advanced settings of color] dialog box, see "[Advanced settings of color] Dialog Box [PRO/EX]".

(4) Embed ICC profile [PRO/EX]

Turn this on to embed the ICC profile when exporting the file.

Files saved in CLIP STUDIO FORMAT (extension: clip) cannot be opened in Clip Studio Paint Ver.1.5.0 or earlier.

In DEBUT, [CMYK color] is not available.

 In the [Preferences] dialog box, you can set default values for the color profile, rendering intent, used library, 

etc. for exporting in [RGB] or [CMYK]. For details on these settings, see "Color conversion [PRO/EX]".

 In the [View] menu > [Color profile] > [Preview settings], you can set the color profile, rendering intent, etc. for 

exporting in [RGB] or [CMYK]. For details on these settings, see "Preview Settings".
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(5) OK

Applies the settings and closes the [Export settings] dialog box.

(6) Cancel

Cancels the settings and closes the [Export settings] dialog box.

[Advanced settings of color] Dialog Box [PRO/EX]
In addition to crop marks, default border, and safety margins, you can also set the color for exporting the camera and transformed camera paths.

(1) Crop marks/Default border/Safety margins

Set the color of crop marks, default border, and safety margins in exported files.

(2) Camera path

You can choose the color of the camera path when exporting a file.

(3) Draw with opacity

Set the opacity of the layer for exporting the camera path. When turned on, the opacity of the layer is set to 100%. When turned off, the 

layer opacity will be as set under [Preferences] > [Camera path/Camera].

Export in displayed colors 

 The color of crop marks and the default border will be as set in [Preferences] > [Ruler/

Unit].

 The color of the safety margin can be set under [Preferences] > [Ruler/Unit] > [Safety mar-

gin color].

Export in cyan Crop marks, default border, and safety margins will be exported in cyan.

Export in black Crop marks, default border, and safety margins will be exported in black.

Export in displayed colors
The color of the camera or transformed camera paths can be exported according to the settings in 

[Preferences] > [Camera path/Camera].

Export field guides in differ-

ent colors

The color of the camera or transformed camera paths is set to different colors for each frame. The 

reference color is the [Display color] set under [Preferences] > [Camera path/Camera]. Even if 

[Display in different colors] is turned off in [Preferences] > [Camera path/Camera], the colors 

will be exported in different colors.

Export in black The camera or transformed camera paths will be exported in black.
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Revert
Discards edits made to the canvas and restores it to the last saved state.

A message will appear when you select this command. Click [Yes] to discard the changes and reload the saved canvas.

Export (Single Layer)
Exports all layers of the current canvas as a single flattened image.

You can export in the following file formats: BMP, JPEG, PNG, TIFF, Targa, Adobe Photoshop Document (extension: psd) and Adobe Photo-

shop Big Document (extension: psb).

 You can set whether or not to export draft layers, as well as the size settings and scaling process.

 For TIFF, JPEG, Adobe Photoshop Document (extension: psd), and Adobe Photoshop Big Document (extension: psb) formats, you can set 

ICC profile embedding.

 In EX, all pages in the work can be exported together by selecting the [Page Manager] window. For information on how to export pages 

together, see "Batch export".

[Export settings] Dialog Box

This item is not available immediately after saving the canvas.

[Embed ICC profile] and [Advanced settings of color] are not available in DEBUT.

psdJPEG
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(1) Preview rendering result on output

When turned on, the [Export preview] dialog box will when exporting.

(2) Quality

When exporting in JPEG, you can set the image quality. The larger the value, the higher the image quality. This option does not appear for 

save formats other than JPEG.

(3) Output as [Background]

When the saved format is Adobe Photoshop document (extension: psd) or Adobe Photoshop big document (extension: psb) and this fea-

ture is on, the Photoshop background layer can be merged and saved. If the saved format is not psd or psb, this setting is not displayed.

(4) Output image [PRO/EX]

When exporting images, you can select whether to include the drafts, crop marks, default border, text, story information, folio, camera 

paths, and safety margins. The checked items will be exported.

With EX, you can specify the image area to be exported in [Export range]. The available options are: [Full page], [To offset of crop mark], 

[To inside of crop mark] and [Selection].

(5) Expression color

Set the expression color of the image to output. You can select from [Auto detect appropriate color depth], [Duotone (Threshold)], [Duo-

tone (Toning)], [Gray] and [RGB color].

For TIFF, JPEG, Adobe Photoshop Document (extension: psd), and Adobe Photoshop Big Document (extension: psb) formats, you can set 

ICC profile embedding. 

Click [Advanced settings of color] to open the dialog box. In the dialog box, you can set the color for crop marks, default border, and the 

default frequency of screentones. For details on the [Advanced settings of color] dialog box, refer to "[Advanced settings of color] Dialog 

Box [PRO/EX]".

For details on the [Export preview] dialog box, see "[Export preview] Dialog Box".

[Selection] exports a rectangular image with the width and height of the current selection area.

 The [Embed ICC profile] option does not appear when saving in BMP, PNG or Targa.

 [CMYK] is available when exporting an image in TIFF (extension: tif), JPEG (extension: jpg), Adobe Photoshop 

Document (extension: psd) or Adobe Photoshop Big Document (extension: psb) format. [PRO/EX]

 In the [Preferences] dialog box, you can set default values for the color profile, rendering intent, and library for 

exporting in [RGB] or [CMYK]. For details on these settings, see "Color conversion [PRO/EX]". [PRO/EX]

 In the [View] menu > [Color profile] > [Preview settings], you can set the color profile, and rendering intent for 

exporting in [RGB] or [CMYK]. For details on these settings, see "Preview Settings". [PRO/EX]

 [Auto detect appropriate color depth] is determined based on the expression color of each layer.

 [Duotone (Threshold)] sets a brightness of 50% as the threshold and outputs in binarized form.

 [Duotone (Toning)] exports in screentones according to the default frequency of the canvas.
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(6) Output size

You can specify the size of the file to output.

(7) Process when scaling [PRO/EX]

Specify the process for enlarging or reducing the image for exporting. You can select from [For illustration] and [For comic].

When you select [For comic], you can set the image quality if you export specifying [Rasterize]. You can select from [Fast] or [Prefer 

quality]. When [For illustration] is selected, [Prefer quality] is always used for exporting.

(8) OK

Applies the settings and opens the [Export preview] dialog box. For details on the [Export preview] dialog box, see "[Export preview] Dia-

log Box".

(9) Cancel

Cancels the settings and closes the [Export settings] dialog box.

Scale ratio from original data Specify the size of the image to export as a ratio of the original data.

Specify output size
Specify the size of the image to export with width and height parameters.

You can select a unit from centimeters, millimeters, inches, pixels, or points.

Specify resolution
Specify the size of the image to export by specifying the resolution. The resolution can be 

specified as a value between 72dpi and 1200dpi.

If quality is desired when exporting in a reduced size, we recommend configuring [Prefer quality] for [Rasterize].
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[Export preview] Dialog Box
Click [OK] in the [Export settings] dialog box to display the [Export preview] dialog box. This shows a preview of the exported image. When 

exporting in JPEG format, you can set the quality of the image while checking the preview.

(1) Image preview

This shows a preview of the exported image. You can drag the [Image preview] to adjust the display position of the previewed image.

(2) Scale up/down slider

By dragging the slider, you can adjust the scale of the [Image preview]. Dragging to the right scales up the image while dragging to the left 

scales down the image. You can also click the numeric value to directly enter the scale.

(3) Zoom out

Click to scale down the image preview.

(4) Zoom in

Click to scale up the image preview.

(5) 100%

Click to display the image preview at 100%.

(6) Fit to navigator

Click to display the image preview to fit to the window size. When the size of the [Image preview] window is adjusted, the image preview 

will change size accordingly.

(7) Fit to Screen

Click to make the image preview fill the window size. When the size of the [Image preview] window is adjusted, the image preview will 

not change size.

The [Export preview] dialog box does not appear if [Preview rendering result on output] is turned off in the [Export 

settings] dialog box.
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(8) Print size

Clicking it shows the Print size in the [Image preview].

A message is displayed when executing this command if a display resolution is not set. Clicking [OK] shows the [Settings of display reso-

lution] dialog, where you can set a display resolution. For details on the [Settings of display resolution] dialog box, see "Display resolu-

tion."

(9) Quality

When exporting in JPEG, you can set the image quality. The larger the value, the higher the image quality. This option does not appear for 

save formats other than JPEG.

The [Quality] setting is reflected in the image preview.

(10)File size

When exporting in JPEG, the size of the file to export is displayed. This option does not appear for save formats other than JPEG.

[Advanced settings of color] Dialog Box [PRO/EX]
In the [Export settings] dialog box, click [Advanced settings of color] to open the dialog box. In addition to crop marks, default border, and 

safety margins, you can also set the color for exporting the camera and transformed camera paths. You can also set the frequency for tones and 

effects.

(1) Crop marks/Default border/Safety margins

You can the export color for crop marks, default border, and safety margins.

(2) Frequency

Set the frequency for exporting an image.

Export in displayed colors 

 The color of crop marks and the default border will be as set in [Preferences] > [Ruler/Unit].

 The color of the safety margin can be set under [Preferences] > [Ruler/Unit] > [Safety margin 

color].

Export in cyan Crop marks, default border, and safety margins will be exported in cyan.

Export in black Crop marks, default border, and safety margins will be exported in black.

Depend on export scale The frequency adjusts depending on the output size specified in the [Export settings] dialog box.

Follow layer settings The frequency will be as set in the original image.
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(3) Enable tone effect for layer

When turned on, the content set in the [Layer Property] palette > [Tone] will be reflected when exporting the image.

(4) Camera path

You can choose the color of the camera path when exporting a file.

(5) Draw with opacity

Set the opacity of the camera path. When turned on, the camera path is exported at 100% opacity. When turned off, the opacity of the cam-

era path will be as set under [Preferences] > [Camera path/Camera].

Flatten and save to device storage [Android/Chromebook]
Images edited in Clip Studio Paint can be exported to the device's storage. Here you can save in BMP, JPEG, PNG and TIFF file formats.

From the [File] menu, click [Flatten and save to device storage] and select the file format you want to save.

In the [Flatten and save to device storage] dialog, enter a file name and tap [OK].

An Export Settings dialog box will appear according to the selected file format. Set each item and tap [OK].

When the Export Preview dialog appears, check its contents and click [OK].

The shows the OS file management screen. Select the save folder, then tap [Save].

Enable Auto Save [Windows/macOS]
This appears when Clip Studio Paint is started by selecting [Synchronized Edit Mode] in Clip Studio MODELER.

Check menu items to reflect edited content from Clip Studio Paint in Clip Studio MODELER by automatically overwriting.

Export in displayed colors
The color of the camera or transformed camera paths will be exported according to the settings in 

[Preferences] > [Camera path/Camera].

Export field guides in differ-

ent colors

The color of the camera or transformed camera paths is set to different colors for each frame. The 

reference color is the [Display color] set under [Preferences] > [Camera path/Camera]. Even if 

[Display in different colors] is turned off in [Preferences] > [Camera path/Camera], the colors will 

be exported in different colors.

Export in black The color of the camera or transformed camera paths are set to black.

 This operation functions in the same way as [File] menu > [Export (Single Layer)]. For information on setting 

each dialog box, see "Export (Single Layer)".

 If you want to export files other than BMP, JPEG, PNG or TIFF to storage, see "Exporting files saved in Clip 

Studio Paint to storage". The same is true if you want to export with your editing layers intact.

 If auto save is disabled, you can reflect edited content in Clip Studio MODELER by selecting [Save] in the [File] 

menu.

 For instructions on starting Clip Studio Paint in [Synchronized edit mode] from Clip Studio MODELER, see the 

Clip Studio MODELER Instruction Manual.
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Export multiple pages [EX]
This allows you to save multi-page works created in Clip Studio Paint as one file. Works can be exported in general image formats, as a fanzine 

printing file, or in e-book format.

Serif text in a work can also be exported together as a text file (extension: txt) by using [Batch export].

.pdf(PDF format)
Exports the work in a PDF format (extension: .pdf) from [File] > [Export multiple pages] > [.pdf (PDF format)].

The operation and settings are identical to [Batch export]. In the [Export PDF format] dialog box, enter the PDF title and set the compression 

method. Select [OK] to export the PDF file.

For details on [Batch export], see "Batch export".

Batch export
Opens the [Batch export] dialog box. In this dialog box, you can save multiple files at once by specifying the folder and the range of pages to 

save.

You can export multiple page Clip Studio Paint files in the following formats: BMP, JPEG, PNG, TIFF, Targa, Adobe Photoshop Document 

(extension: .psd), Adobe Photoshop Big Document (extension: .psb), and PDF (extension: .pdf) format.

Balloon layers and text layers in a work can also be batch exported as a text file (extension: .txt).

1 Select the [File] menu > [Export multiple pages] > [Batch export]. The [Batch export] dialog 
box will open.

2 Set the export location, file format, file name, and range of pages to export.

(1) When using Windows/macOS, click [Browse] and specify the [Export folder].

(2) Specify the file format.

(3) Enter a name for the file to export.

(4) Specify the range of pages to export in [Page range].

(5) Click [OK].
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3 The [Export settings] dialog box will open. Configure settings related to the file(s) to
export.

(1) Configure settings related to the file(s) to export.

(2) Click [OK].

4 The [Export settings] dialog box closes and the files are batch exported.

 If multiple consecutive pages are selected in the [Page Manager] window, the [Batch export] dialog box will 

appear with the pages selected in [Page range] set.

 The file name of each exported page file will be [Name] followed by a sequential number.

The [Export settings] dialog box for batch export is the same as the dialog box displayed for [File] menu > [Save 

Duplicate] / [Export (Single Layer)], but with some restricted functions.

 For details on the restrictions, see "Batch export specifications and restrictions".

 For details on how to set the [Export settings] dialog box, see "[Export settings] Dialog Box".

 The [Export settings] dialog box will open with the values set according to the basic settings of the work. The 

basic settings of the work can be checked and changed in the [Story] menu > [Change basic work settings]. 

For details, see "Change basic work settings".

When using an iPad or iPhone, the Files app is displayed after the Export Settings dialog box closes. Select the 

save folder, then tap [Save].
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[Batch export] Dialog Box

(1) Export folder [Windows/macOS]

Click [Browse] to specify the destination folder.

(2) File format

Specify the file format to export the images. You can export in the following formats: BMP, JPEG, PNG, TIFF, Targa, Adobe Photoshop 

Document (extension: psd) and Adobe Photoshop Big Document (extension: psb), PDF format (extension: pdf).

(3) Export (Single Layer)

When turned on, the layers will exported as a single flattened image.

(4) Write text to file

Text in balloon layers and text layers on exported pages are exported together as a text file (extension: txt).

(5) Name

Input a name for the file(s) to export.

[Export (Single Layer)] is available only when exporting in Adobe Photoshop Document (extension: psd) or Adobe 

Photoshop Big Document (extension: psb) format. When exporting in BMP, JPEG, PNG, TIFF or Targa, images are 

exported with the layers flattened.

 The name of the text file is the specified name, followed by "_export".

 Only visible text layers will be exported. Hidden layers will not be exported.

 Text added in draft layers is not exported if [Draft] is turned off in the [Export Settings] dialog box.

 The text is exported in the order in which it is displayed in the Story Editor. To change the order, edit the text in 

the Story Editor. For details, see "Move text".

The file name of each exported page file will be [Name] followed by a sequential number.
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(6) Page range

Specify the range of pages to export.

(7) Export spread separately

When turned on, two-page spreads are exported as two seperate pages.

Batch export specifications and restrictions
The following describes the specifications and restrictions when exporting images with [File] menu > [Export multiple pages] > [Batch export].

Restrictions

 Rendering results cannot be previewed.

 [Selection] cannot be set in [Export range] in the [Export Settings] dialog box.

Restrictions on Adobe Photoshop Document and Adobe Photoshop Big Document formats

The following restrictions apply if [Export (Single Layer)] is turned off in the [Batch export] dialog box when batch exporting in Photoshop 

Document (extension: psd) or Adobe Photoshop Big Document (extension: psb) format.

 You can export pages with layers intact, but you cannot choose the option [Export spread separately].

 In the [psd export settings] and [psb export settings] dialog box, the [Export range] setting is not available.

For details on how to set the [Export settings] dialog box, see "[Export settings] Dialog Box".
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3D Preview for Binding
Creates a preview of the work and opens the [3D Preview for Binding] dialog box. Select [3D Preview for Binding] see your work in a 3D pre-

view of its actual bound state.

3D Preview for Binding Dialog Box

(1) Preview window

This window shows the bound sample. Use the mouse to move through the bound preview.

(2) Saddle Stitch/Side Stitch Binding

Changes the binding of the bound sample.

 If [3D Preview for Binding] is performed more than once for the same work, preview data will only be output for 

the updated pages from the second time. This reduces the amount of time for the 3D preview to be created.

 The command is not available when [Webtoon] is selected from [New] > [Use of work]. Please select [Story] > 

[View] > [Page-by-page], and set [Binding point] and [Start page] before running the function.

Turn page
After opening the bound sample, move the cursor to the page you want to view and click to turn to that 

page.

Change angle Click and drag the bound sample.

Open/Close Double-click the bound sample. Performing this action restores the bound sample to the default size.

Zoom in Scroll upward with the mouse wheel.

Zoom out Scroll downward with the mouse wheel.
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(3) Zoom out

Zooms out of the bound sample.

(4) Zoom in

Zooms in on the bound sample.

(5) Zoom Reset

Restores the bound sample to the default size.

(6) Go back one page (Right binding: Go forward one page)

Turns a page in the bound sample. If right bound, the display moves to the next page. If left bound, the display moves to the previous page.

(7) Go forward one page (Right binding: Go back one page)

Turns a page in the bound sample. If right bound, the display moves to the previous page. If left bound, the display moves to the next page.

(8) Open/Close

Opens/closes the bound sample. Performing this action restores the bound sample to the default size.

(9) Number of pages

The number of the current page is displayed at the top. The total number of pages in the work is displayed at the bottom. You can click the 

number of the current page and enter a different page number to switch to that page.

(10)Close

Closes the 3D preview dialog box.

Export fanzine printing data
Exports the work as data to be published at a fanzine printing vendor. Select this command to open the [Export fanzine printing data] dialog 

box. Configure the settings in the [Export fanzine printing data] dialog box and click [OK] to export the fanzine printing data. You can check 

the final product by viewing a 3D preview before exporting.

 When using Windows/macOS, Clip Studio will start up, and the exported fanzine printing data can be checked by clicking [Check exported 

data] once the export is complete.

 When using an iPad or iPhone, the Files app is displayed after the [Export fanzine printing data] dialog box is set. Select the save folder, 

then tap [Save]. Open the selected folder to check the exported fanzine printing data.

 When using an Android or Chromebook, follow the on-screen instructions after completing the settings in the [Export fanzine printing 

data] dialog box. In the [File operation/Share] dialog box, check that the correct data is being exported. To open the exported data, go to the 

[File operation/Share] dialog box, select [Export], and export the data to the device. For details, see "Exporting files saved in Clip Studio 

Paint to storage".

 If there are any issues with the data, an error message will appear, and it may not be possible to export the fan-

zine printing data. For information on how to solve these issues, see "If an error message appears".

 If [Export fanzine printing data] is performed twice or more for the same work, the first data will be overwritten 

with the second data. Also, if files unrelated to the exported data have been added to the export destination 

folder, these files may be deleted.

 The data consists of an image file for each page (extension: psd) and a text file with the specifications for each 

page (extension: txt).

 If [Export fanzine printing data] is performed more than once for the same work, only the updated pages will be 

exported from the second time. This makes it quicker to export the fanzine printing data.

 The command is not available when [Webtoon] is selected from [New] > [Use of work]. Please select [Story] > 

[View] > [Page-by-page], and set [Binding point] and [Start page] before running the function.
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[Export fanzine printing data] dialog box

A. Binding (finish) size
Set the cropped border size for binding.

(1) Width

Sets the book width.

(2) Height

Sets the book height.

(3) Book size

Select a width and height from default sizes.

(4) Bleed width

If a printing vendor is selected in the [New] dialog or the [Change basic work settings] dialog, the bleed width recommended by the 

selected company is displayed automatically. If [General-purpose settings] is selected, a standard bleed width is set.

B. Resolution
You can set the resolution of the printing data. If a printing vendor is selected in the [New] dialog or the [Change basic work settings] dia-

log, you can select from resolutions recommended by the printing vendor.

(1) Color

Select the resolution to be used on pages where the basic expression color is [Color].

(2) Gray

Select the resolution to be used on pages where the basic expression color is [Gray].

The fanzine printing data is output in the size set in [Binding (finish) size]. Changing the [Binding (finish) size] in 

this dialog scales the images of the printing data.

 For details on the [New] dialog box, see "New dialog box (Printing of fanzine) [EX]".

 For details on the [Change basic work settings] dialog box, see "Change basic work settings".

 For details on the [New] dialog box, see "New dialog box (Printing of fanzine) [EX]".

 For details on the [Change basic work settings] dialog box, see "Change basic work settings".

A

B
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(3) Monochrome

Select the resolution to be used on pages where the basic expression color is [Monochrome].

C. Comment for printing vendor
If you have any instructions for the printing vendor, enter them here. The comment will be exported as a text file.

If an error message appears
If an error message appears when exporting fanzine printing data, try the following methods to resolve the issue.

 You may be able to confirm the page on which the error occurred by selecting the [Story] menu > [Binding pro-

cess] > [Show binding list]. For details, see "Show binding list".

 You can apply the same settings to multiple pages by selecting the [Story] menu > [Change basic page set-

tings]. For details, see "Change basic page settings".

Message Solution

Turn on the binding (finish) size and set the 

size for the cropped border.

This data cannot be exported as fanzine printing data. Use the [File] menu > [Export 

multiple pages] > [Batch export].

For details, see "Batch export".

The specified printing vendor recommends a 

bleed border of XX mm.

This appears if the bleed width differs from that specified by the printing place.

Click [Continue] and set the [Bleed width] specified by the printing vendor in the 

[Export fanzine printing data] dialog before exporting the data.

If the bleed width is wider than specified, the edges of the bleed area may be printed.

3.0 mm or 5.0 mm are generally used for bleed 

width.

This message may appear if the bleed width differs from that generally used. Open to 

the applicable page, click [Continue] and set the bleed width to 3mm or 5mm in the 

[Export fanzine printing data] dialog box, then export the data.

If the bleed width is wider than specified, the edges of the bleed area may be printed.

Set the number of pages as an even number 

between XX and XX.

This appears if the number of pages is below the minimum specified by the printing 

place, or if it is an odd number. Adjust the number of pages according to the specifica-

tions of the printing place.

For information on adding or deleting pages, see "Add Page" and "Delete Page".

Turn on folio or blind folio and set folio.

This appears if a folio or blind folio is not set. Select the [Story] menu > [Change basic 

work settings] and turn on [Folio] or [Blind folio].

For details on these settings, see "Change basic work settings".

Set the starting number of the folio to 1.

This appears if a number other than "1" is set as the start number of the folio.

Select the [Story] menu > [Change basic work settings] and set the start number of the 

folio to "1".

For details on these settings, see "Change basic work settings".

Turn on the setting of cover page and provide 

cover page.

This appears if a cover page has not been added to the work. Select the [Story] menu > 

[Change basic work settings] and add a cover page.

For details on these settings, see "Change basic work settings".

The following binding (finish) size is recom-

mended for the specified printing vendor.

The binding (finish) size you have set may not be handled by the printing vendor. Click 

[Continue] and set the [Binding (finish) size] specified by the printing vendor in the 

[Export fanzine printing data] dialog before exporting the data.

Either of the following is generally recom-

mended for the binding (finish) size.

The binding (finish) size differs from the size generally used for fanzines. Click [Con-

tinue] and set the [Binding (finish) size] specified by the printing vendor in the [Export 

fanzine printing data] dialog before exporting the data.
CLIP STUDIO PAINT Instruction Manual 97



Menus > File Menu > Export multiple pages [EX]
Open exporting destination of fanzine printing data (Windows/macOS)
Open work files of fanzine printing data in Clip Studio Paint.

This command opens the folder containing the data exported using [Export fanzine printing data].

A folio is generally required. Turn on the folio 

setting.

This appears if a folio or blind folio is not set. Select the [Story] menu > [Change basic 

work settings] and turn on [Folio] or [Blind folio]. 

For details on these settings, see "Change basic work settings".

Draft with the setting to be exported with 

color is included in main text.

This appears when the basic expression color of the body pages is set to [Color] or 

[Grey]. To print a comic in black and white, set the basic expression color to [Mono-

chrome].

Open to the applicable page and set the basic expression color to [Monochrome] in the 

[Story] menu > [Change basic page settings].

For details on how to set, see "Change basic page settings".

Multiple resolutions are set for single basic 

expression color. It is scaled up and down 

when exported, so moire or something may 

occur in tone. 

This appears if different resolutions are set for different pages with the same basic 

expression color.

To export the data in its original resolution, use the [File] menu > [Export multiple 

pages] > [Batch export]. For details, see "Batch export".

 This command cannot be used if data for the work has not been exported using [Export fanzine printing 

data].It also cannot be used if the exported data has been deleted or moved.

 The command is not available when [Webtoon] is selected from [New] > [Use of work]. Please select [Story] > 

[View] > [Page-by-page], and set [Binding point] and [Start page] before running the function.

Message Solution
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Exporting in Kindle format [Windows]
Works created in Clip Studio Paint can be exported in Kindle format.

1 Select the [File] menu > [Export multiple pages] > [Export in Kindle format].

2 In the [Export in Kindle format] dialog box, enter information such as [Title] and [Author]
and click [OK].

3 The following message will appear when the export is complete.

 Select [Proceed to Kindle Direct Publishing (KDP)] to open your web browser and connect to the Kindle Direct Publishing web page. 

The exported data can be published to the Amazon Kindle store from here.

 Select [Check exported data] to launch Clip Studio and check the exported data.

If [Export in Kindle format] is performed twice or more for the same work, the first data is overwritten with the sec-

ond data. Also, if files unrelated to the exported data have been added to the export destination folder, these files 

may be deleted.

The command is not available when [Webtoon] is selected from [New] > [Use of work]. Please select [Story] > 

[View] > [Page-by-page], and set [Binding point] and [Start page] before running the function.

 For information on how to publish the exported data to the Amazon Kindle store, see the Kindle Direct Pub-

lishing Web page.

 You can view the folder containing the data exported in Kindle Format from the [File] menu > [Export multiple 

pages] > [Open export destination of Kindle format].

 The exported Kindle format data can be checked in Clip Studio. For details, see the Help section in Clip Studio.

 If the exported data needs to be adjusted, select the [File] menu > [Export multiple pages] > [Export settings 

for Kindle format], adjust settings such as the size and quality of the images to be exported, then export the 

data again. For details, see "Export settings for Kindle format [Windows]".
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[Export in Kindle format] Dialog Box
Set up information to be included as metadata in Kindle format.

(1) Title

Enter the e-book title to be registered as metadata in Kindle format. This is a required item.

(2) Title (sort key)

When using Japanese kanji characters, you can enter the pronunciation in full-width katakana characters for sorting by title.  

(3) Author

Enter the e-book author to be registered as metadata in Kindle format.

(4) Author (sort key)

When using Japanese kanji characters, you can enter the pronunciation in full-width katakana characters for sorting by author name.  

(5) Advanced Settings

Opens the [Advanced Settings for Kindle] dialog box. Here you can edit detailed information such as [Publisher] and [Date modified]. For 

details, see "[Advanced settings for Kindle] Dialog Box".

[Advanced settings for Kindle] Dialog Box
Configure settings for the Kindle format data, such as items to be registered as metadata and whether a back cover page is included.

(1) Publisher

Enter the publisher to be registered as metadata in Kindle format.

(2) Publishing company (sort key)

When using Japanese kanji characters, you can enter the pronunciation in full-width katakana characters for sorting by publisher name.  

If no changes need to be made in the [Advanced Settings for Kindle] dialog box, you can use the settings that 

appear.
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(3) Date modified

Enter the date of update (creation date) of the book to be registered as metadata in Kindle format. The date of exporting the Kindle format 

data will be pre-entered.

(4) Value of identifier

Displays the book ID to be registered as metadata in Kindle format.

(5) Export back cover page

Turn this on to export the back cover page when exporting a work with a cover page and back cover page.

(6) Insert a blank page so the last pages will be a two-page spread.

If the last page is a single page, turn this on to insert a blank page to display as a two-page spread.

Preview of exported Kindle data [Windows]
Previews the file as exported in Kindle format using the Kindle Preview Tool.

Select an item to start the Kindle Preview Tool and preview how the work will look when read on a Kindle.

If the Kindle Preview Tool is not installed on your device, installation instructions will appear. Install the Kindle Preview Tool by following the 

on-screen instructions.

Export settings for Kindle format [Windows]
Here you can configure the settings for exporting in Kindle format. Select this command to open the [Export settings for Kindle format] dialog 

box. After editing the settings, click [OK] to save the settings.

[Export settings for Kindle format] Dialog Box

(1) Output size

Specify the output size of the image. A larger value is better for displaying on high-resolution devices, but also increases the volume of 

data.

(2) Devices

Displays the Kindle devices that support the selected output size.

(3) Quality

Set the quality of the data to be exported in Kindle Format. A larger value increases the image quality, but also increases the volume of 

data.

(4) Do not make tone gray

Turn this on to export screentones when exporting in Kindle format. However, interference (moiré) may occur in screentone areas depend-

ing on the device that the work is viewed on.

 For details on how to use the Kindle Preview Tool, see the help section of the Kindle Preview Tool.

 The command is not available when [Webtoon] is selected from [New] > [Use of work]. Please select [Story] > 

[View] > [Page-by-page], and set [Binding point] and [Start page] before running the function.
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Open export destination of Kindle format [Windows]
In Clip Studio Paint, open the file that you want to open in Kindle format.

Click the [Open export destination of Kindle format] command to open the folder containing the data exported using [Export in Kindle format].

Export EPUB data
Works created in Clip Studio Paint can be exported as EPUB data.

.

1 Select the [File] menu > [Export multiple pages] > [Export EPUB data].

2 In the [Export EPUB data] dialog box, enter information such as [Title] and [Author] and
click [OK].

3 A message will appear when the export is complete.

 When using Windows/macOS, select [Check exported data] to launch CLIP STUDIO and check the exported data.

 When using an iPad or iPhone, the Files app is displayed after the confirm message is displayed. Select the save folder, then tap 

[Save]. Open the selected folder to check the exported data.

 When using an Android or Chromebook, follow the on-screen instructions after completing the settings in the [Export fanzine print-

ing data] dialog box. In the [File operation/Share] dialog box, check that the correct data is being exported. To open the exported data, 

go to the [File operation/Share] dialog box, select [Export], and export the data to the device. For details, see "Exporting files saved 

in Clip Studio Paint to storage".

 This command cannot be used if the work has not been exported using [Export in Kindle format]. It also can-

not be used if the exported data has been deleted or moved.

 The command is not available when [Webtoon] is selected from [New] > [Use of work]. Please select [Story] > 

[View] > [Page-by-page], and set [Binding point] and [Start page] before running the function.

If [Export EPUB data] is performed twice or more for the same work, the first data will be overwritten with the sec-

ond data. Also, if files unrelated to the exported data have been added to the export destination folder, these files 

may be deleted.

The command is not available when [Webtoon] is selected from [New] > [Use of work]. Please select [Story] > 

[View] > [Page-by-page], and set [Binding point] and [Start page] before running the function.
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[Export EPUB data] Dialog Box
Set information to be registered as metadata for the EPUB data.

(1) Title

Enter the e-book title to be registered as metadata for the EPUB data. This is a required item.

(2) Title (sort key)

Enter the sort key (reading of kanji characters) to be used when sorting e-books in title order.

(3) Author

Enter the e-book author to be registered as metadata for the EPUB data.

(4) Author (sort key)

Enter the sort key (reading of kanji characters) to be used when sorting e-books in author order.

(5) Advanced Settings

Opens the [EPUB advanced settings] dialog box. Here you can edit detailed information such as [Publisher] and [Date modified]. For 

details, see "[EPUB advanced settings] Dialog Box".

 When using a Windows/macOS device, you can view the folder containing the saved data from the [File] menu 

> [Export multiple pages] > [Open exporting destination of EPUB data].

 When using Windows/macOS, you can check the exported data in Clip Studio. For details, see the Help section 

in Clip Studio.

 If the exported data needs to be adjusted, select the [File] menu > [Export multiple pages] > [Export EPUB 

data], configure settings such as the size and quality of the images to be exported and export the data again. 

For details, see "Export settings for EPUB data".
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[EPUB advanced settings] Dialog Box
Configure settings for the EPUB data, such as items to be registered as metadata and whether a back cover page is included.

(1) Publisher

Enter the publisher to be registered as metadata for the EPUB data.

(2) Publishing company (sort key)

When using Japanese kanji characters, you can enter the pronunciation in full-width katakana characters for sorting by publisher name.  

(3) Date modified

Enter the date of update (creation date) of the book to be registered as metadata for the EPUB data. The date of exporting the EPUB data 

will be pre-entered.

(4) Value of identifier

Displays the book ID to be registered as metadata for the EPUB data.

(5) Export back cover page

Turn this on to export the back cover page when exporting a work with a cover page and back cover page.

(6) Insert a blank page so the last pages will be a two-page spread.

If the last page is a single page, turn this on to insert a blank page to display as a two-page spread.

(7) Export for Kindle format

Turn this on to optimize EPUB data when exporting in Kindle format.

If no changes need to be made in the [EPUB advanced settings] dialog box, use the displayed settings as they are.
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Export settings for EPUB data
Here you can configure the settings for exporting as EPUB data. Select this command to open the [Export settings for EPUB data] dialog box. 

After editing the settings, click [OK] to save the settings.

[Export settings for EPUB data] Dialog Box

(1) Output size

Select the output size of the image from the drop-down menu. A larger value is better for displaying on high-resolution devices, but also 

increases the volume of data.

(2) Width/Height

Set the output size of the image by entering values for the width and height. Enter the length of the shorter side in [Width] and the longer 

side in [Height].

(3) Quality

Set the quality of the data to be exported as EPUB data. A larger value increases the image quality, but also increases the volume of data.

(4) Do not make tone gray

Turn this on to export screentones when exporting as EPUB data. However, interference (moiré) may occur in screentone areas depending 

on the device that the work is viewed on.

Open export destination of EPUB data [Windows/macOS]
In Clip Studio Paint, open the file that you want to open as EPUB data.

This command opens the folder containing the data exported using [Export EPUB data].

 This command cannot be used if data for the work has not been exported using [Export EPUB data]. It also 

cannot be used if the exported data has been deleted or moved.

 The command is not available when [Webtoon] is selected from [New] > [Use of work]. Please select [Story] > 

[View] > [Page-by-page], and set [Binding point] and [Start page] before running the function.
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Export animation
Export an animation created in Clip Studio Paint as a video or image sequence.

Image sequence
You can export the frames of the current animation as an image sequence. They can be exported as BMP, JPEG, PNG, TIFF or Targa files.

Select this command to open the [Image sequence export settings] dialog box. Animation can be exported as multiple images with consecutive 

numbers according to the settings in the dialog box.

[Image sequence export settings] Dialog Box

A. Export to [Windows/macOS]
Specify the location to export the image sequence. Click [Browse] to specify the location for exporting the images.

 How to specify the save location differs when using an iPad/iPhone. The Files app is displayed after the [Image 

sequence export settings] dialog box is set. Select the save folder, then tap [Save]. Select the [File] menu > 

[Open] to display the exported file.

 When using an Android/Chromebook, the [File operation/Share] dialog box will be displayed after the [Image 

sequence settings] dialog box. To open the exported data, go to the [File operation/Share] dialog box, select 

[Export], and export the data to the device. For details, see "Exporting files saved in Clip Studio Paint to stor-

age".

A

B

C

D

E
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B. Settings of file name
Set the file names for each image sequence.

(1) File name

The information set in [Name], [Separator] and [Start number] is displayed in the preview. The file name corresponding to the start number 

of the image sequence is displayed.

(2) Name

Enter the file name for the image sequence.

(3) Separator

Enter a character string to be placed after the file names in the image sequence.

(4) Start number

Set the start number for the numbering.

C. Advanced Settings
Set the file format for the image sequence.

(1) Type

Set the file format for the image sequence. You can choose from PNG, BMP, JPEG, or Targa.

(2) Settings

When exporting in JPEG, you can set image quality. The larger the value, the higher the image quality. This option does not appear for save 

formats other than JPEG.

(3) Export drafts

Turn this on to include draft layers when exporting as an image.

(4) Export frames [PRO/EX]

Turning this on exports the overflow frame, output frame and title-safe area frame as an image.

 The overflow frame and output frame will exported in black.

 The title-safe area frame will be exported in gray.

 If a canvas has crop marks, default border, or safety margins, these can be exported in the image.
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D. Size Settings
You can set the export image size and drawing area.

(1) Drawing area [PRO/EX]

This allows you specify the area of the images to export. You can select from [Output frame], [Overflow frame], [Entire canvas], or [Selec-

tion area].

(2) Output image

Set the height and width of the exported images.

(3) Apply 2D camera effects

When active, images can be exported with the camera movement settings in the 2D camera folder.

E. Frame export
You can set which part of the timeline to export as an image, and the number of images to use per second.

(1) Frame export

You can designate the Start frame and the End frame for exporting.

This will export an image sequence of the specified frames up to the last frame specified.

(2) Frame rate

You can set the frame rate of animations created in Clip Studio Paint. Specify how many images to export for each second of animation.

Image quality may be lost if the image output size is larger than the size set for the drawing area.

[Selection area] exports rectangular images with the width and height of the current selection area.

In PRO and EX, the [Export range settings] are entered differently depending on the frame display method 

selected in [Playback time] in the [New] dialog box or the [New timeline] dialog box.
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Animated GIF
You can export the current animation as an animated GIF. If camera movement has been added with 2D camera folders, these effects will be 

exported in the animated GIF.

When using Windows/macOS
Select the [File] menu > [Export animation] > [Animated GIF] to open the dialog box for specifying the save location. After you specify a save 

location, the [Animated GIF output settings] dialog box will open. Set the export method and click [OK] to export as an animated GIF.

When using a Tablet/Smartphone
Select the [File] menu > [Export animation] > [Animated GIF] to open the dialog box to specify the file name. After you enter the file name, the 

[Animated GIF Export Settings] dialog box will open. Set the export method and click [OK] to export as an animated GIF.

[Animated GIF output settings] Dialog Box

(1) Width

Set the width of the animated GIF to be exported. The aspect ratio of the width and height is fixed. Changing the width will automatically 

change the height accordingly.

(2) Height

Set the height of the animated GIF to be exported. The aspect ratio of the width and height is fixed. Changing the height will automatically 

change the width accordingly.

(3) Export range

Specify the start frame and end frame of the range to be exported as an animated GIF.

The frames up to the specified end frame will be exported as an animated GIF.

(4) Frame rate

Set the frame rate of the animated GIF. The frame rate is the number of cels (images) per second. Changing this setting does not change the 

playback time of the animation.

(5) Loop count

Specify the number of times that playback is looped. You can specify a number of playback loops by selecting [Number of loops]. You can 

create an endless loop by selecting [Unlimited].

(6) Playback time

Displays the playback time of the animated GIF and the number of images in the file.

In PRO and EX, the [Export range] is entered differently depending on the frame display method selected in [Play-

back time] in the [New] dialog box or the [New timeline] dialog box.
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(7) Dithering

Turn this on to apply dithering to the exported GIF.

Animated sticker (APNG)
You can export the current animation as an animated PNG (APNG). If camera movement has been added with 2D camera folders, these effects 

will be exported in the animated sticker. APNG is a PNG format file that can be played as an animation. This file format is used for LINE Stick-

ers and for some browsers.

When using Windows/macOS
Select the [File] menu > [Export animation] > [Animated sticker (APNG)] to display the dialog box for specifying the save location. After you 

specify a save location, the [Animated sticker (APNG) export settings] dialog box will open. Adjust the export settings, then click [OK] to 

export the animation as an APNG.

When using a Tablet/Smartphone
Select the [File] menu > [Export animation] > [Animated sticker (APNG)] to display the dialog box to specify the file name. After you enter the 

file name, the [Animated sticker (APNG) export settings] dialog box will open. Adjust the export settings, then click [OK] to export the anima-

tion as an APNG.

[Animated Sticker (APNG) Export Settings] Dialog Box

(1) Width

Set the width of the animated sticker (APNG) to be exported. The aspect ratio of the width and height is fixed. Changing the width will 

automatically change the height accordingly.

(2) Height

Set the height of the animated sticker (APNG) to be exported. The aspect ratio of the width and height is fixed. Changing the height will 

automatically change the width accordingly.

(3) Export range

Specify the start frame and end frame of the range to be exported as an animated sticker (APNG).

The frames up to the specified end frame will be exported as an animated sticker (APNG).

Dithering is a method of artificially reducing the color ranges of images. It simulates a larger range of color 

expression with a small amount of colors, but may also increase the file size.

In PRO and EX, the [Export range] is entered differently depending on the frame display method selected in [Play-

back time] in the [New] dialog box or the [New timeline] dialog box.
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(4) Frame rate

Set the frame rate of the animated sticker (APNG). The frame rate is the number of cels (images) per second. Changing this setting does 

not change the playback time of the animation.

(5) Loop count

Specify the number of times that playback of the sticker (APNG) is looped. You can specify a number of playback loops by selecting 

[Number of loops]. You can create an endless loop by selecting [Unlimited].

(6) Playback time

Displays the playback time of the animated sticker (APNG) and the maximum number of images in the file.

(7) Delete blank spaces

This deletes all areas that are not drawn before exporting the sticker. In this case, the exported sticker will be smaller than the specified 

size.

(8) Color reduction

Turn this on to reduce the color range to 256 colors (transparent + 255 colors) before exporting the file. This reduces the file size, but may 

also result in lower display quality due to the reduced number of colors.

Movie
Exports animation created in Clip Studio Paint as a movie file.

When using macOS/tablets/smartphones
You can export animations as movie files. The export format will be mp4. macOS/iPad/iPhone devices are also able to export to QuickTime 

format.

Select the [File] menu > [Export animation] > [Movie] to open the dialog box for specifying the file name. After you enter the file name, the 

dialog box for export settings will appear.

[Movie export settings] Dialog Box

(1) Audio settings Select options for the sampling frequency, bit number, mono/stereo from the drop-down menu.

(2) Scaling settings Specify the image size of the movie to be exported.

(3) Apply 2D camera effects When active, videos can be exported with the camera movement set in the 2D camera folder.

(4) Frame rate You can set the frame rate when exporting a video.
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Windows version:
Exports an animation as a movie file. Files can be exported in AVI format (extension: avi) or MP4 format (extension: mp4).

Select the [File] menu > [Export animation] > [Movie] to open the dialog box for specifying the save location. After you specify a save loca-

tion, the [Movie export settings] dialog box will appear.

[Movie export settings] Dialog Box

When exporting a movie file in AVI format, a dialog for setting the compression method of the video will appear 

after the export settings are configured.

(1) Export version
Specify the version of the movie to be used. [Export as AVI1.0] or [Export as AVI2.0] can be 

selected. This is shown when exporting a movie file in AVI format. 

(2) Audio settings Select options for the sampling frequency, bit number, mono/stereo from the drop-down menu.

(3) Scaling settings Specify the image size of the movie to be exported.

(4) Apply 2D camera effects When active, videos can be exported with the camera movement set in the 2D camera folder.

(5) Frame rate You can set the frame rate when exporting a video.

(6) Enable transparency
Keeps the transparent areas of the canvas transparent when exporting. This is shown when 

exporting a movie file in AVI format. 

AVI

MP4
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Export animation cels [EX]
You can export the animation cels in the animation folder corresponding to the current animation as BMP, JPEG, PNG, TIFF or Targa images.

[Export animation cels] dialog box

(1) Export folder [Windows/macOS]

Click [Browse] to specify the destination folder.

(2) Export folder name

Enter a name for the file export folder.

(3) File name

Select a format for the file names. You can choose from the [Cel name], [Serial number], [Animation folder name + cel name], or [Anima-

tion folder name + number]. For [Cel name], the cel names in the animation folder will be used as the file names.

(4) File prefix

You can add text as a prefix to the file names.

(5) File format

Specify the file format to export the images. You can select a format from BMP, JPEG, PNG, TIFF and Targa.

(6) Export range

Specify the area of the images to be exported. You can select from [Overflow frame] and [Entire canvas].

(7) Export drafts within animation cels [EX]

Turning this on merges the draft layers when exporting images. If [Export for PaintMan] is turned on, the draft layers will be exported as 

shadow planes.

 Actions set up in 2D camera folders are not reflected in the exported file.

 How to specify the save location differs when using an iPad/iPhone. The Files app is displayed after the 

[Export animation cels] dialog box is set. Select the save folder, then tap [Save]. Select the [File] menu > 

[Open] to display the exported file.

 When using an Android/Chromebook, the [File operation/Share] dialog box will be displayed after the [Export 

animation cels] dialog box. To open the exported data, go to the [File operation/Share] dialog box, select 

[Export], and export the data to the device. For details, see "Exporting files saved in Clip Studio Paint to stor-

age".
CLIP STUDIO PAINT Instruction Manual 113



Menus > File Menu > Export animation
(8) Export frames

Turning this on exports the overflow frames as they currently appear.

(9) Export layers not in animation folders

Turning this on merges and exports layers that are not contained in animation folders.

(10)Export for PaintMan

Turn this on to process and export the image for PaintMan. As with binary tracing in TraceMan, the content is binarized and separated into 

main lines and color tracing lines (red, blue, green, etc.). This makes it possible to import the image with the content separated into a main 

plane and color plane when importing the image in PaintMan.

If you draw the fill colors for specified shadows on a draft layer, PaintMan can reduce the colors and import this content as a shadow 

plane.

(11) Line width

Allows you to set the line width when exporting for PaintMan. This item can be set when [Export for PaintMan] is turned on.

 Turning on [Export for PaintMan] will binarize the layers outside of the animation folder.

 This method cannot export selection layers, quick masks, or paper layers. It also cannot export any hidden 

layers.

0xFFFFFF

0xFF0000

0x00FF00

0x0000FF

0xFF80FF

0x80FFC0

0xFFFF00

0x8080FF

0xFF8000

0x00C0FF

0x80FFFF

0xFF8080
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(12)Preview

Click this to display the [Line width preview] dialog box. A preview appears to show how the image will look when it is exported for 

PaintMan. The [Line width] setting can also be changed while checking the preview. This item can be set when [Export for PaintMan] is 

turned on.

[Line width preview] Dialog Box

(1) Preview window Shows how the image will look when it is exported for PaintMan.

(2) Scale up/down slider
Drag the slider to adjust the scale of the preview window. You can also adjust the size by directly 

inputting a value.

(3) Zoom out Click to scale down the image in the preview window.

(4) Zoom in Click to scale up the image in the preview window.

(5) 100% Click to scale the image in the preview window to 100%.

(6) Fit to navigator
Click to display the image in the preview window fit to the dialog box size. When the size of the 

window is adjusted, the image preview will change size accordingly.

(7) Fit to Screen
Click to display the image in the preview window fit to the size of the current dialog box. When 

the size of the window is adjusted, the image preview will not change size.

(8) Print size

Click to display the image in the preview window in the print size.

If a display resolution has not been set, a message will appear to prompt you to set the display 

resolution. Clicking [OK] shows the [Settings of display resolution] dialog, where you can set a 

display resolution. For details on the [Settings of display resolution] dialog box, see "Display res-

olution".

(9) Line width
Allows you to set the line width for exporting. Changes to the line width are shown in the pre-

view.

(10) Preview target Opens a menu where you can select the cel to be displayed in the preview window.
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Exposure sheet [EX]
The contents of the [Timeline] palette of the current animation can be exported as timeline information. You can export in CSV format or the 

Digital Exposure Sheet Information format (extension: xdts).

Select this command to open a dialog box for specifying the save location of the file. In the dialog box, set the save location, file name, and file 

format, then export the exposure sheet information.

CSV Format
CSV files can be viewed in software such as word processors and spreadsheet software.

 The first line displays the parent folder name of the animation folder. If the parent folder is nested, the folder names are joined by "/".

 The second line displays the animation folder names.

 The third line onward display the frame name and information corresponding to each frame, such as the cel name and track label. Inbe-

tween track labels are marked as “○”, while reverse sheet track labels are marked as “●”.

Digital exposure sheet format
Digital exposure sheet format files (extension: xdts) can be opened with the Toei Animation Digital Exposure Sheet program.

 Layers arranged from bottom to top in the [Timeline] palette are aligned from left to right in the Toei Animation Digital Exposure Sheet.

 This format only exports information for displayed animation folders and 2D camera folders.

 Layers with animation folder names S0 to S9 are output as sound field data for the Toei Animation Digital Exposure Sheet.

 2D camera folder information is output as data in the "Camera" field of the Toei Animation Digital Exposure Sheet.

 The frame numbers start from "1" regardless of the display settings on the [Timeline] palette.

 Exported CSV files cannot be opened in RETAS STUDIO or Clip Studio Paint.
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OpenToonz Scene File [Windows/macOS] [EX]
You can export the current animation as an file for OpenToonz.

You can export the following information:

When exporting as an OpenToonz Scene File, draw the lines or color traces using the following five colors so that coloring is available in 

OpenToonz.

If fill color on draft layers indicates shadow specifications, use the following colors.

 OpenToonz must be installed on the same device as Clip Studio Paint in order to use the [OpenToonz Scene 

File] command. Please install OpenToonz before using this command.

 If the installation location of OpenToonz has changed, the [Specify OpenToonz Installation Path] dialog box 

will appear when the command is executed. Click [Browse] and specify the OpenToonz installation location.

 The animation folder cannot be imported into OpenToonz if the folder name contains the following symbols: \ / 

: * ? " < > |  

Settings in 2D camera folders will not be exported to the OpenToonz file.

Clip Studio Paint OpenToonz

Cel images in animation folders
 Toonz raster level file (extension: tlv)

 Palette file (extension: tpl)

[Timeline] palette information Scene file (extension: tnz)

 Anything drawn in white (0xFFFFFF) will become transparent.

 If other colors have been used in the image, the colors will be reduced to the above colors. However some 

lines may not be appear correctly

0xFF0000 (α255)

0x00FF00 (α255)

0x0000FF (α255)

0xFFFFFF (α0)

0x000000 (α255)

0xFF80FF

0x80FFC0

0xFFFF00

0x8080FF

0xFF8000

0x00C0FF

0x80FFFF

0xFF8080
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[OpenToonz Scene File Export Settings] Dialog Box

(1) Export folder

Click [Browse] to specify the destination folder.

(2) Export folder name

Enter a name for the file export folder.

(3) Enable anti-aliasing

Enables you to export to OpenToonz with anti-aliasing enabled on the drawing lines.

(4) Line width

You can adjust the line width for importing in OpenToonz. [Line width] cannot be set when [Enable anti-aliasing] is on.

When anti-aliasing is enabled, the image is exported with only high opacity colors remaining to prevent colors 

from mixing.
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(5) Preview

Click this to display the [Line width preview] dialog box. A preview appears to show how the image will look when it is exported for 

OpenToonz. The [Line width] setting can also be changed while checking the preview.

A [Preview] cannot be shown when [Enable anti-aliasing] is on.

[Line width preview] Dialog Box

(1) Preview window Shows how the image will look when it is exported for OpenToonz.

(2) Scale up/down slider
Drag the slider to adjust the scale of the preview window. You can also adjust the size by directly 

inputting a value.

(3) Zoom out Scales down the image in the preview window.

(4) Zoom in Scales up the image in the preview window.

(5) 100% Scales the image in the preview window to 100%.

(6) Fit to navigator
Fits the preview image to the window size. When the size of the window is adjusted, the image 

preview will change size accordingly.

(7) Fit to Screen
Click to display the image in the preview window fit to the size of the current dialog box. When 

the size of the window is adjusted, the image preview will not change size.

(8) Print size

Click to display the image in the preview window in the print size.

If a display resolution has not been set, a message will appear to prompt you to set the display 

resolution. Clicking [OK] shows the [Settings of display resolution] dialog, where you can set a 

display resolution. For details on the [Settings of display resolution] dialog box, see "Display res-

olution".

(9) Line width Set the line width for exporting. Changes to the line width will be shown in the preview window.

(10) Preview target Opens a menu where you can select the cel to be displayed in the preview window.
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Audio
Select the [File] menu > [Export animation] > [Audio] to export the content of audio layers within an animation file as an audio file in WAV 

format (extension: wav) or Ogg format (extension: ogg).

The audio file quality and range to be exported can be set in the [Audio export settings] dialog box.

 When using Windows/macOS, the [Audio export settings] dialog box is displayed after the file save location is specified.

 When using an iPad/iPhone, specify the file save location in the Files app after the [Audio export settings] dialog box is displayed.

 When using an Android/Chromebook, the [File operation/Share] dialog box will be displayed after the [Audio export settings] dialog box. 

To open the exported data, go to the [File operation/Share] dialog box, select [Export], and export the data to the device. For details, see 

"Exporting files saved in Clip Studio Paint to storage".

Audio export settings dialog box (for Wav format)

(1) Export frame settings

Set the export range for audio files by specifying the number of frames in the [Timeline] palette.

(2) Audio settings

Select options for the sampling frequency, bit number, mono/stereo from the drop-down menu.

Audio export settings dialog box (for Ogg format)

(1) Export frame settings

Set the export range for audio files by specifying the number of frames in the [Timeline] palette.

(2) Audio settings

Set the quality of the audio file. The larger the value, the higher the quality.

 Audio files cannot be exported if the timeline is inactive.

 Even if an audio layer is created, audio files cannot be exported if no audio file is loaded.

The available options depend on the device you are using.
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Export webtoon*
Select [File] > [Export webtoon] to export files in a webtoon-friendly format. You can select from .jpg or .png.

[Export webtoon] Dialog Box

(1) Export folder [Windows/macOS]

Click [Browse] to specify the destination folder.

(2) File format

Specify the file format to export the images. You can select from .jpg or .png.

(3) Name

Enter a name for the file(s) to export.

(4) Output size

You can specify the size of the file to output.

If [Export pages separately] or [Divide vertically] are selected in [File export settings], page numbers will be added 

after the file name.

Scale ratio from original 

data
Specify the size of the image to export as a ratio of the original data.

Specify width
Specify the size of the image to export by specifying the width. The size of the image will change 

according to the specified width.
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(5) Page range [EX]

You can specify what to export when working with projects with multiple files.

(6) File export settings

This allows you specify how to export the webtoon.

All pages All pages will be exported.

Specify page(s) Specify the range of pages to export.

Export pages separately 

[EX]
Exports each canvas of a multiple file project as an image.

Export as one continuous 

page [EX]
Exports each canvas of a multiple file project as one connected file.

Divide vertically

Divides the height by the specified px and exports as multiple separate images.

When editing a multi-page document with EX, flattens each canvas into one image, divides the 

height of the image according to the specified height, and exports as multiple separate images.

If the image cannot be divided evenly, the last image will be shorter.
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Export vectors [PRO/EX] 
Selecting a vector layer and then [File] menu > [Vector Export] will export the image on the layer as an SVG format file.

If you save in SVG format, you can load it into software that supports SVG format, such as Adobe Illustrator, while maintaining control point 

and other data.

If you save in SVG format, not all information is retained. This is also the case when you load the file into Clip Studio Paint again. The follow-

ing covers specifics of what is lost and retained.

 Pen pressure effects such as varying line thickness are lost.

 Many vector line parameters, such as brush tip shape are lost. Only [Brush Size], [Main Color], [Opacity], and [Sharp angles] are retained.

 Vector line color is retained, but the color set in [Layer Color] of the [Layer Properties] palette is not.

 If a layer mask has been set, the data is saved with the layer mask removed.

 When drawing a line with [Spline] or [Quadratic Bezier] selected under [Curve] in the [Tool Properties] palette, it is converted into a Cubic 

Bezier with the control points rearranged.

 Lines erased with the Eraser or Selection tool will disconnect the vector line removing vector paths and and control points.

In addition to the above, importing SVG format files exported by Clip Studio Paint into Illustrator will result in the following.

 When multiple layers are selected for export, each layer is converted to an Illustrator group. The group name will be the same as the layer 

name.

 The [Opacity] set under [Ink] in the [Sub Tool Details] palette will be converted to line opacity. Vector layer [Opacity] is converted to group 

opacity.

 If you draw with [Correction] set to [Sharp angles] in the [Sub Tool Details] palette, it will be converted to Illustrator as [Miter Join] under 

[Corner]. If you draw with [Sharp angles] turned off, it will be converted to [Round Caps] under [Corner] in Illustrator.

Timelapse
For details, see Clip Studio TIPS.

 Even if multiple vector layers are selected, they will be exported as a single file.

 You cannot export balloon layers, vector image material layers or frame border folders.

 [Vector Export] cannot be performed if the timeline is enabled.
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Import
You can import image files, pattern image files, and so on.

Image
Imports an image file to a new layer above the current layer.

1 Select the [File] menu > [Import] > [Image].

2 The [Open] dialog box opens. Select the image to import.

3 The image will be imported to a new image layer above the current layer.

4 You can change the transformation method in the [Tool Property] palette.

 If you import an image while there is a selection area on the canvas, the image will be imported to the selection 

area.

 You can also import an image file by dragging and dropping it to the [Layer] palette.

You can import multiple images at once by selecting multiple images in the [Open] dialog box. 

To draw on a layer with an imported image, the layer must be rasterized. For details, see "Rasterize".

For details on the setting method, see the descriptions of "Transformation settings" and "Image material" in "CLIP 

STUDIO PAINT Tool Setting Guide".
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5 Guide lines are shown on the Canvas. Use the handles and control points on the bounding
box to adjust the image’s orientation, size, and shape.

Scaling an image

If the transformation mode is set to [Scale/Rotate] in the [Tool Property] palette, you can scale an image by dragging the handles.

You can adjust the image afterwards.

(1) On the [Layer] palette, select the layer with the imported image.

(2) On the [Tool] palette, select the [Operation] tool.

(3) On the [Sub tool] palette, select [Object].

You can repeatedly tile imported images. For details, see the Tiling section of the CLIP STUDIO PAINT Tool Setting 

Guide.

 To transform only the vertical length or horizontal length, turn off [Keep aspect ratio] in the [Tool Property] pal-

ette.

 Even if [Keep aspect ratio] is turned off, you can scale without changing the original ratio by holding down 

Shift while dragging.

 Dragging while holding down Alt allows you to scale the image up and down the image from the center point.

Guide

Center
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Rotating an image

Dragging the rotation handle allows you to rotate the image.

(1) Move the center point (+).

(2) Drag the rotation handle to rotate the image around the center point.

Free transform an image

If the transformation mode is set to [Free Transform] in the [Tool Property] palette, you can freely transform the image by dragging the 

handles. You can use this when you want to create the appearance of depth.

 Hold down Shift while dragging the center point to move the center point horizontally, vertically, or along a 45-

degree diagonal angle.

 Hold down Shift while dragging the rotation handle to rotate in increments of 45 degrees.

 If the transformation mode is set to [Scale] in the [Tool Property] palette, the rotation handle will not show. 

This is shown when you select other items.

Hold down Shift while dragging a handle to move the handle according to the direction of the guideline.
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Other Transformations

You can set [Distort], [Skew], and [Perspective] from the [Tool Property] palette.

Moving an image

Drag the drawing area or the bounding box to move the image.

Pattern from Image
Imports an image file to a new layer above the current layer. The imported image will be tiled.

1 Select the [File] menu > [Import] > [Pattern from Image].

2 Opens the [Open] dialog box. Select the image to import.

Hold down Shift while dragging the drawing area or bounding box to move the image horizontally, vertically, or 

along a 45-degree diagonal angle.

If you import a pattern image while there is a selection area on the canvas, the image will be imported to the selec-

tion area.

You can import multiple images at once by selecting multiple images in the [Open] dialog box. 

SkewDistort Perspective
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3 A pattern image layer is created above the current layer and the image file is imported.
The imported image will be tiled.

4 You can change the transformation method in the [Tool Property] palette.

To draw on a layer with an imported pattern image, the layer must be rasterized. For details on rasterization, see 

"Rasterize".

For details on tool setting methods, see Transforming settings and Image material in the CLIP STUDIO PAINT Tool 

Setting Guide.
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5 A bounding box will appear around the image. Use the handles and control points on the
bounding box to adjust the image’s orientation, size, and shape.

Scaling a pattern image up/down

When the transformation mode in the [Tool Property] palette is set to [Scale/Rotate], you can scale the pattern image up or down by drag-

ging the handles.

You can adjust the image afterwards. To display the bounding box afterwards, follow the procedure below.

(1) On the [Layer] palette, select the layer with the pattern image.

(2) On the [Tool] palette, select the [Operation] tool.

(3) On the [Sub tool] palette, select [Object].

You can set how to tile an image in the [Tool Property] or [Sub Tool Detail] palette. For details, see the Tiling sec-

tion of the CLIP STUDIO PAINT Tool Setting Guide.

 To transform only the vertical length or horizontal length, turn off [Keep aspect ratio] in the [Tool Property] pal-

ette.

 Even if [Keep aspect ratio] is turned off, you can scale without changing the original ratio by holding down 

Shift while dragging.

 Dragging a handle while holding down Alt allows you to scale the image up and down from the center point. 

Guide
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Rotating a pattern image

Dragging the rotation handle allows you to rotate the pattern image.

(1) Move the center point (+).

(2) Drag the rotation handle to rotate the pattern image around the center point.

Free transforming a pattern image

When the transformation mode in the [Tool Property] palette is set to [Free Transform], you can transform a pattern image freely by drag-

ging the handles. You can use this when you want to create the appearance of depth.

 Hold down Shift while dragging the center point to move the center point horizontally, vertically, or along a 45-

degree diagonal angle.

 Hold down Shift while dragging the rotation handle to rotate in increments of 45 degrees.

 If the transformation mode is set to [Scale] in the [Tool Property] palette, the rotation handle will not show. 

This is shown when you select other items.

Hold down Shift while dragging a handle to move the handle according to the direction of the guideline.
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Other Transformations

You can set [Distort], [Skew], and [Perspective] from the [Tool Property] palette.

Moving a pattern image

Drag the drawing area or the bounding box to move the pattern image.

Hold down Shift while dragging the drawing area or bounding box to move the image horizontally, vertically, or 

along a 45-degree diagonal angle.

SkewDistort Perspective
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Create file object
Imports an image file as a file object layer. File object layers are layers used to load files such as images and movies into Clip Studio Paint.

Unlike standard layers, the file remains in its original state when referred to as a layer by Clip Studio Paint.

The file object layer cannot be edited in the working file, but it can be updated after being edited in the original file.

You can import the following image file formats: CLIP STUDIO FORMAT (extension: clip), BMP, JPEG, PNG, TIFF, Targa, Adobe Photoshop 

Document (extension: psd), and Adobe Photoshop Big Document format (extension: psb).

1 Select the [File] menu > [Import] > [Create file object].

2 In the dialog box, select the file to be added and click [Open].

3 The selected image file will be imported as a file object layer.

Movie
You can import movie files as file object layers. File object layers are layers used to load files such as images and movies into Clip Studio Paint.

Unlike standard layers, the file remains in its original state when linked as a layer by Clip Studio Paint.

The following movie files can be imported.

 In Windows version: AVI format (extension: avi), MP4 format (extension: mp4), QuickTime format (extension: mov)

 For macOS/iPad/iPhone: QuickTime format (extension: mov)/MP4 format (extension: mp4)

 For Android/Chromebook: MP4 format (extension: mp4)

1 Select the [File] menu > [Import] > [Movie].

2 In the dialog box, select the movie file to be added and click [Open].

3 File object layers are added on the [Layer] palette.
If a timeline is enabled, the movie tracks are added on the [Timeline] palette and the movie can be played.

 Files for file object layers are referred to by Clip Studio Paint files. The file object layer will not be displayed 

correctly if the save location of the reference file or the file object layer has changed. In this case, re-import 

the file to display it correctly. For information on importing, see "Change file of file object".

 When you import a Clip Studio Format file (extension: clip) in which a timeline is enabled, you can select the 

frame to be displayed in the [Tool Property] palette by selecting the file object layer with the [Object] tool.

It may not be possible to import movie files depending on the codec program installed in your operating environ-

ment.

 Files for file object layers are referred to by Clip Studio Paint files. The file object layer will not be displayed 

correctly if the save location of the reference file or the file object layer has changed. In this case, re-import 

the file to display it correctly. For information on importing, see "Change file of file object".

 You can set a frame to be shown on the [Tool Property] palette by selecting a file object layer created from a 

movie file using the [Object] tool.
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3D data
You can import a 3D file as a 3D layer.

The following 3D model file formats can be imported: CLIP STUDIO 3D Character format (extension: cs3c), CLIP STUDIO 3D Object format 

(extension: cs3o), CLIP STUDIO 3D Background format (extension: cs3s), fbx, 6kt, 6kh, lwo, lws, obj.

For information on importing, see "Importing 3D Materials".

Vector [PRO/EX] 
Select [File] menu > [Import] > [Vector] to import SVG format files exported from Adobe Illustrator, etc. as a vector layer.

SVG format files can be loaded into Clip Studio Paint while maintaining control points and other information.

Importing SVG format files created in Illustrator or other software into Clip Studio Paint, they will be converted as follows.

 For lines, the color, size, and opacity remain the same. However, SVG format files exported from Illustrator are converted to pixel units at 

72 dpi, so they may be greatly enlarged if the canvas has a high resolution.

 If [Corner] is set to [Miter Join] in Illustrator, it will be converted to sharp angled vector lines.

 Fills and clipping masks are converted into Outlines. Outline width is 1 pixel at 72 dpi. The higher the resolution of the canvas, the thicker 

the line will be. For fills, the outline will be the same color as the fill. For Clipping masks, the outline will be black.

 Text and raster images will not be reproduced in Clip Studio Paint.

 If you set a brush definition for a line, it may be split into multiple lines or fills. In Clip Studio Paint, broken line and fill settings are con-

verted to line drawings.

 A line containing a curve is converted into a Bezier curve. However, circles and ellipses are converted to spline curves.

 For information on how to edit 3D layers, see "Explanation: 3D Materials".

 3D materials compatible with Version 1.5 (extension: c2fc, c2fr) can be imported to the canvas by dragging 

and dropping the 3D material to the canvas.

 Ver. 1.5 compatible 3D materials (extension: c2fc, c2fr) and 6kt, 6kh cannot be imported on tablets/smart-

phones/Macs with Apple M1 chips.

 FBX files cannot be imported on Android/Macs with Apple M1 chips.

 When using an iPad with iOS12 or earlier, 3D data consisting of multiple files cannot be imported from outside 

the [ClipStudio] folder. Move files to the [ClipStudio] folder in the Files app to import them.
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Audio
Imports an audio file to a new audio layer (audio track). Clip Studio Paint can import 8-bit or 16-bit uncompressed WAV format files, MP3 

files, and Ogg files.

1 Select the frame from which to start playing the audio file in the [Timeline] palette.

2 Select the [File] menu > [Import] > [Audio]. In the dialog box that appears, select an audio
file.

3 An audio track will be created on the [Timeline] palette and the audio clip is created on the
selected frame.

 One vector layer is created per SVG file. If you select more than one file, a vector layer will be created for each 

file. The name of the vector layer is the same as the file name.

 SVG format files that do not contain lines or fills cannot be loaded into Clip Studio Paint.

 If you drag and drop an SVG file onto the canvas, it will load as a vector layer. SVG format files cannot be 

imported if there is no canvas opened.

Audio files cannot be imported if the animation timeline is not active.

 Audio clips can be edited like normal clips. For details on editing, see "Clip operations".

 For details on editing audio files, see "Keyframe settings".

 Audio files (extensions wav, mp3, ogg) can also be imported by dragging and dropping them on the document 

window.

 Imported audio files can be listened to in the [Item bank] palette. For details on the [Item bank] palette, see 

"Functions of Item bank Palette".

 Multiple audio files can be loaded into audio tracks (layers). However, to play multiple audio files in the same 

frame, you will need to create an audio track (layer) for each audio file to be played. For details on how to cre-

ate audio layers, see "Audio".
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Batch import [EX]
You can select multiple image files and import them to each page file as a layer.

You can import the following file formats: BMP, JPEG, PNG, TIFF, Targa, Adobe Photoshop Document (extension: psd), and Adobe Photoshop 

Big Document (extension: psb).

1 Create a page file for importing image files, or open an existing page file.

2 Select the [File] menu > [Import] > [Batch import].

3 The [Open file] dialog box will open. Specify the image to import.

 For details on how to create a page file, see "Creating a Multi-Page File".

 You can use [Batch import] when a single page file is open. In this case, the [Create story folder] dialog box 

will open after you specify the page from which to start importing. You will need to create a story folder in this 

dialog box.

Image files can be imported even when the number of image files exceeds the number of pages. The images will 

be added to new pages created automatically.
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4 The [Batch import] dialog box opens. The canvas will show a preview of the image on the
start page. Specify the orientation, size, and position of the image on the canvas and spec-
ify the start page in the dialog box.

(1) Use the controller and the handles to adjust the image orientation, size, and position.

(2) Specify the first page to import in [Start page] of the [Batch Import] dialog box.

(3) Click [OK].

 Drag the controller to rotate the image.

 Drag the handles to adjust the image size.

 Drag the image to adjust its position.

The [Create story folder] dialog box will open if images are batch imported when a single page file is open. You will 

need to create a story folder in this dialog box. For details, see "[Create story folder] Dialog Box".

Controller

Handle
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5 The images are imported to each page file as specified when the dialog box is closed.
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[Batch Import] Dialog Box

(1) Start page

Specify the page from which to start importing images.

 Select [Page 1] to import images from the first page.

 Select [Specified page] to import images from the page specified in [Page number].

(2) Import as raster layer

Imports the images as raster layers.

(3) Set as draft layer

Imports the images to draft layers.

[Create story folder] Dialog Box

(1) Location to create story folder

Specifies the location where the management folder will be created. Click [Browse] to specify the location.

(2) Management folder

Enter a name for the management folder.

(3) Management file

Displays the management file name (extension: cmc).

(4) View *

You can choose from the following views. The settings and [Story] window will change depending on the view.

(5) Binding point

Selects the direction in which to bind the book. Select either [Left binding] or [Right binding].

Page-by-page Pages will be optimized for works with page turns such as bound books.

Webtoon Pages will be optimized for vertical scrolling works such as webtoons.
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(6) Start page

Set which side to put the first page.

 When starting with a left page, select [From left].

 When starting with a right page, select [From right].

Pose Scanner (image) (Technology preview)
This reads a photo containing a figure and applies the figure's pose to a 3D drawing figure. This feature aims to create a rough estimation of the 

pose you want. Here we will explain how to simultaneously import photos and 3D drawing figures.

1 Select the [File] menu > [Import] > [Pose Scanner (image) (Technology preview)].

2 The [Open] dialog box opens. Select a photo with a pose you want to apply. In this exam-
ple, the following photo is selected.

 Generally, [Left binding] is used for Western-style comics, and [Right binding] is used for Japanese-style 

manga.

 You can set it up by selecting [Page-by-page] under [View].

You can set it up by selecting [Page-by-page] under [View].

 This function is a technology preview. You can try it out before its official release.

 When you use this feature, the image data is uploaded to the server, where the AI interprets the data and esti-

mates the pose. You need to be connected to the Internet to use this feature. For information on the image 

uploaded to the server and the generated data, see "About AI features".

Apply a pose to 3D drawing figures and 3D characters on a canvas. To apply a pose to a selected 3D drawing fig-

ure or a 3D character, select a command.

You can import the following file formats: BMP, JPEG, PNG, TIFF and Targa.
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3 Select the 3D drawing figure you wish to apply the pose to from the [Pose Scanner (image)
(Technology preview)] dialog box and click OK.

4 This applies the figure's pose in the photo to a 3D drawing figure and imports it to the can-
vas.

When selecting a 3D drawing figure or a 3D character on a canvas, this screen will not display. This applies a fig-

ure's pose from a photo to 3D characters or 3D drawing figures.

 If you choose an image with multiple figures, the Pose Scanner will capture the pose of the largest figure.

 The figure's fingers and hand position will not be captured in the pose.

 Figures may not be recognized in some photos.

 You can apply a pose from a photo to 3D drawing figures and 3D characters on a canvas using the [Pose Scan-

ner (image) (Technology preview)] from either the [Tool Property] palette or the [Object Launcher].
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Pose Scanner (camera) [Tablet/Smartphone]
Take a picture of a figure with the Tablet/Smartphone’s camera to apply the figure's pose to a 3D drawing figure. Here we will explain how to 

simultaneously import poses and 3D drawing figures.

1 Select the [File] menu > [Import] > [Pose Scanner (camera)].

2 The camera will open. Take a picture of a figure and tap [Use Photo].

3 Select the 3D drawing figure you wish to apply the pose to from the [Pose Scanner (cam-
era)] dialog box.

4 This applies the figure's pose in the photo to a 3D drawing figure and imports it to the can-
vas.

 This function is a technology preview. You can try it out before its official release.

 When you use this feature, the image data is uploaded to the server, where the AI interprets the data and esti-

mates the pose. You need to be connected to the Internet to use this feature. For information on the image 

uploaded to the server and the generated data, see "About AI features".

Apply a pose to 3D drawing figures and 3D characters on a canvas. To apply a pose to a selected 3D drawing fig-

ure or a 3D character, select a command.

When selecting a 3D drawing figure or a 3D character on a canvas, this screen will not appear. This applies a fig-

ure's pose from a photo to 3D characters or 3D drawing figures.

 If you choose an image with multiple figures, the Pose Scanner will capture the pose of the largest figure.

 The figure's fingers and hand position will not be captured in the pose.

 Figures may not be recognized in some photos.

 You can apply a pose from a photo to 3D drawing figures and 3D characters on a canvas using the [Pose Scan-

ner (camera)] from both the [Tool Property] Palette or the [Object Launcher].
CLIP STUDIO PAINT Instruction Manual 141



Menus > File Menu > Import
Pose Scanner (photo library/storage) [Tablet/Smartphone]
This imports a photo containing a figure from the Tablet/Smartphone’s photo library and applies the figure's pose to a 3D drawing figure. This 

feature aims to create a rough estimation of the pose you want. Here we will explain how to simultaneously import poses and 3D drawing fig-

ures.

1 Select the [File] menu > [Import] > [Pose Scanner (Photo library)] or  [Pose Scanner (stor-
age)].

2 Select the image containing the pose you wish to apply.

3 Select the 3D drawing figure you wish to apply the pose to from the [Pose Scanner] dialog
box.

4 This applies the figure's pose in the photo to a 3D drawing figure and displays on the can-
vas.

 This function is a technology preview. You can try it out before its official release.

 When you use this feature, the image data is uploaded to the server, where the AI interprets the data and esti-

mates the pose. You need to be connected to the Internet to use this feature. For information on the image 

uploaded to the server and the generated data, see "About AI features".

Apply a pose to 3D drawing figures and 3D characters on a canvas. To apply a pose to a selected 3D drawing fig-

ure or a 3D character, select a command.

When selecting a 3D drawing figure or a 3D character on a canvas, this screen will not appear. This applies a fig-

ure's pose from a photo to 3D characters or 3D drawing figures.

 If you choose an image with multiple figures, the Pose Scanner will capture the pose of the largest figure.

 The figure's fingers and hand position will not be captured in the pose.

 Figures may not be recognized in some photos.

 You can apply a pose from a photo to 3D drawing figures and 3D characters on a canvas using the [Pose Scan-

ner (photo library)] or [Pose Scanner (storage)] from both the [Tool Property] Palette or the [Object Launcher].
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Scan [Windows/macOS]
Scan and import images as layers.

1 Select the [File] menu > [Import] > [Scan].

2 The scanner driver will appear. Configure the driver and scan.

3 An image layer with the imported image will be created above the current layer.

You can set up scanner devices in [File] menu > [Import] > [Select scan device]. For details, see "Select Scan 

Device [Windows/macOS]".

The scanning procedure will depend on the selected scanner. Please refer to the instruction manual of the scan-

ner.

To draw on a layer with an imported image, the layer must be rasterized. For details, see "Rasterize".
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Continuous Scan [Windows/macOS] [EX]
Use a scanner to scan multiple images and import them as layers in separate page files.

1 Create a page file for importing image files, or open an existing page file.

2 Select the [File] menu > [Import] > [Continuous Scan].

3 The scanner driver will appear. Configure the driver and scan the pages.

4 Exit the driver when the scan is complete.

 For details on how to create a page file, see "Creating a Multi-Page File".

 You can use [Continuous Scan] even if a single-page file is open. In this case, the [Create story folder] dialog 

box will open after you specify the page from which to start importing. You will need to create a story folder in 

this dialog box.

The scanning procedure will depend on the selected scanner. Please refer to the instruction manual of the scan-

ner.
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5 The [Continuous Scan] dialog box will open. The canvas will show a preview of the
scanned image on the start page. Specify the orientation, size, and position of the image
on the canvas and specify the start page in the dialog box.

(1) Use the controller and handles to adjust the image orientation, size, and position.

(2) Specify the start page to import in the [Continuous Scan] dialog box.

(3) Click [OK].

 Drag the controller to rotate the image.

 Drag the handles to adjust the image size.

 Drag the image to adjust its position.

The [Create story folder] dialog box will open if images are batch imported when a single page file is open. You will 

need to create a story folder in this dialog box. For details, see "[Create story folder] Dialog Box".

Controller

Handle
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6 The images are imported to each page file as specified when the dialog box is closed.
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[Continuous scan] Dialog Box

(1) Start page

Specify the page from which to start importing images.

 Select [Page 1] to import images from the first page.

 Select [Specified page] to import images from the page specified in [Page number].

(2) Import as raster layer

Imports the images as raster layers.

(3) Set as draft layer

Imports the images to draft layers.

[Create story folder] Dialog Box

(1) Save folder

Specifies the location where the management folder will be created. Click [Browse] to specify the location.

(2) Management folder

Enter a name for the management folder.

(3) Management file

Displays the management file name (extension: cmc).
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Select Scan Device [Windows/macOS]
Select the scanning device to be used for scanning.

1 Connect a scanner.

2 Select the [File] menu > [Import] > [Select scan device]. Displays the [Select source] dialog
box.

3 Select the connected scanner in the [Select source] dialog box.

(1) Select the connected scanner.

(2) Click [Select].

4 The selected device will be set as the scan device.

 For information on installing the scanner driver, please see the instruction manual for the scanner.

 On Windows, only TWAIN-compliant scanners can be used.

The WIA scanner driver cannot be used.
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Camera settings [Tablet/Smartphone]
Selecting this opens the camera app. Photos taken with your device’s camera can then be imported into Clip Studio Paint.

1 Select the [File] menu > [Import] > [Camera settings].

2 Take pictures after the camera launches.

3 When the picture taken is displayed, tap [Use Photo] at the bottom right of the screen.

4 When returning to Clip Studio Paint, the photo will be loaded as an image material layer.

From Photo library [iPad/iPhone]
Select [File] menu > [Import] > [From Photo library] to select a file from the OS photo library and open it. After you select an image, the pro-

gram will return to Clip Studio Paint and the photo is imported as an image material layer.

From device [Android/Chromebook]
Select [File] menu > [Import] > [From device] to select a file from the OS file management screen and open it. After you select an image, the 

program will return to Clip Studio Paint and the photo is imported as an image material layer.

Exposure sheet [EX]
The exposure sheet information will be loaded in the [Timeline] palette.

You can import Digital Exposure Sheet Information files with the extension xdts.

1 Select the [File] menu > [Import] > [Exposure sheet].

2 In the dialog box that appears, select the file to import and click [Open].

3 The exposure sheet information will be reflected on the [Timeline] palette.

To take a picture again, tap [Retake] to return to the camera screen.

When importing the exposure sheet information file, the layer structure of the exposure sheet information file and 

the layer configuration of Clip Studio Paint are compared.

If a layer that does not exist in the exposure sheet information is part of the [Timeline] palette, a confirmation mes-

sage will appear for processing the layer.

 If a layer that is part of the timeline information does not exist on the [Timeline] palette, it will be added to the 

[Timeline] palette.

 If a layer on the [Timeline] palette is locked, the exposure sheet information will not be loaded to the corre-

sponding layer.
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Batch process [EX]
You can run menu commands/auto actions for specified page files in one go.

1 Select the [File] menu > [Batch process]. Opens the [Batch process] dialog box.

2 Set the batch process, target pages or files and the save options after the process is fin-
ished.

(1) Select the processes to run.

(2) Specify the which pages or files to run the processes on in [Apply to].

(3) Choose the save options for after the process is complete.

(4) Click [OK].

3 Click [OK] to close the dialog box and run the batch process on the specified page file(s).

 You can run batch processes when the page files are either open or displayed in the [Page Manager] window.

 Selecting the [Page Manager] window will only Batch process the page files selected.

specifying it as the only target in [Apply to] on the [Batch process] dialog box. For details, see "Apply to".

A dialog box titled [Next batch process] may display in some cases.

 To run the same process as before, select [Continue].

 To show the [Next batch process] dialog box for each page, turn on [Show the settings dialog each time].

 If you want to skip the batch process for a file, select [Skip].
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[Batch process] Dialog Box
@

A. Run
Select the processes you want to run.

(1) Process category

Select the category of the processes you want to run.

 For menu commands, select [Main menu].

 For auto actions, select [Auto action].

(2) List of processes

Select the processes you want to run.

Sub-menu commands can be displayed or hidden in the following ways:

 Click the leftmost arrow symbol.

 Double-click the item name.

A

B

C
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B. Apply to
Specify the page files to run the batch process.

C. Save options
Set how to save and close the files after the batch process is complete.

(1) Save options

Set how to save the files after the batch process is complete.

(2) Do not close canvases that are already open

Turn this on to leave currently open canvases open after the batch process is complete.

All pages The process will be carried out on all pages.

Selected pages
The process will be carried out on the pages selected in the [Page Manager] window. When several 

pages are separately open, the process will run on the displayed page file.

Open canvases The process will be run on the open page files.

Current canvas The process will be run on the open page file.

Close without saving Close the files after the batch process without saving.

Save and close Overwrite the files after the batch process, then close the files.

Save As and close Save the files under a different name after the batch process, then close the files.
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Print Settings [Windows/macOS]
Check and adjust the print settings to prepare for printing.

[Print Settings] Dialog Box

(1) Preview rendering result on output

When turned on, the [Print preview] dialog box will appear for you to check the content before printing.

In EX, the [Print preview] dialog box will not appear when printing more than one page.

For details on the [Print preview] dialog box, see "[Print preview] Dialog Box".
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(2) Print settings

Set the size and orientation for printing.

(3) Rotate paper 90 degrees

Prints the canvas image in landscape orientation.

(4) Output image [PRO/EX]

You can select whether to include the drafts, crop marks, default border, text, story information, folio, camera paths, and safety margins 

when printing. The checked items will be printed.

With EX, you can specify the image area to print in [Export range]. You can choose from [Full page], [To offset of crop mark], and [To 

inside of crop mark].

(5) Expression color

Set the expression color for printing. You can select from [Auto detect appropriate color depth], [Duotone (Threshold)], [Duotone (Ton-

ing)], [Gray], and [RGB color].

(6) Advanced settings of color [PRO/EX]

Opens the [Advanced settings of color] dialog box. In the dialog box, you can set the color for crop marks, default border, and safety mar-

gins, and the frequency of screentones. For details on the [Advanced settings of color] dialog box, refer to "[Advanced settings of color] 

Dialog Box [PRO/EX]".

(7) Process when scaling [PRO/EX]

Specify the process for enlarging or reducing the image for printing. You can select from [For illustration] and [For comic]. When you 

select [For comic], you can set the image quality for printing when you print in [Rasterize] mode.

You can select from [Fast] or [Prefer quality]. When you select [For illustration], [Prefer quality] is automatically specified.

Actual size The size for printing is the actual size.

Scale up or down according to paper The size for printing is adjusted to fit the paper size.

Pixel size The size for printing is adjusted so that the relationship between the image pixel 

and screen pixel is 1 to 1.

Dual page [EX] The page layout for printing is set to dual page. 

 Two pages are printed on one sheet of paper.

 The margin on the front side becomes the outer side, as the binding margin 

will be on the outer side of the paper.

Spread [EX] The page layout for printing is set to two-page spread. 

 Two pages are printed on one sheet of paper.

 The margin on the front side becomes the inner side, as the binding margin 

will be on the inner side of the paper.

 For [Auto detect appropriate color depth], the expression color of each layer will be determined based on the 

original color depth and output.

 [Duotone (Threshold)] sets a brightness of 50% as the threshold and outputs in binarized form.

 [Duotone (Toning)] outputs with screentones according to the [Default frequency] of the canvas. 

If quality is desired when printing at a reduced scale, turn on [Prefer quality] for [Rasterize].
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(8) Execute print

Saves the settings and opens the dialog box for printing.

[Advanced settings of color] Dialog Box [PRO/EX] 
Click [Advanced settings of color] in the [Print Settings] dialog box to open this dialog box. In the dialog box, you can set the color for crop 

marks, default border, and safety margins, camera, and camera paths. You can also set the frequency for tones and effects.

(1) Crop marks/Default border/Safety margins

Set the color for crop marks, default border, and safety margins.

(2) Frequency

You can set the frequency for printing.

(3) Enable tone effect for layer

When turned on, any tone effects added using the [Layer Property] palette will be applied when printing an image.

 The dialog box for printing depends on your OS and printer.

 On macOS, the [Print resolution] dialog box will appear when you select [Execute print] from the [Print] dialog 

box. Confirm the print resolution and click [OK] to start printing. The [Print resolution] dialog box references 

the resolution of the printer connected to the computer. However, you can change these settings if necessary.

Export in displayed colors 

 The color of the crop marks and default border will be as set in [Preferences] > [Ruler/

Frame/Unit] (the current display color).

 The color of the safety margin (the color displayed on the canvas) can be set under [Prefer-

ences] > [Ruler/Unit] > [Safety margin color].

Export in cyan Crop marks, default border, and safety margins will be exported in cyan.

Export in black Crop marks, default border, and safety margins will be exported in black.

Depend on export scale
The frequency varies in accordance with the output size specified in the [Print Settings] dialog 

box.

Follow layer settings The frequency will be as set in the original image.
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(4) Camera path

Set the color of the camera path when printing.

(5) Draw with opacity

Set the opacity of the camera path for printing. When turned on, the camera path is printed at 100% opacity. When turned off, the opacity 

of the camera path will be as set under [Preferences] > [Camera path/Camera].

Print [Windows/macOS]
Print your file.

1 Select the [File] menu > [Print] to open the dialog box for printing.

2 Set up the print settings in this dialog box. The below example is the dialog box that
appears on Windows devices.

(1) Select a printer.

(2) Enter the number of copies to print.

(3) Click the [Print] button to display the [Print preview] dialog box.

Export in displayed colors
The color of the camera or transformed camera paths will be as set in [Preferences] > [Camera 

path/Camera].

Export field guides in differ-

ent colors

The camera and transformed camera paths are printed in different colors for each frame. The ref-

erence color is the [Display color] set under [Preferences] > [Camera path/Camera]. Even if [Dis-

play in different colors] is turned off in [Preferences] > [Camera path/Camera], these will be 

printed in different colors.

Export in black The camera or transformed camera paths are printed in black.

 The dialog box for printing depends on your OS and printer.

 On macOS, the [Print resolution] dialog box will appear when you select [Execute print] from the [Print] dialog 

box. Confirm the print resolution and click [OK] to start printing. The [Print resolution] dialog box references 

the resolution of the printer connected to the computer. However, you can change these settings if necessary.

 With EX, you can specify the page area to print.
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3 Check the preview on the [Print preview] dialog box. Click [OK] to start printing.

The [Print preview] dialog box will not appear if [Preview rendering result on output] is turned off in the [Print Set-

tings] dialog box. You can start printing from from the dialog box for printing.
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[Print preview] Dialog Box
Click the [Print] button in the [Print] dialog box to open the [Print preview] dialog box.

(1) Image preview

Shows a preview of the printed image. You can drag the image preview to adjust the display position.

(2) Scaling slider

By dragging the slider, you can adjust the scale of the [Image preview]. Dragging to the right scales up the image while dragging to the left 

scales down the image. You can also click the numeric value to directly enter the scale.

(3) Zoom out

Click to zoom out of the image preview.

(4) Zoom in

Click to zoom in to the image preview.

(5) 100%

Click to display the image preview at 100%.

(6) Fit to navigator

Click to display the image preview to fit to the window size. When the size of the [Image preview] window is adjusted, the image preview 

will change size accordingly.

(7) Fit to Screen

Click to fit the previewed image to the [Image preview] window size. When the size of the [Image preview] window is adjusted, the image 

preview will not change size.

(8) Print size

Clicking it shows the Print size in the [Image preview].

A message is displayed when executing this command if a display resolution is not set. Clicking [OK] shows the [Settings of display reso-

lution] dialog, where you can set a display resolution. For details on the [Settings of display resolution] dialog box, see "Display resolu-

tion".

The [Print preview] dialog box will not appear if [Preview rendering result on output] is turned off in the [Print Set-

tings] dialog box.
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Preferences [Windows]
Opens the [Preferences] dialog box.

Here you can set Clip Studio Paint preferences for layers, tools, tablet settings, performance and more.

Tool
Configures settings related to tools.

Switch tool temporarily (Tool shift)
(1) Switch tool temporarily by pressing and holding shortcut key

When turned on, you can hold down a shortcut key assigned to a tool on the [Tool] palette to switch to that tool while the key is held down.

(2) Length of keypress to switch tools

Specify the time in milliseconds to switch the tool from the time the shortcut key is pressed.

Options
(3) Minimum drag distance

This option allows you to change the distance that the cursor needs to be dragged before it is recognized as a drag action. This is useful for 

tools where clicks and drags have different outputs, such as the [Object] tool or the [Move layer] tool. The smaller the value, the smaller 

the distance the pen or mouse has to move to be interpreted as dragging.
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(4) Auto scroll at edge of canvas

Sets how the mouse cursor behaves when it leaves the canvas.

(5) Figure tool guidelines

Turn this on to see a simplified preview of lines being created with the sub tools in the [Figure] tool > [Direct draw] sub tool group. You 

can select from [Line preview], [Simple view], [Line preview & control points] or [Simple view & control points].

(6) Handle size

Sets the display size of control points.

When [Simple view & control points] and [Line preview & control points] are set in [Figure tool guidelines], the size of the control points 

will change when drawing.

In addition, the control points displayed when editing lines drawn on vector layers, frame border folders, balloon layers, and rulers are also 

changed to the size set here.

None Clicking and dragging outside the canvas does not change the position of the canvas.

Drag Dragging outside the canvas scrolls it into the direction of the mouse cursor.

Drag with mouse (Windows/

macOS)

In addition to dragging, moving the mouse cursor outside the canvas also scrolls it according to 

the position of the mouse cursor.

  If [Line preview] and [Simple view] are set to not show control points, even if [Add/delete control points while 

drawing] is turned on in the [Sub Tool Detail] palette, you will not be able to insert or delete control points by 

clicking the line or a control point.

 Even if you set [Line preview] and [Line preview & control points] and show the line preview, this will not 

reflect in the [Starting and ending] setting.

Line preview Line preview & control pointsSimple view
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(7) Start from current size when changing brush size by dragging on canvas

When the brush size is adjusted by dragging the mouse while holding down Ctrl + Alt, the brush size adjustment will start from the current 

size.

(8) Display brush size adjustment on canvas

Turn this option on to preview the brush size with a circle in the center of the canvas when changing the brush size.

(9) Preview lines by pressing modifier key (Shift) [Windows/macOS/iPadAndroid/Chromebook]

Previews the line that will be created when drawing a straight line by holding the Shift key and clicking with a drawing tool.

You can also view the lines when using a mouse on iPad devices/Androids/Chromebooks.

(10)Confirm shape with double-click or double-tap

When this is turned on, double-clicking allows you to confirm your lines when using a sub tool that creates continuous curves or polygonal 

lines, such as [Continuous curve] and [Bezier curve].

(11) Use fast view while navigating canvas

Puts the canvas in fast view mode when dragged with viewing tools such as the [Zoom] tool and [Move] tool. This reduces the required 

processing capacity when using a viewing tool.

(12)Use white instead of transparency when drawing on layers with locked transparent pixels

On layers with locked transparent pixels, white will be used instead of transparency when using an Eraser tool or a drawing tool set to 

transparent color.

Brush size adjustment starts

from the current size.
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Tablet [Windows]
Configures settings related to tablet operation.

Using tablet service
Configures settings related to the type of tablet in use.

(1) Wintab

Select this option when using a normal tablet.

(2) Tablet PC

Select this option when using a tablet PC.

Coordinate detection mode
(3) Use mouse mode in setting of tablet driver

To display this option, set [Using tablet service] to [Wintab]. This item will turn on when setting the tablet in mouse mode.

If you are using a Windows 8 or Windows 10 touch device without a pen, set [Using tablet service] to [Wintab] to 

switch between touch operation and tool operation when using this software. For details on how to switch, see 

"Switch between tool operations and touch operations when operating the canvas".
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(4) Use more accurate coordinate detection

To display this option, set [Using tablet service] to [Tablet PC]. Turning on this item improves pen coordinate detection accuracy, resulting 

in smoother lines.

Tablet operation area
Configure the display area and tablet operation area of the tablet for Clip Studio Paint.

(5) Set tablet operation area with application

When turned on, the [Display area] and [Tablet operation area] of the tablet are set from Clip Studio Paint.

Operation area on monitor

Sets the monitor area in which the cursor can move.

Operation area on tablet

Sets the tablet area in which operation is possible.

Tablet Settings
(6) Input frequency

Set the amount of information to be sent from your tablet when using it. You can select from [Prefer speed] or [Prefer quality].

Set this function when using a tablet without "Operation area on monitor" and "Operation area on tablet" settings. 

If the driver of your tablet has these settings, configure them on the driver.

Run on all monitors
The cursor can move around the entire area of the connected monitor. This also applies 

to multi-monitors, independently of how they are arranged.

Operate specified monitor

This setting is available only in a multi-monitor environment. Turning on this item dis-

plays the monitor number on the right side. You can change the value with a pop up 

slider which will display as many values as the number of connected monitors. The area 

in which the cursor can move is the area around the upper left corner of the specified 

monitor.

Operate while keeping aspect ratio of 

monitor
The operation area is set so that the monitor is included in the tablet area.

Operate with whole tablet The aspect ratio is ignored and the whole tablet is set as operation area.
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Tablet [macOS]
Configures settings related to tablet operation.

(1) Priority for process

Set the processing priority when using the tablet. The priority can be set between 1 and 6. The lower the figure, the higher the priority of 

tablet processing becomes.

(2) Precision

Set the volume of information to be sent from your tablet. You can select [Prefer quality], [Recommended], or [Prefer speed].

 Drawing operations may not be performed properly if the tablet is used in Clip Studio Paint while another 

application is running. This problem can sometimes be solved by changing the value in [Priority for process].

 When the value in [Priority for process] is low, operations in Clip Studio Paint may sometimes get slower.

Sending a larger volume of information from your tablet improves drawing precision. However, more information 

than necessary may be sent from your tablet, which can result in slow drawing. In this case, setting [Precision] to 

[Recommended] or [Prefer speed] may resolve this issue.
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Touch gesture
Configure settings related to touch gestures.

When using macOS, you can use touch gestures with the trackpad or the macOS Sidecar function.

macOS

Windows/Tablet/Smartphone
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(1) Use tools with finger

Turn this on to use tools with your finger.

(2) Canvas operations

You can assign the following touch gestures as operations for the canvas.

 Single swipe [Windows/Tablet/Smartphone]

 Two-finger swipe

 Two-finger pinch

 Two-finger rotation

 Two-finger tap [Windows/Tablet/Smartphone]

 Three-finger tap [Windows/Tablet/Smartphone]

 Press and tap [Windows]

(3) Palettes [Windows/Tablet/Smartphone]

The following touch gestures can be set as operations for palettes.

 Two-finger tap

 Three-finger tap

 Press and tap [Windows]

 When [Use tools with finger] is turned off, you cannot use [Single swipe].

 Selecting [Single Swipe] in [Single Swipe/Long press] allows you to assign different tools for touch gestures 

and pen input. To learn about these settings, refer to "Modifier key settings [Windows] [PRO/EX]". The Tablet 

settings are the same.

 If a touch gesture is disabled, it cannot be used on the canvas.

If a touch gesture is disabled, it cannot be used in Clip Studio Paint.
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Command
Allows you to adjust settings related to Menu Commands.

Transform
(1) Only target raster layers, vector layers, selection layers, and layer masks

Select [Layer] menu > [Layer Order] to Transform the order of the selected layer.

 Raster Layer

 Vector layer

 Stock of selections area (Selection layer)

 Layer mask

When turned off, items from [Edit] menu > [Transform] can be used on the following layers.

 Image material layer

 Text layer

 Balloon layer

 Frame border folder

 Gradient layer

 Ruler

 Special ruler

 Only selections on Raster layers, Vector layers, Layer Masks and Selection layers can be transformed.

 When [Only target raster layers, vector layers, selection layers, and layer masks] is turned off, depending layer 

type, some transformations may not be supported.
CLIP STUDIO PAINT Instruction Manual 167



Menus > File Menu > Preferences [Windows]
Paste
(2) When SVG code is saved to clipboard [PRO/EX] [Windows/macOS]

Set this operation to copy graphics from Illustrator and paste them into Clip Studio Paint.

Convert to vector lines
A vector layer is created and lines and fills in the clipboard are converted to SVG format and 

pasted as vector lines.

Raster image Adds a raster layer, and pastes the image from the clipboard.

The compatibility of Illustrator data is the same as when importing SVG format files. For details, see "Vector [PRO/

EX]".
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Interface
Adjust settings related to IME controls, interface color scheme, and screen/operations optimized for touch operations.

Windows / macOS

iPad
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IME control [Windows/macOS]
Sets the Input Method Editor (IME) settings, if an IME is set up on your device.

(1) Automatically activate IME when editing text layer

When this is turned on, the input method will automatically change to the IME when you type on a Text layer. With this option, you can 

automatically switch to IME input without manually toggling the input settings, depending on your IME settings.

(2) Automatically switch IME when typing text into panel

When this is turned on, the input mode of the IME will change automatically when you type in a palette. For example in Japanese, the IME 

mode will toggle to hiragana input when the mouse cursor is moved to the field to input the layer name on the [Layer] palette, or to alpha-

numeric input when the mouse cursor is moved to type in a numeric field in the [Tool Property] palette.

Color
You can change the color scheme of the Clip Studio Paint main window.

(3) Interface color

Choose the color scheme for the user interface. You can select from [Light color] or [Dark color].

Light color

Dark color
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(4) Adjust density

Use the slider to adjust the density of the color.

Touch Operation Settings [Windows]
You can switch Clip Studio Paint screens and operations to be optimized for Windows touch operations.

(5) Adjust interface for touch operations

Turn this on to optimize the sizes of the buttons, text, and operations for Windows touch operations.

(6) Interface Scaling

When [Adjust interface for touch operations] is turned on, you can adjust the sizes of buttons and text.

You can select from [Small], [Default], or [Large].

Layout [Windows/Tablet]
Switches the basic layout of Clip Studio Paint palettes according to the device.

(7) Switch to tablet interface

Turn this on to switch the basic palette layout to a layout optimized for tablets.

Turn this off to switch the basic palette layout to a layout optimized for computers.

Status bar [iPad/iPhone]
You can show or hide the status bar.

(8) Display the status bar

Turn this on while Clip Studio Paint is running to display the iPad/iPhone status bar.

Edge keyboard [Tablet/Smartphone]
You can set how the edge keyboard is displayed.

(9) View

You can change how the edge keyboard is displayed by selecting by hiding, using the switch button, or swiping.

Changes to settings in [Touch Operation Settings] will be applied when Clip Studio Paint is restarted. For opera-

tions when using a slate device, see "Explanation: Operations Using Unique Windows Features".

Depending on the Windows settings, some items may not be displayed in [Large], [Default], or [Small] modes.

The basic layout will change if you turn on [Switch to tablet interface].

To save the current placement of the palettes, you should register a workspace. For details, please refer to "Regis-

ter Workspace [PRO/EX]".

Hide Hides the edge keyboard.

Switch Button
Switches how the edge keyboard is displayed. For details on the edge keyboard switch button, 

see "Show/hide edge keyboard".

Swipe
Changes how the edge keyboard is displayed by swiping towards the canvas from the left or right 

edges of the device. For details, see "Display edge keyboard".
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(10)Modifier Key [Android/Chromebook]

The Edge keyboard can be set to use modifier keys.

Push A modifier key is only active while you hold it down. This is recommended for drawing with your finger.

Toggle
Once you press a button, it will remain pressed. Press it again to return it to its original state. This is recom-

mended for drawing with a pen.
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Performance
Configures settings related to performance such as memory and undo history.

Memory
(1) Virtual memory path [Windows/macOS]

Specify the disk drive where to create the virtual memory.

(2) Allocate to application [Windows/macOS/iPad/iPhone]

Specify the percentage of memory to allocate to the Clip Studio Paint application. When you specify a percentage, the size of the allocated 

memory will be shown below as the [Memory size to use].

For Windows/macOS versions, changes in settings take effect after the application is restarted. For the iPad and iPhone, after clicking 

[OK] in the [Preferences] dialog box, the changes take effect.

Undo
(3) Undo levels

Specify the maximum number of operations you can undo with [Edit] menu > [Undo].

(4) Undo interval between actions

Specify the number of seconds without any operation necessary to recognize an operation as another when using the same tool consecu-

tively.

For example, specify the number of seconds necessary to recognize an operation as another when drawing with fast strokes using a draw-

ing tool.

Make sure to specify a folder in a disk drive with sufficient capacity. If the virtual memory is created in a location 

with insufficient capacity, the program may become unstable.

Be sure that the allocated memory size is not too small. If the allocated memory size is too large, the operating 

system may become unstable.
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Cursor
Specify the shape of the cursor. You can also set an additional display mode for small brush sizes, and set the display position for reversed cur-

sors (brush size, sight, single pixel dot).

(1) Shape of cursor

You can specify the cursor shape for each tool.

Tool specific Cross None

Dot Single pixel dot

Brush-size and 

 dot

Brush-size and 

 Single pixel dot

Sight Brush-size

Triangle (Orientation adjustable)

Brush-size and 

 tool specific

Brush-size and 

 cross
CLIP STUDIO PAINT Instruction Manual 174



Menus > File Menu > Preferences [Windows]
Brush-type cursor

Refers to the following tools:

 Brush Tool

 Airbrush Tool

 Decoration Tool

 Eraser Tool

 Blend Tool

 Correct line Tool

 Selection pen

 Erase selection

 Fill leftover areas

 Ruler pen

 Frame border pen

 Fill leftover

Pen-type cursor

Refers to the following tools:

 Pen Tool

 Pencil Tool

Eraser-type cursor

Refers to the following tools:

 Eraser Tool

Figure-type cursor

Refers to the following tools:

 Figure Tool

 Ruler Tool (Straight line, Curve, Figure)

 Balloon Tool

 Select layer

 Close and fill

 Gradient Tool

 Rectangle frame

 Polyline frame

 Remove dust

 Select dust

Fill-type cursor

Refers to the following tools:

 Auto select Tool

 Fill Tool

 Freeform gradient Tool

 Available cursor shapes depend on the tool.

 On Windows, macOS, and Tablet, even if you select None, the [Sight] cursor will appear on the canvas when 

you use a mouse or trackpad.

The [Pastel] tool group in the the [Pencil] tool falls under “Brush-type cursors”.
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View-type cursor

Refers to the following tools:

 Zoom Tool

 Move Tool

 Eyedropper Tool

Line-correction-type cursor [PRO/EX]

Refers to the following tools:

 Correct line Tool

(2) Additional display when brush-size cursor is small

When the brush size is small, an additional line appears around the cursor to make it easier to see. Here you can change the line to dots, or 

hide the line completely. The options are [None], [Dot], or [Line]. This setting applies to all tools, regardless of the tool type.

(3) Display position of reversed cursor (Brush-size/Sight/Single pixel dot)

You can set the display position of the cursor when drawing with a cursor set to [Brush Size], [Sight], or [Single pixel dot].

Layer/Frame 
You can adjust settings relating to layers and masks, as well as settings for the default gutter space between frame borders.

Changing this setting may improve the drawing speed when it is slow.

No delay The center of the cursor is the position of the input device.

Delay for stabilization
The center of the cursor is the input position corrected by Stabilization. The cursor follows the 

input device with a short delay.

In DEBUT, the [Layer/Frame] section is called [Layer].
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Layer
You can adjust default settings when creating layer copies, layer folders, and selection layers.

(1) Name of copies

Select the layer name format for new layer copies.

(2) Use [Through] blending mode for new layer folders

When turned on, [Through] will be the default blending mode for new layer folders.

(3) Opacity of selection layers [PRO/EX]

Set the opacity when creating a new selection layer.

(4) Vector path opacity [PRO/EX]

Adjust the opacity of displayed vector paths.

(5) How to scale down screentones [PRO/EX]

Adjust how tones are displayed when the canvas is scaled down.

Mask
Set how the mask area is displayed when creating a layer mask.

(6) Area Color

Allows you to set the color of masks. Click the color indicator to open the [Color settings] dialog box.

(7) Opacity of mask

Adjusts the opacity of the mask area.

(8) Display mask area when creating mask

Choose whether or not to show the mask area when creating a layer mask.

This setting does not apply to frame border folders.

You can show vector paths by selecting the [View] Menu > [Show vector paths]. For details, see "Show vector 

paths [PRO/EX]".

Show tone
The tone pattern will be kept in most cases. In some instances, the scale or frequency may cause 

interference (moiré) or may make the tone may appear gray.

Show gray The tone pattern will be omitted and screentones will be shown as gray.

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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Frame Border [PRO/EX]
These settings adjust the default gutter size when frames are divided with the [Divide frame border] or [Divide frame folder] sub tools.

(9) Vertical gutter

The space between frame borders when a frame border is divided vertically.

(10)Horizontal gutter

The space between frame borders when a frame border is divided horizontally.

(11) Display mask area when creating frame

Indicate the masked area when a frame is created.

These settings are also used when frames are edited with the [Object] tool. If [Snap to other frame borders] is 

turned on in the [Sub Tool Detail] palette, frame borders and control points will snap to other frames and their 

extension lines in accordance with the values in these [Frame Border] settings.

Fram
e border

Fram
e border

Frame border

Frame border
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Light table
Set preferences for light table layers. Light table layers are cels and layers that are registered in the [Animation cel] palette.

Registered settings
Set how cels or layers appear when first registered to the [Animation cel] palette.

(1) Opacity

Set the opacity of light table layers.

(2) Color mode

Set the display colors for light table layers.

(3) Layer color

Set the display color when [Half color] or [Monochrome] is selected as the display mode. Click the color indicator to open the [Color set-

tings] dialog box. When using the [Monochrome] display mode, the layer color will be used in place of black.

You can change how light table layers are displayed in the [Animation cel] palette. In [Preferences], you can set 

the typical display settings, while in the [Animation cel] palette, you can configure detailed settings for work proj-

ects. For details, see "Functions of Animation Cels Palette".

Color Cels and layers are displayed in their original colors.

Half color The original color of cels and layers is combined with the color specified in [Layer color].

Monochrome
The cel and layer colors are converted to grayscale, with the selected layer color used for black, 

and the selected sub color used for white.

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
CLIP STUDIO PAINT Instruction Manual 179



Menus > File Menu > Preferences [Windows]
(4) Sub color

Set the display color to be used in place of white when [Monochrome] is selected for [Color mode]. Click the color indicator to open the 

[Color settings] dialog box.

Overall opacity settings
Set the opacity of all light table layers registered in the [Animation cels] palette.

(5) Default opacity

Set the default opacity for light table layers. This applies to all light table layers registered to the [Animation cels] palette.

Camera path/Camera
Adjust settings for the display color and display method of the camera path for layers and 2D camera folders.

Camera path
(1) Show these layers

You can choose whether to show the camera path on all 2D camera folder or on the current editing layers.

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

Show or hide the camera path by selecting the [Animation] menu > [Show camera path].

Editing layers
The camera path will be shown for the currently selected layers in the [Layer] palette. In order to 

display the camera path, the layers must have keyframes.

2D camera
The camera path will be show for all visible 2D camera folders. However, the camera path will 

not be shown for hidden 2D camera folders.
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(2) Color

Set the display color of the camera path. Click the color indicator to open the [Color settings] dialog box.

(3) Opacity

Set the opacity of the camera path.

(4) Show field guides

When turned on, the camera frames (field guides) for the layers set in [Show these layers] will be shown. These field guides can be 

selected.

(5) Display in different colors

When turned on, the first frame will be shown in the color set as the [First color], and the last frame will be shown in the color set as the 

[Last color]. The frames in between are displayed as a gradient between the first color and the last color.

When turned off, all frames will be shown in the color set under [Camera path].

(6) First color

Set the color of the frame displayed first. Click the color indicator to open the [Color settings] dialog box.

(7) Final color

Set the color of the frame displayed last. Click the color indicator to open the [Color settings] dialog box.

(8) Show lines

When turned on, lines will show the movement of the camera frames for the layers set in [Show these layers]. The option [Corners] will 

show lines connecting the corners of the field guides, while [Center of rotation] will show a line connecting the center point of the field 

guides.

2D camera
(9) Color

Set the display color of the 2D camera. Click the color indicator to open the [Color settings] dialog box.

(10)Opacity

Set the opacity of the 2D camera.

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

Keyframe Only field guides set with keyframes will be displayed.

All frames All field guides will be displayed.

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

If an image material layer with free transform settings is selected, the camera path of the [Center of rotation] is not 

displayed.

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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Show all field guides
(11) Color

Set the display color of all field guides for the selected frame. Click the color indicator to open the [Color settings] dialog box.

(12)Opacity

Set the opacity for all field guides.

Ruler/Unit
Here you can adjust settings for the color and opacity of rulers, grids, and crop marks, as well as units used for tools.

Ruler/Grid/Crop mark [PRO/EX]
Configure settings for the color and opacity of rulers, grids, and crop marks.

(1) Line color

You can set the colors for the following rulers, grids, and margins.

 Color of ruler to snap

 Color of ruler not to snap

 Color of grid line

 Color of grid dividing line

 Color of crop mark/default border

 Safety margin color

Click the color indicator for each item to open the [Color settings] dialog box and select a color.

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

In DEBUT, [Ruler/Unit] is called [Unit].
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(2) Opacity of Ruler/Grid/Crop mark

Set the opacity of rulers, grids, and crop marks.

(3) When snapping to perspective ruler, reset drawing direction by returning to start point

When turned on, you can change the snapped drawing direction when using a perspective ruler by dragging the drawing tool back to the 

starting point.

Unit 
Allows you to set the unit of length to use in Clip Studio Paint.

(4) Unit of length

Allows you to set the unit of length to use in Clip Studio Paint. You can choose from pixels or millimeters.

(5) Text unit

Select the unit of text size for the [Text] tool, from [pt] (points) or [Q] (quarter).

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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Canvas
Allows you to configure settings such as the display quality of the canvas. as well as settings related to the scale and angle for displaying the 

canvas.

View
Set the display quality of the canvas.

(1) Display quality

Select the display quality for the canvas from [Default] and [High quality].

(2) Transparent

Set the color of transparent areas. Specify the color of the checkered pattern with [Color 1] and [Color 2].

Click each color indicator to open the [Color settings] dialog box and select the colors for the checkered pattern.

Default

The image may appear pixelated when the canvas is rotated or at some scaling settings. How-

ever, you will be able to perform operations more quickly as image processing does not require 

as much processing capacity.

High quality
The image is always displayed in high quality. Operations may become slow when the canvas is 

rotated or at some scaling settings.

If canvas operations become slow, try turning on [Use fast view while navigating canvas] in [Preferences] > [Tool] 

to improve the operating conditions. For details, see "Options".

When the Paper layer is hidden, the transparent area will be shown in a checkered pattern.
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Scale
Sets the display scale of the canvas.

(3) Scale list 

Displays a list of scales for zooming in to or out of the canvas with the [Navigator] palette or [View] menu.

(4) Scale input field

Use the input field to edit the selected display scale or add a new scale.

(5) Add

Adds the scale in the input field to the scale list.

(6) Delete

Deletes the selected scale from the scale list.

(7) Change

Changes the scale selected in the scale list to the value specified in the input field.

(8) Revert

Restores the scale list to its default state.

Angle
Sets the angle increment for rotating the canvas.

(9) Step

Specify the angle by which the canvas will rotate when rotating the canvas with the [Navigator] palette and [View] menu > [Rotate/Invert].

Display resolution
Adjust the display resolution.

(10)Settings

Opens the [Settings of display resolution] dialog box.

Once you set the display resolution, you can view your canvas at print dimensions when [Print size] is selected in the [View] menu.

[Settings of display resolution] dialog box

(1)  Resolution
Set the display resolution for the print size. When you change the resolution setting, the size of the ruler 

will adjust accordingly.

(2) Ruler
The scale used as a guide for printing size. It is displayed in centimeters. Adjust the resolution 

according to the ruler so that it comes to actual size.
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File
Sets settings for importing and exporting files.

Auto-Recovery
Adjust settings related to canvas recovery.

(1) Enable canvas recovery

Turn this on to save canvas recovery information at regular intervals.

In case Clip Studio Paint closes abnormally, it will automatically restore the canvas from its recovery information when the software is 

next launched.

(2) Save recovery data every

You can adjust how often recovery information is saved. Recovery information is automatically saved at the set interval. You can set an 

interval between 5 and 60 minutes.

Canvases using linked functions of Clip Studio Modeler cannot be restored.

Windows/macOS/Tablet

Smartphone
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Export
Adjust settings for exporting the canvas.

(3) Use layer cache when exporting

The layer cache will be used when exporting and saving files. This can shorten the time it takes to export or save the canvas.

Import IllustStudio document (xpg) [Windows/macOS] [PRO/EX]
Adjust settings for importing IllustStudio documents (extension: xpg).

(4) Combine all layers

Flattens the layers and imports the image.

(5) Anti-aliasing vector

Enables anti-aliasing for vector layers.

(6) Rasterize vector

Imports vector layers by converting them into raster layers.

Importing ComicStudio Page Files (cpg) [Windows/macOS] [PRO/EX]
Adjust settings for importing ComicStudio page files (extension: cpg).

(7) Combine all layers

Flattens the layers and imports the image.

(8) Anti-aliasing vector

Enables anti-aliasing for [Vector] layers.

(9) Rasterize vector

Imports vector layers by converting them into raster layers.

Page Management [Win/macOS/Tablet] [EX]  
(10)Auto save when switching page

When turned on, the last page will automatically save and close when you switch to another page.

When using Macs with Apple M1 chips, this will not be displayed.

When an IllustStudio document with vector layers is imported to Clip Studio Paint, the content of the vector layers 

may not be imported correctly. To import the content correctly, convert them into raster layers.

When using Macs with Apple M1 chips, this will not be displayed.

In macOS version, Text layers will not be merged even when [Combine all layers] is turned on.

When a ComicStudio document with vector layers is imported to Clip Studio Paint, the content of the vector layers 

may not be imported correctly. To import the content correctly, convert them into raster layers.
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(11) Always open in a new tab when double-clicking or tapping to open a page

Set how page files open when double-clicked in the [Page manager] window.

 When turned on, clicked page files will open in a new tab.

 When turned off, the current page file will close and the selected page will open.

Switching to another canvas [Smartphone]
(12)Auto save when switching canvas

When turned on, the file of the canvas being edited will automatically save and close when you switch to another canvas.
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Color conversion [PRO/EX]
Set default values for the color profile, rendering intent, and library for exporting in RGB and CMYK.

Settings of color conversion

(1) RGB profile

Specify the RGB color profile.

(2) CMYK profile

Specify the CMYK color profile.

(3) Rendering intent

Set how to process the color conversion between color spaces with the color management system.

(4) Library to use [Windows]

Select the library to use from [Icclibrary] and [MicrosoftICM].

These color conversion settings are used as the default values when converting between RGB and CMYK modes 

for displaying or exporting images.

Perceptual
Preserves the visual relationship between colors so that colors are perceived as natural even when 

color values are changed.

Saturation
Compares the maximum highlight in the source color space with the maximum highlight in the 

destination color space, and shifts the difference.

Relative Colorimetric Tries to reproduce vivid colors, even at the expense of color accuracy.

Absolute Colorimetric Does not change colors that fall within the destination gamut, but changes out-of-gamut colors.
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Edit text [EX] 
Configure settings for text entered with the Story Editor and for how text is displayed.

New text
Adjust settings for adding new text.

(1) How to insert new text

This indicates whether or not a new layer is created when adding new text.

(2) New text property

Adjust the default settings for new text, such as text size and font.

Add to current layer Adds the entered text to an existing text layer.

Always create new layer Creates a new text layer each time text is entered.

These settings are reflected on the canvas. They are not reflected in the Story Editor.

Selected text tool property Reflects the current settings in the [Tool Property] palette of the [Text] tool.

Copy from current text Uses the settings of other text on the same page.
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Line break
Configure display settings and advanced settings for line breaks.

(3) Line breaks

Set how to display line breaks in the Story Editor.

(4) Paragraph breaks

You can set how to divide text by pressing Enter in the Story Editor.

View
Configure font settings for the Story Editor.

(5) Direction

Set whether text displays horizontally or vertically in the Story Editor.

(6) Main text font

Set the font and size of text entered in the Story Editor.

(7) Reading font

Allows you to set the font and size of readings entered in the Story Editor.

Show line break Breaks the line at the specified position.

Show symbol only
Shows a sign to indicate a line break in the specified position, without breaking the line. The line 

break is inserted on the canvas in the position indicated by the symbol.

No paragraph breaks The text is not divided when Enter is pressed.

Single line space Press enter to divide text one time.

Double line space The text is divided when Enter is pressed twice consecutively.

Triple line space The text is divided when Enter is pressed three times consecutively.

These settings are reflected in the Story Editor. They do not affect text on the canvas.

Select the font name to open the [Font list]. For details on the font list, see "CLIP STUDIO PAINT Tool Setting 

Guide".

Select the font name to open the [Font list]. For details on the font list, see "CLIP STUDIO PAINT Tool Setting 

Guide".
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3D
You can set the default 3D drawing figure and display settings for 3D materials.

Model settings
(1) Drawing figure to be used with pose materials

You can choose the gender and version of the default drawing figure for loading pose materials onto the canvas.

Rendering Settings [Windows]
(2) Use multi-sampling

Turn this on to apply multi-sampling to 3D materials to improve the display quality.

If 3D materials are not displaying correctly, turning off [Use multi-sampling] may improve the way the 3D materials 

are displayed.
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Privacy Settings 
This allows you to set your privacy settings.

(1) Automatically send anonymous crash reports and usage information

When this is turned on, usage information is sent automatically. The information you provide will be used to improve our applications and 

services. It does not identify your personal information.
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Shortcut Settings [Windows]
Allows you to set a shortcut for some of the main menu items, tool property items and brush sizes, as well as tools and sub tools.

Selecting [File] menu > [Shortcut settings] opens the [Shortcut settings] dialog box.

On the [Shortcut Settings] dialog box, you can edit, add or delete the shortcuts of menu items, etc.

Shortcut settings dialog box

(1) Setting area

Select the category of the item(s) you want to assign a shortcut.

(2) Shortcut list

Displays the list of current shortcuts.

Main menu Displays a list of the top menus, submenus, and commands.

Pop-up palette [Windows/

macOS/Tablet]

Switches the [Shortcut list] to [Pop-up palette] items. The [Pop-up] palette is a function that 

pops up a menu next to the mouse cursor.

Options Displays a list of functions and operations that are not included in the menus and tools.

Tool Displays a list of tools and sub tools.

Auto action

[PRO/EX]
Displays a list of auto actions.

Sub-menu commands can be displayed or hidden in the following ways:

 Click the leftmost arrow symbol.

 Double-click the item name.
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(3) Information area

The area where messages are shown when the set shortcut is duplicated.

(4) Edit shortcut

Select the row of the item you want to edit, and then click the button to edit the shortcut. To change the shortcut, type the shortcut you wish 

to use and press Enter.

(5) Add shortcut

Adds shortcut settings.

Select the row of the item you want to edit, and then click the button and type the shortcut. To change the shortcut, type the shortcut you 

wish to use and press Enter.

(6) Delete shortcut

Select the item you want to delete, and click. The shortcut of the selected item is deleted.

(7) OK

Saves the set shortcuts and closes the dialog box.

(8) Cancel

Closes the dialog box without saving the set shortcuts.

(9) Reset to original defaults

Resets the shortcut settings to their original defaults.

 When using a Wacom stylus, shortcuts can be assigned to the side button of the stylus pen.

 With macOS, you cannot set shortcuts that are duplicated with keyboard shortcuts set in [System preference].

 When using a Tablet, edge keyboard buttons can also be set. Please refer to "Using the edge keyboard" for 

information on the edge keyboard for the Tablet/Smartphone.

 Pressing Esc after typing the shortcut cancels the input setting.

 Double clicking the item in the Shortcut list also enables shortcut editing.

 When using a Wacom stylus, shortcuts can be assigned to the side button of the stylus pen.

 With macOS, you cannot set shortcuts that are duplicated with keyboard shortcuts set in [System preference].

 When using a Tablet, edge keyboard buttons can also be set. Please refer to "Using the edge keyboard" for 

information on the edge keyboard for the Tablet/Smartphone.

 Pressing Esc after typing the shortcut cancels the input setting.
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Modifier key settings [Windows] [PRO/EX] 
The Ctrl, Alt, Shift, and Space keys individually or combined, the mouse wheel, right-click, and tail switch can be assigned to tools to perform 

operations such as temporary tool switch, brush size change, and so on.

(1) Common settings

Select this item to set common modifier keys to all tools.

(2) Settings for each process of tool

To set modifier keys for each tool separately, click the button on the right side of the [Sub tool]. The [Select sub tool] dialog box opens to 

set the sub tools.

[Output process] and [Input process] show the output/input process set to the selected sub tool.

(3) Refine

Narrows down the modifier keys shown in [Operation].

Modifier key settings are not set by sub tool, but by output process and input process. Therefore, changing the 

modifier key setting for one sub tool also changes the setting of sub tools if they have the same output process or 

input process.

For details on output and input processes, see "Input Process and Output Process of Sub Tools".
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(4) Operation

Shows a list of modifier keys that can be set.

Select a function from the pull down menu. You can select from [None], [Common], [Tool aux. operation], [Change tool temporarily], 

[View operation], [Show Menu] and [Change brush size].

None

Does not set any function to the modifier key.

Common

When [Settings for each process of tool] in the [Modifier Key Settings] dialog box is selected, [Common] can be selected from [Opera-

tion]. Selecting [Common] assigns the modifier key settings to all tools. Common modifier keys for tools can be adjusted by selecting 

[Common settings] from the [Modifier Key Settings] dialog.

Tool aux. operation

Sets an auxiliary operation that a tool can perform while in use.

Selecting [Tool aux. operation] shows the [Setting for tool aux. operation] dialog box. There, you can set the details of the tool auxiliary 

operation.

(1) Turn on the auxiliary operation item you want to set.

(2) Click [OK] to set the auxiliary operation.

 The available options for modifier keys depend on the device you are using.

 The available functions depend on the modifier key.

[Tool aux. operation] cannot be selected for processes without auxiliary operations. (Example of auxiliary opera-

tion: [Create special ruler])

Clicking [Settings] allows you to re-edit the [Tool aux. operation] settings.
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Change tool temporarily

Switches a tool or sub tool temporarily by pressing a modifier key.

Selecting [Change tool temporarily] shows the [Change tool temporarily] dialog box. On the dialog box, set the tool to change temporarily.

(1) Select the tools and/or sub tools from the list.

(2) Click [OK] to set the temporary switching of the tools and/or sub tools to the modifier key.

Sub-menu commands can be displayed or hidden in the following ways:

 Click the leftmost arrow symbol.

 Double-click the item name.

Clicking [Settings] allows you to re-edit the [Change tool temporarily] settings.
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View operation

Sets the operation when a modifier key is held down to a view operation such as scale up, scale down, rotate, and scroll.

Selecting [View operation] shows the [Setting for view operation] dialog box. Sets the Tool aux. operation content via the dialog box.

(1) Select a view operation from the list.

(2) Clicking [OK] sets the view operation to the modifier key.

Show menu

Shows the menu when a modifier key is pressed.

Change brush size

Allows you to change the brush size by dragging while holding the modifier key.

(5) Initialize

Restores to default modifier key settings.

Clicking [Settings] allows you to re-edit the [Setting for view operation] settings.
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Command bar settings [Windows] [PRO/EX]
Here you can edit settings for the Command Bar. You can add or delete command icons on the Command Bar, as well as change the position of 

the icons.

[Command bar settings] Dialog Box

(1) Category

Selects the category of the function you want to add to the Command Bar.

(2) List

Shows the [Selected area] function list. From here you can add functions to the [Command Bar].

(3) Close

Closes the [Command Bar Settings] dialog box.

Main menu Displays a list of the top menus, submenus, and commands.

Pop-up palette
The list display will switch to a pop-up palette. The pop-up palette is a function that pops up a 

menu next to the mouse cursor.

Optional content
The list display will switch to optional content. Optional content consists of functions and opera-

tions that are not included in the menu and tools.

Tool Displays a list of tools and sub tools.

Auto action Displays a list of auto actions.

Drawing color
This shows the [Color settings] dialog box and allows you to select a color. After selecting a 

color, an icon of that color is added to a list. You can select a color from that list as well.
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(4) Add

Adds the selected item in the list to the Command Bar. The command icon will be added to the right of the icon currently selected on the 

Command Bar.

If an icon is not selected, it will be added to the far right of the Command Bar.

(5) Settings

Edits the item that is currently selected on the Command Bar. The dialog box that appears will depend on what icon is selected.

(6) Delete

Deletes the selected icon or separator from the Command Bar.

(7) Add Separator

Adds a separator to the right side of the selected icon on the Command Bar.

(8) Insert into group

Groups multiple commands together under a selected icon in the command bar.

A drop-down icon will appear to the right of the command bar icon. Click it display a list of the grouped commands.

(9) Restore default layout

Restores the Command Bar to the default state.

When you restore the Command Bar to the default state, any added icons will be deleted, and the position of icons will be reverted to the 

original state.

Main menu
The [Icon settings] dialog box will appear. For details on the [Icon settings] dialog box, see "Icon 

settings dialog".

Pop-up palette
The [Icon settings] dialog box will appear. For details on the [Icon settings] dialog box, see "Icon 

settings dialog".

Options
The [Icon settings] dialog box will appear. For details on the [Icon settings] dialog box, see "Icon 

settings dialog".

Tool
The [Settings of sub tool] dialog box will appear. For details on the [Settings of sub tool] dialog 

box, see "Settings of sub tool".

Auto action
The [Icon settings] dialog box will appear. For details on the [Icon settings] dialog box, see "Icon 

settings dialog".

Drawing color
The [Name Settings] dialog box will appear. For details on the [Name Settings] dialog box, see 

"Name settings dialog".

Images and background colors set for each icon are saved even if you restore the Command Bar to the default 

state. If you re-add an icon that was deleted, it will appear with the previously chosen image or background color.
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Adding a Command
Follow these steps to add an icon to the Command Bar.

1 Select the [File] menu > [Command Bar Settings]. The [Command Bar Settings] dialog box 
will open.

2 On the Command Bar, click the icon at the position you want to add a new command.

3 In the [Command Bar Settings] dialog box, set the following.

(1) Select the type of icon (function) to add.

(2) From the list that appears, select the function to add to the Command Bar.

(3) Click [Add].

The new command icon will be added to the right of the selected icon.
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4 The icon will be added to the Command Bar.

You can move icons by dragging and dropping them on the Command Bar.

5 Close the [Command Bar Settings] dialog box.

You can also drag and drop items from the list to add them to the Command Bar.

Add separators and group icons using the following steps while the [Command Bar Setting] dialog box is open.

 Click the Command Bar icon and click [Add Separator] to add a separator to the right side of the icon.

 When dragging and dropping an icon from the Command Bar on the separator or to the right end/left end of 

the Command Bar, a separator will be created at that position.

 You can group icons by dragging and dropping them onto other icons on the Command Bar.

You can drag and drop the following icons onto the Command Bar to add them.

 Tool icons in the [Tool] palette

 Tool icons and sub tool groups in the [Sub Tool] palette

 Auto actions in the [Auto Action] palette

You can add the following functions to the Command Bar by dragging and dropping them while holding down Ctrl.

 Icons on the selection launcher

 Icons on the [Quick Access] palette
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Deleting a Command
Follow these steps to delete an icon from the Command Bar.

1 Select the [File] menu > [Command Bar Settings]. The [Command Bar Settings] dialog box 
will open.

2 On the Command Bar, select the icon of the command you want to delete.

3 Click [Delete] on the [Command Bar Settings] dialog box.

4 The icon will be deleted from the Command Bar.

5 Close the [Command Bar Settings] dialog box.

To delete a separator, select it on the Command Bar.

You can also right-click an icon and select [Delete] from the menu that appears.
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Grouping Commands
Follow these steps to group icons on the Command Bar.

1 Select the [File] menu > [Command Bar Settings]. The [Command Bar Settings] dialog box 
will open.

2 On the Command Bar, select the icon you want to group.

3 Select the command to add from the list of the [Command Bar Settings] dialog.

(1) Select the type of icon (function) to add.

(2) From the list that appears, select the function to add to the Command Bar.

(3) Click [Insert into group].
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4 The icon selected on the Command Bar will become a group with the item selected in the
[Command bar settings] dialog box.

5 The order in which commands are shown can be changed by displaying them as a list. 

(1) Click the drop-down menu icon. The icons of the grouped commands will appear.

(2) Drag and drop the icon of the command whose position you want to change.

6 Close the [Command Bar Settings] dialog box.

 You can also group icons by dragging and dropping them onto other icons on the Command Bar.

 A drop-down icon will appear to the right of the [command bar] icon. 

Hold Ctrl while dragging the command icon to change its position.
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Changing a command icon
Follow these steps to change the image of an icon.

1 Select the [File] menu > [Command Bar Settings]. The [Command Bar Settings] dialog box 
will open.

2 On the Command Bar, click the icon of the command you want to change.

3 Click [Settings] on the [Command Bar Settings] dialog box.

4 When the [Icon Setting] dialog box appears, you can set up the icon image and background
color.

(1) Click [Specify image file] and specify the image file to choose an icon from the file selection dialog.

(2) Click [OK].

 You can use the following image file formats: BMP, JPEG, PNG, TIFF and Targa.

 For details on the [Icon settings] dialog box, see "Icon settings".

 When selecting a tool or sub tool icon, the [Sub Tool Settings] dialog box will appear. For details, see "Settings 

of sub tool".

 When selecting a drawing color icon, the [Name Settings] dialog will appear. For details, please refer to "Name 

Settings".
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5 The icon on the Command Bar will change.

6 Close the [Command Bar Settings] dialog box.

The Command Bar, Selection Launcher, and Quick Access palette use the same icons. If you use the [Command 

Bar Settings] dialog box to change the icon of a command that is also on the Selection Launcher, it will also 

change on the Selection Launcher.
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Tab-Mate Controller [Windows] 
Assigns Clip Studio Paint operations to the Tab-Mate Controller (sold separately). Furthermore, assigns commands to the Tab-Mate Control-

ler's Quick Menu.

Tab-Mate Controller settings
You can assign Clip Studio Paint operations to the Tab-Mate Controller. It also allows you to adjust the sensitivity of the control stick when it is 

in the center.

A. Reset
Initializes the Tab-Mate Controller settings.

B. Function settings
You can assign Clip Studio Paint operations to the Tab-Mate Controller.

Functions that can be set vary depending on whether they will be assigned to the control stick or buttons.

(1) Setting up a control stick

Functions you can set to the control stick are as follows.

Disable

Does not assign any function to the control stick.

For details on purchasing the Tab-Mate Controller (sold separately), see “CLIP STUDIO NET”.

For names of Tab-Mate Controller parts, see "Names and Functions of Parts of the Tab-Mate Controller".

A

B

C
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Scroll

Scrolls the canvas in the direction the control stick is tilted.

Clicking [Settings] opens the [Settings of canvas operation] dialog box. In the dialog box, you can set the scroll amount for the canvas.

Rotate to tilted angle

Rotates the canvas in the direction the control stick is tilted.

Rotate by turning

 Rotating the control stick clockwise rotates the canvas clockwise.

 Rotating the control stick counterclockwise rotates the canvas counterclockwise.

Clicking [Settings] opens the [Settings of canvas operation] dialog box. In the dialog box, you can set the rotation amount for the canvas.

Zoom by turning

 Rotating the control stick clockwise zooms in the canvas.

 Rotating the control stick counterclockwise zooms out the canvas.

Clicking [Settings] opens the [Settings of canvas operation] dialog box. In the dialog box, you can set the zoom amount for the canvas.

Scroll By moving the slider, set the amount by which the canvas will displace. The larger the value, the 

larger will be the amount by which the canvas will displace.

Fix speed
Turning on this item displaces the canvas at a fixed speed. If turned off, the speed at which the 

canvas will displace will be proportional to the degree the control stick is tilted.

Rotate
By moving the slider, set the amount by which the canvas will rotate. The larger the value, the 

larger will be the amount by which the canvas will rotate.

Zoom
By moving the slider, set the amount by which the canvas will rotate. The larger the value, the 

larger will be the amount by which the canvas will zoom in/out.
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Zoom by up/down, rotate by left/right

 Tilting the control stick upward zooms in the canvas.

 Tilting the control stick downward zooms out the canvas.

 Tilting the control stick to the right rotates the canvas clockwise.

 Tilting the control stick to the left rotates the canvas counterclockwise.

Clicking [Settings] opens the [Settings of canvas operation] dialog box. In the dialog box, you can set the rotation amount and zoom 

amount for the canvas.

Brush

 Tilting the control stick upward increases the brush size.

 Tilting the control stick downwards decreases the brush size.

 Tilting the control stick right increases the brush size.

 Tilting the control stick left decreases the brush size.

Timeline

 Tilting the control stick upward moves the frame of the [Timeline] palette forward.

 Tilting the control stick downward moves the frame of the [Timeline] palette backward.

 Tilting the control stick right moves the frame of the [Timeline] palette forward.

 Tilting the control stick left moves the frame of the [Timeline] palette backward.

Parallel line ruler

Rotating the control stick rotates the parallel line ruler on the canvas.

Zoom
By moving the slider, set the amount by which the canvas will zoom in/out. The larger the value, 

the larger will be the amount by which the canvas will zoom in/out.

Rotate
By moving the slider, set the amount by which the canvas will rotate. The larger the value, the 

larger will be the amount by which the canvas will rotate.

Fix speed

Turning on this item zooms in/out or rotates the canvas at a fixed speed. If turned off, the speed 

at which the canvas will zoom in/out or rotate will be proportional to the degree the control stick 

is tilted.
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(2) Buttons

Selecting the function to set from the pull down menu displays the related dialog box for you to set the function.

Disable

Does not assign any function to the button.

Execute menu command

Assigns a Clip Studio Paint menu item to the button. Set the content on the dialog box.

(1) Select the menu item from the dialog box.

(2) Click [OK] to assign the function.

Clicking [Settings] also displays the related dialog box.
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Execute option command

Assigns an auxiliary operation of the items below to the button.

 Canvas

 Tool Property

 Brush Size

 Sub Tool

 Layer Property

 Drawing color

Set the content on the dialog box.

(1) Select the item from the dialog box.

(2) Click [OK] to assign the function.
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Change tools

Switches a tool or sub tool temporarily when the button is pressed. Set the content on the dialog box.

(1) Select the tools and/or sub tools from the list.

(2) Click [OK] to assign the function.

Allocate modifier key

Makes a button work in the same way as when a modifier key (Ctrl, Shift, Alt, or Space) is pressed. Set the content on the dialog box.

(1) Select the modifier key to assign. Selecting multiple items is equivalent to pressing multiple modifier keys simultaneously.

(2) Click [OK] to assign the function.

C. Error margin of neutral position
Adjusts the sensitivity of the control stick when it is in its center. When conditions such as a canvas not scrolling as operated, or a canvas 

scrolling on its own occur, they may be improved by adjusting this value.

Sub-menu commands can be displayed or hidden in the following ways:

 Click the leftmost arrow symbol.

 Double-click the item name.
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Quick Menu Settings
Assigns menu items to the Tab-Mate Controller's [Quick Menu].

A. Number of items
Specifies the number of menu items to assign. Select from [8 directions] and [4 directions].

B. Preview
Previews the menu items assigned to the control stick.

C. Function settings
Assigns menu items to the [Quick Menu].

In the Quick menu, there are two items: [Root menu] and [Child menu].

To toggle between the [Root menu] and [Child menu], click ▼ (triangle).

 When ▼ (triangle) is turned to the right, the [Root menu] can be set.

 When ▼ (triangle) is turned downward, the [Child menu] can be set.

For details on how to use the [Quick Menu], see "Explanation: Using the Quick Menu".

Root menu Items displayed when the Quick menu is started.

Child menu
Items displayed when the control stick is tilted for a while in the direction of the [Root 

menu].

If the control stick is kept tilted, the [Root menu] switches to [Child menu]. To display the [Root menu] when the 

[Quick menu] is displayed, place the control stick in the neutral position.

A

B C

D
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To set, proceed as follows.

Disable

Does not assign any menu item.

Execute menu command

Assigns a Clip Studio Paint menu item. Clicking [Settings] displays the [Settings for "Execute menu command"] dialog box.

(1) Select the menu item from the dialog box.

(2) Click [OK] to assign the function.

D. Initialize
Initializes the [Quick menu] settings.

Placing the mouse cursor over [Settings] will allow you to check in [Preview] the direction of the control stick to 

which the function will be assigned.
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Explanation: Using the Quick Menu
[Quick Menu] is a menu that allows you to execute a menu item assigned to a tilt direction of the Tab-Mate Controller control stick. To use the 

[Quick Menu], proceed as follows.

1 Tilt the control stick while holding down the A button on the Tab-Mate Controller. Displays 
the [Quick Menu]. Keep the A button of the Tab-Mate Controller held down even after the 
[Quick Menu] is displayed.

2 While holding down the A button of the Tab-Mate Controller, tilt the control stick in the
direction in which the root menu you want to execute is displayed. The [Child menu] is dis-
played.

Releasing the A button closes the [Quick Menu]. Keep the button held down while operating the [Quick Menu].

Control

stick

A button pressed

Keep control stick tilted

and A button pressed
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3 With the A button of the Tab-Mate Controller still held down, tilt the control stick in the
direction in which the menu you want to execute is displayed.

4 Release the A button of the Tab-Mate Controller. The selected menu item executes.

For details on how to set the [Quick Menu], see "Quick Menu Settings".

Releasing the A button of the Tab-Mate Controller when the control stick is in the neutral position cancels the 

[Quick Menu].

A button pressed

Release
CLIP STUDIO PAINT Instruction Manual 218



Menus > File Menu > Tab-Mate Controller [Windows]
Names and Functions of Parts of the Tab-Mate Controller
The following describes the name of each part of the Tab-Mate Controller, and how to check/switch the operating mode.

Name of each part

Checking the operating mode
The current operating mode is displayed with a LED. The button and control stick operation vary for each operating mode.

Switching the operating mode
To switch the operating mode:

 Long press the control stick to toggle the LED between on and blinking.

 Press the S button to toggle between the red and blue LED.

Red (On/Blinking)
You can assign Clip Studio Paint operations to the Tab-Mate Controller in [File] menu > [Tab-

Mate Controller settings].

Blue (On/Blinking) You can use the Tab-Mate Controller as a mouse.

A button

B buttonC button

D button

E button

S button

Control stick

LED
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CLIP STUDIO TABMATE [Windows]
You can assign Clip Studio Paint functions to the Clip Studio Tabmate (sold separately). You can also set up tool rotation with the Clip Studio 

Tabmate so you can switch between tools or functions by simply pressing a button.

CLIP STUDIO TABMATE Settings
You can assign Clip Studio Paint functions to the Clip Studio Tabmate.

Assigning Clip Studio Paint operations allows you to use those operations simply by pressing buttons on the Clip Studio Tabmate.

A. Mode
Select a mode to assign functions to the Clip Studio Tabmate. You can select from Mode 1 to Mode 4.

B. Preview
This shows the Clip Studio Tabmate modes and part names.

 Functions assigned to the selected mode in the [CLIP STUDIO TABMATE Settings] dialog box will be shown in this preview. When 

[Mode 1 (red lighting)] is selected, the LED preview will be red.

 When you press the Clip Studio Tabmate buttons, the corresponding button name will be highlighted.

C. Button names
These are the Clip Studio Tabmate buttons that can be assigned to Clip Studio Paint functions. Depending on the assigned function, button 

operations and numbers may show.

 For details on purchasing the CLIP STUDIO TABMATE (sold separately), see "CLIP STUDIO.NET".

 For information on how to connect your Clip Studio Tabmate, please refer to the instructions included in the 

product.

The Clip Studio Tabmate modes can be switched by pressing the Clip Studio Tabmate's [CLIP STUDIO] button.

A

B
C D E F

G

H
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D. Assigned functions
Assigns Clip Studio Paint operations to the Clip Studio TABMATE.

Select the function you want assign to each button from the pull-down menu. Depending on the function, a pop-up dialog box correspond-

ing to the selected function will appear.

(1) Disable

This disables button functions. The Clip Studio Tabmate will not have any effect on Clip Studio Paint even if you press its buttons.

(2) Execute menu command

You can assign Clip Studio Paint main menu commands to the Clip Studio Tabmate buttons.

If you select this option, the [Settings for "Execute menu command"] dialog box will appear. Select a menu command from the dialog box 

and click [OK] to assign it.

You can also open the [Settings for "Execute menu command"] dialog by clicking [Settings].
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(3) Execute option command

The following auxiliary functions of Clip Studio Paint can be assigned to the Clip Studio Tabmate.

 Canvas

 Tool property palette

 Brush size palette

 Sub tool palette

 Layer property palette [PRO/EX]

 Quick access palette [PRO/EX]

 Drawing color

 Edit

 Confirm and Cancel

If you select this option, the [Settings for "Execute option command"] dialog box will appear. Select a menu command from the dialog box 

and click [OK] to assign it.

You can also open the [Settings for Execute option command] dialog by clicking [Settings].
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(4) Execute auto action [PRO/EX]

You can assign Clip Studio Paint auto actions to the Clip Studio Tabmate.

If you select this option, the [Settings to Execute auto action] dialog box will appear. Select a auto action from the dialog box and click 

[OK] to assign it.

(5) Change tools

Tools and sub tools in Clip Studio Paint can be assigned to Clip Studio Tabmate buttons.

If you select this option, the [Settings to change tools] dialog box will appear. Select a tool or sub tool from the dialog box and click [OK] 

to assign it to a button.

You can also open the [Settings to Execute auto action] dialog by clicking [Settings].
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(6) Using tool rotation

Tool rotation is a function that allows you to switch the Clip Studio Paint tools each time a Clip Studio Tabmate button is pressed.

Selecting this item shows the [Tool Rotation Settings] dialog box. To learn about these settings, see "When selecting to execute tool rota-

tion".

(7) Assigning modifier keys

You can assign modifier keys (Ctrl, Shift, Alt, Space) to Clip Studio Tabmate buttons.

Select [Allocate modifier key] and click [Settings]. Shows the [Settings to allocate modifier keys] dialog box. Select a modifier key and 

click [OK] to assign it.

More than one modifier key can be selected from the [Settings to allocate modifier key] dialog box. In that case, it will be equivalent to 

multiple modifier keys being pressed.

 If you turn on [Switch tool temporarily (tool shift)] in the [Settings to change tools] dialog box, you can change 

to a different tool while holding down a button on the Clip Studio Tabmate.

 You can show the [Settings to change tools] dialog box by clicking [Settings].

To learn how to set tools in the [Tool Rotation Settings] dialog box, see "Tool Rotation Settings".

The following items cannot be selected for [Allocate modifier key].

 [Wheel (Up)]

 [Wheel (Down)]

 Items added when [Execute with repeated taps] is selected

 Items added when [Execute according to length of key press] is selected

 Items added by selecting [Execute with ON/OFF]
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(8) Pop up palette

You can assign pop-up palettes in Clip Studio Paint to Clip Studio Tabmate buttons.

If you select this option, the [Palette pop-up settings] dialog box will appear. Select either [Display/hide pop-up] or [Display pop-up while 

pressing button]. Select a palette to pop up and click [OK] to assign the palette pop-up to a button.

(9) Execute with repeated taps

Multiple functions of Clip Studio Paint can be assigned to a single button on the Clip Studio Tabmate. Different functions can be executed 

according to the number of times the button is pressed.

Unlike tool rotation, functions other than tools can also be selected. To learn about these settings, see "When the number of consecutive 

taps to execute is selected".

(10)Execute according to length of key press

Multiple functions of Clip Studio Paint can be assigned to a single button on the Clip Studio Tabmate. Different functions can be executed 

depending on the length of the button press.

Display/hide pop-up Each time the Clip Studio Tabmate button is pressed, the palette will show or hide.

Press a button to show the pop-up. You can also set up the button so that the palette appears only while the button is pressed.

[Palette Pop-up] is not available for the following items.

 [Wheel (Up)]

 [Wheel (Down)]

 Items added when [Execute with repeated taps] is selected

 Items added when [Execute according to length of key press] is selected

 Items added by selecting [Execute with ON/OFF]

The following items are not available for [Execute with repeated taps].

 [Wheel (Up)]

 [Wheel (Down)]

 Items added when [Execute with repeated taps] is selected

 Items added when [Execute according to length of key press] is selected

 Items added by selecting [Execute with ON/OFF]
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To learn about these settings, see "When selecting Execute according to length of key press".

(11) Execute with ON/OFF

Different functions can be turned on while pressing a Clip Studio Tabmate button and then turned off again upon release of the button.

To learn about these settings, see "When Execute with ON/OFF is selected".

E. Settings
When clicked, a dialog box corresponding to the assigned action will appear. You can set detailed operations in this dialog box.

For details on the dialog box, see the items under the [Assigned functions] options.

F. Information area
This indicates the action assigned to the button.

If the function has registered shortcut keys, you can assign those functions without selecting it from the [Assigning functions] drop-down 

menu.

Double-clicking this column shows [Input with shortcut]. Input the shortcut key and press Enter. Shows the action assigned to the button.

G. Reset
This resets the CLIP STUDIO TABMATE settings back to the default state.

The following items cannot be selected for [Execute according to length of key press].

 [Wheel (Up)]

 [Wheel (Down)]

 Items added when [Execute with repeated taps] is selected

 Items added when [Execute according to length of key press] is selected

 Items added by selecting [Execute with ON/OFF]

The following items cannot be selected for [Execute with ON/OFF].

 [Wheel (Up)]

 [Wheel (Down)]

 Items added when [Execute with repeated taps] is selected

 Items added when [Execute according to length of key press] is selected

 Items added by selecting [Execute with ON/OFF]
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H. Options
This shows the [TABMATE Options] dialog box. It is possible to set the interval registered for operations when tapping a button repeat-

edly as well as long press operations.

TABMATE Options Dialog box

(1) Length of button press for switching tool temporarily

With this setting, you can choose the amount of time that the button needs to be pressed to switch the tool. This setting is used when 

[Change tools] is selected from the [Assigned functions] options in the [CLIP STUDIO TABMATE Settings] dialog box.

(2) Interval duration to recognize as repeated taps

Adjust the interval recognized as repeated taps by repeatedly pressing it. This setting is used when [Execute with repeated taps] is selected 

from the [Assigned functions] options in the [CLIP STUDIO TABMATE Settings] dialog box.

(3) Time until recognized as hold press

You can adjust the length of time recognized as a long press when pushing a button. This setting is used when [Execute according to length 

of key press] is selected from [Assignment] options in the [CLIP STUDIO TABMATE Settings] dialog box.
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When configuring Clip Studio Tabmate settings
The following describes hot to set [Execute Tool Rotation], [Execute with repeated taps], [Execute according to length of key press] and [Exe-

cute with ON/OFF] in the CLIP STUDIO TABMATE setting] dialog box when they are selected.

When selecting to execute tool rotation
Up to 10 tools can assigned to each Clip Studio Tabmate button by selecting [Execute Tool Rotation] under the [Assignment] options in the 

[CLIP STUDIO TABMATE Settings] dialog box.

This section describes how to assign the tool rotation.

1 In the [CLIP STUDIO TABMATE setting] dialog box, select [Execute Tool Rotation] from the 
[Assignment] options.
Shows the [Tool Rotation Settings] dialog box.

2 You can configure the settings in the [Tool Rotation Settings] dialog box.

(1) From [Settings selection], select the setting you want to apply to the tool rotation.

(2) The tool rotation settings are reflected in the [Tool assignment list]

(3) Click [OK].

3 The settings are reflected in the [CLIP STUDIO TABMATE Settings] dialog box.

 To learn how to set tools in the [Tool Rotation Settings] dialog box, see "Tool Rotation Settings".

 You can open the [Tool Rotation Settings] dialog box by clicking [Settings]. This can also be set by selecting 

the [File] menu ([CLIP STUDIO PAINT] menu in macOS) > [CLIP STUDIO TABMATE] > [Tool rotation].

 Click [Invert tool line-up] to reverse the order that the tools switch.
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When the number of consecutive taps to execute is selected
When selecting [Execute with repeated taps] under the [Assignment] options in the [CLIP STUDIO TABMATE Settings] dialog box, up to four 

functions can be set for each Clip Studio Tabmate button.

This section describes how to set a function according to frequency.

1 In the [CLIP STUDIO TABMATE Settings] dialog box, select [Execute with repeated taps] 
from the [Assignment] options.

When selecting [Execute with repeated taps], you can set between 1~4. Here, functions to be executed according to the number of repeated 

taps can be set.

Press the buuton once to access the function set as 1. Press the buuton twice to access the function set as 2. It is possible to set this button 

for up to four continuous taps.

2 Set functions from 1 ~ 4

(1) Select the function from the [Assignment] option in 1.

The number of seconds shown when [Execute with repeated taps] is selected indicates the interval at which the 

pressed buttons are recognized as being repeatedly tapped. You can change the interval in the [CLIP STUDIO 

TABMATE Settings] dialog box > [Options].
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(2) When the dialog corresponding to the selected function is shown, select the function to execute and click [OK].

(3) Set functions for the items 2 to 4 as well. The setting method is the same as with the operation of 1 to 2.

 The setting method differs according to the function selected in [Assignment] options. For details, please 

refer to "CLIP STUDIO TABMATE Settings".

 When selecting [Execute with repeated taps] from the [Assignment] options, the following items can not be 

selected: [Allocate modifier key], [Palette pop-up], [Execute with repeated taps], [Execute according to length 

of key press], [Execute with ON/OFF].
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When selecting Execute according to length of key press
When selecting [Execute according to length of key press] under the [Assignment] options in the [CLIP STUDIO TABMATE Settings] dialog 

box, up to three functions can be set for each Clip Studio Tabmate button.

This section describes how to set multiple functions.

1 In the [CLIP STUDIO TABMATE Settings] dialog box, select [Execute according to length of 
key press] from the [Assignment] options.

When [Execute according to length of key press] is selected, the items [Short press], [Long press], and [Release after long press] are 

added.

 Functions when the button is being pressed normally will be assigned to [Short press].

 Functions when the button is long pressed will be assigned to [Long press].

 Functions when the button is released after a long press will be assigned to [Release after long press].

2 Set functions for [Short press], [Long press] and [Release after long press].

(1) Select a function from the [Assignment] option [Short press].

The number of seconds shown when [Execute according to length of key press] is selected is the amount of time 

needed to recognize when you long-press the button. To change the interval, click [Options] in the [CLIP STUDIO 

TABMATE Settings] dialog.
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(2) When the dialog shows, select a function and click [OK].

(3) When the function is set to [Short press], set the function for other items as well. The setting method is the same as with the operation 

of 1 to 2.

 The setting method differs according to the function selected in [Assignment] options. For details, please 

refer to "CLIP STUDIO TABMATE Settings".

 The following items from the [Assignment] option cannot be added by selecting [Execute according to length 

of key press]: [Allocate modifier key], [Palette pop-up], [Execute with repeated taps], [Execute according to 

pressed time], and [Execute with ON/OFF].
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When Execute with ON/OFF is selected
When selecting [Execute with ON/OFF] under the [Assignment] options in the [CLIP STUDIO TABMATE Settings] dialog box, two functions 

can be set for each Clip Studio Tabmate button.

This section describes how to set up multiple functions.

1 In the [CLIP STUDIO TABMATE SETTING] dialog box, select [Execute with ON/OFF] from 
the [Assignment] options.

When selecting [Execute with ON/OFF], the items [ON] and [OFF] will be added.

 Pressing the Clip Studio Tabmate button can be assigned as the [ON] function.

 Releasing the Clip Studio Tabmate button can be assigned as the [OFF] function.

2 Set function for [ON] & [OFF].

(1) Select the function from the [Assignment] option to [ON].
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(2) When the dialog box corresponding to the selected function shows, select the function you want to run.

(3) If the function is turned [ON], set it to [OFF]. The setting method is the same as with the operation of 1 to 2.

 The setting method differs according to the function selected in [Assignment] options. For details, please 

refer to "CLIP STUDIO TABMATE Settings".

 The following items from the [Assignment] option cannot be added by selecting [Execute with ON/OFF]: [Allo-

cate modifier key], [Palette pop-up], [Execute with repeated taps], [Execute according to length of key press], 

and [Execute with ON/OFF].
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Tool Rotation Settings
Selecting this item shows the [Tool Rotation Settings] dialog box. When using a Clip Studio Tabmate, detailed settings can be made for Tool 

Rotation.

Multiple tool rotation settings can be created. For example, you can assign different tool rotation for each button on the Clip Studio Tabmate.

Tool Rotation Settings dialog box

(1) Settings selection

Select the tool rotation settings.

(2) Show Menu

Clicking this shows the menu. In the [Setting selection] the selected settings for tool rotation can be changed and new settings can be 

added.

(3) Invert tool line-up

Click this to reverse the order that the tools switch.

(4) Delete tool from line-up

You can delete tools added to the tool rotation. Select the tool you want to delete from the tool assignments list, and click [Delete tool from 

line-up].

(5) Order

This number indicates the order that the tools switch.

(6) Settings

Clicking this shows the [Tool settings] dialog box. Select a tool or sub tool from the dialog box and click [OK] to assign it to the Tool rota-

tion. Assigned tools and sub tools are shown on the right side of the [Settings].

Create new settings Creating new tool rotation settings.

Delete settings In the [Setting selection] the selected settings for tool rotation can be deleted.

Duplicate settings In the [Setting selection] the selected settings for tool rotation can be duplicated.

Edit settings Selecting this shows the [Edit settings] dialog box. Tool Rotation setting names can be changed.

Double-click the tool name, then enter the shortcut key for the tool or sub tool to assign that tool or sub tool.
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(7) Tool name

This shows the name of the tools and sub tools in the tool rotation.

You can directly assign a tool by clicking the tool name. Double-click the tool name, then enter the shortcut key for the tool or sub tool. 

Press enter to assign a tool or sub tool.

(8) Add

Click here to add an assigned tool. You can assign up to 10 tools for each tool rotation setting.

(9) Reset to original defaults

Returns tool rotation settings to their initial state. The settings of the added tool rotation and the assigned tools are deleted.
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Pen Pressure Settings [Windows]
Adjusts the pen pressure sensitivity when using a tablet.

1 Select the [File] menu > [Pen Pressure Settings] to open the [Adjust pen pressure] dialog 
box.

2 Adjust the pen pressure sensitivity from the [Adjust pen pressure] dialog box.

(1) Draw on the canvas with your usual pen pressure, while deliberately increasing and decreasing pen pressure.

(2) Click [Check adjusted settings].

3 When the [Check adjusted settings] dialog box appears, you can further adjust the pen
pressure sensitivity.

(1)  Draw with your usual pen pressure on the canvas. If you are satisfied with the result, proceed to step 3. To further adjust the pen pres-

sure settings, proceed to step 2.

(2) Click [Stronger] or [Lighter] to adjust pen pressure sensitivity. Draw on the canvas again, and adjust the pen pressure to your liking.

(3) Click [Complete].

Before configuring the pen pressure settings, please connect the tablet and stylus you will use for drawing.

 If the [Show pen pressure graph] is turned on, the [Adjust pen pressure] dialog box will display the pen pres-

sure graph. You can change the pen hardness by adjusting the pen pressure graph curve.

 On Windows, if pen pressure isn’t registering on the canvas or if you cannot click [Check adjusted settings], 

click [If the “Check adjusted settings” button isn’t clickable even after drawing a line] and follow the instruc-

tions.

 When using a Wacom stylus with an iPad or an iPhone, click [If using Wacom Stylus Pen] and follow the 

instructions on the screen.

Draw a line on the canvas with the usual pen pressure, 

and by alternatively pressing hard and softly on purpose.
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Dialog box for adjusting pen pressure

(1) Show pen pressure graph

Turn this on to display the pen pressure graph.

(2) Check adjusted settings

Opens the [Check adjusted settings] dialog box. When this dialog box opens, you can draw with the adjusted pressure on the canvas.

(3) Reset to default

Resets the pen pressure settings to default.

(4) Pen pressure graph

Pen pressure sensitivity will be shown as a curve graph. You can adjust [Pen pressure] and [Output] by dragging the control points of the 

curve.

(5) If the “Check adjusted settings” button isn’t clickable even after drawing a line [Windows]

If the line isn’t reflecting pen pressure, you can change the supported tablet type to improve it. Click this to select the tablet type. This 

option will not appear if a supported tablet is not connected.

(6) If using a Wacom Stylus Pen [iPad/iPhone]

You can also adjust the settings of supported Wacom stylus pens. When using a Wacom stylus, your dominant hand and hand position can 

be simultaneously set.

You can adjust the pen pressure sensitivity by dragging the control points of the curve.

 Drag a control point to change its position.

 Click on the curve to add a control point.

 To delete a control point, drag it outside the graph.
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[Check adjusted settings] dialog box

(1) Stronger

The stronger the pressure, the bigger the change. This option is more sensitive to changes in heavy pen pressure.

(2) Lighter

The weaker the pressure, the bigger the change. This option is more sensitive to changes in light pen pressure.

(3) Show pen pressure graph

Turn this on to display the pen pressure graph.

(4) Pen pressure graph

Pen pressure sensitivity will be shown as a curve graph. You can adjust [Pen pressure] and [Output] by dragging the control points of the 

curve.

(5) Complete

Applies the settings in the [Adjust pen pressure] and the [Check adjusted settings] dialog boxes and closes the dialog box.

(6) Back to previous screen

Returns you to the [Adjust pen pressure] dialog box.

You can adjust the pen pressure sensitivity by dragging the control points of the curve.

 Drag a control point to change its position.

 Click on the curve to add a control point.

 To delete a control point, drag it outside the graph.
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QUMARION [Windows]
Set up a QUMARION device to use with Clip Studio Paint, and import or export calibration data.

Use QUMARION
Turning on this item enables the use of QUMARION in Clip Studio Paint

Import Calibration information
Imports a QUMARION calibration file (extension: qnca) to calibrate QUMARION.

Export Calibration information
Exports the QUMARION calibration information as a QUMARION calibration file (extension: qnca).

Explanation: When Displayed 3D Character Is Misaligned
When the QUMARION pose and the displayed 3D character are misaligned, correct using [Calibration] on the [Object launcher].

Perform a correction when you cannot align the displayed 3D character even by making the QUMARION pose symmetric.

The following describes the correction procedure when the QUMARION pose and the displayed 3D character are misaligned as shown in the 

figures below.

You will not be able to use QUMARION without turning on [Use QUMARION]. Once turned on, [Use QUMARION] 

remains enabled until you quit Clip Studio Paint.

For details on setting up a QUMARION, see "Explanation: When Displayed 3D Character Is Misaligned".

For details on setting up a QUMARION, see "Explanation: When Displayed 3D Character Is Misaligned".

QUMARION pose 3D character material view
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1 Click [Calibration] on the Object launcher.

2 Operate QUMARION so that its pose matches that of the 3D character.

Object launcher

Click [Calibration].

QUMARION pose 3D character material view

Move QUMARION so that its pose matches

that of the 3D character material.
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3 Click [Enable QUMARION] on the Object launcher. The displayed 3D character and QUMAR-
ION pose become the same.

Open CLIP STUDIO [Windows]
Launches the portal application Clip Studio. Clip Studio is a tool and service that aims to support creative activities.

Close CLIP STUDIO PAINT [Windows]
Closes Clip Studio Paint.

 To export the calibration information, select the [File] menu > [QUMARION] > [Export Calibration Information]. 

To import an exported calibration information, select the [File] menu > [QUMARION] > [Import Calibration 

information]. Note that [Import calibration information] and [Export calibration information] are available only 

when [Enable QUMARION] is turned on.

 You can also import calibration files (extension: qnca) created in CLIP STUDIO ACTION legacy version. For 

details on CLIP STUDIO ACTION, see "CLIP STUDIO NET".

Object launcher

Click [Enable QUMARION].
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File operation/Share [Android/Chromebook]
Select the [File] menu > [File operation/Share] to open the [File operation/Share] dialog box. In the [File operation/Share] dialog box, you can 

manage the files.

File operation/Share dialog box

(1) File filter

Narrows down the displayed file types. Click here to choose a file type.

(2) View

Sets the file display order. [Sort by name], [Sort by category], [By size], [Sort by date modified], and [Sort by creation date] can be 

selected.

(3) Ascending order/Descending order

The file display order can be switched between ascending and descending order.

(4) View

The display method can be selected from [Collection] and [List].

(5) Display size

The display size of files and folders can be adjusted.

Tablet Smartphone
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(6) Menu

Clicking this shows the menu. You can perform the following operations on files and folders selected from the file list.

 Open

 Share

 Change name

 Duplicate

 Deleted

 Import

 Export

(7) Open

Select files from the file list to open in Clip Studio Paint.

To import multiple files as a multi-page file on a tablet, select multiple files and click [Open].

(8) Share

Shares selected files and folders from the file list to save to outside cloud services or publish to social media.

(9) Change name

Changes the name of a selected file or folder on the file list.

(10)Duplicate

Duplicates a selected file or folder on the file list.

(11) Delete

Deletes a selected file or folder on the file list.

(12) Import

Imports files from device storage into Clip Studio Paint’s work folder. For details, see "Importing files from storage into Clip Studio 

Paint".

(13)Export

Copies and exports selected files from the file list to the device's storage. For details, see "Exporting files saved in Clip Studio Paint to 

storage".

(14)File list

This is a list of files and folders included in Clip Studio Paint’s work folder. Files and folders can be selected by tapping on the icon's 

check box.

The following will be shown when a folder is selected.

 Multi-page documents will be shown as a management file with a thumbnail of the first page.

 Images exported as an image sequence are saved in a folder and shown with an icon of layered images. In Clip Studio Paint, images 

inside the folder cannot be opened.

 Folders exported through [File] > [Export animation] > [Image sequence] cannot be opened in Clip Studio 

Paint.

 Folders and files exported through [File] > [Export multiple pages] > [Batch export], [Export fanzine printing 

data], or [Export settings for EPUB data] cannot be opened in Clip Studio Paint.

Apps available from [Share] may differ depending on the device used.

Pinch in or out on the file list to change the display size.
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Importing files from storage into Clip Studio Paint
To edit a files in Clip Studio Paint, it needs to be saved to Clip Studio Paint’s work folder.

Select the [File] menu > [File operation/Share] to show the File operation/Share dialog box.

Select [Import] from the menu. On a tablet, you can also load it by tapping  [Import].

When the OS file management screen appears, select the file you want to import.

Exporting files saved in Clip Studio Paint to storage
Files and folders saved in Clip Studio Paint's work folder can be copied and exported to your device's storage.

Select the [File] menu > [File operation/Share] to show the File operation/Share dialog box.

Select the file you want to export to storage from the file list and select [Export] from the [Menu].

From the OS file management screen, select a destination and tap [Save]. If you are using a tablet, you can also tap [Export] to export a file.

Files in folders cannot be imported via the [File operation/Share] dialog box. If you want to import multiple files 

into one file, open the folder and select all the files.

For multi-page works, the Management folder will be deleted from the File operation/Share dialog box.

We recommend using Clip Studio's cloud service to load multi-page works. Alternatively, when importing a man-

agement folder from the device storage or an external drive, the management folder can be compressed into ZIP 

format in advance so that the entire work can be loaded into the management folder in the File operation/Share 

dialog box.
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When using this method, any file that is compatible with Clip Studio Paint's input/output can be exported to the device's storage.

When exporting a folder containing multiple files, the files will be compressed into a ZIP file. The folders that will be compressed are as fol-

lows.

 Management folder for saving a multi-page work

 Folders exported through the [File] Menu > [Export animation] > [Image sequence]

 Folders exported through [File] > [Export multiple pages] > [Batch export], [Export fanzine printing data]

If you want to open the file on another device, extract the previously written file.

Exported files and folders cannot be opened directly by Clip Studio Paint. They need to be loaded into Clip Studio Paint’s work folder to be 

able to edit. For details, see "Importing files from storage into Clip Studio Paint".

Quick Share [Tablet/Smartphone]
Select the [File] menu > [Quick Share] to share the content of the currently open canvas to social media and other devices.

Once the dialog box is displayed, select the service you want to use. When sharing from [Quick Share], canvas layers are merged and converted 

to a PNG file. If timeline is enable, it is converted to an mp4 file. The actual canvas content is not affected by [Quick Share].

 Hidden layers will not be in the converted file.

 If you create a selection area, only that selected area is shared. However, selection areas are disabled in mov-

ies.
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 Edit Menu
The [Edit] menu is mainly for performing edit operations on images. This section describes the commands in the [Edit]
menu.

Undo
Select the [Edit] menu > [Undo] to cancel the last operation.

Redo
Select the [Edit] menu > [Redo] immediately after using Undo to redo the last operation.

Cut
On the [Layer] palette, select the layer you want to cut. Create a selection with the [Selection] tool or the [Auto select] tool as needed.

Select the [Edit] menu > [Cut] to copy the selected area to the clipboard. The selected content will be removed from the canvas.

 If you select an object with the [Object] tool, the object will be cut and copied to the clipboard.

 If a selection area or object is not selected, the entire layer will be cut and copied to the clipboard.

 To paste content that has been copied to the clipboard, use the [Edit] menu > [Paste].
CLIP STUDIO PAINT Instruction Manual 247



Menus > Edit Menu > Copy
Copy
On the [Layer] palette, select the layer you want to copy. Create a selection with the [Selection] tool or the [Auto select] tool as needed.

Select the [Edit] menu > [Copy] to copy the selected area to the clipboard. Unlike with [Cut], the copied content will remain on the canvas.

Copy vectors as SVG [PRO/EX][Windows/macOS] 
Selecting a vector layer and then selecting [Edit] menu > [Copy vector in SVG format], preserves information such as control points to be 

pasted into Adobe Illustrator.

 If you select an object with the [Object] tool, the object will be copied to the clipboard.

 If a selection area or object is not selected, the entire layer will be copied to the clipboard.

 To paste content that has been copied to the clipboard, use the [Edit] menu > [Paste].

 If multiple vector layers are selected, they will be copied together to the clipboard.

 If you create a selection, the lines within it will be copied to the clipboard.

 If you have a specific line selected with the Object subtool, only the selected portion will be copied to the clip-

board.

 [Copy vectors as SVG] cannot be used with balloon layers, vector image material layers, or frame border fold-

ers.

 Furthermore, it cannot be used if the timeline is enabled.

 Vector layer compatibility is the same as when exporting SVG format files. For details, see "Export vectors 

[PRO/EX]".
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Paste
Select the [Edit] menu > [Paste] to create a new layer with the content that has been copied to the clipboard.

 For information on how to copy an image to the clipboard, see "Cut" and "Copy".

 If the content was copied from the same canvas, it will be pasted in the same position as it was copied from. 

To change the position of the image, select the new layer on the [Layer] palette and drag the image with the 

[Move layer] tool. Alternatively, you can also select [Edit] menu > [Paste to shown position] to paste the image 

in the center of the canvas window.

 If a Vector layer, Balloon layer, Text layer, Frame Border folder, Ruler is copied to the clipboard with the 

[Object] tool, it will be pasted onto a selected layer of the same type.

 If you are using PRO/EX on a device running Windows/macOS, when you paste a drawing into Adobe Illustra-

tor, a new vector layer is created and the data is pasted as vector lines. The compatibility of Illustrator data is 

the same as when importing SVG format files. For details, see "Vector [PRO/EX]". If a vector layer is not cre-

ated, please check the settings in the [Preferences] dialog box. For details, see "Command".
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Paste to shown position
Clicking [Edit] menu > [Paste to shown position] pastes items as a layer from the clipboard to the middle of the canvas window and adds a 

layer to the [Layer] palette. Adjusting the canvas changes where the middle of the canvas window falls and where the image is then pasted.

 For information on how to copy an image to the clipboard, see "Cut" and "Copy".

 If a Vector layer, Balloon layer, Text layer, Frame Border folder, Ruler is copied to the clipboard with the 

[Object] tool, it will be pasted onto a selected layer of the same type.

 If only the tail of a balloon is copied to the clipboard, it is pasted into the balloon on the balloon layer, regard-

less of where the canvas is in the canvas window. 

 If you are using PRO/EX on a device running Windows/macOS, when you paste a drawing into Adobe Illustra-

tor, a new vector layer is created and the data is pasted as vector lines. The compatibility of Illustrator data is 

the same as when importing SVG format files. For details, see  "Vector [PRO/EX]". If a vector layer is not cre-

ated, please check the settings in the [Preferences] dialog box. For details, see "Command".
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Delete
Select [Edit] menu > [Delete] to delete the selected area or object. For layers such as the [Image material] layer and [Frame border] layer that 

do not allow objects to be selected, the entire layer will be deleted.

Raster layer
Content inside the selected area will be deleted.

When the Object sub tool is in use
If the [Operation] > [Object] sub tool is in use, the object selected by the [Object] tool will be deleted.

Using [Delete] without a selection area will delete the entire layer.
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Delete Outside Selection
Create a selection area and use the [Edit] menu > [Delete Outside Selection] to delete everything outside of the selection area.

Smart Smoothing
Smart Smoothing is a feature that smooths images and reduces pixel noise caused by enlarging an image. This feature is useful after increasing 

the image size in the following ways:

 After using [Edit] Menu > [Change Image Resolution]

 After using [Edit] Menu > [Transform]

To use this feature, select a layer and then select [Edit] Menu > [Smart Smoothing]. The [Smart Smoothing] dialog box will then appear. Adjust 

the settings in the [Smart Smoothing ] dialog box and click [OK] to apply it to the selected layer.

 Only raster and Image material layers can use Smart Smoothing. However, Image materials using vectors can-

not use Smart Smoothing.

 If you create a selection area, the Smart Smoothing will only be applied to the selection area. You cannot 

change the size of the effect after applying the filter.

 If an Image material layer is selected, even if only a portion of it is selected, the effect will apply to the entire 

canvas.

 For images with jaggies caused by low resolution, applying [Change Image Resolution] from the [Edit] Menu 

to scale the image up before [Smart Smoothing] results in a better-looking image.
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Smart Smoothing dialog box

(1) Intensity

Allows you to specify and adjust the strength for Smart Smoothing. Depending on the scale ratio of the image, changing [Intensity] results 

in a better effect. [Weak] is aimed for images that have been doubled in size, [Middle] for images that have been tripled in size, and 

[Strong] for images that have been quadrupled in size.

(2) Remove noise

Turn this on to remove noise from an image.

(3) Processing unit

Selects the hardware needed for Smart Smoothing. Depending on your device, you might not be able to select this.

(4) Preview

Turn this on to preview the settings set in the [Smart Smoothing].

Remove tone (Technology preview) [EX]
The screentones on the selected layer can be removed or converted to grayscale. This is useful when loading manuscripts created with tradi-

tional media or files that have been flattened.

The larger the canvas size is for an image, the longer it may take for the preview to show it. Hold down Esc to stop 

the preview.

 This function is a technology preview. You can try it out before its official release.

 When you use this feature, the image data is uploaded to the server, where the AI interprets the data and con-

verts the tones. You need to be connected to the Internet to use this feature. For information on the image 

uploaded to the server and the generated data, see "About AI features".

 The [Remove tones (Technology preview)] function can be used on raster layers. The function cannot be used 

on other types of layers.

 When using [Remove tones (Technology preview)] on a layer with the expression color set to [Color], the 

image will be converted to grayscale.

 After creating a selection, use [Remove tones (Technology Preview)] to apply the effect only to the selected 

area.

 [Remove tones (Technology preview)] cannot be used on images with height × width dimensions exceeding 

53,000,000 pixels. [Remove tones (Technology preview)] can be used on a selection with less than 53,000,000 

pixels.
CLIP STUDIO PAINT Instruction Manual 253



Menus > Edit Menu > Remove tone (Technology preview) [EX]
Delete tones from selected layer
You can remove screentones from layers.

Select the layer to process and select the [Edit] menu > [Remove tones (Technology Preview)] > [Delete tones from selected layer].

Change tones to grayscale
The screentones on a layer can be changed to grayscale.

Select the layer to process and select the [Edit] menu > [Remove tones (Technology Preview)] > [Change tones to grayscale].
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Fill
The [Fill] tool fills a selected area with a specified color. Select the layer you want to fill from the [Layer] palette. Create a selection area, then 

select [Edit] menu > [Fill] to fill a selection.

Advanced Fill [PRO/EX]
Select the layer you want to fill, then select the [Edit] menu > [Advanced Fill]. In the dialog box that appears, you can adjust detailed settings 

and fill selected areas.

[Advanced fill] Dialog Box

 Using [Fill] on a layer without a selection will fill the entire layer.

 The fill color will be the current drawing color. For details on how to select colors, see "Color Palettes".
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(1) Drawing color

Select the fill color. The available colors depend on the expression color of the layer.

When the expression color is gray or monochrome (drawing color is black only)

You can choose from [Black] or [Transparent color].

When expression color is gray or monochrome (drawing color is white only)

Select the fill color from [White] or [Transparent color].

When expression color is monochrome (drawing color is black and white)

Select the fill color from [Main drawing color], [Sub drawing color], [Black], [White] or [Transparent color].

When expression color is gray (drawing color is black and white)

Select the fill color from [Main drawing color], [Sub drawing color], [Transparent color] or [Specified color].

Click [Specified color] to select the value using the slider or by directly inputting the numeric value.

Color

Select the fill color from [Main drawing color], [Sub drawing color], [Transparent color] or [Specified color].

Clicking [Specified color] displays the [Color settings] dialog box.

(2) Opacity

Set the opacity of the fill color.

 For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

The [Opacity] option is not available if the expression color is set to monochrome.
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(3) Blending mode

Sets how to apply the fill color over the original colors. You can choose from the following blending modes.

Blending modes are also explained in "Setting the Blending Mode".

Normal Replaces the original color with the fill color.

Darken
The RGB values of the fill color and the original color are compared, and the color with the lower value is 

displayed.

Multiply
The RGB values of the fill color are multiplied by those of the original color. The colors will get darker 

after combining. If the fill color is white, the original color will not be changed.

Color burn

Produces an effect similar to the “burn” technique in silver halide photography. The original colors are 

darkened to enhance contrast and then combined with the fill color. If the fill color is white, the original 

colors will not be changed.

Linear burn
The original colors are darkened and then combined with the fill color. If the fill color is white, the origi-

nal color will not be changed.

Black burn
Darkens the original colors, producing an effect similar to underexposure in photography. The effect is 

not applied on transparent areas.

Subtract
The RGB values of the fill color are subtracted from those of the original color. The colors will get darker 

after combining. If the fill color is black, the original color will not be changed.

Lighten
The RGB values of the fill color and the original color are compared, and the color with the higher value 

is displayed.

Screen

The original drawing colors are inverted and then multiplied by the fill color. The colors will get brighter 

after combining. However, if the fill color is black, the original color will not be changed. If the fill color 

is white, the resulting color will be white.

Color dodge
Produces an effect similar to the “dodge” technique in silver halide photography to brighten the colors on 

the lower layer and decrease contrast. If the fill color is black, the original color will not be changed.

Glow dodge
Produces a stronger effect on semi-transparent areas than [Color dodge]. If the fill color is black, the orig-

inal color will not be changed.

Add
The RGB values of the fill color are added to those of the original color. The colors will get brighter after 

combining. If the fill color is black, the original color will not be changed.

Add (Glow)
Produces a stronger effect on semi-transparent areas than [Add]. If the fill color is black, the original 

color will not be changed.

Overlay
Combines by applying [Multiply] or [Screen] depending on the original colors. After combining, the 

bright areas are brighter and the dark areas are darker.

Soft light

Produces different results depending on the brightness of the fill color. When the fill color is brighter than 

50% gray, the result is brighter than the original color, like the dodge effect. When the fill color is darker 

than 50% gray, the result is darker than the original color, like the burn effect. When the fill color is 50% 

gray, the original color is displayed as is.

Hard light

Produces different results depending on the brightness of the fill color. When the fill color is brighter than 

50% gray, the result is a brighter color, resembling the effect of [Screen]. When the fill color is darker 

than 50% gray, the result is a darker color, resembling the effect of [Multiply]. When the fill color is 50% 

gray, the original color is displayed as is.
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Difference
Subtracts the fill color from the original color and replaces the original color with the absolute value of 

the difference.

Erase The drawing is erased in the filled area.

Background Places the fill color below the original color. The fill color behaves as if it were applied first.

Replace alpha
Overlays the fill color over the original color. The opacity of the overlaid area is converted to the [Opac-

ity] specified in the dialog box.

Compare density Fills only when the opacity of the fill color is greater than the original color.

Erase (compare)
Erases the drawing only when the result of subtracting the opacity of the fill color from 100 is smaller 

than the opacity of the original color.

Vivid light

The contrast is strengthened or weakened depending on the fill color. If the fill color is brighter than 50% 

gray, a burn effect is applied and the image is brightened. If it is darker than 50% gray, a dodge effect is 

applied and the contrast of the image is strengthened.

Linear light
The brightness is increased or decreased depending on the fill color. If the fill color is brighter than 50% 

gray, the image is brightened. If it is darker than 50% gray, the image is darkened.

Pin light

The colors of the image are replaced depending on the fill color. If the fill color is brighter than 50% gray, 

the original color is only replaced by the fill color if the original color is darker. If the fill color is darker 

than 50% gray, the original color is only replaced by the fill color if the original color is brighter.

Hard mix
The RGB values of the fill color are added to those of the original color. If the total of an RGB value is 

higher than 255, it is converted to 255. If the total of an RGB value is lower than 255, it is converted to 0.

Exclusion
An effect similar to [Difference], except with a lower contrast. If the fill color is white, the color of the 

lower layer is inverted when blending. When the fill color is black, the original color is displayed as is.

Darker color
The brightnesses of the fill color and the original color are compared and the color with the lower value is 

displayed.

Lighter color
The brightnesses of the fill color and the original color are compared and the color with the higher value 

is displayed.

Divide
The RGB values of the original color are multiplied by 255 and then divided by the RGB values of the fill 

color.

Hue The hue of the fill color is applied while maintaining the brightness and saturation of the original color.

Saturation The saturation of the fill color is applied while maintaining the brightness and hue of the original color.

Color The hue and saturation of the fill color are applied while maintaining the brightness of the original color.

Brightness The brightness of the fill color is applied while maintaining the hue and saturation of the original color.
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(4) Anti-aliasing

Toggles anti-aliasing on and off. When turned on, anti-aliasing is applied after filling an area bordering an anti-aliased line.

[Draw at canvas edge] ON

[Draw at canvas edge] OFF

Anti-aliased line
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(5) Target color

You can refer specific colors as the target fill area.

The following images with gray rectangles describe Filling.

 A: Figures outside the specified area

 B: Figures inside the specified area

 C: Figures outside the specified area

 D: Figures with reduced opacity

 E: Figures in an enclosed area filled with the drawing color.

 F: Figures in white

 G: Figures in an enclosed area filled with black.

 H: Figures in black and gray

 I : Lines not closed

Target all colors

The area that will be filled depends on whether [Fill closed area] is turned on or off.

When [Fill closed area] is turned on, all enclosed areas within the selection area will be filled.

 Changing the [Target color] setting or adjusting the [Color margin] value may improve run over of the fill color.

 Available options for [Target color] will depend on whether [Fill closed area] is turned on or off.

I

Selected Area
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When [Fill closed area] is turned off, everything in the specified area will be filled.

Only transparent

Fills transparent areas enclosed by lines.

Other than transparent

Fills the selected area except for the transparent parts. This item only appears when [Fill closed area] is turned off.
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Area surrounded by transparent

Fills areas enclosed by transparency. Lines and Figures outside of the specified area will not be filled. This item only appears when [Fill 

closed area] is turned on.

Only black

Fills the specified area in black.
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Other than black

Fills colors other than black within the selection area. This item only appears when [Fill closed area] is turned off.

Area surrounded by black

Only fills areas surrounded by black within the specified area. This item only appears when [Fill closed area] is turned on.

Only white and transparent

Fills white color and transparent areas enclosed by lines.
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Other than white and transparent

Fills colors other than white and transparency. Lines outside of the specified area will not be filled. This item only appears when [Fill 

closed area] is turned off.

Area surrounded by white and transparent

Fills areas enclosed by white or by transparency. Lines and shapes outside of the specified area will not be filled. This item only appears 

when [Fill closed area] is turned on.
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Treat semi-transparent as transparent

The area that will be filled depends on whether [Fill closed area] is turned on or off.

When [Fill closed area] is turned on, pale semi-transparent areas created by anti-aliasing or similar effects are treated as transparent and 

are filled. This avoids gaps in the fill caused by anti-aliasing.

When [Fill closed area] is turned off, everything in the specified area will be filled.

All enclosed areas except transparency

The area that will be filled depends on whether [Fill closed area] is turned on or off.

When [Fill closed area] is turned on, when the selected area completely includes the outer perimeter of the enclosed area, the inside of the 

outer perimeter will be filled. Lines and shapes outside of the specified area will not be filled.

When [Fill closed area] is turned off, everything in the specified area will be filled.
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All enclosed areas including transparency

The area that will be filled depends on whether [Fill closed area] is turned on or off.

When [Fill closed area] is turned on, all lines and transparent areas enclosed by lines will be filled. Parts outside of the specified area will 

not be filled.

When [Fill closed area] is turned off, everything in the specified area will be filled.

(6) Color margin

Specifies the error margin to recognize an area as the one areas when filling. A larger value increase the error margin to include colors 

other than the specified color.

(7) Area scaling

Enlarges or shrinks the fill range. You can specify this value in pixels.

The unit for [Area scaling] can be changed in [Preferences]. For details, see "Ruler/Unit".

Before Advanced fill

Error margin of color: 0.0 Error margin of color: 50.0

Configure [Only transparent part] 

for [Target color] to fill in blue.
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(8) Scaling mode

Set the shape of the corners of the fill when using area scaling.

Rectangle

Determines the area by placing a rectangle on each pixel on the outline of the area to enlarge or reduce. The outline of the enlarged or 

reduced area often becomes rectangular.

Round

Determines the area by placing a circle on each pixel on the outline of the area to enlarge or reduce. The outline of the enlarged or reduced 

area becomes round as angles are rounded off.

To darkest pixel

Finds the part of the line with the darkest color and fills up to that area. If set when enlarging the area with [Area scaling], it will prevent 

runovers to the outside of line pixels with maximum opacity.

(9) Fill closed area

Turning on this item fills enclosed areas within a selected area.

(10)Close gap

When gaps are present in a border line, fills by closing gaps up to a specified number of pixels.

The unit for [Close gap] can be changed in [Preferences]. For details, see "Ruler/Unit".

Fill by 

[Rectangle].

Fill by 

[Round].

[Draw at canvas edge] OFF [Draw at canvas edge] ON
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(11) Refer multiple

Turn this on to adjust the layers that are referred to when filling. If turned off, only the selected layer will be referred to.

(12)Exclude from reference

You can set which layers to refer to when filling. This item can be set when [Refer multiple] is turned on.

(13)Refer to image border

When turned on, treats the outer perimeter of the canvas as a border line.

(14)Fill up to vector path

Fills the area up to the vector path (center line). This is only available when referring to a vector layer.

Colorize (Technology preview)
This function automatically colorizes line art using AI technology.

All layers Refer to all layers. However, hidden layers cannot be referred to.

Reference layer Refers to layers set as reference layers.

Selected layer Refers to all layers that currently selected in the [Layer] palette.

Layer in folder
Refers to layers within the layer folder. The layer to refer to must be in the same folder as the 

currently edited layer.

Exclude draft layers Does not refer to draft layers.

Not refer text Does not refer to Text layers or Balloon layers.

Exclude editing layer Does not refer to the current drawing layer.

Exclude paper layer Does not refer to the Paper layer.

Exclude locked layers Does not refer to locked layers.

 This function is a technology preview. You can try it out before its official release.

 When you use this feature, the image data is uploaded to the server, where the AI interprets the data and col-

ors the image. You need to be connected to the Internet to use this feature. For information on the image 

uploaded to the server and the generated data, see "About AI features".

If you use Colorize after creating a selection area, the effect will only be applied to the selected area.
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Colorize all
The image is automatically colorized based on what is drawn on the layer

1 Select the line art that you want to colorize.

(1) Select the layer with the line drawing in the [Layer] palette.

(2) Click [Set as Reference Layer] in the [Layer] palette to specify it as the reference layer.

2 Select the [Edit] menu > [Colorize (Technology preview)] > [Colorize all]. A new raster layer
with colors will be created above the selected layer.

Please only use one line drawing layer.
CLIP STUDIO PAINT Instruction Manual 269



Menus > Edit Menu > Colorize (Technology preview)
Use hint image and colorize
In addition to the outlines, you can also create a hint layer to specify the colors before using Colorize.

1 Set the line art you want to colorize as the reference layer.

(1) Select the layer with the line drawing in the [Layer] palette.

(2) Click [Set as Reference Layer] in the [Layer] palette to specify it as the reference layer.

2 Create a layer to specify colors as a hint for the colorization.

(1) Click [New Raster layer] to create a new layer.

(2) Draw the colors to use as hints for automatically colorizing the image on the created layer.

Please only use one line drawing layer.

Please use a single hint layer.
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3 Select the hint layer and choose [Edit] menu > [Colorize (Technology preview)] > [Use hint
image and colorize].
A new raster layer with colors will be created above the line art layer. The hint layer is hidden.
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Use more advanced settings
In addition to the outlines, you can also create a hint layer to specify the colors before using Colorize. Before confirming the [Colorize] func-

tion, use the [Colorize] dialog box to adjust the coloring.

1 Set the line art you want to colorize as the reference layer.

(1) Select the layer with the line drawing in the [Layer] palette.

(2) Click [Set as Reference Layer] in the [Layer] palette to specify it as the reference layer.

2 Create a layer to specify colors as a hint for the colorization.

(1) Click [New Raster layer] to create a new layer.

(2) Draw the colors to use as hints for automatically colorizing the image on the created layer.

Please only use one line drawing layer.

 Please use a single hint layer.

 It is recommended to use a maximum of 10 hint colors. The more colors are used, the more time it takes to 

process and perform Colorize.
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3 Select the hint layer and choose the [Edit] menu > [Colorize (Technology preview)] > [Use
more advanced settings].

4 When the [Colorize] dialog box appears, choose the colorize method.
A preview of the Colorize results will be shown on the canvas, so you can adjust the settings while checking the results.

(1) Activate [Analyze colors and colorize].

(2) Select the color to adjust for the output.

(3) Adjust the output of each color by modifying the graph.

(4) Repeat steps 2 and 3 for each color.

(5) Use [Colorize areas without hints].

(6) Click [OK].

For details on the [Colorize] dialog box, see "Colorize dialog box".
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5 A new raster layer with colors will be created above the line art layer. The hint layer will be
hidden.

Colorize dialog box

(1) Analyze colors and colorize

When active, automatic coloring is performed for each color on the hint layer. The color output can be adjusted with a [Tone Curve].

(2) Select color

Select the color to adjust with the [Tone Curve]. The display order of the pull-down menu reflects the processing performed for overlap-

ping colors.

The hint color is displayed under [Select color]. If there are more than 10 hint colors, the 10 colors with the largest 

areas are extracted.
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(3) Up

Moves the color selected under [Select color] one step up.

(4) Down

Moves the color selected under [Select color] one step down.

(5) Tone Curve

Adjust the output of the color selected under [Select color]. Drag the control point to adjust.

(6) Reset

Resets the tone curve currently being edited.

(7) Reset all

Resets the content being edited for tone curves of all colors.

(8) Colorize areas without hints

When active, the same coloring result as when executing [Colorize all] is synthesized.

(9) Blurring intensity

Sets the intensity of blurring the coloring results for lines and line boundaries. The larger the number, the more blurred the colors are.

(10)Blurring precision

Specifies the number of times to calculate the blur. The larger the number, the smoother the blur effect will be.

(11) Remove main lines

By expanding the bright areas of an image, the main lines become less visible. The larger the value, the wider the bright areas become.

(12)Preview

Turn this on to preview the results on the canvas.
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Change color of line to drawing 
You can change the color of a drawing (non-transparent areas) to another color. On the [Layer] palette, select the layer that you want to change 

the color of. Use a color palette to select the color you want to change to, then use the [Edit] menu > [Change color of line to drawing] to 

change the color.

Applicable layers
Raster layer

Vector layer

[Change color of line to drawing] cannot be used for the following expression colors:

 Gray or monochrome (black only)

 Gray or monochrome (white only)

 If you use [Change color of line to drawing] after making a selection area, only the drawing inside the selection 

area will be affected.

 If you use [Change color of line to drawing] on a vector layer with a selection area, the vector lines will be 

divided at the boundary of the selection area, and only the parts inside the selection area will be affected.
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Outline Selection [PRO/EX] 
Creates a border around a selected area.

1 Create a selection with the [Selection] Tool.

2 Select the color you want to use for the edge from the [Color Wheel] palette.

3 On the [Layer] palette, select the layer where you want to add the outline.

4 Then, select the [Edit] menu > [Outline Selection] to open the [Outline Selection] dialog
box.

(1) Adjust settings such as [Border type] and [Line width].

(2) Click [OK].
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5 The outline will be added around the selected area.

[Outline Selection] Dialog Box

(1) Border type

Specify where to draw the outline.

(2) Line width

Specify the width of the outline.

Draw outside Outside the border of the selected area.

Draw on border In the center of the border of the selected area.

Draw inside Inside the border of the selected area.

The unit for [Line width] can be changed in [Preferences]. For details, see "Ruler/Unit".
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(3) Expansion type

Specify how to process the outline at the corners of the selected area. You can select from [Rectangle] and [Round].

(4) Draw on canvas edge

When the selection area is created over the edge of the canvas, it will be cut off at the canvas edge. Turn this on to draw the outline at the 

canvas edge.

(5) Anti-aliasing

Allows you to set the strength of anti-aliasing of a vector lines created on vector layers.

You can select from [None], [Weak], [Middle], or [Strong].

[Expansion type] is not available on vector layers.

Rectangle Round

[Draw at canvas edge] OFF [Draw at canvas edge] ON

Selected area trimmed away

at canvas edge.

Drawn even at 

canvas edge.
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Convert brightness to opacity
Converts the brightness of the image in the selected area into opacity.

When a grayscale image is converted, the areas closer to white will be more transparent, while areas closer to black will be more opaque.

Original image: Paper layer hidden After Convert brightness to opacity: Paper layer hidden

Original image: Paper layer hidden After Convert brightness to opacity: Paper layer hidden
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Register Material [PRO/EX]
You can turn selected content into a material and register it to the [Material] palette. The type of material will depend on what is selected.

Image
Converts the selected layer on the [Layer] palette to a material. Converted materials are registered in the [Material] palette.

You can register raster layers and vector layers as well as gradient layers and fill layers.

If there is a selection area on the canvas, the selection area will be registered as a material.

Template
Registers the entire canvas, including layers, to the [Material] palette.

The registered material will appear as a [Template] option in the [New] dialog box.

Animation
Converts the clip or track selected in the [Timeline] palette to a material.

Converted materials are registered in the [Material] palette as animation materials.

The cels (layers) and specified cels in the selected clip or track are registered in the animation material.

For details on how to register materials to the [Material] palette, see "Registering a Material from the Canvas" and 

"Registering a Layer as Material".

 For details on how to register materials to the [Material] palette, see "Register Layer as Template Material".

 For details on the [New] dialog box, see "New".

 The registered material can also be used as a normal material from the [Material] palette.

 If a canvas with only frame border folders is registered, it will be registered as a Framing template. In all other 

cases, the canvas will be registered as a Layer template. You can use both types of template as Templates 

from the [New] dialog box.

 For details on how to register materials to the [Material] palette, see "Register animation material".

 Animation materials cannot be registered if the timeline is disabled.
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Tonal correction
This layer allows you to adjust the brightness, hue, saturation, luminosity, and gradient of the selected layer.

Types of correction
Clip Studio Paint offers the following types of tonal correction.

Applying a Tonal Correction
This section describes how to apply tonal corrections, using the example of Level Correction.

1 On the [Layer] palette, select a layer.

2 Select the [Edit] menu > [Tonal Correction] > [Level Correction].

With the [Edit] menu > [Tonal Correction] command, you can apply the effect only to the selected layer. To learn 

how to apply an effect to multiple layers, see "New Correction Layer [PRO/EX]".

Brightness/Contrast Adjusts the brightness and contrast of the selected layer.

Hue/Saturation/Luminosity
Changes the color of the selected layer by adjusting the three components (hue, saturation and lumi-

nosity) of the HSV color model.

Posterization [PRO/EX] Converts an image into the specified gradient.

Reverse gradient [PRO/EX] Inverts the colors in an image.

Level Correction Adjusts the contrast of an image using the histogram.

Tone curve [PRO/EX] Adjusts the contrast of an image using the tone curve.

Color balance [PRO/EX] Adjusts the tone of an image by configuring the balance of each RGB color.

Binarization [PRO/EX] Converts the selected layer into a black and white duotone layer.

Gradient map [PRO/EX] Each shade in the image is replaced with colors of the selected gradient.

 Some Tonal Correction effects can only be applied on certain types of layers. Please see the “Applicable lay-

ers” section for each correction layer type to check which layers can be used.

 If you create a selection area, the color correction will only be applied to the selection area. You cannot 

change the size of the effect after applying the filter.
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3 Adjust the settings in the Tonal Correction dialog box that appears.

(1)  Turn on [Preview] and adjust the settings while checking the final result.

(2) Select the channel to adjust brightness.

(3) Drag the triangular control point at the base of the histogram to adjust the brightness of the image.

(4) Move the control point beneath [Output] to adjust the intensity of the brightest points and darkest points in the image.

(5) Click [OK].

4 The tonal correction effect will be applied to the image.
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Brightness/Contrast
Select the [Edit] menu > [Tonal Correction] > [Brightness/Contrast] to open the [Brightness/Contrast] dialog box. Adjusts the brightness and 

contrast of the selected layer.

[Brightness/Contrast] Dialog Box

(1) Brightness

Adjusts the brightness of the image. A lower value darkens the image, while a higher value brightens the image.

(2) Contrast

Adjusts the contrast (difference between lights and darks) of the image. A lower value reduces the contrast, while a larger increases the 

contrast.

(3) Preview

Turn this on to preview the results on the canvas.

(4) Auto adjust

Automatically adjusts [Brightness] and [Contrast] in accordance with the imported image.

Applicable layers
Raster layer (gray)

Raster layer (color)

 To learn how to apply a Tonal Correction effect to a layer, see "Applying a Tonal Correction".

 For information on the settings in the [Brightness/Contrast] dialog box, please see the following section.

Original image After Brightness/Contrast
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Hue/Saturation/Luminosity
To adjust the hue, saturation, or luminosity of the selected layer, select the [Edit] menu > [Tonal Correction] > [Hue/Saturation/Luminosity]. 

This will give options to adjust hue, saturation, and luminosity based on the HSV color model.

[Hue/Saturation/Luminosity] Dialog Box

(1) Hue

Indicates the gradient of color to adjust the hue.

(2) Saturation

Adjusts the vividness of the color. Higher values result in more vivid colors.

(3) Luminosity

Adjusts the brightness of the color. Higher values result in brighter colors.

(4) Preview

Turn this on to preview the results on the canvas.

Applicable layers Raster layer (color)

 To learn how to apply a Tonal Correction effect to a layer, see "Applying a Tonal Correction".

 For information on the settings in the [Hue/Saturation/Luminosity] dialog box, please see the following sec-

tion.

Original image After Hue/Saturation/Luminosity
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Posterization [PRO/EX]
Select the [Edit] menu > [Tonal Correction] > [Posterization] to open the [Posterization] dialog box. You can convert the layer into the speci-

fied number of levels.

[Posterization] Dialog Box

(1) Number of gradients

Set the number of levels to split the image values into. You can set between 2 and 20 levels. More levels will result in a smoother effect.

(2) Preview

Turn this on to preview the results on the canvas.

Applicable layers
Raster layer (gray) 

Raster layer (color)

 To learn how to apply a Tonal Correction effect to a layer, see "Applying a Tonal Correction".

 For information on the settings in the [Posterization] dialog box, please the following section.

Original image After posterization: 3-level posterization
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Reverse gradient [PRO/EX]
Select the [Edit] menu > [Tonal Correction] > [Reverse Gradient] to invert the colors (RBG values) of the selected layer. Inverted values are in 

RGB. For example, R: 100, G: 255, B: 0 would be inverted to R: 155, G: 0, B: 255.

Level Correction
Select the [Edit] menu > [Tonal Correction] > [Level Correction] to adjust the brightness of the selected layer with a histogram. You can adjust 

the brightness of the selected layer using the graph.

Applicable layers

Raster layer (monochrome)

Raster layer (gray)

Raster layer (color)

If you create a selection area, the filter will only be applied to the selection area.

Applicable layers
Raster layer (gray)

Raster layer (color)

Original image After Reverse gradient

Original image After level correction
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[Level Correction] Dialog Box

(1) Channel

Select a channel to adjust the levels. You can choose from [RGB], [Red], [Green], or [Blue].

(2) Histogram

This graph displays the volume of the dark areas (left side) and bright areas (right side) as mountain-like peaks.

(3) Shadows

This controls the darkest parts of the image. Drag to the left and right to adjust the brightness of the image. Drag to the left to make the 

image brighter, or to the right to make the image darker. The [Shadows] control point is usually the furthest left under the histogram.

(4) Midtones

This controls the midtones of the image. When you move the [Shadows] control point or the [Highlights] control point, the [Midtones] 

control point moves in tandem. You can move the [Midtones] control point without affecting the [Shadows] or [Highlights] control points. 

Drag to the left to make the image brighter, or to the right to make the image darker.

(5) Highlights

This controls the lightest parts of the image. Drag to the left and right to adjust the brightness of the image. Drag to the left to make the 

image brighter, or to the right to make the image darker. The [Highlights] control point is usually the furthest right under the histogram.

(6) Shadows output

This controls the darkest parts of the image. Drag to the left and right to adjust the brightness of the image. Drag to the left to make the 

image brighter, or to the right to make the image darker.

(7) Highlights output

This controls the brightest parts of the image. Drag to the left and right to adjust the brightness of the image. Drag to the left to make the 

image brighter, or to the right to make the image darker.

(8) Preview

Turn this on to preview the results on the canvas.

(9) Auto adjust

Automatically adjusts the contrast in accordance with the imported image.

 This section describes how to apply tonal correction effects to layers, using the example of Level Correction. 

For details, see "Applying a Tonal Correction".

 For information on the settings in the [Level Correction] dialog box, please see the following section.
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Tone curve [PRO/EX]
Select the [Edit] menu > [Tonal Correction] > [Tone Curve] to open the [Tone Curve] dialog box. You can adjust the brightness of the selected 

layer using the graph.

[Tone Curve] Dialog Box

(1) Channel

Select a channel to adjust the brightness. You can choose from [RGB], [Red], [Green] and [Blue].

(2) Tone curve

A graph to adjust the contrast of the image. Drag the control points to adjust the contrast.

The horizontal axis of the graph is the "Input" value (original brightness) and the vertical axis is the "Output" value (brightness after 

adjustment).

Applicable layers
Raster layer (gray)

Raster layer (color)

 To learn how to apply a Tonal Correction effect to a layer, see "Applying a Tonal Correction".

 For information on the settings in the [Tone Curve] dialog box, please see the following section.

Original image After Tone Curve
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(3) Preview

Turn this on to preview the results on the canvas.

(4) Reset

Reset the image to the original state.

 This graph displays the volume of the dark areas (left side) and bright areas (right side) as mountain-like 

peaks. Adjust the tone curve while checking the balance of the original image in the histogram.

 Click on the graph to create a new control point.

 To delete a control point, drag it outside of the graph.
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Color balance [PRO/EX]
Select the [Edit] menu > [Tonal Correction] > [Color balance] to open the [Color balance] dialog box. You can adjust the colors of an image by 

adjusting the balance of each RGB color.

[Color balance] Dialog Box

(1) Color balance

Adjust the color balance of the image by using the sliders. You can move the three sliders left and right to adjust the balance of cyan and 

red, magenta and green, and yellow and blue.

The value of each slider is displayed in [Color level]. From left to right, these show the current values of [Cyan - Red], [Magenta - Green] 

and [Yellow - Blue]. You can also directly input values in these fields.

(2) Gradient balance

Select from [Shadow], [Half tone] and [Highlight] to adjust the balance of the selected level. You can adjust the color balance at each level 

separately.

(3) Keep brightness

Keeps the same level of brightness when the gradient balance is adjusted.

Applicable layers Raster layer (color)

 To learn how to apply a Tonal Correction effect to a layer, see "Applying a Tonal Correction".

 For information on the settings in the [Color balance] dialog box, please see the following section.

Original image After Color balance
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(4) Preview

Turn this on to preview the results on the canvas.

Binarization [PRO/EX]
Select the [Edit] menu > [Tonal Correction] > [Binarization] to open the [Binarization] dialog box. This converts the selected layer to blacks 

and whites.

[Binarization] Dialog Box

(1) Threshold

Colors darker than the set threshold will be converted to black, while colors brighter than the set threshold will be converted to white.

(2) Leave transparency

If turned on, the opacity of the original image will be kept.

(3) Preview

Preview the image on the canvas.

Applicable layers
Raster layer (gray)

Raster layer (color)

 To learn how to apply a Tonal Correction effect to a layer, see "Applying a Tonal Correction".

 For information on the settings in the [Binarization] dialog box, please see the following section.

Original image After binarization
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Gradient map [PRO/EX] 
Select the [Edit] menu > [Tonal Correction] > [Gradient map] to open the dialog box. This converts the selected layer to the colors of the gradi-

ent, based on the density of the original colors.

[Gradient map] dialog box

Applicable layers Raster layer (color)

 To learn how to apply a Tonal Correction effect to a layer, see "Applying a Tonal Correction".

 For information on the settings in the [Gradient map] dialog box, please see the following section.

After Gradient mapOriginal image
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A. Gradient settings
You can edit the gradient by moving the nodes.

(1) Color bar

A preview of the gradient.

(2) Node

Set the color of the gradient. You can create extra nodes by clicking an empty space.

Drag the nodes horizontally to adjust the gradient. Selected nodes are shown in blue.

To delete a node, drag it up or down from the gradient bar.

(3) Select left node

Switches to the next node on the left.

(4) Select right node

Switches to the next node on the right.

(5) Reverse gradient

Flips the gradient colors.

(6) Delete node

Deletes the selected node.

B. Gradient set
Here you can manage the gradient settings.

(1) Gradient set lists

Displays a list of gradient sets you can select from.
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(2) Show Menu

Opens the gradient set menu.

(3) Gradient list

A list of gradients in the selected gradient set.

(4) Up/Down

Move the position of the gradient selected in the list up or down.

(5) Replace Gradient

Overwrites the selected gradient with the gradient displayed in the color bar.

(6) Apply to Gradient Settings

Shows the selected gradient in the color bar.

(7) Duplicate Gradient

Duplicates the selected gradient.

(8) Add Gradient

Adds the gradient displayed on the color bar to the list. The new gradient is added to the bottom of the list.

Create new set Creates a new color gradient set.

Delete set Deletes the selected gradient set.

Duplicate set Duplicates the selected gradient set.

Settings of set Change the name of the selected gradient set.

Register set as material

Displays the [Material property] dialog box and allows you to register the selected gradient set 

to the [Materials] palette. For details on the [Material property] dialog box, see "[Material prop-

erty] Dialog Box".

Import material set

Opens the [Import material set] dialog box, where you can import a gradient set registered to the 

[Materials] palette. For details on the [Import material set] dialog box, see "[Import material set] 

dialog box".

Add Gradient
Add the settings of the gradient displayed on the color bar to the list. The added gradient settings 

are displayed at the bottom of the list.

Delete Gradient Deletes the selected gradient from the list.

Duplicate Gradient Duplicates the selected gradient.

Change Gradient Name Change the name of the selected gradient.

Replace Gradient Overwrites the selected gradient with the gradient displayed in the color bar.

Apply to Gradient Settings Shows the selected gradient in the color bar.

Import Gradient

Import a gradient settings file from IllustStudio (extension: cgs).

Gradient settings file from IllustStudio (extension: cgs) cannot be imported on tablets/smartpho-

nea/Macs with M1 chips.

 Gradient sets registered to the [Material] palette can be uploaded to the Clip Studio server using Clip Studio, 

the portal application. For details on uploading methods, please see Clip Studio TIPS.

 Clip Studio can be started from the [File] menu ([CLIP STUDIO PAINT] menu on macOS and Tablet) > [Open 

CLIP STUDIO]. For the Smartphone, select [Menu] > [Usage / Material / Work / Support].
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(9) Delete Gradient

Deletes the selected gradient from the list.

C. Position
Indicates the position of the selected node.

D. Color
Indicates the color of the selected node.

(1) Main drawing color

Uses the main drawing color as the node color. If you change the main drawing color with a color palette, the node color will also change.

(2) Sub drawing color

Set the sub drawing color for node color. If you change the sub drawing color with a color palette, the node color will also change.

(3) Specified color

Set a specified color for node color. Click the color indicator to open the [Color settings] dialog box.

(4) Obtain screen color [Windows/macOS]

You can use the eyedropper to pick a color from the screen as the specified color.

E. Mixing rate curve
Allows you to adjust the change in color between the selected node and the node to the right.

 The horizontal axis of the graph indicates the position of the nodes.

 The vertical axis of the graph indicates the color mixing ratio with respect to the node at the right. When the value is larger, the color 

between the nodes will be closer to the color of the node to the right. When the value is lower, the color between the nodes will be 

closer to the color of the selected node.

 Clicking on the curve allows you to add up to 16 points. which you can drag to adjust the mixing rate curve. To delete a control point, 

drag it outside the graph.

F. Preview
Turn this on to preview the results on the canvas.

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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[Material property] Dialog Box

(1) Material name

Enter a name for the material.

(2) Location to save material

Click a folder in which to save the material. The saved location will be applied to the tree view in the [Materials] palette.

(3) Search tag

Here you can specify the search tag that will appear in the tag list.

Click plus icon in the lower right to create a new tag.

[Import material set] dialog box

(1) Search box

Enter a keyword to search for a gradient set image.

(2) Tag list

A list of tags assigned to materials. Clicking the button shows the [Gradient set list] from the specified settings in [Gradient set].
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(3) Gradient set list

Displays the list of gradient sets.

(4) Show item check box

Shows a checkbox for each gradient set thumbnail in the list. You can select a material by clicking the checkbox.

(5) Large Thumbnails

Shows the gradient sets as large thumbnails.

(6) Small Thumbnails

Shows the gradient sets as small thumbnails.

(7) Detail View

Shows thumbnails and details of the gradient sets.
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Transform
Selecting items from [Edit] menu > [Transform] with a layer selected, moves or transforms the selected layer.

Mode types
The Mode types listed under [Edit] menu > [Transform] are as follows.

Transform image
This section describes how to transform images in a variety of ways.

1 First select a layer on the [Layer] palette.

Scale/Rotate Scales up/down or rotates the image. For details, see "Scale/Rotate".

Scale Scales up/down or rotates the image. For details, see "Scaling Up/Scaling Down".

Rotate Rotates the image. For details, see "Rotate".

Free Transform Freely transforms the image. For details, see "Free Transform".

Distort

Distorts the image. Dragging the corner handles of the bounding box moves the image in the direction 

of the the guide lines. Dragging the middle point handles of the bouding box, moves that line parallel 

to the other side of the guide line. For details, see "Distort".

Skew
Skews the image. Dragging the handles moves the whole side of the image in the direction of the the 

guide lines. For details, see "Skew".

Perspective
Skews the image. Dragging any of the corner handles will move the opposite corner handle into the 

opposite direction. For details, see "Perspective".

Flip Horizontal Flips the image horizontally. For details, see "Flip Horizontal".

Flip Vertical Flips the image vertically. For details, see "Flip Vertical".

Mesh Transformation [PRO/

EX]

Allows you to create guides and handles by dividing a selected area with a lattice to transform an 

image by portions by dragging the corresponding lattice point. For details, see "Mesh Transformation 

[PRO/EX]".

 For details on how to use [Flip Horizontal], see "Flip Horizontal".

 For details on how to use [Flip Vertical], see "Flip Vertical".

 For details on how to use [Mesh Transformation], see "Mesh Transformation [PRO/EX]".
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2 Using the selection tool, create a selection.

3 Select the method of transformation from the [Edit] menu > [Transform]. In this example,
[Free Transform] is selected.

4 Drag either the bounding box guide lines or handles to transform the image.

 Selecting multiple layers transforms all of the selected layers.

 To transform layers other than Raster layers, Vector layers, Layer Masks and Selection layers, see "Com-

mand".

 To change the Layer Mask only, you must unlink the Layer and the Layer Mask. For details, see "Link Mask to 

Layer".

 To change the Ruler only, you must unlink the Layer and the Ruler. For details, see "Link Ruler to Layer".

 If there is no selection area, the entire drawn area of the selected layer will be the target of the transformation.

 Only selections on Raster layers, Vector layers, Layer Masks and Selection layers can be transformed.

For details on how to transform an image, see "Using handles and palettes to transform".
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5 Click [Confirm] on the launcher below the bounding box to apply the transformation.

Using handles and palettes to transform
Selecting items from [Edit] menu > [Transform] shows the handles and guide lines allowing you to adjust them.

You can also adjust transformation values and the transformation mode from the [Tool Property] Palette.

Using the handles to transform
Dragging a handle allows you to transform the image. The directions the handles can move depends on the transformation mode. For deatils on 

how to use, see "Mode types".

 You can double-click inside the bounding box to confirm the transformation.

 Pressing Enter also applies the transformation.

 Press Esc to cancel the transformation.

 If the [Transform launcher] does not appear, select [View] > [Object Launcher].

For details on how to use [Mesh Transformation], see "Mesh Transformation [PRO/EX]".
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Move image
Click on the inside of the bounding box and drag to move the image.

Rotate image
Drag outside the bounding box to rotate the image around the center (+) point.

Hold down Shift while dragging the drawing area or bounding box to move the image horizontally, vertically, or 

along a 45-degree diagonal angle.

 Hold down Shift while dragging to rotate in increments of 45 degrees.

 Dragging the center moves the center of rotation. Change the center point’s position from the [Tool Property] 

palette’s [Center of rotation].

 Hold down Shift while dragging the center point to move the center point horizontally, vertically, or along a 45-

degree diagonal angle.

 Hold down Alt while clicking the canvas to move the center point to wherever you click.

 You cannot rotate the image while using [Scale] from [Edit] > [Transform]. To rotate an image either select 

[Rotation angle] from the [Tool Property] Palette or a transformation option from [Mode]. For details on how to 

change this, see "Changing the Mode".

Center
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Adjusting transformations with the Tool property palette
You can the image scale ratio and angle while transforming from the [Tool Property] Palette.

For items that can be set, see "Tool property palette settings".

Changing the Mode
[Mode] on the [Tool Property] palette allows you to change the transformation method.

Tool property palette settings
When transforming, the following operations can be performed from the [Tool Property] palette.

(1) Reset transformation

Restores the image being edited to its pre-transformation state.

(2) Flip horizontal

Reverses the image horizontally around the center.

(3) Flip vertical

Reverses the image vertically around the center.

 If the transformation is recorded in an auto action, [Auto action settings] will be shown in the [Tool Property] 

palette. For details, see “Transformation settings” in the Clip Studio Paint Tool Setting Guide.

 For details on how to use [Mesh Transformation], see "Mesh Transformation [PRO/EX]".
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(4) OK

Commits the transformation.

(5) Cancel

Cancels the transform.

(6) Mode

This setting changes the transformation mode. You can select from [Scale/Rotate], [Scale], [Rotate], [Free Transform], [Distort], [Skew] or 

[Perspective].

(7) Center of rotation

Sets the center of rotation for the image.

You can select from [Center], [Top left], [Top right], [Bottom right], [Bottom left], [Top], [Left], [Right], [Bottom] and [Free position].

(8) Change vector width [PRO/EX] 

Turning this on allows you to scale the line width of a Vector layer, a Balloon layer or a Frame Border folder.

(9) Keep original image

When turned on, the original image can be kept when moving or transforming.

(10)Scale ratio (Horizontal)

Specifies the horizontal width of an imported image as a percentage of the original image (%).

(11) Scale ratio (Vertical)

Specifies the vertical width of an imported image as a percentage of the original image (%).

(12)Keep aspect ratio

When this is on, the image will keep its original aspect ratio (proportions) when scaling up or down. Use the handles to keep aspect ratio 

of original image when scaling.

(13)Rotation angle

Specifies the image rotation angle with respect to the horizontal position.

(14)Adjust position

Allows you to adjust the size of an image being transformed automatically. The size is specified by the size of the bounding box.

Selecting the next layer repeats the transformation on the duplicated layer. The original image is left on another 

layer.

 Image material layer

 Text layer

 Balloon layer

 Gradient layer

 Stream line layer

 Saturated line layer

Canvas The size of image’s bounding box can be adjusted within the size of the Canvas.

Bleed border The size of image’s bounding box can be adjusted within the size of the Bleed border.

Cropped border The size of image’s bounding box can be adjusted within the size of the Cropped border.

Default border The size of image’s bounding box can be adjusted within the size of the Default border.

Free position The size of image’s bounding box cannot be adjusted.
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(15) Interpolation method

You can select the method for interpolating the colors of pixels when transforming images.

Scale/Rotate
Selecting [Edit] menu > [Transform] > [Scale/Rotate] scales the image up and down by by dragging the handles.

Scaling Up/Scaling Down
Dragging the handles allows you to maintain the current aspect ratio while resizing an image.

 For details on the [Bleed border], [Cropped border], [Default border], see "Explanation: What Are the Default 

Border, Cropped Border and Bleed Border? [PRO/EX]".

 When [Bleed border], [Cropped border], or [Default border] is selected on a canvas on which [Bleed border], 

[Cropped border], and [Default border] are not set, the size of the [Guide] is adjusted so that it is included in 

the [Canvas].

Smooth edges (bilinear)
This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). However, outlines may become blurred depending on the image.

Hard edges (nearest neigh-

bor)

When interpolating the image, the pixels in the image are duplicated. Since the colors are not 

affected by neighboring pixels, outlines (boundaries between colors) remain sharp. However, 

outlines may become jagged depending on the image.

Clear edges (bicubic)

This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). This method results in stronger outlines compared to the [Smooth outline (bilin-

ear method)] setting. However, white noise may appear around outlines depending on the image.

High accuracy (average col-

ors)

The average colors of the original pixels are strictly calculated and contained for each pixel after 

the transformation. Scaling up makes the line sharper and scaling down makes the line smoother. 

Even detailed lines can be preserved when scaling the image down. However, this method can 

result in blurred outlines and can take a long time to process depending on the image.

 For details on the Transform operates, see "Transform image".

 For details on how to use Transform, see "Using handles and palettes to transform".

 You can also use the [Tool Property] Palette to Transform. For details on the [Tool Property] palette settings, 

please see to the following "Tool property palette settings".

 Fill in monochrome layers and Tonal Correction layers do no support [Scale/Rotate].
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Rotating an image
Dragging the center (+) mark moves the center of rotation. Drag outside the bounding box to rotate the image around the center point.

 When scaling, hold down Alt while dragging the handle to scale the ruler around the center point.

 Hold down Shift while dragging a handle to scale without changing the original ratio.

 Dragging a handle while holding down Ctrl allows you to freely transform the image. 

 Dragging a handle while holding down Shift + Ctrl moves the handle according to the direction of the guide-

line.

 When [Keep aspect ratio] in the [Tool Property] Palette is turned off you can scale without changing the origi-

nal aspect ratio.

 Hold down Shift while dragging to rotate in increments of 45 degrees.

 Change the center point’s position from the [Tool Property] palette’s [Center of rotation].

 Hold down Alt while clicking the canvas to move the center point to wherever you click.

 When dragging the center point while holding down Shift, the center point can be moved horizontally, verti-

cally or 45° diagonally.

 Selected guide line will not Rotate. Other Special rulers support [Rotate].

Center
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Scaling Up/Scaling Down
Selecting [Edit] menu > [Transform] > [Scale up/Scale down/Rotate] scales the image up and down by dragging the handles.

With this setting, the image cannot be rotated even by dragging the guidelines.

 Dragging a handle while holding down Alt allows you to scale the image up and down from the center point. 

 Hold down Shift while dragging a handle to resize without changing the original ratio.

 Dragging a handle while holding down Ctrl allows you to freely transform the image. 

 Dragging a handle while holding down Shift + Ctrl moves the handle according to the direction of the guide-

line.

 When [Keep aspect ratio] in the [Tool Property] Palette is turned off you can scale without changing the origi-

nal aspect ratio.

 To rotate an image either select [Rotation angle] from the [Tool Property] Palette or a transformation option 

from [Mode].

 For details on how Transform operates, see "Transform image".

 For details on how to use Transform, see "Using handles and palettes to transform".

 You can also use the [Tool Property] Palette to Transform. For details on the [Tool Property] palette settings, 

please see the following "Tool property palette settings".

 Fill in monochrome layers and Tonal Correction layers do no support [Scale].
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Rotate
Selecting [Edit] menu > [Transform] > [Rotate] rotates the image. Dragging the center (+) mark moves the center of rotation. Dragging outside 

the bounding box to rotate the image around the center point.

Dragging the handles does not scale the image up or down in this case.

 Hold down Shift while dragging to rotate in increments of 45 degrees.

 Change the center point’s position from the [Tool Property] palette’s [Center of rotation].

 Hold down Alt while clicking the canvas to move the center point to wherever you click.

 When dragging the center point while holding down Shift, the center point can be moved horizontally, verti-

cally or 45° diagonally.

 To scale an image either select [Scale ratio] from the [Tool Property] Palette or a transformation option from 

[Mode].

 For details on the Transform operates, see "Transform image".

 For details on how to use Transform, see "Using handles and palettes to transform".

 You can also use the [Tool Property] Palette to Transform. For details on the [Tool Property] palette settings, 

please see to the following "Tool property palette settings".

 Fill in monochrome layers and Tonal Correction layers do no support [Rotate].

 Selected guide lines do not support [Rotate]. Other Special rulers support [Rotate].

Center
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Free Transform
Selecting [Edit] menu > [Transform] > [Rotate] freely transforms a layer.

Dragging a handle allows you to transform the image. [Free Transform] allows you to freely transform by dragging a handle.

Distort
Selecting [Edit] menu > [Transform] > [Distort] moves the handles according to the guide lines.

Dragging the middle point handles of the bouding box, skews the shape along the guide lines.

 Hold down Shift while dragging a handle to move the handle according to the direction of the guideline.

 Dragging a handle while holding down Ctrl allows you to scale the image up and down. 

 Dragging a handle while holding down Ctrl + Shift allows you to scale the image without changing the original 

aspect ratio.

 Dragging a handle while holding down Ctrl + Alt keys allows you to scale up/down the image from the center 

point. 

 For details on the Transform operates, see "Transform image".

 For details on how to use Transform, see "Using handles and palettes to transform".

 You can also use the [Tool Property] Palette to Transform. For details on the [Tool Property] palette settings, 

please see to the following "Tool property palette settings".

 Layers that support [Free Transform] include Raster layers, Vector layers, Layer Masks, Image material layers, 

Frame Border folders, Rulers, and Selection layers.
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Skew
Selecting [Edit] menu > [Transform] > [Skew] moves the handles according to the guide lines.

Dragging the handles of the bouding box, skews the shape along the guide lines.

 Dragging a handle while holding down Ctrl allows you to scale the image up and down. 

 Dragging a handle while holding down Ctrl + Shift allows you to scale the image without changing the original 

aspect ratio.

 Dragging a handle while holding down Ctrl + Alt keys allows you to scale up/down the image from the center 

point. 

 For details on the Transform operates, see "Transform image".

 For details on how to use Transform, see "Using handles and palettes to transform".

 You can also use the [Tool Property] Palette to Transform. For details on the [Tool Property] palette settings, 

please see to the following "Tool property palette settings".

 Layers that support [Distort] include Raster layers, Vector layers, Layer Masks, Image material layers, Frame 

Border folders, Rulers, and Selection layers.

 Dragging a handle while holding down Ctrl allows you to scale the image up and down. 

 Dragging a handle while holding down Ctrl + Shift allows you to scale the image without changing the original 

aspect ratio.

 Dragging a handle while holding down Ctrl + Alt keys allows you to scale up/down the image from the center 

point. 

 For details on the Transform operates, see "Transform image".

 For details on how to use Transform, see "Using handles and palettes to transform".

 You can also use the [Tool Property] Palette to Transform. For details on the [Tool Property] palette settings, 

please see to the following "Tool property palette settings".

 Layers that support [Skew] include Raster layers, Vector layers, Layer Masks, Image material layers, Text lay-

ers, Balloon layers, Frame Border folders, Rulers and Selection layers.
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Perspective
Selecting [Edit] menu > [Transform] > [Perspective ] moves the handles according to the guide lines.

Dragging any of the corner handles will move the opposite corner handle into the opposite direction.

Flip Horizontal
Selecting [Edit] menu > [Transform] > [Flip Horizontal] flips the image around the center point (+). Clicking [OK] from the transform launcher 

under the guide lines confirms the transformation.

 Dragging a handle while holding down Ctrl allows you to scale the image up and down. 

 Dragging a handle while holding down Ctrl + Shift allows you to scale the image without changing the original 

aspect ratio.

 Dragging a handle while holding down Ctrl + Alt keys allows you to scale up/down the image from the center 

point. 

 For details on the Transform operates, see "Transform image".

 For details on how to use Transform, see "Using handles and palettes to transform".

 You can also use the [Tool Property] Palette to Transform. For details on the [Tool Property] palette settings, 

please see to the following "Tool property palette settings".

 Layers that support [Perspective] include Raster layers, Vector layers, Layer Masks, Image material layers, 

Frame Border folders, Rulers, and Selection layers.
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Flip Vertical
Selecting [Edit] menu > [Transform] > [Flip Vertical] flips the image around the center point (+).

Clicking [OK] from the transform launcher under the guide lines confirms the transformation.

 Dragging the center move the position of the center. Also, hold down Alt while clicking the canvas to move the 

center point to wherever you click.

 Allows the layer to be horizontally reversed before confirming [Flip Horizontal]. For details on how to use 

Transform, see "Using handles and palettes to transform".

 You can also use the [Tool Property] Palette to Transform. For details on the [Tool Property] palette settings, 

please see the following "Tool property palette settings".

 Fill in monochrome layers and Tonal Correction layers do no support [Flip Horizontal].

 Dragging the center move the position of the center. Also, hold down Alt while clicking the canvas to move the 

center point to wherever you click.

 Allows the layer to be horizontally reversed before confirming [Flip Vertical]. For details on how to use Trans-

form, see "Using handles and palettes to transform".

 You can also use the [Tool Property] Palette to Transform. For details on the [Tool Property] palette settings, 

please see to the following "Tool property palette settings".

 Fill in monochrome layers and Tonal Correction layers do no support [Flip Vertical].
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Mesh Transformation [PRO/EX]
Allows you to create guides and handles by dividing a selected area with a lattice to transform an image by portions by dragging the corre-

sponding lattice point.

1 On the [Layer] palette, select the layer you want to transform.

2 Using a selection tool, create a selection.

3 Select the [Edit] menu > [Transform] > [Mesh Transformation].

Layers that support [Mesh Transformation] include Raster layers, Vector layers, Layer Masks, and Selection lay-

ers.

 Selecting multiple layers transforms all of the selected layers.

 To change the Layer Mask only, you must unlink the Layer and the Layer Mask. For details, see "Link Mask to 

Layer".

If there is no selection area, the entire drawn area of the selected layer will be the target of the transformation.
CLIP STUDIO PAINT Instruction Manual 313



Menus > Edit Menu > Transform
4 On the [Tool Property] palette, set the number of lattice points (handles).

5 As many lattices as you set will show in the selected area of the image. Transform by drag-
ging the bounding box or handles. 

You can set up to 10 lattice points.

Hold down Shift while dragging a handle to move the handle horizontally, vertically or 45° diagonally.
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6 Click [Confirm] on the launcher below the bounding box to apply the transformation.

Tool property palette settings
[Mesh Transformation] becomes and item in the [Tool Property] Palette when you are using it. 

(1) Reset transformation

Restores the image to the original state before transforming.

(2) Flip horizontal

Flips the image horizontally around the center.

(3) Flip vertical

Flips the image vertically around the center.

 Double click on areas other than the handles inside the guides to confirm the transformation.

 Pressing Enter also applies the transformation.

 Pressing Esc before confirming the transformation cancels it.

 If the [Transform launcher] does not appear, select [View] > [Object Launcher].

If the transformation is recorded in an auto action, [Auto action settings] will be shown in the [Tool Property] pal-

ette. For details on the setting items, see the description of "Transformation settings" in "CLIP STUDIO PAINT Tool 

Setting Guide".
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(4) OK

Applies the transformation.

(5) Cancel

Cancels the transformation.

(6) Center of rotation

Specifies the center of the image transformation.

You can select from [Center], [Top left], [Top right], [Bottom right], [Bottom left], [Top], [Left], [Right], [Bottom], and [Free position].

(7) Change vector width

If turned on while scaling a vector layer, the line width changes in accordance with the transformation.

(8) Keep original image

When turned on, the original image can be kept when moving or transforming.

(9) Number of horizontal lattice points

Specifies the number of horizontal lattice points.

(10)Number of vertical lattice points

Specifies the number of vertical lattice points.

(11) Interpolation method

Select how the colors of surrounding pixels will blend when the image is transformed.

Fix
Selecting [Edit] menu > [Transform] > [OK] removes any changes done to the image.

Cancel
Selecting [Edit] menu > [Transform] > [Cancel] removes any changes done to the image.

Smooth (oversampling)
Each pixel is divided into multiple pixels and calculated as an average of the original pixel colors 

before transformation. This method makes outlines smoother, but may take a long time to process.

Hard edges (nearest neigh-

bor)

The outline of the color separation borders are blended with the color of the adjacent pixels and 

smoothed. However, white noise may appear around the outline depending on the content being 

transformed.
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Change Image Resolution
Change the resolution of the current canvas.

1 Select the [Edit] menu > [Change Image Resolution].

2 The [Change Image Resolution] dialog box will appear.

(1) Configure settings for the size and resolution.

(2) Click [OK].

3 The dialog box will close, and the canvas resolution will be changed.

[Change Image Resolution] Dialog Box

(1) Width

Sets the paper width.

(2) Height

Sets the paper height.

(3) Resolution

Input the paper’s resolution or Click the drop-down button next to it to select a value.

(4) Unit

Select a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.

(5) Scale

Specify the paper size as a ratio of the current paper size.

(6) Fix pixels

Changes the resolution without changing the number of pixels.

Changing the image resolution will delete the crop marks and default border.

In DEBUT, the maximum canvas size is 10000 (height) x 10000 (width) pixels.
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(7) Interpolation method

You can select the method for interpolating the colors of pixels when changing the image resolution.

Change Canvas Size
Changes the size of the current canvas.

1 Select the [Edit] menu > [Change Canvas Size].

2 Adjust the settings in the dialog box that appears.

(1) In [Reference point], set the point of reference for changing the canvas size.

(2) Set the new canvas size.

Smooth edges (bilinear)
This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). However, outlines may become blurred depending on the image.

Hard edges (nearest neigh-

bor)

When interpolating the image, the pixels in the image are duplicated. Since the colors are not 

affected by neighboring pixels, outlines (boundaries between colors) remain sharp. However, out-

lines may become jagged depending on the image.

Clear edges (bicubic)

This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). This method results in stronger outlines compared to the [Smooth outline (bilin-

ear method)] setting. However, white noise may appear around outlines depending on the image.

High accuracy (average col-

ors)

The average colors of the original pixels are strictly calculated and contained for each pixel after 

the transformation. Scaling up makes the lines sharper and scaling down makes the lines 

smoother. Even detailed lines can be preserved when scaling the image down. However, this 

method can result in blurred outlines and can take a long time to process depending on the image.

If you use [Change Canvas Size] when there is a selection area or when the crop marks are not aligned correctly in 

a two-page spread, the crop marks and default border will be deleted. You can also remove the crop marks and 

default border by turning off [Fix center] in the [Change Canvas Size] dialog box.

If you create a selection area, you can fit the canvas size to the selected area.
CLIP STUDIO PAINT Instruction Manual 318



Menus > Edit Menu > Change Canvas Size
3 A preview will be shown on the canvas.
You can change the position or size by dragging the bounding box or handles.

4 Click [OK] on the [Change Canvas Size] dialog box.
The dialog box closes and the canvas resizing is complete.

 Hold down Shift while dragging a handle to resize without changing the original image ratio.

 To resize with the center as the reference point, hold down Alt while dragging the handles.

 You can move the reference point by dragging it on the preview canvas.

Guide

Handle

Preview of the canvas

size configured on the

dialog box.
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[Change canvas size] Dialog Box

(1) Width

Sets the paper width.

(2) Height

Sets the paper height.

(3) Reference point

Specify the point of reference for adjusting the canvas size. If a reference point is specified, the canvas size will change with respect to that 

point when the width or height are changed in the dialog box.

(4) Unit

Select a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.

(5) Fix center [PRO/EX]

Turn this on to fix the center of the crop marks and default border so they remains in the same position when changing the size of the can-

vas.

If the reference point is not set to the center, the actual center of the canvas may be in a different position from the center of the crop marks 

and default border after changing the canvas.

Turning this off will clear the crop marks and default border from the canvas.

(6) Reset

Resets the settings set in the [Change Canvas Size] dialog box to the previous settings.

In DEBUT, the maximum canvas size is 10000 (height) x 10000 (width) pixels.

This option will only appear if the canvas has crop marks or a default border.
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Crop 
Changes the canvas size so that it matches the selected area.

Rotate/Invert canvas
Rotates or inverts the canvas.

 This does not rotate/invert the view, but the canvas itself.

 If you print the canvas, it will be printed in this format.

 The canvas size will also be changed automatically.

Display angle of the original imageDisplay angle after rotation 

 (same as that of the original image)

Canvas size of the original size Canvas size after rotation
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Rotate by 90 degrees clockwise
Rotates the canvas clockwise by 90 degrees.

Rotate 180
Rotates the canvas by 180 degrees.

 Text layers and 3D layers will be converted to raster layers if you rotate or invert the canvas.

 On vector layers, brush patterns and spray patterns may change after rotation/inversion.

 The appearance of screentones may change after rotation/inversion.

 In EX, crop marks and default border will be deleted upon rotation or inversion of the canvas if the canvas is a 

two-page spread and the crop marks are not aligned.

Rotate clockwise by 90 degreesOriginal image

Rotate by 180 degreesOriginal image
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Rotate by 90 Degrees Counterclockwise
Rotates the canvas counterclockwise by 90 degrees.

Flip Horizontal
Inverts the canvas horizontally (mirror image).

Rotate clockwise by 90 degreesOriginal image

Flip HorizontalOriginal image
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Flip Vertical
Inverts the canvas vertically (upside-down mirror image).

Flip VerticalOriginal image
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Canvas Properties [PRO/EX] 
Opens the [Canvas Properties] dialog box. This allows you to change the settings of the current canvas. The available settings depend on 

whether the file is an illustration, comic, or animation.

 "[Canvas Properties] Dialog Box (Illustration)"

 "[Canvas Properties] Dialog Box (Animation)"

[Canvas Properties] Dialog Box (Illustration)
The default expression color and frequency and the crop mark and default border size can be set if [Use of work] is set to [Illustration], 

[Comic], [Printing of fanzine] or [Show all comic settings] when creating a new canvas.

A. Unit
Select a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.

The set content will be used as default settings when creating a new layer.

A

B

C

D

E

F

G

H

I
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B. Canvas
Adjust settings related to the canvas.

(1) Swap width/height

Swaps the width and height of the canvas.

(2) Width

Sets the width of the canvas.

(3) Height

Sets the height of the canvas.

(4) Resolution

Sets the resolution of the canvas. Click the drop-down button next to it to select a value.

(5) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(6) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

 When [Manga draft settings] is turned off, the canvas size will be the final size.

 When [Manga draft settings] is turned on, the [Binding (finish) size] will be the final size when bound in a book.

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".
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(7) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(8) Paper color

You can set a color for the paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to change the color 

of the Paper layer.

C. Manga draft settings
Turn this on to add crop marks, default border (inner), cropped border, bleed border and safety margin to the canvas. Configuring the sizes 

of the bleed border, default border, and canvas displays these guides on the canvas.

D. Manga draft settings > Binding (finish) size
Adjust the settings for creating the comic canvas.

(1) Width

Horizontal length to print.

(2) Height

Vertical length to print.

(3) Default size (Cropped border)

Allows you to select a width and height for the finish size from default sizes.

 The paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click the Paper layer in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the Paper layer.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
CLIP STUDIO PAINT Instruction Manual 327



Menus > Edit Menu > Canvas Properties [PRO/EX]
(4) Bleed width

Add an extra margin to compensate for misaligned trimming of the edges of the pages. To print to the edge of the page, draw up to the 

bleed width area.

The area between the bleed border (the first border from the edge) and the finish border (the second border from the edge) is the bleed area.

E. Manga draft settings > Default border (inner) size
This is a reference border for laying out frames. There are two ways of specifying the default border: by size and position, or by margin. 

This option appears when [Manga draft settings] is turned on.

(1) Default size (Default border)

Allows you to select a width and height for the default border from default sizes.

(2) How to specify default border

You can choose how to specify the size and position of the default border. The options vary depending on the default border settings.

Set size Adjust the size and position of the default border.

Set margin
Adjust the default border based on the distance from the edges of 

the paper.

Bleed width Cropped border

Bleed

Bleed area is the area

between the bleed border and

the cropped border.

Set size Set margin
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(3) Default border settings

Sets the size and position of the default border. The options vary depending on the method of specifying the border.

Set size

Adjust the size and position of the default border.

Set margin

Adjust the default border based on the distance from the left, right, top and bottom edges of the cropped border.

@

F. Align crop mark [EX]
When turned off, crop marks are created at the position where the paper edges of the left and right pages match.

When turned on, the crop marks are combined by aligning the positions of the cropped border. The position of the cropped border on the 

left and right pages can be adjusted in [Gap].

Width Width of the default border.

Height Length of the default border.

X offset Horizontal position of the default border.

Y offset Vertical position of the default border.

 When [X offset] is 0, the default border will be located in the center of the finish border horizontally.

 When [Y offset] is 0, the default border will be located in the center of the finish border vertically.

Top Specifies the upper side of the default border as the distance from the top of the cropped border.

Bottom Specifies the lower side of the default border as the distance from the bottom of the cropped border.

Inside
Specifies the right or left side of the default border as the distance from the direction of the binding 

point.

Outside
Specifies the right or left side of the default border as the distance from the outer edge of the page 

(opposite side to the binding point).

Top

Bottom

Binding side

Cropped border

Default borderDDDDDD
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G. Manga draft settings > Safety margin
Turn this on to add a safety margin to the canvas. When printing magazines and books with different aspect ratios, the position of the bleed 

border changes depending on the format. The safety margin indicates the print-safe area for both magazines and books. Usually, publishers 

and printing companies specify its position.

[Align crop mark] appears only for two-page spreads.

Top Specifies the upper side of the safety margin as the distance from the top of the cropped border.

Bottom Specifies the lower side of the safety margin as the distance from the top of the cropped border.

Inside Specifies the left/right side of the safety margin as the distance from the cropped border on the binding side.

Outside
Specifies the left/right side of the safety margin as the distance from the cropped border on the outer side of the 

page.
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H. Timeline
This appears if [Create moving illustration] is turned on in the [New] dialog.

(1) Timeline

[How to show frames] offers methods of displaying the number of frames in the [Timeline] palette.

(2) Image interpolation

You can select the method for interpolating the colors of pixels when transforming a cel or image material using keyframes.

I. Record timelapse *
When enabled, you can start recording a timelapse. If you save the file in Clip Studio format (extension: .clip), the timelapse will be saved 

with the file. For more detail on timelapses, see Clip Studio TIPS.

 This is also shown when a timeline is created by selecting the [Animation] menu > [Timeline] > [New timeline].

 When in the [Animation] menu > [Timeline] > [Enable timeline] is disabled, the timeline is not shown.

Frame number (starting 

from 1), Frame number 

(starting from 0)

Displays the number of frames for the entire timeline.

The difference between [Frame number (starting from 1)] and [Frame number starting from 0)] is 

the start number of the frames.

Seconds + frame
The frame number is shown as "number of seconds + frame number". The frame number starts 

from 1 again each time the second changes.

Time code The frame number is shown in playback time format, which is “minutes:seconds:frame number”.

Smooth edges (bilinear)
This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). However, outlines may become blurred depending on the image.

Hard edges (nearest neigh-

bor)

When interpolating the image, the pixels in the image are duplicated. Since the colors are not 

affected by neighboring pixels, outlines (boundaries between colors) remain sharp. However, 

outlines may become jagged depending on the image.

Clear edges (bicubic)

This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). This method results in stronger outlines compared to the [Smooth outline (bilin-

ear method)] setting. However, white noise may appear around the outline depending on the con-

tent being transformed.

High accuracy (average col-

ors)

The average colors of the original pixels are strictly calculated and contained for each pixel after 

the transformation. Scaling up makes the line sharper and scaling down makes the line smoother. 

Even detailed lines can be preserved when scaling the image down. However, this method can 

result in blurred outlines and can take a long time to process depending on the image.
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[Canvas Properties] Dialog Box (Animation)
You can set the frame size and the method of showing frames in the timeline if [Use of work] is set as [Animation] when creating a new canvas.

A. Unit
Selects a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.

B. Size of output frame
Sets the size and resolution of the output frame on the canvas.

(1) Width

Sets the width of the output frame.

(2) Height

Sets the height of the output frame.

(3) Resolution

Sets the resolution of the canvas. Click the drop-down button next to it to select a value.

A

B
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D
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CLIP STUDIO PAINT Instruction Manual 332



Menus > Edit Menu > Canvas Properties [PRO/EX]
C. Title-safe area
Turn this on to set the title-safe area of the canvas. Set the distance of the title-safe area from the top, bottom, left and right edges of the 

output frame (margin).

D. Overflow frame
Turn this on to set a overflow frame on the canvas. Overflow frames are useful for creating cuts that move horizontally or vertically across 

the canvas.

(1) How to add an overflow frame

Set how to specify the overflow frame. The width and height are specified differently depending on this setting.

(2) Width

Set the width of the overflow frame.

(3) Height

Set the height of the overflow frame.

(4) Reference point

Specify the position of the reference point (output frame) in relation to the overflow frame.

(5) Offset X

When the overflow frame is larger than the output frame, moves the output frame horizontally.

(6) Offset Y

When the overflow frame is larger than the output frame, moves the output frame vertically.

E. Blank space
Set the blank space around the overflow frame. If there is no overflow frame, the blank space will be added around the output frame.

Enter values in [Up], [Down], [Left], and [Right] to add blank space.

Specified scale Specify a scale based on the size of the output frame.

Specified size Specify measurements for the width and height.
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F. Timeline
The frame display method and image processing method can be set when transforming with keyframes.

(1) Timeline

[How to show frames] offers methods of displaying the number of frames in the [Timeline] palette.

(2) Image interpolation

You can select the method for interpolating the colors of pixels when transforming a cel or image material using keyframes.

G. Record timelapse *
When enabled, you can start recording a timelapse. If you save the file in Clip Studio format (extension: .clip), the timelapse will be saved 

with the file. For more detail on timelapses, see Clip Studio TIPS.

Clear memory [PRO/EX] 
Deletes the content stored in the application memory, such as the operation history for [History].

Frame number (starting 

from 1), Frame number 

(starting from 0)

Displays the number of frames for the entire timeline.

The difference between [Frame number (starting from 1)] and [Frame number starting from 0)] is 

the start number of the frames.

Seconds + frame
The frame number is shown as "number of seconds + frame number". The frame number starts 

from 1 again each time the second changes.

Time code The frame number is shown in playback time format, which is “minutes:seconds:frame number”.

Smooth edges (bilinear)
This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). However, outlines may become blurred depending on the image.

Hard edges (nearest neigh-

bor)

When interpolating the image, the pixels in the image are duplicated. Since the colors are not 

affected by neighboring pixels, outlines (boundaries between colors) remain sharp. However, 

outlines may become jagged depending on the image.

Clear edges (bicubic)

This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). This method results in stronger outlines compared to the [Smooth outline (bilin-

ear method)] setting. However, white noise may appear around the outline depending on the con-

tent being transformed.

High accuracy (average col-

ors)

The average colors of the original pixels are strictly calculated and contained for each pixel after 

the transformation. Scaling up makes the line sharper and scaling down makes the line smoother. 

Even detailed lines can be preserved when scaling the image down. However, this method can 

result in blurred outlines and can take a long time to process depending on the image.
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Menus > Edit Menu > Obtain screen color [Windows/macOS]
Obtain screen color [Windows/macOS]
You can pick up any color on the screen using the eyedropper and use it as a drawing color.

Unlike the [Eyedropper] tool, [Obtain screen color] allows you to register any color on the screen. You can also reference colors from images 

open in other applications.

1 Select the [Edit] menu > [Obtain screen color].

2 This switches to the Eyedropper tool and opens the [Obtain screen color] window. Click a
color on the screen to use it as a drawing color.

3 The screen color you have clicked will be registered as the drawing color.

You can close the [Obtain screen color] dialog box in the following ways.

 Right click

 Press a key on the keyboard

The [Eyedropper] and 

[Obtain screen color] window 

are displayed.

Other application
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Obtain screen color by hiding windows [Windows/macOS]
You can pick up any color on the screen using the eyedropper and use it as a drawing color. Clip Studio Paint is immediately hidden from the 

desktop when [Obtain screen color by hiding windows] is selected. You can pick up any colors from the screen.

Like [Obtain screen color], this allows you to register any color on the screen. You can also reference colors from images open in other applica-

tions.

1 Select the [Edit] menu > [Obtain screen color by hiding windows].

2 This switches to the Eyedropper tool and opens the [Obtain screen color] window. Click a
color on the screen to use it as a drawing color.

3 The screen color you have clicked will be registered as the drawing color.

You can exit the dialog box by right-clicking while the dialog box is open.

The [Eyedropper] and 

[Obtain screen color] window are displayed.

Other application
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Menus > Story Menu [EX] > Open page
 Story Menu [EX]
The [Story] menu is for managing comic or manga files composed of two or more pages. You can manage how to dis-
play a page file, add and delete pages, manage manga or comic story information, and so on. This section describes
the commands in the [Story] menu.

Open page 
Opens the page file selected on the [Page Manager] window after closing the page file you were editing.

Open page in a new tab [Windows/macOS/Tablet]
Opens the page file selected on the [Page Manager] window and keeps the page file you were editing open.

First Page
Opens the page file of the first page.

Previous page
Opens the page file of the previous page.

Next Page
Opens the page file of the next page.

Last Page
Opens the page file of the last page.

Specific Page
Opens the [Specific Page] dialog box. Under [Page], enter the number of pages you want to open and click [OK] to open the specified page(s).

Add Page
Adds a new page file to the next page of the selected page file.

 When using a Smartphone, multiple tabs cannot be opened at the same time. Close the page file being edited 

and open the [Page Management] window to open a page.

 For Windows/macOS/Tablet, when there are two or more tabs open, the page file selected on the [Page Man-

ager] window opens after the page file you were editing closes. The tabs of page files that were not being 

edited remain open.

 For Windows/macOS/Tablet, if [Auto save when switching page] is turned on in [Preferences] > [Page Manage-

ment], switching pages automatically saves and closes the page file you were editing. For details, see "File".

Selecting the page file of the page being edited opens the same page file in another tab.

 When a two-page spread is present after the selected page, page files for two pages are added.

 Adding a page to a single-page file opens the [Create story folder] dialog box. For details on these dialog box 

settings, see "Batch import [EX]".
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Add page (Detail)
Select this command to open the [Add page (Detail)] dialog box. Configuring the page to create on the dialog box adds a new page file to the 

next page of the selected page file.

[Add page (detail)] Dialog Box

A. Preset
Select the canvas size, final size, and bleed border/default border from a list of options.

When custom settings exist, the icon on the right side allows you to delete a setting.

 When a two-page spread is present after the selected page, page files for two pages are added.

 Adding a page to a single-page file opens the [Create story folder] dialog box. For details on these dialog box 

settings, see "Batch import [EX]".

 Use [Final size] to set the size when binding a book for print.

 If you change the settings of a preset, the selected option will automatically change to [Custom].
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B. Canvas size
Sets the canvas size.

(1) Swap width/height

Swaps the width and height of the canvas.

(2) Width

Set the width of the canvas.

(3) Height

Set the height of the canvas.

(4) Resolution

Enter the resolution of the canvas or Click the drop-down button next to it to select a value.

(5) Default size (Canvas size)

Allows you to select a width and height from default sizes.

(6) Unit

Select a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.

 When [Manga draft settings] is turned off, the canvas size will be the final size.

 When [Manga draft settings] is turned on, the [Binding (finish) size] will be the final size when bound in a book.

This option appears when [Manga draft settings] is turned off.

Canvas Size (Manga draft settings : On) Canvas Size (Manga draft settings : Off)
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C. Manga draft settings
Turn this on to add crop marks, default border (inner), cropped border, bleed border and safety margin to the canvas.

Configuring the sizes of the bleed border, default border, and canvas displays these guides on the canvas.

D. Manga draft settings > Binding (finish) size
This sets the border at which the edge of the pages will be trimmed for binding after printing. Drawings within these dimensions will be 

printed. You can also add an extra safety margin to deal with misaligned trimming of the printed pages.

(1) Width

Horizontal length to print.

This option appears when [Manga draft settings] is turned on.

Default border

Bleed width

Canvas
Bleed

Cropped border

Cropped border

Bleed width
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(2) Height

Vertical length to print.

(3) Bleed width

Add an extra margin to compensate for misaligned trimming of the edges of the pages. To print to the edge of the page, draw up to the 

bleed width area.

The area between the bleed border (the first border from the edge) and the finish border (the second border from the edge) is the bleed area.

(4) Default size (Cropped border)

Allows you to select a width and height for the finish size from default sizes.

Bleed width Cropped border

Bleed area is the area

between the bleed border and

the cropped border.

Bleed
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E. Manga draft settings > Default border (inner) size
This is a reference border for laying out frames. There are two ways of specifying the default border: by size and position, or by margin.

(1) Default size (Default border)

Allows you to select a width and height for the default border from default sizes.

(2) How to specify default border

You can choose how to specify the size and position of the default border. The options vary depending on the default border settings.

(3) Default border settings

Sets the size and position of the default border. The options vary depending on the method of specifying the border.

Set size

Adjust the size and position of the default border.

This option appears when [Manga draft settings] is turned on.

Set size Adjust the size and position of the default border.

Set margin Adjust the default border based on the distance from the edges of the paper.

Width Width of the default border.

Height Length of the default border.

X offset Horizontal position of the default border.

Y offset Vertical position of the default border.

 When [X offset] is 0, the default border will be located in the center of the finish border horizontally.

 When [Y offset] is 0, the default border will be located in the center of the finish border vertically.

Default border
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Set margin

Adjust the default border based on the distance from the edges of the cropped border.

F. Preview
Previews the set [Cropped border], [Bleed border/Default border], and [Paper color].

G. Basic expression color/Default frequency
Allows you to set the basic expression color.

(1) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

Top Specifies the upper side of the default border as the distance from the top of the cropped border.

Bottom Specifies the lower side of the default border as the distance from the bottom of the cropped border.

Inside Specifies the right or left side of the default border as the distance from the direction of the binding point.

Outside
Specifies the right or left side of the default border as the distance from the outer edge of the page (opposite 

side to the binding point).

The expression color [Monotone] from Ver.1.2.1 and earlier will be converted into the following [basic expression 

color] and [drawing color].

 Basic expression color: Gray

 Drawing color: Only black
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Basic expression color: Color Basic expression color: Gray Basic expression color: Monochrome
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(2) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(3) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots.

H. Paper color
You can set a color for the Paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to change the color 

of the Paper layer.

I. Template
You can create a page file with an imported template.

Select the checkbox and click the button to open the [Template] dialog box. Specify the template to import to the page file in the dialog 

box.

(1) Template

When turned on, this allows you to specify a template.

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click the Paper layer in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the Paper layer.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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(2) Specified template

Clicking this button opens the [Template] dialog box. Specify the template to import to the page file in the dialog box.

[Template] Dialog Box

 (1) Search box Enter keywords to search for a template.

(2) Tag list
A list of tags assigned to materials. Click a tag button to display materials from the [Material 

list].

(3) Material list A list of template materials. Click a template material to load the settings.

(4) Thumbnail [Large] Shows the large thumbnails of the materials shown in [Material list].

(5) Thumbnail [Small] Shows the small thumbnails of the materials shown in [Material list].

(6) Thumbnail [Detail] Shows the thumbnails as well as information of the materials shown in [Material list].

Templates can be added from the [Edit] menu > [Register Material] > [Template]. For details, see "Register Layer 

as Template Material".
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J. Number of pages
Sets the number of pages to add.

(1) Number of pages

Enter the number of pages to create in the input field. Click the rightmost button to select the number of pages from [1], [2], [4], [8], [12], 

[16], [24], and [32].

(2) Combine into two-page spreads

Turn this on to connect sets of left and right pages as two-page spreads.

K. Register to preset
Registers the current settings in the dialog box as [Preset].

Clicking the button opens the [Register to preset] dialog box. In the dialog box, set the preset name and settings to be included in the pre-

set, then click [OK].

[Register to preset] Dialog Box

(1) Preset name

Enter a name for the preset.

(2) Items to be included in preset

Select the settings you would like to save in the preset.

The width, height, unit, and manga draft settings are always saved to the preset.
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Import Page
Select the page in which you want to add another page behind from the [Page Manager] window. Selecting [Story] menu > [Import pages] 

shows the [Open] dialog box. Choosing an image file from the [Open] dialog box adds it as a page file to the selected page in the [Page Man-

ager] window. It is added behind the selected page.

Importing Single Files
CLIP STUDIO FORMAT (extension: clip), CLIP STUDIO PAINT format (extension: lip), IllustStudio documents (extension: xpg), ComicStu-

dio page files (extension: cpg), BMP, JPEG, PNG, TIFF, Targa, Adobe Photoshop documents (extension: psd), the Adobe Photoshop big docu-

ment format (extension: psb), ibisPaint work files (extension: ipv), and kakooyo! work files (extension: kako). Supports kakooyo! work files 

(extension: kako).

When multiple pages are selected in the [Open] dialog box, they will be imported as a multi-page file.

Importing Multiple pages with the File Manager
This imports multiple pages via the File manager. Clip Studio Paint EX supports management files (extension: cmc) and ComicStudio work 

files (extension: cst) and CLIP STUDIO name files (extension: csnf). Shows the dialog box to import a page. The [Page Management] window 

imports multiple pages as a multi-page file.

 Select the [Story] menu > [Import Page] to open the [Create story folder] for single pages. For details on these 

dialog box settings, see "Batch import [EX]".

 When a blank page with an odd number of pages is set in the [Page Manager] Window, it will add a page file 

making it an even amount of pages.

 When a page in the [Page Manager] Window is selected, that has a two-page spread after it and an odd number 

of pages, it will add a page file.

 When importing CLIP STUDIO FORMAT (extension: clip) files with two-page spreads,  depending on where the 

two-page spread is located, a page file will be added.

 When a ComicStudio work file (extention: cst) or a PDF file is selected, a dialog box to convert them to a Clip 

Studio Paint management file (extension: cmc) appears. Convert the file by following the on-screen instruc-

tions. All pages of a selected file will be converted. After converting, the [Import Page] dialog box shows. Des-

ignate the page you want to import and click [OK]. Converting a file makes a new file so both the original file 

and the converted file will remain.

 When a Clip Studio Storyboard File (extension .csnf) is selected, the [Add page from storyboard file] dialog 

box appears. Choose the pages you want to import, the resolution and the font, click [OK] and the [Page Man-

ager] Window will import the file.

 When importing a multi-page file managing multiple pages, you cannot select multiple files in the [Open] dia-

log box.When using a Tablet/Smartphone, IllustStudio documents (extension: xpg), ComicStudio page files 

(extension: cpg), and ComicStudio work files (extension: cst) cannot be imported.

 IllustStudio documents (extension: xpg), ComicStudio page files (extension: cpg), and ComicStudio work files 

(extension: cst) cannot be imported on tablets/smartphonea/Macs with M1 chips.
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Replace page 
Replaces the file of the selected page with a specified image file.

File formats that you can open are CLIP STUDIO FORMAT (extension: clip), CLIP STUDIO PAINT format (extension:lip), IllustStudio doc-

uments (extension: xpg), ComicStudio page files (extension: cpg), ComicStudio storyboard files (extension: csnf), BMP, JPEG, PNG, TIFF, 

Targa, Adobe Photoshop documents (extension: psd), the Adobe Photoshop big document format (extension: psb), ibisPaint work files (exten-

sion: ipv), and kakooyo! work files (extension: kako). Imports kakooyo! work files (extension: kako).

Duplicate Page
Copies the selected page file to the next page.

Delete Page
Deletes the selected page file.

 Single-page files cannot be imported as two-page spreads. Spread-page files cannot be imported as single 

pages.

 If a page that a member is specified as in charge of while using the group work function is replaced, the mem-

ber is no longer specified for that page.

 When using a Tablet/Smartphone, IllustStudio documents (extension: xpg) and ComicStudio page files (exten-

sion: cpg) cannot be imported.

 IllustStudio documents (extension: xpg) and ComicStudio page files (extension: cpg) cannot be imported on 

tablets/smartphonea/Macs with M1 chips.

 When a two-page spread is present after the selected page, the page file is copied to the next page of the last 

one.

 Copying a page from a single-page file opens the [Create story folder] dialog box. For details on these dialog 

box settings, see "Batch import [EX]".

To delete multiple pages at once, select them on the [Page Manager] window.

You can use the following methods to select multiple pages on the [Page Manager] window:

 To select multiple pages, hold Ctrl while selecting each item.

 To select a consecutive group of pages, click the first item, then hold down Shift and select the last item.
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Combine Pages
Combines the selected page and the next page into a combined two-page spread.

A confirmation dialog box will appear when you select this command. Clicking [OK] will open the [Combine Pages] dialog box, where you 

will be able to configure settings such as the position of the crop mark between pages.

[Combine pages] Dialog Box

(1) Align crop mark

When turned off, this combines the pages by matching the paper edges.

When turned on, this combines the pages by aligning the positions of the cropped border. The positions of the cropped border on the left 

and right pages can be adjusted using [Gap].

(2) Delete layer with no drawing

When turned on and merging an image, this deletes layers that have no drawings on them.

The command is not available when [Webtoon] is selected from [New] > [Use of work]. Please select [Story] > 

[View] > [Page-by-page], and set [Binding point] and [Start page] before running the function.

Two pages of original Combined into one for a 2-page spread
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Change to Split Pages
Splits pages combined into a single two-page spread back into two separate pages.

Selecting the menu item shows a confirmation dialog box. Clicking [OK] shows the [Split Pages] dialog box and deletes blank layers when 

dividing the image.

[Split Pages] Dialog Box

(1) Delete layer with no drawing

When turned on and dividing an image, this deletes layers layers that have no drawings on them.

The command is not available when [Webtoon] is selected from [New] > [Use of work]. Please select [Story] > 

[View] > [Page-by-page], and set [Binding point] and [Start page] before running the function.

2-page spread original Divided into two single pages
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Change basic page settings
Opens the [Change basic page settings] dialog box. Various settings can be changed for the page opened in the [Canvas] window or multiple 

pages selected in the [Page Manager] window. The available settings depend on whether the file is an illustration, comic, or animation.

 "[Change basic page settings] Dialog Box (Illustration)"

 "[Change basic page settings] Dialog Box (Animation)"

1 Changes the settings from the [Page Manager] window.

2 Select [Page Management] menu > [Change basic page settings].

3 Configure the settings in the [Change basic page settings] dialog box and click [OK].

Page settings can also be changed by selecting the page you want to change from the [Story] window. Batch set-

tings can be set for multiple pages when using this method.

 Batch settings cannot be set if the selected pages have different sizes, resolutions, or basic expression col-

ors. Configure the settings individually for each page.

 If pages are selected via the [Page Manager] window, the settings cannot be undone. Reconfigure the settings. 

The settings can be undone in the [Canvas] window if the page selected in the [Page Manager] window is open 

in the [Canvas] window.
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4 The page settings have been changed.
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[Change basic page settings] Dialog Box (Illustration)
The following items can be set if [Use of work] is set to [Illustration], [Comic], [Printing of fanzine] or [Show all comic settings] when creating 

a new canvas.

A. Unit
Select a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.
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B. Canvas
Adjust settings related to the canvas.

(1) Swap width/height

Swaps the width and height of the canvas.

(2) Width

Set the width of the canvas.

(3) Height

Set the height of the canvas.

(4) Resolution

Enter the resolution of the canvas or Click the drop-down button next to it to select a value.

(5) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(6) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

 When [Manga draft settings] is turned off, the canvas size will be the final size.

 When [Manga draft settings] is turned on, the [Binding (finish) size] will be the final size when bound in a book.

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".
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(7) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(8) Paper color

You can set a color for the Paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to change the color 

of the Paper layer.

C. Manga draft settings
Turn this on to add crop marks, default border (inner), cropped border, bleed border and safety margin to the canvas. Configuring the sizes 

of the bleed border, default border, and canvas displays these guides on the canvas.

D. Manga draft settings > Binding (finish) size
Adjust the settings for creating the comic canvas.

(1) Width

Horizontal length to print.

(2) Height

Vertical length to print.

(3) Default size (Cropped border)

Allows you to select a width and height for the finish size from default sizes.

(4) Bleed width

Add an extra margin to compensate for misaligned trimming of the edges of the pages. To print to the edge of the page, draw up to the 

bleed width area.

The area between the bleed border (the first border from the edge) and the finish border (the second border from the edge) is the bleed area.

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click the Paper layer in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the Paper layer.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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E. Manga draft settings > Default border (inner) size
This is a reference border for laying out frames. There are two ways of specifying the default border: by size and position, or by margin. 

This option appears when [Manga draft settings] is turned on.

(1) Default size (Default border)

Allows you to select a width and height for the default border from default sizes.

(2) How to specify a default border

You can choose how to specify the size and position of the default border. The options vary depending on the default border settings.

(3) Default border settings

Sets the size and position of the default border. The options vary depending on the method of specifying the border.

Set size

Adjust the size and position of the default border.

Set margin

Adjust the default border based on the distance from the edges of the cropped border.

F. Align crop mark
Shown when a page set as a spread is opened. Turn this on to align the positions of the cropped border on the left and right pages. The 

position of the cropped border on the left and right pages can be adjusted in [Gap].

Set size Adjust the size and position of the default border.

Set margin
Adjust the default border based on the distance from the edges of 

the paper.

Width Width of the default border.

Height Length of the default border.

X offset Horizontal position of the default border.

Y offset Vertical position of the default border.

 When [X offset] is 0, the default border will be located in the center of the finish border horizontally.

 When [Y offset] is 0, the default border will be located in the center of the finish border vertically.

Top Specifies the upper side of the default border as the distance from the top of the cropped border.

Bottom Specifies the lower side of the default border as the distance from the bottom of the cropped border.

Inside
Specifies the right or left side of the default border as the distance from the direction of the binding 

point.

Outside
Specifies the right or left side of the default border as the distance from the outer edge of the page 

(opposite side to the binding point).

Set size Set margin
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G. Manga draft settings > Safety margin
Turn this on to add a safety margin to the canvas. When printing magazines and books with different aspect ratios, the position of the bleed 

border changes depending on the format. The safety margin indicates the print-safe area for both magazines and books. Usually, publishers 

and printing companies specify its position.

Top Specifies the upper side of the safety margin as the distance from the top of the cropped border.

Bottom Specifies the lower side of the safety margin as the distance from the top of the cropped border.

Inside Specifies the left/right side of the safety margin as the distance from the cropped border on the binding side.

Outside
Specifies the left/right side of the safety margin as the distance from the cropped border on the outer side of the 

page.
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H. Timeline
This appears if [Create moving illustration] is turned on in the [New] dialog.

(1) Timeline

[How to show frames] offers methods of displaying the number of frames in the [Timeline] palette.

(2) Image interpolation

You can select the method for interpolating the colors of pixels when transforming a cel or image material using keyframes.

I. Record timelapse *
When enabled, you can start recording a timelapse. If you save the file in Clip Studio format (extension: .clip), the timelapse will be saved 

with the file. For more detail on timelapses, see Clip Studio TIPS.

 This is also shown when a timeline is created by selecting the [Animation] menu > [Timeline] > [New timeline].

 When in the [Animation] menu > [Timeline] > [Enable timeline] is disabled, the timeline is not shown.

Frame number (starting 

from 1), Frame number 

(starting from 0)

Displays the number of frames for the entire timeline.

The difference between [Frame number (starting from 1)] and [Frame number starting from 0)] is 

the start number of the frames.

Seconds + frame
The frame number is shown as "number of seconds + frame number". The frame number starts 

from 1 again each time the second changes.

Time code The frame number is shown in playback time format, which is “minutes:seconds:frame number”.

Smooth edges (bilinear)
This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). However, outlines may become blurred depending on the image.

Hard edges (nearest neigh-

bor)

When interpolating the image, the pixels in the image are duplicated. Since the colors are not 

affected by neighboring pixels, outlines (boundaries between colors) remain sharp. However, 

outlines may become jagged depending on the image.

Clear edges (bicubic)

This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). This method results in stronger outlines compared to the [Smooth outline (bilin-

ear method)] setting. However, white noise may appear around outlines depending on the image.

High accuracy (average col-

ors)

The average colors of the original pixels are strictly calculated and contained for each pixel after 

the transformation. Scaling up makes the lines sharper and scaling down makes the lines 

smoother. Even detailed lines can be preserved when scaling the image down. However, this 

method can result in blurred outlines and can take a long time to process depending on the image.
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[Change basic page settings] Dialog Box (Animation)
The following items can be set if [Use of work] is set as [Animation] when creating a new canvas.

A. Unit
Select a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.

B. Size of output frame
Sets the size and resolution of the output frame on the canvas.

(1) Width

Sets the width of the output frame.

(2) Height

Sets the height of the output frame.

(3) Resolution

Sets the resolution of the canvas. Click the drop-down button next to it to select a value.
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C. Title-safe area
Turn this on to set the title-safe area of the canvas. Set the distance of the title-safe area from the top, bottom, left and right edges of the 

output frame (margin).

D. Overflow frame
Turn this on to set a overflow frame on the canvas. Overflow frames are useful for creating cuts that move horizontally or vertically across 

the canvas.

(1) How to add an overflow frame

Set how to specify the overflow frame. The width and height are specified differently depending on this setting.

(2) Width

Set the width of the overflow frame.

(3) Height

Set the height of the overflow frame.

(4) Reference point

Specify the position of the reference point (output frame) in relation to the overflow frame.

(5) Offset X

When the overflow frame is larger than the output frame, moves the output frame horizontally.

(6) Offset Y

When the overflow frame is larger than the output frame, moves the output frame vertically.

E. Blank space
Set the blank space around the overflow frame. If there is no overflow frame, the blank space will be added around the output frame.

Enter values in [Up], [Down], [Left], and [Right] to add blank space.

Specified scale Specify a scale based on the size of the output frame.

Specified size Specify measurements for the width and height.
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F. Timeline
The frame display method and image processing method can be set when transforming with keyframes.

(1) Timeline

[How to show frames] offers methods of displaying the number of frames in the [Timeline] palette.

(2) Image interpolation

You can select the method for interpolating the colors of pixels when transforming a cel or image material using keyframes.

G. Record timelapse *
When enabled, you can start recording a timelapse. If you save the file in Clip Studio format (extension: .clip), the timelapse will be saved 

with the file. For more detail on timelapses, see Clip Studio TIPS.

Frame number (starting 

from 1), Frame number 

(starting from 0)

Displays the number of frames for the entire timeline.

The difference between [Frame number (starting from 1)] and [Frame number starting from 0)] is 

the start number of the frames.

Seconds + frame
The frame number is shown as "number of seconds + frame number". The frame number starts 

from 1 again each time the second changes.

Time code The frame number is shown in playback time format, which is “minutes:seconds:frame number”.

Smooth edges (bilinear)
This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). However, outlines may become blurred depending on the image.

Hard edges (nearest neigh-

bor)

When interpolating the image, the pixels in the image are duplicated. Since the colors are not 

affected by neighboring pixels, outlines (boundaries between colors) remain sharp. However, 

outlines may become jagged depending on the image.

Clear edges (bicubic)

This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). This method results in stronger outlines compared to the [Smooth outline (bilin-

ear method)] setting. However, white noise may appear around outlines depending on the image.

High accuracy (average col-

ors)

The average colors of the original pixels are strictly calculated and contained for each pixel after 

the transformation. Scaling up makes the lines sharper and scaling down makes the lines 

smoother. Even detailed lines can be preserved when scaling the image down. However, this 

method can result in blurred outlines and can take a long time to process depending on the image.
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Change basic work settings
Opens the [Change basic work settings] dialog box. Here you can change the work settings for all pages in the file. The available settings 

depend on the [Use of work] that was selected when creating the file.

[Use of work] can be selected from the [Change basic work settings] dialog box. Settings can be configured in the [New] dialog box and [Show 

all comic settings]. Selecting [Use of work] shows the settings related to the selected item.

When editing a file set to [Animation] as the [Use of work], an animation-specific dialog box will appear. For information on settings specific 

to animation, see "Change basic work settings Dialog Box (Animation)".

Illustration
Displayed when [Illustration] is set as the [Use of work]. Select this to change settings related to illus-

trations. For information on each setting, see "Change basic work settings Dialog Box (Illustration)".

Webtoon
Displayed when [Webtoon] is set as the [Use of work]. Select this to change settings related to illustra-

tions. For information on each setting, see "Change basic work settings Dialog Box (Webtoon)*".

Comic
Displayed when [Comic] is set as the [Use of work]. Select this to change settings related to multi-page 

files. For information on each setting, see "Change basic work settings Dialog Box (Comic)".

Printing of fanzine

Displayed when [Printing of fanzine] is set as the [Use of work]. Select this to change settings related 

to fanzines for printing. For information on each setting, see "Change basic work settings Dialog Box 

(Printing of fanzine)".

Show all comic settings
Displays all page settings that can be configured for illustrations and comics. For information on each 

setting, see "Change basic work settings Dialog Box (Show all comic settings)".

 [Use of work] may not appear for files created in Clip Studio Paint Ver.1.3.9 or earlier. For details on setting 

items on the [Change basic work settings] dialog box, see "Change basic work settings Dialog Box (Show all 

comic settings)".

 If the settings of a particular page are changed after configuring the settings in the [New] dialog box or 

[Change basic work settings] dialog box, the settings in the [Change basic work settings] dialog box will not 

apply to that page.

Settings for a specific page can be changed using the [Story] menu > [Change basic page settings]. For details, 

see "Change basic page settings".
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Change basic work settings Dialog Box (Illustration)
This is the [Change basic work settings] dialog box that appears when the [Use of work] is set to [Illustration].

(1) Unit

Select a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.

(2) Swap width/height

Swaps the width and height of the canvas.

(3) Width

Set the width of the canvas.

(4) Height

Set the height of the canvas.

(5) Default size (Canvas size)

Allows you to select a width and height from default sizes.

(6) Resolution

Enter the resolution of the canvas or Click the drop-down button next to it to select a value.

(7) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(8) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.
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Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(9) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(10)Paper color

You can set a color for the Paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to change the color 

of the Paper layer.

(11) Record timelapse *

When enabled, you can start recording a timelapse. If you save the file in Clip Studio format (extension: .clip), the timelapse will be saved 

with the file. For more detail on timelapses, see Clip Studio TIPS.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click the Paper layer in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the Paper layer.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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Change basic work settings Dialog Box (Webtoon)*
This is the [Change basic work settings] dialog box that appears when the [Use of work] is set to [Webtoon].

(1) Unit

The unit for setting the width and height of the canvas. In this window, the unit is fixed as px.

(2) Swap width/height

Swaps the width and height of the canvas.

(3) Width

Sets the width of the canvas.

(4) Height

Sets the height of the canvas.

(5) Resolution

Sets the resolution of the canvas. Click the drop-down button next to it to select a value.

(6) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(7) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

The expression color [Monotone] from Ver.1.2.1 and earlier will be converted into the following [basic expression 

color] and [drawing color].

 Basic expression color: Gray

 Drawing color: Only black
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Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(8) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(9) Paper color

You can set a color for the Paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to change the color 

of the Paper layer.

(10)Number of pages [EX]

When enabled, creates canvases based on the specified size and number of pages specified in [Number of pages].

(11) Record timelapse

When enabled, you can start recording a timelapse. If you save the file in Clip Studio format (extension: .clip), the timelapse will be saved 

with the file. For more detail on timelapses, see Clip Studio TIPS.

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

 For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click [Paper Layer] in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the [Paper Layer].

 For details on the [New] dialog box in DEBUT, see "Advanced settings of color Dialog Box".

You cannot set a lower number of pages than the current amount.
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Change basic work settings Dialog Box (Comic)
This is the [Change basic work settings] dialog box that appears when the [Use of work] is set to [Comic].

A. Unit
The unit for setting the width and height of the canvas. In this window, the unit is fixed as mm.
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B. Manga draft settings > Binding (finish) size
Adjust the settings for creating the comic canvas.

(1) Swap width/height

Swaps the width and height of the canvas.

(2) Width

Horizontal length to print.

(3) Height

Vertical length to print.

(4) Default size (finish size)

Allows you to select a width and height for the finish size from default sizes.

(5) Bleed width

Sets the [Bleed width]. You can select from [5mm] or [3mm].

The bleed width is a margin to compensate for misaligned trimming of the edges of the pages. To print to the edge of the page, draw up to 

the bleed width area.

The area between the bleed border (the first border from the edge) and the finish border (the second border from the edge) is the bleed area.

(6) Resolution

Set the resolution of the page. When the basic expression color is set to [Monochrome], you can choose from 600dpi or 1200dpi. When the 

basic expression color is set to [Color] or [Gray], you can choose from 350dpi or 600dpi.

(7) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(8) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.
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Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(9) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

C. Setting for fanzine
Configures settings related to printing fanzines.

(1) Check whether to export fanzine printing data

Turn this on and click [OK] in the [Change basic work settings] dialog box to check whether your fanzine printing data can be exported. If 

the data cannot be exported as fanzine printing data, a message will appear when you click the [OK] button in the [New] dialog box.

D. Multiple pages
You can create a work consisting of multiple pages and configure settings such as the number of pages and binding direction.

(1) Number of pages

Sets the number of pages to create. Click the drop-down button next to it to select the amount.

(2) Binding point

Selects the direction in which to bind the book. Select either [Left binding] or [Right binding].

(3) Start page

Set which side to put the first page.

 When starting with a left page, select [From left].

 When starting with a right page, select [From right].

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

You cannot set a lower number of pages than the current amount.

Generally, [Left binding] is used for Western-style comics, and [Right binding] is used for Japanese-style manga.

The [Start page] setting is not available when [Cover page] is turned on.
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E. Cover page
You can add a cover page and configure settings such as the drawing colors and resolution.

(1) Cover page

When switched from off to on, you can add cover pages to the work. The first and last pages are replaced with a [Cover page], [Cover 

(inside)], [Back cover (inside)] and [Back cover page].

When switched from On to Off, the [Cover page], [Cover page (back)], [Back cover page (back)] and [Back cover page] remain but are 

changed to normal pages.

 When [Cover page] is turned on and [OK] is clicked in the [Change basic work settings] dialog box, a message 

saying "Set existing pages as cover pages?" may be shown. Click [No] to add new cover pages at the begin-

ning and end of the work.

 The existing settings of the cover pages or the pages replaced by normal pages are maintained when the 

[Cover page] setting is changed. Make sure that settings such as [Resolution] and [Basic expression color] in 

the [Story] menu > [Change basic page settings] match the settings in the [Change basic work settings] dialog 

box. For details on these settings, see "Change basic page settings".

When [Cover page] is turned on and [OK] is clicked in the [Change basic work settings] dialog box, a message 

saying "Added a cover page because the cover page cannot be replaced in this composition." may be shown.

If 4 or more pages are added for [Number of pages] in the [Change basic work settings] dialog box and [OK] is 

clicked, a [Cover page], [Cover page (back)], [Back cover page (back)] and [Back cover page] are added at the 

beginning and end of the work.

If pages cannot be replaced with cover pages in the [Change basic work settings] dialog, this may be caused by 

the following issues:

 The work contains fewer than 4 pages.

 An odd number of pages are set for the work.

 The first page is a spread page and the pages set as the [Cover (inside)] and [Back cover (inside)] are a spread 

page.

 The first page is a spread page and [Binding point] is set as [Right binding] but [Start page] is set as [Left] or 

[Binding point] is set as [Left binding] but [Start page] is set as [Right].

 The first page is a single page and the pages set as the [Cover (inside)], [Back cover (inside)] and [Back cover 

page] are a spread page.

 The first page is a single page, [Binding point] is set as [Right binding] and [Start page] is set as [Right] or 

[Binding point] is set as [Left binding] but [Start page] is set as [Left].

To replace the pages with cover pages, change the following settings:

(1) Turn [Cover page] off in the [Change basic work settings] dialog box.

(2) Change the [Multiple pages] setting to resolve the above issues and click [OK].

(3) Open the [Change basic work settings] dialog box again and turn on [Cover page].

Basic expression color: Color Basic expression color: Monochrome
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(2) Resolution

Set the resolution of the cover page. When the basic expression color is set to [Monochrome], you can choose from 600dpi or 1200dpi. 

When the basic expression color is set to [Color] or [Gray], you can choose from 350dpi or 600dpi.

(3) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(4) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(5) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(6) Paper color

You can set a color for the Paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to change the color 

of the Paper layer. This option is available when the basic expression color is set to [Color].

F. Story Information/Folio
Set the scope of application of the story information and folio.

(1) Reset setting changes page by page

When turned on, the position, size, edge settings and the like for the [Story information] and pagination for all pages adjusted individually 

with tools and palettes are disabled and changed to the values set on the [Change basic work settings] dialog box.

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click the Paper layer in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the Paper layer.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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G. Story information
Enter information such as the story name, number of stories, subtitle, author, and page numbers. This information is displayed outside the 

bleed border, in the non-printable area. These are optional settings, so you can skip items that aren’t relevant.

(1) Story name

Enter a title for the work. The pull down menu shows options for where to place the story name.

(2) Number of stories

When turned on, you can enter the number of stories in the work.

(3) Subtitle

Enter a subtitle for the comic or manga.

(4) Author

Enter the name of the author or author group. The pull down menu shows options for where to place the author name.

(5) Page number

Turn this on to add page numbers. The pull down menu shows options for where to place the page numbers. You can change the starting 

number with the [Start number] setting.

H. Folio
Adjust settings for the page numbers that are shown when the pages are bound.

(1) Start number

Enter the starting page number.

(2) Color

Choose a color for the page numbers. You can select from black or white.

(3) Put edges

Turn this on to add a border around the page numbers. In the input field on the right, set the thickness of the border.

(4) Folio

Turn this on to show the page numbers on the printed page. The pull down menu shows options for where to place the page numbers.

(5) Format

Set the text to be added before and/or after the page number, if any. Input the text in the fields on the left and right, respectively.
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(6) Gap with default border

Set the gap between the folio and the default border. A larger value increases the size of the gap.

(7) Font

Select the font to use for the page numbers.

(8) Size

Set the font size for the page numbers.

(9) Blind folio

When turned on, hidden page numbers are indicated in the lower part of the gutter (the side where the book is bound). Settings such as font 

and size cannot be set for [Blind folio].

I. Record timelapse *
When enabled, you can start recording a timelapse. If you save the file in Clip Studio format (extension: .clip), the timelapse will be saved 

with the file. For more detail on timelapses, see Clip Studio TIPS.
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Change basic work settings Dialog Box (Printing of fanzine)
This is the [Change basic work settings] dialog box that appears when the [Use of work] is set to [Printing of fanzine].

A. Unit
The unit for setting the width and height of the canvas. In this window, the unit is fixed as mm.

B. Manga draft settings > Binding (finish) size
Adjust the settings for creating the comic canvas.

A

B

C

D

E

F

G

H

I
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(1) Width

Horizontal length to print.

(2) Height

Vertical length to print.

(3) Default size (Cropped border)

Allows you to select a width and height for the finish size from default sizes.

(4) Bleed width

Sets the [Bleed width]. You can select from [5mm] or [3mm]. Selecting a printing place in [Fanzine printing vendor] automatically sets the 

[Bleed width] recommended by the printing place.

The bleed width is an extra margin to compensate for misaligned trimming of the edges of the pages. To print to the edge of the page, draw 

up to the bleed width area.

The area between the bleed border (the first border from the edge) and the finish border (the second border from the edge) is the bleed area.

(5) Resolution

Set the resolution of the page. If a printing place is selected in [Fanzine printing vendor], you can select from resolutions recommended by 

the printing vendor.

(6) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(7) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(8) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".
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C. Setting for fanzine
Configures settings related to printing fanzines.

(1) Fanzine printing vendor

Select the name of the printing vendor from which to request printing. This option will be set as [General-purpose settings] if there are no 

applicable companies.

(2) Home Page

The URL of the website of the printing place selected in [Fanzine printing vendor]. Click the URL to launch your web browser and display 

the website of the printing vendor. This item is not displayed if [General-purpose settings] or [Do not specify fanzine printing place] is 

selected.

(3) Check whether to export fanzine printing data

Turn this on and click [OK] in the [Change basic work settings] dialog box to check whether your fanzine printing data can be exported. If 

the data cannot be exported as fanzine printing data, a message will appear when you click the [OK] button in the [New] dialog box.

D. Multiple pages
You can create a work consisting of multiple pages and configure settings such as the number of pages and binding direction.

(1) Number of pages

Sets the number of pages to create. Click the drop-down button next to it to select the amount.

If [Cover page] is turned on, include the cover page when setting the number of pages. The numbers of pages that can be selected differ 

depending on the settings.

(2) Binding point

Selects the direction in which to bind the book. Select either [Left binding] or [Right binding].

[Fanzine printing vendor] is a Japanese langauge only service. Fanzine printing vendor cannot be selected in 

other language versions of Clip Studio Paint.

You cannot set a lower number of pages than the current amount.

Generally, [Left binding] is used for Western-style comics, and [Right binding] is used for Japanese-style manga.
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E. Cover page
You can add a cover page and configure settings such as the drawing colors and resolution.

(1) Resolution

Set the resolution of the cover page. If a printing place is selected in [Fanzine printing vendor], you can select from resolutions recom-

mended by the printing vendor.

(2) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(3) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(4) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(5) Paper color

You can set a color for the Paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to change the color 

of the Paper layer. This option is available when the basic expression color is set to [Color].

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click the Paper layer in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the Paper layer.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

Basic expression color: Color Basic expression color: Monochrome
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F. Story Information/Folio
Set the scope of application of the story information and folio.

(1) Reset setting changes page by page

When turned on, the position, size, edge settings and the like for the [Story information] and pagination for all pages adjusted individually 

with tools and palettes are disabled and changed to the values set on the [Change basic work settings] dialog box.

G. Story information
Input information such as the story name and author name. This information is displayed outside the bleed border, in the non-printable 

area. These are optional settings, so you can skip items that aren’t relevant.

(1) Story name

Enter a title for the work. The pull down menu shows options for where to place the story name.

(2) Author

Enter the name of the author or author group. The pull down menu shows options for where to place the author name.

H. Folio
Adjust settings for the page numbers that are shown when the pages are bound.

(1) Folio

Turn this on to show the page numbers on the printed pages. The pull down menu shows options for where to place the page numbers.

(2) Format

Set the text to be added before and/or after the page number, if any. Input the text in the fields on the left and right, respectively.

(3) Font

Select the font to use for the page numbers.

(4) Size

Set the font size for the page numbers.

(5) Blind folio

When turned on, hidden page numbers are indicated at the bottom of the gutter (the side where the book is bound). Settings such as font 

and size cannot be set for [Blind folio].

I. Record timelapse *
When enabled, you can start recording a timelapse. If you save the file in Clip Studio format (extension: .clip), the timelapse will be saved 

with the file. For more detail on timelapses, see Clip Studio TIPS.
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Change basic work settings Dialog Box (Show all comic settings)
This is the [Change basic work settings] dialog box that appears when the [Use of work] is set to [Show all comic settings]. The same settings 

are also displayed if [Use of work] is not displayed in the [Change basic work settings] dialog box.

A. Unit
Select a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.

A

B

C

D

E

F

G

H

I

J

K

L

M
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B. Canvas
Adjust settings related to the canvas.

(1) Swap width/height

Swaps the width and height of the canvas.

(2) Width

Sets the width of the canvas.

(3) Height

Sets the height of the canvas.

(4) Resolution

Sets the resolution of the canvas. Click the drop-down button next to it to select a value.

(5) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(6) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

 When [Manga draft settings] is turned off, the canvas size will be the final size.

 When [Manga draft settings] is turned on, the [Binding (finish) size] will be the final size when bound.

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".
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(7) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(8) Paper color

You can set a color for the Paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to change the color 

of the Paper layer.

C. Manga draft settings
Turn this on to add crop marks, default border (inner), cropped border, bleed border and safety margin to the canvas.

Configuring the sizes of the bleed border, default border, and canvas displays these guides on the canvas.

D. Manga draft settings > Binding (finish) size
Adjust the settings for creating the comic canvas.

(1) Width

Horizontal length to print.

(2) Height

Vertical length to print.

(3) Default size (Cropped border)

Allows you to select a width and height for the finish size from default sizes.

(4) Bleed width

The bleed width is an extra margin to compensate for misaligned trimming of the edges of the pages. To print to the edge of the page, draw 

up to the bleed width area.

The area between the bleed border (the first border from the edge) and the finish border (the second border from the edge) is the bleed area.

E. Manga draft settings > Default border (inner) size
This is a reference border for laying out frames. There are two ways of specifying the default border: by size and position, or by margin. 

This option appears when [Manga draft settings] is turned on.

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click the Paper layer in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the Paper layer.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

Set size Set margin
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(1) Default size (Default border)

Allows you to select a width and height for the default border from default sizes.

(2) How to specify the default border

You can choose how to specify the size and position of the default border. The options vary depending on the default border settings.

(3) Default border settings

Sets the size and position of the default border. The options vary depending on the method of specifying the border.

Set size

Adjust the size and position of the default border.

Set margin

Adjust the default border based on the distance from the edges of the cropped border.

F. Manga draft settings > Safety margin
Turn this on to add a safety margin to the canvas. When printing magazines and books with different aspect ratios, the position of the bleed 

border changes depending on the format. The safety margin indicates the print-safe area for both magazines and books. Usually, publishers 

and printing companies specify its position.

Set size Adjust the size and position of the default border.

Set margin
Adjust the default border based on the distance from the edges of the 

paper.

Width Width of the default border.

Height Length of the default border.

X offset Horizontal position of the default border.

Y offset Vertical position of the default border.

 When [X offset] is 0, the default border will be located in the center of the finish border horizontally.

 When [Y offset] is 0, the default border will be located in the center of the finish border vertically.

Top Specifies the upper side of the default border as the distance from the top of the cropped border.

Bottom
Specifies the lower side of the default border as the distance from the bottom of the cropped 

border.

Gutter
Specifies the right or left side of the default border as the distance from the direction of the 

binding point.

Outside
Specifies the right or left side of the default border as the distance from the outer edge of the 

page (opposite side to the binding point).

Top Specifies the upper side of the safety margin as the distance from the top of the cropped border.

Bottom Specifies the lower side of the safety margin as the distance from the top of the cropped border.

Inside Specifies the left/right side of the safety margin as the distance from the cropped border on the binding side.

Outside
Specifies the left/right side of the safety margin as the distance from the cropped border on the outer side of the 

page.
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G. Setting for fanzine
Sets settings related to printing fanzines.

(1) Fanzine printing vendor

Select the name of the printing vendor from which to request printing. Select [Do not specify fanzine printing place] if you do not want to 

set a fanzine printing place.

(2) Home Page

The URL of the website of the printing place selected in [Fanzine printing vendor]. Click the URL to launch your web browser and display 

the website of the printing vendor. This item is not displayed if [General-purpose settings] or [Do not specify fanzine printing place] is 

selected.

(3) Check whether to export fanzine printing data

Turn this on and click [OK] in the [Change basic work settings] dialog box to check whether your fanzine printing data can be exported. If 

the data cannot be exported as fanzine printing data, a message will appear when you click the [OK] button in the [New] dialog box.

H. Multiple pages
You can create a work consisting of multiple pages and configure settings such as the number of pages and binding direction.

(1) Multiple pages

Turn this on to create a file with multiple pages.

(2) Number of pages

Sets the number of pages to create. Click the drop-down button next to it to select the amount.

If [Cover page] is turned on, include the cover page when setting the number of pages. The numbers of pages that can be selected differ 

depending on the settings.

(3) Binding point

Selects the direction in which to bind the book. Select either [Left binding] or [Right binding].

[Fanzine printing vendor] is a Japanese langauge only service. Fanzine printing vendor cannot be selected in 

other language versions of Clip Studio Paint.

You cannot set a lower number of pages than the current amount.

Generally, [Left binding] is used for Western-style comics, and [Right binding] is used for Japanese-style manga.
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(4) View *

You can choose from the following views. The settings and [Story] window will change depending on the view.

(5) Start page

Set which side to put the first page.

 When starting with a left page, select [From left].

 When starting with a right page, select [From right].

I. Cover page
You can add a cover page and configure settings such as the drawing colors and resolution.

(1) Cover page

When switched from off to on, you can add cover pages to the work. The first and last pages are replaced with a [Cover page], [Cover 

(inside)], [Back cover (inside)] and [Back cover page].

When switched from On to Off, the [Cover page], [Cover page (back)], [Back cover page (back)] and [Back cover page] remain but are 

changed to normal pages.

Page-by-page Pages will be optimized for works with page turns such as bound books.

Webtoon Pages will be optimized for vertical scrolling works such as webtoons.

You can set it up by selecting [Page-by-page] under [View].

 The [Start page] setting is not available when [Cover page] is turned on.

 You can set it up by selecting [Page-by-page] under [View].

 When [Cover page] is turned on and [OK] is clicked in the [Change basic work settings] dialog box, a message 

saying "Set existing pages as cover pages?" may be shown. Click [No] to add new cover pages at the begin-

ning and end of the work.

 The existing settings of the cover pages or the pages replaced by normal pages are maintained when the 

[Cover page] setting is changed. Make sure that settings such as [Resolution] and [Basic expression color] in 

the [Story] menu > [Change basic page settings] match the settings in the [Change basic work settings] dialog 

box. For details on these settings, see "Change basic page settings".
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(2) Resolution

Type in the cover page resolution. Clicking the drop-down button on the right allows you to select a resolution from 72dpi to 1200dpi.

(3) Basic expression color

Sets the basic expression color. You can choose from [Color], [Gray], or [Monochrome].

(4) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

When [Cover page] is turned on and [OK] is clicked in the [Change basic work settings] dialog box, a message 

saying "Added a cover page because the cover page cannot be replaced in this composition." may be shown.

If 4 or more pages are added for [Number of pages] in the [Change basic work settings] dialog box and [OK] is 

clicked, a [Cover page], [Cover page (back)], [Back cover page (back)] and [Back cover page] are added at the 

beginning and end of the work.

If pages cannot be replaced with cover pages in the [Change basic work settings] dialog, this may be caused by 

the following issues:

 The work contains fewer than 4 pages.

 An odd number of pages are set for the work.

 The first page is a spread page and the pages set as the [Cover (inside)] and [Back cover (inside)] are a spread 

page.

 The first page is a spread page and [Binding point] is set as [Right binding] but [Start page] is set as [Left] or 

[Binding point] is set as [Left binding] but [Start page] is set as [Right].

 The first page is a single page and the pages set as the [Cover (inside)], [Back cover (inside)] and [Back cover 

page] are a spread page.

 The first page is a single page, [Binding point] is set as [Right binding] and [Start page] is set as [Right] or 

[Binding point] is set as [Left binding] but [Start page] is set as [Left].

To replace the pages with cover pages, change the following settings:

(1) Turn [Cover page] off in the [Change basic work settings] dialog box.

(2) Change the [Multiple pages] setting to resolve the above issues and click [OK].

(3) Display the [Change basic work settings] dialog box again and turn [Cover page] on.

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".
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(5) Default frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots. This appears when the basic expression color is set to 

[Gray] or [Monochrome].

(6) Paper color

You can set a color for the Paper layer. Click the color indicator to open the [Color settings] dialog box. Specify a color to change the color 

of the Paper layer. This option is available when the basic expression color is set to [Color].

J. Story Information/Folio
Set the scope of application of the story information and folio.

(1) Reset setting changes page by page

When turned on, the position, size, edge settings and the like for the [Story information] and pagination for all pages adjusted individually 

with tools and palettes are disabled and changed to the values set on the [Change basic work settings] dialog box.

K. Story information
Enter information such as the story name, number of stories, subtitle, author, and page numbers. This information is displayed outside the 

bleed border, in the non-printable area. These are optional settings, so you can skip items that aren’t relevant.

(1) Story name

Enter a title for the work. The pull down menu shows options for where to place the story name.

(2) Number of stories

When turned on, you can enter the number of stories in the work.

(3) Subtitle

Enter a subtitle for the comic or manga.

(4) Author

Enter the name of the author or author group. The pull down menu shows options for where to place the author name.

(5) Page number

Turn this on to add page numbers. The pull down menu shows options for where to place the page numbers. You can change the starting 

number with the [Start number] setting.

 The Paper layer is a single-color layer at the bottom of the layer palette. When the paper layer is hidden, trans-

parent areas of the canvas will be shown in a checkered pattern.

 The Paper layer color can be changed afterwards. You can double-click the Paper layer in the [Layer] palette to 

display the [Color settings] dialog box and change the color of the Paper layer.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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L. Folio
Adjust settings for the page numbers that are shown when the pages are bound.

(1) Start number

Enter the starting page number.

(2) Color

Choose a color for the page numbers. You can select from black or white.

(3) Put edges

Turn this on to add a border around the page numbers. In the input field on the right, set the thickness of the border.

(4) Folio

Turn this on to show the page numbers on the printed page. The pull down menu shows options for where to place the page numbers.

(5) Format

Set the text to be added before and/or after the page number, if any. Input the text in the fields on the left and right, respectively.

(6) Gap with default border

Set the gap between the folio and the default border. A larger value increases the size of the gap.

(7) Font

Select the font to use for the page numbers.

(8) Size

Set the font size for the page numbers.

(9) Blind folio

When turned on, hidden page numbers are indicated in the lower part of the gutter (the side where the book is bound). Settings such as font 

and size cannot be set for [Blind folio].

M. Record timelapse *
When enabled, you can start recording a timelapse. If you save the file in Clip Studio format (extension: .clip), the timelapse will be saved 

with the file. For more detail on timelapses, see Clip Studio TIPS.
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Change basic work settings Dialog Box (Animation)
Displayed when [Animation] is selected for [Use of work] in the [New] dialog box. This allows you to change settings related to animation 

works.

(1) Unit

Select a unit for the width and height. You can choose from centimeters, millimeters, inches, pixels, or points.

(2) Story name

Enter a name for the story. The pull down menu shows options for where to place the story name. This information is displayed in the 

blank space.

(3) Number of stories

Enter the number of stories.

(4) Reset setting changes page by page

Turn this on to stop adjustments made to one page, such as frame sizes and the story information position, from being applied to all the 

other pages.

(5) Manage files using folders

Turn this on to manage multiple files in folders. Click [OK] in the [Change basic work settings] dialog to display the [Create story folder] 

dialog and create a folder for managing files.

(6) Cel template

Click this to open the [Template] dialog, where you can select a template (layer configuration) for cels. Cel templates are applied when a 

cel is created by selecting [Animation] > [New animation cel]. If a template is already being used, you can open the [Template] dialog by 

clicking the template name button.

(7) Record timelapse *

When enabled, you can start recording a timelapse. If you save the file in Clip Studio format (extension: .clip), the timelapse will be saved 

with the file. For more detail on timelapses, see Clip Studio TIPS.

For details on the [Create story folder] dialog box, see "Batch import [EX]".
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Sort page file names
You can reassign file names so that the pages managed in the [Page Manager] window have the same numbers as the page numbers indicated in 

the [Page Manager] window.

For example, if the cover page is page 1 and the body pages start from page 3, the file name of the cover page will be changed to 

"page0001.clip" and the file names for the body text will be changed to "page0003.clip", "page0004.clip", "page0005.clip", etc.

For two-page spreads, both page numbers are used in the file name ("page0006-page0007.clip", etc.).

Page manager
Select this command to open the [Page Manager] window.

[Sort page file names] cannot be used when using the group work function.

For details on the [Page Manager] window, see "Page Manager Window".

Page manager window
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Page Manager Layout [Windows/macOS/Tablet]
Sets the layout of the [Page Manager] window. You can choose from the following layout options: [Tab], [Left], [Right], [Top] and [Bottom].

Page manager window layout: Tab

Page manager window layout: Left Page manager window layout: Right

Page manager window layout: Up Page manager window layout: Bottom
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Auto-scroll*
The [Story] window scroll can be set in [Story] menu > [Page Manager Layout] > [Auto-scroll].

When enabled, the [Story] window will automatically scroll to display the page that is currently being edited.

View*
You can choose how to view pages from the [Story] window.

Page-by-page
Pages in the [Story] window will be displayed horizontally.

Webtoon
When enabled, pages in the [Story] window will be displayed vertically.

When [Webtoon] is selected in the [Page settings] of the [New] dialog box the [Settings for multi-page works] dia-

log may appear. The view will change once the [Binding point] and [Start page] are set and [OK] is clicked.
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Webtoon reading direction*
You can select the webtoon reading direction from [Left-to-right] or [Right-to-left].

 When [Page-by-page] is selected in the [Page settings] of the [New] dialog box and a file with page spreads is 

opened in [Webtoon] view, the spread pages will be split and displayed vertically.

 Even when [Page-by-page] is selected in the [Page settings] of the [New] dialog box and a file with page 

spreads or cover pages is opened in [Webtoon] view, adding and removing pages will be done two pages at a 

time.

Right-to-left Left-to-right
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Binding process
The [Binding process] submenu includes functions for publishing works created as fanzines.

Show binding list
Switches the display from the [Page Manager] window to the [Show binding list] window. In the [Show binding list] window, you can confirm 

and edit the print layout of the cover pages, back cover pages, and body pages of the work, as well as information on each page.

[Show binding list] window

(1) No.

A number indicating the order of the work as a whole.

(2) Thumbnails

These are the thumbnails of each page. Double click a thumbnail to open the page (canvas).

(3) Confirm

Shows a message when confirmation of an item is required, such as when there is an issue with the data.

(4) Flatplan

Shows the layout for printing and binding the work, including the cover page, back cover page and main text.

(5) Printing file name

This is each page’s file name when exporting fanzine printing data.

The command is not available when [Webtoon] is selected from [New] > [Use of work]. Please select [Story] > 

[View] > [Page-by-page], and set [Binding point] and [Start page] before running the function.

The [Show binding list] option is not available when the [Page Manager] window is not open.

To return to the [Page Manager] window, select the [Story] menu > [Binding process] > [Show binding list] again.

For details on resolving issues deatiled in confirmation messages, see "Confirmation message".
CLIP STUDIO PAINT Instruction Manual 393



Menus > Story Menu [EX] > Binding process
(6) Folio

This is the page numbers of the work. "-" is shown for pages that are set to not use a folio.

(7) Basic expression color

This is the basic expression color of each page. You can choose from [Color], [Gray] or [Monochrome].

(8) Resolution

Each page’s resolution.

(9) Memo

Memo allows you to leave notes such as messages for the printing place or reminders about the manuscript. Double clicking the field 

allows you to enter a note. In addition to confirming notes in this window, notes can be exported to a text file when exporting the fanzine 

printing data.

Confirmation message
If a message is shown in the [Confirm] field of the [Binding list] window, the following methods may resolve the issue.

Message Solution

No setting for cropped border.

This appears if a binding (finish) size is not set.

Open the page, select the [Story] menu > [Change basic page settings], turn on [Manga 

draft settings] and set the [Binding (finish) size].

For details on these settings, see "Change basic page settings".

Finish size differs from basic size.

This appears when the [Binding (finish) size] set in the [New] dialog box differs from the 

[Binding (finish) size] on the page.

Open the page, select the [Story] menu > [Change basic page settings], turn on [Manga 

draft settings] and set the [Binding (finish) size] so that it matches the other pages. 

For details on these settings, see "Change basic page settings".

Bleed width is not set.

This appears when a Bleed width is not set for the work.

Open the page, select the [Story] menu > [Change basic page settings], turn on [Manga 

draft settings] and set the [Bleed width].

For details on these settings, see "Change basic page settings".

Bleed width is different from width of basic 

setting.

This appears when the [Bleed width] set in the [New] dialog box differs from the Bleed 

width on the page.

Open the page, select the [Story] menu > [Change basic page settings], turn on [Manga 

draft settings] and set the [Bleed width] so that it matches the other pages. 

For details on these settings, see "Change basic page settings".

Cover page is set with monochrome, but 

basic expression colors on canvas aren't set 

with monochrome.

This appears when the cover page is set to [Monochrome] but the basic expression color 

is set to [Color] or [Gray]. 

Open to the applicable page and change the basic expression color to [Monochrome] in 

the [Story] menu > [Change basic page settings].

For details on these settings, see "Change basic page settings".

Cover page is set with gray, but basic 

expression colors on canvas are set with 

monochrome.

This appears when the cover page is set to [Color] or [Gray] but the basic expression 

color is set to [Monochrome].

Open to the applicable page and change the basic expression color to [Color] or [Gray] in 

the [Story] menu > [Change basic page settings]. 

For details on these settings, see "Change basic page settings".
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Main text is set with monochrome, but basic 

expression colors on canvas aren't set with 

monochrome.

This appears when a body page (main text) set to [Monochrome] has a basic expression 

color set to [Color] or [Gray]. Open to the applicable page and change the basic expres-

sion color to [Monochrome] in the [Story] menu > [Change basic page settings].

For details on these settings, see "Change basic page settings".

Width of spine is set to 0.0mm or narrower.

This is displayed when the width of the spine (crop mark alignment width) on the cover 

page is set to 0.0mm.

Open the page, turn on [Align crop mark] in the [Story] menu > [Change basic page set-

tings] and set the [Gap] (spine width).

For details on these settings, see "Change basic page settings".

Resolution may be set to the value that fan-

zine printing vendor doesn't accept.

This appears if the resolution differs from that specified by the printing vendor. The 

images may be scaled up or down when executing [Export fanzine printing data].

To export the data in its original resolution, use the [File] menu > [Export multiple pages] 

> [Batch export]. For details, see "Batch export".

Layer with expression color that cannot be 

reproduced with basic expression colors 

may be contained.

This appears when a page contains a layer with a larger number of colors than the basic 

expression color of the page. For example, if the basic expression color is set to [Mono-

chrome], layers set to [Color] or [Gray] cannot be reproduced. Open the page and change 

the expression colors or convert the layers to screentones.

For details on these settings, see "Layer Property Palette [PRO/EX]".

Folio is outside of cropped border.
This appears when the folio is outside the cropped border. Open the page and use the 

[Object] sub tool to move the folio inside the cropped border.

Text is outside of or near cropped border.

This appears when text such as dialog is outside or near the cropped border. Open the 

page and use the [Object] sub tool to move the text so that it is at least 5 mm inward from 

the cropped border.

Main text page is set to export with color.

This appears when the basic expression color of the body pages is set to [Color] or 

[Grey].

Open to the applicable page and change the basic expression color to [Monochrome] in 

the [Story] menu > [Change basic page settings].

For details on these settings, see "Change basic page settings".

Resolution is different from the basic set-

tings of cover page.

This appears when the cover page resolution set in the [New] dialog box differs from the 

actual resolution of the cover page.

Open to the applicable page and set the cover page resolution in the [Story] menu > 

[Change basic page settings] so that it matches the basic settings. 

For details on these settings, see "Change basic page settings".

Resolution is different from the basic set-

tings of main text.

This appears when the body page (main text) resolution set in the [New] dialog box 

differs from the actual resolution of the body pages (main text).

Open to the applicable page and set the main text resolution in the [Story] menu > 

[Change basic page settings] so that it matches the basic settings. 

For details on these settings, see "Change basic page settings".

Message Solution
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Settings of printing file name
You can add text to the beginning or end of the file name when exporting fanzine printing data.

1 Select [Story] menu > [Binding process] > [Settings of printing file name].

2 Configure this setting in [Settings of printing file name].

(1) Enter the text to be added to the printing file name in [Prefix] or [Suffix] for the [Cover page], [Back cover page] or [Main text].

(2) Click [OK].

3 The text is now added to the [Printing file name] in the [Binding list screen].

[Settings of printing file name] dialog box

(1) Cover page

Allows text to be added to the printing file name of the cover page.
CLIP STUDIO PAINT Instruction Manual 396



Menus > Story Menu [EX] > Binding process
(2) Back cover page

Allows text to be added to the printing file name of the back cover page.

(3) Main text

Allows text to be added to the printing file name of the main text.

(4) Prefix

Allows text to be added to the beginning of the printing file name.

(5) Suffix

Allows text to be added to the end of the printing file name.

Enable to sort the order of cover page
Select this item to move (rearrange) the pages set as [Cover page], [Cover page (back)], [Back cover page] and [Back cover page (back)] in the 

[Page Manager] window and [Show binding list].

If the same items are selected again, the [Cover page], [Cover page (back)], [Back cover page] and [Back cover page (back)] will be locked and 

cannot be moved.

The [Prefix] and [Suffix] settings for [Back cover page] are not applied if the cover page is a spread.
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Edit text
The [Edit text] function allows you to batch-edit dialog (text) in the work using the Story Editor. You can use functions such as Search and 

Replace or enter all dialog (text) at once before starting drawing.

[Edit text] operations
The following operations can be performed in [Edit text] in the [Story] menu.

Open story editor
Select this command to open the Story Editor.

Open the story editor "Open story editor"

Add new text "New text"

Delete text "Delete text"

Set font and size of text "Apply tool properties to text"

Search for text in the work "Searching for text"

Replace text in the work "Replace text"

The Story Editor can be operated with the mouse or keyboard. For details on how to use the Story Editor with the 

mouse or keyboard, see "Operations in the story editor [EX]".

 When the Story Editor is opened, the history of each page is deleted.

 While the Story Editor is open, actions on all pages are recorded to the History palette. Closing the Story Edi-

tor deletes the history of actions performed while the Story Editor was open.

 If text has already been added to the file, the text will appear in the Story Editor.

 You can edit the layout and text that appears in the Story Editor in [Preferences] > [Story editor] > [View]. For 

details, see "Edit text [EX]".
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[Story editor] window

(1) Page area

This area shows all the text for a single page. The page number is shown at the bottom. One page is created for each page in the work. You 

can select a page area by holding the Ctrl or Shift and clicking the page area.

(2) Text area

An area shows the text for a single segment. Click a text area to enter or edit the text. The entered or edited text will be reflected on the 

page. You can select a text area by holding Ctrl or Shift and clicking the text area.

 To select multiple page areas, hold Ctrl while selecting each item.

 To select a consecutive group of page areas, click the first item, then hold down Shift and select the last item.

 If text layers and balloon layers on the page are hidden, they will be shown as text areas, but will not be edit-

able.

 You can add a new text layer by selecting the [Story] menu > [Edit text] > [New text].

 To select multiple text areas, hold Ctrl while selecting each item.

 To select a consecutive group of text areas, click the first item, then hold down Shift and select the last item.
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New text
Creates a new text area in the Story Editor.

1 Click a text area in a page area.

2 Select the [Story] menu > [Edit text] > [New text].

3 A new text area will be added beneath the selected text area.

4 Click the new text area to enter text. Shows the entered text on the page.

 You can move text areas in the Story Editor. For details, see "Operations in the story editor [EX]".

 You can also create a new text area by moving the cursor to the beginning or end of a text area and pressing 

Shift + Enter.

 If the text on the page is written horizontally, it will be shown at the top left of the page.

 You can edit settings for text layers and fonts in the Story Editor in [Preferences] > [Story editor] > [View]. For 

details, see "Edit text [EX]".
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Delete text
Deletes a text area from the Story Editor.

1 Select the text area to be deleted by clicking while holding Ctrl.

2 Select the [Story] menu > [Edit text] > [Delete text].

3 The selected text area will be deleted from the Story Editor. The text is deleted from the
page at the same time.

You can also delete text areas by clicking a text area while holding down the Ctrl key to select the text area and 

then pressing Delete.
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Apply tool properties to text
Applies the formatting settings from the [Tool Property] palette of the [Text] sub tool to the selected text area.

1 You can select the text area to apply the settings to by clicking while holding down Ctrl.

2 Select the [Text] tool > [Text] sub tool from the [Sub tool] palette.
On the [Tool Property] palette, edit the formatting settings for the selected text.

3 Select the [Story] menu > [Edit text] > [Apply tool property to text].

4 The settings from the [Tool Property] palette of the [Text] sub tool will be applied to the
selected text area.

 The settings on the [Tool Property] palette of the [Text] sub tool can be saved as the default settings for text 

entered in the Story Editor. For details, see "Edit text [EX]".

 For information on configuring advanced settings for text, see "Editing Text".
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Find and Replace
You can search for or replace text in the Story Editor.

Searching for text
You can search for text in the Story Editor.

1 Select the [Story] menu > [Edit text] > [Find and Replace].

2 Enter the text to be searched and select the search method in the dialog box that appears.

(1) Enter the text to be searched in the [Search string] box.

(2) Select the [Search direction]. This sets the search direction from the current position of the cursor in the Story Editor.

(3) Click [Search].

3 The searched text will be highlighted in the Story Editor.

If the searched text appears multiple times in the work, you can search for the next instance by clicking [Search] 

again.
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Replace text
You can replace the text entered in [Search string] in the Story Editor with different text.

1 Select the [Story] menu > [Edit text] > [Find and Replace].

2 Edit the terms in the [Find and Replace] dialog box.

(1) Enter the text to be replaced in [Search string].

(2) Enter the replacement text in [Replacement string].

(3) Click [Replace all].

3 All instances of the text entered in [Search string] are replaced with the text entered in
[Replacement string].

To replace one instance at a time, click [Replacement] in the [Find and Replace] dialog box.
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[Find and Replace] dialog box

(1) Search string

Enter the text to be searched. If replacing text, enter the text to be replaced here.

(2) Replacement string

If replacing the text in [Search string], enter the replacement text here.

(3) Do not differentiate case

Turn this on to search text characters entered in the search string without differentiating between upper case and lower case.

(4) Search direction

Select the direction in which to start searching or replacing text. Select [Next] to search from below the position of the cursor. Select [Pre-

vious] to search from ahead of the position of the cursor.

(5) Search

Search for the text entered in [Search string] in the Story Editor. If the search text appears multiple times in the Story Editor, you can move 

to the next instance by clicking [Search] again.

(6) Replace

Search for the text entered in [Search string] in the text in the Story Editor and replace it with the text entered in [Replacement string]. 

Click this again to replace the target text and move to the next instance.

(7) Replace all

Replaces all instances of the target text at the same time. All instances of the text entered in [Search string] in the Story Editor are replaced 

with the text entered in [Replacement string].

(8) Close

Closes the [Find and Replace] dialog box.
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Group work [Windows/macOS]
A function allowing group work by multiple users for works consisting of multiple pages.

To enable group work, the user serving as the administrator uploads a work folder to a network server or shared folder as group work data.

The users working on the project obtain the group work data and create work folders on their own computers. Each user edits pages in their 

work folder and the edited content is reflected in the group work data on the network.

Operations of the group work function
The following operations can be performed with the group work function. The operations that can be performed may vary depending on the set-

tings of the group work data and your environment.

Update work folder
Select this to access the group work data on the network and update the work folder. Group work data edited by other users is reflected.

Each user's environment must be confirmed before using the group work function.

 If the group work data is saved to a Windows environment, the group work function cannot be used on com-

puters with Mac OS X 10.9.

 If the group work data is saved to a mac OS environment, the group work function cannot be used on comput-

ers with Windows.

Contents Command

To upload group work data "Prepare group work data"

To download group work data "Obtain group work data"

To specify a member in charge "Set member for work"

To reflect edited content in the group data "Reflect change on group work data"

To remove a member in charge "Cancel settings of member for work"

To update your work folder "Update work folder"

If multiple members have edited the same page
"Open conflicting file""Cancel change of work folder"

"Resolve confliction"

To check the work history "Show log"

To check the data settings, your user name and your user 

authority
"View settings"

 If the page you are editing in your work folder is updated by another user, a conflict occurs between the two 

versions of the page. Conflictions between multiple versions of a page can be resolved by performing [Cancel 

change of work folder] or [Resolve confliction]. For details, see "Cancel change of work folder" and "Resolve 

confliction".

 If a confliction occurs for a page management file, this cannot be resolved by performing [Cancel change of 

work folder] or [Resolve confliction]. In [Obtain group work data], create a work folder in another folder, per-

form an operation such as adding a page and perform [Reflect change on group work data].
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Reflect change on group work data
The content edited in your work folder is reflected in the group work data.

1 Select the [Story] menu > [Group work] > [Reflect change on group work data].

2 In the [Reflect change on group work data] dialog box, set the page for which to reflect
edited content in the group work data.

(1) Enter a message for other users in [Comment].

(2) Select the page for which to reflect edited content in the group work data from [Reflected file].

(3) Click [OK].

3 Confirm the content in the [Result of change] dialog box and click [OK].

When works containing a file object layer are included in group work data, the reference file of the file object layer 

is not included. To apply changes to the file object layer, the reference file needs to be placed in a location where 

all users can access it.
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[Reflect change on group work data] dialog box

(1) Cancel setting of member for work

Turn this on to remove your setting as the member in charge when reflecting the changes in the group work data.

(2) Comment

Enter a message for other users.

(3) Reflected file

A list of pages and files edited in your work folder. Turn on the checkbox of each page or file for which to reflect changes in the group 

work data.

If the page you are editing in your work folder is updated by another user, a conflict occurs between the two ver-

sions of the page. Conflictions between multiple versions of a page can be resolved by performing [Cancel 

change of work folder] or [Resolve confliction]. For details, see "Cancel change of work folder" and "Resolve con-

fliction".

If you have added or deleted pages, the changes to the page management file also need to be reflected in the 

group work data.
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Show log
Select this to display the [Log] dialog box and check the log for [Reflect change on group work data] (change history).

[Log] Dialog Box

(1) Displayed content

Select the content for which to display a log.

(2) Log

A list of group work data logs. The content to be displayed can be refined in [Displayed content].

The date on which the group work data was uploaded, serial number, name of the member in charge and comments are displayed here. 

Select a log to display details in [Comment] and [Change file].

(3) Comment

Displays comments added to the selected log. This is not displayed if a log with no comments is selected.

Show all log Displays the logs of the page management file and all logs.

Show log of selected page Displays the log of the page selected in the [Page Manager] window.

Show log of page management file Displays the log of the page management file.

A serial number is not displayed if the group work data is set as [Do not rewrite over group work data]. The set-

tings of the group work data can be checked in [Show settings]. For details, see "View settings".

Comments are added when performing [Reflect change on group work data]. For details, see "Reflect change on 

group work data".
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(4) Change File

Displays the number of changed pages in the selected log. A basic history of changes such as [Updated] and [Added] is also displayed.

Below is a breakdown of changes.

Add Displayed when a page is added.

Update Displayed when a page is updated.

Deleted Displayed when a page is deleted.

Submit
Displayed when a user performs [Reflect change on group work data] if [Do not rewrite over group work data] is 

turned on for the group work data. This creates a duplicate file without overwriting the group work data.

Reject
Displayed for group data set to [Do not rewrite over group work data] if a work file edited by a user is deleted when 

the administrator performs [Resolve confliction]. 
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Set member for work
A member in charge can be set for each page.

1 Select the page for which to set a member in charge from the [Page Manager] window.

2 Select the [Story] menu > [Group work] > [Set member for work].

3 Specify the member in charge and the page they are in charge of in the [Set member for
work] dialog box.

(1) Turns on [Give instructions to other users].

(2) Enter the name of the member.

(3) Enter instructions, etc. in [Comment].

 It may not be possible to set [Set member for work] depending on the group work data setting. A member in 

charge can be set when your [Authority] is [Administrator] or when [Open only file set for member in charge] 

and [Do not rewrite over group work data] are turned off.

 The settings of the group work data, such as [Authority], can be checked in [Show settings]. For details, see 

"View settings".
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(4) Select the page for which to specify a member in charge from [File to do while in charge of].

(5) Click [OK].

4 An icon and the name of the member appear next to the applicable page in the [Story] win-
dow when the member in charge is set.

[Set member for work] dialog box

(1) Set yourself in charge

When turned on, this allows members to specify themselves as members in charge.

Multiple members in charge can be set for the same page. Selecting a page for which a member in charge has 

been specified and setting another member in [Set member for work] displays an icon and the number of mem-

bers in charge next to the applicable page in the [Page Manager] window.

When [Open only file set for member in charge] is turned on for group work data, the [Set member for work] dialog 

box is displayed when opening a page for which no member in charge has been set by the [Administrator], allow-

ing a member in charge to be set.
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(2) Give instructions to other users

When turned on, this allows members to specify other members as members in charge.

(3) Name of member

Enter the name of a member to set that member. If you have previously entered a member’s name, you may be able to select it from the 

menu by clicking the drop-down button on the right.

(4) Comment

Allows you to enter a comment such as work instructions.

(5) File to do while in charge of

A list of pages and files for which a member in charge can be set. Turn on the checkbox of each page to select pages for which to set a 

member in charge.

When setting [Name of member], use the name set for [User name] in [Prepare group work data] and [Obtain group 

work data]. A member cannot be set as a member in charge if the name set in [Name of member] is different from 

that set in [User name]. Users should confirm each other's user name before starting work.

The member names shown are a history of names previously used in [Name of member]. A maximum of 10 entries 

are displayed.

Setting a member in charge of a page management file allows that member to add and delete pages. If [Open only 

file set for member in charge] or [Do not rewrite over group work data] is turned on, only the [Administrator] can 

add or delete pages.
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Cancel settings of member for work
Removes the member(s) in charge set for a page.

1 Select the page for which to remove a member in charge from the [Page Manager] window.

2 Select the [Story] menu > [Group work] > [Cancel setting of member for work].

3 Remove the member in charge set for the page in the [Cancel setting of member for work]
dialog.

(1) Select the name of a member.

(2) Select the page for which to remove a member in charge from [File in no charge of].

(3) Click [OK].

 It may not be possible to perform [Cancel setting of member for work] depending on the group work data set-

ting. The member in charge settings can be deleted if your [Authority] is [Administrator] or [Open only file set 

for member in charge] and [Do not rewrite over group work data] are turned off.

 The settings of the group work data, such as [Authority], can be checked in [Show settings]. For details, see 

"View settings".
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4 The icon and name of the member disappear from the applicable page in the [Page Man-
ager] window when the member in charge is removed.

[Cancel settings of member for work] dialog box

(1) Name of member

Select the name of the user who will no longer be a member in charge.

(2) File in no charge of

Select the file or page for which to remove a member in charge. You can select a file by turning on the checkbox.
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Show member's comment
Select this to display the [Member's comment] dialog box and check the settings of and comments from the member in charge.

[Member's comment] dialog box

(1) Member in charge

Displays the settings of the member in charge.

The page for which the member in charge was set, the date on which they were set as a member in charge, the name of the member in 

charge and comments from the member are displayed here. Select this to display detailed comments in [Comment].

(2) Comment

Displays comments for the item selected in [Member in charge]. This is not displayed if an item with no comments is selected.

Comments are added when [Set member for work] is executed. For details, see "Set member for work".
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Cancel change of work folder
Cancels the changes made in your work folder and restores the contents to their status when they were imported from the group work data.

1 Select the [Story] menu > [Group work] > [Cancel change of work folder].

2 In the [Cancel change of work folder] dialog, select the file for which to cancel changes
and click [OK].

3 Confirm the content in the [Result of change] dialog box and click [OK].

If changes by another user are reflected on the same page, the page is imported with the other user's edits.
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4 In the [Cancel change of work folder] dialog box, the changes are canceled and the files
are obtained from the group work data.

Open conflicting file
Opens the conflicting file saved in your work folder.

1 Select the conflicting page from the [Page Manager] window.

2 Select the [Story] menu > [Group work] > [Open conflicting file].

3 The conflicting file saved in your work data opens.

If multiple users edit the same page at the same time and both users attempt to reflect their changes in the group 

work data or update their work folder, a confliction occurs in the page. A yellow "!" icon will appear next to con-

flicting files in the [Page Manager] window. 

When a conflict occurs, edits by the other user are saved in your work folder as a new, independent file. This file is 

called a "Conflicting file".

If the group work data is set to [Do not rewrite over group work data], the [Open conflicting file (for Administrator)] 

dialog box is displayed for the administrator. In [File to open], select the file to be opened and click [OK].

For details, see "[Open conflicting file (for Administrator)] dialog box".
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[Open conflicting file (for Administrator)] dialog box

(1) Show only the latest one

When turned on, this displays only the last file for which a user performed [Reflect change on group work data].

(2) File to open

Displays a list of files created when users have performed [Reflect change on group work data]. Select the file to open.

If a user performs [Reflect change on group work data], a new file is created in the group work data. If multiple 

users perform [Reflect change on group work data] for the same page, a new file is created each time this opera-

tion is performed.
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Resolve confliction
Select the file containing the version of the conflicting page to be kept. This resolves the confliction.

1 Select the conflicting page from the [Page Manager] window.

2 Select the [Story] menu > [Group work] > [Resolve confliction].

3 In the dialog box that appears, select the file to be kept and click [OK].

If multiple users edit the same page at the same time and both users attempt to reflect their changes in the group 

work data or update their work folder, a confliction occurs in the page. A "!" icon will appear next to conflicting 

files in the [Page Manager] window. ] displays the icon.

If the group work data is set to [Do not rewrite over group work data], the [Resolve confliction (for Administrator)] 

dialog box is displayed for the administrator. In [File to keep], select the file to be kept in the work folder and click 

[OK].

For details, see "[Resolve confliction (for Administrator)] dialog".
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4 The selected file is kept and the other files are discarded, resolving the confliction. The
icon indicating a confliction disappears from beside the page in the [Page Manager] win-
dow.

[Resolve confliction] dialog box
This dialog is displayed if [Do not rewrite over group work data] is turned off or if you have [User] authority. Select the version of the page to 

be kept by selecting the file in the group work data or the file you edited.

To reflect the settings in the group work data, perform [Reflect change on group work data] after performing 

[Resolve confliction].

The settings of the group work data can be checked in [Show settings]. For details, see "View settings".
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[Resolve confliction (for Administrator)] dialog
This dialog is displayed when the administrator selects [Resolve confliction] if [Do not rewrite over group work data] is turned on.

(1) Show only the latest one

When turned on, this displays only the last file for which a user performed [Reflect change on group work data].

(2) File to keep

Displays a list of files created when users have performed [Reflect change on group work data]. Select the file to keep.

Prepare group work data
Open the page management file for which to perform group work and upload the group work data to a location such as a network server or 

group folder. You can also specify an operation method for the group work data.

Execute [Prepare group work data]. The user who uploaded the group work data is set as the administrator.

The settings of the group work data can be checked in [Show settings]. For details, see "View settings".

If a user performs [Reflect change on group work data], a new file is created in the group work data. If multiple 

users perform [Reflect change on group work data] for the same page, a new file is created each time this opera-

tion is performed.

 The settings configured in the [Prepare group work data] dialog cannot be changed after uploading the group 

work data.

 When works containing a file object layer are included in group work data, the reference file of the file object 

layer is not included. To allow other users to edit the file object layer, the reference file needs to be placed in a 

location where all users can access it.
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1 Open the page management file for which to perform group work.

2 Select the [Story] menu > [Group work] > [Prepare group work data].

3 In the [Prepare group work data] dialog box, set the location and operation method of the
group work data and upload the data.

(1) In the [Location to create group work data] dialog box, specify the location in which to create group work data.

(2) Enter the name of the folder for the group work data in [Group work folder name].

(3) Enter the user name.

(4) Set an operation method for the group work data.

(5) Enter comments in [Comment].

(6) Click [OK].

For details on settings in the [Prepare group work data] dialog box, see "[Prepare group work data] dialog box".
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4 The [Prepare group work data] dialog box closes and the group work data is uploaded.
The displayed page management file can be edited continuously as the page management file of the work folder.

[Prepare group work data] dialog box

(1) Location to create group work data

Specify the location to create group work data so that other users can participate in the group work.

Example: Location set as the shared folder in Windows or macOS.

(2) Group work folder name

Enter the name of the folder to which to save the data for the group work.

(3) User name (your name)

Enter the name of the user performing [Prepare group work data].

(4) Open only files set for member in charge

When turned on, members can only open pages for which they are specified as a member in charge. Even the administrator of the group 

work data cannot open pages for which they are not specified as a member in charge.

If group work data is created in a shared folder set with the macOS file sharing feature, access authority needs to 

be set for group work members in macOS.

To use the group work function, set the access authority for all users to [Read/Write], click the gear icon and 

select "Apply to enclosed items".

See the help of your version of macOS for details on how to set the macOS file sharing function.

For information on how to set shared folders, see the help of your computer.

The user name set here is used when specifying and removing member names. Make sure to inform the other 

users of this user name before starting the group work.
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(5) Display warning if opening file that hasn't been set by member in charge

When turned on, a warning message is displayed when a member attempts to open a file for which they are not set as a member in charge.

This cannot be set if [Open only file set for member in charge] is set.

(6) Do not rewrite over group work data

When turned on, the group work data cannot be overwritten.

When a user performs [Reflect change on group work data], a new folder is created in the group work folder and the edited page is copied 

there.

Only the administrator can reflect users' edits in the group work data. When the administrator performs [Update work folder], the page 

edited by the user is imported as a conflicting file. The administrator must perform [Resolve confliction] and configure the settings so that 

the user's edits are reflected in the group work data.

Additionally, only the administrator can specify or remove members in charge.

(7) Comment

Enter comments for the group work data.

Specify members in charge in [Set member for work]. For details, see "Set member for work".

If an online file sharing service is used as the destination for creating group work data, turn on [Do not rewrite 

over group work data].

It may take time to reflect edits if the group work data is created on a file sharing service. This means that it may 

not be possible to operate the group work data correctly if [Do not rewrite over group work data] is turned off.
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Obtain group work data
Obtain (download) the group work data created in [Prepare group work data] and create a work folder on the computer you will use to partici-

pate in the group work.

Perform [Obtain group work data]. The user who created the work folder is set as a user.

1 Select the [Story] menu > [Group work] > [Obtain group work data].

2 In the [Obtain group work data] dialog box, obtain the group work data and create a work
folder on your computer.

(1) Choose a location for group work data to be accessed in [Group work data location].

(2) Specify a location in which to create the work folder in [Location to create work folder].

(3) Enter the name of the work folder in [Folder name].

(4) Enter the user name.

(5) Click [OK].

3 The [Obtain group work data] dialog closes and the work folder is created in the specified
location.
The [Page Manager] window of the work folder is also displayed.

For details on each item in the [Prepare group work data] dialog box, see "[Prepare group work data] dialog box".
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[Obtain group work data] dialog box

(1) Location of group work data (on network)

Specify the location of the group work data to be obtained.

(2) Location to create work folder (on this computer)

Specify a location in which to obtain the group work data and create a work folder for editing the data on your computer.

(3) Folder name

Enter a name for the work folder.

(4) User name (your name)

Enter the name of the user performing [Obtain group work data].

The user name set here is used when specifying and removing member names. Make sure to inform the other 

users of this user name before starting the group work.
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View settings
You can confirm the settings of the group work data you are currently editing.

[Settings of group work] Dialog Box

(1) Group work data

Displays the location of the group work data.

(2) Work folder

Displays the location of the work folder.

(3) User name

Displays the user name set for the group work data. This user name is used when specifying and removing member names.

(4) Authority

Displays the user's authority level. The user who performed [Prepare group work data] is displayed as [Administrator]. Users who perform 

[Obtain group work data] are displayed as [User].

(5) Open only files set for member in charge

Displays the setting configured by the administrator in the [Prepare group work data] dialog box.

(6) Warn if opening file not for member in charge

Displays the setting configured by the administrator in the [Prepare group work data] dialog box.

(7) Do not rewrite over group work data

Displays the setting configured by the administrator in the [Prepare group work data] dialog box.

For details on [Open only file set for member in charge], [Warn if opening file not for member in charge] and [Do 

not rewrite over group work data] see "Prepare group work data".
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 Animation menu
The [Animation] menu allows you to manage animation folders and cels and perform operations on the [Timeline] pal-
ette. This section describes the commands in the [Animation ] menu.

Explanation: Animation folders and cels
Animation folders are folders for managing animation cels.

Layers and layer folders in an animation folder are treated as cels creating the movement of the animation.

Animation folder C: Eye movement cels

Animation folder B: Mouth movement cels

Animation folder A: Outlines

Layer folders are handled as a single cel.

These can be used in cases such as those 

where you want to use separate layers for 

the drawn lines and coloring.
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You can create animation by specifying cels to the [Timeline] palette.

Cels (layers) in an animation folder must be specified to the Timeline before they can be drawn on.

For details on specifying cels to the Timeline, see "Cel specification operations".

Animation folder C: Eye movement cels

Specify a cel in the animation folder for each track (animation folder) on the [Timeline] palette.

Cel: 1 Cel: 2 Cel: 3 Cel: 1
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New animation layer
This creates a new layer or folder for animation.

Animation folder
Creates a new animation folder on the [Layer] and [Timeline] palettes. Animation folders are folders for storing animation cels (layers).

Layers and layer folders created in an animation folder can be used as cels.

2D camera folder
Creates a 2D camera folder on the [Layer] palette and the [Timeline] palette.

You can use 2D camera folders to add camera movement to an animation without transforming the images in the animation folders or layers.

Audio
Creates a new audio layer (audio track) on the [Layer] palette and the [Timeline] palette.

You can use audio layers to add or edit audio files on the [Timeline] palette. In the [Timeline] palette, this is called an “audio track”.

Creating audio layers
To create an audio layer, select the [Animation] menu > [New animation layer] > [Audio].

The audio layer will be created in the [Layer] and [Timeline] palettes.

However, audio files can not be played in this state. To play audio files, you need to import an audio file. For information on importing audio 

files, see "Audio".

 Animation folders cannot be created inside an existing animation folder.

 If a single letter is set as the name of an animation folder, subsequent folders will automatically be named with 

the next letter of the alphabet. For example, if you select an animation folder called "A" in the [Layer] palette 

and create a new animation folder, the new animation folder will be called "B".

 Cels in an animation folder must be specified to the Timeline before they can be drawn on. For information on 

how to specify cels, see "Edit track". You can also specify a cel to the Timeline at the same time it is created by 

selecting the [Animation] menu > [New animation cel].

For details on adding camera movement with the 2D camera, see "Keyframe settings".

You cannot create an Audio layer if a Timeline has not been created on the canvas.
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New animation cel
Creates a new cel in an animation folder.

If a cel is created while the [Timeline] palette is enabled, the cel will be specified to the current frame.

To use this command, first select an animation folder on the [Layer] palette or [Timeline] palette.

Edit track
The [Edit track] submenu includes commands for specifying cels, clips, and keyframes on the Timeline.

Delete
Deletes a specified cel, clip, or keyframe from the Timeline.

Even if a specified cel, clip, or keyframe is deleted from the Timeline palette, the cel will remain in the [Layer] palette. The following explana-

tion uses cels as an example.

1 Click and select a cel on the Timeline to delete. The names of selected cels are displayed 
in bold.

 A new cel is specified for the frame selected in the [Timeline] palette. If another cel is already specified for the 

selected frame, the new cel is specified for the next frame.

 If another cel is already specified for the selected frame and there are multiple cels in the same clip, the new 

cel will be specified between the specified frame and the previous cel.

 The cel is a raster layer by default. You can change the layer type and expression color with the [Layer] menu 

> [Convert Layer]. For details, see "Convert layer [PRO/EX]".

 Cels can also be created by creating a new layer in the [Layer] palette or [Layer] menu. The cel will not be 

specified to the Timeline in this case. Specify a cel to the Timeline using methods such as the [Animation] 

menu > [Edit track].

 If you want to draw on or edit a cel that is not specified to the Timeline, select the [Animation] menu > [Enable 

timeline] to disable the timeline.

 You can set a [Cel template] in the [New] dialog in PRO or EX to create a cels with a template layer configura-

tion. This is useful for creating layer folders and multiple layers at once.

 To select multiple specified cels, hold Ctrl or Shift while selecting. You can also select multiple cels by drag-

ging to surround them.

 Select a clip to delete. To select multiple clips, hold Ctrl or Shift while selecting.

 Select a keyframe to delete. To select multiple keyframes, hold Ctrl or Shift while selecting.

 If no cel, clip, or keyframe is selected on the Timeline, the deletion target will depend on the area selected by 

the track name. For example, if a transformation area is selected, the transformed keyframes will be deleted 

from the current frame. If a specified cel area is selected, the cel of the current frame will be deleted.
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2 Select the [Animation] menu > [Edit track] > [Delete] to delete cels from the Timeline.

Cut
Cut and store a selected cel, clip, or keyframe from the Timeline to the clipboard.

Copy
Copies a selected cel, clip, or keyframe on the Timeline to the clipboard. The copied cel, clip, or keyframe remains on the Timeline.

Paste
Pastes the selected cel, clip, or keyframe stored on the clipboard to the Timeline.

Select a track and frame to paste the cel, clip, or keyframe on.

Select the [Animation] menu > [Edit track] > [Paste] to paste the cel, clip or keyframe onto the selected frame.

 When pasting to the same animation folder as the cel, clip, or keyframe stored in the clipboard, the same cel, clip, or keyframe will be 

pasted.

 You cannot paste them to different types of tracks (layers).

 When pasting a specified cel to an animation folder different from the cel stored on the clipboard, a cel with the same name will be speci-

fied in the designated folder. The same applies when pasting a clip containing a specified cel.

 You can also delete cels from the Timeline using key operations. For details on deleting with key operations, 

see "Delete the cel specification".

 For details on deleting clips from the Timeline, see "Delete clip".

 For details on deleting keyframes from the Timeline, see "Delete keyframe".

 To select multiple specified cels, hold Ctrl or Shift while selecting. You can also select multiple cels by drag-

ging to surround them.

 To select multiple clips, hold Ctrl or Shift while selecting.

 To select multiple keyframes, hold Ctrl or Shift while selecting. You can also select multiple keyframes by 

dragging to surround the keyframes.

 To select multiple specified cels, hold Ctrl or Shift while selecting. You can also select multiple cels by drag-

ging to surround them.

 To select multiple clips, hold Ctrl or Shift while selecting.

 To select multiple keyframes, hold Ctrl or Shift while selecting. You can also select multiple keyframes by 

dragging to surround the keyframes.
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Enable keyframes on this layer
Enables/disables editing with keyframes on the selected layer or track.

Add keyframe
When selected, a keyframe is added to the frame selected on the Timeline.

You record the following settings in the [Timeline] palette using keyframes.

 Moving or transforming animation folders or layers

 Changing the opacity of animation folders or layers

 Camera movement and opacity of 2D camera folder

 Audio layer volume

 Keyframe interpolation

Switch keyframe to hold interpolation
Changes the keyframe interpolation method to hold interpolation.

Select the keyframe in the [Timeline] palette and click the [Animation] menu > [Edit Track] > [Switch keyframe to hold interpolation].

The keyframe interpolation of the selected keyframe will be set to [Hold].

Switch keyframe to linear interpolation
Changes the keyframe interpolation method to linear interpolation.

Select the keyframe in the [Timeline] palette and click the [Animation] menu > [Edit Track] > [Switch keyframe to linear interpolation].

The keyframe interpolation of the selected keyframe will be set to [Linear].

You can also toggle [Enable keyframes on this layer] from the [Timeline] palette. For details, see "Enable keyframe 

editing".

 You can also add keyframes using the [Timeline] palette. For details, see "Keyframe settings".

 For more information on using keyframes, see "Key frame operation".

 If you want to add keyframes to animation folders or layers, select the desired layer and select the [Animation] 

menu > [Edit track] > [Enable keyframes on this layer]. For 2D camera folders and audio layers, keyframes can 

be added without turning on [Enable keyframes on this layer].

 For details on keyframe interpolation, see "Graph Editor".

 For details on how to change the keyframe interpolation method, see "Changing the keyframe interpolation".

 For more information on interpolation methods, see "Graph Editor".

 For details on how to change the keyframe interpolation method, see "Changing the keyframe interpolation".

 For more information on interpolation methods, see "Graph Editor".
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Switch keyframe to smooth interpolation
Changes the keyframe interpolation method to smooth interpolation.

Select the keyframe in the [Timeline] palette and click the [Animation] menu > [Edit Track] > [Switch keyframe to smooth interpolation].

The keyframe interpolation of the selected keyframe will be set to [Smooth].

Edit layers with active keyframes
This allows you to temporarily draw or make edits with a brush or pen on a layer (track) that has [Enable keyframes on this layer] turned on.

When on, the selected layer’s transformations will be disabled, leaving only the selected layer and paper layer. All other layers will be dis-

played as semi-transparent.

It you switch to another layer, this setting will turn off automatically. All layers will return to the usual opacity.

Delete all keyframes
Deletes all keyframes from the selected track on the Timeline.

Specify cels
Select this to open the [Select layer] dialog box. In this dialog box, choose a cel for the frame selected on the Timeline. First, you need to be 

selecting an animation folder on the [Layer] palette or [Timeline] palette.

1 Select the frame for which to specify a cel on the Timeline.

(1) Click the frame for which to specify a cel.

(2) Click the track (animation folder) for which to specify a cel.

2 Select the [Animation] menu > [Edit track] > [Specify cels].

 For details on how to change the keyframe interpolation method, see "Changing the keyframe interpolation".

 For more information on interpolation methods, see "Graph Editor".

You can also toggle this setting by clicking [Edit layers with active keyframes] on the [Timeline] palette.

 Cels can also be specified by right-clicking on the Timeline.

 You can specify cels while using the [Timeline] tool by selecting a frame in the [Timeline] palette and pressing 

Enter.
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3 Select the name of the cel to be specified from the [Select layer] dialog box and click [OK].

4 The cel will be specified to the Timeline.

[Select layer] Dialog Box

(1) Select layer

A list of cel (layer) names in the currently selected animation folder. Here you can select the cel to be specified to the Timeline.

(2) Enter layer name

Any cel (layer) name can be added and specified to the Timeline. The entered cel name is specified in the [Timeline] palette, but the cel 

will not be created in the [Layer] palette. To create the cel in the [Layer] palette, select the [Animation] menu > [Edit Track] > [Create all 

supported cels].

 If specifying a cel that hasn’t been created yet, enter the cel (layer) name in [Enter layer name] and click [OK]. 

In this case, the cel name will be specified in the [Timeline] palette, but the cel will not be created in the [Layer] 

palette. Please create a cel with the same name in the [Layer] palette.

 If a cel that has not yet been created is specified, the background of the area specified by that cel will be trans-

parent in the clip in the [Timeline] palette. Color appears in the background of the area specified by that cel 

when the cel is created.

 If selecting a frame that already has a specified cel, the previous cel will be replaced with the newly specified 

cel.
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Batch specify cels
This opens the [Batch specify cels] dialog box. Here you can batch specify cels to the Timeline palette from the selected frame onward.

To use this command, you need to be selecting an animation folder on the [Layer] palette or [Timeline] palette.

1 select the frame for which to specify a cel on the Timeline.

(1) Click the frame for which to specify a cel.

(2) Click the track (animation folder) for which to specify a cel.

2 Select the [Animation] menu > [Edit track] > [Batch specify cels].

3 Configure the settings in the [Batch specify cels] dialog box and click [OK].
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4 The specified cels will be shown on the [Timeline] Palette.

[Batch specify cels] dialog box

A.  How to specify
Select how to specify the cels. The setting methods for [Specify cel] change when a specification method is selected.

(1) Specify value

Specify cels by entering a numerical value in the input field.

(2) Specify name of existing animation cel

[Specify cel] changes to a pull-down menu when this is selected. In the pull-down menu, you can select the names of cels in the animation 

folder being edited.

B. Specify cel (when "Specify value" is selected)
(3) Start number

Enter the number of the start cel.

(4) End number

Enter the number of the end cel.

(5) Number of frames

Enter the interval for which to specify cels. Cels are created in intervals of the specified number of frames.

If [Batch specify cels] is used for frames that already have specified cels, the previous cels will be replaced with 

the cels specified in [Batch specify cels]. Specified cels of other frames will remain as they are.

A A

B C

D D

E E
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C. Specify cel (when "Specify name of existing animation cel" is selected)
Allows you to select cels from the animation folder being edited.

(6) Start cel

Select the name of the start cel.

(7) End cel

Select the name of the end cel.

(8) Number of frames

Enter the interval for which to specify cels. Cels are created in intervals of the specified number of frames.

D. Repeat settings
Specify the number of times to repeat specifying cels.

(9) Number of repeats

Specify the number of times to repeat specifying cels.

(10)Repeat to end

Continues specifying cels until the end of the timeline.

E. Advanced settings
(11) Create gap of n frames for each cel specification

Leaves a gap of frames between specified cels. Clips are not created in this area. When this is turned on, you can specify the [Number of 

frames].

For example, specifying "1" for [Number of frames] leaves one blank frame between cels.

(12)Skip cel number for cel specification

Specify a number of numbered cels to be skipped when specifying cels. When this is turned on, you can specify the [Number of cels].

For example, when "1" is entered as the number of cels to skip when cels are numbered 1 to 5, this setting will specify cels 1, 3 and 5, skip-

ping one cel each time.

Create all supported cels
Cels that are specified in the [Timeline] palette but have not been created in the [Layer] palette can be created together by specifying this item. 

The cels are created in all animation folders included in the timeline.
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Rename in timeline order
Renumbers the names of the cels in the selected animation folder to match the order displayed on the [Timeline] palette. The changed cel 

names are applied to both the [Timeline] palette and the [Layer] palette. The order of the cels on the [Layer] palette is also changed according 

to the cel names.

Rename in layer order
Renumbers the names of the cels in the selected animation folder according to their order in the [Layer] palette. The changed cel names are 

applied to both the [Timeline] palette and the [Layer] palette.

 Cel names consisting of text other than numbers will be changed to numbers.

 If any of the cels in the animation folder are not specified in the [Timeline] palette, numbers after those of the 

specified cels will be assigned as the cel names for the unspecified cels. The order of the cels on the [Layer] 

palette is also changed according to the numbers.

 If the same animation folder is used for multiple timelines, the timeline currently displayed in the [Timeline] 

palette is prioritized. The other timelines are ordered according to the [Timeline list]. You can adjust the order 

of the [Timeline list] under the [Animation] menu > [Timeline] > [Manage timeline].
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Select previous cel
The operation for this item differs depending on the canvas settings or the cel or layer that is selected.

 If the timeline is enabled, this selects the cel before the frame currently selected in the [Timeline] palette.

 If the timeline is disabled, this selects the cel below the cel currently selected in the [Layer] palette. If the lowest cel in the animation folder 

is selected, the top layer in the same folder is selected.

 If a light table layer is selected in the [Animation cels], the display will switch between the light table layers in the order they are displayed 

on the [Layer] palette. Clicking this displays the layer below. It also changes the light table layers linked to the edited cel.

Select next cel
The operation for this item differs depending on the canvas settings or the cel or layer that is selected.

 If the timeline is enabled, this selects the cel after the frame currently selected in the [Timeline] palette.

 If the timeline is disabled, this selects the cel above the cel currently selected in the [Layer] palette. If the top cel in the animation folder is 

selected, the lowest layer in the same folder is selected.

 If a light table layer is selected in the [Animation cels], the display will switch between the light table layers in the order they are displayed 

on the [Layer] palette. Clicking this displays the layer above. It also changes the light table layers linked to the edited cel.

Combine clips
Joins together multiple consecutive clips in the same track selected on the [Timeline] palette.

Divide clip
Splits the clip at the frame selected on the [Timeline] palette.

Set as first displayed frame
You can set the start position of a clip according to the frames on the [Timeline] palette.

On the [Timeline] palette, select the target track and then select the frame to be set as the start position of the clip.

Select the [Animation] menu > [Edit track] > [Set as first displayed frame] to set the selected frame as the start position of the clip.

 Cel names consisting of text other than numbers will be changed to numbers.

 If cels that have not been created in the [Layer] palette are specified in the [Timeline] palette, numbers after 

those of the cels on the [Layer] palette will be assigned to the other cels specified in the [Timeline] palette.

 Multiple clips can be selected by holding down Ctrl while selecting clips.

 Clips in different tracks (animation folders) cannot be joined.

 For details on the names of each part of the [Timeline] palette, see "Functions of Timeline Palette".

 If a frame in the clip is selected when using [Set as first displayed frame], the clip containing the frame will be 

shortened and the selected frame will become the start of the clip.

 If a cel before the selected frame is specified, the specified cel moves to the selected frame.
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Set as last displayed frame
You can set the end position of a clip according to the frames on the Timeline.

On the Timeline, select the target track and then select the frame to be set as the end position of the clip.

Select the [Animation] menu > [Edit track] > [Set as last displayed frame] to set the selected frame as the end position of the clip.

Graph Editor
Switches to the Graph Editor view in the [Timeline] palette.

Graph Editor
When selected, the [Timeline] palette switches to the Graph Editor. Clips with a frame among the tracks selected in the Timeline palette can be 

edited using the Graph Editor. Select this icon again to return to the original [Timeline] palette.

Snap to X-axis
When active, the movement of a keyframe along the X-axis is restricted to certain units.

Snap to Y-axis
When active, the movement of a keyframe along the Y-axis is restricted to certain units.

Unpair handles
When active, the left and right control handles can be operated separately while adjusting the slope.

Play/Stop
Plays or stops animation on the canvas.

 For details on the names of each part of the [Timeline] palette, see "Functions of Timeline Palette".

 If a cel after the selected frame is specified, the section of the clip from the specified frame to the next cel is 

deleted.

 If a frame without a clip is selected when using [Set as last displayed frame], the previous clip is extended and 

the selected frame becomes the end of the clip.

 If a frame with a specified cel is selected when using [Set as last displayed frame], the cel will be deleted.

 For details on the Graph Editor, see "Graph Editor".

 If [Enable keyframes on this layer] is turned off for the selected layer, you cannot switch to the Graph Editor.

For details on [Split curve before/after keyframe], see "Adjusting either side of the animation curve separately.".

 Animation playback can also be stopped by pressing Esc or clicking a palette other than the [Timeline] palette 

during playback.

 When an animation is played, played frames will be cached. This allows the animation to buffer more quickly 

the next time it is played. However, the previous playback cache is discarded when the canvas or [Timeline] 

palette is edited.
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Playback settings
Edit playback settings for animation.

Play in real time
Plays the animation according to the frame rate.

Play all frames
This plays all frames when playing the animation.

Loop play
This button enables loop play. When playing animation, playback will return to the first frame after reaching the last frame.

Render 2D camera
When active, the camera movement set in the 2D camera folder track is applied when the animation is played.

Render before starting playback
Turn this on to render the playback range of the animation before playing the animation.

This avoids issues where playback is delayed due to the time taken to load the animation. However, rendering before playing the animation 

means that there may be a delay before playback starts.

Prefer speed
If the canvas has a high resolution, the resolution will automatically be reduced when playing the animation to improve the playback speed.

A cache is created with images at a size near the scale of the canvas when playing the animation. When the scale is changed during playback, 

the cache is discarded according to the scale.

Prefer quality
When the canvas has a high resolution, the resolution is automatically reduced when playing the animation to improve the playback speed.

A cache is created with images at a size near the scale of the canvas when playing the animation. The cache is not discarded when the scale is 

changed during playback.

When an animation is played with [Play in real time] turned on, it plays according to the set time. However, drop-

frame (where not all of the cels can be played) may occur.

 When playing with [Play all frames] active, all frames are played instead of eliminating the restriction to play 

within the set time. This means that the animation may play more slowly than the actual playback speed.

 When playing with [Play all frames] active, audio files in the audio track will not be played. To play audio files, 

turn on [Play in real time].
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Move frame
Operate the frames in the [Timeline] palette using commands.

Go to start
Selects the first frame on the Timeline.

Go to end
Selects the last frame on the Timeline.

Go to previous frame
Selects the frame before the selected frame on the Timeline.

Go to next frame
Selects the frame after the selected frame on the Timeline.

Previous keyframe
Selects the keyframe before the currently selected frame on the [Timeline].

Next keyframe
Selects the keyframe after the currently selected frame on the [Timeline].

Go to specified frame
Selects the frame corresponding to the specified number in the [Timeline] palette.

Selecting this command shows the [Go to specified frame] dialog box. Enter the frame to be selected in [Frame number] and click [OK]. The 

specified frame will be selected in the [Timeline] palette.

This operation only switches between keyframes on the current track. Other tracks are not referenced.

This operation only switches between keyframes on the current track. Other tracks are not referenced.

In PRO and EX, the [Frame number] is entered differently depending on the frame display method selected in 

[Playback time] in the [New] dialog box or the [New timeline] dialog box. 
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Go to timeline label
Specify the name of a timeline label and go to the frame containing that timeline label.

1 Select the [Animation] menu > [Move frame] > [Go to timeline label]. Opens the [Go to time-
line label] dialog box.

2 In the [Go to timeline label] dialog box, select the name of the timeline label and click [OK].

3 The frame containing the specified timeline label becomes the current frame.

If a file contains multiple timelines (cuts), you can select timeline labels created in a different cut. When this is 

selected, the [Timeline] palette switches to the cut containing the corresponding timeline label.
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Label
Set labels on the [Timeline] palette. Created labels can be used as markers when editing.

Create timeline label
Creates a timeline label in the specified frame on the Timeline.

1 Select the frame to add a timeline label to on the Timeline.

2 Select the [Animation] menu > [Label] > [Create timeline label]. Opens the [Create timeline
label] dialog box.

3 In the [Create timeline label] dialog box, enter the name of the label and click [OK].
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4 A timeline label will be added to the specified frame on the Timeline.

Delete timeline label
Deletes a timeline label from the Timeline.

1 Select the frame containing the timeline label to be deleted on the Timeline.

2 Select the [Animation] menu > [Label] > [Delete timeline label]. The timeline label in the
specified frame will be deleted.

Timeline labels with the same name cannot be created in the same file.
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Create track label
Creates a track label in a frame in the specified track on the Timeline.

1 Select the track to add a track label to on the Timeline.

(1) Select the frame to which to add the track label.

(2) Select the track to which to add the track label.

2 Select the [Animation] menu > [Label] > [Create track label]. Opens the [Create track label]
dialog box.

3 In the [Create track label] dialog box, enter the label name and the range to apply the
labels, then click [OK].

(1) Enter instructions, etc. for the [Label name].

(2) For [Range], enter the range for the label. For example, enter “10” to specify the 10 frames from the selected frame.

(3) Click [OK].

4 A track label will be created in the specified track on the Timeline. Click the [+] of the
track name to display the track label area for displaying the track label.

 In the [Track label] area of the [Timeline] palette, you can edit the text of track labels and change the position 

of the frame. For details, see "Label operations".

 For track labels on the 2D camera folder tracks, you can select from a list of camera instructions for your ani-

mation. You can output camera instructions to a Toei Animation Digital Exposure Sheet. For details on adding 

camera instructions, see "Track labels of 2D camera folder tracks". For details on exporting a Toei Animation 

Digital Exposure Sheet, see "Apply Toei Animation Digital Exposure Sheet information to current exposure 

sheet [EX] [Windows/iPad]".
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Delete track label
Deletes a track label from the [Timeline] palette. You can delete standard track labels, inbetween track labels, and reverse sheet track labels.

1 Select the frame in the track containing the track label to be deleted on the [Timeline] pal-
ette.

(1) Select the frame from which to delete the track label.

(2) Select the track from which to delete the track label.

2 Select the [Animation] menu > [Label] > [Delete track label]. The track label for the speci-
fied frame will be deleted.

Create inbetween track label
Adds a track label specifying an inbetween point in a frame in the specified track on the [Timeline] palette.

Select the frame and track in which to specify the track label, then select the [Animation] menu > [Label] > [Create inbetween track label] to 

create a track label specifying an inbetween point.

Create reverse sheet track label
Adds a track label specifying a reverse sheet inbetween point in a frame in the specified track on the [Timeline] palette.

Select the frame and track in which to specify the track label and select the [Animation] menu > [Label] > [Create reverse sheet track label] to 

create a track label specifying an inbetween point.

For labels created across multiple frames, select one of the frames in the range.

 In the [Timesheet] palette, right-click with your mouse and drag the track to show the popup menu for specify-

ing a cel. Press Alt + Enter to create an inbetween track label.

 Inbetween track labels are indicated by the inbetween symbol "○" when the [Timeline] palette is exported as a 

timesheet in CSV format. To learn how to export a timesheet in CSV format, refer to "Exposure sheet [EX]".

 In the [Timesheet] palette, right-click with your mouse and drag the track to show the popup menu for specify-

ing a cel. Press Enter while holding Shift + Alt to create an inbetween track label.

 When the [Timeline] palette is exported as a timesheet in CSV format, reverse sheet track labels are indicated 

by “●”, the reverse sheet symbol.  To learn how to export a timesheet in CSV format, see "Exposure sheet 

[EX]".
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Timeline
You can create and manage multiple animation timelines on a single canvas in Clip Studio Paint.

The [Timeline] menu item includes commands for managing timelines, such as creating or switching timelines.

Enable timeline
Enables or disables the timeline for the canvas.

When the timeline is enabled, you can edit the [Timeline] palette. The canvas only displays cels and layers specified for selected frames on the 

[Timeline] palette.

When the timeline is disabled, the [Timeline] palette cannot be edited, but all cels in the animation folder are displayed on the canvas. Cels can 

be edited regardless of whether they are specified on the Timeline.

New timeline
Select this item to open the [New timeline] dialog box. This can be used to create a new timeline on the canvas.

If the canvas does not have a timeline, you can add a timeline to create an animation.

[New timeline] Dialog Box

(1) Timeline name

Enter a name for the timeline.

(2) Frame rate

Enter a frame rate for the timeline.

 When the timeline is enabled, cels in the animation folder that are not specified to the Timeline palette cannot 

be displayed or edited on the canvas. Specify these cels for frames on the Timeline or disable the timeline to 

display these cels on the canvas and enable editing.

 If the timeline is disabled, the settings for the keyframes set for layers and tracks respectively is also disabled. 

If the timeline is enabled again, the keyframes will be shown in the state when the timeline was disabled.

The frame rate (fps) is the number of images that can be displayed in one second to run the animation. For exam-

ple, if a frame rate of 30 is set, up to 30 images (cels) can be shown each second.
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(3) Playback time

Enter the playback time. The content that can be edited differs depending on the settings configured in the [New] dialog.

When making the first timeline, use the pull-down menu to select how to display frames on the [Timeline] palette. The box for inputting 

the playback time will change depending on the selected option.

(4) Scene number

Enter the scene number.

(5) Cut number

Enter the cut number.

(6) Division line

Set up the lines that divide the Timeline. Division lines will be shown at the specified frame interval (for example, after every five frames).

(7) Image interpolation

You can select the method for interpolating the colors of pixels when transforming a cel or image material using keyframes.

Go to previous timeline
Switches to the previous timeline if there are multiple timelines.

Frame number (starting 

from 1), Frame number 

(starting from 0)

Set the number of frames for the entire timeline. For example, if the frame rate is 30 fps and you 

would like to make a 4-second animation, enter "120" (30 frames x 4 seconds). The difference 

between [Frame number (starting from 1)] and [Frame number starting from 0)] is the start num-

ber of the frames.

Seconds + frame
Set the playback time in seconds. To add frames after the specified number of seconds, enter the 

number of frames to be added.

Time code
Set the playback time in minutes and seconds. To add frames after the set number of seconds, set 

the number of frames to be added.

Smooth edges (bilinear)
This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). However, outlines may become blurred depending on the image.

Hard edges (nearest neigh-

bor)

When interpolating the image, the pixels in the image are duplicated. Since the colors are not 

affected by neighboring pixels, outlines (boundaries between colors) remain sharp. However, 

outlines may become jagged depending on the image.

Clear edges (bicubic)

This method blends the colors of neighboring pixels to create smooth outlines (boundaries 

between colors). This method results in stronger outlines compared to the [Smooth outline (bilin-

ear method)] setting. However, white noise may appear around outlines depending on the image.

High accuracy (average col-

ors)

The average colors of the original pixels are strictly calculated and contained for each pixel after 

the transformation. Scaling up makes the lines sharper and scaling down makes the lines 

smoother. Even detailed lines can be preserved when scaling the image down. However, this 

method can result in blurred outlines and can take a long time to process depending on the image.

The display order of the timelines can be changed in the [Animation] menu > [Timeline] > [Manage timeline] dialog 

box. For details on the [Manage timeline] dialog box, see "Manage timeline".
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Go to next timeline
Switches to the next timeline if there are multiple timelines.

Change settings
Change settings for the current timeline.

In the dialog box that appears, edit the settings and click [OK] to change the timeline settings.

[Change settings] Dialog Box

(1) Timeline name

Enter a name for the timeline.

(2) Start frame

Input the start frame.

(3) End frame

Input the end frame.

(4) Division line

Set up the lines that divide the Timeline. Division lines will be shown at the specified frame interval (for example, after every five frames).

(5) Scene number

Enter the scene number.

(6) Cut number

Enter the cut number.

The display order of the timelines can be changed in the [Animation] menu > [Timeline] > [Manage timeline] dialog 

box. For details on the [Manage timeline] dialog box, see "Manage timeline".

The values that can be entered for [Start frame] and [End frame] differ depending on the [Playback time] set in the 

[New] dialog box or the [New timeline] dialog box. For details, see "[New timeline] Dialog Box".
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Change frame rate
Select this item to open the [Change frame rate] dialog box.

This allows you to change the frame rate (number of frames per second) set when creating the canvas.

[Change frame rate] Dialog Box

(1) Frame rate

Change the frame rate.

(2) Change total number of frames [EX]

When this is turned on, the number of frames on the timeline will change to fit the playback time that was originally specified. The posi-

tion of specified cels also changes.

Manage timeline
Manage timelines in the file.

In the [Manage timeline] dialog box, you can add, delete or duplicate timelines.

[Manage timeline] Dialog Box

(1) Timeline list

A list of timelines in the file. Select a timeline to change the settings.

(2) New timeline

Clicking the item shows the [New timeline] dialog box. This can be used to create a new timeline on the canvas.

If the canvas does not have a timeline, you can add a timeline to create an animation.

The playback time of movie tracks, audio tracks, or dialog tracks cannot be changed according to the frame rates. 

This means that the clip position and length may not match those of the other tracks.

For details on the [New timeline] dialog box, see "New timeline".
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(3) Duplicate

Duplicates the timeline selected in the timeline list.

This opens the [Duplicate timeline] dialog box, where you can enter the timeline name, scene number, and cut number.

[Duplicate timeline] Dialog Box

(4) Delete

Deletes the timeline selected in the timeline list.

(5) Change settings

Changes the settings of the timeline selected in the [Timeline list]. Clicking the menu item shows the [Change settings] dialog box.

(6) Move up

Moves the timeline selected in the [Timeline list] one place up.

(7) Move down

Moves the timeline selected in the [Timeline list] one place down.

Insert frame
You can also insert frames using the [Timeline] palette.

1 Select the frame in the [Timeline] palette.

2 Select [Insert frame] from the [Animation] menu > [Timeline].

For details on the [Change settings] dialog box, see "Change settings".
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3 Adjust the settings in the [Insert frame] dialog box and click [OK].

Inserts the number of frames set in the [Insert frame] dialog box from the selected frame.

 Inserting a frame causes the frame’s clip and Area Label to become longer. However, movie and audio tracks will not go any longer 

than the original movie or audio file length.

 Clips, specified cels, labels, and keyframes after the selected frame, will move behind the inserted frame segment. The end position 

of the timeline will also move backward.

Insert frame

(1) Number of frames

Enter the number of frames to insert.

(2) Show selected layer only

Inserts a frame only on the selected track (layer). Frames will not be inserted into other tracks. The timeline’s end position will not change.

(3) Split clip

Inserts the selected frame into a new frame and splits the clip into before and after sections. Clips will not be placed on inserted frames.

(4) Preview

Shows a preview of the [Insert frame] dialog box’s settings on the [Timeline] palette and the canvas.

 If you are using DEBUT or PRO, you can use up to 24 frames. If exceeded, frames cannot be inserted.

 However, if [Split clip] in the [Insert frame] dialog box is turned on, the keyframe will be hidden outside of the 

clip. For details, see "Insert frame".
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Delete frame
Deletes the selected frame from the [Timeline] palette.

1 Select the frame in the [Timeline] palette.

2 Select [Delete frame] from the [Animation] menu > [Timeline].

3 Configure the settings in the [Delete frame] dialog box and click [OK].

Deletes the number of frames set in the [Delete frame] dialog box from the selected frame.

 Deleting a frame causes the frame’s clip and Area Label to become shorter.

 A clip inside a deleted frame is also deleted.

 A specified cel inside a deleted frame is combined into one.

 A keyframe inside a deleted frame is combined into one. However, if [Split clip] in the [Delete frame] dialog box is turned on, the 

keyframe will be hidden outside of the clip.

 Clips, specified cels, labels, and keyframes after the selected frame, will move forward ahead of the deleted frame segment. The end 

position of the timeline will also move forward.

If [Show selected layer only] and [Split clip] in the [Delete frame] dialog box is turned on, the ressult changes.

For details, see "[Delete frame] dialog box".
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[Delete frame] dialog box

(1) Number of frames

Sets the number of frames you want to delete.

(2) Show selected layer only

Deletes frame from the selected track (layer) only. This frame will not be deleted from other tracks. The end position of the timeline will 

not change.

(3) Split clip

Deleting a frame separates the clip into two clips.

(4) Preview

Shows a preview of the [Delete frame] dialog box′s settings on the [Timeline] palette and the canvas.

Apply Toei Animation Digital Exposure Sheet information to current exposure sheet [EX] 
[Windows/iPad]
You can open the Toei Animation Digital Exposure Sheet and use the vertical exposure sheet to edit the contents of the [Timeline] palette.

To display a Toei Animation Digital Exposure Sheet select [Animation] menu > [Timeline] > [Apply Toei Animation Digital Exposure Sheet 

information to current exposure sheet]. At the same time, you will be able to edit the exposure sheet with the contents of the [Timeline] palette 

applied to it.

In the Toei Animation Digital Exposure Sheet, you can edit the total number of frames, the timing of cels being displayed, and the camera 

instructions.

 To use [Apply Toei Animation Digital Exposure Sheet information to current exposure sheet], the Toei Anima-

tion Digital Exposure Sheet must be installed on the same device. Please install the Toei Animation Digital 

Exposure Sheet before using this command.

 When using Windows, the installation location for the Toei Animation Digital Exposure Sheet is changed, the 

[Toei Animation Digital Exposure Sheet settings] dialog will open when the command is run. Click [Browse] 

and set the installation folder for the Toei Animation Digital Exposure Sheet.

 If you are using an iPad, you may get the message "Set path directory." Adjust these settings by following the 

on-screen instructions. For details, see "Toei Animation Digital Exposure Sheet Path [EX][iPad]".
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Load changes to Toei Animation Digital Exposure Sheet [EX] [Windows] 
Load the changes made to the Toei Animation Digital Exposure Sheet to Clip Studio Paint.

Select [Animation] menu > [Timeline] > [Load changes to Toei Animation Digital Exposure Sheet] to apply the settings to the Toei Animation 

Digital Exposure Sheet in Clip Studio Paint’s [Timeline] palette.

 If a canvas that is already connected to a Toei Animation Digital Exposure Sheet is open, the settings will be applied to that canvas. The 

same is true when you have multiple canvases open at the same time.

 If there is no canvas linked to a Toei Animation Digital Exposure Sheet, the setting will be applied to the current canvas.

If there is an animation folder in the Timeline palette of Clip Studio Paint that is not in the Toei Animation Digital Exposure Sheet, the [Import 

Toei Digital Exposure Sheet] dialog will appear.

You can set up the method of processing animation folders in Clip Studio Paint when loading the file.

Toei Animation Digital Exposure Sheet settings [EX] [Windows]
It is possible to link Toei Animation Digital Exposure Sheet settings with Clip Studio Paint.

Select [Animation] menu > [Timeline] > [Toei Animation Digital Exposure Sheet settings] to display the [Toei Animation Digital Exposure 

Sheet settings] dialog. Click [Browse] to specify the installation location for the Toei Animation Digital Exposure Sheet.

Toei Animation Digital Exposure Sheet Path [EX][iPad] 
It is possible to link Toei Animation Digital Exposure Sheet settings with Clip Studio Paint.

Selecting [Animation] menu > [Timeline] > [Toei Animation Digital Exposure Sheet path], displays a message. Confirm its content, and click 

OK.

When the File App appears, tap [This iPad] > [ToeiAnimationDigitalTimeSheet] > [Xdts] and then, tap [Done].

 If an animation folder on the [Timeline] palette is locked, the exposure sheet information will not be updated.

 If you are using an iPad, you may get the message "Set path directory." Adjust these settings by following the 

on-screen instructions. For details, see "Toei Animation Digital Exposure Sheet Path [EX][iPad]".
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Show animation cels
Set animation cel display settings.

Show edited cel only
Turn this on to show only the cel selected for editing from the animation folder.

Enable onion skin
Onion skin is a function in which specified cels surrounding the selected cel are displayed on the canvas in addition to the selected cel.

Turn this on to display the onion skin on the canvas.

The onion skin shown depends on the timeline settings.

This item cannot be set when [Enable onion skin] is turned on.

When the timeline is enabled The cels before and after the selected cel on the Timeline palette are displayed as onion skin.

When the timeline is dis-

abled
The cels above and below the selected cel on the [Layer] palette are displayed as onion skin.

 Onion skin settings such as the display color and number of displayed cels can be set in the [Animation] 

menu > [Show animation cels] > [Onion skin settings]. For details, see "Onion skin settings".

 To modify a cel with the onion skin as a reference, select the [Animation] menu > [Light table] > [Register 

onion skin images]. Onion skin cels corresponding to that cel are registered in the [Light table specific to cel] 

on the [Animation cels] palette.

 The onion skin display color will not apply to cels that have their layer folder’s blending mode set to 

[Through].

The surrounding cells are displays in a 

different color in onion skin form.
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Onion skin settings
Select this item to open the [Onion skin settings] dialog. This allows you to configure onion skin settings such as the number of displayed cels 

and the display color.

[Onion skin settings] Dialog Box

(1) Number of views

Set the number of cels to be displayed as onion skin. The number of preceding cels can be different from the number of following cels.

(2) Color mode

You can set the color mode for onion skins.

(3) Display color

The display colors of the onion skins can be changed by setting the color mode to [Half color] or [Monochrome]. The display color of the 

previous frame is shown in [Display color of previous frame], and that of the next frame is shown in [Display color of next frame]. Click-

ing each color indicator shows the [Color settings] dialog box. Here, a color can be set.

(4) Set Opacity

Turning this on sets the opacity of the onion skins.

Color The cels displayed as onion skins are shown in the original colors.

Half color
The colors set for [Display color of previous frame] and [Display color of next frame] are com-

bined while maintaining the colors of the cels displayed as onion skins.

Monochrome
The colors of the cels displayed as onion skins will be changed to grayscale and shown in the col-

ors set as [Display color of previous frame] and [Display color of next frame].

Color Half color Monochrome
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(5) Opacity

The opacity of the onion skins can be set in [Start]. If multiple skins are set for [Number of skins], specify a value for [Step opacity] to 

show the skins with the opacity reduced by the specified value for each skin.

Check cel motion by key input
Allows you to check cel movement with key operations. When the [Check cel motion by key input] dialog appears, you can switch between 

cels using the numeric keys or cursor keys. Click [Close] in the dialog box to end switching between cels by key operation.

The cel view is switched in the order of the layers in the animation folder on the [Layer] palette.

The cel display method differs depending on the key.

Numerical keys
Press 1 to show the bottom cel in the selected animation folder. Show other cels by pressing the 2 and 3 key. The keys correspond to cel order.

Function keys
Press F1 to show the bottom cel in the selected animation folder. The other cels can be shown by pressing keys such as F2 and F3. The keys 

correspond to cel order.

Cursor keys
Press the cursor keys to move through the cels in the selected animation folder.

Edge keyboard [Tablet/Smartphone]
Press T1 to show the bottom cel in the selected animation folder. The other cels can be shown by pressing keys such as T2 and T3. The keys 

correspond to cel order. For how to use the edge keyboard, see "Using the edge keyboard"

 If the light table is disabled, this item cannot be selected. However, if an animation folder containing multiple 

cels is selected, it can be selected.

 If multiple cels are selected on the [Layer] palette, the key operations are applied only to the selected cels.

 If the light table is enabled and multiple light table layers are registered to the [Animation cels] palette, the key 

operations are applied to the light table layers on the [Animation cels] palette. For details on how to enable the 

light table layer, see "Enable light table". For details on the [Animation cels] palette and light table layers, see 

"Functions of Animation Cels Palette".

 Key operations may differ if shortcut keys are used. Follow the instructions in the message shown.

 When using a Tablet/Smartphone, key operation can be performed by connecting a keyboard to the Tablet/

Smartphone. This can also be performed with the edge keyboard.

The ↑ key Shows the cels in order from bottom to top. Releasing the key shows the selected cel on the [Layer] palette.

The ↓ key Shows the cels in order from top to bottom. Releasing the key shows the selected cel on the [Layer] palette.

The → key
Shows the cels in order from bottom to top. Releasing the key shows the cel that was indicated at the time the key 

was released.

The ← key
Shows the cels in order from top to bottom. Releasing the key shows the cel that was indicated at the time the key 

was released.
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[Check cel motion by key input] Dialog Box

(1) When command is finished, go to the last shown layer

When active, even after clicking [Close] for the [Check cel motion by key input] dialog box, the selected cel still shows.

(2) Only check visible layers

When active, this only shows cels that can be switched. Even when operating keys, cels set to be hidden are not shown.

(3) Prioritize display speed over quality

When active, this improves the speed at which cels are switched during key operation. However, the display quality of the image on the 

canvas will be lower.

(4) Revert to original view

Click to return to the cel (the currently selected cel) that was shownfirst.
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Check surrounding cels by key input
Allows you to check cel motion with key operations. When the [Check cel motion by key input] dialog appears, you can switch between cels 

using the numeric keys or cursor keys. Click [Close] in the dialog box to end switching between cels by key operation.

The cel view is switched in the order of the layers in the animation folder on the [Layer] palette.

The cel display method differs depending on the key.

Numerical keys
Pressing the numerical keys allows you to see 4 cels on either side of the selected cel on the [Layer] Palette.

Function keys
Pressing action keys allows you to see 4 cels on either side of the selected cel on the [Layer] Palette.

Cursor keys
Press the cursor keys to move through the cels in the selected animation folder.

 If light table is disabled, this command cannot be selected. However, if an animation folder containing multiple 

cels is selected, it can be selected.

 If multiple cels are selected on the [Layer] palette, the key operations are applied only to the selected cels.

 If the light table is enabled and multiple light table layers are registered to the [Animation cels] palette, the key 

operations are applied to the light table layers on the [Animation cels] palette. For details on how to enable the 

light table layer, see "Enable timeline". For details on the [Animation cels] palette and light table layers, see 

"Functions of Animation Cels Palette".

 Key operations may differ if shortcut keys are used. Follow the instructions in the message shown.

 When using a Tablet/Smartphone, key operation can be performed by connecting a keyboard to the Tablet/

Smartphone. You can also use key operations with the edge keyboard.

The 5 key Shows the cel selected on the [Layer] palette.

The 4 key to the 1 key Shows the cels below the selected cel on the [Layer] palette.

The 6 key to the 9 key Shows the cels above the selected cel on the [Layer] palette.

F5 Shows the cel selected on the [Layer] palette.

The F4 key to the F1 key Shows the cels below the cel selected on the [Layer] palette.

The F6 key to the F9 key Shows the cels above the cel selected on the [Layer] palette.

The ↑ key Shows the cels in order from bottom to top. Releasing the key shows the selected cel on the [Layer] palette.

The ↓ key Shows the cels in order from top to bottom. Releasing the key shows the selected cel on the [Layer] palette.

The → key
Shows the cels in order from bottom to top. Releasing the key shows the cel that was indicated at the time the key 

was released.

The ← key
Shows the cels in order from top to bottom. Releasing the key shows the cel that was indicated at the time the key 

was released.
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Edge keyboard [Tablet/Smartphone]
Pressing the edge keyboard allows you to see 4 cels on either side of the selected cel on the [Layer] Palette. Please refer to "Using the edge key-

board" for information on the edge keyboard.

[Check surrounding cels by key input] Dialog Box

(1) When command is finished, go to the last shown layer

When active, even after clicking [Close] for the [Check surrounding cels by key input] dialog box, the selected cel still shows.

(2) Only check visible layers

When active, this only shows cels that can be switched. Even when operating keys, cels set to be hidden are not shown.

(3) Prioritize display speed over quality

When active, this improves the speed at which cels are switched during key operation. However, the display quality of the image on the 

canvas will be lower.

(4) Revert to original view

Click to return to the cel (the currently selected cel) that was shown first.

The T5 key Shows the cel selected on the [Layer] palette.

The T4 key to the T1 key Shows the cels below the cel selected on the [Layer] palette.

The T6 key to the T15 key Shows the cels above the cel selected on the [Layer] palette.
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Light table
Allows you to configure the settings of the [Animation cels] palette and light table layers registered to the [Animation cels] palette.

Enable light table
Turn this on to display the light table layers on the canvas. Turn it off to hide the light table layers.

Fixes the current animation cel as the editing target
Fixes a registered cel as an [Edited cel]. When this is set, the [Edited cel] does not change when another cel is selected on the [Layer] palette or 

[Timeline] palette.

Register selected layer
Register a layer selected on the [Layer] palette as a light table layer on the [Animation cels] palette.

 If an [Edited cel] is set on the [Animation cels] palette and [Fix current cel as editing target] is turned on, the image is registered to the 

[Light table specific to cel].

 If an [Edited cel] is not set on the [Animation cels] palette, the image is registered to the [Common light table for canvas].

For details on the [Animation cels] palette and light table layers, see "About the Animation Cels Palette" and 

"Functions of Animation Cels Palette".

If [Enable light table] is turned off, selecting a light table layer on the [Animation cels] palette automatically turns it 

on.

If the layer contains a layer folder or layer mask, the layer is registered to the [Animation cels] palette with the 

folder or mask merged.

The light table layer registered in the 

[Animation cels] palette is displayed.
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Select and register file
Registers other image files to the light table on the [Animation cels] palette. You can register the following file formats: Clip Studio Format 

(extension: clip), BMP, JPEG, PNG, TIFF, Targa, Adobe Photoshop Document (extension: psd) and Adobe Photoshop Big Document (exten-

sion: psb).

Select this command to open a dialog box for selecting the exposure sheet file. Select a file to register the image to the [Animation cels] palette.

 If an [Edited cel] is set on the [Animation cels] palette, the image is registered to the [Light table specific to cel].

 If an [Edited cel] is not set on the [Animation cels] palette, the image is registered to the [Common light table for canvas].

Registers a layer copied from another canvas
Pastes a layer copied from another canvas to the light table on the [Animation cels] palette.

If the selected layer is a light table layer from a [Light table specific to cel], it is registered to the [Light table specific to cel]. Otherwise, it is 

registered to the [Common light table for canvas].

Register onion skin images
If onion skin is enabled, the surrounding cels displayed as onion skin are registered to the [Light table specific to cel] on the [Animation cels] 

palette. The onion skin layer color of the registered cels (light table layers) is kept, but the opacity is not.

Cels registered to the light table cannot be displayed as onion skin.

Deregister selected image from light table
Deregisters the selected light table layer from the [Animation cels] palette.

Deregister all images from light table
Deregisters all light table layers currently shown on the [Animation cels] palette.

 If the file has multiple layers (CLIP STUDIO FORMAT (extension: clip), Adobe Photoshop Document (exten-

sion: psd) or Adobe Photoshop Big Document (extension: psb), the layers are merged in the version of the 

image that is registered to the [Animation cels] palette.

 When light table layers are registered from another file, the other file is referred to in the same way as with file 

object layers. The only information recorded for file object layers is the location where the loaded file is saved. 

This means that if the location of the registered file or the location of the canvas is changed, the file location 

needs to be re-specified by selecting the light table layer using the [Object] tool.

When light table layers are copied from another canvas, the other file is referred to in the same way as with file 

object layers. The only information recorded for file object layers is the location where the loaded file is saved. 

They therefore need to be deleted and re-registered if the save location of the original file or canvas changes.
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Move canvas to center
Selecting this item shows the [Move canvas to center] dialog. Drag the slider to adjust the position and angle of the canvas based on the light 

table layers shown on the canvas.

Show 2D camera frames
When active, this is set to the selected frame in the [Timeline] pallette and shows the camera movement from the 2D camera folder.

The top of the camera frame is shown with a thicker line.

 For details on how to use [Move canvas to center], see "Move canvas to center".

 [Move canvas to center] can be used when two light table layers are registered to the [Light table specific to 

cel] on the [Animation cels] palette, or when two light table layers are selected.

[Display color] and [Opacity] of the 2D camera folder can be set via [Camera path/Camera] in the [Preferences] dia-

log box. For details, please refer to "Camera path/Camera".

The canvas moves.
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Show camera path
When active, this shows the the field guides of the 2D camera folder or the currently selected layer. By default, the camera path of the 2D cam-

era folder is shown.

Show all field guides
When active, this shows all guides for layers and tracks with keyframes on the canvas. Turning it off shows only the layer and track guides.

The display of the camera path can be set via [Camera path/Camera] in the [Preferences] dialog box. For details, 

please refer to "Camera path/Camera".

 [Display color] and [Opacity] of the guides can be set via [Camera path/Camera] in the [Preferences] dialog 

box. For details, please refer to "Camera path/Camera".

 When [Show camera path] is active, only the camera path for the currently selected layer or track will be dis-

played.
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 Layer Menu
The [Layer] menu is for performing operations related to layers. This section describes the commands in the [Layer]
menu.

Explanation: What Is a Layer?
Layer are like pieces of transparent film stacked on top of each other. A completed image is a group of stacked layers viewed from the top.

In digital art, an artwork typically consists of different layers created for each process, which are then combined and edited.

In the example above, the canvas has the following layers from top to bottom: an effect layer, a line drawing layer, a coloring layer, a Back-

ground layer, and a Draft layer.

Since you can work on each layer individually, you can create a coloring layer separate from the line art layer, so you can paint without affect-

ing the line art.

The different types of layers and layering methods are an important aspect of digital art.

Effect

Line drawing

Coloring

Background

Draft
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New Raster Layer
Select [Layer] menu > [New Raster Layer]. A raster layer will be created above the selected layer on the [Layer] palette.

New Layer
Creates a new layer. You can create the following types of layers.

 "Raster Layer"

 "Vector Layer [PRO/EX]"

 "Gradient layer [PRO/EX]"

 "Fill [PRO/EX]"

 "Tone [PRO/EX]"

 "Frame Border Folder [PRO/EX]"

 "3D Layer [PRO/EX]"

 "Paper"

 "Clip Studio SHARE > Foil layer [EX]"

 If a cel is selected on the [Animation cels] palette, a cel (layer) will be created above the selected cel. The 

selection will switch to the newly created cel.

 If a light table layer on the [Light table specific to cel] or [Common light table for canvas] is selected, the layer 

is created at the top of the animation folder containing the selected cel.

 To learn how to change the layer name and expression color settings when making a raster layer, see "Raster 

Layer".
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Raster Layer
Creates a new raster layer (layer for drawing) above the selected layer.

1 Select the [Layer] menu > [New Layer] > [Raster layer].

2 In the dialog box that appears, set the name, expression color, and blending mode, then
click [OK].

3 The new raster layer will be added to the [Layer] palette.

[New raster layer] Dialog Box

(1) Name

Add a name for the layer.

(2) Expression color [PRO/EX]

Set the default expression color. You can choose from [Color], [Gray], or [Monochrome].

Expression color: Color

Expression color: Gray and Monochrome
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(3) Drawing color [PRO/EX]

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(4) Blending Mode

You can set a blending mode for the layer.

The expression color [Monotone] from Ver.1.2.1 and earlier will be converted into the following [expression color] 

and [drawing color].

 Expression color: Gray

 Drawing color: Only black

[Drawing color] only appears when the expression color is set to [Gray] or [Monochrome].

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing color will be black only.

Only white The drawing color will be white only.

Both black and white The drawing colors will be black and white only.

For more information on blending modes, see "Blending Modes on the Layer Palette".
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Vector Layer [PRO/EX]
Creates a new vector layer above the selected layer. A vector layer is a layer that allows you to edit lines that have already been drawn. You can 

change the brush tip or brush size, or change the shape of the lines using handles and control points.

You can use the following tools on vector layers.

1 Select the [Layer] menu > [New Layer] > [Vector layer].

2 In the dialog box that appears, set the name, expression color, and blending mode, then
click [OK].

3 The new vector layer is added to the [Layer] palette.

Tools for drawing on vector layers

[Pen]

[Pencil]

[Brush]

[Airbrush]

[Decoration]

[Eraser]

[Figure]

 The [Fill] tool cannot be used on vector layers.

 When drawn on a vector layer, lines may have a slightly different appearance than when drawn on a raster 

layer, depending on the selected [Sub Tool].

For information on how to edit vector layers, see "Explanation: Editing a Vector Layer [PRO/EX]".
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[New vector layer] Dialog Box

(1) Name

Enter the layer name.

(2) Expression color

Set the default expression color. You can choose from [Color], [Gray], or [Monochrome].

(3) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(4) Blending Mode

Set how to combine the colors with other layers.

The expression color [Monotone] from Ver.1.2.1 and earlier will be converted into the following [expression color] 

and [drawing color].

 Expression color: Gray

 Drawing color: Only black

[Drawing color] only appears when the expression color is set to [Gray] or [Monochrome].

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing color will be black only.

Only white The drawing color will be white only.

Both black and white The drawing colors will be black and white only.

Expression color: Color

Expression color: Gray and Monochrome
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Gradient layer [PRO/EX]
Gradient layers are used for creating and editing gradients.

1 Using a selection tool, create a selection.

2 Using a color palette, choose the colors for the start and end of the gradient.
 The start color will be the main drawing color.

 The end color will be the sub drawing color.

3 Select the [Layer] menu > [New layer] > [Gradient layer] to create a gradient layer and
layer mask.
A Gradient Layer and a Layer Mask will be created.
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A handle for editing the start and end points of the gradient will also appear. You can drag this handle to edit the gradient.

 You can change the gradient after you create it. For details, see "Changing the pattern and color of the gradi-

ent".

 If you create a selection area, the gradient will only appear within the selection area. You can later change the 

area that the gradient appears in. For details, see "Editing where the gradient layer is visible".

 Selecting [Edit] menu > [Transform] also lets you scale Gradient Layers. For details, see "Transform".
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Changing the pattern and color of the gradient
Select the [Operation] tool > [Object] sub tool palette and select the gradient layer in the [Layer] palette to display settings in the [Tool Prop-

erty] palette. Selecting [Gradient Layer] from the [Layer] Palette allows you to adjust its settings from the [Tool Property] Palette.

Change the settings in the [Tool Property] palette to edit the gradient. For details on settings in the [Tool Property] palette, please see the Gradi-

ent section of the Clip Studio Paint Tool Setting Guide.
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Edit the position and angle of the gradient
Select the [Operation] tool > [Object] sub tool palette and select the gradient layer in the [Layer] palette to edit the gradient. Select a Gradient 

layer from the [Layer] palette to edit.

A handle to edit the start and end points of the gradient will appear on the canvas. You can drag this handle to edit the angle and position of the 

gradient.

Straight gradient

 Drag the start point (+) to adjust the start point of the gradient.

 Dragging an end point (□) adjusts the angle and the end point position of the gradient.

Circular gradient

Drag the start point (+) to adjust the position of the gradient.

Shows two end points. Dragging either adjusts the size and angle of the gradient.
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Elliptical gradient

Drag the start point (+) to adjust the position of the gradient.

Shows four end points. Dragging either adjusts the size and angle of the gradient.

Editing where the gradient layer is visible
On the [Layer] palette, select the layer mask for the gradient layer. You can adjust where the gradient appears by erasing or drawing on the layer 

mask.

For information on how to edit layer masks, see "Layer Mask".
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Fill [PRO/EX]
A fill layer is used to fill the canvas with a single color, and is useful for flat colors in illustration. In the direction of the fill, etc.

If you use a fill layer, you can easily change the color and adjust the area of the fill using layer masks later.

1 Using a selection tool, create a selection.

2 Select [Layer] menu > [New layer] > [Fill].

3 In the [Color settings] dialog box, choose the fill color, then select [OK].

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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4 A fill layer in the selected color will be created with a layer mask.
Fill Layers are displayed in the color set in the [Color settings] dialog box.

If you create a selection area, the Fill layer will only appear within it. You can later change the area that the fill 

color appears in. For details, see "Editing the area of a fill layer".
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Changing the color of a fill layer
Select the [Operation] tool > [Object] sub tool palette and select the gradient layer in the [Layer] palette to edit the gradient.

On the [Layer] palette, select a Fill layer to edit.

When you hover over a color palette while selecting the fill layer, the cursor will switch to an eyedropper. Select a color on the color palette to 

change the color of the fill layer.

You can also change the color of a fill layer using the below method.

1. On the [Layer] palette, select the fill layer.

2. Select the [Operation] tool > [Object] sub tool.

3. In the [Tool Property] palette, change the [Fill color] to change the color of the layer.
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Editing the area of a fill layer
On the [Layer] palette, select the layer mask of the fill layer. You can adjust where the fill appears by erasing or drawing on the layer mask.

For information on how to edit layer masks, see "Layer Mask".
CLIP STUDIO PAINT Instruction Manual 483



Menus > Layer Menu > New Layer
Tone [PRO/EX]
This creates a simple screentone layer. The [Simple tone settings] dialog box opens when you create the layer. You can edit the tone pattern and 

dot frequency in this dialog box.

1 Using a selection tool, create a selection area.

2 Select [Layer] menu > [New layer] > [Tone] to open the [Simple tone settings] dialog box.

3 Set the tone pattern, dot frequency, and density, then select [OK].

For details on the [Simple tone settings] dialog box, refer to "[Simple tone settings] Dialog Box".
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4 A simple tone layer and layer mask will be created based on these settings.
 

[Simple tone settings] Dialog Box

(1) Frequency

Specify the number of screentone lines per inch. Larger values result in smaller dots.

(2) Density

Specify the density of the tones (halftone dots).

(3) Type

Select the pattern for the screentone. You can choose from: Circle, Square, Lozenge, Line, Cross, Ellipse, Noise, Sugar plum, Asterisk, 

Star, Carrot, Cherry (round), Cherry (mid), Cherry (thin), Flower (round), Flower (mid), Flower (thin), Clover (round), Clover (thin), 

Ninja star, Diamond, Heart, Clubs, and Spades.

(4) Angle

Set the angle of the tone pattern (halftone dots).

 You can edit the settings of the tone layer later. For details, see "Changing the tone settings".

 You can use the [Material] palette to switch the tone pattern. For details, see "Swapping a Pasted Material".

 To learn how to add to the tone or erase parts of the tone, see "Cutting or adding to a tone".
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(5) Size

Set the size of the noise. This setting is only available when [Noise] is selected under [Type].

(6) Factor

Set the noise factor. This setting is only available when [Noise] is selected under [Type].

(7) If there are tones with the same settings, combine them into one

When turned on, if there is a Fill layer set to [Tone] with the same settings, the layer will be merged into that layer without creating a new 

Fill layer. This item only appears when there is a selection area.

Changing the tone settings
You can edit the settings such as the tone frequency, angle, and pattern after the layer has been created. Select the tone layer and go to the 

[Layer Property] palette to view these settings.

For details on the [Layer Property] palette, see the “Tone” section of "Functions of Layer Property Palette 

(Default)".
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Cutting or adding to a tone
On the [Layer] palette, select the layer mask of the tone layer. You can adjust where the tone appears by erasing or drawing on the layer mask.

For information on how to edit layer masks, see "Layer Mask".
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Frame Border Folder [PRO/EX]
This creates a new frame border folder in alignment with the canvas default border. Frame border folders allow you to manage layers separately 

for each comic frame.

1 Select [Layer] menu > [New layer] > [Frame Border folder].

2 Adjust the settings in the [New frame folder] dialog box and click [OK].

3 A new frame border folder will be added to the [Layer] palette, and the frame border will be
drawn on the canvas.

 To learn how to draw inside frame borders or edit frame borders, see "Explanation: Comic Frame Division 

[PRO/EX]".

 The frame border folder will be created in the [Layer] palette. When you draw on a layer inside a frame border 

folder, only the areas within the frame will be shown.
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[New frame folder] Dialog Box

(1) Name

Add a name for the frame border folder.

(2) Draw border

When this is on, the border lines will be drawn on the canvas.

(3) Line width

Adjust the thickness of the border lines.

(4) Anti-aliasing

You can choose whether to use anti-aliasing on the frame border lines. When anti-aliasing is turned on, lines are less jagged and have a 

smooth border. Select [None] if you do not want to use anti-aliasing. You can choose different levels of anti-aliasing, from [Weak], [Mid-

dle], and [Strong].

(5) Left page/Right page

When creating a frame border folder on a two-spread, specify which page to create the frame border folder.

For single page For 2-page spread
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3D Layer [PRO/EX]
It is possible to create a new 3D layer without 3D materials. If there is a selection area or a selected frame, the 3D layer will be created in the 

position of the area or frame.

1 Using a selection tool, create a selection.

2 Select [Layer] menu > [New layer] > [3D layer].

3 A 3D layer and layer mask will be created according to the selected area.

For details on using 3D layers, see "Explanation: 3D Materials".

 Creating frame folders for each frame allows you to also create 3D layers for each frame. Frame folders for 3D 

layers can be selected from the [Layer] palette.

 If there is both a selection and a frame on the canvas, the selection is prioritized when creating a 3D layer.

The selected area

3DLayer
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Paper
The paper layer is the bottom-most solid layer. Hiding the Paper layer displays transparent areas of the image on the canvas in a checkered pat-

tern. Normally, when a new canvas is created, a paper layer is created at the same time.

If a Paper layer has not been created on the canvas, you can manually create one via the Layer Menu. Note that multiple Paper layers cannot be 

created on a single canvas.

1 Select [Layer] Menu > [Paper].

2 In the [Color settings] dialog box, select the color you want the paper to be.

3 Creates a Paper layer in the [Layer] Palette.

Clip Studio SHARE > Foil layer [EX]
Art works with a Foil layer uploaded to Clip Studio Share show a metallic foil stamping effect in the 3D viewer.

1 Using the selection tool, create a selection.

2 Select [Layer] Menu > [New Layer] > [Clip Studio SHARE] > [Foil layer].

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

 The Foil layer effect is only visible upon uploading a work from Clip Studio. Uploading a work from a browser 

will disable the effect.

 When exporting the work into another format or printing it, canvases with a Foil layer will export or print as a 

Fill layer.

 Even if you hide the Foil layer and its layer mask, it will still be visible when uploaded to Clip Studio Share.

 Even if you change the Foil layer's opacity and blending mode, or set [Effect] in the [Layer Properties] palette, 

when uploaded to Clip Studio Share, the Foil layer will still appear with these settings disabled.
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3 Set a color in the [New foil layer] dialog box.

(1) Click the color icon and select a color from the [Color settings] dialog box.

(2) Select the foil stamping effect from [Print style].

(3) Drag the foil preview to check how the color looks.

(4) Click OK to confirm.

4 Creates a Foil layer and a Layer mask.
Foil layers are created using the color set in the [Color settings] dialog box.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

 You can change the size of the [New foil layer] dialog box by dragging one of the edges of the box.
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New foil layer Dialog Box

(1) Preview

Shows a 3D preview of the Foil layer. You can drag the preview to adjust and view the angle of the Foil layer.

(2) Color

Clicking the color icon shows the [Color settings] dialog box.

(3) Print style

From Foil stamping effect you can choose the following options: [Embossed (thick)], [Embossed (medium)], [Embossed (thin)], [Flat], 

[Debossed (thick)], [Debossed (medium)], [Debossed (thin)].

 If there is no Foil layer on the top of the [Layer] palette, or if the Foil layer is renamed, the effect will be dis-

abled when uploaded to Clip Studio SHARE.

 If there is a Foil layer at the top of the [Layer] palette, you can change its color. Select [Layer] menu > [Foil 

Layer] to reset the Foil layer.

 You can change the drawing area of the Foil layer just like Fill layer. For details, see "Fill [PRO/EX]". However, 

if you set the Layer Mask’s [Posterization] to [Yes] and draw a gradient with transparency, the Foil stamping 

effect will only be applied from the default threshold.

Even if the following settings are made for the Foil layer, they will not show in the preview.

 Opacity and Blending mode settings

 Settings for hiding Foil layers and masks

 [Layer Property] Palette [Effect] settings
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Explanation: Editing a Vector Layer [PRO/EX]
A vector layer is a layer that allows you to edit lines that have already been drawn. You can change the brush tip or brush size, or change the 

shape of the lines using handles and control points. You can use the following tools to edit lines on vector layers.

The following section describes how to edit a lines on vector layers using these tools.

Editing with the Operation Tool
Select a line on a vector layer with the [Operation] > [Object] tool to display the handles and control points for the line. You can use these to 

edit the vector line.

Transforming lines
Click the line you want to edit. Handles will appear on the selected line.

[Operation] tool > [Object] sub tool

Displays handles that you can use to rotate, move, or transform the lines. Drag the control 

points to transform part of the line shape. You can also use the [Tool Property] palette to 

change the shape of the brush tip, brush size, line color, and so on.

[Correct line] tool You can use this tool to adjust control points, line width, and so on.

 To select a consecutive group of objects, click the first item, then hold down Shift and select the last item.

 Select the [Object] sub tool, click the [Sub Tool Detail] > [Operate] category > [Operation of transparent part], 

activate [Select area by dragging] and select the [Object] to select all objects inside the specified area at once.

Click on the line 

you want to edit.
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Use the handles and control points on the bounding box to adjust the image’s orientation, size, and shape.

Scaling an image up/down

Drag the handles on the edge of the image to scale the image up or down.

Rotating an image

Dragging the rotation handle allows you to rotate the image.

 If the transformation mode is set to [Free Transform] in the [Tool Property] palette, you can freely transform 

the image by dragging the handles.

 Holding down Shift during free transform and dragging a handle moves it in the direction of the frame. When 

[Mode] in the [Tool Property] palette is set to [Distort], you can move both handles.

 Dragging a handle while holding down Alt allows you to scale the image.

 Hold down Shift while dragging a handle to resize the image without changing the original ratio.

 Turn on [Change thickness while scaling] on [Sub Tool Detail] palette > [Transformation settings] category to 

automatically adjust the line thickness in accordance with the transformation.
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Moving an image

Drag the vector line or the bounding box to move the image.

Transforming an image

Drag a control point on the line to transform the shape near the control point.

 Hold down Shift while dragging the rotation handle to rotate in increments of 45 degrees.

 Turn on [Change thickness while scaling] on [Sub Tool Detail] palette > [Transformation settings] category to 

automatically adjust the line thickness in accordance with the transformation.

 If the transformation mode is set to [Scale] in the [Tool Property] palette, the rotation handle will not show. 

This is shown when you select other items.

 Hold down Shift while dragging the drawing area or bounding box to move the image horizontally, vertically, or 

along a 45-degree diagonal angle.

 Turn on [Change thickness while scaling] in the [Sub Tool Detail] palette > [Transformation settings] category 

to automatically adjust the line thickness in accordance with the transformation.
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Transforming a curve

Direction points are displayed for rectangles and polygons set with [Roundness of corner], and for quadratic and cubic Bezier curves. Dragging 

a direction point allows you to transform the curve.

Example of curve: Quadratic Bezier

Example of curve: Rectangle with rounded corners

Control point

Control point

Control point
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Changing line color, brush tip shape, and brush size
With the [Operation] > [Object] tool, select the vector layer on the [Layer] palette to display settings for the line color, brush tip shape, and 

brush size in the [Tool Property] palette.

You can adjust these settings to change the line color, brush shape, brush size and so on.

Right-click Menu during Object Tool Use [Windows/macOS]
If you right-click a vector line when the [Operation] > [Object] tool is selected, a menu will appear. From this menu, you can perform the fol-

lowing operations you can perform from [Correct line] tool > [Control point] sub tool.

 Add control point

 Delete control point

 Switch corner

 Cut line

For details on the operations you can perform, see "Control point".
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Select multiple control points
With the [Operation] > [Object] tool, select the drawing on the vector layer to display the handles and control points for the line.

To select multiple control points, you can either hold the Shift key and select each point, or drag to select control points if the setting is turned 

on in the [Sub Tool Detail] palette.

Select multiple items by holding Shift
Consecutively click the control points while holding Shift . This will select multiple control points.

Click with the [Shift] key held down.
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Select multiple items by dragging
Click [Operation of transparent part] in [Object] Sub Tool’s [Tool Property] palette. Turn on [Select area by dragging] and choose [Control 

point].

Drag on the canvas. The two or more control points inside the dragged area are selected.

 If [Select area by dragging] is turned on and set to [Object], only object can be selected by dragging. Control 

points cannot be selected.

 Hold down Shift while dragging to select multiple control points to select consecutive points.

 To select additional control points after selecting multiple control points, hold down the Shift key and click the 

control points you want to add.

Select area by dragging
CLIP STUDIO PAINT Instruction Manual 500



Menus > Layer Menu > Explanation: Editing a Vector Layer [PRO/EX]
Editing with the Correct line Tool
With the [Correct line] tool, you can edit control points and change the line width of vector lines.

Choose the appropriate tool from the [Sub tool] palette.

A. Control point
You can move, add, delete and switch corners of control points and adjust line width and opacity of drawn lines. You can select how you 

will edit control points and lines from the [Tool Property] palette.

(1) Move control points

Drag a control point to transform the shape of the line near the control point.

A

B

C

D

E

F

G
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(2) Add control point

Click the line to add a control point. You can also drag control points to transform the shape of the line near the control point.

Dragging a control point allows you to move it.

(3) Delete control point

Click a control point to delete it.

When [Move control points] is selected, you can do the following for a lines drawn with [Cubic Bezier] selected 

from [Curve] on the [Tool Property] palette.

 Pressing Alt while dragging a direction point changes the shape of the line and the anchor point into a corner.

 Pressing Space while dragging moves all control points at once.

When [Add control point] is selected, you can do the following for a lines drawn with [Cubic Bezier] selected from 

[Curve] on the [Tool Property] palette.

 Dragging a line adds a anchor point at the start of the drag and a direction point at the end of the drag. The 

shape of the line changes according to the position of the direction point.

 Pressing Alt while dragging a direction point changes the shape of the line and the anchor point into a corner.

 Pressing Space while dragging moves all control points at once.

Click

Click the control point
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(4) Switch corner

Clicking a control point allows you to switch the type of corner at the clicked point. Clocking switches between angled corners and 

rounded corners.

When [Switch corner] is selected, you can do the following for a lines drawn with [Cubic Bezier] selected from 

[Curve] on the [Tool Property] palette.

 Dragging an anchor point changes the direction point into a curve. At the same time, the direction point 

moves to the end position of the drag.

 Dragging a direction point changes the shape of the line and changes the anchor point into a corner.

 Pressing Space while dragging moves all control points at once.

Click Click
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(5) Adjust line width

Drag a control point to change the width of the line near the control point.

[Adjust line width] cannot be used to edit the control points of a ruler.

Correct line width (Thicker)

Correct line width (Thinner)

Drag

Drag
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(6) Correct density

Drag a control point to change the density of the line near the control point.

(7) Cut line

With this option, you can cut a vector line at the clicked point to divide it into separate lines.

[Correct density] cannot be used to edit the control points of a ruler.

[Cut line] cannot be used to edit the control points of a special ruler.

Drag Drag

Click on the 

vector line

Divided into separate lines

at the clicked point.
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B. Pinch vector line
You can transform the line by dragging a portion of the line. Use [Fix end] options on the [Tool Property] palette to select whether to fix 

the positions of the start point and end point when transforming the line.

(1) Fix both ends

Fixes the start and end points of the line. The start point and end point will not move when the line is pinched.

Drag a portion of the line
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(2) Fix either end

Fixes the opposite end from the point where the line will be reshaped. The end that is fixed will not move when the line is pinched.

(3) Free both ends

The start point and end point of the line can move. When the line is pinched, the start point and end point may move depending on the 

pinch level.
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C. Simplify vector line
Drag over the line to simplify the line by reducing the number of control points.

D. Connect vector line
This connects lines that were drawn separately. Drag from the end of one line to the end of another line to connect them.

The Tool Property palette's, [Convert curve], allows you to simplify and change curve type at the same time. You 

can select from [Polyline], [Spline], [Quadratic Bezier], and [Cubic Bezier].

Trace the line

Trace the line
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E. Adjust line width
Drag over a line to scale the line width up or down.

On the [Tool Property] palette, you can select how to scale the line width.

(1) Thicken Thickens the line width by the specified amount.

(2)Narrow Narrows the line width by the specified amount.

(3) Scale up width Scales the current line width up by the specified percentage.

(4) Scale down width Scales the current line width down by the specified percentage.

(5) Fix width Changes the line width to the specified value.

Correct line width (Fix width)

Trace the line
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F. Redraw vector line
With this tool, you can redraw a portion of the line by dragging it.

You can set how you want to redraw the line in the [Tool Property] palette.

(1) Fix end

Select whether or not and how to fix the starting point and/or end point when transforming a line.

Fix both ends
Fixes the start and end points of the line. The starting point and end point do not move even if the 

line is redrawn.

Fix either end
Fixes the opposite end from the point where the line will be reshaped. The end that is fixed does 

not move even if the line is redrawn.

Free both ends The start point and end point of the line can move.

Drag a portion of

the vector line
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(2) Connect line

When turned on, you can connect two neighboring segments of lines with the same brush tip shape, size, and angle settings. Draw over the 

ends of both segments when redrawing the line to connect the two segments.

(3) Simplify

When turned on, you can simplify the line by reducing the number of control points. Use the slider to set how many control points to 

reduce. The larger the value,

the more control points will be removed.

(4) Stabilization

Sets stabilization of lines drawn on the tablet. The larger the value, the smoother the line will be; the smaller the value, the more similar the 

line will be to the raw input.

Drag so as to overlap

the ends of the lines.
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G. Redraw vector line width 
Allows you to change the line width by dragging over the vector line as if tracing. You can also link the brush size dynamics to [Pen pres-

sure] in the [Tool Property] palette to adjust the line width by adjusting the pen pressure.

The brush size can be adjusted in the [Tool Property] palette.

(1) Brush size

This sets the drawing size. Use the slider to change the settings. You can also change the setting by using the up and down arrow icons next 

to the input field. The [Dynamics] button allows you to adjust the tablet settings that affect the brush size.

For more information on Dynamics, see the "CLIP STUDIO PAINT Tool Setting Guide".

Vector line

Drag over the vector

line as if tracing.
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New Correction Layer [PRO/EX]
Creates a new tonal correction layer above the selected layer. Correction layers have the following features.

 Correction layers can adjust the brightness, hue, saturation, luminosity, and posterization levels of lower layers.

 Created correction layers apply an effect to all lower layers. For details, see "Creating a tonal correction layer".

 You can change the layer order to change the layers affected by the tonal correction layer. The strength of the effect can be adjusted by edit-

ing the layer mask. For details, see "Changing the area of a tonal correction layer".

 Double-click a tonal correction layer to edit the settings. For details, see "Editing a tonal correction layer".

Types of correction layer
You can create the following types of correction layers.

To directly apply tonal correction to a selected layer, use the [Edit] menu > [Tonal correction] and choose the 

appropriate command. For details, please refer to "Tonal correction".

Brightness/Contrast Adjusts the brightness and contrast of an image.

Hue/Saturation/Luminosity Adjusts the three components (hue, saturation and luminosity) of the HSV color model.

Posterization Converts an image into the specified gradient.

Reverse Gradient Inverts the colors in an image.

Level Correction Adjusts the contrast of an image using the histogram.

Tone Curve Adjusts the contrast of an image using the tone curve.

Color balance Adjusts the tone of an image by adjusting the balance of each RGB color.

Binarization Converts an image into a black and white duotone image.

Gradient map Each shade in the image is replaced with colors of the selected gradient.
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Creating a tonal correction layer
This section describes how to apply tonal corrections, using the example of Gradient map layer.

1 In the [Layer] palette, select the layer you want to apply the effect to.

2 Select [Layer] menu > [New Correction Layer] > [Gradient map].

3 Adjust the settings in the dialog box that appears.

(1) Choose a gradient set from the list and double-click to select it.

(2) Click a node below the color bar.

(3) In the [Color] section, select the color to use. The selected node will change to this color.

 If you create a selection area, the effect will only be applied to the selection area. You can change the size of 

the effect later. For details, please refer to "Changing the area of a tonal correction layer".

 The effect applies to layers below the created correction layer.
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(4) You can drag nodes left and right to adjust levels of the gradient.

(5) Repeat steps 2 to 4 as necessary.

(6) Click [OK].

4 After you select [OK], the tonal correction will be applied and a tonal correction layer with
a layer mask will appear above the selected layer in the [Layer] palette.

 If you select [Reverse Gradient], the dialog box will not appear. Proceed to the next step.

 As you edit the settings in the dialog box, a preview of the results will be shown on the canvas. You can check 

the results as you edit the settings.

After creating the layer, you can open the dialog box again to edit the settings. For details, please refer to "Editing 

a tonal correction layer".
CLIP STUDIO PAINT Instruction Manual 515



Menus > Layer Menu > New Correction Layer [PRO/EX]
Changing the area of a tonal correction layer

Adjusting the layer mask
You can select the layer mask and draw on it or erase parts of it to adjust the balance over the original image.

 Erasing parts of the layer mask will reveal the original image.

 Drawing on the layer mask with a drawing tool will make the tonal correction effect appear stronger.

Changing the position of a tonal correction layer
Moving the correction layer in the [Layer] palette allows you to change the layer to which the correction applies.

For information on how to adjust layer masks, see "Layer Mask".
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Applying a tonal correction layer to specific layers
If you create a tonal correction layer inside a layer folder, the effect will only apply to layers in the same layer folder.

Temporarily hiding a tonal correction layer
You can temporarily hide the correction layer in the [Layer] palette to compare the state before and after applying the effect.

If you want to apply the tonal correction effect to layers beneath the layer folder, set the blending mode of the 

folder to [Through].

Deleting the correction layer will return the lower layers to the original state.
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Editing a tonal correction layer
Click the Tonal Correction layer icon on the [Layer] palette.

In the dialog box that appears, you can edit the settings for the tonal correction layer.

You cannot edit the settings for a [Reverse Gradient] tonal correction layer.
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Tonal Correction layer (Brightness/Contrast)
Select the [Layer] menu > [New Correction Layer] > [Brightness/Contrast] to create a new layer for adjusting the brightness and contrast of the 

image.

[Brightness/Contrast] Dialog Box

(1) Brightness

Adjusts the brightness of the image. A lower value darkens the image, while a higher value brightens the image.

(2) Contrast

Adjusts the contrast (difference between lights and darks) of the image. A lower value reduces the contrast, while a larger value increases 

the contrast.

 For details on how to create a Tonal Correction layer, see "Creating a tonal correction layer".

 For information on how to edit a Tonal Correction layer, see "Changing the area of a tonal correction layer".

 For information on the settings in the [Brightness/Contrast] dialog box, please see the following section.

Original image After applying correction layer (Brightness/Contrast)
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Tonal Correction layer (Hue/Saturation/Luminosity)
Select the [Layer] menu > [New Correction Layer] > [Hue/Saturation/Luminosity] to create a new layer for adjusting the three components 

(hue, saturation and luminosity) of the HSV color model.

[Hue/Saturation/Luminosity] Dialog Box

(1) Hue

Indicates the hue of the color (red, green, yellow, etc.).

(2) Saturation

Adjusts the vividness of the color. Higher values result in more vivid colors.

(3) Luminosity

Adjusts the brightness of the color. Higher values result in brighter colors.

 For details on how to create a Tonal Correction layer, see "Creating a tonal correction layer".

 For information on how to edit a Tonal Correction layer, see "Changing the area of a tonal correction layer".

 For information on the settings in the [Hue/Saturation/Luminosity] dialog box, please see the following sec-

tion.

Original image After applying correction layer (Hue/Saturation/Luminosity)
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Tonal Correction layer (Posterization)
Select the [Layer] menu > [New Correction Layer] > [Posterization] to create a layer that allows you to adjust the posterization.

[Posterization] Dialog Box

(1) Number of gradients

Set the number of levels to split the image values into. You can set between 2 and 20 levels. More levels will result in a smoother effect.

 For details on how to create a Tonal Correction layer, see "Creating a tonal correction layer".

 For information on how to edit a Tonal Correction layer, see "Changing the area of a tonal correction layer".

 For information on the settings in the [Posterization] dialog box, please see the following section.

After applying correction layer (Posterization)Original image
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Tonal Correction layer (Reverse Gradient)
Select the [Layer] menu > [New Correction Layer] > [Binarization] to create a layer to invert the colors (RGB values) of the image. Inverted 

values are in RGB. For example, R: 100, G: 255, B: 0 would be inverted to R: 155, G: 0, B: 255.

 If you create a selection area, the effect will only be applied to the selection area. You can change the size of 

the effect later.

 For information on how to edit a Tonal Correction layer, see "Changing the area of a tonal correction layer".

Original image After applying correction layer (Reverse gradient)
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Tonal Correction layer (Level correction)
Select the [Layer] menu > [New Correction Layer] > [Level Correction] to create a new layer for adjusting the brightness of the image with a 

histogram

[Level Correction] Dialog Box

(1) Channel

Select a channel to adjust the levels. You can choose from [RGB], [Red], [Green], or [Blue].

(2) Histogram

This graph displays the volume of the dark areas (left side) and bright areas (right side) as mountain-like peaks.

(3) Shadows

This controls the darkest parts of the image. Drag to the left and right to adjust the brightness of the image. Drag to the left to make the 

image brighter, or to the right to make the image darker. The [Shadows] control point is usually the furthest left under the histogram.

(4) Midtones

This controls the midtones of the image. When you move the [Shadows] control point or the [Highlights] control point, the [Midtones] 

control point moves in tandem. You can move the [Midtones] control point without affecting the [Shadows] or [Highlights] control points. 

Drag to the left to make the image brighter, or to the right to make the image darker.

 For details on how to create a Tonal Correction layer, see "Creating a tonal correction layer".

 For information on how to edit a Tonal Correction layer, see "Changing the area of a tonal correction layer".

 For information on the settings in the [Level Correction] dialog box, please see the following section.

Original image After applying correction layer (Level correction)
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(5) Highlights

This controls the lightest parts of the image. Drag to the left and right to adjust the brightness of the image. Drag to the left to make the 

image brighter, or to the right to make the image darker. The [Highlights] control point is usually the furthest right under the histogram.

(6) Shadows output

This controls the darkest parts of the image. Drag to the left and right to adjust the brightness of the image. Drag to the left to make the 

image brighter, or to the right to make the image darker.

(7) Highlights output

This controls the brightest parts of the image. Drag to the left and right to adjust the brightness of the image. Drag to the left to make the 

image brighter, or to the right to make the image darker.

Tonal Correction layer (Tone curve)
Select the [Layer] menu > [New Correction Layer] > [Tone Curve] to create a new layer for adjusting the brightness of the image with a graph.

[Tone Curve] Dialog Box

 For details on how to create a Tonal Correction layer, see "Creating a tonal correction layer".

 For information on how to edit a Tonal Correction layer, see "Changing the area of a tonal correction layer".

 For information on the settings in the [Tone Curve] dialog box, please see the following section.

After applying correction layer (Tone curve)Original image
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(1) Channel

Select from [RGB], [Red], [Green] and [Blue] channels to adjust brightness.

(2) Tone curve

A graph to adjust the contrast of the image. Drag the control point to adjust.

The horizontal axis of the graph is the "Input" value (original brightness) and the vertical axis is the "Output" value (brightness after 

adjustment).

(3) Reset

Reset the image to the original state.

 This graph displays the volume of the dark areas (left side) and bright areas (right side) as mountain-like 

peaks. Adjust the tone curve while checking the balance of the original image in the histogram.

 Click on the graph to create a new control point.

 To delete a control point, drag it outside of the graph.
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Tonal Correction layer (Color balance) 
Select the [Layer] menu > [New Correction Layer] > [Color balance] to create a new layer for adjusting the color of the image by editing the 

RGB balance.

[Color balance] Dialog Box

(1) Color balance

Adjust the color balance of the image by using the sliders. You can move the three sliders left and right to adjust the balance of cyan and 

red, magenta and green, and yellow and blue.

The value of each slider is displayed in [Color level]. From left to right, these show the current values of [Cyan - Red], [Magenta - Green] 

and [Yellow - Blue]. You can also directly input values in these fields.

(2) Gradient balance

Select from [Shadow], [Half tone] and [Highlight] to adjust the balance of the selected level. You can adjust the color balance at each level 

separately.

(3) Keep brightness

Keeps the same level of brightness when the gradient balance is adjusted.

 For details on how to create a Tonal Correction layer, see "Creating a tonal correction layer".

 For information on how to edit a Tonal Correction layer, see "Changing the area of a tonal correction layer".

 For information on the settings in the [Color balance] dialog box, please see the following section.

Original image After applying correction layer (Color balance)
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Tonal Correction layer (Binarization) 
Select the [Layer] menu > [New Correction Layer] > [Binarization] to create a layer to convert the layer content into black and white.

[Binarization] Dialog Box

(1) Threshold

The color of dots darker than the set threshold is reduced to black, while the color of dots brighter than the set threshold is reduced to 

white.

 For details on how to create a Tonal Correction layer, see "Creating a tonal correction layer".

 For information on how to edit a Tonal Correction layer, see "Changing the area of a tonal correction layer".

 For information on the settings in the [Binarization] dialog box, please see the following section.

After applying correction layer (Binarization)Original image
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Tonal Correction layer (Gradient map) 
Select the [Layer] menu > [New Correction Layer] > [Gradient map] to create a correction layer that converts the colors of the original layer to 

the gradient based on the density of the original colors.

[Gradient map] dialog box

Tonal Correction gradient map layers from versions 1.3.1 or earlier are not supported in later versions.

 This section describes how to create a tonal correction layer, using the example of Gradient Map. For details, 

please refer to "Creating a tonal correction layer".

 For information on how to edit a Tonal Correction layer, see "Changing the area of a tonal correction layer".

 For information on the settings in the [Gradient map] dialog box, please see the following section.

Tonal Correction layer (gradient map)Original image
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A. Gradient settings
Create a gradient by moving the nodes.

(1) Color bar

A preview of the gradient.

(2) Node

Adjust the color of the gradient using the nodes. You may create multiple nodes. Click an empty space to add a node.

You can drag the nodes horizontally to adjust the tone of the gradient. When a node is selected, the icon will be highlighted.

To delete a node, drag it vertically off the color bar.

(3) Select left node

Switches the selected node to the next node on the left.

(4) Select right node

Switches the selected node to the next node on the right.

(5) Reverse gradient

Inverts the gradient settings.

(6) Delete node

Deletes the selected node.

B. Gradient set
Manage gradient settings.

(1) Show Gradient Sets

Displays the [Gradient set] list and make a selection.
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(2) Show Menu

Displays the gradient set menu.

(3) Gradient list

A list of gradient settings included in the current gradient set.

(4) Up/Down

Move the display position of the selected gradient settings up or down.

(5) Replace Gradient

Overwrites the settings selected in the list with the settings of the gradient displayed in the color bar.

(6) Apply to Gradient Settings

Imports the gradient settings selected from the list into the color bar.

(7) Duplicate Gradient

Duplicates the selected gradient settings.

(8) Add Gradient

Adds the settings of the gradient displayed on the color bar to the list. The added gradient settings are displayed at the bottom of the list.

(9) Delete Gradient

Deletes the gradient settings selected in the list.

C. Position
Set the position of the selected node.

Create new set Create a new color gradient data set.

Delete set Deletes the selected gradient set.

Duplicate set Duplicates the selected gradient set.

Settings of set Change the name of the selected gradient set.

Register set as material

Displays the [Material property] dialog box, where you can register the selected gradient set to 

the [Materials] palette. For details on the [Material property] dialog box, see "[Material prop-

erty] Dialog Box".

Import material set

Displays the [Import material set] dialog box, where you can import a gradient set registered to 

the [Materials] palette. For details on the [Import material set] dialog box, see "[Import material 

set] dialog box".

Add Gradient
Add the settings of the gradient displayed on the color bar to the list. The added gradient settings 

are displayed at the bottom of the list.

Delete Gradient Deletes the gradient settings selected in the list.

Duplicate Gradient Duplicates the selected gradient settings.

Change Gradient Name Change the name of the selected gradient settings.

Replace Gradient
Overwrites the settings selected in the list with the settings of the gradient displayed in the color 

bar.

Apply to Gradient Settings Imports the gradient settings selected from the list into the color bar.

Import Gradient

Import a gradient settings file from IllustStudio (extension: cgs).

Gradient settings file from IllustStudio (extension: cgs) cannot be imported on tablets/smartpho-

nea/Macs with M1 chips.
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D. Color
Set the color of the selected node.

(1) Main drawing color

Uses the main drawing color as the node color. If you change the main drawing color with a color palette, the node color will also change.

(2) Sub drawing color

Uses the sub drawing color as the node color. If you change the sub drawing color with a color palette, the node color will also change.

(3) Specified color

Specify a color for the node. Click the color indicator to open the [Color settings] dialog box.

(4) Obtain screen color [Windows/macOS]

You can use the eyedropper to pick a color from the screen as the specified color.

E. Mixing rate curve
Allows you to adjust the change in color between the selected node and the node to the right.

 The horizontal axis of the graph indicates the position of the nodes.

 The vertical axis of the graph indicates the color mixing ratio with the node to the right. When the value is larger, the color between 

the nodes will be closer to the color of the node to the right. When the value is lower, the color between the nodes will be closer to the 

color of the selected node.

 Clicking on the curve allows you to add up to 16 points. which you can drag to adjust the mixing rate curve. To delete a control point, 

drag it outside the graph.
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New Layer Folder
Layer folders allow you to group several layers in one folder. For example, you can separate layers for your character and layers for the back-

ground into different folders to make your file easier to manage.

First, select any layer on the [Layer] palette. Select the [Layer] menu > [New Layer Folder] to create an empty layer folder above the selected 

layer.

You can drag and drop layers in to and out of the folder. You can also store layer folders inside other layer folders.

 Layer folders inside animation folders are treated as single cels. The layer folder corresponding to the cel will 

be displayed as a thumbnail on the [Layer] palette.

 You can select multiple layers and move them into a layer folder at once. To select multiple layers, hold Ctrl or 

Shift while selecting.

 Select the layers and then use the [Layer] menu > [Create folder and insert layer] to create a new layer folder 

containing the selected layers. For details, see "Create folder and insert layer".

Drag and drop

to the Layer folder.
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Create folder and insert layer
You can either select a layer from the [Layer] palette or by selecting [Layer] menu > [Create folder and insert layer]. The selected layer will be 

stored in the created layer folder.

Ungroup Layer Folder
Select a layer folder from the [Layer] palette. Select the [Layer] menu > [Delete layer folder] to delete it. Ungrouping a layer folder will only 

delete the folder. Any layers inside the folder will remain.

Frame Border folders and Animation folders operate in the same way, only deleting the folder and any layers inside it will remain.

 You can also drag layers onto the [New Layer Folder] icon in the [Layer] palette to create a new layer folder 

with that layer stored inside it.

 You can select multiple layers and move them into a layer folder at once. Hold Ctrl or Shift to select multiple 

layers.

 When [Ungroup Layer Folder] is executed on a Layer Folder with Opacity, Blending mode, or Palette color set-

tings applied, those settings will be erased.

 When [Ungroup Layer Folder] is executed on a Layer Folder set with an Effect from the [Layer Property] Pal-

ette, those settings will be erased.

 When [Ungroup Layer Folder] is executed on a Layer Folder set with a Layer mask or a Ruler, they will be 

erased.
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Duplicate Layer
Select the layer from the [Layer] palette you want to duplicate. Select the [Layer] menu > [Duplicate Layer] to duplicate it.

Delete Layer
In the [Layer] palette, select the layer you want to delete. Select the [Layer] menu > [Delete Layer] to delete it.

 You can select multiple Layer Folders and move them into a layer folder at once. Hold down Ctrl or Shift and 

click the layer folder to select multiple layers.

 Layer folders inside a selected Layer folder will not be deleted.

 When [Ungroup Layer Folder] is used on an Animation folder, for each layer (cel), clips (from starting frame to 

ending frame), will be created on the [Timeline] palette.

 You can select multiple layers and duplicate them at once. To select multiple layers, hold Ctrl or Shift while 

selecting.

 You can duplicate layer folders in the same way. The layers inside the layer folder will also be duplicated.

 You can change the name of layer copies in [Preferences] > [Layer/Frame]. For details, see "Layer/Frame".

 You can also duplicate layers by selecting the layer, then holding Alt and dragging the layer.

You can delete layer folders in the same way. The layers inside the layer folder will also be deleted.

 The "Delete layer" operation cannot be performed on a layer registered to the [Animation cels] palette as a 

light table layer. For details on deleting light table layers from the [Animation cels] palette, see "Deleting a light 

table layer".

 To delete a layer from the canvas, select the layer on the [Layer] palette and click [Delete Layer].
CLIP STUDIO PAINT Instruction Manual 534



Menus > Layer Menu > Layer Mask
Layer Mask
Creates a mask for the selected layer or layer folder. Masks can be adjusted and deleted.

What is a layer mask?
A layer mask is a feature that can hide part of the image on a layer. You can use this to hide unnecessary parts, or to limit the area for fill layers 

and gradient layers.

Editing a layer mask
 You can draw on layer masks with a drawing tool to remove portions of the mask and reveal the images on the layers below.

 While selecting a layer mask, you can use eraser tools to draw more of the layer mask and hide the lower layers.

You can also use brush or pen tools with transparency to draw the mask.

Draw on mask using

drawing-type tool.

Using the eraser tool

creates a mask.
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 The opacity of the mask will vary depending on the opacity of the tool.

Mask Outside Selection

1 Using a selection tool, create a selection.

Drawn at 100% opacity

Drawn at 75% opacity

Drawn at 50% opacity

Drawn at 25% opacity

Drawn at 1% opacity

Background image

Drawn on layer mask with [Eraser] toolDrawn on layer mask with drawing-type tool

Image on layer to be masked
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2 On the [Layer] palette, select the layer you want to mask.

3 Select the [Layer] menu > [Layer Mask] > [Mask Outside Selection].
The layer mask will be applied to the area outside the selection, and the layer mask will appear in the [Layer] palette Areas under the mask 

will be hidden.

If a selection is not created, the mask will apply to the entire layer.

You can edit layer masks after creating them. For details, see "What is a layer mask?".
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Mask Selection

1 Using a selection tool, create a selection.

2 On the [Layer] palette, select the layer you want to mask.

3 Select the [Layer] menu > [Layer Mask] > [Mask Selection].
The layer mask will be applied to the selected area, and the layer mask will appear in the [Layer] palette Areas under the mask will be hid-

den.

If there is no selection area, the layer mask will be created without any masked areas.
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Delete Mask
Select the [Layer] menu > [Layer Mask] > [Delete Mask] to delete the layer mask from the selected layer.

Apply Mask to Layer
Select the [Layer] menu > [Layer Mask] > [Apply Mask to Layer] to combine the layer and the layer mask together. This deletes the layer 

mask.

Enable Mask
Select the [Layer] menu > [Layer Mask] > [Enable Mask] to enable or disable the layer mask.

Show Mask Area
Select the [Layer] menu > [Layer Mask] > [Show Mask Area] to display the mask area in purple.

You can edit layer masks after creating them. For details, see "What is a layer mask?".

 When you combine the layer mask and the layer, the combined layer will be a raster layer, regardless of the 

original layer type.

 You can apply layer masks to layers with keyframes by selecting the [Animation] menu > [Edit layers with 

active keyframes].

You can also show/hide the masked area by clicking the layer mask icon while holding down Alt.

Show mask area OFF Show mask area: ON
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Link Mask to Layer
Select the [Layer] menu > [Layer Mask] > [Link Mask to Layer] to link the layer and the mask. When linked, the mask moves with the layer 

when it is moved with the [Move layer] tool.

You can turn this off in the menu to unlink the mask and the layer. When not linked, the mask will not move when the layer is moved with the 

[Move layer] tool.

When a layer and a mask are linked, a check mark will appear between the layer and mask thumbnails on the [Layer] palette.

Ruler/Frame [PRO/EX]
Allows you to perform operations related to the ruler/frame border.

 Allows you to divide/integrate frame borders.

 Allows you to delete and show rulers, create perspective rulers, etc. It also allows you to set whether to move the ruler along with the draw-

ing area of the layer being edited, or separately.

Selection from Ruler 
Select a layer that has a ruler with a closed shape. Select the [Layer] menu > [Ruler/Frame] > [Selection from Ruler] to create a selection area.

You cannot create a selection from a ruler that does not have a closed shape.

You can also create a selection on the [Layer] palette by clicking the ruler icon while holding down Ctrl.
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Draw along ruler
Allows you to draw a line along a ruler on the canvas.

You can also set the drawing color from the color palette. Select the layer you want to draw on, and then select [Layer] menu > [Ruler/Frame] 

> [Draw along ruler] to show the [Draw along ruler] dialog box. Set [Line width] and [Anti-aliasing] settings, and then click [OK] to draw a 

line along the ruler on the selected layer.

Draw along ruler Dialog Box

(1) Line width

You can set the width of the line when drawing along the ruler.

(2) Anti-aliasing

You can set the strength of the anti-aliasing. You can select from [None], [Weak], [Middle], or [Strong].

 If you have a specific ruler selected with the Object subtool, lines will only be drawn along the selected portion 

of the ruler.

 This does not apply to the Special ruler, Perspective ruler, or the Symmetrical ruler.
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Ruler from vector
Select a vector layer and the select [Layer] menu > [Ruler/Frame] > [Ruler from Vector] to create a ruler that matches the image on the vector 

layer.

Delete Ruler
Select the ruler with the [Object] tool. Select the [Layer] menu > [Ruler/Frame] > [Delete ruler] to it.

Show Ruler
Select the [Layer] menu > [Ruler/Frame] > [Show Ruler] to hide or display or hide the rulers on the current layer.

Link Ruler to Layer
Select the [Layer] menu > [Ruler/Frame] > [Link Ruler to Layer] to link the movement of the layer and rulers on the layer.

 When turned on, the rulers move with the layer when it is moved with the [Move layer] tool.

 When turned off, the rulers and the content on the layer can be moved separately with the [Move layer] tool.

Create Perspective Ruler
Select the [Layer] menu > [Ruler/Frame] > [Create Perspective Ruler] to create a ruler for perspective drawing with up to three vanishing 

points.

 If you have a specific line selected with the Object subtool, only the selected portion will be converted to a 

ruler.

 [Ruler from Vector] does not work on a Vector layer that is hidden or has keyframes enabled on a Vector layer 

in the [Timeline] palette.

 It also cannot be used on balloon layers, vector image material layers, or frame border folders.

If no ruler is selected, this will delete all rulers on the current layer.

For details on perspective rulers, see "Explanation: Perspective ruler [PRO/EX]".
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Divide frame border equally
Allows you to divide frame borders into equal sections. While selecting a frame border folder on the [Layer] palette, select the [Layer] menu > 

[Ruler/Frame] > [Divide frame border equally] to open the dialog box.

In the dialog box, you can set the number of divisions, direction of the division, and the folder structure of the frame border folder after divi-

sion.

[Divide frame border equally] Dialog Box

(1) Number of vertical divisions

Set the number of vertical divisions in the frame border.

(2) Number of horizontal divisions

Set the number of horizontal divisions in the frame border.

(3) Fit to Side Direction of Frame

Set the angle of the divided sides.

When turned on, the frame border will be divided at the same angles as the original frame border.
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When turned off, the frame border will be divided vertically and horizontally.

(4) Divide folder

Set up the structure of the frame border folders after division.

Duplicate Layer

The original frame border folder will be deleted, and a new frame border folder will be created for 

each divided frame border. The images in the original frame border folder will be copied to each 

new frame border folder.

Create empty folder
The original frame border folder is left as it is, and an empty frame border folder is created for 

each new frame border. The images remain stored in the original frame border folder.

Not change The frame border are only divided, and no changes are made to the frame border folders.
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Combine frames
Combines the frame border folders that are currently selected on the [Layer] palette. While selecting a frame border folder on the [Layer] pal-

ette, select the [Layer] menu > [Ruler/Frame] > [Combine frames] to open the dialog box.

In the dialog box, you can set the structure of the frame border folder after combining.

[Combine frames] Dialog Box

(1) Combine folder

You can set the structure of the frame border folder after combining.

Combine border

Connects the frame borders to combine them into one frame border. The images in the original frame border folders are stored in a newly 

created frame border folder.

States of frame borders and layers before combined
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Combine only folder

Combines the folders into one frame border folder, while leaving the border lines as they are. The images in the original frame border fold-

ers are stored in a newly created frame border folder.

Create common folder

Combines the folders into one frame border folder, while leaving the border lines as they are. The original frame border folders are not 

deleted.

Show in All Layers
Select a layer with a ruler and select the [Layer] menu > [Ruler/Frame] > [Show in All Layers] to display rulers on all layers. The ruler can be 

snapped to on the following types of layer:

 Raster layer

 Vector layer

 Selection layer

 Quick mask

 Balloon tool (When Balloon pen is selected)

If you select a ruler inside an animation folder and turn on [Show in All Layers], the ruler can only be snapped to 

within the selected cel.

Original frame border folder

Combined common 

 frame border folder
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Show in Same Folder
Select a layer with a ruler and select the [Layer] menu > [Ruler/Frame] > [Show in Same Folder] to display rulers on all layers in the same 

folder. The ruler can be snapped to on layers in the same folder. For layers that can snap to rulers, please see the previous section.

Show Only When Editing Target
Select a layer with a ruler and select the [Layer] menu > [Ruler/Frame] > [Show Only When Editing Target] to display the rulers only on the 

current layer.

Link guide to ruler
Select the [Layer] menu > [Ruler/Frame] > [Link guide to ruler ruler] to link the ruler to the layers created above it.

When turned on, rulers and guides can be moved together with the [Move layer] tool.

File object
A list of commands related to file object layers. File object layers are layers used to load files such as videos and images into Clip Studio Paint.

Unlike standard layers, files such as videos and images remain in their original state when referred to as a file object by Clip Studio Paint.

The original file cannot be changed in Clip Studio Paint, but it can be updated in Clip Studio Paint after opening it and drawing in it separately. 

Standard layers can also be converted to file object layers, allowing you to save them and edit them as separate files.

Convert layer to file object
Converts the selected layer or layers to a file object layer. The selected layers are saved as a separate file in Clip Studio format (ext: clip).

Although the layers are converted to a single file object layer on the original canvas, they will be kept as separate layers in the separately saved 

file. To edit a file object layer, open the Clip Studio format file for the file object.

1 On the [Layer] palette, select the layer to be converted to a file object layer.

2 Select the [Layer] menu > [File object] > [Convert layer to file object].

Files for file object layers are referred to by Clip Studio Paint files. The file object layer will not be displayed cor-

rectly if the save location of the reference file or the file object layer has changed. In this case, re-import the file to 

resolve this issue. For information on importing, see "Change file of file object".

For details on how to import other files as file object layers, see "Create file object" or "Movie".

You can convert multiple layers to a single file object layer by selecting multiple consecutive layers.
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3 In the dialog box that appears, set the area to be converted and the conversion method.

4 In the [Save file object] dialog box, choose where to save the reference file of the file
object layer, then click [Save].

5 The file object layer will be created on the [Layer] palette.
A file object layer icon will be added to the layer.

For details on editing file object layers, see "Open file of file object".
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[Convert layer to file object] dialog box

(1) Area

Specifies the area to be exported in Clip Studio format (extension: clip). The canvas in the created file will be the size of the specified area.

(2) Copy paper settings

Applies the paper settings of the canvas to the file exported as a file object.

(3) Copy crop mark/default border settings

Applies the crop mark and default border settings of the edited canvas to the file exported as a file object.

This can be selected when the [Area] is set to [Canvas Size].

(4) Keep original layer

Keeps the selected layer when creating the file object layer.

Paste as file object
Select the [Layer] menu > [File object] > [Paste as file object] to paste the file or layer saved to the clipboard as a file object layer.

Canvas Size Exports in the same size as the original canvas size.

Drawing area Extracts only the drawn parts of the selected layer to export.

Selection
Extracts only the selected area to export. This option only appears when there is a selection area on 

the canvas.

 When pasting a file in a Clip Studio format file (extension: clip), only the layers copied to the clipboard will be 

drawn. If the timeline is enabled for that layer, you can set the frame to be displayed on the [Tool Property] pal-

ette in the same way as with movie files.

 If the original file or layer is deleted, it cannot be pasted as a file object layer.
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Change file of file object
Use this command to change the reference file of the selected file object layer. The drawn content of the layer can be changed by changing the 

file. If the link to the reference file is broken, this issue can be resolved by relinking the file.

1 Select a file object layer from the [Layer] palette.

2 Select the [Layer] menu > [File object] > [Change file of file object].

3 In the dialog box that appears, select the file for updating and click [Open].

4 The file object layer will change to the content in the selected reference file.

Open file of file object
On the [Layer] palette, select a file object layer. Select [Layer] menu > [File object] > [Open file of file object] to open the original reference 

file and edit the content of the file object layer.

 If the file is in Clip Studio format (extension: clip), a new canvas window will open in Clip Studio Paint, allowing you to edit the file. When 

the reference file is saved, the content of the file object layer will be updated at the same time.

 If the reference file is in a different format, the corresponding software on your device will launch. Changes to the content will not be 

reflected in the file object layer if the file is edited in different software. You will need to manually update the file object layer to reflect the 

changes. For information on how to update, see "Update file object".

Open folder of file object
On the [Layer] palette, select a file object layer. Select [Layer] menu > [File object] > [Open folder of file object] to display the folder contain-

ing the reference file.

This is useful when you want to select the software to open and edit the reference file.

Update file object
Reloads the selected file object layer from the reference file and updates it to the current content.

On the [Layer] palette, select a file object layer. Select [Layer] menu > [File object] > [Update file object] to update the file object with the lat-

est information and reflect any changes made to the reference file.

The status of the reference file of the file object layer can be checked by selecting the file object layer with the 

[Object] tool. The reference file needs to be changed or updated if anything is displayed for [Status] on the [Tool 

Property] palette.

If you select the file object layer using the [Object] tool, you can update the file object layer using [Open file] on 

the [Tool Property] palette.

 It is necessary to update the file object layer to reflect the edited contents of the referenced file. For informa-

tion on how to update, see "Update file object".

 If the file object layer was selected using the [Object] tool, the same operation can also be performed using 

[Open folder] on the [Tool Property] palette.

When you run [Update file object], file object layers edited in other software will also be updated.
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Update all file objects
Select [Layer] menu > [File object] > [Update all file objects] to update all file objects with the latest information and reflect any changes made 

to the reference files.
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Layer settings
The [Layer] menu > [Layer Settings] contains commands for editing settings related to layers.

Set as reference layer
Set the selected layer as a reference layer. When you set a layer as a reference layer, you will be able to use certain tools to select and draw on 

a layer while referring only to this layer.

 

How to set as reference layer
On the [Layer] palette, select the layer you want to use as a reference layer and then select [Layer] menu > [Layer Layer Settings] > [Set as Ref-

erence Layer].

The selected is set as a Reference layer. A lighthouse icon will appear in the [Layer] palette next to layers that are set as reference layers.

Tools that can use the [Reference] layer

[Fill] tool

[Auto select] tool

[Shrink selection] tool

[Fill] tool (Close and fill)

[Fill] tool (Fill leftover areas)

 Select the [Layer] menu > [Layer Settings] > [Set as Reference Layer] again to stop using the layer as a refer-

ence layer.

 You can select multiple layers and assign them as reference layers.

 A layer folder can also be set as a reference layer.

Fill is performed by only referring to

the black line drawing (reference layer).

The icon changes to

when configured as reference layer.
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Set as Draft Layer [PRO/EX]
Select the [Layer] menu > [Layer Settings] > [Set as Draft Layer] to set the selected layer as a draft layer.

Draft layers can be excluded when setting references or exporting files.

 You can choose whether to include draft layers when exporting files with [File] menu > [Save Duplicate] or [Export (Single Layer)].

 You can choose whether to refer to draft layers when creating a selection or using fill tools.

 Select the [Layer] menu > [Layer Settings] > [Set as Draft Layer] again to stop using the layer as a reference 

layer.

 You can assign multiple layers as draft layers.

 Layer folders can also be set as draft layers.

is displayed for a draft layer.
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Clip to Layer Below
Select [Layer] menu > [Layer settings] > [Clip to Layer Below] to limit the shown area of the selected layer to the drawn parts of the layer 

immediately below. Any content on the clipped layer that is outside of the drawn area of the lower layer (above transparent pixels) will not be 

shown. This allows you to add extra details without going outside of the area of the lower layer.

Layers that are clipped to lower layers will have a green bar shown next to the layer thumbnail.

Lock Layer
Select the [Layer] menu > [Layer settings] > [Lock Layer] to lock the selected layer. Locked layers cannot be drawn on or edited.

If you create a new layer below a clipped layer using any of the following methods, the created layer will also be 

clipped.

 Creating a new layer or folder layer

 Inserting a material from the [Material] palette

 Pasting an image

 Creating an image material layer with [File] menu > [Import]

Select the [Layer] menu > [Layer settings] > [Lock Layer] again to unlock the selected layer.

is displayed for a locked layer.
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Lock transparent pixels
Select the [Layer] menu > [Layer settings] > [Lock transparent pixels] to lock transparent pixels on the selected layer. Allows you to draw on 

already drawn areas without going out of the drawn area.

Show Layer
Select the [Layer] menu > [Layer settings] > [View Layer] to view or hide the selected layer. An eye icon is shown on the [Layer] palette next 

to layers that are visible.

Change Layer Name
Allows you to rename the selected layer.

1 On the [Layer] palette, select the layer you want to rename.

2 Select the [Layer] menu > [Layer Settings] > [Change Layer Name].

3 Enter the new name in the [Change Layer Name] dialog box then, click [OK] to change its
name.

4 Changes the name of the selected layer to the name set in the dialog box.

is displayed for a locked layer.
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Display palette colors in parent folder [PRO/EX]
When a palette color is specified for a layer, the specified color will also be shown by the parent layer folder.

Select the layer with a specified palette color, then go to the [Layer] menu > [Layer Settings] > [Display palette colors in parent folder] to tog-

gle whether the palette color is shown.

Display palette colors on canvas [PRO/EX]
Select the [Layer] menu > [Layer Settings] > [Display palette colors on canvas] to fill the canvas with the specified palette color.

The palette color will be shown at half the opacity of the layer itself. If the opacity of the layer is changed, the opacity of the palette color will 

adjust accordingly.

The displayed palette color will not appear in exported files.

Advanced Settings
Select the [Layer] menu > [Layer Settings] > [Advanced Settings] to edit settings for tonal correction layers and fill layers.

 When selecting a tonal correction layer, a dialog box for editing tonal correction effects will appear.

 When selecting a fill layer, the [Color settings] dialog box will appear.

 If the parent folder is already showing the palette color of a higher layer than the selected layer, the palette 

color will not be shown by the parent folder.

 For details on how to change the palette color, see "Functions of Layer Palette".

 If you hide the layer or select a frame in the [Timeline] palette that does not include the layer, the palette color 

will be hidden.

 For details on how to change the palette color, see "Functions of Layer Palette".

 For details on the dialog box for tonal correction, see "New Correction Layer [PRO/EX]".

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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Selection from Layer
Select the [Layer] menu > [Selection from Layer] to create a selection of the drawn parts on the current layer.

Create Selection
Creates a selection from the drawn parts on the current layer.

Add Selection
Creates a selection from the drawn parts on the current layer and adds it to an existing selection area.
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Delete Selection
Creates a selection from the drawn parts on the current layer and removes that portion from an existing selection area.

Select Overlapping Area
Creates a selection area from a drawing on the current layer in areas that overlap with the existing selection area.
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Rasterize
Select a layer in the [Layer] palette, then go to the [Layer] menu > [Rasterize] to convert the selected layer to a raster layer.

Convert layer [PRO/EX]
Converts a layer into a different layer type. You can also change the type and expression color of a layer, as well as convert a drawing inside a 

selected area into an image material layer.

1 On the [Layer] palette, select the layer you want to change.

2 Select the [Layer] menu > [Convert Layer].

For layers with [Enable keyframes on this layer] active, the currently selected frame in the [Timeline] palette will be 

rasterized as it is is currently shown. After converting, the keyframes included in the track (layer) will be deleted 

and a clip will be created from the start to the end frame.

 When you rasterize a frame border folders, a raster layer with border lines and a layer folder containing masks 

in the shape of the frames will be created.

 Selecting [Rasterize] on a raster layer with layer effects added will convert the layer to a raster layer with the 

layer effects applied.

For layers with [Enable keyframes on this layer] active, keyframes included in the track (layer) are deleted. A clip 

is created from start to end frame.
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3 In the dialog box that appears, edit the settings for the layer.

(1) Set the layer type, expression color, and blending mode.

(2) Click [OK].

4 Click [OK] to convert the layer according to the settings.
If multiple layers are selected, they will be combined into one layer.

 When converting to a vector layer, you can adjust advanced settings by clicking [Vector settings]. For details, 

see "[Vector layer conversion settings] Dialog Box".

 For layers with [Enable keyframes on this layer] active and [Keep Timeline] selected in the [Convert Layer] dia-

log box, layers can be converted while keyframe settings are still active. For details, please refer to "[Convert 

layer] Dialog Box".
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[Convert layer] Dialog Box

(1) Type

Choose the layer type after conversion.

Raster Layer

Converts the selected layer into a raster layer.

Vector layer

Converts the selected layer into a vector layer.

Image material layer

Converts the selected layer into an image material layer.

The available layer types depend on the selected layer.

When converting multiple layers to vector layers, they are converted as follows.

 Layers with layer masks will be converted without the layer mask.

 Layers with tone or edge effects added in the [Layer Property] palette are converted without the effects.

 Layers with a the layer color set in the [Layer property] palette, will be converted to the specified layer color.

Converting into [Color] a [Gray] or [Monochrome] vector layer drawn with a color brush tip will not show the lines 

in black or gray, but in the color set for the brush tip.

If you convert the image while there is a selection area on the canvas, only the area inside the selection will be 

converted into a layer.

Expression color: Color

Expression color: Gray and Monochrome
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Vector image material layer

Converts the selected layer into an image material layer (including vector images).

A vector image material layer has the following characteristics:

 It is a layer that can have both raster images and vector images.

 Vector images included in the layer can be scaled up or down without losing image quality. However, they cannot be edited.

You can only convert to a vector image material layer when the selected layers include a vector layer. However, if the vector layer includes 

a layer mask, it will be converted without the layer mask.

Frame border folder

Allows you to change the expression color of selected frame border folders.

Balloon layer

Allows you to change the expression color of selected balloon layers.

Text layer

Allows you to change the expression color of selected text layers.

Stream line layer 

Allows you to change the expression color of selected stream line layers.

Saturated line layer 

Allows you to change the expression color of selected saturated line layers.

(2) Name

Sets a converted layer’s name.

(3) Expression color

Set the default expression color. You can choose from [Color], [Gray], or [Monochrome].

Depending on the selected layers, the order in which the layers are stacked may not be the same as before the 

conversion. For details, see "Vector image material layer conversion order".

If you convert the image while there is a selection area on the canvas, only the area inside the selection will be 

converted into a layer.

The expression color [Monotone] from Ver.1.2.1 and earlier will be converted into the following [expression color] 

and [drawing color].

 Expression color: Gray

 Drawing color: Only black
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(4) Drawing colors

Set the drawing colors when using [Gray] or [Monochrome] basic expression colors. You can set the drawing colors using the black and 

white square icons.

Gray

You can set drawing colors in the following ways with the black and white buttons.

Monochrome

You can set drawing colors in the following ways with the black and white buttons.

(5) Blending Mode

Set how to combine the colors with other layers.

(6) Keep original layer

When turned on, a copy of the original layer will be kept after converting the layer.

(7) Keep timeline

Set whether or not to keep the [Timeline] palette settings for layers with [Enable keyframes on this layer] turned on.

When active, layers can be converted while maintaining keyframe and clip settings contained in the track (layer) on the [Timeline] palette.

When inactive, keyframe and clip settings contained in a track (layer) on the [Timeline] palette are erased. Clips are created from start to 

end frame. The converted state shows according to the display state of the selected frame on the [Timeline] Palette.

[Drawing color] only appears when the expression color is set to [Gray] or [Monochrome].

Only black The drawing colors will be grayscale from black to transparency.

Only white The drawing colors will be grayscale from white to transparency.

Both black and white The drawing colors will be grayscale from black to white.

Only black The drawing colors will be black and transparency only.

Only white The drawing colors will be white and transparency only.

Both black and white The drawing colors will be black, white, and transparency only.

For details on expression colors and drawing colors, see "Explanation: Expression Color and Drawing Color".

When executing [Convert Layers] with the following options, the [Keep timeline] setting is set to OFF. When con-

verting, keyframe and clip settings in a track (layer) on the [Timeline] are deleted.

 Image material layers or file object layers are converted into any other layer type.

 A vector image material layer is converted into any other layer type.

 Convert to image material layers or vector image material layers. This does not apply when converting from 

image material layers, vector image material layers, or file object layers.

 Layers inside an animation folder are converted into a different layer type.

 Converting layer folders or frame border folders

 Selecting multiple layers to convert.

As an exception, when converting from a frame border folder to a frame border folder, [Keep timeline] remains on.
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(8) Vector settings

When [Vector Layer] is set to [Type], clicking this opens the [Vector layer conversion settings] dialog box. On the dialog box, you can con-

figure detailed settings when converting to a vector layer. For details on the [Vector layer conversion settings] dialog box, see "[Vector 

layer conversion settings] Dialog Box".

[Vector layer conversion settings] Dialog Box

(1) Maximum line width

Sets the maximum line width of a converted vector line.

Any line from the original image that is thicker than the specified value is recognized as a fill color, and only the surrounding vector lines 

are created.

(2) Correction

Sets the number of control points after conversion.

The larger the value, the less the number of the control points after the conversion, resulting in a simplified vector line.

(3) Export all in black

Turning this on converts vector lines to black.

Turning this on creates a vector line per RGB value of the original image.

(4) Include white in conversion

A pixel of all RGB values set to 255 is not converted into a vector line when turned off.

(5) Anti-aliasing

Allows you to set the strength of anti-aliasing of a converted vector line. You can select from [None], [Weak], [Middle], or [Strong].

(6) Density threshold

Sets the border value of opacity for pixels to be converted into a vector line.

Pixels with higher opacity than the set value will be converted into a vector line.

The unit for [Maximum line width] can be changed in [Preferences]. For details, see "Ruler/Unit".

When [Export all in black] is turned off and the number of colors of the original image exceeds 16, it cannot be 

converted into a vector layer.

If [Export all in black] is turned on, while [Include white in conversion] is turned off, pixels larger than the value of 

[Density threshold] in both opacity and brightness are converted into a vector line.
CLIP STUDIO PAINT Instruction Manual 564



Menus > Layer Menu > Convert layer [PRO/EX]
Vector image material layer conversion order
When converting into a vector image material layer, all layers other than vector layers are merged, and then, the vector layers stacked above it. 

For this reason, when raster layers are stacked above vector layers as shown in the figure below, the order in which layers are stacked change 

after layer conversion.

Layer 4
(Raster layer)

Layer 3
(Vector layer)

Layer 3
(Vector layer)

Layer 4
(Raster layer)
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LT conversion of layer [EX] 
Allows you to separate a selected layer into lines and tones created on separate layers.

[LT conversion of layer] can be used on the following layers.

Applicable layers

Raster layer

Vector layer

Balloon layer

Text layer

Image material layer

3D layer

Saturated line layer

Stream line layer

For layers with [Enable keyframes on this layer] active, [LT conversion of layer] will be run on the image shown as 

the currently selected frame on the Timeline. After converting, the keyframes included in the track (layer) will be 

deleted and a clip is created from the start to the end frame.

You can also convert a layer to lines and tones by selecting the [Layer Property] palette > [Extract line] > [Execu-

tion of LT conversion of layer]. For details on how to convert to lines and tones with the [Layer Property] palette, 

see "Extract line [EX]".

Original image After LT conversion of layer
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1 Select the layer you want to separate into lines and tones.

2 Select [Layer] menu > [LT conversion of layer] to open the dialog box.

3 Then, adjust the settings for the conversion to lines and tones.

(1) Set the method for extracting the lines, layers for the extracted lines, depth of the lines, and so on.

(2) Select the method for extracting the texture of the lines.

(3) Set posterization and the tone pattern.

(4) Click [OK].

 When selecting a 3D layer, be sure to check the layout and camera angle of the 3D material before converting. 

To learn about these settings, see "Explanation: 3D Materials".

 When converting a 3D material for ComicStudio, such as an LWO-format material without texture, turn on 

[Light Source] in the [Tool Property] palette.
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4 The layer will be converted into lines and tones, and a layer folder will be created with the
new layers.
The created line and tone layers are stored in the new layer folder separate from the original layer. The original layer is kept but hidden.

 Turn on [Preview] to preview the settings on the canvas.

Settings for the tone pattern, frequency, and angle will not be reflected in the preview.

 Please note the turning on [Preview] may slow down your computer. Hold Esc to stop the preview.

 The settings in the dialog box differ if the layer to be converted is a 3D layer.

 For details on setting the [LT conversion of layer] dialog box, see "[LT conversion of layer] Dialog Box (3D 

Layer)" and "[LT conversion of layer] Dialog Box (Not 3D Layer)".

 The conversion will create a tone layer for each gradient level specified under [Posterization] in the [LT con-

version of layer] dialog box.

 When converting from a 3D layer, two types of outline layers will be created: one extracted from the 3D mate-

rial shape, and another from the texture.

Layer before conversion

The layer is separated 

into outlines and tones 

before the conversion
CLIP STUDIO PAINT Instruction Manual 568



Menus > Layer Menu > LT conversion of layer [EX]
[LT conversion of layer] Dialog Box (3D Layer)
When converting from a 3D layer, the following settings will appear.

A. Extract line
Adjust settings for extracting the lines from the 3D layer.

(1) Output layer

Choose whether to extract the lines to a raster layer or a vector layer. You can select from [Raster layer] and [Vector layer].

(2) Line width

Set the width of the outlines.

(3) Accuracy of detection

Adjust the accuracy with which to detect the lines.

(4) Adjust precision to the scene dimension

Turning this on allows the precision with which outlines are detected to be automatically adjusted according to the size of 3D materials.

If the selected layer is not a 3D layer, see "[LT conversion of layer] Dialog Box (Not 3D Layer)".

[Adjust precision to the scene dimension] cannot be set when a 3D layer compatible with Version 1.5 is selected.

A

B

C

D

E

F

G

H

I

J

K

L
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(5) Enhancement degree of outer line

Allows you to set the degree by which the outer lines will be enhanced.

B. Depth
Turn on this option to give depth to the outlines. You cannot set [Depth] when [Process of edge detection 2] is set for [Process of edge 

detection].

(1) Line width

You can adjust line width by operating the graph. The larger the difference between the upper limit and lower limit of the [Front] and 

[Back], the larger the line depth will be.

(2) Reset

Resets the [Depth] settings to default.

(3) Apply only to outer line

When turned on, the [Depth] settings apply only to the outermost lines.

C. Smooth
Turn this on to smooth the outlines of 3D layers. A larger [Level] value makes the outline smoother.

D. Extract line of texture
When turned on, the texture of the 3D layer is also a target of the conversion.

You can set a finer line width by editing the control points of the graph. Below are instructions on editing graphs.

 Drag a control point to change its position.

 Click on the curve to add a control point.

 To delete a control point, drag it outside the graph.

Increasing the [Level] value for smoothing may create gaps between the outline and lines extracted from tone or 

from texture in 3D materials.

If [Extract line] on the [Layer property] palette is turned on, you can inherit the settings for [Extract line] to these 

following items: [Extract line of texture], [Posterize before extracting lines], [Threshold of fill in black], [Correction 

line width], and [Method of detecting edge].
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E. Extract after posterization
When turned on, the texture is posterized before the outline is extracted. The gradient can be adjusted using [Posterization control].

Posterization control

Adjust the grayscale gradient to extract as outline.

(1) Density

Shows the grayscale value. Clicking the numeric value allows you to change it directly.

(2) Preview

Previews the posterization.

(3) Node

This is a controller that adjusts the grayscale gradient. Dragging the node horizontally allows you to adjust the density of the  gradient. 

Drag a node out of [Posterization control] deletes it. Clicking on a blank area allows you to add a node.

F. Black fill threshold
Allows you to set up an area to be filled in black. You can set the threshold using the slider.

G. Correction line width
Allows you to adjust the width of the texture outline using a slider.

H. Process of edge detection
Allows you to select the method for extracting texture. The items to set will vary depending on the method selected.

(1) Threshold of edge

Set the gray density threshold to extract as outline. The smaller the value, the more lines will be detected making the line art wider.

(2) Direction of detection

Specify the direction in which to detect the outline. If turned off, outline detection is weaker.

(3) Threshold of edge height

Allows you to adjust the height of the edge detected as an outline. The smaller the value, the weaker the edge, making even small changes 

detected as a line.

(4) Threshold of gradient variation

Adjusts the continuity of the detected line art based on the variation in the the line’s thickness. The larger the value, the more likely it is to 

have short segments.

Process of edge 

detection 1
The outline is extracted based on [Threshold of edge] and [Direction of detection].

Process of edge 

detection 2

The outline is extracted based on [Threshold of edge height] and [Threshold of gradient variation].

This method is suitable when a more delicate expression is required.

Process of edge detection 1 Process of edge detection 2
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I. Tone work
When turned on, you can set the tone.

J. Posterization
When turned on, you to adjust the density of the tone using [Posterization control].

Posterization control

Adjusts the density of the tones.

(1) Density

Shows the density of the tone numerically. Clicking the numeric value allows you to change it directly.

(2) Preview

Previews the posterization.

(3) Node

A controller to adjust the gradient of the tone density.

 Dragging the node horizontally allows you to adjust the gradient range reflecting the density of the tone.

 Dragging a node out of the [Posterization control] allows you to remove it.

 Clicking on a blank area allows you to add a node.

K. Type
Allows you to select a tone type and set it. The available settings depend on the selected tone type.

(1) Type

Select the pattern for the screentone. You can choose from: Circle, Square, Lozenge, Line, Cross, Ellipse, Noise, Sugar plum, Asterisk, 

Star, Carrot, Cherry (round), Cherry (mid), Cherry (thin), Flower (round), Flower (mid), Flower (thin), Clover (round), Clover (thin), 

Ninja star, Diamond, Heart, Clubs, and Spades.

(2) Frequency 

Specify the number of screentone lines per inch.

(3) Angle 

Set the angle of the tones.

If [Tone] on the [Layer Property] palette is turned on, you can inherit the settings for [Tone].

The [Type] setting cannot be previewed on the canvas.

Normal cases Type: Noize
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(4) Size 

Set the size of the noise. This setting is only available when [Noise] is selected under [Type].

(5) Factor 

Specify the noise factor. This setting is only available when [Noise] is selected under [Type].

L. Preview
Turn this on to preview the results on the canvas.

」

[LT conversion of layer] Dialog Box (Not 3D Layer)
Set the following items to a selected layer (Except 3D Layers)

 The [Type] setting cannot be previewed on the canvas.

 Turning on [Preview] may slow down your computer. To exit the preview, long press Esc.

 If the selected layer is a 3D layer, see "[LT conversion of layer] Dialog Box (3D Layer)".

 If [Extract line] on the [Layer Property] palette is turned on, you can inherit the [Extract line] settings to each of 

the following items: [Posterize before extracting lines], [Threshold of fill in black], [Correction line width], and 

[Method of detecting edge].

A

B

C

D

E

F

G

H
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A. Posterize before extracting lines
When turned on, the original layer is posterized before outline extraction. The gradient can be adjusted using [Posterization control].

Posterization control

Adjust the grayscale gradient to extract as outline.

(1) Density

Shows the grayscale value. Clicking the numeric value allows you to change it directly.

(2) Preview

Previews the posterization.

(3) Node

This is a controller that adjusts the grayscale gradient.

 Dragging the node horizontally allows you to adjust the gradient range reflecting the density.

 Dragging a node out of the [Posterization control] allows you to remove it.

 Clicking on a blank area allows you to add a node.

B. Black fill threshold
Allows you to set up an area to be filled in black. You can set the threshold using the slider.

C. Correction line width
Allows you to adjust the width of the outline using the slider.

D. Method of detecting edge
Allows you to select the method for extracting the outline. The items to set will vary depending on the method selected.

(1) Threshold of edge

Set the gray density threshold to extract as outline. The smaller the value, the more lines will be detected making the outline wider.

(2) Direction of detection

Specify the direction in which to detect the outline. If turned off, outline detection is weaker.

(3) Threshold of edge height

Allows you to adjust the height of the edge and detect it as an outline. The smaller the value, the weaker the edge, making even small 

changes detected as a line.

(4) Threshold of gradient variation

Adjusts the continuity of the detected outline based on variation in thickness. The larger the value, the more likely it is to have short seg-

ments.

Process of edge 

detection 1
The outline is extracted based on [Threshold of edge] and [Direction of detection].

Process of edge 

detection 2

The outline is extracted based on [Threshold of edge height] and [Threshold of gradient variation].

This method is suitable when a more delicate expression is required.

Process of edge detection 1 Process of edge detection 2
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E. Tone work
When turned on, you can set the tone.

F. Posterization
When turned on, you to adjust the density of the tone using [Posterization control].

Posterization control

Adjusts the density of the tones.

(1) Density

Shows the density of the tone numerically. Clicking the numeric value allows you to change it directly.

(2) Preview

Previews the posterization.

(3) Node

A controller to adjust the gradient of the tone density.

 Dragging the node horizontally allows you to adjust the gradient range reflecting the density of the tone.

 Dragging a node out of the [Posterization control] allows you to remove it.

 Clicking on a blank area allows you to add a node.

G. Type
Allows you to select a tone type and set it. The available settings depend on the selected tone type.

(1) Type

Select the pattern for the screentone. You can choose from: Circle, Square, Lozenge, Line, Cross, Ellipse, Noise, Sugar plum, Asterisk, 

Star, Carrot, Cherry (round), Cherry (mid), Cherry (thin), Flower (round), Flower (mid), Flower (thin), Clover (round), Clover (thin), 

Ninja star, Diamond, Heart, Clubs, and Spades.

(2) Frequency 

Specify the number of screentone lines per inch.

(3) Angle 

Set the angle of the tone pattern.

 If [Tone] on the [Layer Property] palette is turned on, you can inherit the settings for [Tone].

The [Type] setting cannot be previewed on the canvas.

Normal cases Type: Noize
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(4) Size 

Set the size of the noise. This setting is only available when [Noise] is selected under [Type].

(5) Factor 

Specify the noise factor. This setting is only available when [Noise] is selected under [Type].

H. Preview
Turn this on to preview the results on the canvas.

」

 The [Type] setting cannot be previewed on the canvas.

 Turning on [Preview] may slow down your computer. To exit the preview, long press Esc.
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Transfer To Lower Layer 
This transfers the content on the selected layer to the layer immediately below.

Select [Layer] menu > [Transfer To Lower Layer] to transfer the content of the selected layer to the layer immediately below.

 You can transfer images from vector layers to raster layers. In this case, the image is will be rasterized and 

then transferred.

 [Transfer To Lower Layer] cannot be used if [Enable keyframes on this layer] is turned on for either the cur-

rently selected layer or the lower layer.

Transfer to lower layer
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Merge with layer below
Select [Layer] menu > [Merge with layer below] to combine the selected layer and the layer immediately below into one layer.

Merge selected layers
Select [Layer] menu > [Merge selected layers] to combine the selected layers into one layer. This is useful when you want to combine an image 

drawn over several layers.

When merging layers while [Enable keyframes on this layer] is turned on, the layers will be merged as they appear 

on the selected frame on the Timeline. After combining, the keyframe included in the track (layer) is deleted and a 

clip is created from the start to the end frame.

 Vector layers will be converted to raster layers after combining. If combining two vector layers, the combined 

layer will also be a vector layer.

 When only a [Text] layer and a [Balloon] layer are merged, the resulting layer is not converted into a [Raster] 

layer. This also applies when only [Text] layers or [Balloon] layers are combined.

 When a layer including a ruler is combined, the ruler will be applied to the layer after combining.

 When only a layer folder is selected, layers within the layer folder will be combined and converted into one 

layer.

 If a [Layer Mask] is applied to a lower layer, the confirmation message [Do you want to apply mask before com-

bining?] will be displayed. Selecting [Apply] will combine the layers after applying the mask to the lower layer. 

Selecting [Maintain] keeps the layer mask and applies it to layer after combining.
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Merge visible layers
Select [Layer] menu > [Merge visible layers] to combine all visible layers into one layer. Hidden layers are not combined and are left as they 

are.

 The layers must be consecutive in the [Layer] palette.

 When merging layers while [Enable keyframes on this layer] is turned on, the layers will be merged as they 

appear on the selected frame on the Timeline. After combining, the keyframe included in the track (layer) is 

deleted and a clip is created from the start to the end frame.

 Vector layers will be converted to raster layers after combining. If combining two vector layers, the combined 

layer will also be a vector layer.

 When only a [Text] layer and a [Balloon] layer are merged, the resulting layer is not converted into a [Raster] 

layer. This also applies when only [Text] layers or [Balloon] layers are combined.

 When a layer including a ruler is combined, the ruler will be applied to the layer after combining.

When merging layers while [Enable keyframes on this layer] is turned on, the layers will be merged as they appear 

on the selected frame on the Timeline. layer After combining, the keyframe included in the track (layer) is deleted 

and a clip is created from the start to the end frame.

 Locked layers can also be combined.

 After combining, the layer will be converted into a raster layer.

 When a layer including a ruler is combined, the ruler will be applied to the layer after combining.
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Merge visible to new layer 
Select [Layer] menu > [Merge visible to new layer] to copy all visible layers and merge them into one layer. The original layers are kept as they 

are.

Flatten image
Select [Layer] menu > [Flatten image] to combine all layers into one layer.

When merging layers while [Enable keyframes on this layer] is turned on, the layers will be merged as they appear 

on the selected frame on the Timeline. After combining, the keyframe included in the track (layer) is deleted and a 

clip is created from the start to the end frame.

 Locked layers can also be combined.

 After combining, the layer will be converted into a raster layer.

When merging layers while [Enable keyframes on this layer] is turned on, the layers will be merged as they appear 

on the selected frame on the Timeline. After integrating, the keyframe included in the track (layer) is deleted and a 

clip is created from the start to the end frame.

 Locked layers can also be combined.

 After combining, the layer will be converted into a raster layer.

 When a layer including a ruler is combined, the ruler will be applied to the layer after combining.
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Layer Order [PRO/EX]
Select the [Layer] menu > [Layer Order] to change the order of the selected layer.

Top
Moves the selected layer to the top.

Up
Moves the selected layer up by one place.

Down
Moves the selected layer down by one place.
CLIP STUDIO PAINT Instruction Manual 581



Menus > Layer Menu > Change Selected Layer [PRO/EX]
Bottom
Moves the selected layer to the bottom.

Change Selected Layer [PRO/EX]
Select the [Layer] menu > [Change Selected Layer] to open commands for changing the current layer.

Layer Above
Switches to the layer above the current layer.

Layer Below
Switches to the layer below the current layer.
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 Select Menu
The [Selection] menu contains items for operating selected items and areas. This section describes the commands in
the [Selection] menu.

Select All
Select the [Select] menu > [Select All] to select the entire canvas.

Deselect
Select the [Select] menu >[Deselect] to deselect a selection area.

Reselect
Select the [Select] menu >[Reselect] to select a selection area that was deselected.

Invert selected area
Select the [Select] menu > [Invert selected area] to invert the selected area.
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Expand Selected Area 

1 Using a selection tool, create a selection.

2 Select the [Select] menu > [Expand Selected Area].

3 In the dialog box that appears, adjust the [Expansion width] and [Expansion type], then
click [OK].

 

4 The selected area will expand by the specified amount.
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[Expand selected area] Dialog Box

(1) Expansion width

Specify the width by which to expand the selected area.

(2) Expansion type

Select how to process the corners when expanding from each type.

Shrink Selected Area

1 Using a selection tool, create a selection.
 

2 Select the [Select] menu > [Shrink Selected Area].

3 In the dialog box that appears, adjust the [Shrinking width] and [Shrinking type], then click
[OK].

 

The unit for [Expansion width] can be changed in [Preferences]. For details, see "Ruler/Unit".
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Menus > Select Menu > Shrink Selected Area
4 The selected area will shrink by the specified width.
 

[Shrink selected area] Dialog Box
 

(1) Shrinking width

Specify the width by which to shrink the selected area.

(2) Shrinking type

Select how to process the corners when reducing from each type.

(3) Shrink at edge of canvas

Turning on this checkbox allows you to shrink the selected area even when it is on the canvas edge.

The unit for [Shrinking width] can be changed in [Preferences]. For details, see "Ruler/Unit".
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Blur border [PRO/EX]

1 Using a selection tool, create a selection.

2 Select the [Select] menu > [Blur border].

3 Adjust the settings in the [Blur border] dialog box and click [OK].

4 The borders in the selected area will be blurred.
If you fill the selected area, the border of the selected area will be blurred.

The unit for [Strength] can be changed in [Preferences]. For details, see "Ruler/Unit".
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Select Color Gamut [PRO/EX]
Creates a selection of a specific color.

The following example shows how to select only the purple areas of a character in a file with the following layers.

1 On the [Layer] palette, select the layer to make a selection from.
In this example, we select the character layer.

2 Select the [Select] menu > [Select Color Gamut].

[Background] [Character]
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Menus > Select Menu > Select Color Gamut [PRO/EX]
3 In the dialog box that appears, edit the settings for the selection color.

(1) Turn on [Refer multiple] and set which layers to refer to create the selection. In this example, we set it to [All layers].

(2) Click the canvas to specify the color.

(3) Adjust the error margin of the color to adjust the selected area.

(4) Click [OK].

4 A selection area of the specified color will be created.
In this example, all purple areas on all layers have been selected.
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[Select Color Gamut] Dialog Box

(1) Error margin of color

Set the error margin of color for the target color. A larger value increases the error margin to include colors other than the specified color.

(2) Selection type

Set how to create a selection when there is already a selection area on the canvas.

(3) Refer multiple

You can set the layers to refer to.

(4) Reset

Resets the current selection.

A. New selection Creates a new selection.

B. Add to selection Adds a selection to the existing selection area.

C. Delete from selection Erases the selection from the existing selection area.

All layers Refer to all layers. However, hidden layers cannot be referred to.

Reference layer Refers to layers set as reference layers.

Selected layer Refers to all layers that are currently selected in the [Layer] palette.

Layer in folder
Refers to layers within the layer folder. The layer to refer to must be in the same folder as the 

layer currently being edited.

If [Refer multiple] is turned off, only the current layer is referred to.

A B C
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Select Overlapping Vectors [PRO/EX]
Selects vector lines as a whole even if only part of the vector path falls within the selection area.

1 Select the vector layer on the [Layer] palette, then create a selection area with a selection 
tool.

2 Select the [Select] menu > [Select Overlapping Vectors].
This will select all vector lines with vector paths in the selection area.

When you select a vector line, the sub tool will switch to the [Object] sub tool.
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Select Vectors Within Area [PRO/EX]
Selects only the vector lines that fall completely within the selection area.

1 Select the vector layer on the [Layer] palette, then create a selection area with a selection 
tool.

2 Select the [Select] menu > [Select Vectors Within Area].
This will select all vector lines that fall entirely within the selection area.

-

When you select a vector line, the sub tool will switch to the [Object] sub tool.
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Quick Mask [PRO/EX]
You can use Quick Masks to create selection areas with drawing tools. This allows you to easily create selections with complex shapes while 

checking the image.

1 Select the [Select] menu > [Quick Mask] to turn on the menu item.
Creates a [Quick Mask] in the [Layer] palette.

2 With a drawing tool, draw the selection on the quick mask.
The selection is displayed in red.

3 In the [Select] menu, select [Quick Mask] again to remove the check mark and create a
selection area from the quick mask.
Creates a [Quick Mask] from the selection. Deletes the [Quick mask].

Drawn selection areas are

displayed in red.
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Convert to Selection Layer [PRO/EX]
Create a selection area with a selection tool, then select the [Select] menu > [Convert to Selection Layer]. The selection area will be stored on a 

newly created selection layer.

The selection area is shown in green above the canvas. Creates a Selection layer is created in the [Layer] palette.

You can draw on the created selection layer to edit the selected area.

 For information on how to convert a saved selection layer into a selection, see "Convert Selection Layer to 

Selection [PRO/EX]".

 A [Selection] layer can be shiwn or hidden using the [Show/Hide layer] icon on the [Layer] palette.
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Convert Selection Layer to Selection [PRO/EX] 
Select the [Select] menu > [Convert Selection Layer to Selection] option to convert the selection layer back to a selection. Creates a selection 

from a Selection layer.

For details on how to create a selection layer, see "Convert to Selection Layer [PRO/EX]".
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 View Menu
The [View] menu contains items you can adjust to alter the way the canvas is shown. This section describes the com-
mands in the [View] menu.

Rotate/Invert
The [View] menu > [Rotate/Invert] section includes commands for changing how the canvas can be viewed. The following actions can now use 

[Rotate/Invert].

Zoom in
Select the [View] menu > [Zoom in] to make part of the canvas appear larger.

Zoom out
Select the [View] menu > [Zoom Out] to make part of the canvas appear smaller.

100%
Select the [View] menu > [100%] to view the image pixels at a 1:1 ratio to the screen pixels.

200%
Select the [View] menu > [200%] to view the image pixels at double their size (a 1:2 ratio).

Reset rotation/inversion Resets a rotated or inverted view to its original angle.

Reset Rotation Resets the viewing angle to 0 degrees.

Rotate 90 Rotates the view by 90 degrees.

Rotate 180 Rotates the view by 180 degrees.

Rotate 270 Rotates the view by 270 degrees.

Flip Horizontal Reverses the view horizontally.

Flip Vertical Reverses the view vertically.

Rotate Left Rotates the view to the left by a defined angle.

Rotate Right Rotates the view to the right by a defined angle.

The rotation steps for [Rotate Left] and [Rotate Right] can be set in [Preferences] > [Canvas] > [Angle]. For details, 

see "Canvas". 

You can change the zoom increments in [Preferences] > [Canvas] > [Scale]. For details, see "Canvas". 

You can change the zoom increments in [Preferences] > [Canvas] > [Scale]. For details, see "Canvas". 
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Fit to Screen
Select the [View] menu > [Fit To Screen] to adjust the size of the canvas so that the entire canvas is visible on the screen.

Reset Display
Select [View] menu > [Reset Display] to reset the zoom, position, angle, and inversion of the canvas and view the entire canvas. 

Fit to navigator
Select the [View] menu > [Fit to navigator] to toggle whether the canvas size adjusts with the size of the [Canvas] window.

When this is turned on, the entire canvas will be shown in the [Canvas] window. When the size of the [Canvas] window is adjusted, the canvas 

itself will change size accordingly.

Print size
Select the [View] menu > [Print size] to view the canvas at its actual print size.

 You need to set a display resolution in order to display at print size.

 If a display resolution has not been set, a message will appear to prompt you to set the display resolution. 

Click [OK] to open the [Settings of display resolution] dialog box and add a display resolution. For details on 

the [Settings of display resolution] dialog box, see "[Settings of display resolution] dialog box".

 You can also set the display resolution in [Preferences] > [Canvas].
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Scroll Bar
Select the [View] menu > [Scroll Bar] to hide or display the scroll bar at the side of the [Canvas] window. This also displays or hides the canvas 

controls next to the horizontal scroll bar.

Selection Border
Select the [View] menu > [Selection Border] to show or hide the selection border.

Scroll bar

Canvas control

[Selection Border] ON[Selection Border] OFF
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Menus > View Menu > Selection Launcher
Selection Launcher
Select the [View] menu > [Selection Launcher] to show or hide the Selection Launcher.

Selection Launcher Settings [PRO/EX] 
Create a selection area on the canvas, then select the [View] menu > [Selection Launcher Settings].

In the dialog box that appears, you can add or delete command icons on the [Selection Launcher], change icon positions or images, and change 

the hierarchy of icons. For details, see "Configuring the Selection Launcher Settings [PRO/EX]".

Transform launcher
Select the [View] menu > [Transform launcher] to show or hide the Transform launcher. The Transformation Launcher will appear when select-

ing an item with [Edit] > [Transform].

Text launcher [Windows/macOS/iPad/Android/Chromebook]
Select the [View] menu > [Text launcher] to show or hide the Text launcher.

For details on the Selection launcher, see "Selection Launcher".

You need to take the following steps to open the [Selection Launcher Settings] dialog box.

 Create a selection on the canvas.

 If the Selection Launcher does not appear, select the [View] menu > [Selection Launcher].

For details on the Text Launcher, see "Text launcher".
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Object Launcher
Select the [View] menu > [Object Launcher] to show or hide the Object Launcher. The [Object launcher] pops up when selecting a 3D material.

Grid [PRO/EX]
Select the [View] menu > [Grid] to show or hide the grid.

For details on the Object Launcher, see "Operations Using the Object Launcher".

 The color and opacity of the grid lines can be adjusted in the [Preferences] dialog box. For details, see "Ruler/

Unit".

 You can adjust the origin, spacing, and divisions of grid lines from the [View] menu > [Grid/Ruler Settings]. For 

details, see "Grid/Ruler Settings [PRO/EX]".

 Turning on [View] menu > [Snap to Grid] to make drawing tools snap to the grid lines.

Grid: On Grid: Off
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Ruler [PRO/EX]
Select the [View] menu > [Ruler] to show or hide the canvas rulers.

Drag the Ruler onto the canvas to create a Guide. You can drag a Guide outside of the canvas with the [Object] 

sub tool to delete it.

Rulereeeeeeeeeeeeeeeeeeeeeereeeeeeeeeeeeeeeeeeeeeeeerrrr
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Grid/Ruler Settings [PRO/EX]
Select the [View] menu > [Grid/Ruler Settings] to open the dialog box. In this dialog box, you can set the origin of grid lines and rulers, and the 

spacing and number of divisions of the grid.

[Grid/Ruler Settings] Dialog Box

(1) Original point of grid ruler

You can set the origin point of grid lines and rulers. Select a position from [Top left], [Bottom left], [Center], [Top right], [Bottom right], 

and [Custom]. Select [Custom] to specify a numerical value for the origin position.

(2) Gap

Adjust the space between the main grid lines.

(3) Number of divisions

Adjust the number of divisions between the main grid lines.

Crop mark/Default border [PRO/EX]
Select the [View] menu > [Crop mark/Default border] to show or hide the crop marks and default border.

When working in an animation file (selected as [Animation] in the [New] dialog box), this shows or hides the output frame, title-safe area, and 

overflow frame.
」

 The unit for setting grids and rulers is the [Unit] that was set when creating the canvas.

 If you change the unit using [Change Image Resolution] or [Change Canvas Size] in the [Edit] menu, the unit 

for configuring grids and rulers will also change.

When configuring, the origin position is previewed as a red cross (x) on the canvas. You can adjust the origin 

point by dragging the red cross.

For details on crop marks and the default border, see "Explanation: What Are the Default Border, Cropped Border 

and Bleed Border? [PRO/EX]".
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Menus > View Menu > Crop mark/Default border settings [PRO/EX]
Crop mark/Default border settings [PRO/EX]
Select the [View] menu > [Crop mark/Default border settings] to open the [Crop mark/Default border settings] dialog box. In the dialog box, 

you can edit crop mark and default border settings.

[Crop mark/Default border settings] Dialog Box

A. Crop mark/Default border
Turning on this item creates crop marks and a default border (inner) on the canvas.

You can adjust the crop marks, default border, and offsets to change the guidelines that appear on the canvas.

Closing the dialog box with this setting turned off will delete the crop marks and default border.

A

B

C

A

B

C

D

For single page For 2-page spread
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Menus > View Menu > Crop mark/Default border settings [PRO/EX]
B. Crop mark (finish border)
This sets the border at which the edge of the pages will be trimmed for binding after printing. Images within this border will be printed.

(1) Default sizes (finish border)

Allows you to select a width and height for the finish size from default sizes.

(2) Crop mark settings

Adjust the size of the printable area and the bleed width.

Width

Horizontal length to print.

Height

Vertical length to print.

Cropped border
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Menus > View Menu > Crop mark/Default border settings [PRO/EX]
Bleed width

This is an extra margin to compensate for misaligned trimming of the edges of the pages. To print to the edge of the page, draw up to the 

bleed width area.

The area between the bleed border (the first border from the edge) and the finish border (the second border from the edge) is the bleed area.

C. Default border (inner)
This is a reference border for laying out frames. There are two ways of specifying the default border: by size and position, or by margin.

(1) Default sizes

Allows you to select a width and height for the default border from default sizes.

Bleed width Cropped border

Bleed

Bleed area is the area

between the bleed border and

the cropped border.

Default border

Set size

Set margin
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Menus > View Menu > Crop mark/Default border settings [PRO/EX]
(2) How to specify default border

Sets how to specify the size and position of the default border. Displayed items vary depending on the content set in [Default border set-

tings].

(3) Default border settings

Sets the size and position of the default border. The options vary depending on the method of specifying the border.

Set size

Adjust the size and position of the default border.

Set margin

Adjust the default border based on the distance from the edges of the paper.
@

Set size Adjust the size and position of the default border.

Set margin Adjust the default border based on the distance from the edges of the paper.

Width Width of the default border.

Height Length of the default border.

X offset Horizontal position of the default border.

Y offset Vertical position of the default border.

 When [X offset] is 0, the default border will be located in the center of the finish border horizontally.

 When [Y offset] is 0, the default border will be located in the center of the finish border vertically.

Top Specifies the upper side of the default border as the distance from the top of the paper.

Bottom Specifies the lower side of the default border as the distance from the bottom of the paper.

Inside Specifies the right or left side of the default border as the distance from the direction of the binding point.

Outside
Specifies the right or left side of the default border as the distance from the outer edge of the page (opposite 

side to the binding point).

Top

Bottom

Binding side

Cropped border

Default borderDDDDDD
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Menus > View Menu > Safety margin [PRO/EX]
D. Align crop mark
When turned off, crop marks are created at the position where the paper edges of the left and right pages match.

When turned on, the crop marks are combined by aligning the positions of the cropped border. The position of the cropped border on the 

left and right pages can be adjusted in [Gap].

Safety margin [PRO/EX]
Select the [View] menu > [Safety margin] to hide or show the safety margin.

On-screen area (webtoon)*
[View] menu > [On-screen area (webtoon)] will display the on-screen area on the canvas. Off-screen areas will be grayed out.

The on-screen area (webtoon) highlights what part of the webtoon will be shown on a smartphone screen.

The [Align crop mark] setting only appears for two-page spreads.
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On-screen area settings (webtoon)*
The aspect ratio of the on-screen area can be set from the [On-screen area (webtoon)] dialog box, displayed by selecting  [View] menu > [On-

screen area settings (webtoon)].

Story information [EX]
Select the [View] menu > [Story Information] to hide or show the story information and page numbers.

Paper
Select the [View] menu > [Paper] to hide or show the paper layer.

When the paper layer is hidden, transparent areas will be shown in a checkered pattern.

 For details on how to change the aspect ratio of the on-screen area, see "On-screen area settings (webtoon)*".

 The on-screen are will not be displayed when the canvas is rotated or if the canvas has a spread.

You can change the colors of the checkered pattern in [Preferences]. For details, see "Canvas".
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Menus > View Menu > Show Tone Area [PRO/EX]
Show Tone Area [PRO/EX]
Select the options in the [View] menu > [Show Tone Area] to highlight areas with screentones in color.

Show Selected Tone Area
When turned on, selecting a layer with tones on the [Layer] palette will show the areas with tone in color.

When Tone is turned on as an effect, you can change the color to highlight the tones in the [Layer Property] pal-

ette > [Area Color]. For details, see "Tone".

 When [Tone] is turned on in the [Layer Property] palette of a layer folder, selecting a toned layer in the folder 

will not show the tone areas of that layer in color.

 When [Edge] is turned on on the [Layer Property] palette for [Layer Folder], selecting a toned layer in a folder 

shows the toned areas of that layer with colors, but clipped to the layer below.
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Show All Tone Areas
Turn this on to highlight all tone areas in color.

Include Image Material Area
Turn this on to highlight areas with pasted image materials in color.

When [Overlay texture] is turned on in the [Layer Property] palette, image material areas will not shown in color 

even if [Include Image Material Area] is turned on.

[Image material layer]
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Show vector paths [PRO/EX]
Select the options in the [View] menu > [Show vector paths] to display the vector paths on lines drawn on vector layers. You can also adjust 

how control points are shown.

You can also display center paths for frame border folders and balloon layers.

Show vector paths on selected layers
This shows vector paths only on the vector layer currently selected in the [Layer] palette. Vector paths will also display for selected frame bor-

der folders and balloon layers.

 If the lines are almost black or blue, the vector paths will appear in orange. If the lines are almost white or red, 

the vector paths will appear in blue.

 You can adjust the vector path opacity in the [Preferences] dialog box. For details, see "Layer/Frame".
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Show all vector paths on vector layers
This shows the vector paths of the vector layers on all vector layers.

Show control points at beginning and end
Turn this on to display the control points of the vector path at the beginning and end.

Turning on [Show all vector paths on vector layers] will not display center paths for frame border folders or bal-

loon layers. Vector paths will display when you select the frame border folder or balloon layer.

 To display control points, either [Show vector paths on selected layers] or [Show all vector paths on vector 

layers] must be turned on to be enabled for control points to display.

 Will also show multiple control points. Except the Special ruler, Perspective ruler and Symmetrical ruler.
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Show all control points
Turning this on displays all of the control points along vector paths.

Show playback fps
Select the [View] menu > [Show playback fps] to display the frame rate when playing an animation in the [Canvas] window.

Snap to Ruler [PRO/EX]
Select the [View] menu > [Snap to Ruler] to adjust snapping to rulers.

When turned on, it allows you to draw along a ruler or a Frame Border.

Snap to Special Ruler [PRO/EX]
Select the [View] menu > [Snap to Special Ruler] to adjust snapping to Special rulers.

When turned on, allows you to draw along a special ruler.

Snap to Grid [PRO/EX]
Select the [View] Menu > [Snap to Grid] to adjust snapping to grids and perspective rulers.

When turned on, it allows you to draw along the grid lines of a grid or a perspective ruler.

 To display control points, either [Show vector paths on selected layers] or [Show all vector paths on vector 

layers] must be turned on to be enabled for control points to display.

 Will also show multiple control points. Except the Special ruler, Perspective ruler and Symmetrical ruler.

For information on playing animations, see "Play/Stop".
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Menus > View Menu > Change Special Ruler Snap [PRO/EX]
Change Special Ruler Snap [PRO/EX]
When multiple special rulers are on the canvas, select the [View] menu > [Change Special Ruler Snap] to switch which special ruler will be 

snapped to.

Color Profile [PRO/EX]
Allows you to set the color profile, rendering intent and used library to preview on the canvas.

Preview Settings
Select the [View] menu > [Color profile] > [Preview Settings] to open the [Preview of color profile] dialog box.

In this dialog box, you can change settings for color conversion when using a color profile preview. You can also apply the set color profile 

when exporting an image using [Save Duplicate] or [Export (Single Layer)].

[Preview of color profile] Dialog Box

A. Profile for preview
Select the color profile for previewing the colors.

 You can only snap to one special ruler at a time.

 A drawing is not snapped to a [Special ruler] displayed in green.

 You do not need to switch between other types of rulers.

 CMYK is a color space for print using cyan, magenta, yellow and keytone (black).

 RGB is a color space for screen display on monitors and scanners. Colors are expressed in red, green and 

blue.

A

B

C

D

E
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Menus > View Menu > Color Profile [PRO/EX]
B. Rendering intent
Set how to process the color conversion between color spaces with the color management system.

C. Library to use [Windows]
Select whether to use the [Icclibrary] or [MicrosoftICM].

D. Tonal correction
Turn on this item to adjust contrast for the image. You can select from [Tone Curve] or [Level Correction].

Tone Curve

Adjusts the contrast of an image using the tone curve.

Perceptual
Preserves the visual relationship between colors so that colors are perceived as natural even when 

color values are changed.

Saturation Compares the maximum highlight in the source color space with the maximum highlight in the 

destination color space, and shifts the difference.

Relative Colorimetric Tries to reproduce vivid colors, even at the expense of color accuracy.

Absolute Colorimetric Does not change colors that fall within the destination gamut, but changes out-of-gamut colors.

[Library to use] is not available on macOS.

[Tonal Correction] can be set only when the [Profile for preview] is CMYK.

(1) Channel Select a channel to adjust the brightness. The available channels depend on the selected color 

profile.

(2) Reset Reset the image to the original state.

(3) Tone curve

A graph to adjust the contrast of the image. Drag the control points to adjust the curve. The hori-

zontal axis of the graph is the "Input" value (original brightness) and the vertical axis is the "Out-

put" value (brightness after adjustment).
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Level Correction

Adjusts the contrast of an image using the histogram.

 To delete a control point, drag it outside the graph.

 The horizontal axis of the graph is the "Input" value (original brightness) and the vertical axis is the "Output" 

value (brightness after adjustment).

 This graph displays the volume of the dark areas (left side) and bright areas (right side) as mountain-like 

peaks. Adjust the tone curve while checking the balance of the original image in the histogram.

(1) Channel
Select the channel to adjust the levels. The available channels depend on the selected color pro-

file.

(2) Histogram
This graph displays the volume of the dark areas (left side) and bright areas (right side) as moun-

tain-like peaks.

(3) Shadows
This controls the darkest parts of the image. The [Shadows] control point is usually the furthest 

left under the histogram.

(4) Midtones This controls the midtones of the image.

(5) Highlights
This controls the brightest parts of the image. The [Highlights] control point is usually the fur-

thest right under the histogram.

(6) Shadows output This controls the darkest parts of the image.

(7) Highlights output This controls the brightest parts of the image.

If either edge of the mountain in the histogram does not reach the range edge, move the control point to the edge 

of the peak on that side. To correct the entire image, adjust in such a way as to spread the peaks across the entire 

histogram range.
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E. Range in application of settings
Specify the scope of the settings configured in the dialog box.

You can also set whether or not to save the settings configured in the [Preview of color profile] dialog box when saving the file.

Preview
Select the [View] menu > [Color profile] > [Preview] command to preview the settings set up in the [Preview of color profile] dialog box.

If you have not yet set options in the [Preview of color profile] dialog box, the dialog box will open.

Save on canvas

 Saves the settings configured in the [Preview of color profile] dialog box when saving the 

file. When you open the file again after saving it, the color profile settings will be retained.

 The settings configured in the dialog box will also apply to other windows.

 To apply the settings when exporting an image, export in TIFF format (extension: tif), JPEG 

format (extension: jpg), Adobe Photoshop Document (extension: psd) or Adobe Photoshop 

Big Document format (extension: psb). When exporting, do not forget to turn on [Embed 

ICC profile] in the [Export settings] dialog box.

Set only in this window

 Does not save the settings in the [Preview of color profile] dialog box when saving the file or 

exporting in a specified format. When you open the file again after saving, the color profile 

settings will be those set in the [Preferences] dialog box.

 The settings configured in this dialog box will not apply to other windows.

 The color profile preview settings are saved for the next time the application is started. For example, the appli-

cation is closed with the preview on, the preview will automatically be used the next time the application is 

started.

 If you have not yet set options in the [Preview of color profile] dialog box, the dialog box will open when you 

select the [Preview] command.
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 Filter Menu
The [Filter] menu allows you to generate blur, cloud and natural patterns, etc. on a selected layer. This section
describes the commands in the [Filter] menu.

Blur
These filters blur the image.

Using the Blur Filters
This section describes how to apply a blur filter, using the example of [Gaussian blur].

1 First select a layer on the [Layer] palette.

2 Select the [Filter] menu > [Blur] > [Gaussian blur].

Blur & Blur (Strong)
These filters calculate the average colors around borders and sharp edges to make the image 

appear smoothly blurred.

Gaussian blur A filter that smooths an image. You can specify the strength of the blur.

Smoothing Applies anti-aliasing to smooth the outline of an image.

Radial blur A filter that smooths an image by averaging it in a concentric pattern.

Motion blur
A filter that smooths an image by averaging the border lines and sharp areas of the image in a 

given direction. 

 Some filters can only be applied on certain types of layers. Please refer to the “Filters” section for more infor-

mation.

 If you create a selection area, the filter will only be applied to the selection area. You cannot change the size of 

the effect after applying the filter.
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3 Adjust the [Filter] settings in the dialog box that appears.

(1) Adjust the [Strength] setting.

(2) Click [OK].

4 Click OK to apply the filter effect to the canvas.

 A dialog box will not appear with the [Blur], [Blur (Strong)] or [Smoothing] filters. 

 When using the [Radial blur] filter, a red cross (x) will appear on the canvas to indicate the center of the blur. 

You can move this red cross to adjust the center point.
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Blur & Blur (Strong)
These filters calculate the average colors around borders and sharp edges to make the image appear smoothly blurred.

Select [Filter] menu > [Blur] > [Blur (Strong)] (or [Blur]) to apply this filter to the selected layer. The filter will only be applied to the image on 

the layer.

Applicable layers 
Raster layer (gray)

Raster layer (color)

If you create a selection area and then use the [Blur] or [Blur (Strong)] filters, the effect will only be applied within 

the selection area.

Original image After applying Blur (Strong)
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Gaussian blur
Select the layer you want to apply a filter to, then select the [Filter] menu > [Blur] > [Gaussian blur] to open the dialog box. This smooths out 

the image. You can specify the strength of the blur.

[Gaussian blur] Dialog Box

(1) Strength

Adjust the size of the blur.

(2) Preview

Preview the image on the canvas.

Applicable layers 
Raster layer (gray)

Raster layer (color)

 To learn how to apply a [Blur] effect to a layer, see "Using the Blur Filters".

 If you create a selection area, the filter will only be applied to the selection area. You cannot change the size of 

the effect after applying the filter.

 For information on the settings in the [Gaussian blur] dialog box, please see the following section.

Original image After applying Gaussian blur: 80
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Smoothing
This filter applies an anti-aliasing effect to the selected layer. Anti-aliasing smooths outlines by adding intermediate colors at the boundaries 

between colors and at the edges of images.

Select the layer to process and select the [Filter] menu > [Effect] > [Blur] > [Smoothing]. The anti-aliasing effect will be applied to the layer to 

make jagged lines less noticeable.

Radial blur
Select the layer you want to apply a filter to, then select the [Filter] menu > [Blur] > [Radial blur] to open the dialog box. This filter blurs the 

image by smoothing and averaging it in a radial pattern.

Applicable layers
Raster layer (gray)

Raster layer (color)

If you create a selection area, the color correction will only be applied to the selection area.

Applicable layers
Raster layer (gray)

Raster layer (color)

Original image After applying Smoothing

Original image After applying Radial blur
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[Radial blur] Dialog Box

(1) Strength

Sets the Strength of an image.

(2) Direction to blur

Set the direction to blur from [Both directions], [Outward], or [Inward].

 To learn how to apply a [Blur] effect to a layer, see "Using the Blur Filters".

 If you create a selection area, the effect will only be applied to the selection area. You cannot change the size 

of the effect after applying the filter.

 For information on the settings in the [Radial blur] dialog box, please see the following section.

A red cross (x) will appear on the canvas while the dialog box is open. Drag this to set the center of the effect.

Original image

Both directions InwardOutward
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(3) Mode

You can select [Box] and [Smooth] from Mode.

(4) Preview

Turn this on to preview the results on the canvas.

Original image

Box Smooth
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Motion blur
Select the layer you want to apply a filter to, then select the [Filter] menu > [Blur] > [Motion blur] to open the dialog box. This filter blurs the 

image by averaging the border lines and sharp areas of the image in a specified direction.

[Motion blur] Dialog Box

(1) Strength

Sets the Distance of an image.

(2) Angle

Sets the Angle of an image.

Applicable layers
Raster layer (gray)

Raster layer (color)

 To learn how to apply a [Blur] effect to a layer, see "Using the Blur Filters".

 If you create a selection area, the effect will only be applied to the selection area. You cannot change the size 

of the effect after applying the filter.

 For information on the settings in the [Motion blur] dialog box, please see the following section.

Original image After applying Motion blur
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(3) Direction to blur

When selecting the direction you can choose from [Both directions], [Forward], and [Backward].

Back

Original image

Forward Both directions
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(4) Mode

You can select [Box] and [Smooth] from Mode.

(5) Preview

Turn this on to preview the results on the canvas.

Box Averages the values of each pixel and its surrounding pixels.

Smooth Assigns more weight to central pixels and averages the values of pixels.

Original image

Box Smooth
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Sharpen
These filters sharpen an image.

Unsharp mask
This filter sharpens images by enhancing the contrast at the border between colors.

1 On the [Layer] palette, select a layer.

2 Select the [Filter] menu > [Sharpen] > [Unsharp mask].

3 Set the [Unsharp mask] dialog box.

(1) Set the strength of the effect, threshold value, and so on.

(2) Click [OK].

Unsharp mask
These filters sharpen images by enhancing the contrast at the image borders.

You can set the strength and threshold value of the effect by specifying numerical values.

Sharpen & Sharpen More

Filters that sharpen images by enhancing the contrast at the image borders.

There are two variants of the filter depending on the strength of its effect: [Sharpen] and [Sharpen 

More].

If you create a selection area, the filter will only be applied to the selection area.
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4 The filter will be applied to increase the contrast  on the selected layer at borders between
colors.

[Unsharp mask] Dialog Box

(1) Radius

Set the size of the effect.

(2) Strength

Set the strength of the effect.

(3) Threshold

Set a minimum level of difference in values between adjacent areas to be recognized as different colors.

A higher value detects fewer borders between colors.

(4) Preview

Turn this on to preview the results on the canvas.
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Sharpen & Sharpen More 
Filters that sharpen images by enhancing the contrast at the image borders. There are two variants of the filter depending on the strength of its 

effect: [Sharpen] and [Sharpen More].

Select the layer you want to apply a filter to, then select the [Filter] menu > [Sharpen] > [Sharpen More] (or [Sharpen]) to open the dialog box. 

The filter will only be applied to the image on the layer.

If you create a selection area and then use the [Sharpen] or [Sharpen More] filters, the effect will only be applied 

within the selection area.

Original image

Sharp Sharpen More
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Effect 
The filters apply special effects to an image.

Remove jpeg noise
On the selected layers, removes noise generated when an image is saved in JPEG format.

Select the layer you want to process and select [Filter] menu > [Effect] > [Remove jpeg noise].

This removes noise from an image in a layer.

Remove jpeg noise This filter remove the noise that appears when images are saved in JPEG format.

Artistic This filter applies an artistic touch and create line art from an image.

Mosaic This filter applies a mosaic effect to the image.

Applicable layers
Raster layer (color)

Raster layer (gray)

You can use this filter on a selection area to apply the effect only to the selected area.
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Artistic
Applies the Artistic filter to the selected layer. This effect is useful for adding an artistic touch and converting your work into line art.

1 First select a layer on the [Layer] palette.

2 Select [Filter] Menu > [Effect] > [Artistic].

3 Adjust the settings in the [Artistic] dialog box and click [OK].

Applicable layers Raster layer (color)

If you create a selection area, the effect will only be applied to the selection area.
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4 Applies the filter effect to the selected layer.

Artistic dialog box

(1) Content of process

Select from one of the following options to apply the filter.

The following explains the Artistic dialog box settings.

Color and lines Blurs the colors and extracts the lines from the original image.

Color only Blurs the colors of the original image.

Lines only Extracts the lines from the image. The lines are black, and the rest of the image is transparent.
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(2) Line width

Allows you to set the thickness of the extracted lines.

(3) Line simplicity

The larger the value, the more the lines connect.

(4) Line density

The larger the value, the more of the line that is extracted.

(5) Line opacity

Allows you to set the opacity of the lines.

(6) Line anti-aliasing

The larger the value, the stronger the anti-aliasing resulting in smoother lines.

(7) Color blending

Blurs the images without adjusting the boundaries of the colors. The larger the value, the stronger the blur effect.

 When [Color only] is selected, the [Line width], [Line simplicity], [Line density], [Line opacity], and [Line anti-

aliasing] are not applied to the canvas.

 When [Lines only] is selected, the [Color blending], [Color blur], and [Number of colors] are not applied to the 

canvas.

Color only Line onlyColor and lines

Original image Color  blending
CLIP STUDIO PAINT Instruction Manual 634



Menus > Filter Menu > Effect
(8) Color blur

Allows you to set the blur range. The larger the value, the stronger the blur effect.

(9) Number of colors

Allows you to set the number of colors. The larger the value, the more colors used to make up the gradients.

(10)Preview

Turn this on to preview the results of the artistic filter on the canvas.

(11) Reset

Clicking this resets all values to their initial settings.

Original image Color blur
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Mosaic
This filter applies a Mosaic effect to the image.

1 First select a layer on the [Layer] palette.

2 Select the [Filter] menu > [Effect] > [Mosaic].

3 Applies the settings in the [Mosaic] dialog box.

(1) Set the tile size.

(2) Click [OK].

Applicable layers
Raster layer (color)

Raster layer (gray)

If you create a selection area, the effect will only be applied to the selection area.
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4 The filter is applied and the image on the layer will get a mosaic effect.

[Mosaic] Dialog Box

(1) Tile size

Set the size of the tiles in the mosaic.

(2) Preview

Turn this on to preview the results on the canvas.
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Distort
This contains filters for distorting images.

Using the Distort Filters
This section describes how to apply a Distort filter, using the example of [Pinch].

1 First select a layer on the [Layer] palette.

2 Select the [Filter] menu > [Transform] > [Pinch].

Pinch This filter distorts images by pinching at the center point of the transformation.

Ripple A filter that distorts images by rippling outward from the center of the image.

Curved surface A filter that distorts images by making them appear as if they are reflected on a cylindrical or spherical surface.

Polar coordinates
Converts the coordinates of an image to polar coordinates (coordinates indicated by radii and angles) or rectan-

gular coordinates (coordinates in which the axes form a rectangle).

ZigZag A filter that distorts images by creating a zigzag pattern.

Wave A filter that transforms the coordinates of images to a wave shape.

Twirl A filter that transforms images by creating a twirl effect.

Fish-eye lens
This filter distorts images by making them appear as if they are viewed through a fish-eye lens. The area outside 

the "lens" is transparent.

 Some filters can only be applied on certain types of layers. Please refer to the “Filters” section for more infor-

mation.

 If you create a selection area, the filter will only be applied to the selection area. You cannot change the size of 

the effect after applying the filter.
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3 Adjust the [Filter] settings in the dialog box that appears.

(1) Drag the red cross (x) on the canvas to set the center of the transformation.

(2) Configure settings such as the degree of transformation and the range of transformation.

(3) Click [OK].

4 Click OK to apply the filter effect to the canvas.

The option to set a center of the transformation only appears for the following filters. This setting does not appear 

for other Distort filters.

[Pinch], [Ripple], [Curved surface], [Twirl], [Fish-eye lens]
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Pinch
Select the layer you want to apply a filter to, then select the [Filter] menu > [Distort] > [Pinch] to open the dialog box. This distorts the image 

on the layer by pinching it in toward a specified center point.

[Pinch] Dialog Box

Applicable layers

Raster layer (color)

Raster layer (gray)

Raster layer (monochrome)

 To learn how to apply a [Distort] effect to a layer, see "Using the Distort Filters".

 If you create a selection area, the effect will only be applied to the selection area. You cannot change the size 

of the effect after applying the filter.

 For information on the settings in the [Pinch] dialog box, please see the following section.

A red cross (X) will appear on the canvas while the dialog box is open. Drag this to set the center of the distortion.

Original image After applying Pinch
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(1) Strength

The degree of pinching to apply to the image.

 Set a positive number to pinch the image toward the viewer.

 Set a negative number to pinch the image away from the viewer.

(2) Area

Specify the range in which to apply the transformation effect.

(3) Radius

Set the range of the image distortion.

(4) Shape

Set the vertical/horizontal ratio of the area to distort the image.

 Set a positive number to make the transformation range narrower horizontally.

 Set a negative number to make the transformation range narrower vertically.

Entire selection Applies the transformation effect to the entire image.

Specify size (use radius/

shape)

Specifies the range and vertical/horizontal ratio of the transformation effect. Specify the range 

and vertical/horizontal ratio using the [Radius] and [Shape] settings.

Amount: -50Amount: 50

Flattening: 0.5 Flattening: -0.5
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(5) Preview

Turn this on to preview the results on the canvas.

Ripple
Select the layer you want to apply a filter to, then select the [Filter] menu > [Distort] > [Ripple] to open the dialog box. This creates a ripple 

effect from the center to the outside of the canvas.

[Ripple] Dialog Box

(1) Rotation

Transform the image by rotating from the center point of the transformation.

Applicable layers

Raster layer (color)

Raster layer (gray)

Raster layer (monochrome)

 To learn how to apply a [Distort] effect to a layer, see "Using the Distort Filters".

 If you create a selection area, the effect will only be applied to the selection area. You cannot change the size 

of the effect after applying the filter.

 For information on the settings in the [Ripple] dialog box, please see the following section. 

A red cross (X) will appear on the canvas while the dialog box is open. Drag this to adjust the center of the trans-

formation.

Original image After applying Ripple
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(2) Number of waves

The number of waves that will be created.

(3) Area

Specify the range in which to apply the transformation effect.

(4) Radius

Set the range of the image distortion.

(5) Shape

Set the vertical/horizontal ratio of the area to distort the image.

 Set a positive number to make the transformation range narrower horizontally.

 Set a negative number to make the transformation range narrower vertically.

(6) Preview

Turn this on to preview the results on the canvas.

Entire selection Applies the transformation effect to the entire image.

Specify size (use radius/

shape)

Specifies the range and vertical/horizontal ratio of the transformation effect. Specify the range 

and vertical/horizontal ratio using the [Radius] and [Shape] settings.

Shape: 0.5 Shape: -0.5
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Curved surface
Select the layer you want to apply a filter to, then select the [Filter] menu > [Distort] > [Curved surface] to open the dialog box. This distorts the 

images by making it appear as if it is reflected on a cylindrical or spherical surface.

[Curved surface] dialog box

Applicable layers

Raster layer (color)

Raster layer (gray)

Raster layer (monochrome)

 To learn how to apply a [Distort] effect to a layer, see "Using the Distort Filters".

 If you create a selection area, the effect will only be applied to the selection area. You cannot change the size 

of the effect after applying the filter.

 For information on the settings in the [Curved surface] dialog box, please see the following section.

A red cross (X) will appear on the canvas while the dialog box is open. Drag this to set the center of the transfor-

mation.

Original image After applying Curved surface
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(1) Strength

Set the degree to which to transform the image.

 Set a positive number to curve the image toward the viewer.

 Set a negative number to curve the image away from the viewer.

(2) Method

Allows you to set the type of curved face to apply to the image. You can select from [Cylinder] or [Sphere].

(3) Angle

Allows you to set the angle when set to [Cylinder].

(4) Area

Specify the range in which to apply the transformation effect.

(5) Radius

Set the range of the image distortion.

Entire selection Applies the transformation effect to the entire image.

Specify size (use radius/

shape)

Specifies the range and vertical/horizontal ratio of the transformation effect. Specify the range 

and vertical/horizontal ratio using the [Radius] and [Shape] settings.

Strength: 50 Strength: -50

Sphere Cylinder
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(6) Shape

Set the vertical/horizontal ratio of the area to distort the image.

 Set a positive number to make the transformation range narrower horizontally.

 Set a negative number to make the transformation range narrower vertically.

(7) Preview

Turn this on to preview the results on the canvas.

Polar coordinates
Select the layer you want to apply a filter to, then select the [Filter] menu > [Distort] > [Polar coordinates] to open the dialog box. This distorts 

the image by converting the image coordinates to polar coordinates or rectangular coordinates.

Applicable layers

Raster layer (color)

Raster layer (gray)

Raster layer (monochrome)

 To learn how to apply a [Distort] effect to a layer, see "Using the Distort Filters".

 If you create a selection area, the effect will only be applied to the selection area. You cannot change the size 

of the effect after applying the filter.

 For information on the settings in the [Polar coordinates] dialog box, please see the following section.

Shape: 0.5 Shape: -0.5

Original image After applying polar coordinate
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[Polar coordinates] Dialog Box

 (1) Transformation method

Specify the method for transforming the image.

(2) Preview

Turn this on to preview the results on the canvas.

Rectangular to polar
Converts the coordinates of the image from rectangular coordinates (all axes form a rectangle) to 

polar coordinates.

Polar to rectangular
Converts the coordinates of the image from polar coordinates (graph indicated by radii and 

angles) to rectangular coordinates.

Spherical surface reflection Transforms images by making them appear as if they are projected on a spherical surface.

Original image

Rectangular to polar Polar to rectangular Spherize
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ZigZag
Select the layer you want to apply a filter to, then select the [Filter] menu > [Distort] > [ZigZag] to open the dialog box. A that transforms 

images by creating a zigzag wave pattern.

[ZigZag] Dialog Box

(1) Angle

Specify the angle of the waves.

(2) Wave height

Specify the amplitude of the waves.

(3) Number of waves

Specify the number of waves.

(4) Preview

Turn this on to preview the results on the canvas.

Applicable layers

Raster layer (color)

Raster layer (gray)

Raster layer (monochrome)

 To learn how to apply a [Distort] effect to a layer, see "Using the Distort Filters".

 If you create a selection area, the effect will only be applied to the selection area. You cannot change the size 

of the effect after applying the filter.

 For information on the settings in the [ZigZag] dialog box, please see the following section.

Original image After applying ZigZag
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Wave
Select the layer you want to apply a filter to, then select the [Filter] menu > [Distort] > [Wave] to open the dialog box. This distorts the image 

by converting the image coordinates to a wave shape.

[Wave] Dialog Box

Applicable layers

Raster layer (color)

Raster layer (gray)

Raster layer (monochrome)

 To learn how to apply a [Distort] effect to a layer, see "Using the Distort Filters".

 If you create a selection area, the effect will only be applied to the selection area. You cannot change the size 

of the effect after applying the filter.

 For information on the settings in the [Wave] dialog box, please see the following section.

Original image After applying Wave
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(1) Shape

Select the method to distort the image.

(2) Number of waves

Enter the number of waves.

(3) Wavelength (Minimum)

Set the minimum distance between the highest points of the waves.

(4) Wavelength (Maximum)

Set the maximum distance between the highest points of the waves.

(5) Amplitude (Minimum)

Set the minimum amplitude of the wave shape.

(6) Amplitude (Maximum)

Set the maximum amplitude of the wave shape.

Sine Converts the coordinates of the image to a sine wave (a wave with a cyclic transformation).

Triangle Converts the coordinates of the image to a triangular wave.

Rectangular Converts the coordinates of the image to a rectangular wave.

Original image

Sine Triangle Rectangular
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(7) Horizontal ratio

Set the horizontal ratio of the amplitude.

(8) Vertical ratio

Set the vertical ratio of the amplitude.

(9) Undefined areas

Select the process for the area of the image that is outside the wave area.

(10)Regenerate

Regenerates the wave shape according to the settings in the dialog box.

(11) Preview

Turn this on to preview the results on the canvas.

Wrap around Fills the edges of the image using the image on the opposite edge. 

Repeat edge pixels Fills the edges of the image with the drawing color.

Clicking [Regenerate] regenerates the wave shape by selecting random values between the minimum and maxi-

mum values for [Wavelength] and [Amplitude].
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Twirl
Select the layer you want to apply a filter to, then select the [Filter] menu > [Distort] > [Twirl] to open the dialog box. This distorts the image 

on the layer by twisting it.

[Twirl] Dialog Box

(1) Twist

Set the rotation angle for twisting the image.

(2) Tension

Set the strength with which the image is pulled.

Applicable layers
Raster layer (color)

Raster layer (gray)

 To learn how to apply a [Distort] effect to a layer, see "Using the Distort Filters".

 If you create a selection area, the effect will only be applied to the selection area. You cannot change the size 

of the effect after applying the filter.

 For information on the settings in the [Twirl] dialog box, please see the following section.

A red cross (X) will appear on the canvas while the dialog box is open. Drag this to adjust the center of the trans-

formation.

Original image After applying Twirl
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(3) Area

Specify the range in which to apply the transformation effect.

(4) Radius

Set the range of the image distortion.

(5) Shape

Set the vertical/horizontal ratio of the area to distort the image.

 Set a negative number to make the transformation range narrower vertically.

 Set a positive number to make the transformation range narrower horizontally.

(6) Preview

Turn this on to preview the results on the canvas.

Entire selection Applies the transformation effect to the entire image.

Specify size (use radius/

shape)

Specifies the range and vertical/horizontal ratio of the transformation effect. Specify the range 

and vertical/horizontal ratio using the [Radius] and [Shape] settings.
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Fish-eye lens
Select the layer you want to apply a filter to, then select the [Filter] menu > [Distort] > [Fish-eye lens] to open the dialog box. This distorts the 

image on the layer by making it look as if it is viewed through a fish-eye lens. The area outside the "lens" is transparent.

[Fish-eye lens] Dialog Box

Applicable layers

Raster layer (color)

Raster layer (gray)

Raster layer (monochrome)

 To learn how to apply a [Distort] effect to a layer, see "Using the Distort Filters".

 If you create a selection area, the effect will only be applied to the selection area. You cannot change the size 

of the effect after applying the filter.

 For information on the settings in the [Fish-eye lens] dialog box, please see the following section.

A red cross (X) will appear on the canvas while the dialog box is open. Drag this to adjust the center of the trans-

formation.

Original image After applying Fish-eye lens
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(1) Distortion

Set the distortion size of the lens. The larger the value, the further forward the center of the lens will appear.

(2) Area

Specify the range in which to apply the transformation effect.

(3) Radius

Set the range of the image distortion.

(4) Shape

Set the vertical/horizontal ratio of the area to distort the image.

 Set a positive number to make the transformation range narrower horizontally.

 Set a negative number to make the transformation range narrower vertically.

(5) Preview

Turn this on to preview the results on the canvas.

Entire selection Applies the transformation effect to the entire image.

Specify size (use radius/

shape)

Specifies the range and vertical/horizontal ratio of the transformation effect. Specify the range 

and vertical/horizontal ratio using the [Radius] and [Shape] settings.

Distortion: 80Original image

Flattening: 0.5 Flattening: -0.5
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Render

Perlin noise
This creates a cloud-like pattern on the selected layer.

1 First select a layer on the [Layer] palette.

2 Select the [Filter] menu > [Render] > [Perlin noise].

3 Adjust the resulting effect with the [Perlin noise] dialog box.

(1) Adjust the pattern.

(2) Click [OK].

Applicable layers
Raster layer (gray)

Raster layer (color)

When applying the [Perlin noise] filter, the effect is applied regardless of the content on the selected layer. Please 

use an empty layer for this filter.

If you create a selection area, the effect will only be applied to the selection area.
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4 The filter will be applied and the pattern will be created.

You can change the blending mode or opacity to use the created layer as a texture.
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[Perlin noise] Dialog Box

(1) Scale

Set the pattern size. The larger the value, the larger the size of the pattern.

(2) Amplitude

Set the amplitude of the pattern. The larger the value, the higher the contrast of the pattern.

(3) Attenuation

A larger value creates a rougher pattern.

(4) Repetition

The larger the value, the weaker the blur.

(5) Offset X

Set the starting position (horizontal axis) of the pattern.

(6) Offset Y

Set the starting position (vertical axis) of the pattern.

(7) Preview

Turn this on to preview the results on the canvas.
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Correct line
These filters are for correcting drawing lines.

Remove dust
Automatically detects fine dust on the selected layer. This filter can erase dust up to a specified size and fill gaps in the main color.

1 First select a layer on the [Layer] palette.

2 Select the [Filter] menu > [Correct line] > [Remove dust].

3 Adjust the settings in the [Remove dust] dialog box that appears.

(1) Set the [Dust size].

(2) Select the process method in [Mode].

(3) Click [OK].

Remove dust A filter for removing fine dust from images.

Adjust line width A filter for changing the width of lines drawn on raster layers.

Applicable layers

Raster layer (color)

Raster layer (gray)

Raster layer (monochrome)

If you create a selection area, the effect will only be applied to the selection area.
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4 The filter is applied and the dust is removed from the image.

[Remove dust] dialog box

(1) Dust size

Specifies the maximum size for an object to be recognized as dust.

(2) Mode

Specifies the method by which to remove dust.

Remove dust from transparency

Small opaque and translucent spots in transparent areas are recognized as dust. The dust is replaced by transparent color.
CLIP STUDIO PAINT Instruction Manual 660



Menus > Filter Menu > Correct line
Remove dust from white background

Small non-white spots in areas completely filled white are recognized as dust. The dust is filled with white.

Fill transparent gaps with surrounding color

Small transparent and translucent spots in opaque areas are recognized as dust. The dust is filled with the main color around it.
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Fill transparent gaps with foreground color

Small transparent and translucent spots in opaque areas are recognized as dust. The dust is filled with the drawing color.

(3) Preview

Turn this on to preview the results on the canvas.

Drawing color
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Adjust line width
A filter for changing the width of lines drawn on raster layers.

1 First select a layer on the [Layer] palette.

2 Select the [Filter] menu > [Correct line] > [Adjust line width].

3 Adjust the settings in the [Adjust line width] dialog box.

(1) Select the line width adjustment method in [Process].

(2) Set the degree to which to correct the line width in [Scale].

(3) Click [OK].

Applicable layers

Raster layer (color)

Raster layer (gray)

Raster layer (monochrome)

[Adjust line width] is enabled for lines drawn in transparent areas.

If you create a selection area, the filter will only be applied to the selection area.
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4 The line width in the selected area is corrected.

[Adjust line width] dialog box

(1) Process

Set how to correct the line width. Select from [Narrow] or [Thicken].

(2) Scale

Allows you to set the degree to which to correct the line width.

(3) At least 1 pixel

Leaves a line of one pixel without erasing the line when [Process] is set to [Narrow].

(4) Preview

Turn this on to preview the results on the canvas.
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Menus > Window Menu [Windows/macOS/Tablet] > Canvas
 Window Menu [Windows/macOS/Tablet]
The [Window] menu is for performing operations related to the windows. This section describes the commands in the
[Window] menu.

Canvas
This menu includes commands related to canvases.

New Window Displays the current canvas in another window.

Cascade [Windows/macOS] Displays separate [Canvas] windows stacked on top of each other. 

Tiled Displays all open [Canvas] windows next to each other.

Next canvas
When multiple [Canvas] windows, Page Manager windows, or Story Editor windows are 

open, this switches the current editing canvas.

Previous Canvas
When multiple [Canvas] windows, Page Manager windows, or Story Editor windows are 

open, this switches the current editing canvas.

Switch between open canvases Switch between several open canvases.
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New Window
Select the [Window] menu > [Canvas] > [New Window] to open a duplicate of your current canvas.

The duplicated window can be displayed and zoomed in or out separately. This is useful when you want to zoom into a portion of the image 

while viewing the canvas as a whole. Since the data on both canvases are the same, any changes made in one window will appear on both win-

dows.

For information on how to display your canvas in separate windows, see "Displaying a Canvas Individually [Win-

dows/macOS]".

Changes made in one

window are reflected in 

the other as well.
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Cascade [Windows/macOS]
Select the [Window] menu > [Canvas] > [Cascade] to view all separate canvas windows in a cascade.

Tiled
Select the [Window] menu > [Canvas] > [Tiled] to view all your canvases in a tiled view.
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Next canvas
You can use this to switch between multiple canvas windows, Page Manager windows, or Story Editor windows.

The program switches between windows in the order that they were edited.

Previous canvas
You can use this to switch between multiple canvas windows, Page Manager windows, or Story Editor windows.

The program switches between windows in the order that they were edited. Selecting [Previous canvas] will switch to the last edited window.

Switch between open canvases
At the bottom of the [Window] menu > [Canvas] submenu, there is a list of open canvases.

Select a file name to bring the selected canvas to the forefront.
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Workspace
In Clip Studio Paint, palette layouts, shortcut settings, command bar layouts and preferences for unit settings can be registered as a workspace. 

You may have one workspace for each process and work by switching among them.

Select the [Window] menu > [Workspace] to register, load, and manage your workspaces.

Reset to Default
This restores the palette layout to the original default at installation.

Register Workspace [PRO/EX]
You can register your palette layout, shortcut settings, command bar layouts, and unit preferences as a “workspace.”

1 Lay out the palettes.

2 Select the [Window] menu > [Workspace] > [Register Workspace].

 If you change a workspace that you have loaded, the changes will automatically be updated for that work-

space. 

 Select the [Window] menu > [Workspace] > [Reload “selected workspace name”] to restore the workspace to 

its registered state. 

 If you register a workspace with the same name as an existing workspace, the existing workspace will be over-

written. 

 To learn how to set up shortcuts, see "Shortcut Settings [Windows]".

 For information on the Command bar layout, see "Command bar settings [Windows] [PRO/EX]".

 For information on unit settings in Preferences, see "Ruler/Unit".
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Menus > Window Menu [Windows/macOS/Tablet] > Workspace
3 Opens the [Register Workspace] dialog box. Name the workspace

(1) Choose a name for the workspace.

(2) Click [OK].

4 The workspace is registered.

Register workspace as material [PRO/EX]
Select the [Window] menu > [Workspace] > [Register workspace as material] to register the palette to the [Material] palette. You can register 

the palette layout, shortcut settings, command bar layouts, and unit preferences in the workspace material.

Search for workspace material(s) [PRO/EX]
Select the [Window] menu > [Workspace] > [Search for workspace material(s)] to open Clip Studio ASSETS and see a list of workspace mate-

rials.

You can download these materials and use them in your Clip Studio Paint.

For information on how to load a registered workspace, see "Import workspace [PRO/EX]".

 For details on how to register workspaces to the [Material] palette, see "Register Workspace".

 The [Register Workspace] dialog box will appear if a workspace is not being used. Workspaces are also regis-

tered to the [Window] menu > [Workspace] at the same time materials are registered.

 For how to import workspace materials, see "For workspaces [PRO/EX]".

 Workspaces registed to the [Window] menu can also be exported from it. For details, see "Import workspace 

[PRO/EX]".
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Manage Workspace [PRO/EX]
Select the [Window] menu > [Workspace] > [Manage Workspace] to open the [Workspace management] dialog box. In the dialog box, you can 

rename and delete registered workspaces.

[Manage Workspace] Dialog Box

(1) Workspace list

Displays a list of registered workspaces.

(2) OK

Commits the set content and closes the dialog box.

(3) Cancel

Cancels the set content and closes the dialog box.

(4) Delete

Clicking the button deletes the workspace selected in [Workspace list].

(5) Change name of settings

Clicking the button allows you to rename the workspace selected in [Workspace list].
258

Renaming can be done by double clicking the workspace name in the [Workspace list].
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Workspace import settings [PRO/EX]
Select the [Window] menu > [Workspace] > [Workspace import settings] to choose which items you would like to load when loading the work-

space..

[Workspace import settings] Dialog Box

(1) Items to Load

This allows you to set the items to be applied when loading a workspace. Multiple items can be set.

(2) Always check when loading workspaces

When turned on, the [Workspace import settings] dialog box is shown when loading a workspace and you can set the items to import. 

When turned off, the settings configured here are applied when a workspace is loaded.

Reload Workspace [PRO/EX]
Reverts the selected workspace to its default status.

1 Select the [Window] menu > [Workspace] > [Reload Workspace].

2 In the dialog box that appears, choose any settings that you want to load in addition to the
palette layout, then click [OK].

3 The workspace is loaded as set in the dialog box.

 To learn how to set up shortcuts, see "Shortcut Settings [Windows]".

 For information on the Command bar layout, see "Command bar settings [Windows] [PRO/EX]".

 For details on Preferences > Unit settings, see "Ruler/Unit".

"Reload '(name of selected workspace)'" is shown in the menu.

 If [Always check when loading workspace] is turned on, the [Workspace import settings] dialog box will 

appear each time you load a workspace.

 If [Always check when loading workspace] is turned off, you can adjust the items to be applied when loading 

the workspace by selecting the [Window] menu > [Workspace import settings].
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Import workspace [PRO/EX]
Imports a registered workspace.

1 The lower part of the menu item list accessed by selecting the [Window] menu > [Work-
space] contains a list of registered workspaces. Select the workspace you want to load.

2 In the dialog box that appears, choose any settings that you want to load in addition to the
palette layout, then click [OK].

3 The workspace is loaded as set in the dialog box.

 If you change a workspace that you have loaded, the changes will automatically be updated for that work-

space. If you load a workspace after it has been automatically updated, the workspace will be loaded with the 

changes applied. 

 To restore the workspace to the registered state, select the [Window] menu > [Workspace] > [Reload “selected 

workspace name”]. 

Clip Studio Paint comes with default workspaces for illustrations and comics, as well as other default workspaces 

under [By category].

 The current workspace in use is indicated by a check mark. 

 “Current workspace status not registered.” If this message is shown, clicking [Yes] shows the [Register Work-

space] dialog box where the state prior to loading can be registered as a workspace.

 If [Always check when loading workspace] is turned on, the [Workspace import settings] dialog box will 

appear each time you load a workspace.

 If [Always check when loading workspace] is turned off, you can adjust the items to be applied when loading 

the workspace by selecting the [Window] menu > [Workspace import settings].
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Command Bar 
Displays/hides the Command Bar.

Quick access [PRO/EX]
Displays/hides the [Quick Access] palette.

Tool
Displays/hides the [Tool] palette.

For details on the [Tool] palette, see "Tool Palette".

Command bar

[Quick Access] palette

[Tool] palette
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Sub Tool
Displays/hides the [Sub tool] palette.

Tool Property
Displays/hides the [Tool Property] palette.

For details on the [Sub tool] palette, see "Sub tool palette".

For details on the [Tool Property] palette, see "Tool property Palette".

[Sub Tool] Palette

[Tool property] palette
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Brush Size
Displays/hides the [Brush Size] palette.

Sub Tool Detail [PRO/EX]
Displays/hides the [Sub Tool Detail] palette.

For details on the [Brush Size] palette, see "Brush Size Palette".

For details on the [Sub Tool Detail] palette, see "Sub tool detail palette [PRO/EX]".

[Brush size] palette

[Sub tool detail] palette
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Color Wheel
Displays/hides the [Color Wheel] palette.

Color Slider
Displays/hides the [Color Slider] palette.

Color Set
Displays/hides the [Color Set] palette.

For details on the [Color Wheel] palette, see "Color Wheel Palette".

For details on the [Color Slider] palette, see "Color Slider Palette".

For details on the [Color Set] palette, see "Color Set Palette".

[Color wheel] palette

[Color slider] palette

[Color set] palette
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Intermediate Color [PRO/EX]
Displays/hides the [Intermediate Color] palette.

Approximate Color [PRO/EX]
Displays/hides the [Approximate Color] palette.

Color History [PRO/EX]
Displays/hides the [Color History] palette.

For details on the [Intermediate Color] palette, see "Intermediate color Palette [PRO/EX]".

For details on the [Approximate Color] palette, see "Approximate Color Palette [PRO/EX]".

For details on the [Color History] palette, see "Color History Palette [PRO/EX]".

[Intermediate color] palette

[Approximate color] palette

[Color history] palette
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Layer
Displays/hides the [Layer] palette.

Search Layer [PRO/EX]
Displays/hides the [Search Layer] palette.

For details on the [Layer] palette, see "Layer Palette".

For details on the [Search Layer] palette, see "Search Layer Palette [PRO/EX]".

[Layer] palette

[Search layer] palette
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Layer Property [PRO/EX]
Displays/hides the [Layer Property] palette.

For details on the [Layer Property] palette, see "Layer Property Palette [PRO/EX]".

[Layer property] palette
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Animation cels
Shows/hides the [Animation cels] palette.

Timeline
Displays/hides the [Timeline] palette.

For details on the [Animation cels] palette, see "Animation Cels palette".

For details on the [Timeline] palette, see "Timeline palette".

[Animation cels] palette

[Timeline] palette
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All sides view [EX]
Displays/hides the [All sides view] palette.

Navigator
Displays/hides the [Navigator] palette.

For details on the [All sides view] palette, see "All Sides View Palette [EX]".

For details on the [Navigator] palette, see "Navigator Palette".

[All sides view] palette

[Navigator] palette
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Sub View [PRO/EX]
Displays/hides the [Sub View] palette.

History [PRO/EX]
Displays/hides the [History] palette.

For details on the [Sub View] palette, see "Sub view Palette [PRO/EX]".

For details on the [History] palette, see "History Palette [PRO/EX]".

[Sub view] palette

[History] palette
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Auto Action [PRO/EX]
Shows/hides the [Auto Action] palette.

Information
Displays/hides the [Information] palette.

Item bank
Shows/hides the [Item bank] palette.

For details on the [Auto Action] palette, see "Auto Action Palette [PRO/EX]".

For details on the [Information] palette, see "Information Palette".

[Auto action] palette

[Information] palette

[Item bank] palette
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Material
Displays/hides the [Material] palette.

Show/Hide All Palettes
Displays/hides the currently displayed palettes.

For details on the [Item bank] palette, see "Item bank palette".

For details on the [Material] palette, see "Material Palettes".

[Material] palette
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Menus > Window Menu [Windows/macOS/Tablet] > Hide Title Bar/Hide Menu Bar
Hide Title Bar/Hide Menu Bar
On Windows, this hides the [Title Bar] and [Menu Bar] from the main window.

On macOS, this hides the [Title Bar] from the editing window.

On Tablet, this hides the [Menu Bar].

Hiding the Title Bar [Windows/macOS]
Select the [Window] menu > [Hide Title Bar] when the Title Bar and Menu Bar are displayed. The Title Bar will be hidden. When the Title Bar 

is hidden, the window view will be maximized.

Hiding the Menu Bar [Windows/Tablet]
Select the [Window] menu > [Hide Menu Bar] when the Title Bar is hidden and the Menu Bar is displayed. The Menu Bar will be hidden.

Restoring the Title Bar and Menu Bar
On Windows, when the Title Bar and Menu Bar are hidden, hold down the Shift key and press the Tab key. The Title bar and Menu bar will 

appear.

On macOS, when the [Title Bar] is hidden, hold down the Shift key and press the Tab key. The Title Bar will appear.

Title Bar
Menu Bar

Menu Bar

Menu Bar

Title Bar
Menu Bar
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Show Canvas Tab [Windows]
Shows/hides the canvas tab.

 When this turned on, the canvas tab is always displayed.

 If this is turned off, the canvas tab is not shown when there is only one canvas open.

If another canvas is open in a separate window, the canvas tab will be shown when [Show Canvas Tab] is turned 

off.
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Palette dock
You can change the display settings for the palette dock.

Fix the width of the palette dock
Select whether to fix the width of the palette dock.

 When this is turned on, the width of the palette dock is fixed. The width cannot be changed even when the palette dock is dragged.

 When this is turned off, the width of the palette dock can be changed.

Displaying palettes as pop-ups/tabs
You can switch how the palette dock icons work. You can choose from pop-up display or tab display. These settings can be changed for each 

palette dock.

Display (palette name) as pop-up
If you choose [Display (palette name) as pop-up], the palette will be displayed as a pop-up when clicked.

Display (palette name) as tab
If you choose [Display (palette name) as tab], the palette dock will be displayed when you click the palette icon.

You can show or hide the palette dock even when this setting is turned on.

You can also switch these palette dock click settings by right-clicking the palette dock icon. For details, see 

"Switch operation of palette dock icon".
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Menus > Help Menu > Training and Tutorials
 Help Menu
The following describes the [Help] menu in Clip Studio Paint. This section describes the commands in the [Help] menu.

Training and Tutorials
Selecting [Help] Menu  > [Training and Tutorials]  starts the Web browser and shows Clip Studio Paint Training and Tutorials.

You need to be connected to the Internet to access these tutorials.

Getting Started
The “Getting Started” shown at initial startup is displayed when [Help] Menu > [Getting Started] is selected.

Instruction Manual
Selecting [Help] menu > [Instruction Manual] starts the Web browser and shows the Clip Studio Paint online manual.

A network connection is needed to use the online manual.

Support
Selecting [Help] Menu  > [Support] opens the web browser to the Clip Studio Paint support site. In addition to frequently asked questions, you 

can find a community to post questions about Clip Studio Paint.

To access the Clip Studio Paint support website, you need to be connected to the Internet.

Settings to Associate Files [Windows]
When selected, this associates files in the Clip Studio format (extension: clip), management files (extension: cmc) and files in Clip Studio Paint 

format (extension: lip) to Clip Studio Paint.

This may improve conditions in which Clip Studio Paint does not start even when a file in Clip Studio or Clip Studio Paint file is run.

About CLIP STUDIO PAINT [Windows]
Displays the product information of your Clip Studio Paint. You can check information such as the version of your Clip Studio Paint.

Version information [Windows]
Displays Clip Studio Paint's version information and license details.

When configuring [Settings to Associate File], be sure you are logged into your computer with System Adminis-

trator privileges.
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Explanation: Window 
Operation [Windows/
macOS/Tablet]
This chapter describes the Clip Studio Paint screen configuration and how to operate the palettes, palette 

docks and canvas windows. When using a Smartphone, see How to: Smartphone exclusive controls [Smart-

phones].

 Clip Studio Paint Screen Configuration

 Palette and Palette Dock Operation

 Canvas Operations



Explanation: Window Operation  > Clip Studio Paint Screen Configuration
Explanation: Window Operation

 Clip Studio Paint Screen Configuration
The Clip Studio Paint main window roughly consists of the following components.

When using Windows/macOS
When using Windows/macOS, the following screen is displayed.

(1) Title bar

Displays the name of the file being edited, size, resolution, scale of the canvas, name of the software, and so on.

(2) Command bar

Allows you to use various functions by clicking the icons. You can customize the icon view by displaying the icon of frequently used func-

tions, for example. For details on how to use, see "Command bar settings [Windows] [PRO/EX]".

(3) Palette dock

Area accommodating multiple palettes. This can be created at the left, right or bottom of the window.

For details on how to use, see "Palette and Palette Dock Operation".

(4) Palette

Screen for configuring settings. There are various types of palettes. In this screen, palettes are accommodated in palette docks. However, 

they can also be displayed individually as windows or dialog boxes. For details on the palette operation, see "Palette and Palette Dock 

Operation".

(5) Canvas window

Area for editing images as well as drawing. For details, see "Canvas Window".
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When using a Tablet
When using a Tablet, the following screen will be displayed.

(1) Command Bar

Allows you to use various functions by clicking the icons. Customize and register frequently used functions.

To customize, select [CLIP STUDIO PAINT] menu > [Command Bar Settings].

For information on how to configure, see "Command bar settings [Windows] [PRO/EX]".

(2) Palette and Palette Dock

Palette and Palette Dock Area accommodating multiple palettes This can be created at the left, right or bottom of the window.

When using the Tablet, the palette will be display as an icon. Clicking each icon will pop up the corresponding palette.

For information on how to show palettes, see "Toggle display of palette dock".

(3) Canvas window

Area for editing images as well as drawing. For details, see "Canvas Window".
CLIP STUDIO PAINT Instruction Manual 692



Explanation: Window Operation > Clip Studio Paint Screen Configuration > Command Bar
Command Bar
The area on the upper part of the main window where function icons are arranged is called the "Command Bar". Clicking an icon on the [Com-

mand Bar] is equivalent to executing a menu function.

When using Windows/macOS

(1) Open CLIP STUDIO

The included portal application “CLIP STUDIO” will launch.

(2) New

Creates a new canvas necessary for creating an illustration.

(3) Open

Opens a saved illustration or image for re-editing.

(4) Save

Saves an illustration or image being created.

(5) Undo

Clicking it cancels the last operation.

(6) Redo

Clicking it redoes the undone operation.

(7) Delete

Deletes everything drawn on a layer. When there is a selection, deletes everything within the selected area.

(8) Delete Outside Selection

Deletes everything outside the selected area.

(9) Fill

Fills in the selected color. When there is a selection, fills the selected area.

(10)Scale/Rotate

Scales up/down, rotates, or transforms. When there is a selection, scales up/down, rotates or transforms the content of the selected area.

Select the [File] menu > [Command Bar Settings] to customize the items that appear on the [Title Bar]. For details, 

see "Command bar settings [Windows] [PRO/EX]". [PRO/EX]

CLIP STUDIO is a tool for supporting creative activities.
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Explanation: Window Operation > Clip Studio Paint Screen Configuration > Command Bar
(11) Deselect

Deselects a selected area.

(12) Invert selected area

Inverts a selected area.

(13)Show border of selected area

Displays/hides the dashed line indicating a selected area.

(14)Snap to Ruler [PRO/EX]

Configures snap to ruler. When turned on, allows you to draw along a ruler.

(15)Snap to Special Ruler [PRO/EX]

Configures snap to special ruler. When turned on, allows you to draw along a special ruler.

(16)Snap to Grid [PRO/EX]

Configures snap to a perspective ruler grid. When turned on, allows you to draw along the grid lines of a perspective ruler.

(17)CLIP STUDIO PAINT Support

The web browser opens to the support page for Clip Studio Paint.

When using a Tablet

(1) Display the application menu

Display the application menu and select it.

(2) Use different tools with fingers and pen

Switch between using the current tool or the tool assigned as a touch gesture when swiping with one finger.

 When turned on, swiping with one finger will operate the tool defined in the [Modifier Key Settings] dialog. The [Hand] tool will be 

assigned by default.

 When this is turned off, the screen can be swiped with one finger to operate the selected tool.

(3) Open CLIP STUDIO

The [CLIP STUDIO] dialog box opens. CLIP STUDIO is a tool for supporting creative activities.

(4) New

Create a new canvas necessary for a new piece of work.

(5) Open

Opens a saved illustration or image for re-editing.

(6) Save

Saves an illustration or image being created.

In DEBUT, an icon that introduces Clip Studio Paint PRO functionalities is displayed. Clicking the icon opens the 

Web browser to display a Web page that introduces functions available after upgrading to Clip Studio Paint PRO.
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Explanation: Window Operation > Clip Studio Paint Screen Configuration > Command Bar
(7) Undo

Clicking it cancels the last operation.

(8) Redo

Clicking it redoes the undone operation.

(9) Delete

Deletes everything drawn on a layer. When there is a selection, deletes everything within the selected area.

(10)Delete Outside Selection

Deletes everything outside the selected area.

(11) Fill

Fills in the selected color. When there is a selection, fills the selected area.

(12)Scale/Rotate

Scales up/down, rotates, or transforms. When there is a selection, scales up/down, rotates or transforms the content of the selected area.

(13)Deselect

Deselects a selected area.

(14) Invert selected area

Inverts a selected area.

(15)Show border of selected area

Displays/hides the dashed line indicating a selected area.

(16)Snap to Ruler

Configures snap to ruler. When turned on, allows you to draw along a ruler.

(17)Snap to Special Ruler

Configures snap to special ruler. When turned on, allows you to draw along a special ruler.

(18)Snap to Grid

Configures snap to a perspective ruler grid. When turned on, allows you to draw along the grid lines of a perspective ruler.

(19)CLIP STUDIO PAINT Support

The web browser opens to the support page for Clip Studio Paint.
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Explanation: Window Operation > Clip Studio Paint Screen Configuration > Palette
Palette
The screen for configuring various settings is called a "Palette". Multiple [Palettes] can be accommodated in a [Palette dock]. Settings configu-

rable in each palette are as follows.
    

For details on how to use Palettes and Palette docks, see "Palette and Palette Dock Operation".

Quick Access Palette [PRO/EX]

 Register functions for frequently used tools, menu commands, auto actions, and drawing 

colors. Registered functions can be used from the [Quick Access] palette.

For details on the [Quick Access] palette, see "Quick Access Palette [PRO/EX]".

[Tool] palette
Various tools are arranged as buttons. Clicking a button enables the tool for use.

For details on the [Tool] palette, see "Tool-type Palette".

[Sub tool] palette

Each tool comes with preconfigured settings called [Sub tool]. Select a sub tool in accor-

dance with the purpose of the tool to use.

For details on the [Sub tool] palette, see "Sub tool palette".

[Tool Property] palette
Allows you to adjust the settings of the sub tool selected on the [Sub tool] palette.

For details on the [Tool Property] palette, see "Tool property Palette".

[Brush size] palette

Allows you to select a tool size from preconfigured values. Furthermore, it also allows you 

to register the size of the tool you are using in the palette.

For details on the [Brush size] palette, see "Brush Size Palette".

[Sub Tool Detail] palette

[PRO/EX]

Allows you to edit the selected [Sub Tool] setting in more detail than the [Tool Property] 

palette.

For details on the [Sub Tool Detail] palette, see the CLIP STUDIO PAINT Tool Setting 

Guide. 

[Color Wheel] palette
Allows you to configure the drawing color by clicking or dragging the [Color Wheel].

For details on the [Color Wheel] palette, see "Color Wheel Palette".

[Color Slider] palette
Allows you to adjust colors using sliders.

For details on the [Color Slider] palette, see "Color Slider Palette".

[Color Set] palette

In addition to selecting a color from a list of typical colors, it allows you to register and man-

age frequently used colors as a [Color Set].

For details on the [Color Set] palette, see "Color Set Palette".

[Intermediate Color] palette [PRO/

EX]

Allows you to select another color from the reference colors of similar conditions config-

ured in the four corners.

For details on the [Intermediate Color] palette, see "Intermediate color Palette [PRO/EX]".

[Approximate Color] palette [PRO/

EX]

Allows you to select another color of similar conditions to the selected drawing color.

For details on the [Approximate Color] palette, see "Approximate Color Palette [PRO/EX]".

Color history palette

[PRO/EX]

The [Color History] palette displays a history of your drawing colors. You can select draw-

ing colors by clicking the tile of a color.

For details on the [Color History] palette, see "Color History Palette [PRO/EX]".

[Layer] palette

Manages layers. which allows you to change the stacking order of layers, their opacity, and 

the like.

For details on the [Layer] palette, see "Layer Palette".
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Explanation: Window Operation > Clip Studio Paint Screen Configuration > Palette
[Layer Property] palette [PRO/EX]
Allows you to configure settings for a layer.

For details on the [Layer Property] palette, see "Layer Property Palette [PRO/EX]".

[Search Layer] palette

[PRO/EX]

A palette to display layers that match a specified type, for example.

For details on the [Search Layer] palette, see "Search Layer Palette [PRO/EX]".

[Animation cels] palette

The [Animation cels] palette is a palette for managing cels and images to be used as a refer-

ence for drawing.

For details on the [Animation cels] palette, see "Animation Cels palette".

[Timeline] palette

The [Timeline] palette is a palette for specifying the timing and combinations for displaying 

cels, using a timeline.

For details on the [Timeline] palette, see "Timeline palette".

[All sides view] Palette [EX] 

A palette for displaying 3D materials on 3D layers from four directions. When a 3D material 

is placed on the layer, it can be viewed from four directions at the same time. The camera 

position and focal point position of the 3D layer can also be changed.

For details on the [All sides view] palette, see "All Sides View Palette [EX]".

[Navigator] palette

The [Navigator] palette allows you to manage the view of the image displayed on the canvas 

window. Allows you to check the entire image or display position while working with the 

image zoomed in.

For details on the [Navigator] palette, see "Navigator Palette".

[Sub View] palette [PRO/EX]
Allows you to acquire a color from an image displayed as color reference. For details, see 

"Sub view Palette [PRO/EX]".

[History] palette [PRO/EX]

The [History] palette records and manages operation history. Clicking an operation record 

on the palette allows you to reverse operations up that point. For details, see "History Palette 

[PRO/EX]".

[Auto Action] palette [PRO/EX]

Allows you to register multiple operations on the palette and run these operations in one go. 

The registered operations can also be run for another canvas. For details, see "Auto Action 

Palette [PRO/EX]".

[Information] palette
Displays the approximate load that Clip Studio Paint is using on your computer. For details, 

see "Information Palette".

[Item bank] palette
A palette displaying a list of files referred to from the canvas, such as the reference files of 

file object layers. For details, see "Item bank palette".

[Material] palettes

These palettes manage a variety of materials used for drawing illustrations and manga. The 

materials can be dragged and dropped to the canvas for use.

For details on the [Material] palette, see "Material Palettes".
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Explanation: Window Operation > Clip Studio Paint Screen Configuration > Canvas Window
Canvas Window
The window for editing images is called [Canvas window]. The canvas window consists of the following components.

(1) Canvas switching tab

Displays the file name of the canvas being edited. Clicking the tab allows you to switch the canvas to edit.

(2) Canvas

Area (paper) for drawing illustrations.

Canvas control
Configures the display size and angle of the canvas.

You can change the order in which the [Canvas switching tabs] are displayed. Furthermore, canvases can be dis-

played on individual windows. For details, see "Canvas Operations".
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Explanation: Window Operation > Clip Studio Paint Screen Configuration > Canvas Window
(3) Scale up/down slider

Drag the slider to adjust the scale to display the image on the canvas window. Dragging to the right scales up the image while dragging to 

the left scales down the image.

(4) Zoom out

When clicked, zooms out the image displayed on the canvas window.

(5) Zoom in

When clicked, zooms in the image displayed on the canvas window.

(6) 100%

When clicked, displays the image displayed on the canvas window at 100%.

(7) Rotation slider

Drag the slider to adjust the display angle of the image displayed on the canvas window. Dragging to the right rotates the image to the right 

(clockwise) while dragging to the left rotates the image to the left (counterclockwise).

(8) Rotate left

When clicked, rotates the image displayed on the canvas window to the left by a specified angle.

(9) Rotate right

When clicked, rotates the image displayed on the canvas window to the right by a specified angle.

(10)Reset rotation

When clicked, resets the display angle of the image displayed on the canvas window to the original angle (0 degrees).

The canvas controls can be toggled as shown or hidden by selecting the [View] menu > [Scroll Bar].
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Operation
 Palette and Palette Dock Operation
The section describes the palette and palette dock operating procedures.

Palette Operation
The following are items common to all palettes.

A. Title Bar
Area where the palette name is displayed. Palettes can be displayed in a different way as well as displayed/hidden.

(1) Show menu

Displays the setting menu of the relevant palette. For details, see the pages of the relevant palette.

(2) Palette name

Displays the name of the palette name.

B. Setting Screen
The screen where items that can be configured in the palette are displayed. Items displayed vary depending on the palette.

Palettes accommodated in the palette dock can be displayed cascaded as if they were tabs. For details, see "Cas-

cade display palettes".

B

A
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Palette Dock Operation
The following describes how to move palettes accommodated in palette docks, and how to change their size.

Changing the Height of a Palette within a Palette Dock
To change the height of a palette accommodated in a palette dock, proceed as follows.

1 Select the palette
Place the mouse cursor on the bottom edge of the palette whose height you want to change.

2 Change the palette height
Drag the palette edge either upwards or downwards. In this example, it is dragged upwards.
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
3 The height change is complete
The bottom edge of the palette is moved up to the dragged position, changing the palette height.
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Change the palette dock width
To change the palette dock width, proceed as follows.

1 Change the palette dock width
Hover the mouse cursor over the palette dock grip or the dock edge on the canvas side, and drag to the right or left. Dragging in the canvas 

direction widens the palette dock while dragging in the opposite direction narrows the palette dock.

2 The palette dock width change is complete
The border of the palette dock is moved up to the dragged position, changing the palette dock width.

The palette dock width cannot be changed if [Window] menu > [Palette dock] > [Fix the width of palette dock] is 

turned on. Turn [Fix the width of palette dock] off to change the width.

grip
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Moving a Palette within a Palette Dock
To move a palette within the palette dock, proceed as follows.

1 Select the palette
Place the mouse cursor on the title bar of the palette to move.

2 Move the palette
Drag and drop the palette to the desired position. Release the mouse button when a red line displays.

You can move palettes between different palette docks. For example, dragging a palette on the right side and 

dropping it on the left side moves it to the left palette dock.
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
3 The moving of the palette is complete
The palette is moved, changing the order in which in it is displayed.

In this example, the palette is dropped at the top but it can be anywhere.
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Cascade display palettes
Palettes stored in the palette dock are displayed in an overlapping manner. This state is called "tabbed".

1 Select the palette
Place the mouse cursor on the title bar of the palette to be displayed as a tab.

2 Move the palette
Drag and drop the palette inside another palette. When the palettes can be displayed as tabs, the destination palette (the palette where the 

one moved was dropped) displays in red. Release the mouse button to commit.
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
3 The grouping into tabs is complete
The palettes at the destination are displayed as tabs. Clicking a tab switches the palettes.

Selecting a tab and then, dragging and dropping it next to another tab allows you to change the order in which they are displayed.

To display a palette grouped into tabs as an individual palette again, perform "Moving a Palette within a Palette 

Dock" from step 2 onwards.
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Moving Palettes Grouped into Tabs at once
Selecting the empty space on the right side of the tabs will allow you to move the grouped palettes at once. They can be moved anywhere, as 

with individual palettes.
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Displaying Palettes in Individual Windows 
Dragging the tab of a palette outside the palette dock displays that palette in an individual window.

A palette displayed in an individual window can be placed back in the palette dock in the same way as with pal-

ettes grouped into tabs.
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Toggle display of palette dock
To toggle the display of the entire palette dock, use the [Minimize Palette Dock] and [Palette Dock to Icon] icons.

For palette docks on the left and right of the window, icons are displayed above the palette dock.

(1) Minimizing palette dock

(2) Palette Dock to Icon

When the palette dock is located at the bottom of the window, an icon will be displayed on the left side of the palette dock.

(1) Palette Dock to Icon

(2) Minimizing palette dock
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Palette Dock to Icon
Clicking [Palette Dock to Icon] hides the palettes inside the palette dock and changes to icons.

Tap [Palette Dock to Icon] again to displays the palette dock.

 When using a Tablet or a tablet device supporting touch operations, the palette dock is set to icon display by 

default.

 If the [Palette Dock to Icon] option is hidden, click the icon to display the palette. You can choose from two 

ways to display palettes. For details, see "Switch operation of palette dock icon".
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Switch operation of palette dock icon
You can switch this if the palette dock icon is displayed. You can choose from pop-up display or tab display. You can switch the settings for 

each palette dock.

Right click the palette icon. Choose the display method from the menu that pops up

(1) Display palette as tab

If you choose [Display (palette name) as tab], the palette dock will display when you click the palette icon.

When palette docks are overlapping, click the icon again to change the palette dock back to an icon.

(2) Display palette as pop-up

If you choose [Display (palette name) as pop-up], the pop-up will display when you click the palette icon.

When editing on the canvas, the palette closes. When the palette is displayed, clicking anything other than that palette will close it.

You can also switch the operation of icon palettes by going to [Window] > [Palette dock] > [Display (palette name) 

as pop-up] or [Display (palette name) as tab].

Click

Click
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Minimizing palette dock
Clicking [Minimize palette dock] collapses the palette dock and minimizes it.

Clicking the icon again expands the palette dock to its original size.
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Moving Palette Docks
Selecting the top of a palette dock allows you to move the entire palette dock. All palette docks except the ones at the bottom of the window can 

be moved to the same locations as palettes. The palette docks at the bottom of the window cannot be moved.

A palette dock cannot be placed between palettes.
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Displaying overlapping palette docks
Dragging and dropping a palette at the top of the palette dock allows to display the palette docks overlapping. Tabs are created for each palette 

dock, and the display of palette docks can be switched to overlap.

1 Select the palette
Move the mouse cursor to the title bar of the palette that to be displayed overlapping in the palette dock.

2 Move the palette
Drag to the top of the palette dock. When ready to be stacked, the entire palette dock is displayed in red. Release the mouse button to com-

mit.

 Multiple “tabbed” palettes can also be displayed to overlap in the pallet dock. For details on how to select, see 

"Moving Palettes Grouped into Tabs at once".

 Other palette docks can also be stacked and displayed in the palette dock. For details on how to select, see 

"Moving Palette Docks".
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
3 The grouping into tabs is complete
The palette docks stack, and tabs are displayed.

Stacked Palette Dock Operations
When palette docks overlap, tabs will be displayed even when palettes aren’t hidden with [Palette Dock to Icon].

The following operations using stacked palette dock tabs can be performed.

Switching views with the tabs
When displaying a palette in the palette dock, tabs can be used to switch the currently displayed palette dock.

Clicking a tab expands in the palette dock the palettes displayed as icons on the tab.

For details on [Palette Dock to Icon], see "Toggle display of palette dock".

 If the [Palette Dock to Icon] option is hidden, click the icon to display the palette. You can choose from two 

ways to display palettes. For details, see "Switch operation of palette dock icon".

 If the palette is set as to display as tab, you can display the palette dock by clicking the icon. The palette of the 

icon you click will come to the front.

Palette dock

Click
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Switching views with a palette icon
If palettes are stacked in the palette dock, use a tab to display a specific palette in the foreground.

Click the palette icon from the palette dock tab. The palette clicked is displayed in the foreground.

Changing the order of tabs
Select the tab and drag and drop tabs above and below the other tabs to change their order.

For information on how to display stacked palettes, see "Cascade display palettes".

When palettes are hidden with [Palette Dock to Icon], the tab order can be rearranged with similar operations.

Click
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
Fixing a Palette Dock to the Monitor [Windows/macOS]
Dragging the palettes and palette dock up to the right, left or bottom edge of the monitor until a red line displays and dropping the palettes and 

palette dock there fixes the palette dock to the monitor.

In Windows, fixing the palette dock to the monitor is not possible if the main window is maximized.
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Explanation: Window Operation > Palette and Palette Dock Operation > Palette Dock Operation
A palette dock fixed to the monitor does not move even if the main window is moved.

The height of a palette dock on the left or right side of the monitor can be changed by dragging up or down the 

bottom edge of the palette dock.
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Explanation: Window Operation > Canvas Operations > Changing the Order of Canvas Switching Tabs
 Canvas Operations 
This section describes how to change the display order of [Switch canvas] tabs, and how to display a canvas individu-
ally.

Changing the Order of Canvas Switching Tabs
Selecting a [Switch canvas] tab and then, dragging and dropping it next to another tab changes the order in which the tabs are displayed.
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Explanation: Window Operation > Canvas Operations > Displaying Multiple Canvases
Displaying Multiple Canvases 
Selecting a [Switch canvas] tab and then, dragging and dropping it on the canvas window edge allows you to display multiple canvases simul-

taneously.

To tile canvases horizontally, drag and drop the [Switch canvas] tab either at the top or bottom of the canvas window.
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Explanation: Window Operation > Canvas Operations > Displaying Multiple Canvases
To tile canvases vertically, drag and drop the [Switch canvas] tab either on the right edge or left edge of the canvas window.
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Explanation: Window Operation > Canvas Operations > Displaying a Canvas Individually [Windows/macOS]
Displaying a Canvas Individually [Windows/macOS]
The following describes the procedure to display a canvas in an individual window as well as to cancel it.

Displaying a Canvas in an Individual Window
Selecting the [Switch canvas] tab and then, dragging and dropping it outside the canvas window displays the canvas in a separate window.
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Explanation: Window Operation > Canvas Operations > Displaying a Canvas Individually [Windows/macOS]
Selecting the [Switch canvas] tab and then, dragging and dropping it on the canvas side also displays the canvas in a separate window.
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Explanation: Window Operation > Canvas Operations > Displaying a Canvas Individually [Windows/macOS]
Canceling an Individual Canvas Window
Selecting the [Switch canvas] tab and then, dragging and dropping it next to another tab cancels the individual window for the canvas.

Selecting the [Switch canvas] tab and then, dragging and dropping it on the canvas side also cancels the individual window for the canvas.

Dragging the [Switch canvas] tab and dropping it on any of the top, bottom, left and right edges of the canvas win-

dow allows you to tile multiple canvases. For details, see "Displaying Multiple Canvases".
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Quick Access Palette 
[PRO/EX]
The [Quick Access] palette can be opened by selecting the [Window] menu > [Quick Access].

In the [Quick Access] palette, functions such as frequently used tools, menu commands, auto actions, and 

drawing colors can be registered. Registered functions can be used from the [Quick Access] palette. 

 Functions of the quick access palette

 Quick access palette operation



Quick Access palette [PRO/EX]  > Functions of the quick access palette
Quick Access palette [PRO/EX] 

 Functions of the quick access palette
The following will describe the [Quick Access] palette's functions.

(1) Set list

The current quick access set used in the [Quick Access] palette can be changed.

The ‘quick access set' is a group that can register tools and commands based on usage, frequency of use, etc.

(2) Button list

List of functions registered in the quick access list. Functions such as tools, menu commands, auto actions, drawing colors, etc. can be reg-

istered to each button.

 Clicking the button will execute the registered function.

You can change how the set list appears by selecting [Show Menu] > [How to display set lists] in the [Quick 

Access] palette.

You can change how buttons appear by selecting [Show Menu] > [View] in the [Quick Access] palette.
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Quick Access palette [PRO/EX] > Functions of the quick access palette > The quick access palette menu
The quick access palette menu
The following describes the functions included in the menu that will be displayed when [Show Menu] on the upper left corner of the [Informa-

tion] palette is clicked.

Create set
New access sets can be created.

For how to create an auto action set, refer to "Add a quick access set".

Manage set
The selected quick access set's name can be changed.

Delete set
The selected quick access plate can be deleted.

Switching sets
If selected, the quick access set's name will be displayed.

When a quick access set's name is selected, the selected quick access set will be displayed in the [Quick Access] palette.

Display set list
Displays/hides the setlist.

How to display set lists
Set list display methods can be set as well. [Button] and [Pop-up] can be selected.

When the set list is hidden, the displayed quick access set can be changed by selecting [Quick Access] > [Show 

Menu] > [Switch the set].

Show menu

Button Pop-up
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Quick Access palette [PRO/EX] > Functions of the quick access palette > The quick access palette menu
View
Display methods of the buttons in the button list can be changed.

Tile(very small, small, medium, large)

When [Tile] is selected, buttons will be displayed as tiles. Four button sizes are available.

When [Tile(very small)] is selected, button names will not be displayed.

Button size will be fixed regardless of the [Quick Access] palette's width.

Tile(4 step, 8 steps, 16 steps)

Similar to [Tile (very small, small, medium, large)], buttons can be displayed as tiles.

The ‘step' is the maximum amount of buttons allowed in one column. [4 step], [8 step], and [12 step] can be selected.

Button size will change along with the [Quick Access] palette's width.

List(small, medium, large)

When [List] is selected, buttons will be displayed as a list. Three button sizes are available.

When the [Quick Access] palette's width is changed, the number of buttons in a column will change.

List(1 step, 2 steps, 3 steps)

Similar to [List (Small, Medium, Large)], buttons can be displayed as a list.

The ‘step' is the maximum amount of buttons allowed in one column. [1 step], [2 step], and [3 step] can be selected.

The number of buttons in a row will be fixed, regardless of the [Quick Access] palette's width.

Tile very small Tile small

List small List midium
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Change Order 
The [Quick Access] palette's button order method can be selected.

Quick access settings
The [Quick Access Settings] dialog will be displayed, allowing editing of the button list's buttons.

For how to edit button lists, refer to "Button list operation".

For details on the [Quick Access Settings] dialog, see "Quick access settings dialog".

Restore default layout [Windows/macOS/Tablet]
Revert the [Quick Access] palette layout to its initial state.

When reverted to its initial state, added quick access sets and buttons will be deleted, and their position will be reverted.

Hide the quick access palette
Hides the [Quick Access] palette.

Drag Orders can be changed by dragging a button.

Ctrl + drag The order can be arranged by dragging a button while holding down Ctrl.

 Even when settings are reset, display methods set in [How to display set lists] and [View] will be maintained.

 Images and background colors set as button icons will be maintained after deletion.

To show the quick access palette again, select [Quick Access] from the [Window] menu. If you are using a Smart-

phone, tap the icon on the palette bar.
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Button list Menu
It is the menu that is displayed when right-clicking on the button list.

Icon settings
The [Icon settings] dialog box will be shown, allowing the setting of names, display methods, etc. of icons.

For the [Icon settings] dialog, see "Icon settings dialog".

Sub Tool Settings
The [Settings of sub tool] dialog will be displayed, allowing the setting of the name, display method, etc. of the sub tool. It is displayed when 

the sub tool button is right clicked.

For details on the [Settings of sub tool] dialog, see "Sub tool settings dialog".

Name Settings
The [Name Settings] dialog will be displayed, and the color's name can be changed.

The name set here will only be reflected in the [Quick Access] palette.

Deleted
The right clicked button can be deleted.

Add drawing color
The drawing color currently selected in the color palette etc. will be added to the button list.

 Depending on the type and position of the right-clicked button, the items displayed in the menu may differ.

 If you are using a Smartphone, you can also display the button list menu by long pressing above the preview 

in the [Quick Access Settings] dialog box.

 When the menu is displayed over drawing colors, sub tools, etc. this will not be displayed.

 Icons set with the [Icon settings] dialog will reflect those contents set here, even when the same icon is added 

to the [Command bar] or [Selection launcher].

The contents set in the [Settings of sub tool] dialog will be reflected in the [Tool] palette and [Sub Tool] palette, 

among others.

For example, when a sub tool's name is changed, the same name will be applied to the sub tool in the [Sub Tool] 

palette.
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Add Separator
A separator will be added under the button that was right clicked when displaying the menu. Following buttons will be added under the separa-

tor.

Change Order 
The [Quick Access] palette's button order method can be selected.

Quick access settings
The [Quick Access Settings] dialog will be displayed, allowing editing of the button list's buttons.

For how to edit button lists, refer to "Button list operation".

For details on the [Quick Access Settings] dialog, see "Quick access settings dialog".

Delete Separator
The right clicked separator can be deleted.

Unlike other menus, it is displayed when a separator is right clicked. Furthermore, when this item is displayed, other items will not be displayed 

in the menu.

Drag Orders can be changed by dragging a button.

Ctrl + drag The order can be arranged by dragging a button while holding down Ctrl.

By changing [Change Order] to [Ctrl + Drag] in the Quick access palette, the following actions can be performed 

with a pen stylus.

 Scroll through the palette by swiping with a pen, when in an environment that supports touch operations.

 When using a Tablet, you can perform the same operation as a right click by long pressing with a pen.
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Quick access settings dialog
A dialog to edit the [Quick Access] palette's button list. Other than adding and deleting buttons and separators, icon display settings can be 

changed.

(1) Setting area

Categories of the functions to add to the [Quick Access] palette can be selected.

(2) List

Commands selected in [Selected area] are displayed. Functions to add to the [Quick Access] palette can be selected.

(3) Close

Closes the [Quick Access Settings] dialog.

In the initial [Quick Access] palette, other than from the menu display, the [Quick Access Settings] can be dis-

played by clicking the [Quick Access Settings] dialog in the button list.

Main menu The list's display will switch to the Main menu.

Pop-up palette [Windows/

macOS/Tablet]

The list display will switch to a pop-up palette. The pop-up palette is a function that pops up a 

menu next to the mouse cursor.

Options
The list's display will switch to the option contents. Option contents are functions and operations 

that are not included in the menu and tools.

Tool The list will switch to the next tool.

Auto action The list will switch to the next auto action.

Drawing color
On selection, the [Color settings] dialog box will be displayed, and a color can be selected. After 

selection, a color icon will be displayed in the list, and a color can be selected from the color icon.

iPhone
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(4) Add

Items selected in the list can be added to the [Quick Access] palette.

(5) Settings

The item selected from the [Quick Access] palette's button list can be set. Displayed items may vary depending on the selected contents.

(6) Delete

Selected buttons and separators can be deleted from the [Quick Access] palette's button list.

(7) Add Separator

A separator will be added under the buttons selected in the [Quick Access] palette button list. Following buttons will be added under the 

separator.

(8) Restore default layout

Revert the [Quick Access] palette layout to its initial state.

When reverted to its initial state, added quick access sets and buttons will be deleted, and their position will be reverted.

(9) Preview [Smartphone]

Shows a preview of the [Quick Access] palette. Here you can confirm the order in which each option is set.

Main menu
The [Icon settings] dialog will appear. For details on the [Icon settings] dialog, see "Icon settings 

dialog".

Pop-up palette [Windows/

macOS/Tablet]

The [Icon settings] dialog will appear. For details on the [Icon settings] dialog, see "Icon settings 

dialog".

Options
The [Icon settings] dialog will appear. For details on the [Icon settings] dialog, see "Icon settings 

dialog".

Tool
The [Settings of sub tool] dialog will be displayed. For details on the [Settings of sub tool] dialog, 

see "Sub tool settings dialog".

Auto action
The [Icon settings] dialog will appear. For details on the [Icon settings] dialog, see "Icon settings 

dialog".

Drawing color
The [Name Settings] dialog will be displayed. For the [Name Settings] dialog box, see "Name set-

tings dialog".

 Even when settings are reset, display methods set in [How to display set lists] and [View] will be maintained.

 Images and background colors set as button icons will be maintained after deletion.
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Icon settings dialog

(1) Preview

A preview of the icon will be displayed. The image file's settings will be reflected. However, the background color of the icon will not be 

reflected.

(2) Specify image file

Import an image file to use as an icon. Clicking the button displays a dialog box to select an image file for the icon.

Acceptable icon image file formats are: BMP, JPEG, PNG, TIFF and Targa.

(3) Reset to default

Restores the icon display to its default settings

(4) Background color of icon

When turned on, an icon's background color can be set. Clicking the color indicator displays the [Color settings] dialog box where the 

background color can be set.

Name settings dialog
The drawing color's name can be set. Input the drawing color's name in [Name], and click [OK].

The name set here will only be reflected in the [Quick Access] palette.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

 Icons set with the [Icon settings] dialog will reflect the contents set here, even when an icon with the same 

function is added to the command bar or selection launcher.
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Sub tool settings dialog

(1) Name

A sub tool's name can be inputted.

(2) Output process

Displays the output process of the currently selected sub tool.

(3) Input process

Displays the input process of the currently selected sub tool.

(4) Tool icon

When the sub tool is selected, the icon displayed in the [Tool] palette can be specified.

Additionally, switching setting items to [User settings] will display a file selection dialog, where an image file can be selected to be used as 

an icon.

Acceptable icon image file formats are: BMP, JPEG, PNG, TIFF and Targa.

(5)  Background color of icon

When turned on, an icon's background color can be set. Clicking the color indicator displays the [Color settings] dialog box where the 

background color can be set.

 The contents set in the [Settings of sub tool] dialog will be reflected in the [Tool] palette and [Sub Tool] palette, 

among others. For example, when a sub tool's name is changed, the same name will be applied to the sub tool 

in the [Sub Tool] palette.

 Icons set with the [Settings of sub tool] dialog will reflect the contents set here, even when an icon with the 

same function is added to the [Command bar] or [selection launcher].

 For details on [Output process] and [Input process], see "Input Process and Output Process of Sub Tools".

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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 Quick access palette operation
The following will describe how to register frequently used functions to the [Quick Access] palette and customize it for
easy use.

Quick access operation
The ‘quick access set' is a group that can register tools and commands based on usage, frequency of use, etc.

When multiple quick access sets are created, a specific quick access set can be selected from the [Quick Access] palette's [Set list] palette.

Add a quick access set
A quick access set will be added to the [Quick Access] palette

1 Create a quick access set
Select [Show Menu] > [Create set].

2 Set up a quick access set
When the [Create set] dialog is displayed, add a name and click [OK].

3 A quick access set will be created
The quick access set created in the [Create set] dialog will be added to the [Quick Access] palette.

Quick Access lists can be added by dragging and dropping a button in a button list to the edge of a set list.
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Move a quick access set
The quick access set's order can be changed by dragging and dropping while pressing the Ctrl key.

 If you are using a Smartphone, you can change the order of Quick Access Sets by dragging and dropping 

them in [Quick Access Settings] dialog box preview screen. 

 When using Windows/macOS/Tablet, you can change their order by dragging and dropping them while the 

[Quick Access Settings] dialog box is displayed.
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Button list operation
Buttons for tools, menu commands, auto actions, drawing colors, etc. can be registered to the button list. By clicking a button, commands and 

auto actions can be executed, while tools and drawing colors can be switched.

Adding buttons
Buttons with various functions can be added to the quick access palette's button list.

1  Select the command
Select [Show Menu] > [Quick Access Settings].

2 Select where to add a button
Select where to add a button from the [Quick Access] palette.

If you are using a Smartphone, tap where you want to add the button from the preview of the [Quick Access Settings] dialog box.

In the initial [Quick Access] palette, other than from the menu display, the [Quick Access Settings] can be dis-

played by clicking the [Quick Access Settings] dialog in the button list.

A button will be added under or to the right of the clicked button.
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3 Select the button to be added
In the [Quick Access Settings], set as follows.

(1) Select the type of button (function) to add.

(2) Select functions to add to the [Quick Access] palette from the list.

(3) Click [Add].

4 The button will then be added
The selected function's button is then added to the [Quick Access] palette.

If you are using a Smartphone, the button of the selected function is added to the [Quick Access Settings] dialog box preview screen.

 If you are using Windows/macOS/Tablet, you can also add buttons by selecting the function you want to add 

from the [Quick Access Settings] dialog box and dragging and dropping it on the [Quick Access] palette.

 By selecting [Add drawing color] from the menu displayed from right clicking the button list, the current draw-

ing color can be added to the [Quick Access] palette.
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5 Close dialog
Click [Close] in the [Command Bar Settings] dialog box.

Rearranging buttons
By dragging and dropping a button in the button list while pressing Ctrl, the button's position can be changed.

If you are using Windows/macOS/Tablet, you can use the following methods to add functions to the [Quick 

Access] palette.

Drag and drop the icons below to the button list on the [Quick Access] palette.

 The [Tool] palette tool icon

 The [Sub Tool] palette tool icon and its sub tool group

 Auto actions in the [Auto Action] palette

For the [Command Bar] icon and the selection launcher icon, drag and drop them to the button list on the [Quick 

Access] palette while holding down the [Ctrl] key.

However, functions cannot be added when the [Quick Access] palette is a pop up display.

 If you are using a Smartphone, you can change a button’s position by dragging and dropping it in the button 

list on the [Quick Access Settings] dialog box preview.

 Dragging and dropping a button above a separator or a button list's upper and bottom edge will add a row and 

separator to the button's destination.

 You can change a button's position by dragging and dropping it while the [Quick Access Settings] is dis-

played.
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Deleting buttons
Select [Delete] from the menu displayed by right-clicking the button to delete. The button will be deleted.

Moving a button to another quick access palette.
Drag and drop the button list's button to the appropriate quick access set while pressing Ctrl.

Buttons can be deleted from the [Quick Access Settings] as well.

 If you are using Windows/macOS/Tablet, select the button you want to delete from the button list on the [Quick 

Access] palette, and click [Delete] in the [Quick Access Settings] dialog box.

 If you are using a Smartphone, select the button you want to delete from [Quick Access Settings] dialog box 

preview screen and tap [Delete].

 If you are using a Smartphone, drag and drop the button from the button list onto the Quick Access Set you 

want to move it to in the [Quick Access Settings] dialog box preview screen.

 If you are using Windows/macOS/Tablet, you can change the position of the buttons by simply dragging and 

dropping them while the [Quick Access Settings] dialog box is displayed.
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Tool-type Palette
This chapter introduces the tool-type palette functions in CLIP STUDIO PAINT.

 Using the Tool-type Palette

 Tool Palette

 Sub tool palette

 Tool property Palette

 Sub tool detail palette [PRO/EX]
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Tool-type Palette

 What is a Tool-type Palette ?
CLIP STUDIO PAINT comes with the following tool-type palettes.

Using the Tool-type Palette
To use a tool-type palette, proceed as follows.

When using Windows/macOS

1 Select the tool
On the [Tool] palette, select the tool to use.

2 Select the sub tool
On the [Sub tool] palette, select the sub tool for the intended purpose.

Tool Palette Various tools are arranged as buttons. Clicking a button enables the tool for use.

Sub tool palette
Each tool comes with preset settings called [Sub tool]. Allows you to select a sub tool for 

the intended purpose.

Tool property Palette Allows you to adjust the settings of the currently selected sub tool.

Sub tool detail palette [PRO/

EX]

Allows you to adjust the selected [Sub tool] settings in more detail than the [Tool Property] 

palette.

When using a Smartphone, see "Using tools".
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3 Adjust the sub tool settings
On the [Tool Property] palette, adjust the settings of the currently selected sub tool.

4 The tool setup is complete
The tool setup is complete. The tool is now set for the intended purpose.

When using a Tablet

1 Select the tool
On the [Tool] palette, select the tool to use.

The [Sub Tool Detail] palette allows you to configure settings in more detail. For details, see "CLIP STUDIO PAINT 

Tool Setting Guide". [PRO/EX]
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2 Select the sub tool
On the [Sub tool] palette, select the sub tool for the intended purpose.

(1) Tap the tab of the [Sub Tool] palette.

(2) Select a sub tool from the [Sub Tool] palette.

3 Adjust the sub tool settings
On the [Tool Property] palette, adjust the settings of the currently selected sub tool.

(1) Tap the tab of the [Tool Property] palette.

(2) On the [Tool Property] palette, adjust the settings of the currently selected sub tool.

4 The tool setup is complete
The tool setup is complete. The tool is now set for the intended purpose.

The [Sub Tool Detail] palette allows you to configure settings in more detail. For details, see "CLIP STUDIO PAINT 

Tool Setting Guide". [PRO/EX]
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 Functions of the Tool-type Palette
This section describes the functions of the tool-type palettes by palette.

Tool Palette
The [Tool] palette displays when [Window] menu → [Tool] is selected.

Various tools are arranged as buttons. Clicking a button enables the tool for use.

A. Tool Buttons
Various tools are arranged as buttons. Clicking a button enables the tool for use.

Note that a tool button is displayed with the icon of the selected sub tool.

B. Color Icon
Displays the currently selected drawing color along with readily available drawing colors.

In the example below, the readily available colors are (in the order of their availability) "red", "blue" and "transparent". "Red", which is 

displayed with a border, is the currently selected drawing color. To change the color, click the relevant color indicator.
 

(1) Main color

Set the primary (most frequently used) color.

Double clicking displays the [Color settings] dialog box where a color can be selected.

For details on the functions of each tool, see "Tool List".

A

B
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(2) Sub color

Set the next most frequently used color.

This will be the background color when you specify [Create both line and fill] with the [Figure] tool, or you create a balloon.

Double clicking displays the [Color settings] dialog box where a color can be selected.

(3) Transparent color

Select to use transparent color.

For the [Color settings] dialog box, refer to "Advanced settings of color Dialog Box".

For the [Color settings] dialog box, refer to "Advanced settings of color Dialog Box".
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Tool Palette Menu
The following describes the functions included in the menu that displays when you click [Palette menu] on the upper left corner of the [Tool] 

palette.

Tool settings
Displays the [Tool settings] dialog box where you can set a name for the tool.

Delete tool
Deletes the selected tool and all sub tools included in the tool.

Add from default
This opens the [Add from default] dialog box, where you can add tools to the initial settings. If you delete a tool from the initial settings, you 

can add it back here.

Select a sub-tool to from [Add from default] dialog box and click [OK] to add the selected tool to the [Tool] palette.

Show menu
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Migrate tool preferences > From IllustStudio [Windows] [PRO/EX] 
Allows you to add all IllustStudio tools to the [Tool] palette in one go. [Brush shape] and [Texture] used in the tool are added to the [Material] 

palette.

[Migrate tool preference from IllustStudio] Dialog Box

(1) Location of IllustStudio user data folder

Displays the location of the IllustStudio user data folder.

If the user data folder has been moved using the IllustStudio preferences, 

click [refer] to specify the user data folder on the [Browse folder] dialog box.

(2) Location of IllustStudio execution file

Displays the location of the IllustStudio executable file.

If the installation folder of the application has been moved at the time of 

installing IllustStudio, click [refer] to specify [IllustStudio.exe] on the [Please 

select [IllustStudio].] dialog box.

(3) Brush pattern material to import

Settings to import [Brush shape] from IllustStudio. You can select either [All 

pattern materials] or [Only pattern materials used in tool].

Selecting [Only pattern materials used in tool] will exclude [Brush shape] not 

used in the IllustStudio tool set.

(4) Tool type to import

Select the tool(s) to import from IllustStudio.

To select, check the boxes next to the tool name. You can select multiple 

tools.
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Migrate tool preferences → From ComicStudio 4.0 [Windows/macOS] [PRO/EX]
Allows you to add all ComicStudio 4.0 tools to the [Tool] palette in one go. [Brush shape] used in the tool are added to the [Material] pal-

ette.When using Macs with Apple M1 chips, this will not be displayed.

[Migrate tool preference from ComicStudio 4.0] Dialog Box

(1) Location of Comic Studio 4.0 user data 

folder

Displays the location of the ComicStudio 4.0 user data folder.

If the user data folder has been moved using the ComicStudio 4.0 preferences, click 

[refer] to specify the user data folder on the [Browse folder] dialog box.

(2) Location of ComicStudio 4.0 execution file

Displays the location of the ComicStudio 4.0 executable file.

If the installation folder of the application has been moved at the time of installing 

ComicStudio 4.0, click [refer] to specify either of the files below on the [Please 

select [ComicStudio 4.0].] dialog box.

Windows users

 Users of ComicStudio EX 4.0: CS_EX.exe

 Users of ComicStudio Pro 4.0: CS_Pro.exe

 Users of ComicStudio Debut 4.0: CS_Debut.exe

For macOS

 Users of ComicStudioEX4.0: ComicStudio EX.app

 Users of ComicStudioPro4.0: ComicStudio Pro.app

 Users of ComicStudioDebut4.0: ComicStudio Debut.app

(3) Tool type to import
Select the tool(s) to import from ComicStudio 4.0.

To select, check the boxes next to the tool name. You can select multiple tools.
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Show color icon 
When turned on, the color icons are displayed on the [Tool] palette.

Change Order 
The order method can be selected in [Tool] on the [Tool] palette.

Hide tool palette
Hides the [Tool] palette.

Customizing the Tool Palette
You can change the order in which [Tools] are arranged. Furthermore, you can drag and drop [Sub Tool] and [Tool Group] from the [Sub tool] 

palette to have them registered in the [Tool] palette.

Changing the Tool Layout
The [Tool] layout on the palette can be changed by dragging the buttons.

Drag The tool layout on the palette can be changed by dragging a tool.

Ctrl + drag The tool layout on the palette can be changed by dragging a tool while holding down Ctrl.

To show the Tool palette again, select the palette from the [Window] menu. If you are using a Smartphone, tap the 

icon on the palette bar.

If Ctrl + Drag is selected for [Show Menu] > [Change order] on the [Tool] palette, the tool order can be changed by 

dragging a tool while holding [Ctrl].

Dragging and dropping to the tool group separator displays separator lines above and below the moved tool.

Show color icon: Off Show color icon: On

Color icon
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Adding a Sub Tool to the Tool Palette
Dragging and dropping a [Sub Tool] between the tool icons on the [Tool] palette adds the [Sub Tool] to the [Tool] palette.

 If Ctrl + Drag is selected for [Show Menu] > [Change order] on the [Sub Tool] palette, a sub tool can be added 

to the [Tool] palette by dragging it while holding Ctrl.

 If you are using a Smartphone, you can add a sub tool to the [Tool] palette by displaying the [Tool] palette and 

[Sub tool] palette at the same time. For details on how to display a palette, see "Palette Bar Settings".

 If you are using a Smartphone, you can also add a sub tool to the [Tool] palette using the [Select sub tool] dia-

log box. Swipe the sub tool horizontally and drag and drop it on the icon of the tool you want to move it to.
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Adding a Tool Group to the Tool Palette
Dragging and dropping a [Tool group] icon between the tool icons on the [Tool] palette adds [Tool group] to the [Tool] palette.

 If Ctrl + Drag is selected for [Show Menu] > [Change order] on the [Sub Tool] palette, a tool group icon can be 

added to the [Tool] palette by dragging it while holding down the Ctrl.

 If you are using a Smartphone, you can add a tool group to the [Tool] palette by displaying the [Tool] palette 

and [Sub tool] palette at the same time. For details on how to display a palette, see "Palette Bar Settings".

 If you are using a Smartphone, you can also add a tool group to the [Tool] palette using the [Select sub tool] 

dialog box. Swipe the sub tool horizontally and drag and drop it on the icon of the tool you want to move it to.
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Sub tool palette
The [Sub tool] palette displays when [Window] menu → [Sub tool] is selected.

Each tool comes with preset settings called [Sub tool].

Each button has a sub tool assigned. Click to change the [Tool Property] palette settings.

Depending on the palette, you may click [Group switch] to display the sub tools of a different group.

(1) Switch Group

Switch between groups of tools, for tools with multiple groups.

(2) Sub Tool

This is a list of sub tools included in the group. Select sub tools from here.

(3) Import sub tool material

The [Import sub tool material] dialog is displayed, and materials downloaded from CLIP STUDIO ASSETS can be loaded.

(4) Duplicate sub tool

Displays the [Duplicate sub tool] dialog box to copy the currently selected sub tool. For details, see "Sub tool Palette Menu".

(5) Delete sub tool

Deletes the currently selected sub tool.

For details on the [Import sub tool material] dialog box, see "Sub tool Palette Menu".
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Sub tool Palette Menu
The following describes the functions included in the menu that displays when you click [Palette menu] on the upper left corner of the [Sub 

tool] palette.

Settings of sub tool group
Displays the [Settings of sub tool group] dialog box where you can set a name for the sub tool.

Duplicate sub tool
Displays the [Duplicate sub tool] dialog box to copy the currently selected sub tool.

[Duplicate sub tool] Dialog Box

Some menu items can be run from the context menu that displays when you right click the mouse.

(1) Name Input a name for the sub tool.

(2) Output process Displays the output process of the currently selected sub tool.

(3) Input process Displays the input process of the currently selected sub tool.

(4)Tool icon

Specify the icon to display on the [Tool] palette when the sub tool is selected.

Switch a setting to [User settings] to display a file selection dialog that allows you to select an image 

file to use as an icon.

(5) Background color of icon
Set the background color for the icon to display on the [Tool] palette when the sub tool is selected. 

Clicking the color indicator displays the [Color settings] dialog box.

 For details on [Output process] and [Input process], see "Input Process and Output Process of Sub Tools".

 Acceptable file formats for [Tool icon] → [User settings] are: BMP, JPEG, PNG, TIFF and Targa.

The image can be changed by specifying an image and then clicking [User settings] again.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

Show menu
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Tool-type Palette > Functions of the Tool-type Palette > Sub tool palette
Settings of sub tool
Displays the [Settings of sub tool] dialog box where you can edit the name of the currently selected sub tool.

Sub tool settings dialog

Delete sub tool
Deletes the currently selected sub tool.

(1) Name Input a name for the sub tool.

(2) Output process Displays the output process of the currently selected sub tool.

(3) Input process Displays the input process of the currently selected sub tool.

(4)Tool icon

Specify the icon to display on the [Tool] palette when the sub tool is selected.

Switch a setting to [User settings] to display a file selection dialog that allows you to select an 

image file to use as an icon.

(5) Background color of icon
Set the background color for the icon to display on the [Tool] palette when the sub tool is selected. 

Clicking the color indicator displays the [Color settings] dialog box.

 For details on [Output process] and [Input process], see "Input Process and Output Process of Sub Tools".

 Acceptable file formats for [Tool icon] → [User settings] are: BMP, JPEG, PNG, TIFF and Targa.

The image can be changed by specifying an image and then clicking [User settings] again.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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Tool-type Palette > Functions of the Tool-type Palette > Sub tool palette
Create custom sub tool [PRO/EX]
Displays the [Create custom sub tool] dialog box to add the current settings on the [Tool Property] palette as a new sub tool.

[Create custom sub tool] Dialog Box

(1) Name Input a name for the sub tool.

(2) Output process Set an output process for the sub tool.

(3) Input process Set an input process for the sub tool.

(4) Tool icon

Specify the icon to display on the [Tool] palette when the sub tool is selected.

Switch a setting to [User settings] to display a file selection dialog that allows you to select an image 

file to use as an icon.

(5) Background color of icon
ConSet figure the background color for the icon to display on the [Tool] palette when the sub tool is 

selected. Clicking the color indicator displays the [Color settings] dialog box.

 For details on [Output process] and [Input process], see "Input Process and Output Process of Sub Tools".

 Acceptable file formats for [Tool icon] → [User settings] are: BMP, JPEG, PNG, TIFF and Targa.

The image can be changed by specifying an image and then clicking [User settings] again.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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Tool-type Palette > Functions of the Tool-type Palette > Sub tool palette
Add from default
This opens the [Add from default] dialog box, where you can add tools to the initial settings. If you delete a sub tool from the initial settings, 

you can add it back here.

Select a sub-tool to from [Add from default] dialog box and select [OK] to add the selected tool to the [Sub Tool] palette.

Lock [PRO/EX]
Saves the values set on the [Tool Property] palette to the currently selected sub tool. When locked, the settings on the [Tool Property] palette 

can be changed but when the same sub tool is selected again, the settings are restored to those at the time of [Lock].

Reset to default
Resets the settings on the [Sub tool] palette and restores the selected sub tool settings to their initial values.

Save as default
Registers the settings on the [Sub tool] palette as the initial settings for the selected sub tool.

Modifier key settings [PRO/EX]
Opens the [Modifier Key Settings] dialog box where you can set modifier keys for the selected sub tool.

Import sub tool [PRO/EX]
Sub Tool Files (extension: .sut) and Photoshop brush files (extension: .abr) can be imported and registered to the [Sub Tool] palette. When 

using Windows/macOS, IllustStudio and ComicStudio tool sets (extension: .tos) can also be imported.

Sub tools added from the [Add from default] dialog box will be added to the currently selected sub tool group.

Locked sub tools are displayed on the [Sub tool] palette with a [Lock] icon. 

For details on the [Modifier Key Settings] dialog box, see "Modifier key settings [Windows] [PRO/EX]".
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Tool-type Palette > Functions of the Tool-type Palette > Sub tool palette
Export sub tool [PRO/EX]
Exports (saves) the selected [Sub Tool] to a sub tool file (extension: sut).

Register sub tool as material [PRO/EX]
Displays the [Material property] dialog box to register the selected sub tool in a [Material] palette.

[Material property] Dialog Box

(1) Material name

Input a name for the material.

(2) Location to save material

Click a folder to specify the location to save the material. The specified location is applied to the [Tree view] on the [Materials] palette.

(3) Search tag

Click the tag list and specify a search tag displayed in the [Tag list].

Clicking the tag with a + sign in the lower right will allow you to create a new tag.

When using Android/Macs with Apple M1 chips, IllustStudio and ComicStudio tool sets (extension: .tos) cannot be 

imported.

 Sub tool files (extension: .sut) and IllustStudio and ComicStudio tool sets (extension: tos) can also be 

imported to the [Sub tool] palette using drag and drop.

 When Photoshop brush files with multiple brush settings are imported, a sub tool group will be added to the 

[Sub Tool] palette.

 A sub tool can also be registered as material by dragging and dropping the selected sub tool to a [Material list] 

on the [Material] palette. When registered in this way, the [Material property] dialog box does not display.

 Sub tools registered to the [Material] palette can be uploaded to the CLIP server using the included portal 

application, CLIP STUDIO. For details on uploading methods, please see Clip Studio TIPS.

 Clip Studio can be started from the [File] menu ([CLIP STUDIO PAINT] menu on macOS and Tablet) > [Open 

CLIP STUDIO]. For the Smartphone, select [Menu] > [Usage / Material / Work / Support].
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Tool-type Palette > Functions of the Tool-type Palette > Sub tool palette
Import sub tool material
The [Import sub tool material] dialog is displayed and sub-tool materials downloaded from CLIP STUDIO ASSETS are imported.

By selecting the sub-tool material to load from the [Sub Tool List], and clicking [OK], the sub tool material is loaded into the [Sub Tool] pal-

ette.

[Import sub tool material] dialog box

(1) Search box

Enter keywords and search for sub tool materials.

(2) Tag list

A list of tags assigned to materials displayed as buttons. When clicking the button, the sub-tool material with the specified parameter is 

displayed in the [Sub tool List].

(3) Sub Tool List

Display sub tool materials downloaded from CLIP STUDIO ASSETS in a list.

(4) Show item checkbox

A checkbox is displayed for each thumbnail of the sub tool materials displayed in the [Sub Tool List]. You can select a material by turning 

on the checkbox.

(5) Thumbnail [Large]

The thumbnail of the sub tool materials displayed in the [Sub Tool List] is displayed large.

(6) Thumbnail [Small]

The thumbnail of the sub tool materials displayed in the [Sub Tool List] is displayed small.

(7) Thumbnail [Detail]

In addition to thumbnails of the sub tool materials displayed in the [Sub Tool List], information on the sub tool materials is displayed.
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Tool-type Palette > Functions of the Tool-type Palette > Sub tool palette
View
Set how to display each sub tool button.

Stroke

Displays sub tool buttons as strokes. Strokes can be used only for drawing tools such as pen and brush. For others, a text is displayed.

Tile/Tile small

Displays sub tool buttons as tiles. Tiles come in two sizes.

Text

Displays the sub tool buttons using text.

Show group name of sub tool
When turned on, displays the sub tool group name next to the [Switch group] icon.

Tile Tile small

Show group name of sub tool: on Show group name of sub tool: off
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Tool-type Palette > Functions of the Tool-type Palette > Sub tool palette
Show command bar 
When turned on, the command bar is displayed on the [Sub tool] palette.

Change Order 
The icon order method can be selected in [Tool Group] in [Sub Tool] on the [Sub Tool] palette.

Hide sub tool palette
Hides the [Sub tool] palette.

Input Process and Output Process of Sub Tools
The following describes what sub tool input process and output process are.

In CLIP STUDIO PAINT, a sub tool operation is defined as a combination of an [Input process] and [Output process].

For example, for [Lasso] and [Selection pen], the [Input process] and [Output process] are set as follows:

In the examples above, how the tools are specified (input process) are different but the operation "Create selection" (output process) is common 

to both.

Drag The sub tool and tool group layout on the palette can be changed by dragging the icons.

Ctrl + drag The sub tool and tool group layout on the palette can be changed by dragging the icons while holding down Ctrl.

To show the [Sub Tool] palette again, select the palette from the [Window] menu > [Sub Tool]. If you are using a 

Smartphone, tap the icon on the palette bar.

Input process Indicates how to specify the tool.

Output process Indicates the target to be created or processed.

Tool name Input process Output process

Lasso Lasso Selection

Selection pen Brush Selection

Show command bar: Off Show command bar: On

Command barCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCCC
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Tool-type Palette > Functions of the Tool-type Palette > Sub tool palette
Customizing the Sub Tool Palette
You can change the order in which [Sub tools] are arranged. Furthermore, you can also manage [Sub Tool] by tool group, by creating new tool 

groups, changing their display order, and so on.

Changing the Sub Tool Layout
The [Sub Tool] layout on the palette can be changed by dragging the buttons.

Changing the Tool Group Layout
The tool group layout on the palette can be changed by dragging the buttons.

Creating a Tool Group
To create a tool group, drag and drop a [Sub Tool] to the empty space next to the tool group icons. A new tool group is created.

If Ctrl + Drag is selected for [Show Menu] > [Change order] on the [Sub Tool] palette, the sub tool and tool group 

order can be changed by dragging a sub tool or tool group while holding down Ctrl.
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Tool-type Palette > Functions of the Tool-type Palette > Sub tool palette
Moving to Another Tool Group
Dragging and dropping a [Sub Tool] to the icon of another tool group moves the [Sub Tool] to that tool group.

Moving a Tool Group to Another Tool
Dragging and dropping a [Tool group] icon to another tool icon on the [Tool] palette moves the [Tool group] to that tool.

Dragging and dropping a button to the space between two tool group icons is also possible.

 Dragging and dropping a button to the space between two tool group icons is also possible.

 If you are using a Smartphone, you can add a tool group to the [Tool] palette by displaying the [Tool] palette 

and [Sub tool] palette at the same time. For details on how to display a palette, see "Palette Bar Settings".

 If you are using a Smartphone, you can also add a tool group to the [Tool] palette using the [Select sub tool] 

dialog box. Swipe the sub tool horizontally and drag and drop it on the icon of the tool you want to move it to.
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Tool-type Palette > Functions of the Tool-type Palette > Tool property Palette
Tool property Palette
The [Tool Property] palette displays when [Window] menu → [Tool Property] is selected.

The [Tool Property] palette adjusts the settings of the selected sub tool.

(1) Stroke preview

Previews the stroke of the selected sub tool.

(2) Lock [PRO/EX]

Saves the values set on the [Tool Property] palette to the currently selected sub tool. When locked, the settings on the [Tool Property] pal-

ette can be changed but when the same sub tool is selected again, the settings are restored to those at the time of [Lock].

(3) Tool property

Allows you to adjust the settings of the sub tool selected on the [Sub tool] palette.

(4) Initial settings

Resets the settings on the [Tool Property] palette and restores the selected sub tool settings to their initial values.

(5) Sub tool detail [PRO/EX]

When turned on, displays the [Sub Tool Detail] palette. When turned off, closes the [Sub Tool Detail] palette.

Items with values set by a slider can be switched to an indicator. For details on how to change, see "Right-click 

menu [Windows/macOS]".

Locked sub tools are displayed on the [Sub tool] palette with a [Lock] icon.

Items available on the [Tool Property] vary depending on the selected sub tool. For tool-specific items, see "Tool 

List".

The [Sub Tool Detail] palette allows you to edit the selected sub tool setting in more detail than the [Tool Property] 

palette. For details, see the CLIP STUDIO PAINT Tool Setting Guide.
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Tool-type Palette > Functions of the Tool-type Palette > Tool property Palette
Tool property Palette Menu
The following describes the functions included in the menu that displays when you click [Palette menu] on the upper left corner of the [Tool 

Property] palette.

Lock [PRO/EX]
Saves the values set on the [Tool Property] palette to the currently selected sub tool. When locked, the settings on the [Tool Property] palette 

can be changed but when the same sub tool is selected again, the settings are restored to those at the time of [Lock].

Reset to default
Resets the settings on the [Tool Property] palette and restores the selected sub tool settings to their initial values.

Save as default
Registers the settings on the [Tool Property] palette as the initial settings of the selected sub tool.

Modifier key settings [PRO/EX]
Opens the [Modifier Key Settings] dialog box where you can set modifier keys for the selected sub tool.

Show Category 
When turned on, displays category division line of the [Sub Tool Detail] palette on the [Tool Property] palette.

For details on the [Modifier Key Settings] dialog box, see "Modifier key settings [Windows] [PRO/EX]".

Show menu

Show Category: OffShow Category: On
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Tool-type Palette > Functions of the Tool-type Palette > Tool property Palette
Show stroke preview 
When turned on, displays [Stroke preview].

Show command bar 
When turned on, displays the command bar of the [Tool Property] palette.

Hide tool property palette
Hides the [Tool Property] palette.

To show the Tool Property palette again, select the palette from the [Window] menu. If you are using a Smart-

phone, tap the icon on the palette bar.

Show stroke preview: Off Show stroke preview: On

Stroke preview

Show command bar: Off Show command bar: On

Command bar
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Tool-type Palette > Functions of the Tool-type Palette > Tool property Palette
Right-click menu [Windows/macOS]
The following describes how to set the palettes using the menu that displays when an item on the palette is right-clicked.

(1) Copy value

Copies the setting values of the item to other sub tools. You can select one of the following copy destinations:

 Copy to all sub tools within same group

 Copy to all sub tools within same tool

 Copy to all sub tools within all tools

(2) Copy displayed status

Copies the displayed status of the slider/indicator to other sub tools. You can select one of the following copy destinations:

 Copy to all sub tools within same group

 Copy to all sub tools within same tool

 Copy to all sub tools within all tools

When using a Tablet/Smartphone, the right-click menu cannot be displayed. You can perform the same operation 

from the menu displayed by clicking [Show Sub Tool Detail Menu] on the [Sub Tool Detail] palette. For details, see 

"Sub tool detail palette [PRO/EX]".

Right-clicking over the slider/indicator

Right-clicking over any item other than the slider/indicator
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Tool-type Palette > Functions of the Tool-type Palette > Tool property Palette
(3) Show slider

Switches the indicator display to slider display.

(4) Show indicator

Switches the slider display to indicator display.

(5) Indicator settings

Selecting the menu item displays the [Indicator settings] dialog box. On the dialog box, you can register a value to each indicator bar.

(1) Input a value in the input field of each indicator bar. Click the button on the right to set the value with the slider.

(2) Clicking [OK] registers the input values.

[Show slider] displays when you right-click over a slider/indicator.

 [Show indicator] appears when you right-click over a slider/indicator.

 The set value is not displayed for indicator display. Click the arrow button to the right of the indicator to show 

the value currently being set.

[Indicator settings] appears when you right-click over a slider/indicator.

When configuring values with the [Indicator settings] dialog box, be sure the values are decreasing to the left and 

increasing to the right.
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Tool-type Palette > Functions of the Tool-type Palette > Sub tool detail palette [PRO/EX]
Sub tool detail palette [PRO/EX]
The [Sub Tool Detail] palette can be opened by selecting the [Window] menu > [Sub Tool Detail]. Allows you to adjust the settings of the cur-

rently selected sub tool.

The display of the [Sub tool details] palette changes when the size is reduced. If you are using a Smartphone, the categories are displayed at the 

top.

(1) Category

Select the category of the item to set.

When using a Smartphone or when the [Sub Tool Detail] palette width is reduced, category can be selected from the pull-down menu at the 

top of the palette. Category can also be switched by clicking [<] and [>] in the pull-down menu.

(2) Stroke preview

Previews the stroke of the sub tool being set.

 The [Sub Tool Detail] palette also displays when [Sub Tool Detail] on the [Tool Property] palette is clicked.

 There is no [Window] menu on the Smartphone. Tap [Sub Tool Detail] on the [Tool Property] palette to display 

the [Sub Tool Detail] palette.

 When using Windows/macOS/Tablet, the category is displayed at the top of the palette when the width of the 

[Sub Tool Detail] palette is reduced. Category can be selected from the pull-down menu.

 Reducing the width of the [Sub Tool Detail] palette may hide the stroke preview, information display, [Reset all 

settings to default] and [Save as default]. When all settings cannot be displayed, they are displayed broken up 

into [Category name 1], [Category name 2], etc.

SmartphoneWindows/mac/Tablet
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Tool-type Palette > Functions of the Tool-type Palette > Sub tool detail palette [PRO/EX]
(3) Show in tool property

Set items to be displayed on the [Tool Property] palette. Turned on items can also be adjusted from the [Tool Property] palette when the 

sub tool with configured settings is selected.

(4) Show sub tool detail menu display

Clicking the button displays a menu that allows you to copy the setting values or showing status to other sub tools.

Copy value

Copies the setting values of the item to other sub tools. You can select one of the following copy destinations:

 Copy to all sub tools within same group

 Copy to all sub tools within same tool

 Copy to all sub tools within all tools

Copy displayed status

Copies the displayed status of the item to other sub tools. You can select one of the following copy destinations:

 Copy to all sub tools within same group

 Copy to all sub tools within same tool

 Copy to all sub tools within all tools

Show Indicator

Switches the slider display to indicator display.

Show slider

Switches the indicator display to slider display.

The set value is not displayed for indicator display. Click the arrow button to the right of the indicator to show the 

value currently being set.
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Tool-type Palette > Functions of the Tool-type Palette > Sub tool detail palette [PRO/EX]
Indicator settings

Selecting the menu item displays the [Indicator settings] dialog box. On the dialog box, you can register a value to each indicator bar.

(1) Add a value into each field of the indicator bar. Click the button on the right to set the value with the slider.

(2) Clicking [OK] registers the input values.

(5) Settings of sub tool

Configure the sub tool settings in detail.

(6) Information area

Displays setting tips, preview of the settings and the like.

(7) Show Category

When turned on, displays category division lines on the [Tool Property] palette.

(8) Reset all settings to default

Restores the settings of the selected sub tool to their initial values.

(9) Register all settings to initial settings

Registers the settings for the selected sub tool as its initial settings.

(10)Close [Smartphone]

Closes the [Sub Tool Detail] palette.

When configuring values with the [Indicator settings] dialog box, be sure the values are decreasing to the left and 

increasing to the right.

Items that can be set vary depending on the selected tool and sub tool. For details, see the CLIP STUDIO PAINT 

Tool Setting Guide.

Depending on the selected category, the palette height may need to be increased for settings preview to display.
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Tool List
This chapter introduces the functions in the [Tool] palette by tool.



Tool List  > Zoom Tool
Tool List

 Zoom Tool
The zoom tool allows you to zoom in or out the screen view.

To zoom in or out, click or drag on the canvas.

The [Zoom] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details, see the "CLIP STU-

DIO PAINT Tool Setting Guide".

Click or drag
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Tool List  > Move Tool
 Move Tool
The [Move] tool allows you to scroll as well as rotate the screen view.

The [Move] tool comes with preconfigured settings called [Sub Tool]. You can change the sub tool by clicking the but-
tons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Example of Sub Tool: Hand
Selecting [Hand] on the [Sub tool] palette allows you to scroll the screen view. To scroll, drag on the canvas.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details, see the "CLIP STU-

DIO PAINT Tool Setting Guide".

Example of sub tool: Palm
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Tool List  > Move Tool
Example of Sub Tool: Sub Tool
Selecting [Rotate] on the [Sub tool] palette allows you to rotate the screen view. To rotate, drag on the canvas.

Example of sub tool: Rotation
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Tool List  > Operation Tool
 Operation Tool
The [Operation] tool allows you to transform/rotate image materials/frame borders, select layers, operate 3D materials
and rulers, and so on.

The [Operation] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Example of Sub Tool: Object
Selecting [Object] on the [Sub tool] palette allows you to move, transform and rotate frame borders, imported images and the like.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details, see the "CLIP STU-

DIO PAINT Tool Setting Guide".

When using Windows/macOS, right clicking the canvas when the [Object] sub tool is selected displays a menu. 

The displayed menu items vary depending on the content of the edited layer.

Example of sub tool: Object

Allows you to move, transform and rotate frame borders, imported images and the like.
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Tool List  > Operation Tool
Example of Sub Tool: Select layer
Selecting [Select layer] on the [Sub tool] palette allows you to select a particular layer from an image composed of multiple layers.

 Clicking on the canvas selects the layer if it includes a drawn area. When multiple layers are stacked, the topmost layer with a drawn area is 

selected.

 Specifying a selection by dragging the tool on the canvas selects a layer including a drawn area within the selected area.

Example of Sub Tool: Light table
Selecting [Light table] on the [Sub tool] palette allows you to operate the light table layer on the canvas. You can change the size, position and 

angle of the light table layer by dragging the handles of the light table layer.

For details on the light table layer, see "About the Animation Cels Palette".

Click

Example of Sub Tool: Select layer

Selecting [Select layer] on the [Sub tool] palette allows you to select a particular layer from an image composed of multiple layers.

Example of Sub Tool: Light table

You can change the size, position and angle of the light table layer by dragging the handles of the light table layer.

Drag
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Tool List  > Operation Tool
Example of Sub Tool: Edit timeline
Selecting [Edit timeline] on the [Sub tool] palette allows you to move the frame selected in the timeline on the canvas. Click and drag a frame 

in the timeline to move it forward or back.

Example of Sub Tool: Edit timeline

Click and drag a frame in the timeline to move it forward or back.

Drag
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Tool List  > Move layer Tool
 Move layer Tool
The [Move layer] tool allows you to move only a specific layer image. Tone patterns and grids can also be moved.

Dragging on the canvas, moves the selected layer.

The [Move layer] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see the 

CLIP STUDIO PAINT Tool Setting Guide.
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Tool List  > Marquee Tool
 Marquee Tool
The [Marquee] tool is a tool that allows you to create all kinds of selections depending on a shape or drawing.

The [Marquee] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

 Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see 

the CLIP STUDIO PAINT Tool Setting Guide.

 Creating a selection displays a [Selection Launcher] below the selected area. For details, see "Selection 

Launcher".
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Tool List  > Marquee Tool
Example of Sub Tool: Rectangle/Ellipse
Selecting [Rectangle]/[Ellipse] on the [Sub tool] palette allows you to create a rectangular/elliptical selection.

Example of sub tool: Lasso
Selecting [Lasso] on the [Sub tool] palette allows you to create a selection of any shape.

Dragging while holding down Shift will allow you to create circular or square selection.

Example of sub tool: Rectangle selection

Allows you to create a rectangular or circular selection area.

Example of sub tool: Lasso selection

Allows you to create a selection area of any shape.
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Tool List  > Marquee Tool
Example of Sub Tool: Polyline
Selecting [Polyline] on the [Sub tool] palette allows you to create a selection composed of straight line segments.

Example of Sub Tool: Selection pen/Erase selection
Selecting [Selection pen] or [Erase selection] on the [Sub tool] palette allows you to create a selection as drawn.

 To close a selection, double click or click the starting point.

 To cancel all the specified points, press [Esc].

 To cancel the point specified last, press [Delete].

Selection pen Dragging on the canvas creates a selection in the dragged area.

Erase selection Dragging on a selected area deletes the dragged area from the selection.

Example of sub tool: Polyline selection

Allows you to create a selection area composed of straight line segments.

Example of sub tool: Selection pen

Dragging on the canvas creates a selection area in the dragged area.
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Tool List  > Marquee Tool
Shrink selection
Allows you to create a selection matching the outline of a drawing completely included in the area drawn by dragging the marquee tool.

Example of sub tool: Erase selection

Dragging on a selection area deletes the dragged area from the selection.

Example of sub tool: Shrink selection

Dragging around an object creates a selection area along the drawing.
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Tool List > Marquee Tool > Selection Launcher
Selection Launcher
Creating a selection displays a [Selection Launcher] below the selected area.

From the [Selection Launcher], you can perform various operations related to the selection.

(1) Deselect

Deselects a selected area.

(2) Crop

Changes the canvas size so that it matches the selected area.

(3) Invert selected area

The area outside the selected area becomes the selected area.

(4) Expand Selected Area

Expands the selected area. For details, see "Expand Selected Area".

(5) Shrink Selected Area

Shrink the selected area. For details, see "Shrink Selected Area".

(6) Delete [Windows/macOS/Tablet]

Clears drawings inside a selected area.

(7) Delete Outside Selection [Windows/macOS/Tablet]

Clears drawings outside a selected area.

(8) Cut and paste [Windows/macOS/Tablet]

Cuts out the contents of the selection and pastes them on a new layer.

(9) Copy and paste [Windows/macOS/Tablet]

Copies the contents of the selection and pastes them on a new layer.

(10)Move/Transform [Windows/macOS/Tablet]

Moves or transforms the content inside a selected area. For details on scale up/scale down/rotate, see "Transform".

(11) Fill [Windows/macOS/Tablet]

Fills a selected area with the drawing color.

Selection Launcher
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(12)New tone [Windows/macOS/Tablet] [PRO/EX]

Creates a new toned [Fill in monochrome] layer. In the created layer, the area outside of the selected area is masked.

(13)Selection Launcher Settings [PRO/EX]

Clicking the menu item displays the [Selection Launcher Settings] dialog box. The dialog box allows you to add/delete command icons to/

from the [Selection Launcher], change the display position or image of an icon, arrange icons hierarchically, and so on. For details, see 

"Configuring the Selection Launcher Settings [PRO/EX]".

The [Simple tone settings] dialog box opens while you are creating the layer. In the dialog box, you can configure 

settings related to the number of lines and halftone dots. For details, see "Tone [PRO/EX]".

The [Selection Launcher Settings] dialog box can also be displayed from [View] menu > [Selection Launcher Set-

tings].

A toned [Fill in monochrome] layer

is created, and the area outside of

the selection is masked.
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Configuring the Selection Launcher Settings [PRO/EX]
This section describes the names and functions of each part of the [Selection Launcher Settings] dialog box and how to edit the icons on the 

[Selection Launcher].

[Selection Launcher Settings] Dialog Box

(1) Setting area

Select the category of the function to be added to the [Selection Launcher].

(2) List

Commands selected in [Selected area] are displayed. The function to be added to the [Selection Launcher] can be selected.

(3) Close

Close the [Selection Launcher Settings] dialog box.

Main menu The list's display will switch to the Main menu.

Pop-up palette [Windows/

macOS/Tablet]

The list display will switch to a pop-up palette. The pop-up palette is a function that pops up a 

menu next to the mouse cursor.

Options
The list's display will switch to the option contents. Option contents are functions and operations 

that are not included in the menu and tools.

Tool The list will switch to the next tool.

Auto action The list will switch to the next auto action.

Drawing color

On selection, the [Color settings] dialog box will be displayed, and a color can be selected. After 

selection, a color icon will be displayed in the list, and a color can be selected from the color 

icon.
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(4) Add

Add items selected in the list to the [Selection Launcher]. The icon will be added to the right side of the icon selected in [Selection 

Launcher].

If the [Selection Launcher] icon is not selected, it will be added to the right edge of the [Selection Launcher].

(5) Settings

Adjust the items selected in the [Selection Launcher]. Displayed items may vary depending on the selected contents.

(6) Delete

Deletes selected icons and separators in the [Selection Launcher].

(7) Add Separator

Adds a separator to the right side of the selected icon in the [Selection Launcher].

(8) Insert into group [Windows/macOS/Tablet]

Adds a command icon hierarchically to the position of the icon selected in the [Preview].

A drop-down icon will appear to the right of the command bar icon. When clicking the hierarchical icon, the icons under the respective 

hierarchy are listed.

(9) Restore default layout

The [Selection Launcher] layout can be reverted to its initial state.

When reverted to its initial state, added icons will be deleted, and their position will be reverted.

(10)Preview [Smartphone]

Shows a preview of the Selection launcher.

Drag and drop the icons in the preview to change their order. To move the selection launcher icon, swipe the icon vertically, then drag and 

drop it to its destination.

Main menu
The [Icon settings] dialog will appear. For details on the [Icon settings] dialog, see "Icon settings 

dialog".

Pop-up palette [Windows/

macOS/Tablet]

The [Icon settings] dialog will appear. For details on the [Icon settings] dialog, see "Icon settings 

dialog".

Options
The [Icon settings] dialog will appear. For details on the [Icon settings] dialog, see "Icon settings 

dialog".

Tool
The [Settings of sub tool] dialog will be displayed. For details on the [Settings of sub tool] dia-

log, see "Settings of sub tool".

Auto action
The [Icon settings] dialog will appear. For details on the [Icon settings] dialog, see "Icon settings 

dialog".

Drawing color
The [Name Settings] dialog will be displayed. For details on the [Name Settings] dialog box, see 

"Name settings dialog".

Images and background colors set for each icon are maintained even after deletion.
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Adding a Command
To add a command to the [Selection Launcher], proceed as follows.

1  Select the command
Click [Selection Launcher Settings] on the [Selection Launcher]. The [Selection Launcher Settings] dialog box opens.

2 Decide the position where you want to add the command
In the [Selection Range Launcher], click the icon at the position where to add the command icon.

If you are using a Smartphone, tap the position where you want to add a command icon on the [Selection Launcher Settings] dialog pre-

view screen.

3 Select the command to add
In the [Selection Launcher Settings] dialog, set as follows.

(1) Select the type of icon (function) to add.

The [Selection Launcher Settings] dialog box can also be displayed from [View] menu > [Selection Launcher Set-

tings].

A command icon will be added to the right of the clicked icon.
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(2) Select functions to add to the [Selection Launcher] from the list.

(3) Click [Add].

4 The icon will be added
The icon of the selected command is added to the [Selection Launcher].

When the [Selection Launcher] icons are dragged and dropped next to another icon, the icon positions can be changed.

If you are using a Smartphone to change the position of an icon, swipe it towards another icon on [Selection Launcher Settings] dialog pre-

view screen.

5 Close dialog
Click [Close] on the [Selection Launcher Settings] dialog box.

Add icons to the [Selection Launcher] by dragging and dropping items from the list into the [Selection Launcher].

To add a separator icon and group icons, do the following while the [Selection Launcher Settings] dialog box is 

displayed. If you are using a Smartphone, you can add separators and group icons by performing the same oper-

ations using the icons in the [Selection Launcher Settings] dialog preview screen.

 Click the [Selection Launcher] icon and click [Add Separator] to add a separator to the right side of the icon.

 Dragging and dropping the icon of the [Selection Launcher] on the separator or to the right end/left end of the 

[Selection Launcher], a separator will be created at that position.

 When the [Selection Launcher] icons are dragged and dropped above another icon, the icons can be hierar-

chized.

If you are using Windows/macOS/Tablet, you can add functions to the [Selection Launcher Settings] dialog box 

using the following methods.

Drag and drop the following icons to the button list in the [Selection Launcher Settings] dialog box.

 The [Tool] palette tool icon

 The [Sub Tool] palette tool icon and its sub tool group

 Auto actions in the [Auto Action] palette

For the [Command Bar] icon/[Quick Access] palette icon, drag and drop it to the button list in the [Selection 

Launcher Settings] dialog while holding down the [Ctrl] key.
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Deleting a Command
To delete an icon from the [Selection Launcher], proceed as follows.

1  Select the command
Click [Selection Launcher Settings] on the [Selection Launcher]. The [Selection Launcher Settings] dialog box opens.

2 Select the icon to delete
In the [Selection Launcher], select the icon of the command you want to delete.

If you are using a Smartphone, select the icon you want to delete from the [Selection Launcher Settings] dialog preview screen.

3 Deleting an icon
Click [Delete] on the [Selection Launcher Settings] dialog box.

4 Deleting an icon
The icon is deleted from the Selection launcher.

5 Close dialog
Click [Close] on the [Selection Launcher Settings] dialog box.

The [Selection Launcher Settings] dialog box can also be displayed from [View] menu > [Selection Launcher Set-

tings].

To delete a separator, select a separator from the [Selection Launcher].
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Arranging Commands Hierarchically [Windows/macOS/Tablet]
To arrange the icons on the [Selection launcher] hierarchically, proceed as follows.

1  Select the command
Click [Selection Launcher Settings] on the [Selection Launcher]. The [Selection Launcher Settings] dialog box opens.

2 Decide where to hierarchize command icons
In the [Selection Launcher], select the icon to hierarchize.

 If you are using Windows/macOS/Tablet, you can also right-click an icon and select [Delete].

 If you are using a Smartphone, you can also delete icons by long-pressing them and selecting [Delete] on the 

[Selection Launcher Settings] dialog preview screen.

The [Selection Launcher Settings] dialog box can also be displayed from [View] menu > [Selection Launcher Set-

tings].
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3 Select the command to add
Select the command to add from the list of the [Selection Launcher Settings] dialog.

(1) Select the type of icon (function) to add.

(2) Select functions to add to the [Selection Launcher] from the list.

(3) Click [Insert into group].

4 The icons will be hierarchized
The icon selected by [Selection Launcher] is hierarchized and the command selected in the [Selection Launcher Settings] dialog is added.

 When the [Selection Launcher] icons are dragged and dropped above another icon, the icons can be hierar-

chized.

 A drop-down icon will appear to the right of the [command bar] icon. 
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5 Reorder the icons
The order in which commands are arranged hierarchically can be changed by displaying them as a list.

(1) Click the drop-down menu icon. The icons of the commands arranged hierarchically are displayed.

(2) Drag and drop the icon of the command whose position you want to change.

6 Close dialog
Click [Close] on the [Selection Launcher Settings] dialog box.

Hold Ctrl while dragging the command icon to change it's position.
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Changing the icon of a command
To change the icon of a command, proceed as follows.

1  Select the command
Click [Selection Launcher Settings] on the [Selection Launcher]. The [Selection Launcher Settings] dialog box opens.

2 Select the icon to change
In the [Selection Launcher], click the command icon to change.

If you are using a Smartphone, select the icon of the command you want to change from the [Selection Launcher Settings] dialog preview 

screen.

3 Display setting screen
Click [Settings] on the [Selection Launcher Settings] dialog box.

4 Set icon
When the [Icon Setting] dialog box is shown, you can set up the icon image and background color.

(1) Click [Specify image file] and specify the image file to choose an icon from the file selection dialog.

(2) Click [OK].

The [Selection Launcher Settings] dialog box can also be displayed from [View] menu > [Selection Launcher Set-

tings].
CLIP STUDIO PAINT Instruction Manual 796



Tool List  > Marquee Tool
5 The icon change is complete
The Selection Launcher] icon has been changed.

6 Close dialog
Click [Close] on the [Selection Launcher Settings] dialog box.

 Acceptable icon image file formats are: BMP, JPEG, PNG, TIFF and Targa.

 For details on the [Icon settings] dialog box, see "Icon settings".

 When selecting a tool or sub tool icon, the [Sub Tool Settings] dialog box will be displayed. For details, see 

"Settings of sub tool".

 When selecting a drawing color icon, the [Name Settings] dialog will be displayed. For details, see "Name Set-

tings".

[Command Bar], [Selection Launcher] and [Quick Access] palette will use the same icon. Changing the icon of a 

command on the [Command Bar] with the [Selection Launcher Settings] dialog box also changes the icon on the 

[Command Bar].
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 Auto select Tool
The [Auto select] tool allows you to create a selected area from continuous areas of the same color.

The [Auto select] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

 Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see 

the CLIP STUDIO PAINT Tool Setting Guide.

 To cancel an auto selection process is taking a long time, press Esc.

Click

Example of use: Auto select tool
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 Eyedropper Tool
The [Eyedropper] tool allows you to acquire colors from an image.

Clicking on the canvas acquires a drawing color and reflects it in the [Color] palette.

The [Eyedropper] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see the 

CLIP STUDIO PAINT Tool Setting Guide.

Example of use: Eye dropper
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 Pen Tool
The [Pen] tool allows you to draw lines of different thicknesses as with dip pens, or of uniform thickness as with felt-tip
pens.

The [Pen] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see the 

CLIP STUDIO PAINT Tool Setting Guide.

Example of drawing: [Pen] tool

Allows you to draw lines of different thicknesses as with dip pens,

or of unifor thickness as with felt-tip pens.
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 Pencil Tool
The [Pencil] tool allows you to draw with strokes in different tones as with a pencil.

The [Pencil] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see the 

CLIP STUDIO PAINT Tool Setting Guide.

Example of drawing: [Pencil] tool

Allows you to draw with strokes in different tones as with a pencil.
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 Brush Tool
The [Brush] tool allows you to draw with strokes that blend multiple colors as with a brush.

The [Brush] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

When [Brush] tool is used on a vector layer, the drawing may have a different touch than when drawn on a raster 

layer depending on the selected [Sub Tool].

Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see the 

CLIP STUDIO PAINT Tool Setting Guide.

Example of drawing: [Brush] tool

Allows you to draw with strokes that blend multiple colors 

 as with a brush.
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 Airbrush Tool
The [Airbrush] tool allows you to draw with blurred strokes as with an air brush.

The [Airbrush] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see the 

CLIP STUDIO PAINT Tool Setting Guide.

Example of drawing: [Air brush] tool

Allows you to draw with blurred strokes as with an air brush.
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 Decoration Tool
The [Decoration] tool allows you to draw consecutive image patterns and the like.

The [Decoration] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see the 

CLIP STUDIO PAINT Tool Setting Guide.

Example of drawing: [Decoration] tool
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 Eraser Tool
The [Eraser] tool allows you to erase images, such as already drawn lines. When dragged on the canvas, erases an
image.

The [Eraser] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Example of Sub Tool: Rough (When used on raster layer)
The [Eraser] tool allows you to erase images, such as already drawn lines. When dragged on the canvas, erases an image.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see the 

CLIP STUDIO PAINT Tool Setting Guide.

Depending on the [Sub Tool], the effect may vary between [Raster Layer] and [Vector Layer].

Example of sub tool: Rough eraser (When used on raster layer)

Allows you to erase images, such as already drawn lines. When dragged on the canvas, erases an image.
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Example of Sub Tool: Vector (When used on vector layer) [PRO/EX]
Erases a line up to the intersection with another line drawn on the [Vector layer].

Example of sub tool: For vectors (When used on vector layer)

Allows you to erase a line up to the intersection with another line drawn on the [Vector] layer.
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 Blend Tool
The [Blend] tool blurs the colors in the canvas area where it is dragged as when paint is spread with the fingers.

The [Blend] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Example of Sub Tool: Blend
When [Blend] is selected on the [Sub tool] palette, dragging the tool on the canvas blurs the colors as when paint is spread with the fingers.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see the 

CLIP STUDIO PAINT Tool Setting Guide.

Blend function does not work when [Blend] tool is used on a [Vector] layer.

Example of sub tool: Blend

Allows you to blur the colors in the area of the canvas dragged with the tool as when paint is spread with the fingers.
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Example of Sub Tool: Copy stamp [PRO/EX]
Selecting a portion of an image and dragging the tool on a distant place or another layer as if drawing with a pen allows you to transfer the 

image. Click on the canvas while holding down the Alt key to specify the reference.

 The types of layers that can be specified as reference are raster layer and Selection layer only.

 Image transfer is possible when the expression colors, drawing colors and the layer mask selection statuses 

are the same between the reference layer and destination layer.

 Image transfer between a layer whose expression color is monochrome and another layer whose expression 

color is gray is possible if the drawing colors are the same.

Example of sub tool: Copy stamp

Selecting a portion of an image and dragging the tool on a distant place or another layer as if drawing with a pen, 

 allows you to transfer the image.

The image is transferred

[Alt] key + Click

Specify the destination

layer and  then, drag.
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 Fill Tool
The [Fill] tool allows you to easily fill a closed area by clicking on it.

The [Fill] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Example of Sub Tool: Refer only to editing layer
Selecting [Refer only to editing layer] on the [Sub tool] palette allows you to fill by referring to the layer being edited.

 Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see 

the CLIP STUDIO PAINT Tool Setting Guide.

 Use the [Close and fill] and [Fill leftover areas] sub tools when you want to fill a drawing composed of multiple 

closed areas in one go. They are perfect for coloring areas that are very small and difficult to fill, such as the 

tip of the hair, or 1-dot lines.

 To cancel a fill process that is taking a long time, press Esc.

Example of sub tool: Refer only to editing layer

Allows you to fill by referring to the layer being edited (black line drawing).
CLIP STUDIO PAINT Instruction Manual 809

https://www.clip-studio.com/site/gd_en/csp/toolguide/


Tool List  > Fill Tool
Example of Sub Tool: Close and fill
Dragging the tool as if enclosing the area to fill allows you to fill closed spots in the area.

Example of sub tool: Enclose and fill

Dragging as if enclosing the area to fill allows you to fill closed spots in the area.

Original image

Area to fill
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Example of Sub Tool: Fill leftover areas
Dragging the tool as if tracing the area to fill allows you to fill closed spots in the area.

Example of sub tool: Paint unfilled area

Dragging as if tracing the area to fill allows you to fill closed spots in the area.

Original image

Area to fill
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 Gradient Tool
Dragging the [Gradient] tool on the raster layer allows you to draw a gradient from a specified position, for a specified
length and in accordance with the settings.

The [Gradient] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Example of Sub Tool: Gradient
Drag the canvas to draw a gradient from a specified position, for a specified length and in accordance with the settings.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see the 

CLIP STUDIO PAINT Tool Setting Guide.

Drag in the direction desired

for the gradient.

Example of use: Gradient
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Example of Sub Tool: Contour line paint
A smooth gradation can now be created by clicking the area between two colored lines.

Proper filling with the [Contour line paint] tool may not be possible if anti-aliasing is applied to the outline. Set 

[Anti-aliasing] to [Off] or [None] in the drawing tool when creating the outline.

Click

An area enclosed by two-color lines 

will be filled with gradient.
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 Figure Tool
The [Figure] tool allows you to create all kinds of shapes such as straight lines, curves and figures. In addition, it
allows you to create saturated lines and stream lines for drawing manga.

The [Figure] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Sub tool example: Straight line
Selecting [Straight line] on the [Sub tool] palette allows you to draw a single straight line. Dragging on the canvas allows you to draw a straight 

line.

In DEBUT, you cannot use any sub tools in the [Stream line]/[Saturated line] sub tool groups.

 Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see 

the CLIP STUDIO PAINT Tool Setting Guide.

 You can select the line preview method from [Preferences] dialog box > [Tools] > [Figure tool guidelines].

Drag
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Sub tool example: Curve
Selecting [Curve] on the [Sub tool] palette allows you to draw a curve. Drag the curve from the start to finish and move the mouse to adjust its 

curvature. Click to finalize the curve.

If you are drawing with a pen or a finger, after designating the end of the curve, you can drag from a place on the canvas to adjust its curvature.

Example of Sub Tool: Polyline
Selecting [Polyline] on the [Sub tool] palette allows you to draw a series of connected straight line segments that pass through multiple points.

When [Curve] on the [Sub Tool Detail] palette is selected, drag the curve from the start to finish, and then click on 

two places to adjust its curvature. If you are drawing with a pen or a finger, you can drag from two places on the 

canvas to adjust its curvature.

Drag

Click

Click
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Sub tool example: Continuous & Bezier curves
Selecting [Continuous curve] on the [Sub tool] palette allows you to draw a series of connected straight lines and curves that pass through mul-

tiple points. Select [Bezier curve] to draw a complex curve using multiple control points.

Example of Sub Tool: Lasso fill
Selecting [Lasso fill] on the [Sub tool] palette allows you to specify an area of any shape to fill.

For details on how to draw continuous curves, see "Drawing Continuous curves & Bezier curves".

Example of Sub Tool: Continuous curve

Specify multiple points to draw the curve.

Example of Sub Tool: Bezier curve

Example of sub tool: Lasso fill

Allows you to specify an area of any shape to fill.
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Example of Sub Tool: Rectangle/Ellipse
Selecting [Rectangle] or [Ellipse] on the [Sub tool] palette allows you to draw shapes such as rectangles and ellipses.

Example of Sub Tool: Polygon
Selecting [Polygon] on the [Sub tool] palette allows you to create a polygon. On the [Tool property] palette, you can configure the number of 

vertexes for the polygon, roundness of the corners and the like.

Example of sub tool: Rectangle

Allows you to draw shapes such as rectangles and ellipses.

Example of sub tool: Polygon

Allows you to draw polygons.
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Example of Sub Tool: Dark stream lines ([Stream line] sub tool group) [PRO/EX] 
Selecting [Stream line] sub tool group on the [Sub tool] palette allows you to create speed-like effect lines. The color, size and space between 

lines that make up the sea urchin flash can be adjusted with the [Tool Property] palette.

Example of Sub Tool: Dense saturated line ([Saturated line] sub tool group) [PRO/EX] 
Selecting [Saturated line] sub tool group on the [Sub tool] palette allows you to create focus-like effect lines. The color, size and space between 

lines that make up the sea urchin flash can be adjusted with the [Tool Property] palette.

For how to create and edit stream lines, see "Explanation: Creating and Editing Stream Lines and Saturated Lines 

[PRO/EX]".

For how to create and edit saturated lines, see "Explanation: Creating and Editing Stream Lines and Saturated 

Lines [PRO/EX]".

Example of Sub Tool: Dark stream line ([Stream line] sub tool group)

Example of Sub Tool: Dense saturated line ([Saturated line] sub tool group)
CLIP STUDIO PAINT Instruction Manual 818



Tool List > Figure Tool > Drawing Continuous curves & Bezier curves
Drawing Continuous curves & Bezier curves
You can select [Curve] on the [Tool property] palette when the [Continuous curve] sub tool or [Bezier curve] sub tool is selected.

The following describes how to draw continuous curves for each drawing method.

For Straight lines
You can specify multiple points and draw a polygonal line that passes through those points. Click on the canvas to specify the anchor point of 

the line. Double-click to confirm the drawing. Clicking on a screen other than the [Canvas] window also confirms the drawing.

You can adjust settings to make continuous curves from [Tool] in the [Preferences] dialog box. Here you can set 

the drawing method for continuous curves and how control points are displayed. For details, see "Tool". 

 If you want to edit a line or a point while drawing a polyline, see "Editing a Polyline".

 You can also press the [Ctrl] key and click a position without an anchor point, or press the [Enter] key to con-

firm the drawing.

 Making your final click on the first clicked point last will finalize the drawing and create a closed shape.

anchor point
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Tool List > Figure Tool > Drawing Continuous curves & Bezier curves
For Splines
You can specify multiple points and draw a curve that passes through those points. The default setting of the [Continuous curve] sub tool is set 

to [Spline].

Click on the canvas to specify the anchor point of the curve. Click while holding down Alt to make the anchor point a corner. Double-click to 

confirm the drawing. Clicking on a screen other than the [Canvas] window also confirms the drawing.

 If you want to edit a line or a point while drawing a curve, see "Editing a Polyline".

 You can also press the [Ctrl] key and click a position without an anchor point, or press the [Enter] key to con-

firm the drawing.

 Making your final click on the first clicked point last will finalize the drawing and create a closed shape.

anchor point 
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Tool List  > Figure Tool
For Quadratic Beziers
A Quadratic Bezier is a curve composed of multiple control points.

Click where you want the line to start. Then click where you want the direction point to adjust the curve. Move your pen or mouse to adjust its 

curvature.

If you want to draw a continuous curve, click and specify the position where you want the direction point of the next curve to be drawn. An 

anchor point will be created between the current and the previous direction points.

Adjust the curvature, click your ending point for the drawing, and then click on the screen outside the [Canvas] window to confirm the it. Dou-

ble-clicking also confirms the drawing.

To connect two curves with a corner, before drawing the connecting curve, press Alt and click where you want the corner to be. An anchor 

point will be created where you clicked. To draw the next curve, click where you want the direction anchor to be.

 If you want to edit a line or a point while drawing a curve, see "Editing a Polyline".

 You can also confirm the drawing by holding down Ctrl and clicking a place without a control point, or by 

pressing Enter.

 Making your final click on the first clicked point last will finalize the drawing and create a closed shape.

Click
Click

Click

anchor point 

Alt + Click

anchor point 
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Tool List  > Figure Tool
For Cubic Beziers
A Cubic Bezier is a curve composed of multiple control points. The default setting of the [Bezier curve] sub tool is set to [Cubic Bezier].

Click where you want the line to start. If you start dragging from where you want the first curve to end, an anchor point will be created at the 

start of the drag and a direction point will also show. Moving the mouse adjusts the the curve. Release the mouse button when you have decided 

on the position of the curve.

If you want to draw a continuous curve, start dragging from when you want the anchor point and release the mouse button to confirm the curve. 

Clicking on the screen outside the [Canvas] window also confirms the drawing. You can also double-click anywhere other than a direction 

point or anchor point to confirm it.

If you want to make a anchor point a corner, click where you want the anchor point to be and drag it while pressing Alt.

The following example has the [Sub Tool Detail] palette > [Continuous curve] category’s [How to specify] set to 

[By drag].

Click
Drag

Drag

Click
Alt + Drag
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Tool List  > Figure Tool
Drawing Cubic Beziers with clicks
When drawing a curve, Setting [Sub Tool Detail] palette > [Continuous curve] category’s [How to specify] to [By click] is the same as selecting 

[Quadratic Bezier] from [Curve].

For details on how to draw curves, see "For Quadratic Beziers". However, the same control points as in the Cubic Bezier will be created. The 

process for editing a curve after drawing it varies.

Editing a Polyline
While drawing a polyline or continuous curve, you can edit the lines and points you have already drawn.

Redrawing from the previous point
Press Backspace or Delete. You can also redraw it with a right-click.

Delete control point
Click the anchor point to delete. However, if [Add/delete control points while drawing] on the [Sub Tool Detail] palette is set to off, you cannot 

delete them.

Add control point
Click on a drawn line to add an anchor point to it. However, if [Add/delete control points while drawing] on the [Sub Tool Detail] palette is set 

to off, you cannot add them.

 If you want to edit a line or a point while drawing a curve, see "Editing a Polyline".

 You can also confirm the drawing by holding down Ctrl and clicking a place without a control point, or by 

pressing Enter.

 Making your final click on the first clicked point last will finalize the drawing and create a closed shape.

Editing control points while drawing is the same as when [How to specify] is set to [By drag]. For details on edit-

ing, see "Editing a Polyline".

If you are using PRO/EX, you can edit polylines and curves after drawing by drawing on a vector layer. For details, 

see "Explanation: Editing a Vector Layer [PRO/EX]".

On a device where touch gestures can be used, tapping with two fingers will redraw the line from the previous 

point. To use this method, you must set [Tap with two fingers] from [Touch gesture] > [Preferences] dialog box to 

[Cancel].

Cubic Bezier Quadratic Bezier
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Tool List  > Figure Tool
Switch corner
This switches anchor points into corners or curves. When switching the anchor point into a corner, two lines with crosses on them appear in 

which you can adjust the angle of the corner. When switching the anchor point into a curve, two linked lines with direction points on them 

appear in which you can adjust the angle of the curve.

If you select [Cubic Bezier] in [Curve] and set [Selection mode] to [By drag], you can change the anchor point in the following ways.

 To make a curve a corner, press Alt and click the anchor point.

 To make a corner a curve, press Alt and drag the anchor point.

 If you drag the anchor point while pressing Alt, the curve becomes a corner and you can adjust it’s angle at the same time with the direction 

points.

 Click the anchor point of the curve drawn last to change it to a corner.

 Drag the anchor point of the corner drawn last to change it to a curve.

If [Curve] is set to [Spline] or [Quadratic Bezier], you can change the anchor point in the following ways. Having [Curve] set to [Cubic Bezier], 

is the same as when [Selection mode] is set to [By click].

 To switch the anchor point, click it while pressing Alt.

 Click the anchor point drawn last to switch it.

Move control points
Press Ctrl and drag the anchor point to move it.

Move direction points
If [Curve] is set to [Quadratic Bezier] or [Cubic Bezier], you can change the direction point in the following ways. Press Ctrl and drag the 

direction point to move it.

If [Curve] is set to [Cubic Bezier], pressing Alt and dragging an anchor point also moves the direction points.

Adjusting in angle increments with clicks and drags
When drawing a line, hold down Shift and move the pen or mouse to move it in 45 ° increments. 

If [Curve] is set to [Quadratic Bezier], only the first anchor point created and anchor points that have been 

switched to corners can be moved.

 After you can move direction points, you can move control points associated with them by pressing Space 

and dragging the direction point.

 Even if [Cubic Bezier] is selected in [Curve], if the [Continuous curve] category > [How to specify] is set to [By 

click] in the [Sub tool detail] palette, even if you press Alt while dragging a created anchor point, the direction 

points cannot be edited. The anchor point will switch to a corner.

When [Angle increment] in the [Continuous curve] category on the [Sub tool details] palette is turned on, you can 

move the pen or mouse to create specified angle increments without pressing the Shift.
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Tool List  > Frame border tool [PRO/EX]
 Frame border tool [PRO/EX]
The [Frame Border] tool allows you to create and edit frame borders.

The [Frame Border] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Example of Sub Tool: Rectangle frame
Selecting [Rectangle frame] on the [Sub tool] palette allows you to draw a rectangular frame border for manga.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see the 

CLIP STUDIO PAINT Tool Setting Guide.

For how to create and edit frame borders, see "Explanation: Comic Frame Division [PRO/EX]".

Example of sub tool: Rectangle frame
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Tool List  > Frame border tool [PRO/EX]
Example of Sub Tool: Polyline frame
Selecting [Polyline frame] on the [Sub tool] palette allows you to draw a polygonal frame border for manga.

Example of Sub Tool: Divide frame folder
Selecting [Divide frame folder] on the [Sub tool] palette allows you to divide a frame border.

For how to create and edit frame borders, see "Explanation: Comic Frame Division [PRO/EX]".

Example of sub tool: Polyline frame

Example of sub tool: Divide frame folder

Drag over the frame

to divide.
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Tool List  > Ruler tool [PRO/EX]
 Ruler tool [PRO/EX]
The [Ruler] tool allows you to create and edit rulers. In addition to [Linear ruler] and [Curve ruler], you can use [Special
ruler], which includes rulers such as [Perspective ruler], [Symmetrical ruler] and rulers that are useful for effect lines in
manga, such as [Parallel line] and [Radial line].

The [Ruler] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Example of Sub Tool: Figure ruler
Selecting [Figure ruler] on the [Sub tool] palette allows you to create rulers of rectangles, ellipses and other shapes. Creating a ruler allows you 

to draw snapped to the ruler.

Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see the 

CLIP STUDIO PAINT Tool Setting Guide.

For how to create, edit and delete rulers, see "Explanation: Ruler [PRO/EX]".

Example of sub tool: Figure ruler (Ellipse) Example of sub tool: Figure ruler (Rectangle)
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Tool List  > Ruler tool [PRO/EX]
Example of Sub Tool: Special ruler (Radial line)
Selecting [Special ruler] on the [Sub tool] palette allows you to create rulers of parallel lines, radial lines, and so on. Creating a ruler allows you 

to draw snapped to the ruler.

For how to create, edit and delete rulers, see "Explanation: Ruler [PRO/EX]".

Example of sub tool: Special ruler (Focus line)
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Tool List  > Text Tool
 Text Tool
The [Text] tool allows you to input and allocate text.

The [Text] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

 Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see 

the CLIP STUDIO PAINT Tool Setting Guide.

 For how to create and edit text, see "Explanation: Balloons and Text".
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Tool List  > Balloon Tool [PRO/EX]
 Balloon Tool [PRO/EX]
The [Balloon] tool allows you to create balloons. Input text using the [Text] tool and surround it using the [Balloon] tool
to create a balloon on the same layer.

The [Balloon] tool comes with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Example of Sub Tool: Ellipse balloon + Balloon tail
Selecting [Ellipse balloon] on the [Sub tool] palette creates an oval balloon. The figure below shows an example of balloon to which a tail has 

been added afterwards by selecting [Balloon tail] on the [Sub tool] palette.

 Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see 

the CLIP STUDIO PAINT Tool Setting Guide.

 For how to create and edit balloons and text, see "Explanation: Balloons and Text".

Example of sub tool: Elliptical balloon + Balloon tail
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Tool List  > Balloon Tool [PRO/EX]
Example of Sub Tool: Curve balloon + Text
Selecting [Curve balloon] on the [Sub tool] palette creates a balloon made of polylines or continuous curves. The figure below shows an exam-

ple of a balloon to which text has been added afterwards using the [Text] tool.

Example of Sub Tool: Balloon pen + Thought balloon tail
Selecting [Balloon pen] on the [Sub tool] palette creates a hand-drawn type balloon. The figure below shows an example of balloon to which a 

Thought balloon tail has been added afterwards by selecting [Thought balloon tail] on the [Sub tool] palette.

Example of sub tool: Curve balloon + Text

Example of sub tool: Balloon pen + Thought balloon tail
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Tool List  > Balloon Tool [PRO/EX]
Example of Sub Tool: Sea urchin flash ([Flash] sub tool group) 
Selecting [Flash] sub tool group on the [Sub tool] palette allows you to create flare effect lines. The color, size and space between lines that 

make up the sea urchin flash can be adjusted with the [Tool Property] palette.

The [Flash] sub tool group is drawn using saturated lines. For how to create and edit saturated lines, see "Expla-

nation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX]".

Example of Sub Tool: Sea urchin flash ([Flash] sub tool group)
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Tool List  > Correct line Tool/Remove dust Tool [PRO/EX]
 Correct line Tool/Remove dust Tool [PRO/EX]
The [Correct line] tool is a tool to correct drawings, frame borders, balloons and rulers on the [Vector] layer. It allows
you to correct control points, line width and the like.

The [Remove dust] tool automatically detects dust on the canvas. It can erase dust of up to a specified size, fill in the
surrounding color, as well as select dust spots.

The [Correct line] tool and [Remove dust] tool come with preconfigured settings called [Sub Tool].
You can change the sub tool by clicking the buttons on the [Sub tool] palette.
Furthermore, using the [Tool Property] palette, you can configure detailed settings for the selected sub tool.

Example of Sub Tool: Control point
Selecting [Control point] on the [Sub tool] palette allows you to move, add and delete control points, switch corners, change the line width and 

density, and so on. The figure below is an example of [Delete control point].

Settings available on the [Tool Property] vary depending on the selected sub tool. For details on settings, see the 

CLIP STUDIO PAINT Tool Setting Guide.

Example of sub tool: Control point (Delete control point)

Click the control point
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Tool List > Correct line Tool/Remove dust Tool [PRO/EX] > Drawing Continuous curves & Bezier curves
Example of Sub Tool: Pinch vector line
Selecting [Pinch vector line] on the [Sub tool] palette allows you to transform a line by dragging a portion of the line. You can also connect 

multiple vector lines as well as add control points to the line.

Example of Sub Tool: Simplify vector line
Selecting [Simplify vector line] on the [Sub tool] palette allows you to reduce the number of control points and simplify the line.

Example of sub tool: Pinch vector line

Drag a portion of the line

Example of sub tool: Simplify vector line

Trace the line
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Tool List > Correct line Tool/Remove dust Tool [PRO/EX] > Drawing Continuous curves & Bezier curves
Example of sub tool: Adjust line width
Selecting [Adjust line width] on the [Sub tool] palette allows you to scale the line width. The figure below is an example where the line width 

has been made uniform with [Fix width].

Example of Sub Tool: Remove dust
Selecting [Remove dust] on the [Sub tool] palette allows you to erase dust spots on the canvas. Dragging around the area to clean makes the 

tool automatically detect and erase dust spots.

Example of sub tool: Correct line width (Fix width)

Trace the line

Example of sub tool: Remove dust

(1) Original image (2) During dust removal　 (3) After dust removal

Drag to enclose the area
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Tool List > Correct line Tool/Remove dust Tool [PRO/EX] > Drawing Continuous curves & Bezier curves
Example of Sub Tool: Fill leftover
Selecting [Fill leftover] on the [Sub tool] palette allows you to fill small transparent and translucent spots within an opaque area in the predom-

inant color around the spots. Specify the area you want to fill by dragging as if tracing.

Example of Sub Tool: Redraw vector line width
Selecting [Redraw vector line width] on the [Sub tool] palette allows you to change the line width by dragging over the vector line as if tracing. 

Furthermore, if [Pen pressure] is configured for [Affected by] on the [Tool Property] palette for the brush size, you can adjust the line width by 

adjusting the pen pressure.

 [Redraw vector line width] can change the line width of lines drawn on the [Vector] layer, as well as frame bor-

ders in a [Frame border folder] and drawing lines on the [Balloon] layer.

 For details on [Affected by], see the CLIP STUDIO PAINT Tool Setting Guide.

Example of sub tool: Fill leftover

(1) Original image (2) Specifying the unfilled area to paint　 (3) After dust removal

Drag as if tracing

Vector line

Example of sub tool: Redraw vector line width

Drag over the vector

line as if tracing.
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Tool List > Correct line Tool/Remove dust Tool [PRO/EX] > Drawing Continuous curves & Bezier curves
Example of Sub Tool: Redraw vector line
Selecting [Redraw vector line] on the [Sub tool] palette allows you to transform a vector line by dragging a portion of it.

The [Redraw vector line] can transform the following vector lines:

 Drawing lines on the [Vector] layer

 Frame border lines in the [Frame border folder]

 Drawing lines on the [Balloon] layer

 [Linear ruler], [Curve ruler], [Figure ruler] and [Ruler pen] of the [Ruler] sub tool

Example of sub  tool: Redraw vector line

Drag a portion of

the vector line
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Color Palettes
This chapter introduces the color palette functions in Clip Studio Paint.

 Color Wheel Palette

 Color Slider Palette

 Color Set Palette

 Intermediate color Palette [PRO/EX]

 Approximate Color Palette [PRO/EX]

 Color History Palette [PRO/EX]



Color Palettes  > What Are Color Palettes?
Color Palettes

 What Are Color Palettes?
Clip Studio Paint comes with the following color palettes to select a color from.

Color Wheel Palette
Allows you to configure a drawing color by clicking or dragging the [Color 

Wheel].

Color Slider Palette

Allows you to configure a drawing color with sliders.

You can configure colors from the [HSV], [CMYK [PRO/EX]] or [RGB] 

color spaces in accordance with the use.

Color Set Palette

With [Color Set] palette, in addition to selecting your color from a list of typ-

ical colors, you can register and manage frequently used colors as a [Color 

Set].

Intermediate color Palette 

[PRO/EX]

The [Intermediate Color] palette allows you to select an intermediate color 

with respect to reference colors configured in the four corners.

Approximate Color Palette 

[PRO/EX]

The [Approximate Color] palette allows you to select a color proximate to a 

selected drawing color.

Color History Palette [PRO/EX]
The [Color History] palette displays a history of your drawing colors. You 

can select drawing colors by clicking the tile of a color.
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Color Palettes > Functions of Color Palettes > Color Wheel Palette
 Functions of Color Palettes
This section describes the functions of the color palettes by palette.

Color Wheel Palette
The [Color Wheel] palette is displayed when [Window] menu > [Color Wheel] is selected.

Allows you to configure the drawing color by clicking or dragging the [Color Wheel].

A. Color Wheel
Allows you to configure the drawing color by clicking or dragging the [Color Wheel]. Clicking the icon on the lower right of the palette 

allows you to switch the color space.

(1) HSV color space

A color is specified by Hue (H), Saturation (S) and Value (V).

A

B

C

HSV color space HLS color space

Click to switch the

color space.

Hue (H)
Saturation (S)

Value (V)

High

High

Low

Low
CLIP STUDIO PAINT Instruction Manual 840



Color Palettes > Functions of Color Palettes > Color Wheel Palette
(2) HLS color space

A color is specified by Hue (H), Luminosity (L) and Saturation (S).

B. Color Icon
Displays the currently selected drawing color along with readily available drawing colors.

In the example below, the readily available colors are (in the order of their availability) "red", "blue" and "transparent". "Red", which is 

displayed with a border, is the currently selected drawing color. To change the color, click the relevant color indicator.
 

(1) Main color

Set the primary (most frequently used) color.

Double clicking displays the [Color settings] dialog box where a color can be selected.

(2) Sub color

Set the next most frequently used color.

This will be the background color when you specify [Create both line and fill] with the [Figure] tool, or you create a balloon.

Double clicking displays the [Color settings] dialog box where a color can be selected.

(3) Transparent color

Select to use transparent color.

C. HSV value/RGB value
Displays numerically the HSV value of the drawing color in the lower part of the palette. Clicking the HSV value changes the indication to 

RGB value.

For the [Color settings] dialog box, refer to "Advanced settings of color Dialog Box".

For the [Color settings] dialog box, refer to "Advanced settings of color Dialog Box".

Hue (H)

Luminance (L)

Saturation (S)

High

High

Low

Low
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Color Palettes > Functions of Color Palettes > Color Wheel Palette
Color Wheel Palette Menu
The following describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the 

[Color Wheel] palette.

HSV color space
Switches the color space to HSV. HSV is an acronym for Hue, Saturation and Value.

HLS color space
Switches the color space to HLS. HLS is an acronym for Hue, Luminosity and Saturation.

Hide color wheel palette
Hides the [Color Wheel] palette.

Advanced settings of color Dialog Box
This is a dialog box for configuring color settings. In addition to selecting colors like in the palette, colors can be changed by entering values or 

acquired from the screen.

(1) How to set

You can choose from the following method to set colors: [Default], [Color Wheel 1], [Color Wheel 2], [Color Set] and [History]. The dis-

play of the [Color settings] dialog box varies depending on the selected item.

(2) Hue Circle

The hue circle in [Color settings] can be switched between [HLS] and [HSV]. This is displayed when [Default], [Color Wheel 1] or [Color 

Wheel 2] is selected. 

To show a hidden palette again, select the palette you want to display from the [Window] menu. If you are using a 

Smartphone, tap the button on the palette bar.

[History] cannot be selected in Debut.

Show menu
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Color Palettes > Functions of Color Palettes > Color Wheel Palette
(3) Color settings

At the color selection screen, you can verify the actual color of the color that is currently being selected. The display differs depending on 

the item selected in [How to set].

Refer to the following items for each display.

 "Default"

 "Color Wheel 1"

 "Color Wheel 2"

 "Color Set"

 "Color History [PRO/EX]"

(4) Original color

The set color displayed immediately after opening the [Color settings] dialog. Clicking this reverts [Color settings] to the original color.

(5) Set color

Displays the color set in [Color settings].

(6) Obtain screen color [Windows/macOS]

Clicking this changes the mouse cursor to an eyedropper. It is possible to reference a color on the screen using the eyedropper and set it as 

the color.

(7) HSV/HLS

A color can be set by inputting a value.

If [HSV] is set for [Hue Circle], values for Hue, Saturation and Value can be entered. If [HLS] is set for [Hue Circle], values for Hue, 

Luminance and Saturation can be entered.

If [Default] is set for [How to set], radio buttons are displayed before each item name. These allow you to select the default value for the 

[Color Slider].

(8) RGB

A color can be set by inputting an RGB value.

If [Default] is set for [How to set], radio buttons are displayed before each item name. These allow you to select the default value for the 

[Color Slider].

(9) HEX

Colors can be set by inputting a hexadecimal color code.

(10)L*a*b* [PRO/EX]

A color can be set by inputting an L*a*b* value.

(11) CMYK [PRO/EX]

A color can be set by inputting a CMYK value.

One color model (HSV, HLS or RGB) can be selected as the default model for the [Color Slider].

One color model (HSV, HLS or RGB) can be selected as the default color model for the [Color Slider].
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Color Palettes > Functions of Color Palettes > Color Wheel Palette
Default
The following screen is displayed when [Default] is selected for [How to set].

(1) Hue Circle

The hue circle in [Color settings] can be switched between [HLS] and [HSV].

(2) Color Slider

Operating the [Color Slider] changes the [Color Field] color according to the selected color.

The default value for the [Color Slider] can be selected using the radio buttons to the left of the names of the "HSV", "HLS" and "RGB" 

items.

(3) Color Field

The color in the clicked position is selected.

Color Wheel 1
The following screen is displayed when [Color Wheel 1] is selected for [How to set].

This is operated in the same way as the [Color Wheel] palette. For details, see "Color Wheel Palette".
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Color Palettes > Functions of Color Palettes > Color Wheel Palette
Color Wheel 2
The following screen is displayed when [Color Wheel 2] is selected for [How to set].

(1) Hue Circle

The hue circle in [Color settings] can be switched between [HLS] and [HSV].

(2) Color Slider

Operating the [Color Slider] changes the [Color Field] color according to the selected color.

The value can be adjusted using the [Color Slider] if [HSV] is set for [Hue Circle].

The luminosity can be adjusted using the [Color Slider] if [HLS] is set for [Hue Circle].

(3) Color Field

The color in the clicked position is selected.

Color Set
The following screen is displayed when [Color Set] is selected for [How to set].

(1) Show color set

The color set to be displayed in the [Color Field] can be selected from the [Color Set] list.

(2) Color Slider

Drag or click to scroll through the color set displayed in the [Color Field].

(3) Color Field

The color set selected in [Show color set] is displayed. The clicked color is selected. However, the transparent color cannot be selected.
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Color Palettes > Functions of Color Palettes > Color Wheel Palette
Color History [PRO/EX]
The following screen is displayed when [Color History] is selected for [How to set].

(1) Color Slider

Drag or click to scroll through the color history displayed in the [Color Field].

(2) Color Field

Displays a history of colors that you have used. The clicked color is selected. However, the transparent color cannot be selected.

For details on the [Color Set], see "Color Set Palette".
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Color Palettes > Functions of Color Palettes > Color Slider Palette
Color Slider Palette
The [Color Slider] palette is displayed when [Window] menu > [Color Slider] is selected.

The [Color Slider] palette allows you to configure the drawing color with sliders.

A. RGB lib
Specifies a drawing color by RGB. RGB is an acronym for Red, Green and Blue, and indicates the light's three primary colors. RGB 

express colors displayed on CRT monitors, LCD monitors and the like.
 

B. HSV/HLS lib
In HSV color space, colors are specified by Hue, Saturation and Value.

In HLS color space, colors are specified by Hue, Luminosity and Saturation.

C. CMYK lib [PRO/EX]
Specifies a drawing color by CMYK. CMYK is an acronym for Cyan, Magenta, Yellow and Black, and indicates the primary colors used 

in color printing. CMYK expresses colors for printing.

You can switch the color space by using the menu displayed when you click [Palette menu] on the upper left cor-

ner of the [Color Slider] palette. For details on how to switch color spaces, see "Color Slider Palette Menu".

A

B

C

D
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D. Color Icon
Displays the currently selected drawing color along with readily available drawing colors.

In the example below, the readily available colors are (in the order of their availability) "red", "blue" and "transparent". "Red", which is 

displayed with a border, is the currently selected drawing color. To change the color, click the relevant color indicator.
 

(1) Main color

Set the primary (most frequently used) color.

(2) Sub color

Set the next most frequently used color.

(3) Transparent color

Select to use transparent color.

Color Slider Palette Menu
The following describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the 

[Color Slider] palette.

HSV color space
Switches the color space to HSV. HSV is an acronym for Hue, Saturation and Value.

HLS color space
Switches the color space to HLS. HLS is an acronym for Hue, Luminance and Saturation.

Show color icon 
When turned on, displays the color icons.

Hide color slider palette
Hides the [Color Slider] palette.

To show a hidden palette again, select the palette you want to display from the [Window] menu. If you are using a 

Smartphone, tap the button on the palette bar.

Show menu

Show color icon: Off Show color icon: On

Color icon
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Color Set Palette
To display the [Color Set] palette, select [Window] menu > [Color Set].

With [Color Set] palette, in addition to selecting your color from a list of typical colors, you can register and manage frequently used colors as 

a [Color Set].

(1) Show color set

Displays a list of [Color Set] from which you can select a [Color Set].

(2) Edit color set

Clicking this item opens the [Edit color set] dialog box. The [Edit color set] dialog box allows you to add, select, edit and delete colors in 

the color set.

(3) Import color set material

The [Import color set material] dialog box is displayed, and color set materials downloaded from CLIP STUDIO ASSETS can be loaded.

(4) Color set list

Displays the [Color Set] selected in [Show color set].

Clicking a color tile replaces the color in the [Color icon] on the [Color Slider] palette with that of the clicked color tile.

(5) RGB value/HSV value

The RGB value of the drawing color is displayed numerically in the lower part of the palette. Clicking the RGB value changes the indica-

tion to HSV value.

(6) Replace color

Changes the color of the tile currently selected on the [Color Set] with the current drawing color.

(7) Add color

Adds the currently selected color to [Color Set].

(8) Delete color

Deletes the color of the tile currently selected on the [Color Set].

For details on the [Edit color set] dialog box, see "Edit color set Dialog Box".

For details on the [Import color set material] dialog box, see "Color Set Palette Menu".

 As a tool tip, placing the mouse cursor over a color tile displays the RGB value or HSV value of the color. The 

name of the color is also displayed if a name is set.

 Dragging a tile while holding down Ctrl allows you to change the order of the tiles.

 Clicking another tile while holding down Alt copies the currently selected color to the other tile.
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Edit color set Dialog Box

(1) List of created color sets

Displays the list of color sets.

(2) Add new settings

Creates a new color set.

(3) Add default settings

Creates a new color set with the same content as the [Standard color set].

(4) Duplicate current settings

Copies the color set currently selected in the [List of created color sets].

(5) Delete

Deletes the color set currently selected in the [List of created color sets].

(6) Change name of settings

Renames the color set currently selected in the [List of created color sets].

(7) Up

Moves up the display order of the color set currently selected in the [List of created color sets] by one position.

(8) Down

Moves down the display order of the color set currently selected in the [List of created color sets] by one position.

Double clicking on the name of a displayed color set allows you to rename it.

You can also rename by double clicking the color set currently selected in the [List of created color sets].
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Color Set Palette Menu
The following describes the functions included in the menu that is displayed when you click [Palette menu] on the upper left corner of the 

[Color Set] palette.

Edit color set
Clicking this item opens the [Edit color set] dialog box. The [Edit color set] dialog box allows you to add, select, edit and delete colors in the 

color set.

Switch color set
Allows you to switch the [Color set].

Import color set
Imports a saved color set file (extension: cls) or a color palette data in Adobe Photoshop color swatch format (extension: aco) to the [List of 

created Color sets] on the [Color Set] palette.

Export color set
Exports (saves) the currently displayed [Color Set] as a color set file (extension: cls) or color palette data in Adobe Photoshop color swatch for-

mat (extension: aco).

For details on the [Edit color set] dialog box, see "Edit color set Dialog Box".

You can also import a color set by dragging and dropping a color set file to the [Color set] palette.

Show menu
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Register color set as material [PRO/EX]
Displays the [Material property] dialog box where you can register the selected color set in a [Material] palette.

[Material property] Dialog Box

(1) Material name

Input a name for the material.

(2) Location to save material

Click a folder to specify the location to save the material. The specified location is applied to the [Tree view] on the [Materials] palette.

(3) Search tag

Click the tag list and specify a search tag displayed in the [Tag list].

Clicking the tag with a + sign in the lower right will allow you to create a new tag.

 Color sets registered to the [Material] palette can be uploaded to the CLIP server using the included portal 

application, CLIP STUDIO.

 Clip Studio can be started from the [File] menu ([CLIP STUDIO PAINT] menu on macOS and Tablet) > [Open 

CLIP STUDIO]. For the Smartphone, select [Menu] > [Usage / Material / Work / Support].
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Import color set material
The [Import color set material] dialog box is displayed, and color set materials downloaded from CLIP STUDIO ASSETS can be loaded.

By selecting the colors set material to load from the [Color Set list], and clicking [OK], the color set material is loaded into the [Sub Tool] pal-

ette.

[Import color set material] Dialog Box

(1) Search box

By entering keywords, color set materials can be searched more easily.

(2) Tag list

A list of tags assigned to materials displayed as buttons. Clicking a button displays the Color Set with the specified content in the [Color 

Set list].

(3) Color set list

Displays color set materials downloaded from CLIP STUDIO ASSETS in a list.

(4) Show item checkbox

Shows a checkbox for each thumbnail of the color sets shown in [Color Set list]. You can select a material by turning on the checkbox.

(5) Thumbnail [Large]

Shows large thumbnails of the color set materials shown in [Color Set list].

(6) Thumbnail [Small]

Shows small thumbnails of the color set materials shown in [Color Set list].

(7) Thumbnail [Detail]

Shows the thumbnails as well as information of the color set materials shown in [Color Set list].

Replace color
Changes the color of the tile currently selected on the [Color Set] with the current drawing color.
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Add color
Adds the currently selected color to [Color Set].

Delete color
Deletes the color of the tile currently selected on the [Color Set].

Change color name
The [Change color name] dialog is displayed and the name of the currently selected color can be changed.

Auto-register color in eye dropper
Turning on this menu item allows you to automatically register a color acquired with the [Eyedropper] tool in the [Color Set] palette.

View
Allows you to specify how to display the color tiles.

(1) Size (ex-small/small/medium/large/ex-large)

Specifies the tile size. You can select a size from [ex-small], [small], [medium], [large] and [ex-large].

(2) Step (8/16/24)

Specifies the number of tiles per row. Always displays the number of tiles specified by [Step] relative to the palette width. If the palette 

width is changed, the tile size changes in conjunction with the palette width.

(3) List (small/medium/large)

Displays the color set as a list of color tiles and color names. You can select a size for the view from [List small], [List medium] and [List 

large].

Double clicking the field on the right side of the color tile allows you to input a name for the color.

Show color set bar 
When turned on, displays the color set bar of the [Color Set] palette.

Show command bar 
When turned on, displays the command bar of the [Color Set] palette.

Show color set bar: Off Show color set bar: On

Color set bar

Show command bar: Off Show command bar: On

Command bar
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Change Order 
The order method can be selected in [Tile] on the [Color Set] palette.

Hide color set palette
Hides the [Color Set] palette.

Drag The tile layout on the palette can be changed by dragging the tiles.

Ctrl + drag Dragging a tile while holding down Ctrl allows you to change the order.

To show a hidden palette again, select the palette you want to display from the [Window] menu. If you are using a 

Smartphone, tap the button on the palette bar.
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Intermediate color Palette [PRO/EX]
The [Intermediate Color] palette is displayed when [Window] menu > [Intermediate Color] is selected.

The [Intermediate Color] palette allows you to select an intermediate color with respect to reference colors configured in the four corners.

Selecting a Color from the Intermediate Color Palette
To select a color from the [Intermediate Color] palette, proceed as follows.

1 Configure the reference colors
Configure the reference colors to the tiles located at the four corners of the [Intermediate Color] palette.

(1) select drawing colors to set as reference colors from other color palettes.

(2) Click the tile at a corner of the [Intermediate Color] palette. The drawing color is reflected in the tile and becomes a reference color.

2 Select the color
Select a color from the [Intermediate Color] palette.

Between the tiles at the corners, there are a series of tiles of gradually changing colors. The clicked color is selected as the drawing color.

The RGB value of the drawing color is displayed numerically in the lower part of the palette. Clicking the RGB 

value changes the indication to HSV value.
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Intermediate color Palette Menu
The following describes the functions included in the menu that is displayed when you click [Palette menu] on the upper left corner of the 

[Intermediate Color] palette.

Fix number of steps (Division into 10/20/30 parts)
Specifies the color tile view by the number of tiles per row. You can select the number of tiles comprising the view from [division into 10 

parts], [division into 20 parts] and [division into 30 parts]. If the palette width is changed, the tile size changes in conjunction with the palette 

width.

Fix width of tile (7pt/10pt/15pt)
Specifies the color tile view by the width of each tile. You can select a size from [7pt], [10pt] and [15pt]. If the palette width is changed, the 

number of tiles per row changes in conjunction with the palette width.

Show grid
When turned on, a border is displayed around each color tile.

Hide intermediate color palette
Hides the [Intermediate Color] palette.

Show Menu

Show grid: On Show grid: Off 
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Approximate Color Palette [PRO/EX]
The [Approximate Color] palette is displayed when [Window] menu > [Approximate Color] is selected.

The [Approximate Color] palette allows you to select a color proximate to a selected drawing color.

Selecting a Color from the Approximate Color Palette
To select a color from the [Approximate Color] palette, proceed as follows.

1 Select the reference element
Configure the elements to refer to the vertical/horizontal axis of the [Approximate Color] palette.

(1) Click the character string by the sliders to display the menu.

(2) Select the reference element from the displayed menu.

(3) Configure the reference element for each axis by performing steps (1) and (2) for the vertical and horizontal axes.

The items you can configure as reference elements are as follows.

 Hue (H)

 Saturation (S)

 Luminosity

 Luminosity (L)

 Red (R)

 Green (G)

 Blue (B)

Clicking displays 

the menu.
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2 Select the color
Select a color from the [Approximate Color] palette.

(1) The drawing color selected by using another color palette is shown in the center of the [Approximate Color] palette as a reference 

color.

(2) Move the sliders to adjust the change in color.

(3) Click a color tile to select a color.

(4) The selected color is configured as drawing color.

The RGB value of the drawing color is displayed numerically in the lower part of the palette. Clicking the RGB 

value changes the indication to HSV value.
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Approximate Color Palette Menu
The following describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the 

[Approximate Color] palette.

Fix number of steps (Division into 10/20/30 parts)
Specifies the color tile view by the number of tiles per row. You can select the number of tiles comprising the view from [division into 10 

parts], [division into 20 parts] and [division into 30 parts]. If the palette width is changed, the tile size changes in conjunction with the palette 

width.

Fix width of tile (7pt/10pt/15pt)
Specifies the color tile view by the width of each tile. You can select a size from [7pt], [10pt] and [15pt]. If the palette width is changed, the 

number of tiles per row changes in conjunction with the palette width.

Show grid
When turned on, a border is displayed around each color tile.

Hide approximate color palette
Hides the [Approximate Color] palette.

Show menu

Show grid: OffShow grid: On
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Color History Palette [PRO/EX]
To display the [Color History] palette, select [Window] menu > [Color History].

The [Color History] palette displays a history of your drawing colors. The latest drawing color is recorded in the top left. You can select draw-

ing colors by clicking the tile of a color.

Recorded drawing colors are kept after closing Clip Studio Paint and can be used the next time the application is launched.

Color History Palette Menu
This section describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the [Color 

History] palette.

Register to color set palette
The [Register to color set palette] dialog box is displayed and the drawing color history displayed on the [Color History] palette is registered to 

the [Color Set List] on the [Color Set] palette.

Clear color history
Clears the history of the drawing colors you have obtained.

View
Allows you to specify how to display the color tiles.

(1) Size (ex-small/small/medium/large/ex-large)

Specifies the tile size. You can select a size from [ex-small], [small], [medium], [large] and [ex-large].

(2) Step (8/16/24)

Specifies the number of tiles per row. Always displays the number of tiles specified by [Step] relative to the palette width. If the palette 

width is changed, the tile size changes in conjunction with the palette width.

Hide color history palette
Hides the [Color History] palette.

To show a hidden palette again, select the palette you want to display from the [Window] menu. If you are using a 

Smartphone, tap the button on the palette bar.

Show menu
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Brush Size Palette
The [Brush size] palette is displayed when [Window] menu > [Brush Size] is selected.

The [Brush size] palette allows you to select a tool size from preconfigured values. Furthermore, it also allows 

you to register the size of the tool you are using in the palette.

 Functions of Brush size palette



Brush Size Palette > Functions of Brush size palette > Brush Size Palette Menu
Brush Size Palette

 Functions of Brush size palette
The [Brush size] palette allows you to select a tool size from preconfigured values. Furthermore, it also allows you to
register the size of the tool you are using in the palette.

Brush Size Palette Menu
The following describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the 

[Brush size] palette.

Show slider
When turned on, displays a slider for the tool size, which allows you to change the size of pens and brushes by moving it or by inputting a 

value.

Add current size to preset
Registers the current tool size in the [Brush size] palette.

Delete preset of current size
Unregisters the current tool size from the [Brush size] palette.

Some menu items can be run from the context menu that displays when you right click the mouse.

Show menu

Slider
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Hide brush size palette
Hides the [Brush size] palette.

To show the Brush Size palette again, select the palette from the [Window] menu > [Brush Size]. If you are using a 

Smartphone, tap the icon on the palette bar.
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Layer Palette
Layers are managed with the [Layer] palette, which allows you to change the stacking order of layers, their 

opacity, and the like.

The [Layer] palette is displayed when [Window] menu > [Layer] is selected.

 Functions of Layer Palette

 Layer Operations



Layer Palette  > Functions of Layer Palette
Layer Palette

 Functions of Layer Palette
This section describes the functions of the [Layer] palette.

A. Change palette color
Adds a color mark to the layer selected on the [Layer] palette. Select a color from the pull down menu.

Selecting [Use other color] displays the [Color settings] dialog box. Here, a color can be set.

B. Blending mode
This menu allows you to specify the blending mode of layers.

C. Opacity
Adjusts the opacity of the image on the selected layer. The smaller the value, the more transparent will be the image.

 Selecting multiple layers allows you to change the palette color in one go.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

 For details on blending modes, see "Setting the Blending Mode".

 A blending mode can be set for multiple layers by selecting multiple layers.

Selecting multiple layers allows you to change the opacity of multiple layers in one go.

L
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D. Clip to layer below
Limits the area of the selected layer to display by referring to the layer immediately below.

E. Set as reference layer
Configures the layer selected on the [Layer] palette as [Reference layer].

 For details on the [Reference] layer, see "Set as reference layer".

 Clicking [Set as Reference Layer] again turns off the setting, and cancels its designation as [Reference] layer.

 A [Reference] layer may comprise multiple layers.

 A [Layer Folder] can also be configured as [Reference] layer.

Select the layer to clip.
The thumbnail of the masked

layer is displayed with a vertical

red line.

The icon changes to

when configured as reference layer.
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F. Set as Draft Layer [PRO/EX]
Configures the layer selected on the [Layer] palette as a draft layer.

G. Lock layer
Locks a layer to make layer settings unchangeable. Clicking toggles the lock on and off.

H. Lock transparent pixels
Locks drawing to transparent areas of a [Raster] layer. Allows you to draw on already drawn areas without running over to transparent 

areas. Clicking toggles the lock on and off.

is displayed for a draft layer.

is displayed for a locked layer.

is displayed for a locked layer.
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I. Enable Mask
Allows you to enable/disable the mask as well as visualize the masked area.

(1) Enable mask

When turned on, the layer mask is enabled.

When turned off, the layer mask is disabled. When the layer mask is disabled, the mask layer icon on the [Layer] palette is displayed with 

a red x mark on it.

(2) Show Mask Area

When turned on, displays the masked area in violet.

 When a [Frame Border folder] is selected, the enabled/disabled mask function is that of the [Frame Border 

folder].

 You can also enable/disable the layer mask by clicking the layer mask icon while holding down Shift.

You can also show/hide the masked area by clicking the layer mask icon while holding down Alt.

Show mask area: Off Show mask area: On
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J. Set showing area of ruler [PRO/EX]
Set the range of layers for which to enable snap to ruler and the method for moving the guide lines.

K. Change layer color [PRO/EX]
Applies the layer color to the layer selected on the [Layer] palette. Layer color is a function for changing the color of the drawing on the 

layer arbitrarily.

Click the drop-down icon and select [Layer color] and [Sub color] to show the [Color settings] dialog box. Here you can set a layer color 

(substitute for black) and a sub color (substitute for white).

L. Show layers in 2 panes 
Divides the layer palette view in two. You can change the dividing position by dragging a clip displayed under the list of layers. You can 

seperately scroll the divided layers.

This is convenient to show distant layers separately when there are many layers.

M. New Raster Layer
Creates a new raster layer above the currently selected layer.

N. New vector layer [PRO/EX]
Creates a new [Vector] layer above the currently selected layer.

Show in All Layers
All [Raster] layers, [Vector] layers, [Selection] layers, [Quick Mask] layers and [Balloon pen] lay-

ers are configured as snap range.

Show in Same Folder

All [Raster] layers, [Vector] layers, [Selection] layers, [Quick Mask] layers and [Balloon pen] lay-

ers within the same layer folder are configured as snap range. When there is no layer folder, this 

becomes the same as [Show in All Layers].

Show Only When Editing 

Target
The snap range is limited to the currently configured layer.

Link guide to ruler Turn this on to move the ruler and guide lines together when moving a ruler layer.

 The layer color can also be configured in [Layer color] on the [Layer Property] palette.

 For layers in which the [Expression color] is set to [Color], the color is replaced by grayscale before applying 

the layer color.

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

 Clicking [New Raster Layer] creates a raster layer whose expression color is [Color].

 Clicking [New Raster Layer] while holding down Alt opens the [New Raster Layer] dialog box. The dialog box 

allows you to create the layer by specifying name, expression color, blending mode, and so on.
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O. New Layer Folder
Creates a new [Layer Folder].

P. Transfer To Lower Layer 
Transfers the image on a selected layer to the layer immediately below.

For details, see "Transfer To Lower Layer".

Q. Combine to layer below
Combines a selected layer with that immediately below to make one.

For details, see "Merge with layer below".

R. Create layer mask
Creates a layer mask in the selected layer. The area outside of the selected area is masked.

S. Apply Mask to Layer
Selecting and clicking a layer with a layer mask applies the layer mask and changes the visible layer. This deletes the layer mask.

 Clicking [New vector layer] creates a vector layer whose expression color is [Color].

 Clicking [New vector layer] while holding down Alt opens the [New vector layer] dialog box. The dialog box 

allows you to create the layer by specifying name, expression color, blending mode, and so on.

 [Layer Folder] is a function to group a number of layers in one folder. For example, placing images related to 

the character and images related to the background in separate folders makes the management of related 

images easier.

 When a layer folder is created in an animation folder, a thumbnail of the layer folder is displayed on the [Layer] 

palette. 

 For masks created outside of the selected area, see "Mask Outside Selection".

 Clicking [Create layer mask] while holding down Alt masks the selected area.

When you combine the layer mask and the layer, the combined layer will be a raster layer, regardless of the origi-

nal layer type.

Layer mask can also be applied by dragging and dropping the layer to [Apply Mask to Layer].
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T. Delete Layer
Deletes the currently selected layer.

U. Layer list
Displays a list of layers.

(1) Show/hide layer

Clicking this icon toggles the layer between display and hide. When an eye icon is displayed, the images on the layer are visible.

(2) Layer drawing allowed/not allowed

The layer being edited is displayed with a pen icon.

When multiple layers are selected, layers other than that being edited are displayed with a check mark. Clicking [Layer drawing allowed/

not allowed] again cancels the selection status.

(3) Layer icon

Previews the drawing on the layer with an icon.

When a layer folder is selected, also the layers stored in the folder are deleted.

 Layer folders, layer masks and rulers can also be deleted with [Delete layer].

 Layers registered to the [Animation cels] palette as a light table layer cannot be deleted. Delete the light table 

layer from the [Animation cels] palette to enable this layer to be deleted. For details on how to delete the light 

table layer, see "Animation Cels palette" > "Light Table Layer Operation" > "Deleting a light table layer".

Drag vertically within the layer list while holding down the space bar to scroll through the layer list.

 Right clicking [Show/hide layer] displays a menu that toggles the layer display status. For details, see "Show/

hide layer Toggle Menu".

 Clicking [Show/hide layer] while holding down Alt makes visible the clicked layer only. Clicking [Show/hide 

layer] again while holding Alt restores the previous display status.

 To select multiple layers, click the layers while holding Ctrl.

 To select a group of consecutive layers, click the layers while holding Shift down.

 For layers displayed in [Light table specific to cel] or [Common light table for canvas] on the [Animation cels] 

palette, the light table icon is displayed for [Layer drawing allowed/not allowed].
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(4) Layer name field

Displays layer information such as opacity, blending mode and name.

Clicking the field selects the layer, becoming the layer being edited (target of edit). The selected layer is displayed in light blue. Double 

clicking the field allows you to rename the layer.

When using the Windows/macOS version, placing the mouse cursor over this area and dragging up or down allows you to change the 

order in which the layer is stacked. When multiple layers are selected, all selected layers become the target of stacking order change.

(5) Grip [Tablet/Smartphone]

This is used when changing the order of layers on a Tablet/Smartphone.

Move a finger or pen over the grip and drag up and down to change the layer stacking order. When multiple layers are selected, all selected 

layers become the target of stacking order change.

Clicking the layer icon while holding Ctrl allows you to create a selection from the drawing on the clicked layer.
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Layer Palette Menu
This section describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the [Layer] 

palette.

New Raster Layer
Creates a new raster layer (layer for drawing) above the selected layer.

For details, see "Menu" > "Layer Menu" > "New Raster Layer".

New Layer
Creates a new layer above the selected layer.

For details, see "New Layer".

New Correction Layer [PRO/EX]
Creates a correction layer above the selected layer. This layer allows you to adjust the brightness, hue, saturation, luminosity, gradient and the 

like of the layers below.

For details, see "New Correction Layer [PRO/EX]".

New Layer Folder
Creates a new layer folder.

For details, see "New Layer Folder".

Create folder and insert layer
Creates a new layer folder and places the layer selected on the [Layer] palette in the folder.

Ungroup Layer Folder
Deletes the selected layer folder. When a layer folder is deleted the layers inside the folder will remain.

For details, see "Ungroup Layer Folder".

Duplicate Layer
Makes a copy of the selected layer or layer folder.

For details, see "Duplicate Layer".

Delete Layer
Deletes the selected layer or layer folder.

Some menu items can be run from the context menu that displays when you right click the mouse.

When a layer folder is selected, also the layers stored in the folder are deleted.

Show Menu
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Layer mask
Creates a mask for the selected layer or layer folder. Masks can be deleted as well as configured.

Ruler/Frame [PRO/EX]
Allows you to delete and display rulers, create perspective rulers, and so on. It also allows you to configure whether to move the ruler along 

with the drawing area of the layer being edited, or separately. For details, see "Ruler/Frame [PRO/EX]".

File object [PRO/EX]
Allows you to perform operations related to file object layers. File object layers are layers used to load files such as videos and images into Clip 

Studio Paint.

Layer settings
Allows you to configure settings related to layers such as reference layer, clipping, layer lock, transparent pixel lock, and so on.

Mask Outside Selection
Masks the area outside of the selected area.

For details, see "Mask Outside Selection".

Mask selection
Masks the selected area.

For details, see "Mask Selection".

Delete Mask Deletes the layer mask of a selected layer.

Apply Mask to Layer Applies the layer mask. Applying the mask converts the layer into a [Raster] layer.

Enable Mask
Turning on this item by selecting the menu enables the layer mask.

For details, see "Enable Mask".

Show Mask Area Turning on this item by selecting the menu displays the masked area in purple.

Link Mask to Layer

Turning on this item by selecting the menu links the layer and mask. When linked, the mask 

drawing moves along with the layer when this is moved using the [Move layer] tool.

For details, see "Link Mask to Layer".

Convert layer to file object

Converts the selected layer to a file object layer. The selected layer is saved as a separate file in 

CLIP STUDIO FORMAT (format: clip).

For details, see "Convert layer to file object".

Paste as file object
The file or layer copied to the clipboard is pasted as a file object layer.

For details, see "Paste as file object".

Change file of file object
The reference file of the selected file object layer can be changed.

For details, see "Change file of file object".

Open file object
Opens the reference file of the selected file object layer.

For details, see "Open file of file object".

Update file object
Reloads the selected file object layer from the reference file and updates it to the new image.

For details, see "Update file object".

Update all file objects

Reloads all of the file object layers on the canvas from the reference files and updates them to 

the new images.

For details, see "Update all file objects".
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Set as reference layer

Configures a layer as [Reference] layer. With certain tools, you will be able to select and draw 

on the currently edited layer by referring only to this layer.

For details, see "Set as reference layer".

Set as Draft Layer [PRO/EX]

Configures the layer being edited as [Draft] layer.

For [Draft layers], the following settings are available when configuring as reference, or 

exporting files.

 When exporting files with [File] menu > [Export (Single Layer)], you can choose whether 

to include draft layers.

 When configuring print settings with the [File] menu > [Print Settings], you can choose 

whether to include draft layers.

 Whether or not to include the [Draft] layer in the layers to refer to when creating a selec-

tion, or performing a fill.

Clip to layer below
Limits the area of the selected layer to display by referring to the layer immediately below.

For details, see "Clip to Layer Below".

Lock layer Locks a layer to make layer settings unchangeable. Clicking toggles the lock on and off.

Lock transparent pixels
Locks drawing to transparent areas of a layer. Allows you to draw on already drawn areas with-

out running over to transparent areas. Clicking toggles the lock on and off.

Show layer Clicking this item toggles the selected layer between display and hide.

Change Layer Name Allows you to rename a selected layer. For details, see "Change Layer Name".

Display palette colors in parent 

folder

When a palette color is specified for a layer, the specified color is also displayed for the parent 

folder. For details, see "Display palette colors in parent folder [PRO/EX]".

Display palette colors on canvas
When a palette color is specified for a layer, the canvas is filled with that palette color. For 

details, see "Display palette colors on canvas [PRO/EX]".

Advanced Settings

Opens the dialog box for correction if the correction layer is selected. For details on the dialog 

box, see "New Correction Layer [PRO/EX]". For [Fill in Monochrome Layer], the [Color set-

tings] dialog box is displayed.
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Selection from Layer
Allows you to create a selection from a drawing on the currently edited layer. You can also add or delete a selection to/from an already selected 

area. Furthermore, you can create a selection from the area overlapping an already selected area.

For details, see "Selection from Layer".

Rasterize
Converts the content of a layer other than [Raster] layer into [Raster] layer.

Convert layer [PRO/EX]
Converts the type of the layer selected on the [Layer] palette. You can change the type and expression color of a layer, as well as convert a 

drawing inside a selected area into an image material layer.

For details, see "Convert layer [PRO/EX]".

LT conversion of layer
Allows you to separate a selected layer into outlines (line drawings) and tones and convert each of them into different layers.

For details, see "LT conversion of layer [EX]".

Transfer To Lower Layer 
Transfers the image on a selected layer to the layer immediately below.

For details, see "Transfer To Lower Layer".

Merge with layer below
Combines a selected layer with that immediately below to make one.

For details, see "Merge with layer below".

Merge selected layers
Combines selected layers to make one. This is used to join images drawn separately, for example.

For details, see "Merge selected layers".

Merge visible layers
Combines only layers displayed on the [Layer] palette. Hidden layers are not combined and are left as they are.

For details, see "Merge visible layers".

Create Selection Creates a selection from a drawing on the currently edited layer.

Add Selection
Creates a selection from a drawing on the currently edited layer and adds it to an already 

selected area.

Delete Selection
Creates a selection from a drawing on the currently edited layer and removes that portion 

from an already selected area.

Select Overlapping Area
Creates a selection from a drawing on the currently edited layer and creates another selection 

only from the area overlapping with an already selected area.

For Frame Border Folders, rasterization is performed by keeping the original Frame Border Folder. After rasteriza-

tion, frames within the original Frame Border Folder become hidden.
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Merge visible to new layer
Combines the copies of visible layers. The original layers are kept as they are.

For details, see "Merge visible to new layer".

Flatten image
Combines all layers into one.

For details, see "Flatten image".

Thumbnail size
Allows you to select the size of the thumbnails to be displayed on the [Layer] palette from [None], [Smallest], [Small], [Medium], [Large] and 

[Largest].

Thumbnail display settings 
Allows you to select the area to be displayed in the thumbnail on the [Layer] palette.

Show property bar 
When turned on, displays the property bar of the [Layer] palette.

Show whole canvas Display the entire canvas in the thumbnail.

Show only layer area Display only the drawn area of the layer in the thumbnail.

Display transparent area Displays the transparent area of the layer in the thumbnail.

Thumbnail size: Smallest Thumbnail size: Small Thumbnail size: Middle Thumbnail size: Large

Show property bar: Off Show property bar: On

Property bar
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Show command bar 
When turned on, displays the command bar of the [Layer] palette.

Set command bar below list
When turned on, displays the command bar of the [Layer] palette below the [Layer list].

When turned off, displays the command bar of the [Layer] palette above the [Layer list].

Hide layer palette
Hides the [Layer] palette.

To show the Layer palette again, select the palette from the [Window] menu > [Layer]. If you are using a Smart-

phone, tap the icon on the palette bar.

Show command bar: Off Show command bar: On

Command bar

Set command bar below list: Off Set command bar below list: On
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Show/hide layer Toggle Menu
Right clicking [Show/hide layer] on the [Layer] palette displays a menu that toggles the layer visibility. The following describes the function of 

each menu item.

Switch show and hide of this layer
Toggles the visibility of the currently edited layer.

Show this layer including upper folder
Makes visible the layer folder and the currently edited layer within the folder.

 This menu item is available only when the currently edited layer is selected from inside a layer folder.

 All upper layer folders become visible.

Right Click

Edited layer

Edited layer
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Show all other layers
Makes visible all layers except the one being edited. The visibility of the layer being edited does not change.

Hide all other layers
Hides all layers except the one being edited. The visibility of the layer being edited does not change.

Hide all except selected layer
Hides all layers except the selected one. The visibility of the selected layer does not change.

Edited layer

Edited layer

Selected layer
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 Layer Operations
Layer operations are possible from the [Layer] menu and [Layer] palette.

Select the layer
On the [Layer] palette, click the name of the layer you want to edit.

Creating a New Layer
To create a new layer, select the [Layer] menu > [New Layer]. The layer is created above the layer currently selected on the [Layer] palette.

A layer can also be created by clicking [New Raster Layer] on the [Layer] palette.

Deleting a Layer
Select the layer on the [Layer] palette, then select the [Layer] menu > [Delete Layer]. The layer is deleted from the [Layer] palette.

You can also delete a layer by selecting the layer and clicking [Delete Layer] on the [Layer] palette.

If you are using Windows/macOS/Tablet, you can also delete the selected layer by dragging and dropping it to [Delete Layer] on the [Layer] 

palette.

Layer operations performed on the [Layer] palette are also reflected on the [Timeline] palette. Track (layer) opera-

tions performed on the [Timeline] palette are also reflected on the [Layer] palette.

Select a cel in an animation folder to move to the frame specified by the selected cel on the [Timeline] palette.
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Changing the Stacking Order of a Layer
The order in which layers are stacked can be changed by dragging and dropping.

1 Select the layer
On the [Layer] palette, select the layer whose stacking order you want to change.

2 Change the stacking order of the layer
Drag and drop the palette to the desired position. A red line is displayed in the new position.

When using a Tablet/Smartphone, move a finger or pen over the grip on the right side of the layer and drag and drop it.

3 The stacking order change is complete
The layer moves to the dragged and dropped position.

The stacking order of layer folders can also be changed in the same way as layers.

 To select multiple layers, click the layers while holding Ctrl.

 To select a group of consecutive layers, click the layers while holding Shift down.
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Erasing a Drawing from a Layer
In the [Layer] palette, select the layer whose content you want to delete and then select [Edit] menu > [Delete]. The content drawn on the layer 

is erased, leaving the layer on the [Layer] palette.

Switching Show/Hide for a Layer
On the [Layer] palette, click [Show/hide palette] for the layer whose visibility you want to change.

Displaying a Layer Individually
Clicking [Show/hide layer] while holding down Alt makes visible only the clicked layer.

Clicking [Show/hide layer] again while holding Alt restores the previous visibility status.

Right clicking [Show/hide layer] displays a menu that toggles the layer display status. For details, see "Show/hide 

layer Toggle Menu".

[Alt]+Click [Alt]+Click
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Configuring the Opacity of a Layer
The slider on the upper part of the [Layer] palette allows you to specify the opacity for the selected layer. Moving the slider to the right 

increases the opacity of the layer.

Displaying a Checkered Pattern in Transparent Areas
When Hide is selected for [Show/Hide layer] of the [Paper] layer, the transparent area is displayed in checkered pattern.

You can change the colors of the checkered pattern in the [Preferences] dialog box. For details, see "Canvas".
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Setting the Blending Mode
This menu allows you to specify the blending mode of layers.

Blending Modes on the Layer Palette
The following blending modes can be set on the [Layer] palette.

In this section, the upper layer on which the blending mode is set is called the "set layer" and the layer below it is called the "layer below". The 

figure for each item shows the effect of the set blending mode when the following layer configuration is used.

Normal
The set layer is simply placed over the layer below.

[Darker color], [Lighter color], [Vivid light], [Linear light], [Pin light], [Hard mix], [Exclusion], [Divide], [Hue], [Satu-

ration], [Color] and [Brightness] blending modes have been added to Ver. 1.6.2. Layers with these new blending 

modes will not be shown correctly in Clip Studio Paint Ver 1.5.4 and earlier.

Layer Below Drag the layer to be set (placed on top)
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Darken
The RGB values of the set layer and the layer below are compared and the color with the lower value is displayed.

For example, if a color where R = 100, G = 200 and B = 25 is blended with one where R = 10, G = 255 and B = 90, the blended color uses the 

lowest of each RGB value: R = 10, G = 200 and B = 25.

Multiply
The RGB values of the set layer are multiplied by those on the layer below. After blending, the colors are darker than the originals.

For example, if a color where R = 100, G = 200 and B = 25 is blended with one where R = 10, G = 255 and B = 90, the R values of 100 and 10 

from the two layers are multiplied together and then divided by 255 to obtain the blended color value. The G and B values are calculated in the 

same way to obtain the blended values.

If the set layer is white (R = 255, G = 255, B = 255), the color of the layer below is used as it is.

Color burn
Produces an effect similar to the "burn" in silver halide photography. The colors used in images on the layer below are first darkened to increase 

contrast, and then combined with the colors used on the layer being configured.

If the set layer is white (R = 255, G = 255, B = 255), the color of the layer below is used as it is.
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Linear burn
The colors in the layer below are first darken, and then combined with the colors in the layer being configured.

If the set layer is white (R = 255, G = 255, B = 255), the color of the layer below is used as it is.

Subtract
The RGB values of the set layer are subtracted from those of the layer below. After blending, the colors are darker than the originals.

For example, if R = 10, G = 255 and B = 90 on the layer below and R = 100, G = 200 and B = 25 on the set layer, the R value of the set layer 

(100) is subtracted from that of the layer below (10). Because the result is a negative value, 0 is set as the blended R value. The G and B values 

are calculated in the same way to obtain the blended values.

If the set layer is black (R = 0, G = 0, B = 0), the color of the layer below is used as it is.

Lighten
The RGB values of the set layer and the layer below are compared and the color with the higher value is displayed. For example, if a color 

where R = 100, G = 200 and B = 25 is blended with one where R = 10, G = 255 and B = 90, the blended color uses the highest of each RGB 

value: R = 100, G = 255 and B = 90.
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Screen
The colors used in the layer below are inverted and then multiplied with those on the set layer. After blending , the colors are brighter than the 

originals.

If the set layer is black (R = 0, G = 0, B = 0), the color of the layer below is used as it is. If the set layer is white (R = 255, G = 255, B = 255), it 

remains white.

Color dodge
As with "dodge" in silver halide photography, the colors used in the lower layer becomes brighter and the contrast, lower.

If the set layer is black (R = 0, G = 0, B = 0), the color of the layer below is used as it is.

Dodge (Glow)
Produces stronger effect on semi-transparent areas than [Color dodge].

If the set layer is black (R = 0, G = 0, B = 0), the color of the layer below is used as it is.
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Add
The RGB values of the set layer are added to those of the layer below. After blending , the colors are brighter than the originals.

For example, if R = 10, G = 255 and B = 90 on the layer below and R = 100, G = 200 and B = 25 on the set layer, the R value of the set layer 

(100) is added to that of the layer below (10). The blended value is 110. The G and B values are calculated in the same way to obtain the 

blended values. If the result is over 255, 255 is set as the blended value.

If the set layer is black (R = 0, G = 0, B = 0), the color of the layer below is used as it is.

Add (Glow)
Produces stronger effect on semi-transparent areas than [Add].

If the set layer is black (R = 0, G = 0, B = 0), the color of the layer below is used as it is.

Overlay
[Multiply] or [Screen] is applied depending on the color of the layer below. After combine, bright areas are brighter and dark areas, darker.
CLIP STUDIO PAINT Instruction Manual 890



Layer Palette > Layer Operations > Setting the Blending Mode
Soft light
The results differ depending on the brightness of the set layer. When the overlapping color is brighter than 50% gray, the result is brighter than 

the original color, as in the dodge effect.

When the overlapping color is darker than 50% gray, the result is darker than the original color, as in the burn effect. When the overlapping 

color is 50% gray, the color of the layer below is used as it is.

Hard light
The results differ depending on the brightness of the set layer. When the overlapping color is brighter than 50% gray, the result is a brighter 

color resembling the effect of [Screen].

When the overlapping color is darker than 50% gray, the result is a darker color resembling the effect of [Multiply]. When the overlapping 

color is 50% gray, the color of the layer below is used as it is.

Difference
The color of the set layer is subtracted from the layer below and the absolute value of the difference is blended with the color of the layer below.
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Vivid light
The contrast is strengthened or weakened depending on the color of the set layer. If the set layer is brighter than 50% gray, burn is applied and 

the image is brightened. If it is darker than 50% gray, dodge is applied and the contrast of the image is strengthened.

Linear light
The brightness is increased or decreased depending on the color of the set layer. If the set layer is brighter than 50% gray, the image is bright-

ened. If it is darker than 50% gray, the image is darkened.

Pin light
The colors of the image are replaced depending on the color of the set layer. If the set layer is brighter than 50% gray, the color of the layer 

below is only replaced with that of the set layer in the areas where the color of the layer below is darker. If the set layer is darker than 50% gray, 

the color of the layer below is only replaced with that of the set layer in the areas where the color of the layer below is brighter.
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Hard mix
The RGB values of the set layer are added to those of the layer below. If the total of an RGB value is higher than 255, it is converted to 255. If 

the total of an RGB value is lower than 255, it is converted to 0.

Exclusion
An effect similar to [Difference], except with a lower contrast.

If the set layer is white, the colors of the layer below are inverted when blending. If the set layer is black, the color of the layer below is used as 

it is.

Darker color
The brightness of the set layer and the layer below are compared, and the color with the lower value is displayed.
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Lighter color
The brightness of the set layer and the layer below are compared, and the color with the lower value is displayed.

Divide
The RGB values of the layer below are multiplied by 255 and then divided by the RGB values of the set layer.

For example, if R = 10, G = 255 and B = 90 on the layer below and R = 100, G = 200 and B = 25 on the set layer, the R value of the layer below 

(10) is multiplied by 255 (=2550) and then divided by the R value of the set layer (100). The blended value is 13. The G and B values are cal-

culated in the same way to obtain the blended values. If the result is over 255, 255 is set.

Hue
The hue of the set layer is applied while maintaining the brightness and saturation of the layer below.
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Saturation
The saturation of the set layer is applied while maintaining the brightness and hue of the layer below.

Color
The hue and saturation of the set layer are applied while maintaining the brightness of the layer below.

Brightness
The brightness of the set layer is applied while maintaining the hue and saturation of the layer below.

Through
Applies the effects and layer blending modes of the tonal correction layers stored in the layer folder also to layers outside the layer folder. 

[Through] is available only when a layer folder is selected.
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Layer Property Palette 
[PRO/EX]
The [Layer Property] palette allows you to configure a variety of layer settings.

It can also be used to display and switch tools and sub tools available for use in the selected layer.

The [Layer Property] palette displays when [Window] menu > [Layer Property] is selected.

 Functions of Layer Property Palette



Layer Property Palette [PRO/EX]  > Functions of Layer Property Palette
Layer Property Palette [PRO/EX]

 Functions of Layer Property Palette
This section describes the functions of the [Layer Property] palette. Settings available on the [Layer property] palette
vary depending on the selected layer type. See the corresponding section based on the table below.

Selection layer See "When a Selection Layer, Quick mask, or Paper Layer Is Selected".

Quick mask See "When a Selection Layer, Quick mask, or Paper Layer Is Selected".

Paper layer See "When a Selection Layer, Quick mask, or Paper Layer Is Selected".

When Frame Border Folder Is Selected See "When Frame Border Folder Is Selected".

When Correction Layer Is Selected See "When Correction Layer Is Selected".

When a light table layer is selected See "When a light table layer is selected".

Other layers See "Functions of Layer Property Palette (Default)".
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Functions of Layer Property Palette (Default) 
This section describes the functions of the standard [Layer Property] palette.

Displayed items may vary depending on the selected layer. Furthermore, displayed items may also vary depend-

ing on the configured settings.

A

B

C

D

E

F

H

A

B
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D
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A

D

E
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J

For Image material layerFor Raster layer For Fill layer
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A. Effect
Configures the type of effect to apply to the layer and the area where the effect applies.

(1) Effect

Clicking each of the buttons toggles on and off the effects of [Border effect], [Extract line], [Tone], [Display decrease color], [Overlay tex-

ture] and [Layer color].

When turned on, the related items display on the [Layer Property] palette. In [Effect], you may select multiple items simultaneously.
o

Dragging vertically while pressing the Space bar allows you to scroll through the [Layer Property] palette.

When a cel on the light table is selected from the [Animation cels] palette, items other than [Layer color] cannot be 

selected, regardless of the layer type.

Border effect

Allows you to configure effects to be applied to the drawings and border (perimeter) of materials on 

the layer. Two types of effects are available: [Edge] and [Watercolor edge].

This item is not displayed when [Gradient] layer or [Fill in monochrome] layer is selected.

Extract line [EX]

An effect that extracts line drawings from a layer to display.

This item does not display when a [Gradient] layer, [Fill in monochrome] layer, or [Layer folder] is 

selected.

Tone An effect that displays images on a layer with black and white halftone dots (toning).

Display decrease color

Reduces the colors of a layer to [Monochrome] or [Gray].

This item displays only when a [Image material] layer or [3D] layer is selected.

When turned off, the original expression color(s) is (are) restored.

Overlay texture
Displays when an [Image material] layer other than [Vector image material] layer is selected.

This is an effect where images on an [Image material] layer are displayed as texture.

Layer color

The color of the drawing on the layer can be changed arbitrarily.

For layers whose [Expression color] is [Monochrome] or [Gray], the black [Drawing color] becomes 

[Main color] and the white [Drawing color] becomes [Sub color] for display.

For layers whose [Expression color] is [Color], the colors are first converted into grayscale by the 

application and then changed to alternative colors.
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(2) Effect range 

For layers that has a [layer mask], configure the area where the effect applies.

This item displays when [Border effect], [Extract line] or [Tone] is selected for [Effect] and the selected layer has [layer mask].

B. Border effect 
Turning on [Border effect] for [Effect] displays the items below.

(1) Border effect

Select the effect to apply to the drawings and border (perimeter) of materials on the layer. [Border effect] settings to configure vary 

depending on the selected item.

In the case of Edge

Configure the following items in the case of selecting [Edge].

(2) Thickness of edges

Configure the thickness of the edges with the slider.

(3) Edge color

Configure the color of the edges. Clicking the color indicator displays the [Color settings] dialog box where you can set the color. Click 

[Fill] to set the selected drawing color.

Image Applies the effect to all images inside the selected layer.

Mask image Applies the effect to images on the selected layer after masking.

[Border effect] does not display when a [Gradient] layer or [Fill in monochrome] layer is selected.

Edge Allows you to configure a monochrome edge for the outer side of drawings and border of materials.

Watercolor 

edge

Allows you to configure a pale, subtle edge, as drawn with watercolor, for the outer side of drawings and bor-

der of materials.

Border effect: Edge

Border effect: Border of water color

Original image Edge Border of watercolor
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(4) Edge Anti-aliasing

You can set anti-aliasing to apply to edges. Turn this on when you want to apply anti-aliasing to edges.

In the case of Watercolor edge

Configure the following items in the case of selecting [Watercolor edge].

(5) Area

Configure the area where you want to apply edge to the border of drawings. The larger the value, the wider will be displayed the border 

edge.

(6) Opacity

Configure the opacity of the border area. The larger the value, the more opaque will be displayed the border area.

(7) Darkness

Configure how dark to make the border area. The larger the value the darker will be displayed the border area.

(8) Blurring width

Configure how blurred to make the border area. The larger the value, the more blurred will be displayed the border area.

C. Extract line [EX] 
Selecting [Extract line] for [Effect] displays the items below.

(1) Accuracy of line extraction

Configure the accuracy with which to extract the line drawing. Select one from: [Fast], [High accuracy] and [Highest accuracy]. The 

higher the accuracy, the better will be the quality of the displayed line drawing.

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

 [Extract line] does not display when a [Gradient] layer, [Fill in monochrome] layer, or [Layer folder] is selected.

 Some of the items may not display depending on the selected layer.

Normal cases

When image layer is selected
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(2) Posterize before extracting lines

When turned on, the original layer is posterized before the line drawing is extracted. The gradient can be adjusted using [Posterization con-

trol].

Posterization control

Adjust the grayscale gradient to extract as line drawing.

(3) Threshold of fill in black

Allows you to configure the area to be filled in black. You can set the threshold using the slider.

(4) Correction of line width

Allows you to adjust the width of the line drawing using a slider.

(5) Threshold of edge

Configure the grayscale threshold to extract as line drawing. The smaller the value, the more lines will be detected making the line art 

wider.

(6) Direction of detection

Specify the direction in which to detect the line drawing. The capability to detect line drawings becomes poorer in the opposite direction.

(7) Convert layer to lines and tones

Displays the [LT conversion of layer] dialog box.

Allows you to convert the selected layer by separating it into outline (line drawing) and tone layers, while inheriting the [Extract line] and 

[Tone] settings of the [Layer Property] palette.

When the Selected Layer Is an Image Material Layer

The following additional items are displayed when the selected layer is an [Image material] layer:

(8) Method of detecting edge

Allows you to select the method for detecting line drawings from the [Image material layer] . The items to set will vary depending on the 

method selected.

(1) Density Shows the grayscale value. Clicking the numeric value allows you to change it directly.

(2) Preview Previews the posterization.

(3) Node

This is a controller that adjusts the grayscale gradient.

 Dragging the node horizontally allows you to adjust the gradient range reflecting the density.

 Dragging a node out of the [Posterization control] allows you to remove it.

 Clicking on a blank area allows you to add a node.

Items displayed on the [LT conversion of layer] dialog box vary depending on whether the selected layer is a 3D 

layer or not. For details on the [LT conversion of layer], see the following:

 "[LT conversion of layer] Dialog Box (3D Layer)"

 "[LT conversion of layer] Dialog Box (Not 3D Layer)"

Process 1 Configure settings in the same way as for other layers.

Process 1
Settings to be configured differ from those for other layers. Select this method to extract more delicate line draw-

ings than with [Process 1].
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(9) Threshold of edge height

Allows you to adjust the height of the edge detected as line art. The smaller the value, the weaker the edge, making even small changes 

detected as a line.

(10)Threshold of gradient variation

Adjusts the continuity of the detected line art based on the variation in the thickness of the image. The larger the value, the more likely it is 

to have short segments.

D. Tone
Turning on [Tone] for [Effect] displays the following items.

(1) Frequency 

Specify the number of screentone lines per inch. The larger the value, the smaller will be the halftone dot.

(2) Density 

Configure the method for specifying the tone density.

(3) Reflect layer opacity

When turned on, the opacity of the layer is reflected in the size of the halftone dots at toning.

Use color of image Configures the tone density based on the image color.

Use brightness of image Configures the tone density based on the image brightness.

When fill layer is selected

Original image [Reflect layer opacity]: OFF
(50% layer opacity)

The color of the halftone dots 
 becomes lighter.

[Reflect layer opacity]: ON
(50% layer opacity)

The opacity is reflected in the 
 size of the halftone dots.
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(4) Posterization

When turned on, you to adjust the density of the tone using [Posterization control].

Posterization control

Adjusts the density of the tones.

(5) Dot settings 

Select the shape of the tone from [Circle], [Square], [Lozenge], [Line], [Cross], [Ellipse], [Noise], [Sugar plum], [Asterisk], [Star], [Car-

rot], [Cherry (round)], [Cherry (mid)], [Cherry (thin)], [Flower (round)], [Flower (mid)], [Flower (thin)], [Clover (round)], [Clover (thin)], 

[Ninja star], [Diamond], [Heart], [Clubs], and [Spades].

(6) Angle 

Configure the angle of the tone (halftone dot).

(7) Noise size 

Configure the noise size. You can configure this item when Noise is selected for [Dot settings].

(8) Noise factor 

Configure the noise factor. You can configure this item when Noise is selected for [Dot settings].

(9) Dot position (X) 

Moves the tone (halftone dot) pattern in the horizontal direction.

(10)Dot position (Y) 

Moves the tone (halftone dot) pattern in the vertical direction.

(11) Area Color

If [Show Tone Area] is enabled, you can configure the expression colors of the areas with tone attached and areas with image materials 

attached. Clicking the color indicator displays the [Color settings] dialog box where you can set the color. Click [Fill] to set the selected 

drawing color. Configuring a color changes the color of the toned areas to the configured color.

When [Reflect layer opacity] is turned on, the density of the halftone dots does not change even if the layer opac-

ity is changed, which will allow you to avoid moire from occurring when outputting in black and white, for exam-

ple.

This item does not display when a [Fill in monochrome] layer is selected.

(1) Density Shows the density of the tone numerically. Clicking the numeric value allows you to change it directly.

(2) Preview Previews the posterization.

(3) Node

A controller to adjust the gradient of the tone density.

 Dragging the node horizontally allows you to adjust the gradient range reflecting the density of the 

tone.

 Dragging a node out of the [Posterization control] allows you to remove it.

 Clicking on a blank area allows you to add a node.
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E. Layer color
Turning on [Layer color] for [Effect] displays the following items.

(1) Layer color

Allows you to specify an alternative color to black. Clicking the color indicator displays the [Color settings] dialog box where you can set 

the color. Click [Fill] to set the selected drawing color. Configuring a color changes black to the configured color.

 [Area Color] is displayed if any of the items in the [Display] menu > [Show Tone Area] are turned on. For 

details on [Show Tone Area], see "Show Tone Area [PRO/EX]".

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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(2) Sub color

Allows you to specify an alternative color to white. Clicking the color indicator displays the [Color settings] dialog box where you can set 

the color. Click [Fill] to set the selected drawing color. Configuring a color changes white to the configured color. This item does not dis-

play when the selected layer is monochrome.

F. Expression color 
Allows you to configure [Expression color] for the layer by previewing it. This item displays when a [Raster] layer, [Vector] layer, [Bal-

loon] layer or [Text] layer is selected. Clicking [Apply expression color of preview] commits the [Expression color] for the layer.

Displayed items vary depending on the selected layer and configured [Expression color].

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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(1) Expression color

Changes the expression color of the selected layer. Select from [Color], [Gray] and [Monochrome].

When reducing colors degrades the image quality, the view changes to [Expression color (preview)], where the image is displayed in 

reduced colors but in the original expression color.

(2) Drawing color

Configures the drawing color for [Gray] and [Monochrome]. Configure the color with the [Black] and [White] buttons.

Gray

The drawing color is configured as follows with the [Black] and [White] buttons.

Monochrome

The drawing color is configured as follows with the [Black] and [White] buttons.

(3) Color threshold

The color threshold configured with the slider becomes the border between black and white.

This item displays when a [Raster] layer meeting the following conditions is selected, and [Monochrome] is configured for [Expression 

color] on the [Layer Property] palette.

 [Expression color] is [Color]

 [Expression color] is [Gray] and the [Drawing color] is [Black] and [White]

For details on [Expression color], see "Explanation: Expression Color and Drawing Color".

[Drawing color] displays when [Expression color] is [Gray] or [Monochrome].

Only black button ON The drawing color is configured as a 256-step gradient from black to transparent.

Only white button ON The drawing color is configured as a 256-step gradient from white to transparent.

Both black and white but-

tons ON

The drawing color is configured as a 256-step gradient from black to white. When drawn in trans-

parent, the drawn portion is erased.

Only black button ON The drawing color is configured as black or transparent.

Only white button ON The drawing color is configured as white or transparent.

Both black and white but-

tons ON
The drawing color is configured as black, white or transparent.

Color Gray Monochrome
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(4) Alpha threshold

The alpha threshold for opacity configured with the slider becomes the border between black and white and transparent. This item displays 

when a [Raster] layer is selected, and [Monochrome] is configured for [Expression color] on the [Layer Property] palette.

(5) Reflect layer opacity

Reflects the layer opacity in the density. This item displays when a [Raster] layer is selected, and [Monochrome] is configured for [Expres-

sion color] on the [Layer Property] palette.

(6) Apply expression color of preview

Clicking the button converts the layer into the [Expression color] and [Drawing color] configured on the [Layer Property] palette. At the 

same time, the [Expression color] and [Drawing color] settings prior to configuring them on the [Layer Property] palette are discarded.

For example, if [Monochrome] is configured for [Expression color] on the layer property palette for a [Raster] layer whose [Expression 

color] is [Color] and the [Apply expression color of preview] button clicked, the [Raster] layer is converted to a layer whose [Expression 

color] is [Monochrome].

G. Display decrease color
Turning on [Display decrease color] for [Effect] displays the following items.

(1) Expression color

Configures the [Expression color] applicable when [Display decrease color] is turned on for the selected layer. Select from [Gray] and 

[Monochrome].

(2) Drawing color

Configures the drawing color applicable when [Expression color] is [Gray] or [Monochrome] for [Display decrease color. Configure the 

color with the [Black] and [White] buttons.

(3) Color threshold

The color threshold configured with the slider becomes the border between black and white.

This item displays when the configured [Expression color] is [Monochrome] for [Display decrease color] and

 The [Expression color] is [Color] for the layer when [Display decrease color] is turned off, or

 The [Expression color] is [Gray] and [Drawing color] is [Black] and [White] for the layer when [Display decrease color] is turned off

This item does not display if drawings on the layer are monochrome, even if the [Expression color] of the [Raster] 

layer is [Color] or [Gray].

On
Divides the [Drawing color] into black and white and transparent based on the drawing color with layer 

opacity applied.

Off Applies opacity to a layer whose [Expression color] has been changed to monochrome.

This item does not display if drawings on the layer are monochrome, even if the [Expression color] of the [Raster] 

layer is [Color] or [Gray].

 [Display decrease color] displays when a [Image material] layer or [3D] layer is selected.

 If items for [Display decrease color] are configured, the preview is displayed in [Gray] or [Monochrome], with-

out changing the original expression color.
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(4) Alpha threshold

The alpha threshold for opacity configured with the slider becomes the border between black and white and transparent. This item displays 

when the configured [Expression color] is [Monochrome] for [Display decrease color].

(5) Reflect layer opacity

Reflects the layer opacity in the density. This item displays when the [Expression color] for [Display decrease color] is changed to [Mono-

chrome].

H. Mask expression 
This item displays when a layer including a mask is selected, and [Monochrome] is configured for [Expression color] on the [Layer Prop-

erty] palette. Allows you to configure a gradient for the mask.

(1) Posterization

Select posterization for the mask from [Yes] and [No]. Selecting [Yes] keeps the existing gradient. Selecting [No] binarizes the mask gra-

dient.

(2) Threshold

This item displays when [No] is configured for [Posterization]. The color threshold configured with the slider becomes the border to divide 

the layer mask colors into [Black] and [Transparent].

On
Divides the [Drawing color] into black and white and transparent based on the drawing color with layer 

opacity applied.

Off Applies opacity to a layer whose [Expression color] has been changed to monochrome.
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I. Overlay texture
Turning on [Overlay texture] for [Effect] displays the following items.

(1) Strength

Allows you to configure the strength of the texture. The larger the value, the stronger will be the effect of the texture.

J. Tool navigation
[Tool navigation] displays tools and sub tools that can be used for editing the selected layer.

Placing the mouse cursor over a tool icon on the [Tool navigation] displays the tool name. Clicking the tool icon switches the tool/sub tool.

The [Tool navigation] does not display when a layer including a raster layer and a layer mask is selected.

[Overlay texture] displays when an [Image material] layer other than vector is selected.

When [Image material] layer is stacked above ([Material] palette -> [Monochromatic pattern] -> [Texture] -> [Rough] used)

When [Texture combine] is ON (Strength: 30) Reference: When [Texture combine] is ON 

(Strength: 80)

Configure "30"  for [Strength].

Turn on [Texture combine]  for [Effect].
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When a Selection Layer, Quick mask, or Paper Layer Is Selected
This section describes the functions of the [Layer property] palette when a [Selection] layer, [Quick Mask] or [Paper] layer is selected.

(1) Layer color

Allows you to specify an alternative color for the layer color. Clicking the color indicator displays the [Color settings] dialog box where 

you can set the color. Click [Fill] to set the selected drawing color. Configuring a color changes the display color of the layer to the config-

ured color.

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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When Frame Border Folder Is Selected
This section describes the functions of the [Layer property] palette when a frame border folder is selected.

(1) Expression color of border 

Changes the expression color of the border. Select from [Color], [Gray] and [Monochrome].

When reducing colors degrades the border image quality, the view changes to [Expression color of border (preview)], where the image is 

displayed in reduced colors but in the original expression color.

(2) Drawing color 

Configures the [Drawing color] applicable when [Gray] or [Monochrome] is selected for [Expression color of border]. Configure the color 

with the [Black] and [White] buttons.

Gray

The drawing color is configured as follows with the [Black] and [White] buttons.

Monochrome

The drawing color is configured as follows with the [Black] and [White] buttons.

(3) Apply expression color of preview 

Clicking the button converts the [Expression color] of the [Frame border folder] into the [Expression color of border] and [Drawing color] 

configured on the [Layer Property] palette. The expression color prior to changing with that on the [Layer Property] palette is discarded.

(4) Tool navigation

[Tool navigation] displays tools and sub tools that can be used for editing the selected layer.

Placing the mouse cursor over a tool icon on the [Tool navigation] displays the tool name. Clicking the tool icon switches the tool/sub tool.

[Expression color of border] reflects only in border lines. It does not reflect in layers inside the [Frame border 

folder].

[Drawing color] displays when [Expression color of border] is [Gray] or [Monochrome].

Only black button ON The drawing color is configured as a 256-step gradient from black to transparent.

Only white button ON The drawing color is configured as a 256-step gradient from white to transparent.

Both black and white but-

tons ON
The drawing color is configured as a 256-step gradient from black to white.

Only black button ON The drawing color is configured as black or transparent.

Only white button ON The drawing color is configured as white or transparent.

Both black and white but-

tons ON
The drawing color is configured as black, white or transparent.
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When Correction Layer Is Selected
This section describes the functions of the [Layer Property] palette when the [Correction] layer is selected.

(1) Posterization

Select posterization for the mask from [Yes] and [No]. Selecting [Yes] keeps the existing gradient. Selecting [No] binarizes the mask gra-

dient.

(2) Threshold

This item displays when [No] is configured for [Posterization]. The color threshold configured with the slider becomes the border to divide 

the layer mask colors into [Black] and [Transparent].

Posterization : Yes Posterization: No
CLIP STUDIO PAINT Instruction Manual 913



Layer Property Palette [PRO/EX] > Functions of Layer Property Palette > When a light table layer is selected
When a light table layer is selected
This section describes the features of the [Layer Property] palette when a [Light table] layer is selected on the [Animation cel] palette.

(1) Color mode

Set the display colors for the light table layers.

(2) Layer color

It is possible to set the display color to be used in place of white when [Half color] or [Monochrome] is selected for [Color mode]. When 

[Monochrome] is selected, the [Main color] is used in place of black.

Clicking the color indicator displays the [Color settings] dialog box where you can set the color. Click [Fill] to set the selected drawing 

color. This item does not display when [Color] is selected for [Color mode].

(3) Sub color

it is possible to set the display color to be used in place of white when [Monochrome] is selected for [Color mode].

Clicking the color indicator displays the [Color settings] dialog box where you can set the color. Click [Fill] to set the selected drawing 

color. Configuring a color changes white to the configured color. This item does not display when [Color] or [Half color] is selected for 

[Color mode].

Color Colors of cels and layers are displayed as is.

Half color
The color set for [Layer color] is combined with the cel and layer colors while maintaining those 

colors.

Monochrome
The cel and layer colors are grayed. Black is changed to the color set for [Layer color] and white 

is changed to the color set for [Sub color].

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".

Color Half color Monochrome
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(4) Tool navigation

[Tool navigation] displays tools and sub tools that can be used for editing the selected layer.

Placing the mouse cursor over a tool icon on the [Tool navigation] displays the tool name. Clicking the tool icon switches the tool/sub tool.

Layer property Palette Menu
The following describes the functions included in the menu that displays when you click [Palette menu] on the upper left corner of the [Layer 

property] palette.

Save as default
Displays the [Save layer properties as default] dialog box, allowing the current settings to be registered as default settings on the [Layer Prop-

erty] palette. Items to be registered can be selected from the [Save layer properties as default] dialog box.

Hide layer property palette
Hides the [Layer Property] palette.

Default settings can be registered to [Layer color] for each layer type. For example, if the layer color used when a 

raster layer is selected is registered as a default setting, the registered default setting is applied only when raster 

layers are selected.

To display the [Layer Property] palette again, select the [Window] menu > [Layer Property]. If you are using a 

Smartphone, tap the button on the palette bar.

Show menu
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Search Layer Palette 
[PRO/EX]
The [Search Layer] palette is a palette that displays layers that match a specified condition, such as type.

The palette also allows you to select tools/sub tools that can be used in the displayed layer, as well as perform 

simple layer management operations such as create/delete a layer.

The [Search Layer] palette displays when [Window] menu > [Search Layer] is selected.

 Functions of Search Layer Palette



Search Layer Palette [PRO/EX]  > Functions of Search Layer Palette
Search Layer Palette [PRO/EX]

 Functions of Search Layer Palette
This section describes the functions of the [Search Layer] palette.

(1) Show these layers

Clicking displays a list of layer types. Turning on a check box displays the specified type of layer on the [Layer list].

(2) Include

Allows you to narrow down the layers displayed on the [Layer list] by specifying conditions. You can specify the following conditions: 

[View], [Lock], [Locked transparent pixels] and [Reference layer].

(3) Exclude

Allows you to exclude the layers displayed on the [Layer list] by specifying conditions. You can specify the following conditions: [View], 

[Lock], [Locked transparent pixels], [Reference layer], [Draft] layer, [Outside edited folder], [Outside edited frame folder], [Outside 

edited animation folder].

(4) Tool navigation

[Tool navigation] displays tools and sub tools that can be used for editing the selected layer.

For example, when [Text/Balloon] is specified, the [Object], [Text] and [Balloon] tools and sub tools are displayed as possible tools/sub 

tools.

(5) Create new layer

Creates a new layer above the layer selected on the [Layer] palette.

(6) Delete Layer

Deletes the layer selected on the [Search Layer] palette.

(7) Layer list

Displays a list of layers according to conditions configured in [Show these layers], [Include] and [Exclude].

 The order in which layers are displayed on the [Layer list] cannot be changed.

 [Select layer], [Show/hide layer] and the like work in the same way as in the [Layer] palette. For details on how to use, see "Functions 

of Layer Palette".

 Possible tools and sub tools may not display depending on the type of layer.

 [Tool navigation] does not display when multiple types of layers are specified in [Show these layers].

 Depending on the type of layer specified in [Include], the type of layer you may create varies.

 [Create new layer] may not display depending on the type of layer.
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Search Layer Palette Menu
This section describes the functions included in the menu that displays when you click [Palette menu] on the upper left corner of the [Search 

Layer] palette.

Create folder and insert layer
Creates a new layer folder and places the layer selected on the [Layer] palette in the folder.

Duplicate Layer
Makes a copy of the selected layer or layer folder.

For details, see "Duplicate Layer".

Delete Layer
Deletes the selected layer or layer folder.

Layer mask
Creates a mask for the layer or layer folder selected on the [Search Layer] palette. Masks can be deleted as well as configured.

Drag vertically while holding the Space bar to scroll through the layer list.

Some menu items can be run from the context menu that displays when you right click the mouse.

When a layer folder is selected, also the layers stored in the folder are deleted.

Mask Outside Selection
Masks the area outside of the selected area.

For details, see "Mask Outside Selection".

Mask selection
Masks the selected area.

For details, see "Mask Selection".

Delete Mask Deletes the layer mask of a selected layer.

Apply Mask to Layer Applies the layer mask. Applying the mask converts the layer into a [Raster] layer.

Enable Mask
Turning on this item by selecting the menu enables the layer mask.

For details, see "Enable Mask".

Show Mask Area Turning on this item by selecting the menu displays the masked area in purple.

Link Mask to Layer

Turning on this item by selecting the menu links the layer and mask. When linked, the mask 

drawing moves along with the layer when this is moved using the [Move layer] tool.

For details, see "Link Mask to Layer".

Show Menu
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Ruler/Frame
Allows you to delete and display rulers, create perspective rulers, and so on. It also allows you to configure whether to move the ruler along 

with the drawing area of the layer being edited, or separately. For details, see "Ruler/Frame [PRO/EX]".

File object[PRO/EX]
Allows you to perform operations related to file object layers. File object layers are layers used to load files such as videos and images into Clip 

Studio Paint.

For details, see "File object".

Layer settings
Allows you to configure settings related to layers such as reference layer, clipping, layer lock, transparent pixel lock, and so on.

Set as reference layer

Configures a layer as [Reference] layer. With certain tools, you will be able to select and draw 

on the currently edited layer by referring only to this layer.

For details, see "Set as reference layer".

Set as draft layer

Configures the layer being edited as [Draft] layer.

For [Draft layers], the following settings are available when configuring as reference, or 

exporting files.

 When exporting files with [File] menu > [Export (Single Layer)], you can choose whether 

to include draft layers.

 When configuring print settings with the [File] menu > [Print Settings], you can choose 

whether to include draft layers.

 Whether or not to include the [Draft] layer in the layers to refer to when creating a selec-

tion, or performing a fill.

Clip to layer below
Limits the area of the selected layer to display by referring to the layer immediately below.

For details, see "Clip to Layer Below".

Lock layer Locks a layer to make layer settings unchangeable. Clicking toggles the lock on and off.

Lock transparent pixels
Locks drawing to transparent areas of a layer. Allows you to draw on already drawn areas with-

out running over to transparent areas. Clicking toggles the lock on and off.

Show layer Clicking this item toggles the selected layer between display and hide.

Change Layer Name Allows you to rename a selected layer. For details, see "Change Layer Name".

Display palette colors in parent 

folder

When a palette color is specified for a layer, the specified color is also displayed for the parent 

folder. For details, see "Display palette colors in parent folder [PRO/EX]".

Display palette colors on canvas
When a palette color is specified for a layer, the canvas is filled with that palette color. For 

details, see "Display palette colors on canvas [PRO/EX]".

Advanced Settings

Opens the dialog box for correction if the correction layer is selected. For details on the dialog 

box, see "New Correction Layer [PRO/EX]". For [Fill in Monochrome Layer], the [Color set-

tings] dialog box is displayed.
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Selection from Layer
Allows you to create a selection from a drawing on the currently edited layer. You can also add or delete a selection to/from an already selected 

area. Furthermore, you can create a selection from the area overlapping an already selected area.

For details, see "Selection from Layer".

Rasterize
Converts the content of a layer other than [Raster] layer into [Raster] layer.

Thumbnail size
Allows you to select the size of the thumbnails to be displayed on the [Search Layer] palette from [None], [Smallest], [Small], [Medium], 

[Large] and [Largest].

Thumbnail display settings
Allows you to select the area to be displayed in the thumbnail on the [Search Layer] palette.

Create Selection Creates a selection from a drawing on the currently edited layer.

Add Selection
Creates a selection from a drawing on the currently edited layer and adds it to an already 

selected area.

Delete Selection
Creates a selection from a drawing on the currently edited layer and removes that portion 

from an already selected area.

Select Overlapping Area
Creates a selection from a drawing on the currently edited layer and creates another selection 

only from the area overlapping with an already selected area.

For Frame Border Folders, rasterization is performed by keeping the original Frame Border Folder. After rasteriza-

tion, frames within the original Frame Border Folder become hidden.

Show whole canvas Display the entire canvas in the thumbnail.

Show only layer area Display only the drawn area of the layer in the thumbnail.

Display transparent area Displays the transparent area of the layer in the thumbnail.

Thumbnail size: Smallest Thumbnail size: Small Thumbnail size: Middle Thumbnail size: Large
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Show property bar 
When turned on, displays the property bar of the [Search Layer] palette.

Show command bar 
When turned on, displays the command bar of the [Search Layer] palette.

Set command bar below list
When turned on, displays the command bar of the [Search Layer] palette below the [Layer list].

When turned off, displays the command bar of the [Search Layer] palette above the [Layer list].

Hide search layer palette
Hides the [Search Layer] palette.

To show the Search Layer palette again, select the palette from the [Window] menu > [Search Layer]. If you are 

using a Smartphone, tap the icon on the palette bar.

Show property bar: OFF Show property bar: ON

Property barPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPPP

Show command bar: OFF Show command bar: ON

Command bar

Set command bar below list: OFF Set command bar below list: ON

Command bar
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Search Layer Palette [PRO/EX] > Functions of Search Layer Palette > Search Layer Palette Menu
Show/hide layer Toggle Menu
Right clicking [Show/hide layer] on the [Search Layer] palette displays a menu that toggles the layer visibility.

The menu works in the same way as in the [Layer] palette. See "Show/hide layer Toggle Menu".

Right click
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Animation Cels palette
The Animation Cels palette is a palette for managing cels and images to be used as a reference for drawing.

The Animation Cels palette displays when the [Window] menu > [Animation Cels] is selected.

 About the Animation Cels Palette

 Functions of Animation Cels Palette

 Light Table Layer Operation



Animation Cels palette  > About the Animation Cels Palette
Animation Cels palette

 About the Animation Cels Palette
You can refer to other cels (layers) or image files while drawing animation cels. Set the cel to be drawn as the [Edited
cel], load the reference cels and register them to a [Light table specific to cel] or [Common light table for canvas].

Cels and images registered to a [Light table specific to cel] or [Common light table for canvas] are called light table lay-
ers.

Light table layers can be altered according to the content being drawn. You can move the layers, transform them or
change the layer color. Changes to light table layers are not applied to the original cel or image.

Editing layer

The cel to be referred to (light table layer)

Adjust the position and size of 

the light table layer.

Refer to the light table layer 

while drawing.
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Animation Cels palette  > Functions of Animation Cels Palette
 Functions of Animation Cels Palette
This chapter describes the functions of the Animation Cels palette.

A. Reset position of layers on light table
Resets moved or transformed light table layers to their original state.

B. Reverse layers horizontally on light table
Turns this on to reverse the selected light table layer horizontally.

C. Reverse layers vertically on light table
Turns this on to reverse the selected light table layer vertically.

D. Switch opacity target between All or Individual
Turn this on to apply the opacity setting to all light table layers.

Turn this off to apply the opacity setting only to the selected light table layers.

E. Opacity
Set the opacity of light table layers. Use [Switch opacity target between All or Individual] to set the target of the opacity setting.

Layers that were registered to the light table by selecting [Animation] menu > [Light table] > [Select file and regis-

ter to light table] are adjusted so that their center is aligned with the center of the output frame.

R
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Animation Cels palette  > Functions of Animation Cels Palette
F. Color mode
Clicking this displays a menu where you can set the color mode for light table layers.

G. Enable light table
Turn this on to display the light table layers on the canvas. Turn it off to hide the light table layers.

H. Fix current animation cel as editing target
Fixes a registered cel as the [Edited cel]. When this is set, the [Edited cel] on the Animation Cels palette does not change when another cel 

is selected on the Layer palette or Timeline palette.

I. Select previous cel
The operation for this item differs depending on the cel or layer that is selected.

J. Select next cel
The operation for this item differs depending on the cel or layer that is selected.

K. New animation cel
Click this to create a new cel. The [Edited cel] changes to the created cel.

As with [Animation] menu > [New animation cel], the cel is specified in the Timeline palette, allowing you to draw and edit the cel.

Color Colors of cels and layers are displayed as is.

Half color
The color set for [Change layer color] is combined with the cel and layer colors while maintain-

ing those colors.

Monochrome
The cel and layer colors are grayed. Black is changed to the color set for [Change layer color] and 

white is changed to the color set for [Change sub color].

Change layer color
The [Color settings] dialog box is displayed; here it is possible to set the display color of the layer 

color. The settings are applied when [Half color] or [Monochrome] is set for [Color mode].

Change sub color
The [Color settings] dialog box is displayed; here it is possible to set the display color of the sub 

color. The settings are reflected when [Monochrome] is set for [Color mode].

You can also set the color mode for light table layers in the Layer Property palette. For details on how to use, see 

"When a light table layer is selected".

The default color mode for light table layers can be set in [Preferences]. For details, see "Light table".

The [Edited cel] changes if [Select previous cel] or [Select next cel] is clicked.

Edited cel
If the timeline is enabled, the display switches to the cel before the [Edited cel] according to the 

display order of the timeline.

Light table layer
The displayed light table is changed according to the display order on the Layer palette. Clicking 

this displays the layer below. It also changes the light table layers linked to the edited cel.

Edited cel
If the timeline is enabled, the display switches to the cel after the [Edited cel] according to the dis-

play order of the timeline.

Light table layer
The displayed light table is changed according to the display order on the Layer palette. Clicking 

this displays the layer above. It also changes the light table layers linked to the edited cel.
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Animation Cels palette  > Functions of Animation Cels Palette
L. Select and register file
Register other image files as light table layers on the Animation Cels palette. File formats that can be registered are: Files in Clip Studio 

format (extension: clip), BMP, JPEG, PNG, TIFF, Targa, Adobe Photoshop Document (extension: psd) and Adobe Photoshop Big Docu-

ment (extension: psb).

Select this to display the dialog box for selecting a file. Select a file to register the image to the Animation Cels palette.

 If an [Edited cel] is set on the Animation Cels palette, the image is registered to the [Light table specific to cel].

 If an [Edited cel] is not set on the Animation Cels palette, the image is registered to the [Common light table for canvas].

M. Register selected layer
Register a layer selected on the Layer palette as a light table layer on the Animation Cels palette.

If an [Edited cel] is set on the Animation Cels palette and [Fix current cel as editing target] is turned on, the image is registered to the 

[Light table specific to cel].

If an [Edited cel] is not set on the Animation Cels palette, the image is registered to the [Common light table for canvas].

N. Deregister all images from light table/Deregister selected image from light table
If an [Edited cel] is selected on the Animation Cels palette, [Deregister all images from light table] is shown. This deregisters all light table 

layers from the Animation Cels palette.

If a specific light table layer is selected on the Animation Cels palette, [Deregister selected image from light table] is shown. This deregis-

ters the selected layer from the Animation Cels palette.

In either case, the original layer remains when the light table layer is removed from the Animation Cels palette.

O. Light table tool
Switches from the tool currently being used to the [Light table] tool. For details on the [Light table] tool, see Operation tool or Light table 

layer operations.

P. Display light table specific to cel
Toggles the visibility of the [Light table specific to cel] layer. Light table layers in a [Light table specific to cel] are displayed on the canvas 

even when they are hidden on the Animation Cels palette.

Q. Display common light table for canvas
Toggles the visibility of the [Common light table for canvas] layer. Light table layers in the [Common light table for canvas] are displayed 

on the canvas even when they are hidden on the Animation Cels palette.

R. Edited cel
The cel on which to perform edits such as drawing. The cel selected on the Layer palette is displayed.

If a layer folder is set as the cel, all cels in the layer folder are displayed.

Select another cel on the Layer palette to change the cel displayed as [Edited cel].

If the file has multiple layers (CLIP STUDIO FORMAT (extension: clip), Adobe Photoshop Document (extension: 

psd) or Adobe Photoshop Big Document (extension: psb)), the file will be registered to the Animation Cels palette 

as a flattened layer.

When light table layers are registered from another file, the other file is referred to in the same way as with file 

object layers. The only information recorded for file object layers is the location where the loaded file is saved. 

This means that if the location of the registered file or the location of the canvas is changed, the file location 

needs to be re-specified by selecting the light table layer using the [Object] tool.

If the layer contains a layer folder or layer mask, the folder or mask is merged in the version of the layer that is reg-

istered to the Animation Cels palette.

To register multiple layers at the same time, hold down the Ctrl while selecting layers on the Layer palette.

To register a single layer, turn on [Fix current cel as editing target] before registering the layer.
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Animation Cels palette  > Functions of Animation Cels Palette
S. Light table specific to cel
An area for registering reference images or cels (layers) to be used when drawing the [Edited cel].

Register reference cels (layers) by dragging and dropping them from the Layer palette to the [Light table specific to cel] on the Animation 

Cels palette.

The registered image is displayed on the canvas as a light table layer.

Layers registered to the [Light table specific to cel] are linked to the cel set as the [Edited cel]. Switching the [Edited cel] also changes the 

[Light table specific to cel].

If [Half color] is set for [Color mode] for light table layers, the [Layer color] is displayed as an icon. If [Monochrome] is set for [Color 

mode] for light table layers, the [Layer color] and [Sub color] are displayed as an icon.

T. Common light table for canvas
An area for registering reference images or cels (layers) to be used when drawing all cels on the canvas.

Register reference cels (layers) by dragging and dropping them from the Layer palette to the [Common light table for canvas] on the Ani-

mation Cels palette.

The registered image is displayed on the canvas as a light table layer.

The content of the [Common light table for canvas] does not change when the [Edited cel] is changed.

If [Half color] is set for [Color mode] for light table layers, the [Layer color] is displayed as an icon. If the color mode of a light table layer 

is set to [Monochrome], the [Layer color] and [Sub color] are displayed as an icon.

[Select layer], [Show/hide layer] and the like work in the same way as in the Layer palette. For details on how to 

use, see "Functions of Layer Palette".

Dragging vertically while pressing the Space bar enables you to scroll through the edited cel.

The size and position of light table layers can be changed. For how to edit, see "Light Table Layer Operation". 

Changes made to light table layers are not applied to the original layers.

Dragging vertically while pressing the Space bar enables you to scroll through the light table specific to the cel.

The size and position of light table layers can be changed. For how to edit, see "Light Table Layer Operation". 

Changes made to light table layers are not applied to the original layers.

Dragging vertically while pressing the space bar enables you to scroll through the common light table for the can-

vas.
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Animation Cels palette > Functions of Animation Cels Palette > Animation Cels Palette Menu
Animation Cels Palette Menu
The following describes the functions included in the menu that appears when you click [Palette menu] on the upper left corner of the Anima-

tion Cels palette.

New animation cel
Click this to create a new cel. The [Edited cel] changes to the created cel.

As with [Animation] menu > [New animation cel], the cel is specified in the Timeline palette, allowing you to draw and edit the cel.

Select previous cel
The operation for this item differs depending on the cel or layer that is selected.

Select next cel
The operation for this item differs depending on the cel or layer that is selected.

New Raster Layer
Creates a new raster layer above the selected layer.

For details, see "New Raster Layer".

New Layer
Creates a new layer above the selected layer.

For details, see "New Layer".

New Correction Layer [PRO/EX]
Creates a correction layer above the selected layer. This layer allows you to adjust the brightness, hue, saturation, luminosity, gradient and the 

like of the layers below.

For details, see "New Correction Layer [PRO/EX]".

New Layer Folder
Creates a new layer folder.

For details, see "New Layer Folder".

Create folder and insert layer
Creates a new layer folder and places the layer selected on the Search Layer palette in the folder.

Ungroup Layer Folder
Deletes the selected layer folder. When a layer folder is deleted the layers inside the folder will remain.

For details, see "Ungroup Layer Folder".

Edited cel
If the timeline is enabled, the display switches to the cel before the [Edited cel] according to the 

display order of the timeline.

Light table layer
The displayed light table is changed according to the display order on the Layer palette. Clicking 

this displays the layer below. It also changes the light table layers linked to the edited cel.

Edited cel
If the timeline is enabled, the display switches to the cel after the [Edited cel] according to the dis-

play order of the timeline.

Light table layer
The displayed light table is changed according to the display order on the Layer palette. Clicking 

this displays the layer above. It also changes the light table layers linked to the edited cel.
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Animation Cels palette > Functions of Animation Cels Palette > Animation Cels Palette Menu
Duplicate Layer
Makes a copy of the selected layer or layer folder.

For details, see "Duplicate Layer".

Delete Layer
Deletes the selected layer or layer folder.

Layer mask
Creates a mask for the selected layer or layer folder. Masks can be deleted as well as configured.

For details, see "Layer Mask".

Ruler/Frame [PRO/EX]
Allows you to delete and display rulers, create perspective rulers, and so on. It also allows you to configure whether to move the ruler along 

with the drawing area of the layer being edited, or separately.

For details, see "Ruler/Frame [PRO/EX]".

File object[PRO/EX]
Allows you to perform operations related to file object layers. File object layers are layers used to load files such as videos and images into Clip 

Studio Paint.

For details, see "File object".

Layer settings
Allows you to configure settings related to layers such as reference layer, clipping, layer lock, transparent pixel lock, and so on.

For details, see "Layer settings".

Selection from Layer
Allows you to create a selection from a drawing on the currently edited layer. You can also add or delete a selection to/from an already selected 

area. Furthermore, you can create a selection from the area overlapping an already selected area.

For details, see "Selection from Layer".

Rasterize
Converts the content of a layer other than [Raster] layer into [Raster] layer.

Convert layer [PRO/EX]
Converts the type of the layer selected on the Layer palette. You can change the type and expression color of a layer, as well as convert a draw-

ing inside a selected area into an image material layer.

For details, see "Convert layer [PRO/EX]".

When a layer folder is selected, also the layers stored in the folder are deleted.
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Animation Cels palette > Functions of Animation Cels Palette > Animation Cels Palette Menu
LT conversion of layer
Allows you to separate a selected layer into outlines (line drawings) and tones and convert each of them into different layers.

For details, see "LT conversion of layer [EX]".

Transfer To Lower Layer
Transfers the image on a selected layer to the layer immediately below.

For details, see "Transfer To Lower Layer".

Merge with layer below
Combines a selected layer with that immediately below to make one.

For details, see "Merge with layer below".

Merge selected layers
Combines selected layers to make one. This is used to join images drawn separately, for example.

For details, see "Merge selected layers".

Thumbnail size
Allows you to select the size of the thumbnails to be displayed on the Search Layer palette from [None], [Smallest], [Small], [Medium], 

[Large] and [Largest].

Thumbnail display settings
Allows you to select the area to be displayed in the thumbnail on the Animation Cels palette.

Show property bar
When turned on, displays the property bar of the Animation Cels palette.

Show whole canvas Display the entire canvas in the thumbnail.

Show only layer area Display only the drawn area of the layer in the thumbnail.

Display transparent area Displays the transparent area of the layer in the thumbnail.

Thumbnail size: Smallest Thumbnail size: Small Thumbnail size: Middle Thumbnail size: Large

Property bar

Show property bar: Off Show property bar: On
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Animation Cels palette > Functions of Animation Cels Palette > Animation Cels Palette Menu
Show command bar 
When turned on, displays the command bar of the Animation Cels palette.

Set command bar below list
When turned on, displays the command bar of the Animation Cels palette below the [Common light table for canvas].

When turned off, displays the command bar of the Animation Cels palette above the [Edited cel].

Hide animation cel palette
Hides the Animation Cels palette.

To show the Animation Cels palette again, select the palette from the [Window] menu. If you are using a Smart-

phone, tap the icon on the palette bar.

Command Bar

Show command bar: Off Show command bar: On

Set command bar below list: Off Set command bar below list: On

Command bar
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Animation Cels palette > Light Table Layer Operation > Register cel to light table
 Light Table Layer Operation
This chapter describes how to operate the Animation Cels palette and light table layers. Light table layers can be con-
figured using the [Light table] tool and Tool Property palette in addition to the Animation Cels palette.

Register cel to light table
Register a cel or layer to be used as a drawing reference to the Animation Cels palette.

Drag and drop a reference cel or layer by dragging and dropping it from the Layer palette to the [Light table specific to cel] or [Common light 

table for canvas] on the Animation Cels palette.

It is registered as a light table layer on the Animation Cels palette.

Cels registered to the light table cannot be deleted from the Layer palette. Deregister the cels from the Animation 

Cels palette before deleting them. For information on how to deregister, see "Deleting a light table layer".

If the layer contains a layer folder or layer mask, the folder or mask is merged in the version of the layer that is reg-

istered to the Animation Cels palette.

If the [Edited cel] changes when dragging and dropping a cel, this issue can be resolved by turning on [Fix current 

animation cel as editing target] on the Animation Cels palette before selecting the reference cell. Turn off [Fix cur-

rent animation cel as editing target] before drawing another cel.

You can also register cels to the light table by clicking [Register selected layer] on the Animation Cels palette. For 

details, see "Functions of Animation Cels Palette".

Click [Select and register file] on the Animation Cels palette to register another image file to the light table. For 

details, see "Functions of Animation Cels Palette".

The default color mode for light table layers can be set in [Preferences]. For details, see "Light table".

Drag & drop
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Animation Cels palette > Light Table Layer Operation > Change the order of light table layers
Change the order of light table layers
Select the light table layer to be moved, then drag and drop it to the desired location.

Light table layers can also be moved between a [Light table specific to cel] and the [Common light table for canvas].

Setting a color mode for light table layers
You can set the color mode of the light table layers registered in the Animation Cels palette. Set the layer color so that content drawn on light 

table layers can be seen easily

1 Select the cel
Select the light table layer that you want to change the color mode for from the [Light table specific to cel] on the Animation Cels palette.

When using a Tablet/Smartphone, use your finger or a pen to drag and drop with the grip on the right side of the 

light table layer.

Light table layers in the [Light table specific to cel] cannot be moved to the [Common light table for canvas] if they 

are the same as the [Edited cel].

Drag
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Animation Cels palette > Light Table Layer Operation > Setting a color mode for light table layers
2 Set color mode
It is possible to set a color mode for light table layers.

(1) Click [Color mode] and select a mode from [Color], [Half color] and [Monochrome].

(2) The selected color mode is applied to the light table layer.

3 Configuring the layer color
If [Half color] or [Monochrome] is set as the color mode, a layer color can be set.

(1) Click [Color mode], select [Change layer color] and select the color to be set as the layer color from the [Color settings] dialog box.

(2) The selected layer color is applied to the light table layer.

(3) Adjust [Opacity] as necessary.

If [Monochrome] is set as the color mode, a sub color can be set from [Change sub color].

Color modes can be set either in the Layer Property palette or in the selected light table layer.

For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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Animation Cels palette > Light Table Layer Operation > Using the light table tool
Using the light table tool
The [Light table] tool can be used to move or transform light table layers. Change them according to the content being drawn.

1 Select the cel
Select the light table layer to be adjusted from the [Light table specific to cel] on the Animation Cels palette. The tool selection changes to 

the [Light table] tool automatically.

2 Adjusting a layer with the light table tool
Handles are displayed around the selected layer. Drag a handle to adjust the size or angle.

Changes to light table layers are not applied to the original cel or image.

The tool can also be changed by selecting the [Operation] tool on the Tool palette and then selecting the [Light 

table] tool on the Sub Tool palette.
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Animation Cels palette > Light Table Layer Operation > Reset changes
Scaling a light table layer up/down
Drag a green handle to scale the light table layer up or down.

Rotating a light table layer
Drag the round blue handle to rotate the light table layer.

Moving a light table layer
Drag one of the perimeter lines of the light table to move the light table layer in the dragged direction.

Reversing light table layers vertically or horizontally
[Flip Vertical] or [Flip Horizontal] can be set for light table layers by using the Tool Property palette when the [Light table] tool is selected.

 Click [Flip Vertical] on the Tool Property palette to reverse the light table layer vertically.

 Click [Flip Horizontal] on the Tool Property palette to reverse the light table layer horizontally.

Reset changes
Resets moved or transformed light table layers to their original state. Select the light table layer to be reset on the Animation Cels palette and 

click [Reset position of layers on light table].

Set [Drag] to [Rotate] on the Tool Property palette when the [Light table] tool is selected to rotate light table layers 

by dragging the canvas.

Set [Center of rotation] or [Click] on the Tool Property palette when the [Light table] tool is selected to change the 

position of the rotation center.

Hold down Shift and drag the rotation center point while the [Light table] tool is selected to move it vertically, hor-

izontally or along a 45-degree diagonal angle.

Set [Drag] to [Move] on the Tool Property palette when the [Light table] tool is selected to rotate light table layers 

by moving the canvas.

Set [Center of rotation] or [Click] on the Tool Property palette when the [Light table] tool is selected to change the 

center of inversion.

Light table layers can also be reversed by using [Flip Vertical] and [Flip Horizontal] on the Animation Cels palette.

For details on the Tool Property or Sub Tool Detail palettes when the [Light table] tool is selected, see the Clip Stu-

dio Paint Tool Setting Guide.
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Animation Cels palette > Light Table Layer Operation > Move canvas to center
Move canvas to center
The position and angle of the canvas can be adjusted based on the light table layers displayed on the canvas. This section explains how to do 

this when the light table layers are registered and arranged as shown below.

1  Select the command
Select [Animation] menu > [Light table] > [Move canvas to center].

2 Configure the dialog box
The [Move canvas to center] dialog appears.

(1) Drag the slider in the [Move canvas to center] dialog to adjust the position or angle of the canvas.

(2) Click [OK].

[Move canvas to center] can be used when two light table layers are registered to the [Light table specific to cel] 

on the Animation Cels palette, or when two light table layers are selected.

The names of the light table layers are displayed on either side of the [Move canvas to center] slider. Drag the 

slider toward the light table layer toward which you want to move the canvas.

Set the slider of the [Move canvas to center] dialog to "50" to place the canvas in the exact center between the 

light table layers.

The canvas moves.
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Animation Cels palette > Light Table Layer Operation > Deleting a light table layer
Deleting a light table layer
Delete light table layers registered to the [Light table specific to cel] or [Common light table for canvas] on the Animation Cels palette.

The original cels remain when light table layers are deleted.

Deleting a specific light table layer
Select the light table layer to be deleted from the Animation Cels palette and click [Deregister selected image from light table].

The selected light table layer is deleted from the Animation Cels palette.

Deleting all light table layers
If an [Edited cel] is selected on the Animation Cels palette, click [Deregister all images from light table].

All light table layers are deleted from the Animation Cels palette.

Light table layers can also be deleted by selecting [Animation] menu > [Light table] > [Deregister selected image 

from light table].

Only the light table layers linked to the selected [Edited cel] are deleted. However, if any of these light table layers 

are in the [Common light table for canvas], they are deleted from all editing cels.

All light table layers can also be deleted by selecting [Animation] menu > [Light table] > [Deregister all images 

from light table].
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Timeline palette
The Timeline palette is a palette for specifying the timing and combinations for displaying cels, using a time-

line.

The Timeline palette is displayed when [Window] menu > [Timeline] is selected.

 Functions of Timeline Palette

 Operating the Timeline Palette



Timeline palette > Functions of Timeline Palette > Timeline palette functions (Default)
Timeline palette

 Functions of Timeline Palette
This section describes the functions of the Timeline palette. The next editing screens are located in the Timeline pal-
ette.

 "Timeline palette functions (Default)"

 "Graph Editor"

Timeline palette functions (Default)
This section describes the functions of the Timeline palette.

A. Graph Editor
This switches from the Timeline palette to the Graph Editor. For details on the Graph Editor, see "Graph Editor".

B. Edit timeline
This button selects the [Edit timeline] tool. Frames in the timeline can be moved using the mouse on the canvas.

For details on the [Edit timeline] tool, see "Operating the timeline editing tools".

C. New timeline
This button displays the [New timeline] dialog box. It can be used to create a new timeline on the canvas.

For details on the [New timeline] dialog box, see "New timeline".

When importing timelines edited in Clip Studio ACTION, the following cannot be edited in Clip Studio Paint.

 Subtitle tracks

 Paper layers with opacity

Clip Studio Paint files from Ver.1.8.4 and later cannot be loaded in Clip Studio ACTION.

When using the Smartphone version, some of the buttons at the top of the Timeline palette are hidden. Swipe to 

the left and right of the buttons to display the hidden buttons.
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Timeline palette > Functions of Timeline Palette > Timeline palette functions (Default)
D. Zoom out
This button allows frames to be displayed in the Timeline palette in a smaller size.

E. Zoom in
This button allows frames to be displayed in the Timeline palette in a larger size.

F. Go to start
This button selects the first frame in the Timeline palette.

G. Go to previous frame
This button selects the previous frame of the current frame in the Timeline palette.

H. Play/Stop
This button plays or stops animation on the canvas.

I. Go to next frame
This button selects the next frame of the current frame in the Timeline palette.

J. Go to end
This button selects the last frame in the Timeline palette.

K. Loop play
This button enables loop play. When playing animation, playback will return to the first frame after reaching the last frame.

L. New animation folder
This button creates a new animation folder (track) above the selected track.

M. New animation cel
This button designates a new animation cel to the selected frame on the Timeline palette. At the same time, the new cel will be added to the 

animation folder on the Layer palette.

 When using a touch display with Windows 8 or later, frames can be displayed in the Timeline palette in a 

smaller size by pinching.

 Dragging to the left on the timeline while holding Ctrl + Space enables you to scale down the frame in the 

Timeline palette.

 When using a touch display with Windows 8 or later, frames can be displayed in the Timeline palette in a larger 

size by pinching.

 Dragging to the right on the timeline while holding Ctrl + Space enables you to scale up the frame in the Time-

line palette.

 Animation playback can also be stopped by pressing the Esc key or clicking a palette other than the Timeline 

palette during playback.

 When an animation is played, played frames will be cached. This allows the animation to buffer more quickly 

the next time it is played. However, the previous playback cache is discarded when the canvas or Timeline pal-

ette is edited.

Animation folders are folders for storing cels (layers). For details, see "Explanation: Animation folders and cels".
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Timeline palette > Functions of Timeline Palette > Timeline palette functions (Default)
N. Specifying cels
This button designates cels to frames by displaying the [Select layer] dialog of the current frame when clicked.

For details on the [Select layer] dialog, see "Specify cels".

O. Delete cel designation
Cel specification can be deleted by selecting a specified cel and clicking [Delete cel specification]. 

P. Enable onion skin
Onion skin is a function in which specified cels surrounding the selected cel are displayed on the canvas in addition to the selected cel.

This button turns the onion skin on and off. Click it again to disable the onion skin display.

Q. Add keyframe
This button adds a keyframe to the frame selected in the Timeline palette.

R. Keyframe interpolation
This button sets the keyframe interpolation method of new keyframes.

S. Delete keyframe
Deletes the selected keyframe from the Timeline palette.

T. Enable keyframes on this layer
This button enables/disables keyframe editing of the selected track.

For details on animation folders and cels (layers), see "Explanation: Animation folders and cels".

Deleting specified cels from the Timeline will not affect cels in the Layer palette.

The onion skin display color and number of cels to be displayed can be set in the [Onion skin settings] dialog box. 

For details, see "Onion skin settings".

 For details on adding keyframes, see "Keyframe settings".

 For details on how to use keyframes, see "Key frame operation".

Hold
When Hold is selected, keyframe values are maintained from one keyframe to the next. The values are 

replaced when the next keyframe begins.

Linear The settings of the selected keyframe will be carried to the following keyframe at a fixed speed.

Smooth
The speed will gradually increase after the selected keyframe and then slow down just before the next 

keyframe.

To change the keyframe interpolation after adding a keyframe, see "Changing the keyframe interpolation". 

 For details on adding keyframes, see "Keyframe settings".

 For details on how to use keyframes, see "Key frame operation".
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U. Edit layers with active keyframes
You can temporarily draw or make edits with a brush or pen on a track that has [Enable keyframes on this layer] turned on.

When on, the selected layer’s transformations will be disabled, leaving only the selected layer and paper layer. All other layers will be dis-

played as semi-transparent.

Selecting a different layer cancels the setting automatically and restores the layer display.

V. Current frame/Start frame/End frame
Display the positions of the currently selected frame, the start frame and the end frame.

W. Timeline list
The name of the timeline being edited is displayed.

When using files with multiple timelines, clicking a timeline from the displayed menu will switch the current editing target.

X. Number of frames
This displays frame information. In PRO and EX, the frames are displayed differently depending on the frame display method selected in 

[Playback time] in the [New] dialog box.

For details on how to use keyframes, see "Key frame operation".

 In PRO and EX, the frames are displayed differently depending on the frame display method selected in [Play-

back time] in the [New] dialog box or the [New timeline] dialog box.

 The frame display method can be changed in [How to show frames] in the [Canvas Properties] dialog box. For 

details, see "Canvas Properties [PRO/EX]".

 For details on [Playback time], see "New dialog box (Animation) [PRO/EX]".

 The frame display method can be changed in [How to show frames] in the [Canvas Properties] dialog box. For 

details, see "Canvas Properties [PRO/EX]".

 Drag horizontally while holding down the space bar to scroll horizontally through the timeline.

 Drag horizontally while holding down the Ctrl + Space keys to extend or shrink the frame in the Timeline pal-

ette.
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Y. Tracks and Timelines
The track area displays the layer names and the animation timeline. Cels can be specified and clips can be edited in the timeline of each 

track. The background color of the timeline changes every second.

(1) Show/Hide Track

This button displays/hides a track.

(2) Track details

This shows an area for editing the specified cels, keyframes, and track labels. Displayed settings will differ according to the track (layer) 

type and settings.

Tracks are linked to the layer structure in the Layer palette. Tracks will be created for layer folders, layers, audio layers, and camera work.

Dragging within the timeline while holding down the space bar enables you to scroll through the timeline.
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(1) Track Icon
This icon indicates the layer type. If it is a layer folder, you can open and close the folder and 

show the layer types by clicking to the left of the track icon.

(2) Details
Click this icon to display the track label area. Turning on [Enable keyframes on this layer] adds a 

keyframe editing area to the track.

(3) Track name
This area displays the track name. The settings you can edit change according to the track layer 

type and settings.

(4) Transform area

This area displays the keyframes of layer transformations. Turning on [Enable keyframes on this 

layer] switches to the transformation area. An arrow icon is added to the left of the track name. 

You can open the drop-down arrow to show the keyframes for the position, scale ratio, rotation, 

and center of rotation.

(5) Mask area

This area displays the keyframes of a mask’s transformation. Clicking [Detail] on layers set with a 

layer mask or animation folders will display it. Turning on [Enable keyframes on this layer] 

switches the track name area with the transformation area. An arrow icon is added to the left of 

the track name to show transformations of the layer mask. You can open the drop-down arrow to 

show the keyframes for the position, scale ratio, rotation, and center of rotation.

If [Enable keyframes on this layer] is turned off, it will not be displayed. 

(6) Cel specification area
This is an area to specify cels. If [Enable keyframes on this layer] is turned off, the track name 

area will be the cel specification area. It will also be displayed in the animation folder.

(7) Opacity area
This area displays the keyframes of a layer’s opacity. Click on [Detail] on a track that has [Enable 

keyframes on this layer] turned on to display it.

(8) Track label area
This area displays track labels. Here you can edit and view track labels of a frame. For details on 

how to create and edit a label, see "Label operations".

(9) Volume Area
This area displays the keyframes of an audio file’s volume. The keyframes will be displayed on 

the audio track.

Track names on the Timeline palette have the same structure as on the Layer palette, except that cels in animation 

folders are not displayed. These cels can be displayed specifying the cels in the timeline of each track.
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(3) Thumbnail list

These are the thumbnail images of a cell or layer. Thumbnails for all of the cells are displayed for the animation folder. Clicking the 

thumbnail, selects the frame that the cell specifies, other that the clicked cel.

(4) Starting frame

This lets you set the first frame for animation playback.

Dragging the blue square allows you to adjust the [Start frame] position.

(5) Current frame

The position of the currently selected frame is indicated by red lines.

Click the frame number to select the corresponding frame and change the frame position.

(6) End frame

This lets you set the end frame for animation playback.

Dragging the blue square allows you to adjust the [End frame] position.

 You can set whether to show or hide the timeline thumbnails by selecting [Show Menu] > [Thumbnail Size] in 

the Timeline palette. From [Thumbnail size] it is possible to set whether to show or hide thumbnails, or change 

the thumbnail size. Changed thumbnail display settings will be applied to the thumbnails of each clip.

 To select multiple cels, click the thumbnails while holding down Ctrl or Shift.

 Double clicking the cel name below the thumbnail allows you to change the cel name.

 When a [Palette color] is set in the Layer palette, the palette color is displayed as the cel name.

 Turning on [Layer] menu > [Layer Settings] > [Display palette colors on canvas] enables the [Palette color] to 

be reflected in the thumbnails.

 Dragging horizontally while holding down the space bar enables you to scroll through the thumbnail list for 

each track.

The [Start frame] position cannot be moved to a frame earlier than 0 in DEBUT or PRO.

Click inside the timeline to select a frame, as well as its cel specification, clip and keyframe.

The [End frame] position cannot be moved to a frame later than 24 in DEBUT or PRO.

Drag        to change the start frame of the timeline.

Drag       to change the end frame of the timeline.
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(7) Clip

Clips are units used when editing animated sequences.

For details on how to edit clips, see "Clip operations".

For details on how to specify and edit cels, see "Cel specification operations".

For details on how to specify and edit keyframes, see "Key frame operation".

(8) Clip Thumbnails

These are thumbnails of cels specified for clips.

(9) Specify cel

Indicates the position in which to display cels in an animation folder. When a cel display position is specified, the cel name is displayed in 

the timeline.

(10)Timeline label

This is the label in which instructions, etc. can be written for a specific frame in the timeline.

For details on how to create and edit labels, see "Label".

(11) Track label

This is the label in which instructions, etc. can be written for a specific track.

For details on how to create and edit a label, see "Label operations".

(12)Keyframe

Keyframes record the following settings of each track on the Timeline palette.

 Layer folder/layer transformation and opacity

 Audio layer volume

 Keyframe interpolation

A keyframe’s color varies depending on its [Keyframe interpolation] settings.

(13)Grip [Tablet/Smartphone]

This is used when changing the order of tracks on the Tablet/Smartphone.

Move a finger or pen over the grip and drag up and down to change the track stacking order. When multiple tracks are selected, all selected 

tracks are subject to changes of the stacking order.

You can set whether to show or hide the clip thumbnails by selecting [Show Menu] > [Thumbnail Size] in the Time-

line palette. From [Thumbnail size] it is possible to set whether to show or hide thumbnails, and change the 

thumbnail size.

When the thumbnail display settings are changed, the new settings are also applied to thumbnails in the thumb-

nail list.

Hold Linear Smooth
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Timeline palette menu
This section describes the functions included in the menu that is displayed when you click the [Palette menu] on the upper left corner of the 

Timeline palette.

Show split view
Splits the Timeline palette into two views.
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For canvases with multiple timelines, a different timeline can be displayed in each view.

Thumbnail display settings can also be changed for each view.
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New animation layer
This creates a new animation related layer or folder.

New animation cel
Creates a new cel in an animation folder.

If a cel is created while the Timeline palette is enabled, the cel will be specified to the current frame.

To execute this item, select an animation folder on the Layer palette or Timeline palette.

Edit track
Operations related to specifying cels, clips, and keyframes are performed from the Timeline palette.

Animation folder

Creates a new animation folder on the Layer and Timeline palettes. Animation folders are folders for 

storing animation cels (layers). Layers and layer folders created in an animation folder can be used as 

cels.

2D camera folder

This creates a 2D camera folder on the Layer palette and the Timeline palette. Using a 2D camera 

folder, camera movement can be added to an animation without transforming the animation folder or 

the layers’ images.

Audio
Creates a new audio layer (audio track) on the Layer palette and the Timeline palette. An audio layer is 

a layer for editing an audio file on the Timeline palette.

Delete This deletes the specified cel, clip, or keyframe currently selected in the Timeline palette.

Cut
Cut and store a selected cel specification, clip or keyframe from the Timeline palette on the 

clipboard.

Copy
Store a selected cel specification, clip or keyframe from the Timeline palette on the clipboard. 

The cel will remain on the Timeline palette.

Paste
Pastes the selected cel specification, clip or keyframe stored on the clipboard onto the Time-

line palette For details, see  "Paste".

Enable keyframes on this layer
Enables/disables editing with keyframes on the selected layer or track. For details, see 

"Enable keyframe editing".

Add keyframe This adds a keyframe to the selected frame on the Timeline palette.

Switch keyframe to hold interpola-

tion
This changes the interpolation method of the selected keyframe to [Hold].

Switch keyframe to linear interpola-

tion
This changes the interpolation method of the selected keyframe to [Linear].

Switch keyframe to smooth interpo-

lation
This changes the interpolation method of the selected keyframe to [Smooth].

Edit layers with active keyframes
This allows you to temporarily draw or make edits with a brush or pen on a layer (track) that 

has [Enable keyframes on this layer] turned on.

Delete all keyframes This deletes all keyframes from the selected track in the Timeline palette.

Specify cels
This specifies a cel for the frame selected in the Timeline palette. For details, see  "Specify 

cels".

Batch specify cels
This allows you to batch specify cels in the Timeline palette from the selected frame onward. 

For details, see  "Batch specify cels".
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Graph Editor
This switches from the Timeline palette to the Graph Editor.

Play/Stop
Plays or stops animation on the canvas.

Create all supported cels

This allows cels that are specified in the Timeline palette but have not been created in the 

Layer palette to be created together. They are created in all animation folders included in the 

timeline.

Rename in timeline order
This renumbers the names of the cels in the selected animation folder in the order displayed 

on the Timeline palette. For details, see  "Rename in timeline order".

Rename in layer order
This renumbers the names of the cels in the selected animation folder according to the stack-

ing order in the Layer palette. For details, see  "Rename in layer order".

Select previous cel

If the timeline is enabled, this selects the cel before the frame currently selected in the Time-

line palette. The operation for this item differs depending on the canvas specification or the 

cel or layer that is selected. For details, see  "Select previous cel".

Select next cel

If the timeline is enabled, this selects the cel after the frame currently selected in the Timeline 

palette. Operation for this item differs depending on canvas specification or the cel or layer 

that is selected. For details, see  "Select next cel".

Combine clips
This allows you to select multiple consecutive clips in the same track on the Timeline palette 

and join them together.

Divide clip This splits the clip at the frame selected on the Timeline palette.

Set as first displayed frame
This allows the start position of a clip to be set according to the frames on the Timeline pal-

ette.

Set as last displayed frame The end position of a clip can be set according to the frames on the Timeline palette.
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Playback settings
Set the playback method for playing animation.

Move frame
Operate the frames in the Timeline palette using commands.

Play in real time This plays the animation according to the frame rate.

Play all frames This plays all frames when playing the animation.

Loop play
This button enables loop play. When playing animation, playback will return to the first frame 

after reaching the last frame.

Render 2D camera
When active, the camera movement set in the 2D camera folder track is reflected when the ani-

mation is played.

Render before starting playback

Turn this on to render the playback range of the animation before playing the animation. This 

avoids issues where playback is delayed due to the time taken to load the animation. However, 

rendering before playing the animation means that it may be a while before playback starts.

Prefer speed

When the canvas has a high resolution, the resolution is automatically reduced when playing 

the animation to improve the playback speed. A cache is created with images at a size near the 

scale of the canvas when playing the animation. When the scale is changed during playback, the 

cache is discarded according to the scale.

Prefer quality

When the canvas has a high resolution, the resolution is automatically reduced when playing 

the animation to improve the playback speed. A cache is created with images at a size near the 

scale of the canvas when playing the animation. The cache is not discarded when the scale is 

changed during playback.

Go to start Go to start selects the first frame in the Timeline palette.

Go to end Go to end selects the last frame in the Timeline palette.

Go to previous frame Got to previous frame selects the frame before a selected frame in the Timeline palette.

Go to next frame This button selects the next frame of the current frame in the Timeline palette.

Previous keyframe Selects the keyframe before the currently selected frame on the [Timeline].

Next keyframe Selects the keyframe after the currently selected frame on the [Timeline].

Go to specified frame

Go to specified frame selects the frame corresponding to the specified number in the Timeline 

palette. Selecting this command displays the [Go to specified frame] dialog box. Enter the 

frame to be selected in [Frame number] and click [OK]. The frame entered in [Frame number] 

is selected in the Timeline palette.

Go to timeline label
Specify the name of a timeline label and go to the frame containing that timeline label. For 

details, see  "Go to timeline label".
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Label
Set labels on the Timeline palette. Created labels can be used as markers when editing.

Timeline
Multiple timelines can be created and managed for one canvas. You can perform timeline management operations such as creating additional 

timelines and switching timelines.

Create timeline label
This creates a timeline label in the specified frame on the Timeline palette. For details, see  

"Create timeline label".

Delete timeline label This deletes a timeline label from the Timeline palette. For details, see  "Delete timeline label".

Create track label
Creates a track label in a frame in the specified track on the Timeline palette. For details, see  

"Create track label".

Delete track label

This deletes a track label from the Timeline palette. Inbetween track labels and reverse sheet 

track labels can be deleted in addition to standard track labels. For details, see  "Delete track 

label".

Create inbetween track label
This adds a track label specifying an inbetween point on a frame in the specified track on the 

Timeline palette.

Create reverse sheet track label
This adds a track label specifying a reverse sheet in between point in a frame in the specified 

track on the Timeline palette.

Enable timeline Enables or disables the timeline for the canvas. For details, see "Enable timeline".

New timeline
New timeline displays the [New timeline] dialog box. It can be used to create a new timeline on 

the canvas. For details, see  "New timeline".

Go to previous timeline Switches the editing target to the previous timeline if there are multiple timelines.

Go to next timeline Switches the editing target to the next timeline if there are multiple timelines.

Change settings This changes various settings for the timeline being edited. For details, see  "Change settings".

Change frame rate
Change frame rate allows you to change the frame rate (number of frames per second) set when 

creating the canvas.

Manage timeline This allows you to manage timelines in the file. For details, see  "Manage timeline".

Insert frame You can also insert frames using the Timeline palette. For details, see  "Insert frame".

Delete frame Deletes the selected frame from the Timeline palette. For details, see  "Delete frame".

Apply Toei Animation Digital 

Exposure Sheet information to cur-

rent exposure sheet [EX] [Win-

dows/iPad]

You can open the Toei Animation Digital Exposure Sheet and use the vertical exposure sheet to 

edit the contents of the [Timeline] palette. For details, see "Apply Toei Animation Digital Expo-

sure Sheet information to current exposure sheet [EX] [Windows/iPad]".

Load changes to Toei Animation 

Digital Exposure Sheet [EX] [Win-

dows/iPad] 

Load the changes made to the Toei Animation Digital Exposure Sheet to Clip Studio Paint. For 

details, see "Load changes to Toei Animation Digital Exposure Sheet [EX] [Windows]".

Toei Animation Digital Exposure 

Sheet settings [EX] [Windows]

You can set up the installation path for the Toei Animation Digital Exposure Sheet. For details, 

see "Toei Animation Digital Exposure Sheet settings [EX] [Windows]".

Toei Animation Digital Exposure 

Sheet Path [EX][iPad]

It is possible to link Toei Animation Digital Exposure Sheet settings with Clip Studio Paint. For 

details, see "Toei Animation Digital Exposure Sheet Path [EX][iPad]".
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Show animation cels
Configure settings for displaying animation cels.

Light table
Light table allows you to configure the settings of the Animation Cels palette and light table layers registered to the Animation Cels palette.

Show 2D camera frames
When active, a camera frame for the 2D camera folder set in the frame selected in the Timeline palette is displayed. For details, see "Show 2D 

camera frames".

Show edited cel only Turn this on to display only the cel selected for editing from the animation folder.

Enable onion skin
Onion skin is a function in which previous and consecutive cels are layered over the current cel. 

Turn this on to display the onion skin on the canvas. For details, see  "Enable onion skin".

Onion skin settings

Selecting this item displays the [Onion skin settings] dialog. This allows you to configure onion 

skin settings such as the number of displayed cels and the display color. For details, see  "Onion 

skin settings".

Check cel motion by key input
Allows you to check cel motion with key operations. For details, see  "Check cel motion by key 

input".

Check surrounding cels by key 

input

Allows you to check cel motion with key operations. For details, see  "Check cel motion by key 

input".

For details on the Animation Cels palette and light table layers, see "About the Animation Cels Palette" and "Func-

tions of Animation Cels Palette".

Enable light table
Turn this on to display the light table layers on the canvas. Turn it off to hide the light table lay-

ers.

Fix current animation cel as editing 

target

This fixes a registered cel as the [Edited cel]. When this is set, the [Edited cel] does not change 

when another cel is selected on the Layer palette or Timeline palette.

Register selected layer
Register a layer selected on the Layer palette as a light table layer on the Animation Cels pal-

ette.

Select and register file
Register other image files to the light table on the Animation Cels palette. For details, see  

"Select and register file".

Register layer copied from another 

canvas

This pastes a layer copied from another canvas to the light table on the Animation Cels palette. 

If the selected layer is a light table layer from a [Light table specific to cel], it is registered to the 

[Light table specific to cel]. Otherwise, it is registered to the [Common light table for canvas].

Register onion skin images

If onion skin is enabled, the surrounding cels displayed as onion skin are registered to the [Light 

table specific to cel] on the Animation Cels palette. The onion skin layer color of the registered 

cels (light table layers) is kept, but the opacity is not.

Deregister selected image from 

light table
This deregisters the selected light table layer from the Animation Cels palette.

Deregister all images from light 

table
This deregisters all light table layers shown on the Animation Cels palette.

Move canvas to center

Selecting this item displays the [Move canvas to center] dialog. Drag the slider to adjust the 

position and angle of the canvas based on the light table layers displayed on the canvas. For 

details, see "Move canvas to center".
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Show camera path
When active, the field guides of the 2D camera folder or the currently selected layer are displayed. For details, see "Show camera path".

Show all field guides
When active, all guides for layers and tracks with keyframes on the canvas are displayed. Turning it off displays only the layer and track guides. 

For details, see "Show camera path".

Thumbnail size
It is possible to select the display size for thumbnails in the [Thumbnail List] and [Clip Thumbnails] on the Timeline palette from [None], 

[Smallest], [Small], [Medium], [Large] and [Largest].

Thumbnail display settings
This allows you to set how thumbnails are shown on the Timeline palette.

Hide timeline palette
This hides the Timeline palette.

Show only animation folder This allows you to display thumbnails in the animation folder only.

Display transparent area It is possible to display the transparent area of the layer or cel in the thumbnail.

To show the Timeline palette again, select the palette from the [Window] menu. If you are using a Smartphone, tap 

the icon on the palette bar.

Thumbnail size : Large

Thumbnail size : Small

Thumbnail size : None
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Show/hide track Toggle Menu
Right clicking [Show/hide track] on the Timeline palette displays a menu that toggles the track visibility. The following describes the function 

of each menu item.

Switch Show/Hide for This Track
Displays/hides the track being edited.

Show This Track including Upper Folder
This option makes the selected track and its layer folder visible.

Show All Other Tracks
This makes all tracks visible except the selected track. It does not change the visibility of the selected track.

Hide All Other Tracks
This hides all tracks except the selected track. It does not change the visibility of the selected track.

Hide All Except Selected Track
This hides all tracks except selected track. It does not change the visibility of the selected track.

 This menu item is available only when the selected track is inside a layer folder.

 All upper layer folders become visible.
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Graph Editor
This is the edit screen of the Graph Editor on the Timeline palette.

You can use the Graph Editor to edit clips for the current frame on the selected track.

A. Graph Editor
Click this to switch the Timeline palette between the standard view and Graph Editor view.

B. Drag to zoom
Turn this option on to zoom in and out of the Timeline palette by dragging.

Dragging to the left will zoom in. Dragging to the right will zoom out.

C. Go to start
Go to start selects the first frame of the clip.

D. Go to previous frame
This button selects the previous frame of the current frame in the Timeline palette.

E. Play/Stop
This button plays or stops animation on the canvas.

F. Go to next frame
This button selects the next frame of the current frame in the Timeline palette.

If [Enable keyframes on this layer] is turned off, you cannot switch to the Graph Editor.

When [Drag to zoom] is turned on, you can zoom in and out of the Timeline palette by right-clicking and dragging 

left or right.

You can also zoom in and out of the Timeline palette using the mouse wheel.

 Animation playback can also be stopped by pressing Esc or clicking a palette other than the Timeline palette 

during playback.

 When an animation is played, played frames will be cached. This allows the animation to buffer more quickly 

the next time it is played. However, the previous playback cache is discarded when the canvas or Timeline pal-

ette is edited.
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G. Go to end
Go to end selects the last frame of the clip.

H. Loop play
This button enables loop play. When playing animation, playback will return to the first frame after reaching the last frame.

I. Snap to X-axis
Snap to the X-axis when editing keyframes.

J. Snap to Y-axis
Snap to the Y-axis when editing keyframes.

K. Add keyframe
This button adds a keyframe to the frame selected in the Timeline palette.

L. Keyframe interpolation
Click this to choose the interpolation method between frames when you add a new keyframe.

Create keyframe: Hold interpolation

The settings of the selected keyframe will be carried to the following keyframe at a fixed speed. The values are replaced when the next 

keyframe begins.

Create keyframe: Linear interpolation

The settings of the selected keyframe will be carried to the following keyframe at a fixed speed.

Create keyframe: Smooth interpolation

The speed will gradually increase after the selected keyframe and then slow down just before the next keyframe.

 For details on adding keyframes, see "Add keyframe".

 For details on how to use keyframes, see "Using the Graph Editor".
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M. Delete keyframe
Deletes the selected keyframe from the Timeline palette.

N. Unpair handles
When this is turned on, the handles of the keyframe will operate independently.

While adjusting the curve with the tangents, the left and right control points can be operated separately.

O. Current frame/Start frame/End frame
Display the positions of the currently selected frame, the start frame and the end frame.

P. Track name
Displays the track name.

Q.  View
Displays the x or y–axis of the animation curve. Allows for viewing the Animation curve list and making a selection.

Click the [Switch to Graph Editor] icon to display the x and y axes. You can also specify the axis you wish to display by checking the 

checkbox.

R. Switch to List Editor
Selects settings from the [List Editor]. Click the icon to show a list of settings. Turns on the displayed setting in the [List Editor].

S. List Editor
Displays settings at can be edited with the animation curve. Clicking the eye icon shows/hides the animation curve.

To change the keyframe interpolation after adding a keyframe, see "Changing the keyframe interpolation". 

 For details on deleting keyframes, see "Delete keyframe".

 For details on how to use keyframes, see "Using the Graph Editor".

 In PRO and EX, the frames are displayed differently depending on the frame display method selected in [Play-

back time] in the [New] dialog box or the [New timeline] dialog box.

 The frame display method can be changed in [How to show frames] in the [Canvas Properties] dialog box. For 

details, see “Menu” > “View Menu” > “Canvas Properties” (PRO/EX).

X graph Displays the x–axis animation curve.

Y graph Displays the y–axis animation curve.

Other
Displays any other animation curve information. Curves uninfluenced by the x and y-axis such as [Opac-

ity] and [Volume (%)] will be displayed here.

Clicking the eye icon shows/hides multiple settings.
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T. Animation curve
Displays the curve. The vertical axis is the transform and opacity settings of the layers and camera. The horizontal axis is the timeline. 

Transformation timing and camera movement recorded in the Timeline palette such as move and rotate can be adjusted using the anima-

tion curve.

(1) Keyframe

A frame where layer opacity and transformations are recorded.

Transformation timing, camera position and angles can be edited by moving keyframes.

(2) Tangent

A tangent adjusts the curve of the line between keyframes. Moving the control points at the end of either side of the tangent adjusts the line 

curve.

Timeline Palette Menu (Graph Editor)
This section describes the functions included in the menu that are displayed when you click [Palette menu] on the upper left corner of the Time-

line palette.

Items displayed when switching to the Graph Editor in the Timeline palette may differ to the default display.

Graph Editor
Click this to switch the Timeline palette between the standard view and Graph Editor view.

Snap to X-axis
Snap to the X-axis when editing keyframes.

Snap to Y-axis
Snap to the Y-axis when editing keyframes.

Unpair handles
When this is turned on, the handles of the keyframe will operate independently.

While adjusting the curve with the tangents, the left and right control points can be operated separately.

Add keyframe
This button adds a keyframe to the frame selected in the Timeline palette.

Switch keyframe to hold interpolation
This changes the interpolation method of the selected keyframe to [Hold]. If a keyframe isn't selected, it will select the closest keyframe pre-

ceding the selected frame to be changed.

Switch keyframe to linear interpolation
This changes the interpolation method of the selected keyframe to [Linear]. If a keyframe isn't selected, it will select the closest keyframe pre-

ceding the selected frame to be changed.
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Switch keyframe to smooth interpolation
This changes the interpolation method of the selected keyframe to [Smooth]. If a keyframe isn't selected, it will select the closest keyframe pre-

ceding the selected frame to be changed.

Delete keyframe
Deletes the selected keyframe from the Timeline palette.

Cut keyframe
This cuts a keyframe from the selected Timeline palette. 

Copy keyframe
This copies the selected keyframe onto the Timeline palette.

Paste keyframe
This pastes a keyframe for the selected frame to the Timeline palette.

Hide timeline palette
This hides the Timeline palette.

To show the Timeline palette again, select the palette from the [Window] menu. If you are using a Smartphone, tap 

the icon on the palette bar.
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This section explains how to operate the Timeline palette.

Frame operations
This describes how to operate frames in the Timeline palette.

Select the frame
Click a [Frame number] in the Timeline palette to select a frame.

Selecting a frame in a specific track
Click the frame to be selected in the track on the Timeline palette. The track and frame will both be selected.

You can change the position of individual frames by clicking [Go to previous frame] and [Go to next frame] in the 

Timeline palette.

Click

Click
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Performing frame operations using the menu
You can operate frames with [Animation] menu > [Move frame].

You can also insert and delete frames from the [Insert frame] and [Delete frame] options shown in the menu when you right-click a frame .

Move frame
You can change frames using the options in the [Animation] menu > [Move frame]. For details, see 

"Move frame".

Timeline

 You can insert a frame by selecting [Animation] menu > [Timeline] > [Insert frame]. For details, 

see "Insert frame".

 You can delete a frame by selecting [Animation] menu > [Timeline] > [Delete frame]. For details, 

see "Delete frame".

 When adding frames with the [Insert frame] option, you can right-click and drag the number of frames you 

want to add on the Timeline palette, and the number will be shown in the [Insert frame] dialog box.

 When deleting frames with the [Delete frame] option, you can right-click and drag the number of frames you 

want to delete from the Timeline palette, and the number will be shown in the [Delete frame] dialog box.
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Operating the timeline editing tools
Frame selections can be changed using the [Edit timeline] tool in the [Operation] tool.

Navigating to surrounding frames
Drag on the canvas to navigate to surrounding frames while the [Edit timeline] tool is selected.

Drag left on the canvas to go to the previous frame.

Drag right on the canvas to go to the next frame.

Go to next frame
Click on the canvas to go to the next frame while the [Edit timeline] tool is selected.

The [Edit timeline] tool can also be selected by clicking [Edit timeline] on the Timeline palette.

The mouse operations of the [Edit timeline] tool can be changed in the Tool Property palette.

Drag
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Cel specification operations
This section explains how to specify cels in an animation folder on the Timeline palette and how to edit the specified cels.

Specify the cel
This specifies cels on the Timeline palette.

1 Select the frame
This selects the frame of the cel to be specified in the track.

2 Specify the cel
Right click the same area and select the cel name in the displayed popup menu.

When using a Tablet/Smartphone, select the name of the cel from the pop-up menu displayed by long pressing in the same place.

A cel can be specified by using the following method.

 "Edit track"

 "Specifying cels"of Timeline palette
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3 The cel is specified.
The cel name is displayed on the Timeline palette. A clip is also created at this time if the frame did not already have a clip.

Specify cels at regular intervals [Windows/macOS]
The cel display range can be specified along with the cel.

1 Select the range
Right-click and drag from the start position to the end position of the range to be displayed for the cel.

 Cels can also be specified by entering the cel name in the input field below the popup menu and pressing 

Enter. This allows you to enter names for cels that have not been created in an animation folder. The cel can be 

created later.

 The popup menu can also be shown by selecting the frame for which to specify a cel and pressing Shift + 

Enter. 

 Cels can also be specified in the [Animation] menu. For details, see "Edit track".

 The cel specifications can be modified later. For details, see "Change the cel specification position".

When using a Tablet/Smartphone, you can specify multiple cels at even intervals from the [Animation] menu. For 

details, see "Batch specify cels".

Drag
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2 Specify the cel
Release the mouse button and select the cel name in the displayed popup menu.

3 The cel is specified.
The cel name is displayed on the Timeline palette. A clip is also created in the dragged position at this time.

The popup menu is still displayed.

Cels can also be specified by entering the cel name in the input field below the popup menu and pressing Enter. 

This allows you to enter names for cels that have not been created in an animation folder. The cel can be created 

later.
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4 Specify the next cel
Select the cel name from the popup menu.

5 The cel is specified.
The cel name is displayed in the next frame after the frame where you finished dragging. A clip is added with the number of frames indi-

cated by dragging in step 1. More cels can be specified by repeating the operation in step 5.
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6 Finish cel specification
Press Esc to hide the popup menu.

 The cel specifications can be modified later. For details, see “Change the cel specification position”.

 Cels can also be specified at regular intervals in the [Animation] menu. For details, see "Batch specify cels".
CLIP STUDIO PAINT Instruction Manual 970



Timeline palette > Operating the Timeline Palette > Cel specification operations
Specify other cels
A cel specified in the Timeline palette can be changed to another cel.

1 Select a cel specification
Right-click the specified cel that you want to edit. When using a Tablet/Smartphone, long press to specify the cel.

2 Specify the cel
Select the cel to be specified from the popup menu.

3 The other cel is specified.
The other cel is specified on the Timeline palette.

Cels can also be changed by selecting the cel specification for which to change the cel and selecting [Animation] 

menu > [Edit track] > [Specify cels].
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Change the cel specification position
Change a cel specification to another frame.

1 Select a cel specification
Drag the cel specification for which to change the position and drop it in the destination frame. On the Tablet, use the pen to drag and drop.

2 The cel specification position changes.
The cel specification is moved to the dragged and dropped position.

Duplicate specified cel
This duplicates a cel specification in another frame.

1 Select a cel specification
While pressing and holding the Alt key, drag the cel specification to be duplicated and drop it in the destination frame. 

2 The cel specification position changes.
The cel specification is duplicated in the dragged and dropped position.

 Cel specifications can be moved forward or back, but cannot be moved to a different track.

 If a cel specification is dragged and dropped to a frame that already has another cel specification, the frame is 

overwritten with the new cel specification and the old specification is deleted.
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Delete the cel specification
This deletes a cel specification from the Timeline palette. The cel remains in the Layer palette even if the specified cel is deleted from the Time-

line.

1 Select a cel specification
Right click the cel you want to delete.

2 Delete the cel specification
Clear the input field in the popup menu and press Shift + Enter to delete the cel specification.

 Cel specifications can be duplicated in an earlier or later frame, but cannot be moved to a different track.

 If a cel specification is duplicated in a frame that already has another cel specification, the frame is overwritten 

with the new cel specification and the old specification is deleted.

For details on how to delete a specified cel with the [Animation] menu, see "Delete". You can use this method on 

the Tablet/Smartphone versions as well.
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To split a clip in the position where the cel specification was deleted, press the Enter key after clearing the input field in the popup menu.
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Editing cel specifications using the menu
Cel specifications can also be edited using the options in [Animation] menu > [Edit track].

Cel specification can also be edited from the menu that appears when you right-click a frame.

Create all supported cels

This allows cels that are specified in the Timeline palette but have not been created in the Layer 

palette to be created together. The cels are created in all animation folders included in the time-

line.

For details, see "Create all supported cels".

Cut
This cuts a selected cel specification from the Timeline palette and stores it on the clipboard. For 

details, see "Cut".

Copy

This stores a selected cel specification from the Timeline palette on the clipboard. The cel will 

remain on the Timeline palette.

For details, see "Copy".

Paste
This pastes the cel specification stored on the clipboard to the Timeline palette.

For details, see "Paste".

 If you turn on [Enable keyframes on this layer], click [detail] and then right-click a clip thumbnail or cel specifica-

tion, a menu for editing cel specifications will be displayed.
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Clip operations
This section describes how to operate clips.

Select a clip
Click above the clip to be selected on the Timeline palette. The mouse cursor changes to a hand icon when it is moved to an area where a clip 

can be selected.

Change position of clip
This selects a clip and drags it to the desired position.

Multiple clips can be selected by holding down Ctrl while selecting clips.

Click

Drag
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Trim clip
This adjusts the length of a clip. This method does not change the cel specifications within the clip, but deletes cel specifications outside the 

range of the clip.

1 Change the length of a clip
Move the mouse to the start or end side of the clip and drag left or right. The mouse cursor changes to a left and right arrow icon when it is 

moved to an area where the length can be changed.

2 The length of the clip is changed
This changes the the length of the clip. If the clip is shortened, the cel specifications in the trimmed area are deleted.

Expand/reduce length of clip (time stretch)
This adjusts the length of a clip. This method adjusts the cel specification positions according to the length of the clip.

1 Move the mouse cursor to one side of the clip
Move the mouse to the start or end side of the clip and drag left or right while holding down the Alt key. The mouse cursor changes to a 

left and right arrow icon when it is moved to an area where the length can be changed.

2 The clip length and cel specification positions are changed.
The gap between the cel specifications is adjusted according to the length of the clip.

The audio track and the movie track clips cannot be lengthened or shortened.
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Specify start position of clip
This allows the start position of a clip to be set according to the frames on the Timeline palette.

1 Select the frame
On the Timeline palette, select the track and frame to be set as the start position of the clip.

2  Select the command
Select the [Animation] menu > [Edit track] > [Set as first displayed frame].

3 The start position of the clip is changed
The selected frame is set as the start position of the clip.

Specify end position of clip
This allows the the end position of a clip to be set according to the frames on the Timeline palette.

1 Select the frame
On the Timeline palette, select the track and frame to be set as the end position of the clip.

2  Select the command
This selects the [Animation] menu > [Edit track] > [Set as last displayed frame].

 If a cel before the selected frame is specified, the cel specification position moves to the selected frame.

 [Set as first displayed frame] does not work if a cel is specified for the selected frame.
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3 The end position of the clip is changed
The selected frame is set as the end position of the clip.

Delete clip
This deletes a clip. Deleting a clip allows you to delete all cel specifications in the clip together.

1 Select a clip
This selects the clip to be deleted.

2  Select the command
Select the [Animation] Menu > [Edit track] > [Delete].

3 The clip is deleted
The selected clip is deleted.

 If a cel after the selected frame is specified, the section of the clip from the specified frame to the next cel 

specification is deleted.

 If a frame without a clip is selected when performing [Set as last displayed frame], the previous clip is 

extended and the selected frame becomes the end of the clip.

 If a frame with a cel specification is selected when performing [Set as last displayed frame], the cel specifica-

tion is deleted.
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Editing clips using the menu
Clips can also be edited using the options in [Animation] menu > [Clip].

A clip can also be edited from the menu that displays when you right-click a frame.

Cut
This cuts a selected clip from the Timeline palette and stores it on the clipboard.

For details, see "Cut".

Copy
This stores a selected clip from the Timeline palette on the clipboard. The cel will remain on the Timeline palette. 

For details, see "Copy".

Paste This pastes the clip stored on the clipboard to the Timeline palette. For details, see "Paste".

Combine clips This selects multiple clips and joins them. For details, see "Combine clips".

Divide clip This splits a clip at the position of the selected frame. For details, see "Divide clip".

Even if a menu for editing cel specifications is displayed, clips can still be edited.
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Track operations
This section describes how to operate tracks in the Timeline palette.

Change the display order of tracks
This changes the display order of tracks. When the display order of the tracks is changed, the stacking order on the Layer palette changes 

accordingly.

1 Move a track
Click this to select the track to be moved, then drag and drop it to the desired position.

When using a Tablet/Smartphone, move a finger or pen over the grip on the right side of the track name and drag and drop it.

2 The track order changes
This changes the display order of the tracks.
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Label operations
This section describes how to operate a label.

Label Type
This sets labels on the Timeline palette. Created labels can be used as markers when editing.

There are different kinds of labels.

A. Timeline label
Input instructions and notes for the whole timeline onto a specific frame.

 For details on how to create a Timeline label, see "Create timeline label"

 For details on how to delete a Timeline label, see "Delete timeline label"

B. Track label
Input instructions and notes for the whole timeline onto a track within a specific frame.

Add a [Frame label] for single frames. For multiple frames, an [Area Label] can be added.

For details on how to create a track label, see "Create track label".

The track label of the 2D camera folder track can add camera instructions to your animation from the list. You can 

output camera instructions for a Toei Animation Digital Exposure Sheet.

 For details on additional camera instructions, see "Track labels of 2D camera folder tracks".

 For details on outputting Toei Animation Digital Exposure Sheets, see "Apply Toei Animation Digital Exposure 

Sheet information to current exposure sheet [EX] [Windows/iPad]".

A

BB
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Create track label
This create a track label in a frame.

1 Display the track label area
Clicking [Detail] before the track name to display the track label area.

2 Select the frame
From the track label area, right click on a frame to add a track label.

You can right-click and drag across the track label area to select multiple frames and create a ranged label.
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3 Input instructions and notes.
When the field appears, delete the characters from inside it and press Enter.

4 Creating a track label
Track labels can be created in the track label area.

When the track label area is hidden, the track label will display on the top of the track. It cannot be edited, etc.

In addition to frame labels, in between track labels and reverse sheet track labels can also be created.

Track labels can also be created from the [Animation] menu. For details, see "Create track label".
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Track labels of 2D camera folder tracks
In the track label area of the 2D camera folder, Toei Animation Digital Exposure Sheet.

Instructions for Toei Animation Digital Exposure Sheet camera movement can be added in the track label area of the 2D camera folder. As with 

other track labels, you can right-click and drag it to assign the track label to multiple frames.

Modify the track label
Modifying the track label lets you make adjustments to the track label.

Clicking the track label will display an editable input field. After modifying the input, press the Enter key to see revisions.

Turn off [Select from List] to input instructions and notes onto track labels.

When the track label area is hidden, track labels cannot be modified.
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Change the position of the Track label
This allows you to change the position of the track label. You can use this when you wish to move a track label to a different frame.

Move the track label from the track label area by dragging it.
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Change track label area
When you want to create track labels for multiple frames, you can increase the range of specified frames.

From the track label area, align the cursor with the edge of the track labels whose range you wish to change and drag left or right as needed.
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Delete the track label
Click the track label you wish to delete from the track label area.

When the field appears, delete the characters from inside it and press Enter.

Track labels can also be deleted from the [Animation] menu. See "Label".
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Key frame operation
This section describes how to operate keyframes in the Timeline palette.

Enable keyframe editing
This enables/disables edits used by keyframes on selected tracks and layers. 

1 Select the track
To edit a keyframe, select it from the Timeline palette.

2 Enable keyframes
Click [Enable keyframes on this layer].

3 Switch to keyframe settings
This enables keyframe editing for selected layers and tracks.

If you use the [Object] tool to select a track, you will be able to edit it using keyframes, and the display of the Timeline and Layer palettes 

will change.

 For items that cannot be edited, an icon is displayed on the Layer palette to indicate that the timeline is locked. The cels in the anima-

tion folder will display a semi-transparent lock icon on them.

 [Transform] and [Opacity] will be added to the track on the Timeline palette. For tracks set with a mask, [Mask] will also be added.

You cannot edit 3D layers, quick masks, and paper layers using keyframes that are compatible with Version 1.5.
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 Click the icon to the left of the track name to display a more detailed list of settings.

Keyframe settings
Keyframes can be added to each track of the Timeline palette.

 "2D camera folder track"

 "Animation folder/Layer"

 "Layer mask"

 "Audio track"

 For details on how to draw or edit layers with [Enable keyframes on this layer] turned on, see "Enable key-

frame editing".

 For layer folders, if you set [Enable keyframes on this layer], the settings will be reflected on all the layers 

within the folder. The settings will also be reflected in the animation and 2D camera folders.

 For layers set inside a layer folder with keyframes enabled, you cannot turn off the [Enable keyframes on this 

layer] setting

 For cels inside the animation folder, if [Enable keyframes on this layer] is set, those settings will be reflected in 

the entirety of the animation folder.

 In animation folders with keyframes enabled, if [Enable light table] is turned off or if you are unable to use light 

table layers, even if you select another frame from the Timeline palette, the selected cel in the Layer palette will 

not be replaced. 

To add a keyframe, turn on [Enable keyframes on this layer].
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2D camera folder track
Using 2D camera folders, you can add camera movement to your animation without transforming the images in the animation folders or layers.

When adding a keyframe to a 2D camera folder track, you can register the following settings.

 Transform (Position, Scale ratio, Rotate, Center of rotation)

 Opacity

 Keyframe interpolation

In the example below, a 2D camera folder has been created and a keyframe has been added to a layer. The following will explain how to get the 

background to move along with the character. 

1  Select the command
Select [Animation] menu > [New animation layer] > [2D Camera Folder]. 

A 2D camera folder will be created in the Layer palette and in the Timeline palette.

 With 2D camera folders, you can show the path of keyframe movement and use the camera frame for camera 

directions when animating. For information on how to always show the camera paths, see "Show camera 

path".

 The track label of the 2D camera folder track can add camera instructions to your animation from the list. You 

can output camera instructions for a Toei Animation Digital Exposure Sheet. For details on additional camera 

instructions, see "Track labels of 2D camera folder tracks". For details on outputting Toei Animation Digital 

Exposure Sheets, see "Apply Toei Animation Digital Exposure Sheet information to current exposure sheet 

[EX] [Windows/iPad]".
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2 Storing in a Layer Folder
Camera movement that you add to animation folders or layers will be stored on the Layer palette in the 2D camera folder.

3 Select the tool
On the Tool palette, select the [Operation] tool.

4 Select the sub tool
Open the Sub Tool palette and select [Object].

5 Select the frame
Add camera movement to a selected frame in the Timeline palette.

6 Keyframe interpolation settings
Select an interpolation method from [Keyframe interpolation] on the Timeline palette.

Animation folders and layers can be stored in 2D camera folders, even on the Timeline palette. 

2D camera folders cannot be created inside an existing animation folder.
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7 Add camera movement
If you select the 2D camera folder track with the [Object] tool, a rectangle frame will appear over the canvas. 

You can set up camera movement with the Tool Property palette.

(1) Dragging a handle allows you to scale up/down the image.

(2) Dragging the rotation handle allows you to rotate the entire drawing.

(3) Dragging the rectangle frame allows you to adjust the image position.

(4) In the Tool Property palette, you can enter numerical values for precise adjustments. The other settings configure the opacity of the 

layer.

 For details on [Keyframe interpolation] options, see "Graph Editor".

 To change the keyframe interpolation after adding a keyframe, see "Changing the keyframe interpolation". 

 The rectangle frame corresponds to the camera's viewfinder. When you export an animation, the rectangle 

frame becomes the output range. For example, if you move the rectangle frame to the right, in the exported 

animation, the image will move to the left.

 When the Tool Property palette's [Display mode] is set to [Show camera's field of view], the 2D camera will 

enter rendering mode, and the rectangle frame will not be shown. When you want to edit using the rectangle 

frame, turn the [Display mode] to [Show field guides].

 When an animation frame is displayed in PRO/EX, a transformation box will display over the output frame.

 For details on the Tool Property palette, see the “Clip Studio Paint Tool Setting Guide.”
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8 Adding a keyframe
If you change the settings for the 2D camera folder track, a keyframe will be added to the Timeline palette to register the settings.

9 Add keyframe
To add movement to the background, add the next keyframe.

(1) Add movement to a selected frame.

(2) Click [Detail] on the 2D camera folder track.

(3) Select the transformation area of the 2D camera folder track.

(4) Click [Add keyframe].

(5) A keyframe will be added to the Transformation area.
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10Add camera movement
Confirm that the keyframe made in step 9 is selected.

To create camera movement, use the Tool Property palette or manipulate the handles on the camera frame.

Camera movement will be recorded to the selected keyframe.

Then, keyframes are created, and the camera movement is added.

 Click the icon to the left of the track name to display detailed settings. You can select a specific setting to add 

keyframes only for that setting. For example, if you click [Position], only [Position] will display the [♦] mark. 

For [Transform], only some of the settings will display the [◊] mark.

 If you set a keyframe to only one specific setting but then set a different setting on the canvas, all of the items 

will then have keyframes added to them. For example, for a keyframe with only the [Position] marked with [♦], 

if you rotate the camera frame, [Rotate] will then also have a [♦] mark and a keyframe added to it.
CLIP STUDIO PAINT Instruction Manual 995



Timeline palette > Operating the Timeline Palette > Key frame operation
 For how to edit keyframes, see "Edit keyframes".

 If you want 2D camera settings to be reflected when you play the animation, turn on [Render 2D camera] in 

[Animation]Menu > [Playback settings].
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Animation folder/Layer
When adding a keyframe to the animation frame or a normal layer, you can register the following settings.

 Transform (Position, Scale ratio, Rotate, Center of rotation)

 Opacity

 Keyframe interpolation

This section describes how to add a keyframe from the Timeline palette.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select a frame
Select the frame you wish to set as a keyframe from the Timeline palette.

4 Keyframe interpolation settings
Select an interpolation method from [Keyframe interpolation] on the Timeline palette.

You can also change the values on tracks with a layer mask. For details on how to change this, see "Layer mask".

 For details on [Keyframe interpolation] options, see "Graph Editor".

 To change the keyframe interpolation after adding a keyframe, see "Changing the keyframe interpolation". 
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5 Configuring the Opacity and Transformation of an Image
A frame for transformation will display over the canvas. You can transform the image with the Tool Property palette.

(1) Dragging a handle allows you to scale up/down the image.

(2) Dragging the rotation handle allows you to rotate the entire drawing.

(3) Dragging the rectangle frame allows you to adjust the image position.

(4) In the Tool Property palette, you can enter numerical values for precise adjustments. The other settings configure the opacity of the 

layer.

6 Adding a keyframe
Like when adjusting image settings, when a keyframe is added from the Timeline palette, its settings will be registered.

 When an animation frame is displayed in PRO/EX, a transformation box will display over the output frame.

 You can adjust the layer opacity in the Layer palette.

 For details on the Tool Property palette, see the “Clip Studio Paint Tool Setting Guide.”
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Layer mask
When a track with a layer mask is set, only the layer mask can be transformed. When adding a mask to a keyframe, you can register the follow-

ing settings.

 Transform mask (Position, Scale ratio, Rotate)

 Keyframe interpolation

The following explains the steps before setting up a layer mask to a keyframe.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Show Mask settings
Click [Detail] on the Timeline palette.

4 Select a Mask
When the track name expands, click [Mask].

With this, you can add masks to keyframes. Procedures hereafter are the same as here: "Animation folder/Layer".

Audio track
For audio tracks, you can register volume and keyframe interpolation settings to keyframes.

This section describes how to add audio tracks to keyframes.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].
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3 Select a frame
Select the frame you wish to set as a keyframe from the Timeline palette.

4 Keyframe interpolation settings
Select an interpolation method from [Keyframe interpolation] on the Timeline palette.

5 Adjust volume
You can adjust the [Volume] setting from the Tool Property palette.

 For details on [Keyframe interpolation] options, see "Graph Editor".

 To change the keyframe interpolation after adding a keyframe, see "Changing the keyframe interpolation".

If you want to set the time an audio file begins, adjust the [Start time] settings in the Tool Property palette. This is 

useful when you want to start playing part-way through an audio clip.

When changing the [Start time], it will apply to the whole audio clip selected. The keyframe will not be added to the 

Timeline palette.
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6 Adding a keyframe
Along with the settings, the keyframe will be added to the Timeline palette.

Select a keyframe
This section describes how to select a keyframe.

Select a particular keyframe
Click on the particular keyframes you want to select. The selected keyframes will be shown in a red box.

Keyframes can also be selected by dragging to encircle them.
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Select multiple keyframes
To select multiple keyframes at once, drag to encompass all the keyframes you want to select. The selected keyframes will be shown in a red 

box.

Edit keyframes
This section describes how to change keyframe settings.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select a keyframe
Select the keyframe to edit from the Timeline palette.

4 Change settings
You can use the Tool Property palette and the canvas to adjust the settings.

These changes will be reflected in the keyframe.

 You can also select keyframes on different tracks.

 Hold Shift and drag the timeline while keyframes are selected to add other keyframes in the specified range to 

the selection.

 Hold Ctrl and drag the timeline while keyframes are selected to remove keyframes in the specified range from 

the selection.

You cannot change the [Keyframe interpolation] using this method. For details on how to change the keyframe 

interpolation, see "Changing the keyframe interpolation".

Drag
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Changing the keyframe interpolation
This section describes how to change interpolation methods between keyframes.

Changing the interpolation method of a specific keyframe

1 Select a keyframe
Select a keyframe to change its interpolation method.

(1) Select the frame with the keyframe for which you want to change the interpolation method.

(2) Select the items to be changed.

2 Selecting the interpolation method
Select an interpolation method from [Keyframe interpolation] on the Timeline palette.

3 Changing the interpolation method
Click [Add keyframe] on the Timeline palette.

4 Switch settings
When settings are reflected, the keyframe's color will change.

Changing the interpolation method of multiple keyframes 
You can change the interpolation of multiple keyframes at once. When selecting keyframes between different tracks, you can change all of 

them at once.

1 Select a keyframe
Select a keyframe to change its interpolation method.
CLIP STUDIO PAINT Instruction Manual 1003



Timeline palette > Operating the Timeline Palette > Key frame operation
2 Selecting the interpolation method
From [Animation] menu > [Edit track], you can select [Switch keyframe to hold interpolation], [Switch keyframe to linear interpolation], 

or [Switch keyframe to smooth interpolation].

3 Switch settings
When settings are reflected, the keyframe's color will change.

Change the position of a keyframe
If you drag and drop a keyframe over the Timeline palette, you can change its position.

Duplicate keyframe
If you drag and drop a keyframe over the Timeline palette while holding down the Alt key, you can duplicate it.
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Delete keyframe
This section describes how to delete keyframes.

1 Select a keyframe
Select a keyframe to delete.

2 Delete keyframe
Click [Delete keyframe] on the Timeline palette.

Edit a keyframe enabled layer
You can temporarily draw or make edits with a brush or pen on a track that has [Enable keyframes on this layer] turned on.

1 Select the track
Selects a track from Timeline palette to edit.

 To delete a track, select the [Animation] menu > [Edit track] > [Delete].

 You can also delete keyframes by right-clicking and selecting [Delete].
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2 Enable editing
Click [Edit layers with active keyframes].

3 Switch to track settings
The selected layer effects are canceled out and only the selected layer and the paper layer will display. All other layers will be displayed as 

semi-transparent.

If another layer is selected, the settings will be canceled automatically. The layer display will also be restored.

You can also switch the settings with the [Animation] menu > [Edit layers with active keyframes].
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Disable keyframe editing
Turning off [Enable keyframes on this layer] on a layer folder or track disables keyframe editing.

1 Select the track
Select the track you wish to disable keyframe edits from the Timeline palette.

2 Disable keyframes
Click [Enable keyframes on this layer].

3 Switch to keyframe settings
If changes made to the track are deleted, the keyframes in the Timeline palette will be hidden.

[Transform] and [Opacity] from the track name on the Timeline palette will also be hidden.

For 2D camera folder tracks or audio tracks, you cannot disable edits made to these keyframes.
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The lock icon on the layers in the Layer palette will be hidden.

 When you turn on [Enable keyframes on this layer] again, the preserved settings from when you turned it off 

return, the keyframes will display in the Timeline palette and layer transformations will be restored.

 If you transform a layer or change its opacity while [Enable keyframes on this layer] is turned off, these will not 

be in effect if you turn [Enable keyframes on this layer] back on.
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How to edit keyframes using the menu
Keyframes can be edited from options in [Edit track] located in the [Animation] menu.

Keyframes can also be edited from the menu that displays when you right-click a frame.

Cut
Cuts and stores a selected keyframe onto the clipboard from the Timeline palette. For details, see 

"Cut".

Copy
Stores a selected keyframe onto the clipboard from the Timeline palette. The keyframe above the 

Timeline palette will remain. For details, see "Copy".

Paste Pastes a selected keyframe onto the clipboard from the Timeline palette. For details, see "Paste".

This enable keyframes on 

the layer

This will enable/disable the selected layer or track of a keyframe. For details, see "Enable keyframe 

editing".

Add keyframe This adds a keyframe to the selected frame on the Timeline palette.

Switch keyframe to hold 

interpolation

This changes the interpolation method between the selected keyframes to [Hold]. For details, see 

"Switch keyframe to hold interpolation".

Switch keyframe to linear 

interpolation

This changes the interpolation method between the selected keyframes to [Linear]. For details, see 

"Switch keyframe to linear interpolation".

Switch keyframe to smooth 

interpolation

This changes the interpolation method between the selected keyframes to [Smooth]. For details, see 

"Switch keyframe to smooth interpolation".

Edit layers with active key-

frames

This allows you to temporarily draw or make edits with a brush or pen on a layer (track) that has 

[Enable keyframes on this layer] turned on. For details, see "Edit layers with active keyframes".

Delete all keyframes
This deletes all tracks from the selected track in the Timeline palette. For details, see "Delete all key-

frames".

If you right-click on the transformation area or the opacity area of an animation folder or layer, the settings that 

relate to the keyframes will be shown.

Additionally, if you turn on [Enable keyframes on this layer] while the track name’s [Details] section is closed, the 

settings that relate to the keyframes will be shown.
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Using the Graph Editor
This section describes how to edit using the Graph Editor from the Timeline palette.

What is the Graph Editor?
When you switch to the Graph Editor for a track on the Timeline palette, the Timeline palette will switch to Graph Editor view.

The Graph Editor is a graph with the animation curves. The vertical axis of the graph will change according to the track chosen. The horizontal 

axis is the timeline.

You can edit the animation curve to add image transformations, change the image opacity, or to make detailed adjustments to interpolation 

methods between keyframes.

Audio track volume can also be adjusted this way. However, items other than these cannot.
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Switch to Graph Editor
You can edit a particular track by switching to the Graph Editor.

1 Select the track
This selects a track from the Timeline palette that has [Enable keyframes on this layer] turned on.

2 Switch to Graph Editor
Click the [Graph Editor] icon.

3 Show settings to be edited
When switched to the graph editor, you can choose to display the settings you want to set up on the animation curve.

Click to the left of the setting that you want to adjust. If the eye icon is shown next to the setting, you can edit it.

Select a keyframe
This is the same as the normal view. For details, see "Select a keyframe".

 In [View], select the graph you want to edit in order to narrow the list to options you can edit.

 If you want to change the display size of the animation curve, click [Drag to zoom] and drag it left or right on 

the timeline to adjust it.
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Add keyframe
You can add a keyframe when using the graph editor with the following method.

Add a particular animation curve
Click the animation curve while holding down Alt. A keyframe will be added at the clicked position.

[Alt]+Click
CLIP STUDIO PAINT Instruction Manual 1012



Timeline palette > Operating the Timeline Palette > Using the Graph Editor
Add a particular frame
To add a keyframe to a selected frame, click [Add keyframe] on the frame you want to add to.

Keyframes will be added to all of the animation curves inside the frame.

1 Select a keyframe
Select a frame to add as a keyframe.

2 Add keyframe
Click [Add keyframe] on the Timeline palette.

Keyframes will be added to all of the animation curves inside the frame.
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Delete keyframe
You can use the Graph Editor to delete keyframes by holding down the Alt key and clicking a keyframe.

This will delete the keyframe.

You can also select the keyframe above the animation curve and click [Delete keyframe] on the Timeline palette.

[Alt]+Click
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Move keyframe
To move a keyframe while using the Graph Editor, select the keyframe and drag it.

 If you drag a selected keyframe while holding down Shift, you can confine movement to the X-axis or Y-axis 

direction.

 For details on moving multiple keyframes, see "Move multiple keyframes".
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Move multiple keyframes
If two or more keyframes are selected, all keyframes will be moved at once.

When multiple keyframes are selected, you can select any one to drag them. The selected keyframes will move in the direction you drag them 

to.

To shrink or stretch multiple keyframes at the same time, select and drag them on the graph while holding the Ctrl 

+ Shift keys.

 If you drag along the x-axis while holding Ctrl + Shift, the leftmost keyframe will remain in place while the 

selected keyframes shrink or stretch along the x-axis.

 If you drag along the y-axis while holding Ctrl + Shift, the selected keyframes will shrink or stretch along the y-

axis. 
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Move whole animation curve
If you drag any part other than the animation curve keyframes, the animation curve will move in its entirety. 
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Adjusting the animation curve
Adjust the animation curve by altering its shape.

To do this, drag the control points on the tangents to alter the curve.

Adjusting either side of the animation curve separately.
If [Unpair handles] in the Timeline palette is turned on, the left and right control points at the end of either side of the tangent can be operated 

separately.

1 Select a keyframe
Adjust the curve of the selected keyframe.

2 Switching settings
Click [Unpair handles] from the Timeline palette.

If you select [Unpair handles] from [Animation] menu > [Animation curve], the settings will also change.
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3 Adjusting the curve of the line
The keyframe shape will turn into a rectangle.

While adjusting the curve with the tangents, the left and right control points can be operated separately.

Clicking [Unpair handles] again makes the left and right control points act in tandem again.
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Exit the Graph Editor
Click the [Graph Editor] icon on the Timeline palette. The Timeline palette will return to its original display.

If only one part of a keyframe is set, it will display a diamond icon (◊). For example, if you move a specific anima-

tion curve keyframe, the frame prior to it and behind it will both have keyframes added to them that display a dia-

mond icon (◊).
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Navigator Palette
The Navigator palette allows you to manage the view of the image displayed on the canvas window.

The Navigator palette is displayed when the [Window] menu > [Navigator] is selected.

 Functions of Navigator Palette



Navigator Palette  > Functions of Navigator Palette
Navigator Palette

 Functions of Navigator Palette
The Navigator palette allows you to manage the view of the image displayed on the canvas window. It allows you to
adjust the display position, scale and angle.

(1) Scale up/down slider

Drag the slider to adjust the scale to display the image on the canvas window. Dragging to the right scales up the image while dragging to 

the left scales down the image.

(2) Zoom out

When clicked, zooms out the image displayed on the canvas window.

(3) Zoom in

When clicked, zooms in the image displayed on the canvas window.

(4) 100%

When clicked, displays the image displayed on the canvas window at 100%.

(5) Fit to navigator

When clicked, displays the image on the canvas in such size as to fit it completely in the window. The size of the image changes in con-

junction with that of the window.

(6) Fit to screen

When clicked, displays the image on the canvas in such size as to fit it completely in the current window. The size of the image does not 

change in conjunction with that of the window.

(7) Rotation slider

Drag the slider to adjust the display angle of the image displayed on the canvas window. Dragging to the right rotates the image to the right 

(clockwise) while dragging to the left rotates the image to the left (counterclockwise).

You can also adjust the scale and angle of the image with the sliders and icons at the lower left of the canvas win-

dow.

The step by which the view will zoom out is configured by [Scale] on the [Preferences] dialog box > [Canvas]. For 

details, see "Canvas".

The step by which the view will zoom in is configured by [Scale] on the [Preferences] dialog box > [Canvas]. For 

details, see "Canvas".
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(8) Rotate left

When clicked, rotates the image displayed on the canvas window to the left by a specified angle.

(9) Rotate right

When clicked, rotates the image displayed on the canvas window to the right by a specified angle.

(10)Reset rotation

When clicked, resets the display angle of the image displayed on the canvas window to the original angle (0 degrees).

(11) Flip horizontal

When turned on, reverses horizontally the image displayed on the canvas window.

(12)Flip vertical

When turned on, reverses vertically the image displayed on the canvas window.

The step by which the view will rotate left is configured with [Angle] in the [Preferences] dialog box > [Canvas]. 

For details, see "Canvas".

The step by which the view will rotate by [Rotate Right] is configured by [Angle] on the [Preferences] dialog box > 

[Canvas]. For details, see "Canvas".
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(13) Image preview

Displays completely the image currently displayed on the canvas window.

The area displayed on the canvas window is displayed framed in red. Dragging on the Navigator palette moves the red frame, changing the 

display position of the image displayed on the canvas window.

Drag
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Navigator Palette Menu
This section describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the Naviga-

tor palette.

Rotate/Invert
Canvases can be rotated and flipped.

Zoom in
When clicked, zooms in the image displayed on the canvas window.

Zoom out
When clicked, zooms out the image displayed on the canvas window.

100%
When clicked, displays the image displayed on the canvas window at 100%.

200%
When clicked, displays the image displayed on the canvas window at 200%.

Reset Rotation Resets the display angle of the image displayed on the canvas window to the original angle (0 degrees).

Rotate 90 Rotates the view by 90 degrees.

Rotate 180 Rotates the view by 90 degrees.

Rotate 270 Rotates the view by 90 degrees.

Flip Horizontal Reverses the view horizontally.

Flip Vertical Reverses the view vertically.

Rotate Left Rotates the view to the left by a certain angle.

Rotate right Rotates the view to the right by a certain angle.

The step by which the view will rotate by [Rotate Left] or [Rotate Right] is configured by [Angle] in the [Prefer-

ences] dialog box > [Canvas]. For details, see "Canvas".

The step by which the view will zoom in is configured by [Scale] on the [Preferences] dialog box > [Canvas]. For 

details, see "Canvas".

The step by which the view will zoom out is configured by [Scale] on the [Preferences] dialog box > [Canvas]. For 

details, see "Canvas".

Show menu
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Fit to Screen
When clicked, displays the image on the canvas in such size as to fit it completely in the current window. The size of the image does not change 

in conjunction with that of the window.

Reset display
Resets the position, angle, reversed state of the view, and displays the entire view.

Fit to navigator
When clicked, displays the image on the canvas in such size as to fit it completely in the window. The size of the image changes in conjunction 

with that of the window.

For details, see "Fit to navigator".

Show command bar 
When turned on, displays the command bar of the Navigator palette.

Hide navigator palette
Hides the Navigator palette.

To show the Navigator palette again, select the palette from the [Window] menu. If you are using a Smartphone, 

tap the icon on the palette bar.

Show command bar: OFF Show command bar: ON

Command bar
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Sub view Palette [PRO/
EX]
Allows you to acquire a color from an image displayed as color reference.

The [Sub View] palette is displayed when [Window] menu > [Sub View] is selected.

 Acquiring Colors from a Reference Image

 Functions of Sub View Palette



Sub View Palette [PRO/EX]  > Acquiring Colors from a Reference Image
Sub View Palette [PRO/EX]

 Acquiring Colors from a Reference Image
This section describes the procedure to acquire colors from a reference image imported to the [Sub View] palette.

1 Import the image to refer to
Click [Import] on the [Sub View] palette. From the [Open file] dialog box, import the image whose colors you want to use as reference.

2 Select color
Select the color from the image imported to the [Sub View] palette.

(1) Check that [Switch to eye dropper automatically] is turned on.

(2) Click the area in the color to acquire.

(3) The color of the clicked area is displayed as drawing color in the [Color] palette.
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 Functions of Sub View Palette
This section describes the functions of the [Sub View] palette.

(1) Scale up/down slider

Drag the slider to adjust the display scale for the image on the [Sub View] palette. Dragging to the right scales up the image while dragging 

to the left scales down the image. Clicking the value displayed on the right side allows you to input the scale numerically.

(2) Zoom out

When clicked, zooms out the image displayed on the [Sub View] palette.

(3) Zoom in

When clicked, zooms in the image displayed on the [Sub View] palette.

(4) Fit to Navigator

When turned on, displays the image on the [Sub View] palette in such size as to fit it completely in the palette. The size of the image 

changes in conjunction with the palette size when the latter is changed.

(5) Switch to eye dropper automatically

When turned on, the mouse cursor becomes an [Eyedropper] tool when placed on the [Sub View] palette, which will allow you to acquire 

a color.

When turned off, the mouse cursor becomes a [Hand] tool when placed on the [Sub View] palette, which will allow you to move the image 

view.

(6) Rotation slider

Drag the slider to adjust the display angle for the image on the [Sub View] palette. Dragging to the right rotates the image to the right 

(clockwise) while dragging to the left rotates the image to the left (counterclockwise).

(7) Rotate Left

When clicked, the image displayed on the [Sub View] palette is rotated to the left in increments of 5 degrees.

(8) Rotate right

When clicked, the image displayed on the [Sub View] palette is rotated to the right in increments of 5 degrees.

(9) Reset Rotation

When clicked, the display angle of the image displayed on the [Sub View] palette is reset and reverts to the original angle (0 degrees).
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(10)Flip Horizontal

When turned on, the image displayed in the [Sub View] palette is horizontally flipped.

(11) Flip Vertical

When turned on, the image displayed on the [Sub View] palette is vertically flipped.

(12)To previous image

When multiple images are imported, displays the image prior to the currently displayed one.

(13)To next image

When multiple images are imported, displays the image next to the currently displayed one.

(14) Import

When clicked, displays the dialog box for selecting a file. Selecting a reference image imports the image to the [Sub View] palette.

(15)Clear

When clicked, clears the image displayed on the [Sub View] palette.

 You can import multiple images to the [Sub View] palette. Switch each of the imported images for use.

 You can also import an image file to the [Sub View] palette by drag and drop.
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Sub View Palette Menu
This section describes the functions included in the menu that is displayed when you click [Show Menu] on the upper left corner of the [Sub 

View] palette.

Rotate/Invert
The image displayed on the [Sub View] palette can be rotated or flip.

Zoom in
When clicked, zooms in the image displayed on the [Sub View] palette.

Zoom out
When clicked, zooms out the image displayed on the [Sub View] palette.

Fit to navigator
When turned on, displays the image on the [Sub View] palette in such size as to fit it completely in the palette. The size of the image changes in 

conjunction with the palette size when the latter is changed.

Switch to eye dropper automatically
When turned on, the mouse cursor becomes an [Eyedropper] tool when placed on the [Sub View] palette, which will allow you to acquire a 

color.

When turned off, the mouse cursor becomes a [Hand] tool when placed on the [Sub View] palette, which will allow you to move the image 

view.

Import
When clicked, displays the dialog box for selecting a file. Selecting a reference image imports the image to the [Sub View] palette.

Clear
When clicked, clears the image displayed on the [Sub View] palette.

Reset Rotation Resets the display angle of the image in the [Sub View] palette to the original angle (0 degrees).

Rotate 90 Rotates the image in the [Sub View] palette by 90 degrees.

Rotate 180 Rotates the image in the [Sub View] palette by 180 degrees.

Rotate 270 Rotates the image in the [Sub View] palette by 270 degrees.

Flip Horizontal Horizontally flips the image in the [Sub View] palette.

Flip Vertical Vertically flips the image in the [Sub View] palette.

Rotate Left Rotates the image in the [Sub View] palette 5 degrees to the left.

Rotate right Rotates the image in the [Sub View] palette 5 degrees to the right.

 You can import multiple images to the [Sub View] palette. Switch each of the imported images for use.

 When using Windows/macOS/Tablet, you can also import an image file to the [Sub View] palette by drag and 

drop.

Show menu
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To previous image
When multiple images are imported, displays the image prior to the currently displayed one.

To next image
When multiple images are imported, displays the image next to the currently displayed one.

Show command bar 
When turned on, displays the command bar of the [Sub View] palette.

Show Rotate/Invert on the command bar
When turned on, displays icons related to rotating and flipping on the command bar of the [Sub View] palette.

Hide sub view palette
Hides the [Sub View] palette.

It is not possible to set when [Show command bar] is turned off.

To show the Sub View palette again, select the palette from the [Window] menu > [Sub View]. If you are using a 

Smartphone, tap the icon on the palette bar.

Show command bar: OFF Show command bar: ON

Command bar
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Material Palettes
These palettes manage a variety of materials used for drawing illustrations and manga. The materials can be 

dragged and dropped to the canvas for use.

The Material palettes are displayed from [Window] menu > [Material].

 Characteristics and Types of Materials

 Functions of Material Palettes

 Using Materials

 Registering a Material [PRO/EX]

 Searching for a Material
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Material Palettes

 Characteristics and Types of Materials
This section describes the characteristics and types of materials included in Clip Studio Paint.

Characteristics of Materials
Materials registered to the Material palette can have the following characteristics.

 Some materials are 3D data. The orientation and size of 3D materials can be changed after being imported to the canvas.

 Materials can be used directly by dragging and dropping to the canvas.

 Importing a material to the canvas creates a layer. Each material has its layer stacking order configured. For example, importing a back-

ground material creates a layer at the bottom of the layers or layer folder.

 Some materials come with preconfigured size and tiling layout. When imported, their size are automatically adjusted to fit the canvas or 

frame border.

Types of Materials
Clip Studio Paint comes with the following Material palettes by default.

Tree view folder Layer type Contents

Color pattern Image material layer
Includes color patterns, background images, texture images and 

the like.

Monochromatic pattern Image material layer
Includes monochrome patterns, background images, texture 

images and the like.

Manga material

Framing template Frame border folder Includes templates composed of multiple frame border folders.

Balloon Text/Balloon layer Includes materials for balloons.

Effect line Image material layer Includes image materials for effect lines.

Sound effect Image material layer Includes image materials for sound effects.

Signs Image material layer Includes image materials for signs.

Image material Image material layer

Includes illustration materials such as buildings, flowers and dec-

oration.

Also includes image materials for brush tips.

3D

Body shape 3D layer Includes body shape data for 3D drawing figure material.

Pose 3D layer
Includes pose data for 3D character material, pose model material 

and 3D drawing figure material.

Character 3D layer
Includes 3D character materials. Orientation, facial expression 

and the like can be adjusted with the Tool Property palette.

Small object 3D layer
Includes small 3D object materials. Orientation, size and the like 

can be adjusted with the [Object launcher].

Background 3D layer

Includes 3D background materials. Orientation, size, layout, 

color (texture) and the like can be adjusted with the Tool Property 

palette.
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All materials - Displays all materials included.

Download -
The portal application Clip Studio will open and display materi-

als downloaded from Clip Studio Assets.

 To download materials to the Material palette from Clip Studio Assets, launch the portal application Clip Stu-

dio.

 Clip Studio Assets can be launched from [Search for Additional Materials] in the Material palette.

Tree view folder Layer type Contents
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 Functions of Material Palettes
This section describes the functions of the Material palette.

A. Search for materials on ASSETS
Click to launch the portal application Clip Studio which will show Clip Studio Assets. Materials published in Clip Studio ASSETS can be 

downloaded to Clip Studio Paint.

B. Tree View
Displays the Material palettes hierarchically. Double clicking the folder or folder name part expands the sub-folders.

The portal application Clip Studio will open and materials downloaded from Clip Studio Assets will be registered 

to the [Download] folder.

A

B

C

D

E

F

G
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C. Show command bar for material folders
Adds or deletes a Material Folder from the [Tree View].

(1) Create Material Folder

Creates a new folder in [Tree view].

(2) Rename Material Folder 

Renames the selected folder in [Tree view].

(3) Delete Material Folder

Deletes the selected folder in [Tree view].

D. Tag List
Displays tags assigned to materials as a list of buttons. It also allows for keyword input to search for a material.

(1) Search box

Enter a keyword to search for a material registered in the open Material palette.

(2) Tag list

A list of tags assigned to materials displayed as buttons. Clicking a button displays the included materials in [Material list]. [Type] are tags 

automatically attached to Materials depending on how they were obtained. [Default tags] are tags automatically attached to Materials 

depending on their type. User tags are tags attached to Materials.

 The portal application Clip Studio will open and materials downloaded from Clip Studio Assets will be regis-

tered to the [Download] folder.

 Clip Studio Assets can be launched from [Search for Additional Materials].

 Drag vertically while pressing the space bar to scroll through the tree display.

Default folders cannot be renamed.

 Default folders cannot be deleted.

 Deleting a folder deletes the materials inside.
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E. Material List
Displays the list of materials registered in the open Material palette.

A listed material can be selected from the list and pasted to the canvas by either of the methods below.

 Drag and drop the thumbnail to the canvas

 Drag and drop the thumbnail to the Layer palette

 Select the thumbnail and click [Paste material] of [Command Bar]

 Drag vertically while pressing the space bar to scroll through the tag list.

 User tags can be added from the [Material property] dialog box. Shows the [Material property] dialog box from 

the Command Bar’s [Material property].

 A cloud icon with an arrow may be displayed in the top right corner of the material. This icon is displayed if the 

material data only exists in the cloud. A confirmation message is displayed when you drag and drop the mate-

rial to the canvas. Click [Yes] to open Clip Studio and start downloading the material. After downloading, the 

material can be used as normal. 

 Some materials may have a “no” icon (circle-backslash symbol) in the top right corner. This icon will be 

shown on materials that cannot be used in your version of Clip Studio Paint. Click the icon to show the reason 

why the material cannot be used in Clip Studio Paint.

 Hover the mouse over the thumbnail of a material downloaded from Clip Studio Assets to display the icon at 

the top-right of the material. Click this to launch Clip Studio Assets and display the material information.

 When the selected material is a sub tool, you can import the sub tool by dragging and dropping to the Sub 

Tool palette.

 When the selected material is a color set, you can import the color set by dragging and dropping to the Color 

Set palette.

 If the selected material is an auto action set, the auto action set can be loaded to the Auto Action palette by 

dragging and dropping the material.

 Drag vertically while pressing the space bar to scroll through the material list.

 Materials registered to [Favorites] will show an icon before the Material name.
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F. Detailed Information of Material
Displays information on the material selected on the [Material list]. It also allows for configuring toning settings for the selected material.

(1) Material info. view

Displays information on the material selected on the [Material list].

(2) Toning [PRO/EX]

When turned on, pasting the material selected on the [Material list] to the canvas displays the material in black and white halftone dots 

(toned).

Clicking [Settings of toning] opens the [Simple tone settings] dialog box. On the dialog box, you can configure settings related to toning in 

detail. The configured settings are previewed in the lower part of the palette.

G. Command Bar
You can use the command bar to adjust how materials are displayed. The commands here also help to organize your materials.

(1) Show item checkbox

Shows a checkbox for each thumbnail of the materials shown in [Material list]. You can select a material by turning on the checkbox.

(2) View Material Details

Displays/hides the material details.

(3) Thumbnail [Large]

Shows the large thumbnails of the materials shown in [Material list].

(4) Thumbnail [Small]

Shows the small thumbnails of the materials shown in [Material list].

(5) Thumbnail [Detail]

Shows the thumbnails as well as information of the materials shown in [Material list].

(6) Paste material

Pastes the material selected on the [Material list] to the canvas.

(7) Swap material

Replaces the material pasted on the canvas with that selected in the [Material list].

 For details on the [Simple tone settings] dialog box, see "Simple tone settings Dialog Box [PRO/EX]".

 With the Layer Property palette, tone settings can be changed even after the material is pasted to the canvas. 

For details, see "Layer Property Palette [PRO/EX]".

 If the selected material is a sub tool, import to the Sub Tool palette.

 If the selected material is a color set, import to the Color Set palette.

 If the selected material is an auto action set, the auto action set can be loaded to the Auto Action palette.
CLIP STUDIO PAINT Instruction Manual 1039



Material Palettes  > Functions of Material Palettes
(8) Material property [PRO/EX]

Selecting and clicking a material on the [Material list] opens the [Material property] dialog box.

On the dialog box, you can configure settings such as name, content, paste operation, save destination, tag for search and the like for the 

material.

(9) Add to Favorites

Selecting a material on the [Material list] registers it to the [Favorites] Folder. An Favorites icon will be also be added to the Material 

name.

You can now use Materials registered in the [Favorites] Folder from other folders as well.

If a registered material inside the [Favorites] Folder is already selected, it will be unregistered.

(10)Delete material

Deletes the material selected on the [Material list].

For details on how to swap materials, see "Swapping a Pasted Material".

 The [Material property] dialog box also opens when the thumbnail of the material on the [Material list] is dou-

ble clicked.

 For details on the [Material property] dialog box, see "Material property Dialog Box [PRO/EX]".

[Add to Favorites] can also be accessed from Clip Studio’s [Manage materials].
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Simple tone settings Dialog Box [PRO/EX]

(1) Frequency

Specify the number of screentone lines per inch. The larger the value, the smaller will be the halftone dot.

(2) Density

Configure the method for specifying the tone density.

(3) Type

Select the shape of the tone from [Circle], [Square], [Lozenge], [Line], [Cross], [Ellipse], [Noise], [Sugar plum], [Asterisk], [Star], [Car-

rot], [Cherry (round)], [Cherry (mid)], [Cherry (thin)],  [Flower (round)], [Flower (mid)], [Flower (thin)], [Clover (round)], [Clover 

(thin)], [Ninja star], [Diamond], [Heart], [Clubs], and [Spades].

(4) Angle

Configure the angle of the tone (halftone dot).

(5) Size

Configure the noise size. You can configure this item when Noise is selected for [Type].

(6) Factor

Configure the noise factor. You can configure this item when Noise is selected for [Type].

Use color of image Configures the tone density based on the image color.

Use brightness of image Configures the tone density based on the image brightness.

When the material is a [Fill in monochrome] layer, [Density] must be specified numerically.
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Material property Dialog Box [PRO/EX]
The following describes the [Material property] dialog box.

(1) Material name

Enter a name for the material.

(2) Material image

This is thumbnail that will be shown in the Material palette. Click [Select file] to open a dialog box where you can select an image file to 

be used as the thumbnail.

[Material details] and [Scale up/down] can be configured only when registering only one raster layer or image 

material layer without layer mask and without rulers.

File formats that can be used for thumbnails are: BMP, JPEG, PNG, TIFF and Targa.
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(3) Material settings for brush

Turn on this item when using the material as material for brush.

You can configure [Use for brush tip shape] and [Use for paper texture].

(4) Video thumbnail

Displayed for animation materials. In addition to normal thumbnails, animation materials can be registered as a video thumbnail. Clicking 

the item displays the [Video thumbnail] dialog, where you can play videos for the material to be registered as a thumbnail.

(5) Scale up/down

Configure the size when the material is pasted.

 For details on [Brush tip shape], see the “Clip Studio Paint Tool Setting Guide” > Brush shape.

 For [Paper texture], see the “Clip Studio Paint Tool Setting Guide” > “Brush shape” > “Texture.”

Adjust after pasting Displays handles to adjust the size when the material is pasted.

Expand in full
The material is pasted in such a size as to completely cover the destination. This setting is 

suitable for backgrounds.

Fit to scale
The material is pasted in such a size as to fit completely into the destination. This setting is 

suitable for sound effects and the like which must fit completely.

Adjust according to destina-

tion

The material is enlarged or reduced in accordance with the size of the destination. This setting is 

suitable for materials such as illustrations, where only a portion of the material is arranged.

Fit to text
It allows for materials to be enlarged or reduced in accordance with the size of a text present at 

the position where the material will be pasted.

If the destination is a frame border folder, the image is resized in accordance with the size of the frame border for 

pasting.
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(6) Tiling

When turned on, the material is arranged as a tile when pasted. Specify the repeat type and direction of tiling with the pull down menu.

Tiling

From the pull down menu, specify the repeat type when tiling images.

Tiling direction

From the pull down menu, specify the direction when tiling images.

(7) Specify overlay

Specifies where the pasted material will be inserted in the Layer palette.

When turned off, a new layer is created above the currently edited layer, and the material pasted to the new layer.

When turned on, you can specify with a slider the position where to insert the layer with the material.

(8) Location to save material

Click a folder to specify the location to save the material. The specified location is reflected in the tree view of the Material palette.

(9) Search tag

Click the tag list to specify the search tag to be displayed on the [Tag list].

Clicking the tag with a + sign in the lower right will allow you to create a new tag.

Vertical and horizontal The image is arranged vertically and horizontally.

Only horizontal The image is arranged only in the horizontal direction.

Only vertical The image is arranged only in the vertical direction.

Repeat Reverse Flip

Vertical and horizontal Only horizontal Only vertical
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Material Palette Menu
This section describes the functions listed in the palette menu that appears when you click the menu icon at the upper left corner of the Material 

palette.

Register image as material [PRO/EX]
Converts an image within a selected area or selected layer into a material. Converted materials are registered to the Material palette.

Material Folder > New Folder
Creates a new folder in [Tree view].

Material Folder > Delete
Deletes the selected folder in [Tree view].

Material Folder > Change name
Renames the selected folder in [Tree view].

Select with checkbox
Shows a checkbox for each thumbnail of the materials shown in [Material list]. You can select a material by turning on the checkbox.

Paste material to canvas
Pastes the material selected on the [Material list] to the canvas.

Swap material
Replaces the material pasted on the canvas with that selected in the [Material list].

Material property [PRO/EX]
Shows the [Material property] dialog box of the selected material in [Material list].

On the dialog box, you can configure settings such as name, content, paste operation, save destination, tag for search and the like for the mate-

rial.

 Default folders cannot be deleted.

 Deleting a folder deletes the materials inside.

Default folders cannot be renamed.

For details on how to swap materials, see "Swapping a Pasted Material".

Show menu
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Add to Favorites
A selected material on the [Material list] registers it to the [Favorites] Folder on the [Material list]. An Favorites icon will be also be added to 

the Material name.

You can now use Materials registered in the [Favorites] Folder from other folders as well.

If a registered material inside the [Favorites] Folder is already selected, it will be unregistered.

Delete Material
Deletes the material selected on the [Material list].

View
Select the thumbnails shown in [Material list] from [Detail], [Large thumbnail], and [Small thumbnail].

Sorting
You can sort materials in the material list by the following attributes: Title, Date Added, and Material Folder. You can sort by ascending or 

descending.

View Material Details
Displays/hides the [Detail Information of Material].

Show command bar
Shows/hides the Command Bar.

Show command bar for material folders
You can now Show or Hide the command bar for material folders.

Show materials that cannot be used
Choose whether to display or hide materials that cannot be used in your version of Clip Studio Paint. When this is off, materials that cannot be 

used will be hidden from the list of materials.

Hide material [...] palette
Hides the open Material palette.

When you hover the cursor over a material that cannot be used in Clip Studio Paint, a “no” icon (circle-backslash 

symbol) will appear. Click the icon to show the reason why the material cannot be used in Clip Studio Paint.

To display again the Material palette you have hidden, select the palette from [Window] menu > [Material].
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Operating the Tree View
To edit the [Tree view] folder, proceed as follows.

Adding a Folder to the Tree View
Select the folder and right click to display the menu. Selecting [New Folder] from the menu creates a new folder in the selected folder.

Deleting a Folder from the Tree View
Select the folder and right click to display the menu. Select [Delete] from the menu. Clicking [Yes] on the dialog box confirming deletion 

deletes the selected folder.

 Default folders cannot be deleted.

 Deleting a folder deletes the materials inside.
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Renaming a Folder in the Tree View
Select the folder and right click to display the menu. Select [Change name] from the menu to change the name of the selected folder.

Moving a Folder in the Tree View
To move a folder, select the folder and drag and drop it to the desired position.

Default folders cannot be renamed.

Default folders cannot be moved.
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Moving Materials of Another Folder
To move a material to another folder, select the material on the [Material list] and drag and drop it to the other folder on the [Tree view].
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 Using Materials
This section describes how to paste and edit materials.

Pasting Materials
The way to import a material varies depending on the selected material.

In DEBUT, some functions are restricted.

 Materials in [Balloon]/[Framing template] are converted and imported into the [Image material] layer.

 Materials with [Toning] set to [Fill in monochrome] are converted and imported into the [Raster Layer]. Other 

materials with [Toning] set are imported with [Toning] unchecked.

 Materials in [Gradient layer] cannot be imported.

 Materials that are distributed via Clip Studio Assets can only imported if supported in DEBUT.

A cloud icon with an arrow may be displayed for a material when using the Clip Studio cloud. This icon is dis-

played if the material data only exists in the cloud. A confirmation message is displayed when you drag and drop 

the material to the canvas. Click [Yes] to open Clip Studio and start downloading the material. After downloading, 

the material can be used as normal.
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Image Materials
Image materials can be pasted by dragging them from the Material palette to the canvas.

 Materials can also be pasted to the canvas by clicking [Paste material] on the Material palette.

 You can also paste materials to the canvas by dragging and dropping the thumbnail to the Layer palette.

 Selecting multiple materials and dragging and dropping them to the canvas, allows you to paste them in one 

go.

 When using Windows/macOS, image materials can be pasted onto the canvas via the [Material list] in Clip Stu-

dio in the same way.
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For Animation Materials [PRO/EX]
Animation materials registered in a palette are pasted by dragging from the Material palette and dropping to the canvas.

1 Select the frame
Select the frame from which to start the animation material in the Timeline palette.

2 Pasting an Animation Material
Drag and drop an animation material from the Material palette to the canvas.

3 Pasting an Animation Material
The animation material is pasted to the canvas and the Timeline palette.
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Sub Tools
You can import materials to the Sub Tool palette by dragging and dropping them.

 Animation materials cannot be pasted if the timeline is disabled.

 If the frame rate of the registered material is different from the frame rate of the canvas where the material is 

pasted, the playback time of the animation material is maintained when pasting the material. The number of 

frames in the animation material may change as a result.

 When using Windows/macOS, the sub tools can be imported into the palette via the [Material list] in Clip Stu-

dio in the same way.

 Selecting multiple sub tool materials and dragging and dropping them on the palette allows you import them 

to the palette in one go.

 You can also import sub tool materials from the Sub Tool palette menu.

 Some sub tools cannot be imported to DEBUT.
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Color Sets
Color sets can be imported to the Color Set palette by dragging and dropping.

 When using Windows/macOS, color sets can be loaded into the palette from the [Material list] in Clip Studio in 

the same way.

 Selecting multiple color set materials and dragging and dropping them to the palette allows you import them 

to the palette in one go.

 You can also import color sets with the [Import color set material] option in the Color Set palette menu.

 Some color sets may not be imported in DEBUT depending on their content.
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Auto Action Sets [PRO/EX]
To import an auto action set, drag and drop the material to the Auto Action palette.

 When using Windows/macOS, Auto action sets can be loaded into the palette from the [Material list] in Clip 

Studio using the same operation.

 Selecting multiple auto action set materials and dragging and dropping them to the palette allows you import 

them to the palette in one go.

 Even when executing [Import material set] from the Auto Action palette, auto action materials can be loaded to 

the Auto Action palette.
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Gradient set [PRO/EX]
To import a gradient set, select a gradient set from the Material palette and click [Paste material].

 Gradient set materials can also be imported from the [Gradient Map] dialog. For details, see "[Gradient map] 

dialog box".

 Multiple gradient sets can be batch imported by selecting the gradient set materials and clicking [Paste mate-

rial].
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For workspaces [PRO/EX]
Workspaces can be loaded from the Material palette.

1 Select the material
You can select a workspace from the Material palette and drag and drop it to the canvas.

2 Select the items to load
The [Workspace import settings] dialog box is displayed. In the dialog box, specify the items other than the palette layout you want to 

load.

(1) Specify items to load.

(2) Click [OK].

 In macOS, workspaces cannot be loaded when the canvas is not open.

 When using Windows/macOS, workspaces can be loaded into the palette from the [Material list] in Clip Studio 

using the same operation.

 The [Register Workspace] dialog box is displayed if a workspace is not applied to the main window. In this 

case, enter a [Name] and click [OK]. The state before a workspace was loaded is registered as a workspace. 

For how to register a workspace, see "Register Workspace [PRO/EX]".

For the [Workspace import settings] dialog box, see "Workspace import settings [PRO/EX]".
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3 The workspace is loaded
A confirmation message is displayed before the workspace is loaded.

(1)  Click [OK] in the message that is displayed.

(2)  The palette layouts and settings in the workspace material are reflected in the main window.

The workspace loaded from the Material palette is registered to the [Window] menu > [Workspace] at the same time. This workspace can 

be loaded later by selecting this command.
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Swapping a Pasted Material
A material pasted on the canvas can be replaced with another material.

1 Select the layer
On the Layer palette, select the layer with the material you want to replace.

 Selecting multiple workspaces and dragging and dropping them into the palette allows you to register multiple 

workspaces to the [Window] menu at once. Only one workspace is applied to the main window.

 The palette layout of a workspace material may not be applied as expected if the display environment of the 

place where the workspace is loaded is significantly different from the place where it was registered.

To replace a material, the selected layer must meet the following conditions:

 Only one layer is selected.

 The selected layer is none of the following: Correction layer, Paper layer, 3D layer, Frame border folder, Layer 

Folder.

 The layer is not locked. If the layer is inside a layer folder, the layer folder is not locked.

 The layer is visible. If the layer is in a layer folder, the layer folder is not hidden.

If a Quick Mask or Selection layer is selected, it will be converted to a Layer Mask after the replacement.
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2 Select the material to replace
On the Material palette, select the material.

3 Replace the material
Clicking [Swap material] on the Material palette replaces the pasted material.

The selected material must meet the following conditions:

 It is an image material.

 The material consists of one layer.

 The material is not stored inside a layer folder.

 Only one material is selected in the Material palette.

Click
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Editing Materials
The way to edit imported materials varies depending on the layer type of the material.

You can also replace by dragging and dropping the selected material on the corresponding layer of the Layer pal-

ette.

Layer type Editing a Saturated Line

Image material layer See "Import".

Frame border folder See "Editing a Comic Frame".

Text layer See "Explanation: Balloons and Text".

3D layer See "Explanation: 3D Materials".

Animation Materials See "Operating the Timeline Palette".

For details on the layer type of each Material palette, see "Types of Materials".
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 Registering a Material [PRO/EX]
This section describes how to register a material to the Material palette.

Registering a Material from the Canvas
To register an image selected on the canvas to the Material palette, proceed as follows.

1 Select the image
With a marquee tool, select the image to convert into material.

 For details on how to install materials downloaded at the time you purchased Clip Studio Paint, see the Clip 

Studio Paint Installation Guide. This can be found on the download website of Clip Studio Paint.Registered 

materials can be uploaded to the Clip Studio cloud using the portal application Clip Studio. For details on 

uploading methods, please see Clip Studio TIPS.

 Clip Studio can be launched via the [File] menu ([CLIP STUDIO PAINT] menu on macOS and Tablet) > [Open 

CLIP STUDIO].

If there is no selection, the drawing on the canvas will be registered to the Material palette.
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2  Select the command
Click [Palette menu] on the Material palette, and select [Register image as Material].

3 Configure the material
The [Material property] dialog box will open. Configure the settings for the material on the dialog box.

(1) You can configure settings such as name, content, paste operation, save destination, and tag for search for the material.

(2) Click [OK].

You can also select command from [Edit] menu > [Register Material] > [Image].

For details on the [Material property] dialog box, see "Material property Dialog Box [PRO/EX]".

Show menu
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4 The conversion of image into material is complete
The dialog box closes and the material is registered in the Material palette.

Registering a Layer as Material
To register a layer from the Layer palette or Search layer palette as a material, proceed as follows.

1 Select the layer
On the Layer palette or Search Layer palette, select the layer to convert into a material.

When multiple layers are selected and registered, they are registered to the Material palette with the layer struc-

ture kept.

Creating a selection registers the drawing in the selected area to the Material palette.

If there is no selection, the drawing on the canvas will be registered to the Material palette.
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2  Select the command
Click [Palette menu] on the Material palette, and select [Register image as Material].

3 Configure the material
The [Material property] dialog box will open. Configure the settings for the material on the dialog box.

(1) You can configure settings such as name, content, paste operation, save destination, and tag for search for the material.

(2) Click [OK].

 You can also select command from [Edit] menu > [Register Material] > [Image].

 An image can also be registered as material by dragging and dropping the selected layer to [Material list] in 

the Material palette. When registered in this way, the [Material property] dialog box does not display.

For details on the [Material property] dialog box, see "Material property Dialog Box [PRO/EX]".

Show menu
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4 The conversion of image into material is complete
The dialog box closes and the layer material is registered in the Material palette.

Register Layer as Template Material
This section describes how to register a template material to the Material palette.

1 Creating the Layer Configuration
Create the layer configuration to be registered as a template.

2  Select the command
Select the [Edit] menu > [Register Material] > [Template].

 All layers on the canvas are registered in the template material. Delete any layers that are not needed.

 When a canvas composed of [Frame border folders] only is registered, it is registered as a [Framing template]. 

In all other cases, the canvas is registered as [Layer template]. Either material, [Framing template] or [Layer 

template], may be used as template.
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3 Configure the material
The [Material property] dialog box will open. Configure the settings for the material on the dialog box.

(1) Configure the name, content, save destination and search tag for materials.

(2) Click [OK].

4 Registration of the template material is completed
The dialog box closes and the template material is registered in the Material palette.

For details on the [Material property] dialog box, see "Material property Dialog Box [PRO/EX]".
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Register animation material
This section describes how to register an animation material to the Material palette.

1 Select the track
Select the clip to be registered as an animation material in the Timeline palette.

2  Select the command
Select the [Edit] menu > [Register Material] > [Animation].

3 Configure the material
The [Material property] dialog box will open. Configure the settings for the material on the dialog box.

(1) Configure the name, content, save destination and search tag for materials.

(2) Click [OK].

Animation materials cannot be registered if the timeline is disabled.

 If you do not select a clip, the currently selected track is registered as an animation material.

 If tracks or clips have 2D camera folders or keyframes set to them, these settings will also be reflected in the 

animation material.

 Audio tracks and audio clips can also be registered as animation materials.
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4 Registration of the animation material is completed
The dialog box closes and the animation material is registered in the Material palette.

Register Workspace
This section describes how to register a workspace to the Material palette. A workspace is the palette layout including shortcut settings, com-

mand bar layout and preferences for unit settings.

1 Decide the layout of palettes
Lay out the palettes. Configure the shortcut settings, command bar layout and preferences for unit settings to the state in which you want 

to register them.

For details on the [Material property] dialog box, see "Material property Dialog Box [PRO/EX]".
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2  Select the command
Select the [Window] menu > [Workspace] > [Register workspace as material].

3 Configure the material
The [Material property] dialog box will open. Configure the settings for the material on the dialog box.

(1) Configure the name, content, save destination and search tag for materials.

(2) Click [OK].

 To learn how to set up shortcuts, see "Shortcut Settings [macOS/Tablet]".

 For information on the Command bar layout, see "Command bar settings [Windows] [PRO/EX]".

 For details on Preferences > Unit settings, see "Ruler/Unit".

The [Register Workspace] dialog box is displayed if a workspace is not being used. A workspace with the same 

settings is registered to the [Window] menu > [Workspace] at the same time that the material is registered.

For details on the [Material property] dialog box, see "Material property Dialog Box [PRO/EX]".
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4 The registration of the workspace is complete
The dialog box closes and the workspace material is registered in the Material palette.

Registering a Sub Tool
To register a sub tool, use [Register sub tool as material] on the Sub Tool palette menu.

Registering a Color Set
To register a color set, use [Register color set as material] on the Color Set palette menu.

Registering an Auto Action Set
To register an auto action set, use [Register set as material] on the Auto Action palette menu.

A sub tool can also be registered as a material by dragging the sub tool from the Sub Tool palette and dropping it 

to the [Material list] in the Material palette. When registered in this way, the [Material property] dialog box does not 

display.

Show menu

Show menu

Show menu
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 Searching for a Material
Search for a material is possible from the [Search box] or the [Tag list].

Searching from the Search Box
Enter a keyword to search for a material registered in the open Material palette.

Regarding the Keyword
 Input a material name or tag name for keyword.

 Words matching partly to the keyword can also be searched.

 Words including spaces can be searched by enclosing them between double quotation marks (").

 Search is not sensitive to hiragana and katakana.

Specifying Multiple Keywords
Specifying multiple keywords using space as separator will allow you to narrow down the search results.

For example, assuming that there are two materials having "smile" in its name, and that

The [Tag] of one of them contains "male" and that of the other contains "female",

Inputting "smile" displays both materials in the results. Inputting "smile female" displays only the material with "smile" in its [Material name], 

and "female" in its [Tag] in the results.

Searching from the Tag List
Turning on a button on the [Tag list] displays materials with the same tag on the [Material list].

The [Search box] and [Tag list] can be used combined for searching.

To clear the search conditions, use [Show all the materials in the folder] inside the [Material list].

To clear the conditions for searching the tag list, proceed as follows:

 Click the button again.

 Click [Show all the materials in the folder] inside the [Material list].

Search box

Tag list
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All Sides View Palette 
[EX] 
A palette for displaying 3D materials on 3D layers from four directions.

The All sides view palette is displayed from [Window] menu > [All sides view].

 Features of the All Sides View Palette

 Operating the All Sides View Palette



All Sides View Palette [EX]  > Features of the All Sides View Palette
All Sides View Palette [EX] 

 Features of the All Sides View Palette
A palette for displaying 3D materials on 3D layers from four directions. When a 3D material is placed on the layer, it can
be viewed from four directions at the same time.

The camera position and focal point position of the 3D layer can also be changed. When the camera position is
changed in the All Sides View palette, the new position is reflected on the canvas. The camera position can also be
changed on the canvas and applied to the All Sides View palette.

(1) All sides view

The view window layout displays four different views. Three flat-plane views can be displayed in addition to a perspective view.

The flat-plane views include [Top view], [Bottom view], [Left view], [Right view], [Front view] and [Back view].

Select [View window layout] to change which flat-plane views are shown and their layout.

 The All Sides View palette cannot be used for 3D layers compatible with Ver. 1.5.

 3D materials are only shown in the All Sides View palette if a 3D layer is selected.

 Dragging the border of a view window allows you to change the size of the view.

 To set the same view size for all the view windows, double click the center of the border of the view windows.

 To set the same view height for all the view windows, double click the top or bottom border of a view window.

 To set the same view length for all projections, double click the left or right border of a view window.
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(2) Preview Settings

Turning on [Hide the current side from the designated position] allows you to change the position of the displayed side using the slider.

[View settings] can only be configured for flat-plane views. They cannot be configured for the perspective view.

(3) Select view

Click to display a list of view layouts. You can select a flat-plane view window layout and the views you want to be displayed.

(4) Adapt view to editing target

Adjusts the camera position of the All sides view so that the selected 3D material is at the center of the All sides view.

(5) Make canvas camera reflect perspective view

The camera position, direction and angle of the canvas is reflexed in the perspective view.

 [Adapt view to editing target] is not applied to the perspective view when [Sync perspective view and canvas] 

is turned on.

 This cannot be set if [Camera Object] is selected.

 [Make canvas camera reflect perspective view] cannot be executed when [Sync perspective view and canvas] 

is turned on.

 The [Roll] setting on the Tool Property palette is not applied.

[All sides view] Palette (Front view)

Note: This is an instructional diagram only. It isn’ t displayed on the canvas.

Anything beyond the plane displays 

in the [All sides view] palette.

The section plane moves 

as the slider changes.

Adjust the section position 

with the slider.

Plane
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(6) Make perspective view camera reflect canvas

The camera position, direction and angle of the perspective view is reflected in the canvas.

(7) Show face border edge [Windows/macOS]

When turned on, the face border in the 3D material on the All Sides View palette is displayed. The 3D material display on the canvas is not 

changed.

(8) Sync perspective view and canvas

 When turned on, the camera settings of the perspective view with those of the canvas are synced. When the settings of one camera are 

changed, the new settings are applied to the other camera.

When turned off, the camera settings of the perspective view and canvas can be configured separately.

(9) Always show camera and visible area

When turned on, the [Camera Object] which shows the position and direction of the camera on the canvas, as well as the camera display 

range is displayed.

 [Make canvas camera reflect perspective view] cannot be executed when [Sync perspective view and canvas] 

is turned on.

 The [Roll] setting on the Tool Property palette is set to “0”.

When this is turned on, the settings of the canvas camera are applied to the perspective view camera.

 The camera object and camera display range can also be displayed by selecting [Camera] from the [Object 

List] on the Tool Property palette.

 For details on how to use the [Camera Object], see "Changing the Camera Position".
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Menu of the All Sides View Palette
The following describes the functions included in the menu at the upper left corner of the All Sides View palette.

Adapt view to editing target
Adjusts the camera position of the All sides view so that the selected 3D material is at the center of the All sides view.

Make canvas camera reflect perspective view
The camera position, direction and angle of the canvas is reflexed in the perspective view.

Make perspective view camera reflect canvas
The camera position, direction and angle of the perspective view is reflected in the canvas.

Show face border edge [Windows/macOS]
When turned on, the face border in the 3D material on the All Sides View palette is displayed.

Sync perspective view and canvas
 When turned on, the camera settings of the perspective view with those of the canvas are synced. When the settings of one camera are changed, 

the new settings are applied to the other camera.

When turned off, the camera settings of the perspective view and canvas can be configured separately.

Always show camera and visible area
When turned on, the [Camera Object] which shows the position and direction of the camera on the canvas, as well as the camera display range 

is displayed.

 [Adapt view to editing target] is not applied to the perspective view when [Sync perspective view and canvas] 

is turned on.

 This cannot be set if [Camera Object] is selected.

 [Make canvas camera reflect perspective view] cannot be executed when [Sync perspective view and canvas] 

is turned on.

 The [Roll] setting on the Tool Property palette is not applied.

 [Make canvas camera reflect perspective view] cannot be executed when [Sync perspective view and canvas] 

is turned on.

 The [Roll] setting on the Tool Property palette is set to “0”.

When this is turned on, the settings of the canvas camera are applied to the perspective view camera.

 The camera object and camera display range can also be displayed by selecting [Camera] from the [Object 

List] on the Tool Property palette.

 For details on how to use the camera object, see "Changing the Camera Position".

Show menu
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Revert dividing position to default
Displays the all sides view with all sides in the same size.

Show command bar
When turned on, the command bar of the All Sides View palette is displayed.

Hide All sides view palette
You can hide the All Sides View palette.

To show the All Sides View palette again, select the palette from the [Window] menu. If you are using a Smart-

phone, tap the icon on the palette bar.
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 Operating the All Sides View Palette
The All Sides View palette enables you to change not only the view in the All Sides View palette, but also enables you
to edit the position of the camera and focal point. You can also directly load 3D materials and 3D files.

Changing the All sides View Display
The view of each view window can be changed in the All Sides View palette. You can track views up, down, left and right and scale them up or 

down. This is useful when displaying only a specific area or displaying the entire material when editing 3D materials.

Changing the Display of Flat-Plane Views
When the display of a flat-plane view is changed, the changes are applied to the other flat-plane views. However, the camera position in the 

perspective view and canvas are not changed.

Tracking
Select the [Object] sub tool and drag the mouse cursor in a blank area.

Drag

Moves in the direction dragged.

The other orthographic views 

of the character move to match 

the movement.

The perspective view will not change.
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Scaling Up/Scaling Down
Select the [Object] sub tool, then right-click and drag the cursor in a blank area.

The flat-plane views can also be tracked by the following method.

 Move the mouse cursor to a blank area and hold down the mouse wheel while dragging.

 Drag the [Camera tracking] movement manipulator.

The flat-plane views can also be scaled up or down with the following methods.

 Operate the mouse wheel.

 Drag the [Move camera back and forth] movement manipulator.

Hold down 

the right mouse button 

and drag. 

The other orthographic views 

of the character zoom in as well.

The perspective view will not change.

Zooms in.
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Changing the Perspective View
The perspective view can be changed in the same way as the camera position on the canvas. For details, see "Functions of the Movement 

Manipulator".

If [Sync perspective view and canvas] is turned on, the camera position on the canvas is changed at the same 

time as the perspective view.

Be sure to turn off [Sync perspective view and canvas] to change only the perspective view.
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Changing the Camera Position
The camera position and angle on the canvas can be changed in the All Sides View palette. Use the [Camera Object] and [Focal Point Object] 

in the All Sides View palette to change these.

Displaying the camera object
It is possible to click [Always show camera and visible area] on the All Sides View palette.

The [Camera Object] and [Camera Display Range] are displayed in the All Sides View palette.

Camera Object
It is possible to display the camera position and angle of the canvas. The camera position can be changed by displaying and dragging the 

manipulator.

For details, see "Operating the Camera Object".

 [Rotate camera] and [Snap 3D material to base] cannot be used for flat-plane views.

 Select the [Object] sub tool to change the camera position.

Camera Object

Camera display range
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Camera Display Range
 It is possible to display the range shown by the camera. The area displayed in white on the All Sides View palette is displayed on the canvas.

 The camera object and camera display range can also be displayed by selecting [Camera] from the [Object 

List] on the Tool Property palette.

 [Camera Object] is not displayed in the perspective view when [Sync perspective view and canvas] is turned 

on.

[All sides view] Palette (Top view)

Both the character’ s right hand and the books are outside  

the [Camera Display Range].

Canvas

In the canvas above, the character’ s right hand and the books 

do not display.
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Operating the Camera Object
Click [Camera Object].

The [Camera Object] manipulator and [Focal Point Object] are displayed. The focal point is the point where the camera is looking.

Move the mouse cursor to the [Camera Object] manipulator and drag in the direction in which to move the camera.

 The camera position and angle can also be changed by dragging the [Camera Object].

 The focal point position is not changed by operating the [Camera Object].

 The camera remains directed at the focal point when the [Camera Object] is operated.

Click Manipulator

Focal point

Drag

Dragging the [Camera Object] 

changes the camera angle 

of the canvas.
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Manipulator of the Camera Object

(1) Scroll

Drag along the blue ring. The camera rotates in the direction of the ring, with the same camera position and focal point.

The [Roll] value in the Tool Property palette changes according to the rotation angle.

(2) Rotate Vertically

Drag along the red ring. The focal point is moved at the same time the camera is rotated in the direction of the arrow.

The [Focal point Position] value on the Sub Tool Detail palette changes according to the rotation direction.

(3) Rotate Horizontally

Drag along the green ring. The focal point is moved at the same time the camera is rotated in the direction of the arrow.

The [Focal point Position] value on the Sub Tool Detail palette changes according to the rotation direction.

(4) Controller

Drag the controller (blue circle) to move the camera in the dragged direction while maintaining the focal point position.

The [Camera position] value in the Tool Property palette changes according to the direction of movement.

(5) Move forward/back

When dragged in the direction of the blue arrow, the camera moves in the direction of the arrow while maintaining the focal point position.

The [Camera position] value in the Tool Property palette changes according to the direction of movement.

(6) Move left/right

When dragged in the direction of the red arrow, the camera moves in the direction of the arrow while maintaining the focal point position.

The [Camera position] value in the Tool Property palette changes according to the direction of movement.

(7) Move up/down

When dragged in the direction of the green arrow, the camera moves in the direction of the arrow while maintaining the focal point posi-

tion.

The [Camera position] value in the Tool Property palette changes according to the direction of movement.

Changing the position and angle of the [Camera Object] changes the [Camera] category value on the Sub Tool 

Detail palette. Some items are displayed on the Tool Property palette while operating the [Camera Object].

For details on the [Camera] category, see the “Clip Studio Paint Tool Setting Guide.”
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Changing the Focal Point Position
The focal point is the point where the camera is looking. The Focal Point Object displays a manipulator that can be used to change the focal 

point position. The camera angle changes at the same time the focal point position is changed.

Click the Focal Point Object. A manipulator is displayed for the Focal Point Object.

Move the mouse cursor to the Focal Point Object manipulator and drag in the direction in which to move the focal point.

The Focal Point Object does not appear in the perspective view when [Sync perspective view and canvas] is 

turned on.

Click
Manipulator

Drag

The camera angle of the canvas 

follows the [Focal point].
CLIP STUDIO PAINT Instruction Manual 1086



All Sides View Palette [EX] > Operating the All Sides View Palette > Editing a 3D material
Manipulator of the Focal Point Object

(1) Focal Point Object

When dragged, the focal point moves in the dragged direction.

The camera angle also changes according to the direction of movement.

(2) Move left/right

When dragged in the direction of the red arrow, the focal point moves in the direction of the arrow.

The camera angle also changes according to the direction of movement.

(3) Move forward/backward

When dragged in the direction of the blue arrow, the focal point moves in the direction of the arrow.

The camera angle also changes according to the direction of movement.

(4) Move up/down

When dragged in the direction of the green arrow, the focal point moves in the direction of the arrow.

The camera angle also changes according to the direction of movement.

Editing a 3D material
In the All Sides View palette, you can move 3D materials using the movement manipulators or pose a 3D drawing figure.

Operations are the same as on the canvas. For details, see "Explanation: 3D Materials".

When you move the Focal Point Object, the [Focal Point Position] value on the Sub Tool Detail palette will change 

accordingly.

[Focal Point Position] can be set in the [Camera] or [Layout] category of the Sub Tool Detail palette. For details, 

see the Clip Studio Paint Tool Setting Guide.
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Importing 3D materials and files
3D materials and files can be imported by dragging and dropping the 3D material or file into the All Sides View palette.

3D materials and files imported to the All Sides View palette are also reflected in the canvas.

Supported materials are as follows.

Supported materials

 3D Character Materials

 3D drawing figures (including body shapes)

 3D Object Materials

 3D Background Materials

 Pose materials

Supported files

 CLIP STUDIO 3D character format (extension: cs3c)

 CLIP STUDIO 3D object format (extension: cs3o)

 CLIP STUDIO 3D background format (extension: cs3s)

 Pose files (extension: pep)

 fbx

 6kt

 6kh

 lwo

 lws

 obj

 3D materials compatible with Ver. 1.5 cannot be imported to the All Sides View palette.

 Pose files (extension: pep) and 6kt, 6kh cannot be imported on tablets/smartphones/Macs with Apple M1 

chips.

 FBX files cannot be imported on Android/Macs with Apple M1 chips.

 3D materials and files cannot be imported when QUMARION is enabled.
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History Palette [PRO/EX]
The History palette is a palette for recording and managing operation history.

To display the History palette, select the [Window] menu > [History].

 Functions of History Palette



History Palette [PRO/EX]  > Functions of History Palette
History Palette [PRO/EX]

 Functions of History Palette
The History palette records and manages operation history. Clicking an operation record on the palette allows you to
reverse operations up that point.

Operation history
Displays the operation history chronologically from the oldest one. Clicking the record of the operation up to which to revert, restores the can-

vas to the state immediately after the execution of the clicked record.

Click
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History Palette Menu
This section describes the functions included in the menu that displays when you click [Palette menu] on the upper left corner of the History 

palette.

Hide History palette
Hides the History palette.

 The maximum number of operations that can be recorded in the [Operation history] is determined by the value 

configured in [File] menu > [Preferences] > [Performance] > [Undo levels].

 To clear the [Operation history], select [Edit] menu > [Clear Memory] > [History].

 Dragging vertically through the [Operation History] while pressing the space bar enables you to scroll through 

the [Operation History].

To show the History palette again, select the palette from the [Window] menu. If you are using a Smartphone, tap 

the icon on the palette bar.

Show menuShow menu
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Auto Action Palette [PRO/
EX]
The Auto Action palette is a palette that allows you to record multiple operations and run these operations in 

one go. You can also manage recorded operations.

The Auto Action palette is shown when [Window] menu > [Auto Action] is selected.

 Functions of Auto Action Palette

 Operating the Auto Action Palette
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Auto Action Palette [PRO/EX]

 Functions of Auto Action Palette
The Auto Action palette allows you to record multiple operations and run these operations in one go. The registered
operations can also be run for another canvas.

(1) Switch the set

Click to display a list of auto action sets and switch to the one to use.

(2) Create new set

Click to create a new auto action set. For how to create an auto action set, see "Create the auto action set".

(3) Import material set

The [Import material set] dialog is displayed, and auto action set materials downloaded from Clip Studio ASSETS are imported.

(4) Auto action list

A list of auto actions registered in the auto action set.

(5) Auto action

A setting to record multiple operations and run the recorded operations. Operations can be run by auto action. Click the icon to the left of 

an auto action to show or hide the operations recorded to the auto action.

(6) Command

An operation recorded in the auto action. To show any recorded settings from a dialog box at the time of recording the operation to the auto 

action, click the icon to the left.

(7) Run switch

When turned off (not checked), the relevant command within the auto action is not run.

For details on the [Import material set] dialog box, see "Auto Action Palette Menu".

Drag vertically while pressing the space bar to scroll through the auto action list.
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(8) Change settings switch

When turned on (checked), the dialog box for configuring settings displays at the time the relevant command is run. Once the settings are 

configured, execution of the auto action resumes. When turned off, the settings at the time the auto action was recorded are executed.

(9) Starting and ending the recording of an auto action

Records operations for the added auto action. Clicking again stops the recording.

(10)Play auto action

Click to execute the operations included in the selected auto action. When a certain command within the auto action is selected, commands 

from the selected one onwards are executed.

(11) Add auto action

Add the auto action to the auto action set. For how to add the auto action set, see "Add the auto action".

(12)Delete auto action

Deletes the selected auto action or command.

Auto Action Palette Menu
This section describes the functions included in the menu that appears when you click [Palette menu] on the upper left corner of the Auto 

Action palette.

Button mode
Shows [Auto Action] as a button. Clicking the button enables the auto action for execution.

 Add auto action
Add the auto action to the auto action set.

Delete auto action
Deletes the selected auto action.

 Double clicking a selected auto action also runs the auto action.

 By configuring a shortcut, you can run an auto action just by pressing the shortcut keys. For how to configure 

a shortcut, see "Shortcut Settings [Windows]".

Show menu

Clicking the button enables 

the auto action for execution.

Button mode
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Change auto action
Changes the name of the selected auto action.

Duplicate auto action
Makes a copy of the selected auto action.

Move Auto Action to a different set
If there are multiple auto action sets, the selected Auto Action can be moved to a different auto action set. Select a command and then select the 

auto action set to be moved.

Copy Auto Action to a different set
If there are multiple auto action sets, the selected Auto Action can be copied to a different auto action set. Select a command and then select the 

auto action set to be copied.

Delete command
Deletes the selected command.

Duplicate command
Makes a copy of the selected command.

Create new set
Creates a new auto action set.

Delete set
Deletes the selected auto action set.

Duplicate set
Makes a copy of the selected auto action set.

Settings of set
Renames the selected auto action set.

Switch the set
Allows you to switch the auto action set to be used from the auto action set list.

Start to record auto action
Starts recording the selected auto action. Execution of a command from the menu and the like is recorded in the auto action.

Play auto action
Runs the selected auto action. When a certain command within the auto action is selected, commands from the selected one onwards are run. 

However, commands whose [Run switch] are turned off are not run.

You can also rename an auto action by clicking it.

 You can also start the Auto Action by double-clicking it.

 By configuring a shortcut, you can run an auto action just by pressing the shortcut keys. For how to configure 

a shortcut, see "Shortcut Settings [Windows]".
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Export set
Exports (saves) the content of the current auto action set as an auto action set file (extension: laf).

Import set
Imports an auto action set file (extension: laf) and registers it in the Auto Action palette.

Register set as material
Displays the [Material property] dialog box where you can register the selected auto action set to the Material palette.

[Material property] Dialog Box

(1) Material name

Enter a name for the material.

(2) Location to save material

Click a folder to specify the location to save the material. The specified location is applied to the [Tree view] on the Material palette.

(3) Search tag

Click the tag list and specify a search tag displayed in the [Tag list].

Clicking the tag with a + sign in the lower right will allow you to create a new tag.

Auto action files created with IllustStudio (extension: iaf) and auto action files created with ComicStudio (exten-

sion: caf) cannot be imported.

You can also drag and drop auto action files (extension: .iaf files) into the Auto Action palette to load them.

 Auto action sets registered to the Material palette can be uploaded to the cloud using the portal application 

Clip Studio.

 Clip Studio can be started from the [File] menu ([CLIP STUDIO PAINT] menu on macOS and Tablet) > [Open 

CLIP STUDIO]. For the Smartphone, select [Menu] > [Tutorials / Materials / Files / Support].
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Import material set
The [Import material set] dialog is displayed, and auto action set materials downloaded from Clip Studio ASSETS are imported.

Select the auto action set material you want to load from the [Auto action set list], and click [OK]. The auto action set material is loaded to the 

Auto Action Set palette. When multiple auto action set materials are selected, they can be loaded together.

[Import material set] dialog box

(1) Search box

By entering keywords, auto action set materials can be searched more easily.

(2) Tag list

A list of tags assigned to materials displayed as buttons. When the button is clicked, the auto action set material with the specified content 

will be displayed in the [Auto action set list].

(3) Auto action set list

Displays Auto action set materials downloaded from Clip Studio Assets in a list.

(4) Show item checkbox

A checkbox is shown for each thumbnail of the auto action set material displayed in the [Auto action set list]. You can select a material by 

turning on the checkbox.

(5) Thumbnail [Large]

Displays the thumbnail of the auto action set displayed in [Auto action set list] large.

(6) Thumbnail [Small]

Displays the thumbnail of the auto action set displayed in [Auto action set list] small.

(7) Thumbnail [Detail]

In addition to the thumbnail of the auto action set displayed in the [Auto action set list], information for the auto action set material is 

shown.
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Show the action setting bar 
When turned on, displays the action set bar of the Auto Action palette.

Show command bar 
When turned on, displays the command bar of the Auto Action palette.

Hide auto action palette
Hides the Auto Action palette.

To show the Auto Action palette again, select the palette from the [Window] menu. If you are using a Smartphone, 

tap the icon on the palette bar.

Show action setting bar: OFF Show action setting bar: ON

Action setting bar

Show command bar: OFF Show command bar: ON

Command bar
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Auto Action Palette [PRO/EX] > Operating the Auto Action Palette > Operating the Auto Action Set
 Operating the Auto Action Palette
This section describes how to operate the Auto Action palette.

Operating the Auto Action Set
An "auto action set" is a group of multiple auto actions. You can have multiple auto action sets with auto actions in accordance with the use and 

frequency of use, and use them by switching with the [Switch the set] on the Auto Action palette.

Create the auto action set
To create an auto action set in the Auto Action palette, proceed as follows.

1 Create the auto action set
Click [Create new set] on the Auto Action palette.

2 Configure the auto action set
In the [Create new set] dialog box, enter a name for the set and click [OK].

3 The auto action set is created
The auto action set configured with the [Create new set] dialog box is created in the Auto Action palette.

Switching the auto action set
Select the auto action set from the list displayed by clicking [Switch the set].

To export an Auto Action palette settings, you must export the entire auto action set.

An auto action is added at the time the auto action set is created.
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Auto Action Palette [PRO/EX] > Operating the Auto Action Palette > Operating the Auto Action
Operating the Auto Action
An "auto action" is the settings for recording and running operations. Once you have recorded operations in an auto action, you can automati-

cally run the recorded operations.

Add the auto action
To add the auto action to the auto action set, proceed as follows.

1 Select the auto action set
Select the auto action set to be added with an auto action from the list displayed by clicking [Switch the set].

2 Add the auto action
Add the auto action to the auto action set.

(1) Click [Add auto action].

(2) An auto action is added to the list of auto actions. Input a name for the auto action and press the Enter key.

3 Record operations in the auto action
Record operations in the auto action.

(1) Click [Start to record auto action].

(2) Perform the operations to record in the auto action. Performed operations are displayed as a list of commands in the auto action.

(3) Click [Stop to record auto action]. This ends the recording of operations.

 For tool and sub tool operations, only the movement of layers and selections can be recorded. No other oper-

ations can be recorded. Furthermore, there may be palette and menu operations that cannot be recorded.

 Clicking [Start to record auto action] again allows you to add new commands after the currently selected com-

mand.
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Auto Action Palette [PRO/EX] > Operating the Auto Action Palette > Operating the Auto Action
Run the auto action
To run an auto action and operate the canvas, proceed as follows.

1 Run the auto action
Select the auto action to run, and run.

(1) Select the auto action to run.

(2) Click [Play auto action].

2 The auto action is run
The auto action runs on the canvas.

By configuring a shortcut, you can run an auto action just by pressing the shortcut keys. For how to configure a 

shortcut, see "Shortcut Settings [Windows]".

 When a certain command within the auto action is selected, operations from the selected command onwards 

are run.

 You can also run an auto action by double clicking its name.

 Commands whose [Run switch] are turned off are not run.
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Auto Action Palette [PRO/EX] > Operating the Auto Action Palette > Operating the Auto Action
Changing the order of auto actions and commands
The order in which auto actions are displayed and the order in which commands are run can be changed by drag and drop. The following exam-

ple changes the display order of the auto action, as an example.

1 Select the auto action
On the Auto Action palette, select the auto action whose display order you want to change.

2 Move the auto action
Drag and drop the auto action to the desired position. A red line is displayed in the new position.

3 The change in the order of auto actions is complete
The auto action moves to the dragged and dropped position.

 Clicking auto actions and commands while holding down Ctrl allows you to select multiple auto actions and 

commands.

 Clicking auto actions and commands while holding down Shift allows you to select multiple consecutive auto 

actions and commands.

 In the case of commands, only multiple commands within the same auto action can be selected.

In the case of commands, they can be moved to other auto actions. A red line is displayed at the destination of the 

auto action.
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Information Palette
The Information palette is a palette that allows you to display information such as the workload of the system 

memory and coordinates.

The Information palette displays when [Window] menu > [Information] is selected.

 Functions of Information Palette



Information Palette  > Functions of Information Palette
Information Palette

 Functions of Information Palette
Allows you to display information such as the utilization rate of the system memory and coordinate.

(1) System

Displays the memory load factor for the whole system.

Indicates the "amount of memory used by all applications" over the "amount of memory installed in your computer".

(2) Application

Displays the memory load factor for the application.

Indicates the amount of memory currently used by Clip Studio Paint as a percentage of the available memory. The amount of memory 

available to Clip Studio Paint is configured in [Memory size to use] in [Preferences] > [Performance].

(3) Coordinate information

Displays the position of the mouse cursor on the canvas as the coordinate (X/Y).

(4) Length information

Displays the width (H), height (V), and diagonal line length (L) of the diagram when drawing a diagram such as a rectangle and circle, or 

creating a selection.

When [System] is close to 100%, the performance decreases. Quitting other running applications may lower the 

memory load factor for the system.

When [Application] is close to 100%, the performance decreases. Performing any of the operations below may 

lower the memory load factor for the application.

 Increase [Allocate to application] in the [Preferences] dialog box > [Performance].

 Close unnecessary canvases.

 Perform [Edit] menu > [Clear Memory]. [PRO/EX]

memory load factor for the whole system   ＝ 
amount of memory used by all applications

amount of memory installed in your computer

memory load factor for the application  ＝ 
amount of memory currently used by CLIP STUDIO PAINT

amount of memory available to CLIP STUDIO PAINT
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Information Palette > Functions of Information Palette > Information Palette Menu
Information Palette Menu
The following describes the functions included in the menu that displays when you click [Palette menu] on the upper left corner of the Informa-

tion palette.

Show memory usage
Displays/hides [System] and [Application].

Show coordinate information
Displays/hides the [Coordinate information].

Show length information
Displays/hides the [Length information].

Unit of coordinate/length
Allows you to configure the unit when displaying [Coordinate information] or [Width (H)/height (V)/diagonal line length (L)]. You can select 

from [Fit to unit of canvas], [cm], [mm], [in], [px], and [pt].

Hide Information palette
Hides the Information palette.

To show the Information palette again, select the palette from the [Window] menu. If you are using a Smartphone, 

tap the icon on the palette bar.

Show menu
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Item bank palette
The Item Bank palette is a palette for managing the references, etc. of file object layers used on the canvas.

The Item Bank palette is shown when [Window] menu > [Item bank] is selected.

 Functions of Item bank Palette



Item bank palette  > Functions of Item bank Palette
Item bank palette

 Functions of Item bank Palette
This chapter introduces the functions of the Item Bank palette.

(1) Item list

A list of materials, layers, etc. managed on the canvas. Various materials can be registered by clicking [Register] on the Item Bank palette.

Materials registered in the item list can be loaded on the canvas by dragging and dropping them on the canvas.

The following materials can be managed in the item list.

3D Model

Files in CLIP STUDIO 3D Character format (extension: cs3c), CLIP STUDIO 3D Object format 

(extension: cs3o) or CLIP STUDIO 3D Background format (extension: cs3s) can be registered. 

These can also be registered to the Item Bank palette by loading them from the Material palette or 

from Clip Studio.

Files in fbx, 6kt, 6kh, lwo, lws and obj format can also be registered to the Item Bank palette.

CLIP STUDIO FORMAT

Images in CLIP STUDIO FORMAT (extension: clip). These can be registered to the Item Bank 

palette even when they are loaded as file object layers.

For details on file object layers, see "Create file object".

General image files

General images in BMP, JPEG, PNG, TIFF, Targa, Adobe Photoshop Document (extension: psd) 

or Adobe Photoshop Big Document (extension: psb) format. These can be registered to the Item 

Bank palette even when they are loaded as file object layers.

For details on file object layers, see "Create file object".

Movie file

Allows to register mp4 files. You can register AVI files if using Windows or QuickTime files 

(extension: mov) if using mac OS. These can be registered to the Item Bank palette even when 

they are loaded as file object layers.

For details on file object layers, see "Movie".

Audio file [Windows/

macOS]

Audio files (extensions: wav, mp3, ogg) are supported.

You can also register audio files to the Item Bank palette by importing them through the [File] 

menu > [Import] > [Audio].

When using files in Clip Studio format, general image files and movie files, the reference destinations (paths) are 

managed in the Item Bank palette.
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Item bank palette  > Functions of Item bank Palette
(2) Registering

Select a file in the [Open] dialog and load it in the Item Bank palette.

The files that can be loaded here are the same as the materials that can be managed in the [Item List]. For details, see "(1) Item list".

(3) Settings

You can set names for the materials registered in the Item Bank palette.

In the Item List, select the material for which to change the name and click [Settings] to display the [Item settings] dialog box. Enter a 

name in [Item name] and click [OK] to change the name shown in the Item Bank palette.

(4) Delete

Deletes the material from the Item Bank palette.

In the Item List, select the material to be deleted and click [Delete] to delete the material from the Item Bank palette.

Menu of Item bank palette
This section describes the functions included in the menu that is shown when you click [Show Menu] on the upper left corner of the Item Bank 

palette.

Hide item bank palette
Hides the Item Bank palette.

 3D materials compatible with Version 1.5 (extension: c2fc, c2fr) are not registered to the Item Bank palette.

 6kt and 6kh cannot be imported on tablets/smartphones/Macs with Apple M1 chips.

 FBX files cannot be imported on Android/Macs with Apple M1 chips.

 Audio files cannot be imported if the timeline is not active.

 Materials registered to the Item Bank palette cannot be loaded in other canvases by dragging and dropping.

 Drag vertically while pressing the space bar to scroll through the item list.

When using Windows/macOS/Tablet, you can also drag and drop files into the Item Bank palette to import them.

This changes the name in the Item List, but does not change the layer name or reference file name.

 Materials being used on a canvas cannot be deleted. Delete the material from the Layer palette.

 Materials deleted from the Layer palette are automatically deleted from the Item List.

To show the Item bank palette again, select the palette from the [Window] menu. If you are using a Smartphone, 

tap the icon on the palette bar.
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Explanation: Page Man-
agement [EX]
This chapter describes how to save and edit files managed by page.

 Regarding Management File and Page Files

 Creating a Multi-Page File

 Opening a Multi-Page File

 Page Manager Window

 Operations from the Story Menu



Explanation: Page Management [EX]  > Regarding Management File and Page Files
Explanation: Page Management [EX]

 Regarding Management File and Page Files
EX allows you to store a management file and multiple image files in Clip Studio format (extension: .clip) in an OS
folder and manage them as a multi-page work.

(1) Management folder

The OS folder where the management file and multiple image files in Clip Studio format (extension: clip) are stored.

(2) Management file (extension: cmc)

A file to manage multiple image files in Clip Studio format (extension: clip).

The file takes the name of the [Management folder].

(3) Page file (extension: clip)

The image file in Clip Studio format (extension: clip) of each page. A Clip Studio Paint format file will be stored for each created page.

 When creating a story with multiple pages, do not directly replace page management files (extension: cmc) or 

page files (extension: clip) in the folder from Explorer or the Finder in your OS. The files may become cor-

rupted and not open correctly. Replace pages from the [Story] menu > [Import Page]/[Replace page]. For 

details, see "Import Page"/"Replace page".

 If working in a group of multiple users, use the group work function. For details, see "Group work [Windows/

macOS]".

 Clip Studio Paint format files created in Ver.1.4.4 or earlier (extension: lip) can be saved in Ver.1.5.0 and later 

without changing the extension. However, it will no longer be possible to open the file in Clip Studio Paint 

Ver.1.4.4 or earlier.

Management folder
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Explanation: Page Management [EX] > Regarding Management File and Page Files > File usage in group work [Windows/macOS]
File usage in group work [Windows/macOS]
Files are saved in three or more locations when using the group work function. Group work files other than the standard page management files 

and page files may be created depending on your settings or preferences.

Administrator work folder
Contains files allowing editing and management by the administrator. This folder is created in the administrator's work environment. The fol-

lowing files are added to the administrator work folder.

(1) CollaborateLocal.tclo

A file recording the editing status, etc. of group work data.

(2) Submit

Created if [Do not rewrite over group work data] is turned on. Files reflecting (submitting) changes by users are saved.

User work folders
Contain files allowing editing in users' environments. This folder is created in the users' work environments. The following files are added to 

user work folders.

(1) CollaborateLocal.tclo

A file recording the editing status, etc. of group work data.

Group work data
Files reflecting edited content by the administrator and users. These files are created in a location such as a server shared by the administrator 

and users. The following files are added as group work data.

(1) Collabo

A set of files recording information such as a history of changes reflected in the group work data and information on members are saved.

(2) Submit

Created if [Do not rewrite over group work data] is turned on. Files reflecting (submitting) changes by users are saved.

Do not delete this file during group work. If you delete this file, you will lose administrator authority.

An administrator for group work data cannot be set again later.

For details on [Do not rewrite over group work data], see "Prepare group work data".

Do not delete this file during group work. If you delete this file, you will no longer be able to participate in this 

group work.

Neither the administrator nor users can open group work data directly from Clip Studio Paint.

For details on [Do not rewrite over group work data], see "Prepare group work data".
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Explanation: Page Management [EX]  > Creating a Multi-Page File
 Creating a Multi-Page File
To create a multi-page file, proceed as follows.

Creating from the new dialog box
You can create a multi-page file from the [File] menu > [New].

In the dialog that appears, use the following settings to create a multi-page file.

 For the [Use of work], you can choose [Comic], [Fanzine], or [Show all comic settings].

 Turn on [Multiple pages] and set the number of pages and the binding point.

 For the file name, enter the name of the folder that will store the project files. Then click [Browse] to choose the save location for the folder.

For details on the [New] dialog box, see "New".
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Explanation: Page Management [EX]  > Creating a Multi-Page File
Creating from a single-page file
After opening a single-page file, select the [Story] menu > [Add Page].

The [Create story folder] dialog will appear. You can create a multi-page file with this dialog.

 Enter the name of the folder that will store the project files, then click [Browse] to choose the save location for the folder.

 Also set the binding point and the start page.

You can also open the [Create story folder] dialog to create a multi-page file by selecting the [Story] menu > [Next 

Page].
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Explanation: Page Management [EX]  > Opening a Multi-Page File
 Opening a Multi-Page File
To open a multi-page file, proceed as follows.

1 Select the command
Select [File] menu > [Open]. This opens the dialog box for opening a file.

2 Open the page file
From the dialog box, move to the [Page folder] and specify the management file (extension: cmc) or a page file (extension: clip).

 Specifying a page file (extension: clip) opens the page file of the relevant page.

 Specifying the management file (extension: cmc) opens the [Page Manager] window. Double clicking the page thumbnail opens the 

page file of the relevant page.

Page manager window

Double click
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Explanation: Page Management [EX]  > Opening a Multi-Page File
 Selecting the page file on the [Page Manager] window and then selecting [Story] menu > [Open page] or [Open 

page with new tab] also allows you to open the page file.

 When using Windows/macOS/Tablet, under [File] > [Page] in the [Preferences] dialog box, you can configure 

whether or not to automatically save when switching pages, and how to open files. For details, see "File".
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Explanation: Page Management [EX]  > Page Manager Window
 Page Manager Window
This section describes the names and functions of each part of the [Page Manager] window as well as how to open and
operate the window.

Page Manager Window Functions [Windows/macOS/Tablet]
The names and functions of each part of the [Page Manager] window are as follows.

(1) Story name

Displays the title.

(2) Page list

Each page inside the book is displayed as a thumbnail. It allows you to move a displayed page as well as add/delete a page.

(3) Scale up/down slider

Drag the slider to adjust the display scale of the thumbnails displayed in the [Page Manager] window. Dragging to the right scales up the 

image while dragging to the left scales down the image.

When creating a story with multiple pages, do not directly replace page management files (extension: cmc) or 

page files (extension: clip) in the folder from Explorer or the Finder in your OS. The files may become corrupted 

and not open correctly.

Replace pages from the [Story] menu > [Import Page]/[Replace page]. For details, see "Import Page"/"Replace 

page".

If working in a group of multiple users, use the group work function. For details, see "Group work [Windows/

macOS]".

When using a Smartphone, only the page list is displayed.

For details on how to use the [Page list], see "Page Manager Window Operations".
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Explanation: Page Management [EX] > Page Manager Window > Page Manager Window Functions [Windows/macOS/Tablet]
(4) Zoom out

Clicking zooms out the thumbnails displayed in the [Page Manager] window.

(5) Zoom in

Clicking zooms in the thumbnails displayed in the [Page Manager] window.

(6) Fit to navigator

When clicked, displays the thumbnails displayed in the [Page Manager] window in a size that allows them to fit completely in the window. 

The size of the thumbnails changes in conjunction with that of the [Page Manager] window.

You can also zoom out the [Page Manager] window by selecting the [View] menu > [Zoom out].

You can also zoom in the [Page Manager] window by selecting the [View] menu > [Zoom in].

 Specifying [Fit to Navigator] when the [Page Manager] window is displayed horizontally aligns the thumbnails 

horizontally.

 Specifying [Fit to Navigator] when the [Page Manager] window is displayed vertically aligns the thumbnails 

vertically.

 You can also fit the [Page Manager] window by selecting [View] menu > [Fit to Navigator].
CLIP STUDIO PAINT Instruction Manual 1117



Explanation: Page Management [EX] > Page Manager Window > Window when using the group work function [Windows/macOS]
Window when using the group work function [Windows/macOS]
Icons are displayed in the [Page list] of the [Page Manager] window when using the [Group work] function.

(1) Confliction

This is displayed when multiple edited versions exist for the same page. One edited version needs to be selected for use in the story by per-

forming a function such as [Resolve confliction].

(2) Member (your name)

Displayed for pages you are in charge of.

(3) Name of member

The name of the member in charge of the page is displayed. The displayed member name is the user name entered in [Prepare group work 

data] and [Obtain group work data].

If multiple members are specified, the number of members is displayed.

(4) Not reflected

This is displayed if the edited content of a page in your work folder is not reflected in the group work data.

(5) Member (other user)

Displayed for pages another user is charge of.

For details on the group work function, see "Group work [Windows/macOS]".

Page conflictions can be solved by performing [Resolve confliction]. For details, see "Resolve confliction".

It may only be possible to open pages with this icon, depending on the settings for [Prepare group work data]. For 

details, see "Prepare group work data".

For details on [Prepare group work data] and [Obtain group work data], see "Prepare group work data" / "Obtain 

group work data".
CLIP STUDIO PAINT Instruction Manual 1118



Explanation: Page Management [EX] > Page Manager Window > Opening the Page Manager Window
Opening the Page Manager Window
The [Page Manager] window can be opened by either of the methods below:

 Specify the management file (extension: cmc) in [File] menu > [Open].

 Select [Story] menu > [Page Manager] with a page file open.

Page Manager Window Operations
The functions of the [Page Manager] window and their operation are as follows.

Page File View
Double clicking the page thumbnail opens the page file of the relevant page.

Changed Page File [Windows/macOS/Tablet]
When a page file is changed, an "*" is displayed next to the page number in the [Page Manager] window.

Selecting Multiple Pages
To select multiple pages on the [Page Manager] window, perform as follows:

 To select multiple pages, click the pages while holding down Ctrl.

 To select a group of consecutive pages, click the pages while holding down Shift.
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Explanation: Page Management [EX] > Page Manager Window > Page Manager Window Operations
Moving a Page
Dragging and dropping with a page selected moves the page. You can also select multiple pages to move them at once.
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Explanation: Page Management [EX] > Page Manager Window > Page Manager Window Operations
Duplicate Page
With a page selected, press Alt and drag and drop to duplicate the page. You can also select multiple pages and duplicate them all at once.
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Explanation: Page Management [EX]  > Page Manager Window
Duplicate Pages from other works [Windows/macOS/Tablet]
You can duplicate pages from other works when multiple [Page Manager] windows are open.

Select the page you want to duplicate and drag and drop it to the [Page Manager] window. The page will duplicate in the [Page Manager] win-

dow it was dropped into.

Regarding the Page Manager Window View [Windows/macOS/Tablet]
To zoom in/out and scroll the [Page Manager] window, proceed as follows.

 To zoom in/out the [Page Manager] window view, move the mouse wheel while holding Ctrl.

 To scroll the screen view, drag the [Page manager] window while holding the space bar down.

For how to arrange multiple [Page Manager] windows, see "Canvas Operations". [Page Manager] windows can be 

arranged just like [Canvas] windows.
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Explanation: Page Management [EX] > Operations from the Story Menu > Page Manager Window Operations
 Operations from the Story Menu
When the [Page Manager] window is displayed or a page file is open, you can move the displayed page, add/delete a page as well as configure 

story information from the [Page Management] menu. For details, see "Story Menu [EX]".

The [Story] menu is accessible from the menu that is displayed when you right click on the [Page Manager] win-

dow.
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Explanation: Comic 
Frame Division
[PRO/EX]
This chapter describes the procedures to create, draw inside, and edit comic frames.

 Creating a Comic Frame

 Editing a Comic Frame

 Drawing Comic Frames



Explanation: Comic Frame Division [PRO/EX]  > Creating a Comic Frame
Explanation: Comic Frame Division [PRO/EX]

 Creating a Comic Frame
First, create a new Frame folder over the default border. There are three ways to create a Frame folder.

 "Creating a New Frame Folder"

 "Using Comic Framing Templates"

 "Using the Comic Frame Border Tool"

Creating a New Frame Folder
Select [Layer] menu > [New Layer] > [Frame Border folder] to show the [New frame folder] dialog box.

Set the items in the [New frame folder] dialog box and click [OK]. This creates a new frame folder on the Layer palette with a line drawn on the 

canvas.

Comic Frames can be divided after creating a Frame folder. For details on editing comic Frames, see "Editing a 

Comic Frame".

 For details on the [New frame folder] dialog box, refer to "Frame Border Folder [PRO/EX]".

 You can change the [New frame folder] dialog box’s [Line width] unit type to [mm] or [px] from [Unit of length] 

under [Ruler/Unit] in the [Preferences] dialog box. For details, see "Ruler/Unit".
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Explanation: Comic Frame Division [PRO/EX]  > Creating a Comic Frame
Using a Comic Frame as a Ruler
When [Draw Border] in the [New frame folder] dialog box is turned off, a line will not be drawn. Only a ruler will be created in the Frame 

folder. You can draw lines with the ruler by creating a layer above the Frame folder and drawing on it with a drawing tool.

An advantage of drawing with a ruler is that you can use pen pressure to create varied lines.

We recommend drawing frame lines after dividing comic frames. If you divide a comic frame after you’ve drawn a 

line along with it, the drawn line will remain unchanged. For details on how to divide comic Frames, see "Dividing 

a Comic Frame".
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Explanation: Comic Frame Division [PRO/EX]  > Creating a Comic Frame
Using Comic Framing Templates
Comic [Framing template] from [Manga Materials] on the Material palette can be dragged and dropped onto the canvas. There are multiple 

comic framing templates to choose from starting at [1 frame] and up. When dropped onto the canvas, a new frame folder is added to the Layer 

palette, and a frame line is drawn on the canvas.

 Some comic framing templates already have divided comic frames.

 If you have a particular divided frame template that you frequently use, we recommend registering it as a mate-

rial so that it is easier to reuse. For details, see "Template".
CLIP STUDIO PAINT Instruction Manual 1127



Explanation: Comic Frame Division [PRO/EX] > Creating a Comic Frame > Using the Comic Frame Border Tool
Using the Comic Frame Border Tool
You can use the comic [Frame Border] tool to draw a frame along the default frame.

1 Select the [Frame Border] tool from the Tool palette. Select the [Rectangle frame] sub tool 
from [Create frame] on the Sub Tool palette.

2 Set comic frames for drawing from the Tool Property palette.

 The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previ-

ous version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then 

selecting [Frame Border] on the Sub Tool palette.

 You can transform comic frames by using the [Polyline frame] or the [Frame border pen] sub tool.

 The line thickness can be set from [Brush Size] on the Tool Property palette.

 You can change the Tool Property palette’s [Brush Size] unit type to [mm] or [px] from [Unit of length] under 

[Ruler/Unit] in the [Preferences] dialog box. For details, see "Ruler/Unit".

 For details on the Tool Property palette, see the “Clip Studio Paint Tool Setting Guide.”
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Explanation: Comic Frame Division [PRO/EX] > Creating a Comic Frame > Using the Comic Frame Border Tool
3 Place the mouse cursor by the default border and then drag and drop it onto the canvas.
A new frame folder will be added to the Layer palette, and a frame line will be drawn on the canvas along the default frame.

When you move the mouse cursor near the default frame, you can draw comic frames that snap to the default bor-

der.
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Explanation: Comic Frame Division [PRO/EX] > Editing a Comic Frame > Dividing a Comic Frame
 Editing a Comic Frame
This section describes how to edit frames, etc. based on the frame frames created in "Creating a Comic Frame".

 "Dividing a Comic Frame"

 "Enlarging a Comic Frame (with Bleed)"

 "Changing a Comic Frame’s Thickness, Color, and Line Style"

 "Transforming a Comic Frame"

 "Merging Comic Frames"

 "Deleting Comic Frames"

Dividing a Comic Frame
Divides frames in the comic Frame folder created along the default frame for panel layout.

Dividing Comic Frames with Tools
This section describes how to divide a frames using the [Divide frame folder] sub tool.

1 Select the [Frame Border] tool from the Tool palette. Select the [Divide frame border] sub 
tool from [Cut frame border] on the Sub Tool palette.

2 Set how frames are divided in the Tool Property palette.

 The initial configuration of the sub tools has been changed from Ver.1.5.6. For those who are used to a previ-

ous version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then 

selecting [Frame Border] > [Divide frame border] on the Sub Tool palette.

 When the [Divide frame folder] sub tool is selected, each time a frame is divided, a new frame folder is added 

to the Layer palette.
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Explanation: Comic Frame Division [PRO/EX] > Editing a Comic Frame > Dividing a Comic Frame
(1) Select how frames are divided with [Shape of division]. In this example, [Divide by straight line] is selected.

(2) Set the gaps between frames with [Vertical gutter] and [Horizontal gutter].

3 Drag over the comic frame to divide it.
A preview of the comic frame is displayed as soon as you begin dragging. Leg go when you reach the opposite side of the comic frame.

Dividing a Comic Frame Equally
You can divide comic frames equally using menu commands. This is geared towards the kind of repeating frame division found in 4-frame 

comics.

1 In the Layer palette, select the frame folder you want to divide.

2 Then select [Layer] menu > [Ruler/Frame] > [Divide frame border equally].

 You can change the Tool Property palette’s [Vertical gutter] and [Horizontal gutter] to [mm] or [px] from [Unit of 

length] under [Ruler/Unit] in the [Preferences] dialog box. For details, see "Ruler/Unit".

 If you set the value of [Vertical gutter] and [Horizontal gutter] on the Tool Property palette to 0, you can create 

frame divisions with no space between them.

 For details on the Tool Property palette, see the “Clip Studio Paint Tool Setting Guide.”

Hold down Shift while dragging to divide comic frames in 45 degree increments.

Drag
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Explanation: Comic Frame Division [PRO/EX] > Editing a Comic Frame > Dividing a Comic Frame
3 In the [Divide frame border equally] dialog box you can specify the number of vertical and
horizontal divisions, whether they are fit to the direction of the frames, and how the comic
frame will be divided.

(1) Specify the number of comic frame divisions, the direction of the divisions, and folder structure after division.

(2) Click [OK].

4 The frame is divided according to how the [Split frame equally spaced] dialog box is set.

 For details on the [Divide frame border equally] dialog box, see "Divide frame border equally".

 The set values in the [Preferences] dialog box > [Layer/Frame] > [Vertical gutter] and [Horizontal gutter] are 

reflected in the gaps of the frames. For details, see "Layer/Frame".
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Explanation: Comic Frame Division [PRO/EX] > Editing a Comic Frame > Enlarging a Comic Frame (with Bleed)
Enlarging a Comic Frame (with Bleed)
This section describes how to enlarge a frame border up to the paper edge or adjacent frame border by using handles, which you can use for cre-

ating a frame with bleed.

Click on the comic frame you want to edit on the canvas using the [Operation] tool’s [Object] sub tool.  A bounding box will show around it. 

Clicking on the triangle icon expands the comic frame to the edge of the canvas.

If you don’t want a gap between comic frames, click the triangle icon in the direction you want the gap removed and it will disappear.
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Explanation: Comic Frame Division [PRO/EX] > Editing a Comic Frame > Changing a Comic Frame’s Thickness, Color, and Line Style
Changing a Comic Frame’s Thickness, Color, and Line Style
Click on the comic frame you want to edit on the canvas using the [Operation] tool’s [Object] sub tool.  A bounding box will show around it.

You can change comic frame settings in the Tool Property palette.

Changing a Comic Frame’s Width
You can set the comic frame’s thickness with [Brush Size] on the Tool Property palette.

Make sure that handles and guide lines are displayed on the frame you want edited. This setting displays when a 

frame folder is selected.
CLIP STUDIO PAINT Instruction Manual 1134



Explanation: Comic Frame Division [PRO/EX] > Editing a Comic Frame > Changing a Comic Frame’s Thickness, Color, and Line Style
Changing a Comic Frame’s Color
Set the [Expression color of border] on the Layer Property palette to [Color].

Clicking the [Main color] color icon on the Tool Property palette opens the [Color settings] dialog box. Selecting a color from the [Color Set-

tings] dialog box changes the color of a comic frame’s line.

Changing a Comic Frame Line’s Style
You can change a comic frame line’s style with [Brush shape] on the Tool Property palette.

 If you select [Brush shape] > [Brush tip] and then select the [Material] option on the Sub Tool Detail palette, 

you can register the frame as a brush tip shape in the Material palette. For details, see the Clip Studio Paint 

Tool Setting Guide.

 If you turn off [Draw Border] on the Tool Property palette, only the ruler is created. If you turn on [Snap] in the 

Tool Property palette and switch to another layer, you can draw the frame with a pen tool using varied pen 

pressure.
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Explanation: Comic Frame Division [PRO/EX] > Editing a Comic Frame > Transforming a Comic Frame
Transforming a Comic Frame
Click on the comic frame you want to edit on the canvas using the [Operation] tool’s [Object] sub tool.  A bounding box will show around it.

You can change the comic frame’s size and shape by adjusting the bounding box handles or guidelines. You can also move and rotate the comic 

frame.

Changing a Comic Frame Size
Dragging a handle allows you to change the position of the comic frame lines and transform the entire comic frame size. Any adjacent comic 

frames will also change in size accordingly.

Even if the comic frame is transformed, the layers in the frame folder are not.

To prevent adjacent frames from being linked, set [Keep gutters aligned] to [None] on the Tool Property palette. 

For details on [Keep gutters aligned], see the “Clip Studio Paint Tool Setting Guide.”
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Explanation: Comic Frame Division [PRO/EX] > Editing a Comic Frame > Transforming a Comic Frame
Changing a Comic Frame’s Shape
Dragging a control point of the frame border allows you to transform the frame border together with the vertex.

Rotating a Comic Frame
Dragging the rotation handle allows you to rotate the comic frame.

 You can select multiple control points. For details on how to select, see "Select multiple control points".

 The [Correct line] tool allows you to edit control points and lines. For details on how to use, see "Editing with 

the Correct line Tool".

 Selecting [Edit] menu > [Transform] also lets you scale or freely transform a Frame. For details, see "Trans-

form".

 To prevent adjacent frames from being linked, set [Keep gutters aligned] to [None] on the Tool Property pal-

ette. For details on [Keep gutters aligned], see the “Clip Studio Paint Tool Setting Guide.”

Hold down Shift while dragging to rotate in increments of 45 degrees.
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Explanation: Comic Frame Division [PRO/EX] > Editing a Comic Frame > Merging Comic Frames
Moving a Comic Frame
You can move a comic frame by dragging on it’s lines with the mouse cursor.

Merging Comic Frames
You can merge adjacent comic frames. Select the [Operation] tool’s [Object] Select sub tool. Hold down Shift and click on the comic frames 

you want to merge.

Then select [Layer] menu > [Ruler/Frame] > [Combine frames] to merge them.

 When merging comic frames that are in different frame border folders, the [Combine frames] dialog box will 

display. Select how you wish to merge them and click [OK]. For details on the [Combine frames] dialog box, 

see "Combine frames".

 When merging comic frames that are in different frame border folders, comic frames that are not adjacent to 

each other can also be merged. The frame shape does not change, but it is merged into the same frame border 

folder.

[Shift]+ Click

[Shift]+ Click
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Explanation: Comic Frame Division [PRO/EX] > Editing a Comic Frame > Deleting Comic Frames
Deleting Comic Frames
Click on the comic frame you want to edit on the canvas using the [Operation] tool’s [Object] sub tool.  A bounding box will show around it.

Press Delete to delete the selected frame.

 Make sure that handles and guide lines are displayed on the frame you want to delete. If you only delete a 

comic Frame, the layers in the Frame Border folder will remain.

 If the entire frame border folder is selected, then all the comic frames will be deleted. Follow the instructions in 

the message shown.

 If a frame border folder has been created for each comic frame, a confirmation message appears when delet-

ing the comic frame. Follow the instructions in the message shown.

Click
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Explanation: Comic Frame Division [PRO/EX] > Drawing Comic Frames > Drawing Inside a Comic Frame
 Drawing Comic Frames
You can draw in comic frames effectively by knowing how the layers overlap.

Drawing Inside a Comic Frame
Create a layer in the frame border folder and draw on it.

When drawing on a layer inside a frame border folder, as the comic frame is masked, only the areas within it will be shown.

Even if you draw outside the comic frame, the part that extends beyond it is not shown.

For details on how to create Layers, see "New Layer".

 If you move an outside layer into a frame border folder, any part of your drawing that extends past the comic 

frame will be hidden, but the drawing will not be lost.

 For details on how to draw outside a comic frame, see "Drawing Outside a Comic Frame".
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Explanation: Comic Frame Division [PRO/EX] > Drawing Comic Frames > Drawing Outside a Comic Frame
Drawing Outside a Comic Frame
To draw beyond the comic frame, create a layer above the frame border folder. Layers created above a frame border folder will display anything 

drawn outside the comic frame. The same method can be used when drawing characters that overlap multiple comic frames.

To avoid comic frame lines showing underneath your character, create a layer with white painted in these areas between the line art layer and 

the frame border folder.
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Explanation: Balloons 
and Text
This chapter describes how to create and edit balloons and text.

 Balloon [PRO/EX]

 Text



Explanation: Balloons and Text > Balloon [PRO/EX] > Creating a Balloon
Explanation: Balloons and Text

 Balloon [PRO/EX]
This section describes how to create and edit balloons.

Creating a Balloon
The following describes the procedure to create a balloon and place text in it.

Drawing a Balloon
To draw a balloon by configuring the line width, color and the like, proceed as follows.

1 Select the tool
On the Tool palette, select the [Balloon] tool.

2 Select the sub tool
Open the Sub Tool palette to select a sub tool for drawing the balloon. In this example, [Ellipse balloon] is selected.

3 Configure the tool property
On the Tool Property palette, configure the shape, line width and the like for the balloon.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Text] tool.
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Explanation: Balloons and Text > Balloon [PRO/EX] > Creating a Balloon
4 Configure the balloon's line and color
Configure the sub drawing color as the balloon's color. Configure the main drawing color as the balloon's line color.

5 Drawing a balloon
Drag on the canvas. The balloon is drawn and a balloon layer is created at the same time.

 To add a balloon to an exising balloon layer, select the layer and set [How to add] in the Tool Property palette 

to [Add to selected layer]. In this case, a new layer will not be added. You can also overlap balloon to create a 

series of linked balloons.

 When the Sub Tool Detail palette > [Create balloon] category > [Combine with the text in the drawing area] set-

ting is turned on, drawing a balloon over text will place both text and balloon on the same layer regardless of 

the selected layer and other Sub Tool Detail palette settings. Moving the balloon with the [Object] sub tool also 

moves the text along with it.

Main Color

Sub Color
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Explanation: Balloons and Text > Balloon [PRO/EX] > Creating a Balloon
Attaching a Tail to a Balloon
To add a tail to a balloon, proceed as follows.

1 Select the tool
On the Tool palette, select the [Balloon] tool.

2 Select the sub tool
Open the Sub Tool palette to select a tail sub tool. In this example, [Balloon tail] is selected to create a normal balloon tail.

3 Configure the tool property
Configure the method for drawing the tail, its width and the like.

(1) In [How to bend], set how to draw the balloon tail.

(2) In [Width of tail], configure the tail width at its base.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Text] tool.
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Explanation: Balloons and Text > Balloon [PRO/EX] > Creating a Balloon
4 Draw the tail
How to draw the tail varies depending on the [How to bend] setting.

Straight line

Drag over the canvas from the starting point to the end point.

Polyline

Draw as described below, from the starting point to the end point.

Click the canvas at points (1) to (3) to specify multiple points.

(4) Double clicking at the end point creates a polyline connecting the points specified above.
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Explanation: Balloons and Text > Balloon [PRO/EX] > Creating a Balloon
Spline

Draw as described below, from the starting point to the end point.

Click the canvas at points (1) to (3) to specify multiple points.

(4) Double clicking at the end point creates a curved tail connecting the points specified above.
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Explanation: Balloons and Text > Balloon [PRO/EX] > Editing a Balloon
Editing a Balloon
This section describes how to edit a balloon once created.

Transforming a Balloon
To transform a balloon, proceed as follows.

1 Select the balloon layer
On the Layer palette, select the balloon layer to edit.

2 Select the tool
On the Tool palette, select the [Operation] tool.

3 Select the sub tool
Open the Sub Tool palette and select [Object].

For how to enter text into a balloon, see "Text".
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Explanation: Balloons and Text > Balloon [PRO/EX] > Editing a Balloon
4 Transform the balloon
Handles will appear around the balloon. Drag the handles to transform the balloon.

Control points are also displayed along the lines of balloons, allowing you to transform them.

(1) Click inside the balloon while the handles are visible. Control points will appear on the balloon line.

 If the transformation mode is set to [Free Transform] in the Tool Property palette, you can freely transform the 

balloon by dragging the handles.

 Hold down Shift while dragging a handle during free transformation to move the handle in the direction of the 

frame.

 When scaling, hold down Alt while dragging the handle to scale the balloon around the center point.

 When scaling, hold down Alt while dragging the handle to maintain the original aspect ratio.

If the control points do not appear, change the [Mode] in the Tool Property palette to [Control point and scale/

rotate], then click inside the balloon.
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Explanation: Balloons and Text > Balloon [PRO/EX] > Editing a Balloon
(2) The balloon can be transformed as desired by dragging the control points

Moving a Balloon
To move a balloon, proceed as follows.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Move the balloon
Place the mouse cursor inside the balloon. Drag the balloon to move it.

 Clicking inside the balloon tail allows you to edit only the tail.

 Use the [Mode] option in the Tool Property palette to change the transformation mode.

 You can select multiple control points. For details on how to select, see "Select multiple control points".

 The [Correct line] tool allows you to edit control points and lines. For details on how to use, see "Editing with 

the Correct line Tool".
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Explanation: Balloons and Text > Balloon [PRO/EX] > Editing a Balloon
Rotating a Balloon
To rotate a balloon, proceed as follows.

1 Select the balloon layer
On the Layer palette, select the balloon layer you want to edit.

2 Select the tool
On the Tool palette, select the [Operation] tool.

 To only move the tail, click inside the tail.

 Selecting [Move layer] in step 1 also allows you to move the balloon.

 To select a consecutive group of balloons, click the first item, then hold down Shift and select the last item.

 Hold down Shift while dragging the inside of the balloon to move it horizontally, vertically, or along a 45-degree 

diagonal angle.
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Explanation: Balloons and Text > Balloon [PRO/EX] > Editing a Balloon
3 Select the sub tool
Open the Sub Tool palette and select [Object].

4 Rotate the balloon
Align the cursor with a rotation handle. Drag this to rotate the balloon.

Changing the Thickness and/or Color of a Balloon's Line
You can change the thickness and color of a balloon line from the Tool Property palette. For details on how to change, see "Balloons" in the 

Clip Studio Paint Tool Setting Guide.

 To only rotate the tail, click inside the tail.

 To select multiple balloons, click the additional balloons sequentially while holding down Shift.

 Hold down Shift while dragging the rotation handle to rotate the balloon in increments of 45 degrees.
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Explanation: Balloons and Text > Text > Inputting Text
 Text
This section describes how to input and edit text.

Inputting Text
To input and lay out text, proceed as follows. Text can be entered using the [Text] tool. You can also use the [Story editor] in EX.

Entering text with the [Text] tool
Use the [Text] tool to enter text.

1 Select the tool
On the Tool palette, select the [Text] tool.

2 Configure the tool property
On the Tool Property palette, adjust the settings for text input.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Text] tool and then selecting [Text] 

on the Sub Tool palette.

 For details on the Tool Property palette, see the “Clip Studio Paint Tool Setting Guide.”

 The tool property settings can also be configured after laying out the text. For how to edit, see "Editing Text".
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Explanation: Balloons and Text > Text > Inputting Text
3 Enter the text
Input the text by following the procedure below.

(1) Click the canvas at the desired position to start inputting text.

(2) Input the text.

(3) Click [OK] on the text launcher to confirm the entry

 You can also click outside the text box to confirm the entry.

 Dragging a handle around the text allows you to scale the text up or down.

 When using a Smartphone, the text launcher is displayed above the screen keyboard.

 For details on the text launcher, see "Text launcher".

 Text extending outside the surrounding frame is not displayed on the canvas if [Wrap text at frame] is turned 

on in the Tool Property palette or Sub Tool Detail palette. Dragging the handles around the text changes the 

display area of the text. Dragging the handles does not scale the text up or down in this case.

 In PRO and EX, symbols and special characters can be entered by clicking [Text list] in the Tool Property pal-

ette. Select the text type and font in the popup, then click the special character to be entered. For details on 

[Text list], see the “Clip Studio Paint Tool Setting Guide.” 
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Explanation: Balloons and Text > Text > Inputting Text
Text launcher
This is tha launcher that appears when editing text. If using an iPhone, the text launcher is displayed above the screen keyboard or in the Sub 

Tool Detail palette.

When using Windows/macOS/iPad

(1) Sub Tool Detail [PRO/EX]

Clicking this displays the Sub Tool Detail palette. The text to be entered or the text currently selected can be adjusted.

Clicking it again hides the Sub Tool Detail palette.

(2) Confirm

Clicking this confirms the entered text. When modifying text, the corrected content will be confirmed.

(3) Cancel

Clicking this will cancel text entry. When modifying text, the corrected text will be returned to its previous state.

When using Android/Chromebook

(1) Undo

This undoes previous editing such as inserting and transforming text from the Tool Property palette's Sub-Tool Details palette.

(2) Redo

This redoes previous editing such as inserting and transforming text from the Tool Property palette's Sub-Tool Details palette.

(3) Cut

This cuts selected text and saves it to the clipboard.

(4) Copy

This copies selected text and saves it to the clipboard.

(5) Paste

This pastes the text saved to the clipboard.

(6) Sub Tool Detail

Tapping this displays the Sub Tool Detail palette. The text to be entered or the text currently selected can be adjusted.

Tapping it again hides the Sub Tool Detail palette.

(7) OK

Confirms the entered text. When modifying text, the corrected content will be confirmed.

(8) Cancel

Cancels the entered text. When modifying text, the corrected text will be returned to its previous state.

When using Windows/macOS/Tablet, the visibility of the text launcher can be toggled on and off. You can toggle 

the visibility by going the [View] menu > [Text launcher].
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Explanation: Balloons and Text > Text > Inputting Text
Displaying Halfwidth Text Vertically
When displaying halfwidth characters such as alphanumeric characters and symbols vertically, the default entry format is as follows:

Halfwidth characters
The text is entered horizontally.

Fullwidth characters
The text is entered vertically.

 If [Auto TateChuYoko (Horizontal in Vertical)] is set in the Tool Property palette or Sub Tool Detail palette of the 

[Text] tool, halfwidth alphanumeric characters within a set number of characters are displayed vertically.

 To display halfwidth characters vertically, select each character of the text using the [Text] tool and turn on 

[TateChuYoko (Horizontal in Vertical)] in the Tool Property palette or Sub Tool Detail palette.
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Explanation: Balloons and Text > Text > Inputting Text
Entering text with the story editor [EX]
Use the [Story editor] to enter text. The [Story editor] allows you to batch enter story text.

1  Select the command
Select the [Story] menu > [Edit text] > [Open story editor].

2 Enter text
Click the [Text area] in the [Story editor] and enter text.

3 Select the tool
On the Tool palette, select the [Operation] tool.

4 Select the sub tool
Open the Sub Tool palette and select [Object].

5 Adjust the position of the text
Open the page (canvas) where you entered the text. The entered text is displayed in the top right or top left corner of the page.

Click to select the text you want to move and drag it to adjust the position.

 To enter multiple text blocks, place the cursor at the end of the text block and press Shift + Enter. A new text 

area is added.

 To enter text on another page, click the text area of the page where you want to enter the text.

 For information on how to edit text on a page (canvas), see "Editing Text".

 For details on how to edit text in the [Story editor], see "Operations in the story editor [EX]".
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Explanation: Balloons and Text > Text > Editing Text
Editing Text
This section describes how to edit text.

Editing text
To edit or retype text, proceed as follows.

1 Select the tool
On the Tool palette, select the [Text] tool.

2 Edit and retype text
Click above the letter you want to edit. Settings related to text appear on the Tool Property palette, allowing you to edit and retype the text.

A message confirming replacement of the text is displayed when editing text entered using Clip Studio Paint 

Ver.1.4.4 or earlier, or using ComicStudio or IllustStudio. 

 Select [Yes] to replace the text with text drawn in the latest version.

 Select [No] to keep the drawn text but not edit it.

 Select [Apply to all texts in the layer] to replace all text in the layer with text drawn in the latest version.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Text] tool and then selecting [Text] 

on the Sub Tool palette.
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Explanation: Balloons and Text > Text > Editing Text
Change the text color
To change the text color, proceed as follows.

1 Select the tool
On the Tool palette, select the [Text] tool.

2 Place text into editing mode
Click above the letter you want to edit. You can edit and/or retype the text.

3 Select the letters
Select the letters whose color you want to change.

For details on the Tool Property palette, see the “Clip Studio Paint Tool Setting Guide.”

The text color can be changed if the [Expression color] of the layer is [Color].
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Explanation: Balloons and Text > Text > Editing Text
4 Change the text color
On a color palette, select a drawing color. The text color changes to that selected.

Changing the text size, position, and angle
Select the text with the [Operation] > [Object] tool to display the handles and bounding box of the text. You can use these to edit the text.

When using an smartphone, click the text launcher [Sub Tool Detail]. Selecting the [Font] category in the Sub Tool 

Detail palette and clicking [Color] opens the [Color settings] dialog box. Select the color you want to change to in 

the [Color settings] dialog box to change the text color.

When using Windows/macOS/Tablet, text color is set in the same way. Note: The Sub Tool Detail palette is not 

available in DEBUT.

 You cannot change the content of the text using the [Object] sub tool. Please refer to "Editing text" for how to 

change text that has already been entered.

 You can edit the text in the same way using the [Text] tool.
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Explanation: Balloons and Text > Text > Editing Text
Changing the text size
Drag the handles of the text bounding box to increase or decrease the size of the text.

Move text
Click on the inside of the bounding box and drag to move the text.

 Press Alt while transforming to scale around the center of the frame.

 Pressing Shift while transforming allows you to scale with fixed aspect ratio.

 The text size can be changed by selecting the text using the [Object] tool and changing the [Size] value in the 

Tool Property palette.

 Dragging the handles will not scale the text if [Wrap text at frame] is turned on in the Tool Property palette or 

Sub Tool Detail palette.

 When the transformation mode in the Tool Property palette is set to [Rotate] or [Skew], you cannot scale the 

image up by dragging the handles. Please select another item.

 When using the Text tool, clicking on the inside of the bounding box and dragging moves the position of the 

text.

 Hold down Shift while dragging to move the position of the text horizontally, vertically, or along a 45-degree 

diagonal angle.
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Explanation: Balloons and Text > Text > Editing Text
Rotate Text
Drag a rotation handle of text bounding box to rotate the text.

Transform Text
When the [Mode] in the Tool Property palette is set to [Skew], you can transform the text freely by dragging the handles.

 If the rotation handle does not appear, select an option other than [Scale up/down] from [Mode] in the Tool 

Property palette.

 Hold down Shift while dragging to rotate in increments of 45 degrees.

 Editing the value of [Rotation angle] in the Sub Tool Detail palette will also rotate the text.

 Text that has been rotated will not be editable in Clip Studio Paint Ver 1.9.0 or earlier.
CLIP STUDIO PAINT Instruction Manual 1162



Explanation: Balloons and Text > Text > Editing Text
Flipping text
Drag the handle at the center of the bounding box to flip the text.

 Editing the value of [Skew (horizontal)] and [Skew (vertical)] in the Sub Tool Detail palette will also skew the 

text.

 You can use the Sub Tool Detail palette to change the size and line space when transforming text.

 You can also transform text by selecting the text layer and then selecting the [Edit] menu > [Transform]. For 

details, see "Transform".

 Text that has been transformed will not be editable in Clip Studio Paint Ver 1.9.0 or earlier.

 Even if the transformation mode is set to [Scale/Rotate/Skew] in the Tool Property palette, you can transform 

text. Dragging the corner handles scales the text. Dragging the guide line handles transforms the text.

 Clicking [Flip Horizontal] or [Flip Vertical] in the Sub Tool Detail palette’s [Transformation settings] category 

will flip the view without changing the text’s position.

 Text that has been flipped will not be editable in Clip Studio Paint Ver 1.9.0 or earlier.
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Explanation: Balloons and Text > Text > Editing Text
Adding an outline to text [PRO/EX]
Edges can be added to text using [Object] in the [Operation] tool.

1 On the Tool palette, select the [Operation] tool.

2 Open the Sub Tool palette and select [Object].

3 Click above the letter you want to edit. Handles are displayed around the text.

Edges can also be added to text using [Border effect] in the Layer Property palette. However, if this is applied to 

text in a balloon or with a background, the edges are added to the balloon or background, not the text.

Edges are added to all text within the handles. They cannot be added only to specific characters.
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Explanation: Balloons and Text > Text > Editing Text
4 Click [Sub Tool Detail] on the Tool Property palette.

5 When the Sub Tool Detail palette appears, adjust the settings as follows:

(1) Click [Text].

(2) Turn on [Edge] and set the edge width using the slider.

(3) Click the color display for [Edge color] and select the edge color from the [Color settings] dialog.

(4) Edges are added to the text.
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Explanation: Balloons and Text > Text > Editing Text
Adding the Reading [PRO/EX]
To add reading to the input text, proceed as follows:

1 Select the tool
On the Tool palette, select the [Text] tool.

2 Place text into editing mode
Click above the letter you want to edit. You can edit and/or retype the text.

3 Select the letters
Select the letters to which you want to add the reading. Click the text launcher [Sub Tool Detail].

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Text] tool and then selecting [Text] 

on the Sub Tool palette.

When using an iPhone, the text launcher is displayed above the screen keyboard.
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Explanation: Balloons and Text > Text > Editing Text
4 Add reading
When the Sub Tool Detail palette appears, adjust the settings as follows:

(1) Click [Reading].

(2) Click [Reading setting].

(3) When the pop-up dialog box displays, input the text in [Reading string].

(4) Press the Enter key to confirm the text.

5 The input of the reading is complete
The text input in [Reading string] is displayed along the selected letters.

To adjust the letter size, position and the like for the reading, configure on the Sub Tool Detail palette. For details 

on the Sub Tool Detail palette, see the “Clip Studio Paint Tool Setting Guide.”
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Explanation: Balloons and Text > Text > Using the Mixing Font [PRO/EX]
Using the Mixing Font [PRO/EX]
Mixing font is a combination of font and size configured for each type of letter. This section describes how to configure a mixing font.

Creating the mixing font
To configure a mixing font, proceed as follows.

1 Select the tool
On the Tool palette, select the [Text] tool.

2 Show sub tool detail palette
Click [Sub Tool Detail] on the Tool Property palette.
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Explanation: Balloons and Text > Text > Using the Mixing Font [PRO/EX]
3 Show the [Create mixing font] dialog box
From the Sub Tool Detail palette, open the [Create mixing font] dialog box.

(1) Click [Font].

(2) From [Font], select the font you want to use for the mixing font.

(3) Click [New].

4 Configure the mixing font
On the [Create mixing font] dialog box, create the mixing font.

(1) Enter in a [Mixing font name].

(2) Turn on the checkbox of the letter type to which you want to configure the font type and size.

(3) Configure the font type and size.

(4) Click [OK].

For details on the Sub Tool Detail palette and the [Create mixing font] dialog, see the “Clip Studio Paint Tool Set-

ting Guide.”
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Explanation: Balloons and Text > Text > Using the Mixing Font [PRO/EX]
5 The mixing font is created
Once created, the name of the mixing font name will appear in the Sub Tool Detail palette > [Font].
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Explanation: Balloons and Text > Text > Operations in the story editor [EX]
Using the Mixing Font
To use a mixing font, proceed as follows.

1 Select the tool
On the Tool palette, select the [Text] tool.

2 Show sub tool detail palette
From [Font] on the Tool Property palette, select the created mixing font.

Inputting a text reflects the content of the configured mixing font.

Operations in the story editor [EX]
You can move or duplicate text in the [Story editor].

Selecting with the [Object] sub tool also allows you to apply the mixing font afterwards from the [Tool property] to 

the input text.

Text entered using Clip Studio Paint Ver.1.4.4 or earlier, or using ComicStudio or IllustStudio cannot be edited in 

the [Story editor]. Replace the text with text drawn in the latest version before editing using the [Story editor].

To redraw the text, open the canvas and select the text using the [Text] sub tool or [Object] sub tool. A message 

confirming redrawing of the text is displayed. Click [Yes] or [Apply to all texts in the layer].
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Explanation: Balloons and Text > Text > Operations in the story editor [EX]
Move text
You can move [Text area] in the [Story editor]. You can even move text to a different page.

1 Select text area
Click the [Text area] while holding down Ctrl.

2 Move text area
Move the text by dragging and dropping the [Text area] to the desired position.

 You can select multiple [Text area] and move them at the same time.

 If a [Text area] is moved within the same page, the position of the text on the page does not change.

 If a [Text area] is moved to a different page, the text is placed next to the text on the new page. If there is no 

text on the new page, the text is placed in the top right or top left of the page.
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Explanation: Balloons and Text > Text > Operations in the story editor [EX]
Divide text
Divide a [Text area] in the [Story editor]. Divided text areas can be handled as separate pieces of dialog on the page.

1 Specify the division position
Click the text area and place the text cursor at the place to be split.

2 Divide the text area
Press Enter while holding down the Shift key to divide the text area.

 The text area can be divided by key operations other than Shift + Enter if desired. A different key operation can 

be set in [Story editor] > [Line breaks/Spacing] in [Preferences]. For details, see "Edit text [EX]".

 If you divide the text area when the cursor is at the beginning or end of the text area, a new text area will be 

created.

 Text areas cannot be divided when "Enter text here" is displayed in the text area.
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Explanation: Balloons and Text > Text > Operations in the story editor [EX]
Merging text
Merge text areas in the [Story editor]. Merged text areas can be handled as one piece of dialog on the page.

1 Specify the text area to be merged
Click the latter text area and place the text cursor at start of the text area.

2 Combine text areas
Press Backspace to merge the text area with the previous text area.

Operating from the Story Menu
You can operate the [Story editor] from each item in [Edit text] in the [Story] menu.

For details, see "Edit text".

You can also merge to the next text area by placing the text cursor at the end of the text area and pressing the 

Delete key.
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Explanation: 3D Materials
This chapter describes how to edit 3D materials.

 Types of 3D Data

 Operate 3D Materials

 Operations Using the Movement Manipulator

 Operations Using the Object Launcher

 Operations Using QUMARION [Windows/macOS]

 Operations Using Palettes



Explanation: 3D Materials > Types of 3D Data > 3D Object Materials
Explanation: 3D Materials

 Types of 3D Data
The types of 3D data supported by Clip Studio Paint are as follows.

3D Object Materials
3D object materials are materials whose angles and materials(textures and colors) can be changed.

They are registered under [Material [Small object]] and [Material [Background]] in the Material palette.

For materials with multiple parts, positions and angles of each part can be adjusted.

 3D object materials in [Material[Background]] will have "Ver.2" in their name.

 For how to tell 3D background materials and 3D object materials apart, see "How to tell 3D object materials 

and 3D background materials apart".
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Explanation: 3D Materials > Types of 3D Data > 3D Character Materials
3D Character Materials
3D character materials are character materials whose pose, facial expression and the like can be changed.

They are registered under [Material [Character]] on the Material palette.

3D Drawing Figures
3D drawing figures can have their body shape and pose changed. Body shapes configured using 3D drawing figures can be saved as materials. 

Unlike 3D character materials, 3D pose model materials cannot have their hair style, facial expression and the like changed.
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Explanation: 3D Materials > Types of 3D Data > 3D Background Materials
3D Background Materials
3D background materials are background materials whose angle and material (material properties and color tone) can be changed.

Unlike 3D Objects, the position and angle of each part cannot be adjusted. Only predetermined parts can be moved.

3D background materials are registered in [Material [Background]] in the Material palette. Additionally, they may be available on Clip Studio 

Assets.

How to tell 3D object materials and 3D background materials apart
The following methods can be used to tell 3D object materials and 3D background materials apart.

 When selecting from the Material palette, check [Material details] in the Material palette.

 When selecting either [3D background] or [3D object] from the Material palette's [Tag list], the selected type will be filtered in the Material 

List.

 In Clip Studio Assets, the material type will be displayed under the materials' thumbnail.
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Explanation: 3D Materials > Operate 3D Materials > Paste a 3D Material
 Operate 3D Materials
This section describes how to operate 3D materials.

Paste a 3D Material
The following describes the procedure to paste a 3D material to the canvas.

1 Paste the 3D character material
Paste the 3D character material to the canvas.

(1) On the [Tree view], select [3D] > [Character].

(2) Select the character and drag and drop it to the canvas.

 Materials can also be pasted to the canvas by clicking [Paste material] on the Material palette.

 A confirmation message saying "Do you want to start CLIP STUDIO and download it?" may appear when using 

some 3D materials for the first time. In this case, click [Yes] to download the 3D material. After downloading, 

the material can be used as normal.

 3D materials are automatically registered to the Item Bank palette when imported from the Material palette. 

However, 3D materials compatible with Version 1.5 are not registered.

 When using a Smartphone, select the grip on the material thumbnail and drag and drop it to the canvas.
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Explanation: 3D Materials > Operate 3D Materials > Paste a 3D Material
(3) The 3D character material is pasted to the canvas, and a 3D layer created in the Layer palette.

2 Paste 3D Object Materials
Paste 3D object materials to the canvas.

    

(1) On the [Tree view], select [3D] >[Small object].

(2) Select the 3D object material and drag and drop it to the canvas.

Creating a 3D layer also creates a three-point perspective ruler at the same time. The perspective ruler is hidden 

immediately after the creation of the 3D layer. For details on how to use a perspective ruler, see "Explanation: Per-

spective ruler [PRO/EX]".
CLIP STUDIO PAINT Instruction Manual 1180



Explanation: 3D Materials > Operate 3D Materials > Paste a 3D Material
(3) The 3D object material is pasted to the canvas. The material will be added to the existing 3D layer, so a new 3D layer will not be cre-

ated.

3 Select the tool
On the Tool palette, select the [Operation] tool.

 You can manage multiple 3D materials in one 3D layer. To create a 3D layer for each 3D material, paste the 3D 

material after selecting other than a 3D layer on the Layer palette.

 3D materials compatible with Version 1.5 and 3D materials from Ver. 1.6.0 and later are created as separate 3D 

layers. They cannot be managed in the same 3D layer.

When pasting large 3D materials, other 3D materials may be hidden. Operate the Movement manipulator of the 

pasted material and move until the other 3D materials become visible. For details on how to use the movement 

manipulator, see "Operations Using the Movement Manipulator".
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Explanation: 3D Materials > Operate 3D Materials > Paste a 3D Material
4 Adjust the 3D material
Open the Sub Tool palette to select [Object] and adjust the position and pose of the 3D material.

 For how to adjust the position of the 3D materials, see "Positioning 3D Object Materials" and "Deciding the 

Position and Pose of a 3D Character/3D Drawing Figure".

 3D drawing figures can be pasted on the canvas in a similar fashion.

 In EX, you can also paste 3D materials to the canvas by dragging and dropping the 3D material into the All 

Sides View palette. You can also edit 3D materials while viewing them from four directions using the All Sides 

View palette.
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Explanation: 3D Materials > Operate 3D Materials > Importing 3D Materials
Importing 3D Materials
In addition to 3D materials registered in the Material palette, you can import 3D files in the following formats.

1  Select the command
Select [File] menu > [Import] > [3D data].

2 Select the image file
In the displayed dialog box, select the 3D file to be added and click [Open].

3 The layer is added
The 3D file is imported to the canvas and a 3D layer is added to the Layer palette.

File formats that can be 

imported

CLIP STUDIO 3D Character format (extension: cs3c), CLIP STUDIO 3D Object format (extension: 

cs3o), CLIP STUDIO 3D Background format (extension: cs3s), fbx, 6kt, 6kh, lwo, lws and obj

 Files in ccr, ccrx or m3c format from Clip Studio Assets cannot be imported.

 Ver. 1.5 compatible 3D materials (extension: c2fc, c2fr) and 6kt, 6kh cannot be imported on tablets/smart-

phones/Macs with Apple M1 chips.

 FBX files cannot be imported on Android/Macs with Apple M1 chips.
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Explanation: 3D Materials > Operate 3D Materials > Delete the 3D material
Delete the 3D material
To delete a 3D material from a canvas, proceed as follows.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

 3D files can be imported only to the canvas. They cannot be imported to the Material palette. 3D files can be 

registered to the Material palette using Clip Studio Modeler.

 When using Windows/macOS/Tablet, you can also import 3D files by dragging and dropping a file to the can-

vas.

 3D materials compatible with Version 1.5 (extension: c2fc, c2fr) can be imported by dragging and dropping the 

file to the canvas.

 3D files imported to the canvas are registered in the Item Bank palette. However, 3D materials compatible with 

Version 1.5 (extension: c2fc, c2fr) are not registered to the Item Bank palette.

 In EX, you can also import files by dragging and dropping a file into the All Sides View palette. For supported 

file formats, see "Importing 3D materials and files".
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Explanation: 3D Materials > Operate 3D Materials > Delete the 3D material
3 Select the 3D material
Click to select the 3D material to delete.

4 Delete the 3D material
Select [Edit] menu > [Delete].

You can also delete by pressing Delete.

Click the 3D material

to delete.

The selected 3D

material is deleted.
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Explanation: 3D Materials > Operate 3D Materials > Select the 3D material
Select the 3D material
To select the 3D material to edit, proceed as follows.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D material
Click the 3D material to select.

Click the 3D material

to select.
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Explanation: 3D Materials > Operate 3D Materials > Select the 3D material
The movement manipulator and [Object launcher] of the 3D material will be displayed, and the 3D material will be selected.

 For details on how to use the movement manipulator, see "Operations Using the Movement Manipulator".

 For details on how to use the [Object launcher], see "Operations Using the Object Launcher".

 If selection is disabled for a 3D material, you will not be able to select if when you click. Clicking [Select next 

3D object] and [Select previous 3D object] in the [Object launcher] will switch the targeted 3D material. Addi-

tionally, you can select 3D materials from the [Object list]. For how to select, see "Selecting Multiple 3D mate-

rials and Parts".

Movement manipulator

Object launcher
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Explanation: 3D Materials > Operate 3D Materials > Selecting Multiple 3D materials and Parts
Selecting Multiple 3D materials and Parts
You can select multiple 3D materials using the [Object List] on the Tool Property palette. You can also select multiple parts in 3D object mate-

rials with multiple parts and LWS files with a hierarchy. However, 3D materials and parts cannot be selected at the same time.

When multiple 3D materials or parts are selected, they can be edited (moved, rotated, etc.) at the same time using the manipulators.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D layer
In the Layer palette, select the 3D layer that contains the 3D materials you want to select.

4 Selecting Materials or Parts
In the [Object list] of the Tool Property palette, click the 3D materials or parts you want to select while holding down the Ctrl key.

Ctrl +Click
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Explanation: 3D Materials > Operate 3D Materials > Selecting Multiple 3D materials and Parts
5 Complete selection
The 3D materials or parts selected in the [Object List] are displayed in red when the multiple selection is complete. It is to possible to 

adjustments such as move, rotate, etc. using the manipulators displayed at the bottom of the screen.

 In PRO/EX, setting the Sub Tool Detail palette of the [Object] tool > [Operation] > [Add to selection] to [Select 

additionally] allows you to also make multiple selections by clicking 3D materials or parts on the canvas.

 You can also select multiple 3D materials or parts by holding Shift.

 When using PRO/EX, click [Display object list] on the Object Launcher to display the object list in the Sub Tool 

Detail palette. The object list can be displayed larger than the Tool Property palette.

 To open or close all of the [Object list] hierarchies, Right click [Object List] and click Show all or Close all from 

the displayed menu.

 If you cannot select the parts of a 3D material, selection may be disabled for that 3D material. For information 

on selection settings, see "Toggling selection on 3D materials".

 For details on how to use the manipulators, see "Positioning 3D Object Materials".

 If multiple 3D materials are selected, batch operations such as deletion, cutting, copying and pasting can be 

performed. Please note that these operations cannot be performed for multiple selections of parts in 3D object 

materials and LWS files with a hierarchy.
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Explanation: 3D Materials > Operate 3D Materials > Lock the 3D material
Lock the 3D material
Locks a specific 3D material. Locked materials cannot be edited or moved.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D layer
Open the Layer palette and select the 3D layer to edit.
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Explanation: 3D Materials > Operate 3D Materials > Lock the 3D material
4 Lock the material
In the [Object list] of the Tool Property palette, click [Lock] for the 3D material to be locked.

5 Object is locked
A padlock icon appears in the [Object list] on the Tool Property palette when the object is locked.

It is not possible to edit locked 3D materials other than changing the camera angle.

If the material you want to lock does not appear in the [Object list], click the icon to the right. This displays the 

entire [Object list] as a pop-up.

Click the 3D material 

to lock.
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Explanation: 3D Materials > Operate 3D Materials > Switching Show/Hide for a 3D Material
Switching Show/Hide for a 3D Material 
Displays/hides a specific 3D material. Hidden materials cannot be edited or moved.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D layer
Open the Layer palette and select the 3D layer to edit.

When using 3D objects with multiple parts or 3D materials in LWS format, you can show and hide individual parts.
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Explanation: 3D Materials > Operate 3D Materials > Switching Show/Hide for a 3D Material
4 Showing/Hiding Materials
In the [Object list] of the Tool Property palette, click [Show/Hide] for the 3D material to be shown or hidden.

5 Toggling visibility
The [Show/Hide] icon in the [Object list] of the Tool Property palette changes when a 3D material is shown or hidden.

 If the material you want to show or hide does not appear in the Object list, click the icon to the right. This dis-

plays the entire [Object list] as a pop-up.

 When using PRO/EX, click [Display object list] on the Object Launcher to display the object list in the Sub Tool 

Detail palette. The object list can be displayed larger than the Tool Property palette.

 To open or close all of the [Object list] hierarchies, Right click [Object List] and click Show all or Close all from 

the displayed menu.

Click to 3D the material 
to hide.
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Explanation: 3D Materials > Operate 3D Materials > Toggling selection on 3D materials
Toggling selection on 3D materials
When selection is enabled, you can select individual parts of 3D materials that contain multiple parts.

When selection is enabled, individual parts of a 3D material can be selected and adjusted. When selection is disabled, individual parts cannot be 

selected on the canvas. This is useful when making global adjustments to the 3D material.

Here, the 3D material will be set to enable selection.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D layer
Open the Layer palette and select the 3D layer to edit.

You cannot toggle selection of parts on imported 3D background materials. For information on 3D background 

materials, see "3D Background Materials".
CLIP STUDIO PAINT Instruction Manual 1194



Explanation: 3D Materials > Operate 3D Materials > Toggling selection on 3D materials
4 Change settings
From the Tool Property palette's [Object list], click the "Toggle selection" box of the 3D material of choice.

5 Toggling selection
Clear the "Disable selection" icon in the Tool Property palette [Object list] to be able to select the materials. Click on the select parts of 3D 

materials that are set to enable selection.

 If the material you want to set does not appear in the [Object list], click the icon to the right. This displays the 

entire [Object list] as a pop-up.

 When using PRO/EX, click [Display object list] on the Object Launcher to display the object list in the Sub Tool 

Detail palette. The object list can be displayed larger than the Tool Property palette.

 To open or close all of the [Object list] hierarchies, Right click [Object List] and click Show all or Close all from 

the displayed menu.
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Explanation: 3D Materials > Operate 3D Materials > Positioning 3D Object Materials
Positioning 3D Object Materials
The display size and position of a 3D object material can be configured in accordance with the work.

Moving 3D Object Materials
Move the position of a 3D object material up, down, left, right, forward or back.

1 Selecting 3D Object Materials
Select the 3D object material to move.

2 Moving 3D Object Materials
A root manipulator is displayed for 3D object materials. Drag the arrows of the root manipulator with the mouse cursor to move the item 

in the dragged direction.

 For details how to use 3D character materials, see "Deciding the Position and Pose of a 3D Character/3D Draw-

ing Figure".

 The position of 3D object materials can be configured in detail by using the Tool Property palette and Sub Tool 

Detail palette.

For information on how to select 3D object materials, see "Select the 3D material".

 3D objects compatible with Version 1.5 can be moved by dragging the material with the [Object] tool.

 You can also move 3D object materials by dragging the controller at the center of the root manipulator.

 For details on the Root manipulator, see "Using the Root Manipulator".

 If the 3D object material has multiple parts, operating the manipulator may only move a specific part. This 

issue can be solved by clicking an area of the canvas with no items and then selecting the 3D object material 

again.

 You can also move 3D objects by using the movement manipulator. For details on the movement manipulator, 

see "Functions of the Movement Manipulator".

Drag
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Explanation: 3D Materials > Operate 3D Materials > Positioning 3D Object Materials
Rotating 3D Object Materials
To rotate and change the angle of a 3D object material, proceed as follows.

1 Selecting 3D Object Materials
Select the 3D object material to rotate.

2 Changing the Angle of a 3D Object Material
A root manipulator is displayed for 3D object materials. Drag the ring of the Root manipulator with the mouse cursor to rotate the item in 

the dragged direction.

For information on how to select 3D object materials, see "Select the 3D material".

 You can adjust the angle of a 3D object material with the Sub Tool Detail palette. The palette is useful for pre-

cise adjustments as it allows numerical input. For details, see "Setting Items on the Sub Tool Detail palette".

 The orientation of the 3D object material can be adjusted from the list that appears if you click [Rotate] on the 

[Object launcher]. For details on how to use, see "If a 3D object material is selected".

 For details on the Root manipulator, see "Using the Root Manipulator".

 You can also rotate 3D object materials using the Movement manipulator. For details on the movement manip-

ulator, see "Functions of the Movement Manipulator".

 When moving Ver 1.5 compatible 3D object materials, use the Movement manipulator to rotate. For details on 

the movement manipulator, see "Functions of the Movement Manipulator".

Drag around 

the manipulator ring.

The object material rotates and 

the angle is changed.
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Explanation: 3D Materials > Operate 3D Materials > Positioning 3D Object Materials
Changing 3D Object Material Scale
You can also scale 3D object materials using the Root Manipulator.

1 Selecting 3D Object Materials
Select the 3D object material you want to scale up/down.

2 Changing 3D Object Material Scale
A root manipulator is displayed for 3D object materials. Drag the Root manipulator's [Scale] (the gray ring).

Dragging the [Scale] inward will scale down the 3D object material. Dragging the [Scale] outward will scale up the 3D object material.

Moving 3D Object Material Parts
If a 3D object material has multiple parts, you can move or rotate specific parts only.

1 Selecting 3D Object Materials
Select the 3D object material to move.

For information on how to select 3D object materials, see "Select the 3D material".

 The scale of the 3D object can be adjusted with [Object scale] in the Sub Tool Detail palette. The palette is use-

ful for precise adjustments as it allows numerical input. For details, see "Setting Items on the Sub Tool Detail 

palette".

 For details on the Root manipulator, see "Using the Root Manipulator".

For information on how to select 3D object materials, see "Select the 3D material".

Drag.
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Explanation: 3D Materials > Operate 3D Materials > Positioning 3D Object Materials
2 Select the part
Click the part to move or rotate. The selected part is displayed in red.

3 Move or rotate parts
A part manipulator is displayed for the part to be moved. Drag the arrow or ring with the mouse cursor to move or rotate the part in the 

direction of the arrow or ring.

 You can also select parts from the Object list in the Tool Property or Sub Tool Detail palettes.

 If you cannot select the parts of a 3D material, selection may be disabled for that 3D material. For information 

on selection settings, see "Toggling selection on 3D materials". You can select parts from the [Object list] 

regardless of whether selection is disabled or enabled.

 No arrow or controller is displayed for the part manipulator when moving a 3D object compatible with Version 

1.5. Drag the part with the [Object] tool to move it up, down, left, right, forward or back.

 You can also move 3D object materials by dragging the controller at the center of the part manipulator.

Click.

Drag

You can move or rotate in the direction of 

arrows and rings that have turned yellow.
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Explanation: 3D Materials > Operate 3D Materials > Positioning 3D Object Materials
Select a 3D Object material's camera angle
Some 3D Object materials come with preset camera angles. You can set the 3D object material's camera just by selecting an angle.

1 Selecting 3D Object Materials
Select the 3D object material to edit.

2 Select the camera angle
Click [Camera] on the [Object launcher]. Select a camera angle from the list that displays.

If using the Smartphone version, you can choose a camera angle from the list that appears when you click [Angle] in the Tool Property pal-

ette.

The selected camera angle is reflected in the 3D material.

You can also set the camera for 3D background materials. For information on 3D background materials, see "3D 

Background Materials".

Select a camera angle from

the list.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Deciding the Position and Pose of a 3D Character/3D Drawing Figure
The pose and facial expression of 3D character materials and 3D drawing figures can be configured in accordance with the work. This section 

describes how to configure a 3D character material/3D drawing figure with mouse operation.

Regarding 3D Character Materials
3D character materials are composed of body [parts] such as arms, fingers and head.

Each part has "standard bones" configured, which move in the same way as human joints.

Since the [Bones] of each part are linked, moving a part moves other parts as well.

In Clip Studio Paint, poses for a model are defined by moving/rotating the parts.

For 3D character materials configured with physical settings in Clip Studio Modeler or Clip Studio Coordinate, 

physical settings are reflected when the 3D character materials are moved. For details on Clip Studio Modeler, see 

clipstudio.net.

Dragged part.

Other parts also

move.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Select the pose
Clip Studio Paint comes with preconfigured poses for 3D character materials and 3D drawing figures, which you can just select to assign a pose 

to the 3D character material or 3D drawing figure.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D material
Click the 3D character material or 3D drawing figure to edit.

You can also assign a pose to a 3D character material or 3D drawing figure by dragging and dropping a pose file 

(extension: PEP) created in POSE STUDIO.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
4 Select the pose
Select a pose from the Material palette.

(1) On the [Tree view], select [3D] > [Pose] > [Entire body].

(2) Select a pose and drag and drop it to the canvas.

(3) The selected pose is reflected in the 3D character material or 3D drawing figure.

 If you drag and drop a pose to the canvas when there are no 3D materials on the canvas, a 3D drawing figure 

with the selected pose displays. If you drag and drop multiple pose materials to the canvas, 3D drawing fig-

ures with the selected poses are displayed.

 You can select poses from the Tool Property palette as well. Click the Tool Property palette’s [Use 3D pose 

material] and select a pose from the [Use 3D pose material] dialog box then, select a 3D character or a 3D 

drawing figure and it’s pose will be reflected on the character.

 In EX, you can select a pose and drag and drop it into the [All sides view] to apply the selected pose.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Fixing and Releasing Joints [Windows/macOS]
Joints of 3D characters and 3D drawing figures can be fixed. The fixed joint becomes the fulcrum for translation and rotation. Creating a pose 

is easier if the joints of 3D character materials and 3D drawing figures are fixed. This section describes how to fix and release joints, and the 

extension of parts fixed when a joint is fixed.

Fixing a Joint
To fix a joint, proceed as follows.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D material
Click the 3D character material or 3D drawing figure to edit.

 When using a Tablet, fix and release of joints using right click can not be applied. Please use [Fix joint] and 

[Fix all joints] from the object launcher. For details on the Object launcher, see "When a 3D Character Material 

Is Selected" , "When a 3D Drawing Figure Is Selected".

 When using a Smartphone, fix and release of joints using right click cannot be applied. Settings can be 

adjusted in the Sub Tool Detail palette.

 Some parts are configured with multiple bones such as "Hips" and "Chest". If fixing a joint connecting part 

does not function as intended, fix another joint. To look for another joint, move the mouse cursor near the part 

to be fixed. Part edges displayed in red are joints you can fix.

 There is no limit in the number of joints that can be fixed.

 When no joints have been fixed, the "Hips" part is fixed.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
4 Fixing a Joint
Right click over the part to fix.

A fixing point is displayed at the tip of the clicked part. Joints that can be fixed are those with a fixing point.

Right click

The fixing point

is displayed.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Release the fixed joint
To release a fixed joint, proceed as follows.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D character material
Click the 3D character material to edit.

4 Release the fixed joint
Right click the part whose fixed joint is to be released.

The fixed joint of the clicked part is released and the fixing point, removed.

Right clicking other than the 3D character material on the canvas releases all fixed points, removing all fixing 

points.

Right click

The fixing point

is removed.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Effective Range
The extension of parts fixed as a result of fixing a joint depends on the fixed joint and location of the selection.

Parts on the opposite side of the selection, with center in the fixed joint are fixed.

For example, if you fix the left elbow and select the right shin, the part above the left elbow will be fixed.

If you fix the left elbow and select the left hand, the right hand, left shoulder, and lower body will be fixed.

Dragged part.

Fixed joint
Part to be fixed.

Dragged part.

Part to be fixed.

Fixed joint
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Move the part [Windows/macOS/Tablet]
To move a part of a 3D character or 3D drawing figure, proceed as follows.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D material
Click the 3D character material or 3D drawing figure to edit.

4 Move the part
Drag the part to move.

On the Smartphone version, you can move parts with the manipulator. For details, see "Using Manipulators".

Drag
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Rotate the part [Windows/macOS]
To rotate a selected part, proceed as follows.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D material
Click the 3D character material or 3D drawing figure to edit.

4 Select the part
Click to select the part to rotate.

When using the Tablet/Smartphone versions, you can rotate parts with the manipulator. For details, see "Using 

Manipulators".

Click the part

to rotate.
CLIP STUDIO PAINT Instruction Manual 1209



Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
5 Rotate the part
Operate the mouse wheel. The selected part rotates.

Deciding the Hand Pose
You can easily pose the hands using preset poses with the Sub Tool Detail palette or Tool Property palette.

Steps
To decide a pose for a hand, proceed as follows.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D material
Click the 3D character material or 3D drawing figure to edit.

When displaying the animation controller, the perspective changes when you turn the mouse wheel.

To rotate parts, switch to the manipulator display. For details on how to switch to the manipulator display, see 

"Switching to the Manipulator Display".

The selected part

rotates.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
4 Select the hand for which to create a pose
Click the direction of the hand for which to create a pose.

5 Configure the hand pose
Configure the hand pose with [Hand setup] on the Tool Property palette.

(1) On [Lock finger], click the icon of the finger to fix (lock).

(2) Drag [+] on the [Hand controller] and configure how to bend the fingers.

When configuring a hand pose to a 3D character material or 3D drawing figure, the hand on which the pose will 

reflect may vary depending on the selection.

 When a part on the right side of the body is selected, the pose will be reflected in the right hand.

 When a part on the left side of the body is selected, the pose will be reflected in the left hand.

 When a part in the center of the body is selected or certain parts are not selected, the pose will be reflected in 

both hands.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
(3) A hand pose is created for the 3D character material.

 For details on [Hand setup] functions, see "Hand Setup Items" in the next section.

 Select [3D] > [Pose] > [Hand] from the Material palette to show a list of preset hand poses. Selecting the icon 

of the desired pose to assign to the 3D character material or 3D drawing figure, and dragging and dropping it 

to the 3D character material or 3D drawing figure assigns the pose to the hand.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Hand Setup Items
The following describes the settings in the [Pose] section of the Sub Tool Detail palette and the [Hand setup] of the Tool Property palette.

(1) Lock finger

Locks fingers. From left to right, configures the settings for [Thumb], [Index finger], {Middle finger], [Ring finger] and [Little finger]. 

Clicking a finger displays a chain icon and locks the finger. Locked fingers cannot be moved with the hand controller.

(2) Hand controller

Drag the cross symbol (+) to adjust the hand pose.

Fingers extended and together/Fingers extended and spread apart

Moving the icon to the left makes the fingers move closer. Moving the icon to the right makes the fingers spread apart.

Fingers with            are locked.
CLIP STUDIO PAINT Instruction Manual 1213



Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Open hand/Close hand

Moving the icon upwards opens the hand. Moving the icon downwards closes the hand.

(3) Fist presets

Click the corresponding icon to configure how the fist should look like. There are four fist presets available.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Moving a 3D Character Material or 3D Drawing Figure
You can move a 3D character material or 3D drawing figure horizontally or vertically.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D material
Click the 3D character material or 3D drawing figure to move.

Click the 3D character

material.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
4 Move the 3D character material
Dragging [Move on plane] on the Movement manipulator moves the 3D character material in the dragged direction.

Drag Move 3D material

(　　) on the Movement

manipulator.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Using Manipulators
You can operate 3D character materials using the manipulator.

Rotating Parts with the Manipulator
You can rotate parts of 3D character materials using the manipulator.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Displaying the manipulator
Click the part to be moved in the 3D character material or 3D drawing figure being edited.

4 Move the specific part
Move the mouse cursor to the manipulator and drag in the direction in which to move the part.

 If a 3D character material compatible with Version 1.5 is selected, turn on [Manipulator] in the [Preference] cat-

egory of the Sub Tool Detail palette to display the manipulators.

 If the animation controller is displayed, see "Switching to the Manipulator Display".

Drag around the manipulator.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Names of parts of manipulator
The manipulator can be rotated in the following directions.

(1) Twisted rotation (red)

Drag along the red ring. Rotates the selected part in the direction of the ring.

(2) Bending rotation (green)

Drag along the green ring. Rotates the selected part in the direction of the ring.

(3) Bending rotation (blue)

Drag along the blue ring. Rotates the selected part in the direction of the ring.

(4) Movable range

Displays the range in which the part can be moved. The movable range is not displayed for 3D character materials compatible with Version 

1.5.

Switching to the Animation Controller Display
Click the part displayed in red to switch to the animation controller display.

Some of the manipulators may not be displayed depending on the selected part.

Click.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Using the Animation Controller
Poses can be created using the animation controller.

The animation controller is a tool for operating specific areas of 3D character materials, such as the [Hips], [Right hand], [Left hand] and [Eye-

line].

The unique characteristic of this operation method is that is can move specific areas (e.g. moving only the hips or the eyeline), without moving 

other areas.

The animation controller cannot be used for 3D character materials compatible with Version 1.5.

For details on how to use the animation controller, see "Using the Animation Controller".

 The animation controller is not displayed for 3D character materials compatible with Version 1.5.

 Poses cannot be created with joints fixed in place when moving areas with the animation controller. To create 

poses with joints fixed in place, select and operate a particular part.

 Joint angle limits are disabled when moving and rotating areas with the animation controller.

Animation controller
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Moving Parts in a Specific Area
This section explains how to move parts in a specific area using the animation controller.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Display the animation controller
Click the 3D character material to edit.

4 Select the animation controller
Click the animation controller in the area of the part to be moved. In this example, the animation controller of the eyeline is clicked.

5 Moving Parts in a Specific Area
You can move parts in a specific area by dragging the animation controller.

Drag the arrow of the movement controller with the mouse cursor to move the parts in that specific area in the direction of the arrow.

Click

You can move in the direction of arrows 

that have turned yellow.

Drag
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
You can move parts in a specific area by dragging the animation controller in the desired direction.

Rotating Parts in a Specific Area
This section explains how to rotate parts in a specific area using the animation controller.

1 Display the animation controller
Click the 3D character material to edit with the [Object] sub tool.

2 Select the animation controller
Click the animation controller in the area of the part to be moved. In this example, the animation controller of the left hand is clicked.

Drag

Click
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
3 Rotating a Specific Part
Drag the ring of the rotation handle to rotate the parts in that specific area in the direction of the ring.

Switching to the Manipulator Display
Click the part displayed in blue to switch to the manipulator display.

For details on operations using the manipulator, see "Using Manipulators".

You can rotate in the direction of rings 

that have turned yellow.

Drag

Click.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Using the Root Manipulator
When the animation controller is displayed for a 3D character material, a root manipulator is displayed too.

You can use the root manipulator to move and rotate entire 3D character materials.

Operating the Root Manipulator
Drag the arrow or ring of the root manipulator with the mouse cursor.

The 3D character material moves in the dragged direction.

The root manipulator cannot be used for 3D character materials compatible with Version 1.5.

For details on the directions in which the root manipulator can be moved, see "Names of parts of root manipula-

tor".

Drag.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Names of parts of root manipulator
The root manipulator can be moved in the following directions.

(1) Rotate left/right

Drag along the blue ring. The 3D character material will rotate along with the ring.

(2) Rotate forward/back

Drag along the [Purple] ring. The 3D character material will rotate along with the ring.

(3) Rotate

Drag along the green ring. The 3D character material will rotate along with the ring.

(4) Controller

Click and drag with the mouse cursor. The 3D character material will move in the ring's dragged direction.

(5) Move forward/back

Drag in the direction of the blue arrow. The 3D character material will move in the arrow's direction.

(6) Move left/right

Drag in the direction of the [Purple] arrow. The 3D character material will move in the arrow's direction.

(7) Move up/down

Drag in the direction of the green arrow. The 3D character material will move in the arrow's direction.

(8) Scale

Dragging inward will scale down the 3D character material.

Dragging outward will scale up the 3D character material.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Registering the Pose of a 3D Character or 3D Drawing Figure [PRO/EX]
The pose created for a 3D character or 3D drawing figure can be registered to the Material palette. Besides the body pose, left/right hand poses 

can be registered as well. A registered pose can be applied to another 3D material or canvas.

Registering body poses

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D material
Click the 3D character material or 3D drawing figure whose pose is to be registered.

Ver.1.5 compatible 3D layers cannot register hand poses to the Material palette.

Click the 3D character material.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
4 Register the pose
Click [Register pose] on the [Object launcher].

If using the Smartphone version, you can register the pose from the [Pose] category of the Sub Tool Detail palette. Under [Register mate-

rial], press [Register full body pose as material].

5 Configure the material
The [Material property] dialog box will open. Configure the settings for the material on the dialog box.

(1) Configure the name, content, save destination and search tag for materials.

(2) Click [OK].

For details on the [Material property] dialog box, see "Material property Dialog Box [PRO/EX]".
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
6 The registration of the pose is complete
The dialog box closes and the pose is registered in the Material palette.

Registering hand poses
To register hand poses, click the dropdown icon beside [Register full body pose as material] icon in the [Object Launcher], then select [Register 

left hand pose as material] or [Register right hand pose as material]. Registered hand poses can be applied to both right and left hands. For 

example, right hand poses can be applied to left hands as well.

For how to import a registered pose, see "Select the pose".

If using the Smartphone version, you can register the pose from the [Pose] category of the Sub Tool Detail palette. 

Under [Register material], press [Register right hand pose as material] or [Register left hand pose as material].
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
Create a pose with QUMARION
Clip Studio Paint supports QUMARION. Creating the pose with QUMARION allows you to operate the 3D character material more intui-

tively.

For details on how to use QUMARION with Clip Studio Paint, see "Operations Using QUMARION [Windows/macOS]".

Extract pose from an image using the Pose Scanner, then apply to model (Technology 
preview)
This reads a picture containing a figure and applies the figure's pose to 3D characters and 3D drawing figures. This is aimed at creating a rough 

estimation of the pose you want.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D material
Click the 3D character material or 3D drawing figure to edit.

4 Import the image
Click [Pose Scanner (image) (Technology preview)] on the Tool Property palette.

 This function is a technology preview. Try out these features before their official release.

 When you use this feature, the image data is uploaded to the server, where the AI interprets the data and esti-

mates the pose. A network connection is necessary to execute this function. For information on the image 

uploaded to the server and the generated data, see "About AI features".
CLIP STUDIO PAINT Instruction Manual 1228



Explanation: 3D Materials > Operate 3D Materials > Deciding the Position and Pose of a 3D Character/3D Drawing Figure
If the file selection dialog box displays, you can select the image containing the pose you wish to apply. In this example, the following 

photo is selected.

5 Apply the pose
This applies a figure's pose from a photo to 3D characters and 3D drawing figures. Adjust pose details as needed.

 Importable file formats are: BMP, JPEG, PNG, TIFF and Targa.

 When using a Tablet/Smartphone, click the Tool Property palette’s [Pose Scanner (camera)] or the [Pose Scan-

ner (photo library)] to take or use photos to import a pose.

 If you choose an image with multiple figures in it, the pose will reflect the biggest figure in it.

 The figure’s fingers and hand position will not be reflected in the pose.

 Figures may not be recognized depending on the photo used.
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Explanation: 3D Materials > Operate 3D Materials > Configuring a 3D Drawing Figure Body Shape
Configuring a 3D Drawing Figure Body Shape
3D drawing figures can have their body shape changed. Furthermore, the body shape of a 3D drawing figure can be registered to the Material 

palette as a material. and used repeatedly.

Changing a 3D Drawing Figure Body Shape
3D drawing figures can have their body shape changed. Since you can change by part, you can change the ratio of length of the head to total 

height for a character, for example.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D material
Click the 3D drawing figure whose body shape you want to change.

Click the 3D

drawing figure.
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Explanation: 3D Materials > Operate 3D Materials > Configuring a 3D Drawing Figure Body Shape
4 Choose the head-to-body ratio and body shape
Using the Tool Property palette, change the body shape.

(1) Click the “+” on [Change body shape].

(2) Drag the slider for [Height]. You can adjust the character’s height.

 If you turn on [Adjust head to body ratio with height], the head-to-body ratio of the 3D drawing figure will 

change automatically when you adjust the height.

 If using PRO/EX, you can click [Adjust body shape and size of 3D drawing figure in detail] on the Object 

Launcher to use the Sub Tool Detail palette and adjust the body shape.
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Explanation: 3D Materials > Operate 3D Materials > Configuring a 3D Drawing Figure Body Shape
(3) Drag the 2D slider to adjust the body shape.

5 Adjust body shape
Using the Tool Property palette, adjust the body shape in detail.

(1) Select a part In this example, we select the head.

(2) Drag the 2D slider. You can adjust the width and length of the selected part.

Drag the slider up to make male drawing figures more muscular and female drawing models more curvaceous.

Drag the slider right to make drawing figures fatter and drag the slider left to make drawing models thinner.
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Explanation: 3D Materials > Operate 3D Materials > Configuring a 3D Drawing Figure Body Shape
Registering a 3D Drawing Figure Body Shape [PRO/EX]
The body shape data of a 3D drawing figure can be registered as a material.

1 Select the tool
On the Tool palette, select the [Operation] tool.

2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D drawing figure
Click the 3D drawing figure to register.

 If the option to select parts is not shown on the Tool Property palette, you can click the part names shown 

above the 2D slider to display it.

 With the 3D drawing figure Ver. 2, you can adjust the shoulder width and waist. You cannot adjust these on the 

original drawing figure.

 For details on the Tool Property palette, see the “Clip Studio Paint Tool Setting Guide” > Settings List > Body 

shape.

In this example, only the 3D drawing figure's body shape will be registered. To register its pose, it should be regis-

tered as pose material separately. For how to register a pose, see "Registering the Pose of a 3D Character or 3D 

Drawing Figure [PRO/EX]".

Click the 3D drawing figure.
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Explanation: 3D Materials > Operate 3D Materials > Configuring a 3D Drawing Figure Body Shape
4 Register the 3D drawing figure
Click [Register Material] in [Change body shape] of the Tool Property palette.

5 Configure the material
The [Material property] dialog box will open. Configure the settings for the material on the dialog box.

(1) Configure the name, content, save destination and search tag for materials.

(2) Click [OK].

When using Windows/macOS/Tablet, you can also click [Register body shape] on the object launcher to register.

For details on the [Material property] dialog box, see "Material property Dialog Box [PRO/EX]".
CLIP STUDIO PAINT Instruction Manual 1234



Explanation: 3D Materials > Operate 3D Materials > Configuring a 3D Drawing Figure Body Shape
6 The registration of the body shape is complete
The dialog box closes and the body shape is registered in the Material palette.
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Explanation: 3D Materials > Operate 3D Materials > Configuring a 3D Drawing Figure Body Shape
Importing a Registered 3D Drawing Figure
Import body shape materials onto a 3D drawing figure registered on the canvas.

Drag and drop the registered body shape material from the [Material] onto the canvas. The registered body shape will be loaded onto the 3D 

drawing figure on the canvas.
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Explanation: 3D Materials > Operate 3D Materials > Configuring a 3D Drawing Figure Body Shape
 To change the body shape of a 3D drawing figure that has been placed on the canvas, drag and drop a body 

shape material onto the drawing figure.

 In Clip Studio Paint Ver. 1.7.3 and earlier, files containing 3D drawing figure Ver. 2 will open as read-only files.

 When using a Smartphone, select the grip on the material thumbnail and drag and drop it to the canvas.
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Camera Position
Deciding the Camera Position
The camera control of Clip Studio Paint can display 3D materials in various positions and angles. You can change the position and angle of the 

camera, as well as adjust the composition when finishing the work.

The camera position and angle of 3D layers can be changed by the following methods.

Select the camera angle
Clip Studio Paint comes with preconfigured camera angles for 3D materials. You can configure the camera angle for the 3D material just by 

selecting a camera angle.

1 Select the tool
On the Tool palette, select the [Operation] tool.

Operations Using the Object Launcher

See "Select the camera angle".

For how to operate 3D object materials and 3D background materials, see "Select a 

3D Object material's camera angle" as well.

Operations Using the Movement Manipula-

tor
See "Operations Using the Movement Manipulator".

Operations of the Sub Tool Detail Palette 

[PRO/EX]

Selecting a 3D layer using the [Object] tool allows you to set the camera position and 

angle using the Sub Tool Detail palette.

Supported categories are as follows.

 [Camera] Category

 Select [Camera] from [Object List] in the [Layout] category

For instructions on how to use each category, see the Clip Studio Paint Tool Setting 

Guide.

Operations on the All Sides View palette 

[EX]

The camera position and angle on the canvas can be changed in the All Sides View 

palette. For details, see "Changing the Camera Position".

Changing the camera position and/or angle for a 3D material automatically changes the perspective ruler created 

on the 3D layer.

To select a camera angle for a 3D background material, see "Select a 3D Object material's camera angle". For 

information on 3D background materials, see "3D Background Materials".
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Explanation: 3D Materials > Operate 3D Materials > Deciding the Camera Position
2 Select the sub tool
Open the Sub Tool palette and select [Object].

3 Select the 3D layer
On the Layer palette, click the 3D layer to edit.

4 Select the camera angle
Click [Camera] on the [Object launcher]. Select a camera angle from the list that displays.

If using the Smartphone version, you can choose a camera angle from the list that appears when you click [Angle] in the Tool Property pal-

ette.

The selected camera angle is reflected in the 3D material.

For details on how to use the camera, see "Operations Using the Movement Manipulator".

Select a camera angle from the list.
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Explanation: 3D Materials > Operations Using the Movement Manipulator > Functions of the Movement Manipulator
 Operations Using the Movement Manipulator
The movement manipulator is a series of buttons to edit a selected 3D material or 3D layer. It is shown in the upper part
of a 3D material selected using the [Object] tool. Placing the mouse cursor over a button and dragging it allows you to
change the position or angle. You can also switch between movement methods when dragging the canvas by clicking
each of the buttons.

Functions of the Movement Manipulator
This section describes the functions of the movement manipulator.

 

(1) Rotate camera

Rotates the 3D layer camera vertically and horizontally.

To switch between movement methods by clicking each of the buttons, click [Operation of transparent part] on the 

Tool Property palette of the [Object] tool and turn on [Use 3D layer].

Movement manipulator

Select the character 

and drag          .
The whole 3D layer rotates.
CLIP STUDIO PAINT Instruction Manual 1240



Explanation: 3D Materials > Operations Using the Movement Manipulator > Functions of the Movement Manipulator
(2) Translate camera

Translates the 3D layer camera up and down, and left and right.

(3) Move camera back and forth

Moves the 3D layer camera back and forth.

Clicking [Rotate camera] also allows you to rotate the camera by dragging the canvas.

 Clicking [Translate camera] also allows you to translate the camera by dragging the canvas.

 You can also move the position of the camera by holding down the mouse wheel and dragging.

 Clicking [Move camera back and forth] also allows you to move the camera back and forth by dragging the 

canvas.

 You can also move the camera back and forth by right-clicking and dragging the canvas.

Select the character 

and drag           .
The whole 3D layer moves.

Select the character 

and drag          .

The whole 3D layer

moves back and forth.
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Explanation: 3D Materials > Operations Using the Movement Manipulator > Functions of the Movement Manipulator
(4) Move on plane

Selected 3D materials and parts can be moved on a plane facing the camera. This item is not displayed when a 3D background material is 

selected.

(5) Camera view rotation

Selected 3D materials and parts can be rotated on a plane facing the camera. The rotation direction changes with the icon's dragging direc-

tion. This item is not displayed when a 3D background material is selected.

 Dragging horizontally will rotate the material along the y axis.

 Clicking the [Move on plane] icon also allows you to move 3D materials by dragging on the canvas.

 For information on 3D background materials, see "3D Background Materials".

Drag            .

Drag           horizontally.

y axis
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Explanation: 3D Materials > Operations Using the Movement Manipulator > Functions of the Movement Manipulator
 Dragging vertically will rotate the material along the x axis.

 Dragging in any other direction will rotate the material freely.

 Clicking the [Camera view rotation] icon also allows you to rotate 3D materials and parts by dragging on the 

canvas.

 3D character materials and 3D drawing Figures will rotate from the waist.

 The origin point of 3D object materials may change depending on the material. When selecting entire 3D 

object materials, the position of the Root manipulator controller becomes the origin point. When parts are 

selected, the position of the [Part manipulator] controller becomes the origin point.

 For information on 3D background materials, see "3D Background Materials".

Drag            vertically.

x axis

Drag            diagonally.
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Explanation: 3D Materials > Operations Using the Movement Manipulator > Functions of the Movement Manipulator
(6) Plane rotation

Selected 3D materials and parts can be rotated on a plane facing the camera. This item is not displayed when a 3D background material is 

selected.

(7) Rotate in 3D space

Selected 3D materials and parts can be rotated horizontally in 3D space. This item is not displayed when a 3D background material is 

selected.

 Clicking the [Plane rotation] icon also allows you to rotate 3D materials and parts by dragging on the canvas.

 3D character materials and 3D drawing Figures will rotate from the waist.

 The origin point of 3D object materials may change depending on the material. When selecting entire 3D 

object materials, the position of the Root manipulator controller becomes the origin point. When parts are 

selected, the position of the [Part manipulator] controller becomes the origin point.

 For information on 3D background materials, see "3D Background Materials".

 Clicking the [Rotate in 3D space] icon also allows you to rotate 3D materials and parts by dragging on the can-

vas.

 3D character materials and 3D drawing Figures will rotate from the waist.

 The origin point of 3D object materials may change depending on the material. When selecting entire 3D 

object materials, the position of the Root manipulator controller becomes the origin point. When parts are 

selected, the position of the [Part manipulator] controller becomes the origin point.

 For information on 3D background materials, see "3D Background Materials".

Drag           .

Drag          .
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Explanation: 3D Materials  > Operations Using the Movement Manipulator
(8) Snap and move

Moves selected 3D materials and parts while snapping to the base of the 3D space (floor) and nearby 3D materials. This item is not dis-

played when a 3D background material is selected.

 Base of the 3D space means the grid displayed when a 3D material is clicked. It is equivalent to the floor of the 

3D space.

 Clicking the [Snap move] icon allows you to move 3D materials and parts while snapping to the base of the 3D 

space by dragging the canvas.

 For information on 3D background materials, see "3D Background Materials".

Drag          .
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Explanation: 3D Materials > Operations Using the Object Launcher > Buttons Common to All 3D Materials
 Operations Using the Object Launcher
The [Object launcher] is a launcher shown in the lower part of a 3D material selected using the [Object] tool. Displayed
buttons vary depending on the selected 3D material type. The function of each button in the object launcher is as
described below.

Buttons Common to All 3D Materials
Selecting a 3D material displays the following buttons.

 

(1) Select previous 3D object [Windows/macOS/Tablet]

When multiple 3D materials are included in a 3D layer, switches the selected 3D material.

(2) Select next 3D object [Windows/macOS/Tablet]

When multiple 3D materials are included in a 3D layer, switches the selected 3D material.

(3) Object List [PRO/EX]

Click to display the Sub Tool Detail palette's [Object list] category. You can select and change the settings of 3D materials using the 

[Object list].

(4) Camera [Windows/macOS/Tablet]

Click to display a list of camera angles. Select the camera angle to use in the 3D layer.

(5) Focus on editing target

Moves the camera in such a way that the selected 3D material is displayed in the center of the 3D space.

 When a 3D character material or a part of a 3D pose model is selected, the selection is displayed in the center.

 When a specific part of a 3D object material is selected, the selected part will be centered on the screen.

 This item is not displayed when a 3D background material is selected.

 Some of the buttons may not display depending on the selected 3D material.

 If using the Smartphone version, some settings may be hidden. You can adjust them from the Sub Tool Detail 

palette. For details, see "Setting Items on the Sub Tool Detail palette".

Object launcher
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Explanation: 3D Materials > Operations Using the Object Launcher > When a 3D Character Material Is Selected
(6) Ground

Grounds the 3D material to the base (floor) of the 3D space. When a specific part of a 3D object material is selected, the selected part will 

be grounded to the 3D space's base. This item is not displayed when a 3D background material is selected.

When a 3D Character Material Is Selected
Selecting a 3D character material displays the following additional buttons.

(1) Register full body pose as material [Windows/macOS/Tablet] [PRO/EX]

Registers the pose of the 3D character to the Material palette.

Click the downward arrow (▼) to show the [Register right hand pose as material] and [Register left hand pose as material] options. Select-

ing either will register the hand pose to the Material palette. Registered hand poses can be applied to both right and left hands.

(2) Flip Horizontal [Windows/macOS/Tablet]

Horizontally reverses the pose of the 3D character material.

(3) Initial pose

Resets the pose settings to the initial pose.

(4) Reset scale [Windows/macOS/Tablet]

The scale of 3D characters edited with the Tool Property palette’s [Object scale] or the Root manipulator's [Scale] can be reset to their 

default scale. 

(5) Reset Rotation

The rotation of 3D characters edited with the Movement manipulator or Root manipulator can be reset to their default scale. 

 Base of the 3D space means the grid displayed when a 3D material is clicked. It is equivalent to the floor of the 

3D space.

 For information on 3D background materials, see "3D Background Materials".

 Some of the buttons may not display for 3D layers compatible with Ver 1.5.

 Some of the buttons may not display if connected to QUMARION.

 If using the Smartphone version, some settings may be hidden. You can adjust them from the Sub Tool Detail 

palette. For details, see "Setting Items on the Sub Tool Detail palette".

Windows/macOS

Tablet

Smartphone
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Explanation: 3D Materials > Operations Using the Object Launcher > When a 3D Character Material Is Selected
(6) Enable/disable physical calculation [Windows/macOS/Tablet]

Enables/disables physical calculation for a 3D character with physical settings imported from Clip Studio Modeler or Clip Studio Coordi-

nate.

If enabled, physical calculations are reflected when the 3D character is moved.

(7) Pose Scanner (image) (Technology preview)

This reads a photo containing a figure and applies the figure's pose to 3D materials. Importable file formats are: BMP, JPEG, PNG, TIFF 

and Targa.

Clicking [▼] shows the [Use 3D pose materials]. The [Use 3D pose material] dialog box will be shown, allowing your to apply pose mate-

rials to 3D character materials.

(8) Pose Scanner (camera) [Tablet/Smartphone]

The [Pose Scanner (camera)] reads a photo taken with your Tablet/Smartphone and applies the figure’s pose to a 3D character material.

Click the down arrow (▼) to show the following options.

(9) Fix joint [Windows/macOS/Tablet]

The joint of the selected part will be fixed. If a part where the joint is already fixed is selected, the fixed joint will be released.

(10)Release all fixed joints [Windows/macOS/Tablet]

All fixed joints for the selected 3D character will be released.

(11) Face parts [Windows/macOS/Tablet]

Click to display a list of face parts for the character. Select the desired face part for the selected 3D character material.

(12)Facial expression list [Windows/macOS/Tablet]

Click to display a list of facial expressions for the character. Select the desired facial expression for the selected 3D character material.

 For details on Clip Studio Modeler and Clip Studio Coordinate, see clipstudio.net.

 Importing a 3D character material with physical settings may slow Clip Studio Paint. Turning off [Enable/dis-

able physical calculation] may improve the processing speed.

 The Pose Scanner is a technology preview function. Try out these features before their official release.

 When you use the Pose Scanner feature, the image data is uploaded to the server, where the AI interprets the 

data and estimates the pose. A network connection is necessary to execute this function. For information on 

the image uploaded to the server and the generated data, see "About AI features".

Pose Scanner (image) 
This reads a photo containing a figure and applies the figure's pose to 3D materials. Importable 

file formats are: BMP, JPEG, PNG, TIFF and Targa.

Pose Scanner (photo library) 

[iPad/iPhone]

This reads a photo containing a figure from the iPad/iPhone photo library and applies the figure's 

pose to 3D character materials.

Pose Scanner (Storage)

[Android/Chromebook]

This reads a photo containing a figure from the OS file management screen and applies the fig-

ure's pose to 3D character materials.

Use 3D pose materials
The [Use 3D pose material] dialog box will be shown, allowing your to apply pose materials to 

3D character materials.

 The Pose Scanner is a technology preview function. Try out these features before their official release!

 When you use this feature, the image data is uploaded to the server, where the AI interprets the data and esti-

mates the pose. A network connection is necessary to execute this function. For information on the image 

uploaded to the server and the generated data, see "About AI features".
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Explanation: 3D Materials > Operations Using the Object Launcher > When a 3D Drawing Figure Is Selected
(13)Hair [Windows/macOS/Tablet]

Click to display a list of hair styles for the character. Select the desired hair style for the selected 3D character material.

(14)Body [Windows/macOS/Tablet]

Click to display a list of bodies (clothes) for the character. Select the desired body for the selected 3D character material.

(15)Accessories [Windows/macOS/Tablet]

Click to display a list of accessories for the character. Select the desired accessory (accessories) for the selected 3D character material.

When a 3D Drawing Figure Is Selected
Selecting a 3D drawing figure displays the following additional buttons.

(1) Register full body pose as material [Windows/macOS/Tablet] [PRO/EX]

Registers the 3D drawing figure pose to the Material palette.

Click the downward arrow (▼) to show the [Register right hand pose as material] and [Register left hand pose as material] options. Select-

ing either will register the hand pose to the Material palette. Registered hand poses can be applied to both right and left hands.

(2) Flip Horizontal [Windows/macOS/Tablet]

Horizontally reverses the 3D drawing figure pose.

(3) Initial pose

Resets the pose settings to the initial pose.

(4) Reset scale [Windows/macOS/Tablet]

The scale of 3D drawing figures edited with the Tool Property palette’s [Object scale] or the Root manipulator’s [Scale] can be reset to 

their default scale. 

(5) Reset Rotation

The rotation of 3D drawing figures edited with the Movement manipulator or Root manipulator can be reset to their default scale.

(6) Register body shape [Windows/macOS/Tablet] [PRO/EX]

Registers the configured 3D drawing figure's body shape to the Material palette.

 Some of the buttons may not display for 3D layers compatible with Ver 1.5.

 Some of the buttons may not display if connected to QUMARION.

 If using the Smartphone version, some settings may be hidden. You can adjust them from the Sub Tool Detail 

palette. For details, see "Setting Items on the Sub Tool Detail palette".

Windows /macOS

Tablet

Smartphone
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Explanation: 3D Materials > Operations Using the Object Launcher > When a 3D Drawing Figure Is Selected
(7) Pose Scanner (image) (Technology preview) [Windows/macOS]

This reads a photo containing a figure and applies the figure's pose to 3D drawing figures. Importable file formats are: BMP, JPEG, PNG, 

TIFF and Targa.

Clicking [▼] shows the [Use 3D pose materials]. The [Use 3D pose material] dialog box will be shown, allowing you to apply pose mate-

rials to 3D drawing figures.

(8) Pose Scanner (camera) [Tablet/Smartphone]

The [Pose Scanner (camera)] reads a photo taken with your Tablet/Smartphone and applies the figure’s pose to a 3D drawing figure.

Click the down arrow (▼) to show the following options.

(9) Fix joint [Windows/macOS/Tablet]

The joint of the selected part will be fixed. If a part where the joint is already fixed is selected, fixation will be released.

(10)Release all fixed joints [Windows/macOS/Tablet]

All fixed joints for the selected 3D character will be released.

(11) Adjust body shape and size of 3D drawing figure in detail [PRO/EX]

Click this to display the [Body shape] section of the Sub Tool Detail palette. You can change the body shape of the selected 3D drawing 

figure. Clicking it again hides the Sub Tool Detail palette.

 The Pose Scanner is a technology preview function. Try out these features before their official release.

 When you use the Pose Scanner feature, the image data is uploaded to the server, where the AI interprets the 

data and estimates the pose. A network connection is necessary to execute this function. For information on 

the image uploaded to the server and the generated data, see "About AI features".

Pose Scanner (image)
This reads a photo containing a figure and applies the figure's pose to 3D drawing figures. 

Importable file formats are: BMP, JPEG, PNG, TIFF and Targa.

Pose Scanner (photo library) 

[iPad/iPhone]

This reads a photo containing a figure from the iPad photo library and applies the figure's pose to 

3D drawing figures.

Pose Scanner (Storage)

[Android/Chromebook]

This reads a photo containing a figure from the OS file management screen and applies the fig-

ure's pose to a 3D drawing figure.

Use 3D pose materials
The [Use 3D pose material] dialog box will be shown, allowing you to apply pose materials to 

3D drawing figures.

 The Pose Scanner is a technology preview function. Try out these features before their official release!

 When you use the Pose Scanner feature, the image data is uploaded to the server, where the AI interprets the 

data and estimates the pose. A network connection is necessary to execute this function. For information on 

the image uploaded to the server and the generated data, see "About AI features".
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Explanation: 3D Materials > Operations Using the Object Launcher > If a 3D object material is selected
If a 3D object material is selected
Selecting a 3D object material displays the following additional buttons.

(1) Initial pose [Windows/macOS/Tablet]

If a 3D material has multiple parts, the parts will be set to their default position.

(2) Reset scale

The scale of 3D object materials edited with the Tool Property palette's [Object scale] or the Root manipulator's [Scale] can be reset to 

their default scale.

(3) Reset Rotation

The rotation of 3D object materials edited with the Movement manipulator or Root manipulator can be reset to their default scale. 

(4) Material [Windows/macOS/Tablet]

Click to display a list of materials. Select the desired material for the selected 3D object material. Selecting a material allows you to 

change the tone and texture of the 3D object material.

Some of the buttons may not display for 3D layers compatible with Ver 1.5.

Smartphone

Windows/macOS/Tablet
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Explanation: 3D Materials > Operations Using the Object Launcher > If a 3D object material is selected
(5) Layout

Click to display a list of layouts for the 3D object material. Select the desired layout for the selected 3D object material. The allocation of 

3D object materials can be changed by selecting a layout.

(6) Movable parts

Click to display a list of pose parts set for the 3D object material. A slider can be used to adjust the position of a pose part.
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Explanation: 3D Materials > Operations Using the Object Launcher > When a 3D Background Material Is Selected
When a 3D Background Material Is Selected
Selecting a 3D background material displays the following additional buttons.

(1) Material [Windows/macOS/Tablet]

Click to display a list of materials. Select the desired material for the selected 3D background material. Selecting a material allows you to 

change the tone and texture of the 3D background material.

(2) Layout [Windows/macOS/Tablet]

Click to display a list of layouts. Select the desired layout for the selected 3D background material. Changing the layout allows you to hide 

certain parts or change some parts.

For information on 3D background materials, see "3D Background Materials".
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Explanation: 3D Materials > Operations Using the Object Launcher > When a 3D Background Material Is Selected
(3) Movable parts [Windows/macOS/Tablet]

Click to display a list of pose parts set for the 3D background material. Adjust the position of the pose part using the sliders.
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Explanation: 3D Materials > Operations Using the Object Launcher > When QUMARION Is Connected [Windows/macOS]
When QUMARION Is Connected [Windows/macOS]
When QUMARION is connected, selecting a 3D character material or 3D drawing figure displays the following additional buttons.

(1) Enable QUMARION

Enables/disables input from QUMARION. When multiple QUMARION are connected, as many [Enable QUMARION] as the number of 

connected QUMARION will display.

 When turned on, input from the selected QUMARION is enabled, and the pose of the 3D character material can be created by operat-

ing from the selected QUMARION.

 When turned off, input from the selected QUMARION is disabled, and the pose of the 3D character material is created by operating 

the mouse.

When there are multiple 3D characters, the operation becomes as follows.

In this example, two 3D characters, one "male student" for which input from QUMARION is enabled, and one "female student" are 

assumed.

Macs with Apple M1 chips do not support the QUMALION.

For detailed product information on QUMARION, see the official website of the QUMARION Drawing Doll Input 

Device.

You can connect up to 5 QUMARION.

One QUMARION connected Multiple QUMARION connected

Input enabled

Can be operated with QUMARION 

since             is displayed in blue.
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Explanation: 3D Materials > Operations Using the Object Launcher > When QUMARION Is Connected [Windows/macOS]
When the "male student" is selected, [Enable QUMARION] is displayed in blue. When displayed in blue, the selected 3D character mate-

rial can be operated with QUMARION.

When the "female student" is selected, [Enable QUMARION] is displayed in red. If [Enable QUMARION] is turned on for the "female 

student", [Enable QUMARION] will display in blue, enabling operation of the "female student" with QUMARION. In this case, input to 

the "male student" is disabled.

(2) Always ground

When turned on, the 3D character material will always be grounded to the base of the 3D space (floor) when operated with QUMARION.

(3) Calibration

Allows creating a pose by QUMARION from the pose of the 3D character material on the screen.

In normal operations, clicking [Enable QUMARION] aligns the pose of the 3D character material on the screen to the current pose of 

QUMARION.

Clicking [Calibration] before clicking [Enable QUMARION] allows you to create a pose by QUMARION from the pose of the 3D charac-

ter material on the screen.

(4) Acceleration sensor

When turned on, the acceleration sensor embedded in QUMARION is enabled.

 To correct a previously created pose, you must first align the pose of QUMARION to that of the 3D character 

material on the screen without moving it. You can continue creating the pose on the screen by using [Calibra-

tion] after approximating the pose of QUMARION to that displayed on the screen.

 [Calibration] is possible even when the pose of QUMARION is not aligned with that of the 3D character mate-

rial displayed on the screen. For details on how to correct, see "Explanation: When Displayed 3D Character Is 

Misaligned".

Input enabled

Cannot be operated with QUMARION 

since             is displayed in red.

Clicking this button again makes the button

become blue (           ), enabling operation

with QUMARION.

In this case, input to "male student" is disabled.
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Explanation: 3D Materials > Operations Using QUMARION [Windows/macOS] > When QUMARION Is Connected [Windows/macOS]
 Operations Using QUMARION [Windows/macOS]
Clip Studio Paint supports QUMARION. Creating the pose with QUMARION allows you to operate the 3D character
material more intuitively.

 Do not connect/disconnect QUMARION to/from your computer while Clip Studio Paint is running. Doing so 

may destabilize Clip Studio Paint.

 Macs with Apple M1 chips do not support the QUMALION.

 For details on how to connect or operate QUMARION, see the manuals supplied with QUMARION.

 You can adjust how QUMARION operates from the [Object launcher]. For details, see "When QUMARION Is 

Connected [Windows/macOS]".

 For detailed product information on QUMARION, see the official website of the QUMARION Drawing Doll Input 

Device.
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Explanation: 3D Materials > Operations Using QUMARION [Windows/macOS] > Connect QUMARION
Connect QUMARION
To connect QUMARION to a computer, proceed as follows.

1 Connect QUMARION
Connect QUMARION to your computer using the supplied USB cable.

(1) The USB cable connection port on QUMARION side is located in the lower part of the grip on the back. Connect the smaller plug of 

the supplied USB cable to QUMARION.

(2) Connect the larger plug of the supplied USB cable to a USB port on your computer.

2 Start the application
Start Clip Studio Paint.

If Clip Studio Paint is running, be sure to quit before connecting QUMARION.

 The driver may install automatically when QUMARION is connected for the first time. Install the driver by fol-

lowing the on-screen instructions.

 When connected through a USB hub, QUMARION may not work correctly. Therefore, direct connection to a 

USB port on your computer is recommended.

 The shape of the USB cable connection port on QUMARION is narrow. You may not be able to connect prop-

erly using a commercially available USB cable.

 When connecting, be careful about the connector orientation. Inserting an inverted connector forcefully may 

damage QUMARION and/or your computer.

Back grip

Larger plug

To computer

gggggggggggggggggggggg

Smaller plugg

USB cable port
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Explanation: 3D Materials > Operations Using QUMARION [Windows/macOS] > Using QUMARION
Using QUMARION
To add pose to a 3D character material, 3D drawing figure and the like using QUMARION, proceed as follows.

1  Select the command
Select [Use QUMARION] from the menu.

 Windows Users: Select [File] menu > [QUMARION] > [Use QUMARION].

 macOS users: Select [CLIP STUDIO PAINT] menu > [QUMARION] > [Use QUMARION].

2 Import the 3D character material
Create a new canvas and import the 3D character material to the canvas.

3 Enable QUMARION
On the [Object launcher], click [Enable QUMARION] for the QUMARION to operate. Input from the selected QUMARION is enabled so 

that the Clip Studio Paint 3D character material can be operated from QUMARION.

You will not be able to use QUMARION without turning on [Use QUMARION]. Once turned on, [Use QUMARION] 

remains enabled until you quit Clip Studio Paint.

One QUMARION connected Multiple QUMARION connected
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Explanation: 3D Materials > Operations Using QUMARION [Windows/macOS] > Using QUMARION
4 Create a pose with QUMARION
Operate the QUMARION. The 3D character material imported to the canvas automatically takes the same pose.

5 Disable QUMARION
When you are satisfied with the 3D character pose, click [Enable QUMARION] on the [Object launcher]. The input from QUMARION is 

disabled.

You can adjust how QUMARION operates from the [Object launcher]. For details, see "When QUMARION Is Con-

nected [Windows/macOS]".

QUMARION

CLIP STUDIO PAINT

Create a pose by

operating QUMARION.

The 3D character material

takes the same pose as

QUMARION.
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Explanation: 3D Materials > Operations Using QUMARION [Windows/macOS] > Disconnect QUMARION
Disconnect QUMARION
To disconnect QUMARION from the computer, proceed as follows.

1 Quit the application
Close Clip Studio Paint.

2 Disconnect QUMARION
Unplug the USB cable from QUMARION.

Back grip

To computer

USB cable port
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Explanation: 3D Materials > Operations Using Palettes > Operating Procedure
 Operations Using Palettes
You can edit the settings of a 3D material with the Tool Property, Sub Tool Detail, Layer Property and All Sides View pal-
ettes.

Operating Procedure
This section explains how to configure 3D materials using the palette.

Tool property Palette
This section explains how to configure 3D materials using the Tool Property palette.

1 Selecting 3D Object Materials
Select [Object] of the [Operation] tool, then click the 3D object material to edit.

2 Configure the tool property palette
On the Tool Property palette, configure settings such as the camera angle.

(1) Select the camera angle from [Angle] > [Preset].

(2) Fine adjust the display size of the 3D object material with [Object scale].

The Sub Tool Detail palette (only available in PRO/EX) is shown when [Window] menu > [Sub Tool Detail] is 

checked. It allows for more detailed settings than the Tool Property palette. Some settings appear in both the Sub 

Tool Detail palette and the Tool Property under the same name.

Click
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Explanation: 3D Materials > Operations Using Palettes > Operating Procedure
3 The settings are reflected
The settings are reflected in the 3D object material on the canvas.

Layer Property Palette [PRO/EX]
To edit a 3D layer using the Layer Property palette, proceed as follows.

1 Select the layer
In the Layer palette, select the 3D layer you want to edit.

2 Configure the Layer Property Palette
Configure the Layer Property palette.

(1) Turn on [Border effect].

(2) Turn on [Edge].

(3) Configure the thickness of the edges with the [Thickness of edges] slider.

(4) Click the color display for [Edge color] and select the edge color from the [Color settings] dialog.

Opening the Sub Tool Detail palette from [Sub Tool Detail] on the Tool Property palette will allow you to make more 

detailed adjustments. For details on the Tool Property and Sub Tool Detail palettes, see the “Clip Studio Paint Tool 

Setting Guide."

 For details on the Layer Property palette, see "Functions of Layer Property Palette".

 For details on the [Color settings] dialog box, see "Advanced settings of color Dialog Box".
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Explanation: 3D Materials > Operations Using Palettes > Operating Procedure
3 The settings are reflected
The settings are reflected in the canvas.

All Sides View Palette [EX]
You can also view 3D materials from four directions at the same time using the All Sides View palette. This section explains how to configure 

3D materials using the All Sides View palette. For example, you can adjust the position and pose of a character while viewing from the All 

Sides View palette.

1 Select the 3D material
Select [Object] of the [Operation] tool, then click the 3D material to edit.
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Explanation: 3D Materials > Operations Using Palettes > Operating Procedure
2 Adjusting the Display of the All Sides View Palette
You can zoom into parts that you want to check in the flat-plane views in the All Sides View palette.

(1) Right-click and drag the mouse downward to zoom in.

(2) Next, hold down the mouse wheel and drag to adjust the position.

 For how to change the display of the All Sides View palette, see "Changing the All sides View Display".

 Click [View window layout] on the All Sides View palette to change the direction of the flat-plane views shown 

on the All Sides View palette.

 The view of the All Sides View palette can also be changed using the movement manipulators on the All Sides 

View palette.

Right drag

Drag the wheel
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Explanation: 3D Materials > Operations Using Palettes > Setting Items on the Sub Tool Detail palette
3 Editing a 3D material
It is possible to edit the layout of a 3D material while viewing it in the All Sides View palette.

Setting Items on the Sub Tool Detail palette
The settings items displayed on the [Sub Tool Detail] when a 3D material is selected depend on the type of 3D material that is selected. For 

details, see the Clip Studio Paint Tool Setting Guide.

 3D materials can be edited with the mouse in the All Sides View palette the same way as on the canvas.

 You can change the position of the camera and focal point in the All Sides View palette. For details, see 

"Changing the Camera Position".

The Sub Tool Detail palette (only available in PRO/EX) is shown when [Window] menu > [Sub Tool Detail] is 

checked. It allows for more detailed settings than the Tool Property palette. Some settings appear in both the Sub 

Tool Detail palette and the Tool Property under the same name.

If a 3D object material is selected

CLIP STUDIO PAINT Tool Setting Guide > Tool and Sub Tool Categories > Input/

Output Process/Category List (by Tool and Sub Tool) > Object (3D Object Mate-

rial)

When a 3D Character Material Is Selected

CLIP STUDIO PAINT Tool Setting Guide > Tool and Sub Tool Categories > Input/

Output Process/Category List (by Tool and Sub Tool) > Object (3D Character 

Material)

When a 3D Drawing Figure Is Selected

CLIP STUDIO PAINT Tool Setting Guide > Tool and Sub Tool Categories > Input/

Output Process/Category List (by Tool and Sub Tool) > Object (3D Drawing Fig-

ure)

When a 3D Background Material Is Selected

CLIP STUDIO PAINT Tool Setting Guide > Tool and Sub Tool Categories > Input/

Output Process/Category List (by Tool and Sub Tool) > Object (3D Background 

Material)

When Another 3D Material Is Selected

CLIP STUDIO PAINT Tool Setting Guide > Tool and Sub Tool Categories > Input/

Output Process/Category List (by Tool and Sub Tool) > Object (3D Object Mate-

rial)
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Explanation: Ruler [PRO/
EX]
The chapter describes how to create, edit, and delete rulers.

 What Is a Ruler?

 Creating a Ruler

 Drawing by Snapping to a Ruler

 Editing a Ruler

 Deleting a Ruler



Explanation: Ruler [PRO/EX] > What Is a Ruler? > 
Explanation: Ruler [PRO/EX]

 What Is a Ruler?
Rulers are created for a layer being edited. On raster layers and vector layers, you can snap the pen motion to rulers.
Selecting the [Ruler] tool allows you to create a ruler.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then selecting [Cre-

ate ruler] on the Sub Tool palette.
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Explanation: Ruler [PRO/EX] > What Is a Ruler? > Types of Rulers
Types of Rulers
The following rulers are provided in the sub tools of the [Ruler] tool.

Linear ruler
Creates a single straight line or curved line (Quadratic Bezier, Cubic Bezier) ruler.

Curve ruler
Creates a straight line or curved line (Spline, Quadratic Bezier, Cubic Bezier) ruler connecting multiple points.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then selecting [Cre-

ate ruler] on the Sub Tool palette.

Linear ruler (Straight line) Linear ruler (Quadratic Bezier)

Curve ruler (Spline) Curve ruler (Straight line)
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Explanation: Ruler [PRO/EX] > What Is a Ruler? > Types of Rulers
Figure ruler
Creates figure rulers such as rectangles and ellipses.

Ruler pen
Creates a ruler in the shape of a pen drawing.

Figure ruler (Ellipse) Figure ruler (Rectangle)

Ruler pen
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Explanation: Ruler [PRO/EX] > What Is a Ruler? > Types of Rulers
Special ruler
Includes special rulers for other effects.

You can choose from the Parallel line ruler, Parallel curve ruler, Multiple curve ruler, Radial line ruler, Radial curve ruler, Concentric circle 

ruler and Guides.

Parallel line

Special ruler (Parallel line)
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Explanation: Ruler [PRO/EX] > What Is a Ruler? > Types of Rulers
Parallel curve

Multiple curve

Radial line

Special ruler (Parallel curve)

Special ruler (Multiple curve)

Special ruler (Focus line)
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Explanation: Ruler [PRO/EX] > What Is a Ruler? > Types of Rulers
Radial curve

Concentric circle

Special ruler (Focus curve)

Special ruler (Concentric circle)
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Explanation: Ruler [PRO/EX] > What Is a Ruler? > Types of Rulers
Guide

Symmetrical ruler
This ruler is used for drawing bilaterally symmetric objects, geometric patterns, etc. You can draw in symmetrical positions with the ruler as the 

axis.

Drag the ruler onto the canvas to create a guide. You can drag a guide outside of the canvas with the [Object] sub 

tool to delete it.

Special ruler (Guide)

Symmetrical ruler: Number of lines 5
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Linear ruler
 Creating a Ruler
This section describes how to create a ruler for each type of ruler.

Linear ruler
To create a [Linear ruler], proceed as follows.

1 On the Layer palette, select the layer where to create the ruler.

2 Select the [Ruler] tool from the Tool palette.

3 Select the [Linear ruler] sub tool from the Sub Tool palette.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then selecting [Cre-

ate ruler] on the Sub Tool palette.

You can configure the ruler destination in [Create at editing layer] on the Tool Property palette.

 If [Create at editing layer] is turned on, the ruler is created in the layer being edited.

 If [Create at editing layer] is turned off, a layer is created at the bottom of the Layer palette, and the ruler, cre-

ated there.
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Curve ruler
4 On the canvas, drag from the starting point to the end point of the ruler.
The ruler is created.

Creating a ruler displays a ruler icon on the Layer palette.

Curve ruler
To create a [Curve ruler], proceed as follows.

1 On the Layer palette, select the layer where to create the ruler.

2 Select the [Ruler] tool from the Tool palette.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then selecting [Cre-

ate ruler] on the Sub Tool palette.
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Curve ruler
3 Select the [Curve ruler] sub tool from the Sub Tool palette.

4 On the [Tool Property] palette > [Curve], select a drawing method.
In this example, [Spline] is selected.

You can configure the ruler destination in [Create at editing layer] on the Tool Property palette.

 If [Create at editing layer] is turned on, the ruler is created in the layer being edited.

 If [Create at editing layer] is turned off, a layer is created at the bottom of the Layer palette, and the ruler, cre-

ated there.
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Curve ruler
5 Specify the points that will be connected by the curve.
Double clicking commits the drawn line and creates the ruler.

Creating a ruler displays a ruler icon on the Layer palette.

The drawing method for [Curve ruler] is the same as that for [Continuous curve] of the [Figure] tool. For details on 

how to draw with [Curve rulers] other than [Spline], see "Drawing Continuous curves & Bezier curves".
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Figure ruler
Figure ruler
To create a [Figure ruler], proceed as follows.

1 On the Layer palette, select the layer where to create the ruler.

2 Select the [Ruler] tool from the Tool palette.

3 Select the [Figure ruler] sub tool from the Sub Tool palette.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then selecting [Cre-

ate ruler] on the Sub Tool palette.
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Figure ruler
4 On the [Tool Property] palette > [Figure], select the shape for the ruler.
In this example, [Rectangle] is selected.

5 Drag on the canvas to create the ruler.

(1) Drag while pressing the mouse button in the diagonal direction of the shape. Release the mouse button at the end point.

(2) Dragging the canvas rotates the shape, allowing you to adjust its angle.

(3) Clicking the canvas creates the ruler.

Creating a ruler displays a ruler icon on the Layer palette.

You can configure the ruler destination in [Create at editing layer] on the Tool Property palette.

 If [Create at editing layer] is turned on, the ruler is created in the layer being edited.

 If [Create at editing layer] is turned off, a layer is created at the bottom of the Layer palette, and the ruler, cre-

ated there.
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Ruler pen
Ruler pen
To create a [Ruler pen], proceed as follows.

1 On the Layer palette, select the layer where to create the ruler.

2 Select the [Ruler] tool from the Tool palette.

3 Select the [Ruler pen] sub tool from the Sub Tool palette.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then selecting [Cre-

ate ruler] on the Sub Tool palette.

You can configure the ruler destination in [Create at editing layer] on the Tool Property palette.

 If [Create at editing layer] is turned on, the ruler is created in the layer being edited.

 If [Create at editing layer] is turned off, a layer is created at the bottom of the Layer palette, and the ruler, cre-

ated there.
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Ruler pen
4 Draw on the canvas.
The ruler is created.

Creating a ruler displays a ruler icon on the Layer palette.
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Special ruler
Special ruler
To create a special ruler, proceed as follows.

1 On the Layer palette, select the layer where to create the ruler.

2 Select the [Ruler] tool from the Tool palette.

3 On the Sub Tool palette, select [Special ruler].

4 In the Tool Property palette, select the type of the special ruler.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then selecting [Cre-

ate ruler] on the Sub Tool palette.
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Special ruler
5 Create the ruler on the canvas.
Creating a ruler displays a ruler icon on the Layer palette.

The procedure to create a ruler varies depending on the shape selected in [Special ruler].

Parallel line

Drag on the canvas and adjust the ruler angle. Releasing the left button of the mouse creates the ruler.

You can configure the ruler destination in [Create at editing layer] on the Tool Property palette.

 If [Create at editing layer] is turned on, the ruler is created in the layer being edited.

 If [Create at editing layer] is turned off, a layer is created at the bottom of the Layer palette, and the ruler, cre-

ated there. However for [Guide], if a layer named "Guide" is present, the ruler is created there.
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Special ruler
Parallel curve

Specify the points that will be connected by the curve. Double clicking confirms the line and creates the ruler.

Multiple curve

Specify the points that will be connected by the curve. Double clicking confirms the line and creates the ruler.

The method for drawing parallel curve rulers is the same as drawing a continuous curve with the [Figure] tool. For 

details on how to draw parallel curve rulers other than [Spline], see "Drawing Continuous curves & Bezier curves".

 The method for drawing multiple curve rulers is the same as drawing a continuous curve with the [Figure] tool. 

For details on how to draw with multiple curve rulers other than [Spline], see "Drawing Continuous curves & 

Bezier curves".

 Selecting a ruler with the [Object] sub tool displays the rotation handle. Drag the rotation handle to set how the 

lines will follow the shape of the ruler. For details on how to configure, see "Multiple curve ruler".
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Special ruler
Radial line

Clicking on the canvas creates the ruler. The clicked position will be the center of rotation.

Radial curve

(1) Click the point to locate the center of the ruler.

(2) Specify multiple points and draw a curved line connecting those points. Double clicking commits the drawn line and creates the ruler.
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Special ruler
Concentric circle

(1) From the desired center of the ruler, drag diagonally while pressing the mouse button. Release the mouse button at the end point.

(2) Dragging the canvas rotates the shape, allowing you to adjust its angle.

(3) Clicking the canvas commits the drawn line and creates the ruler.

Guide

(1) Drag from the point to create a guide. Drag in the horizontal direction to create a horizontal guide, and in the vertical direction to cre-

ate a vertical guide.

(2) Release the mouse button when a preview displays in the desired guide direction.

(3) A horizontal or vertical guide is created.

The drawing method for [Radial curve ruler] is the same as that for [Continuous curve] of the [Figure] tool. For 

details on how to draw with [Radial curve rulers] other than [Spline], see "Drawing Continuous curves & Bezier 

curves".

Preview of guide

Drag
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Symmetrical ruler
Symmetrical ruler
To create a [Symmetrical ruler], proceed as follows.

1 On the Layer palette, select the layer where to create the ruler.

2 Select the [Ruler] tool from the Tool palette.

3 Select the [Symmetrical ruler] sub tool from the Sub Tool palette.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then selecting [Cre-

ate ruler] on the Sub Tool palette.

You can configure the ruler destination in [Create at editing layer] on the Tool Property palette.

 If [Create at editing layer] is turned on, the ruler is created in the layer being edited.

 If [Create at editing layer] is turned off, a layer is created at the bottom of the Layer palette, and the ruler, cre-

ated there.
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Explanation: Ruler [PRO/EX] > Creating a Ruler > Symmetrical ruler
4 On the Tool Property palette, configure the number of the lines of the symmetrical ruler,
etc.

5 On the canvas, drag from the starting point to the end point of the ruler.
The ruler is created.

Creating a ruler displays a ruler icon on the Layer palette.

For details on the setting items in the Tool Property palette, see Create symmetrical ruler in the “Clip Studio Paint 

Tool Setting Guide.”
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Explanation: Ruler [PRO/EX]  > Drawing by Snapping to a Ruler
 Drawing by Snapping to a Ruler
This section describes how to configure the snap range of a ruler and draw by snapping to the ruler.

1 You can adjust which layers snap to rulers.

(1) On the Layer palette, select the layer with the ruler you want to set the snap range for.

(2) Set the snap range in [Set showing area of ruler] on the Layer palette.

2 Select a layer from the Layer palette to draw on.

If you want to snap to a special ruler that appears green, you will first need to make the ruler snappable. For 

details on how to make a special ruler snappable, see "Making Special Rulers Snappable".

Show in All Layers The ruler will be snapped to on all raster and vector layers.

Show in Same Folder
The ruler will be snapped to on all raster layers and vector layers in the same folder. If there is 

no layer folder, it behaves the same as [Show in All Layers].

Show Only When Editing 

Target
The ruler will only be snapped to on the current layer.
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Explanation: Ruler [PRO/EX] > Drawing by Snapping to a Ruler > Making Special Rulers Snappable
3 When you draw on the canvas, the drawing will snap to the ruler.

Making Special Rulers Snappable
You can only snap to one special ruler at a time, even if there are multiple special rulers. You must select which special ruler is snappable using 

one of the following methods.

1 Open the [View] menu and check if [Snap to Special Ruler] has a check mark or not.
If it does not have a check mark, select [Snap to Special Ruler].

2 On the Tool palette, select the [Operation] tool. Select the [Object] sub tool from the Sub
Tool palette.

3 Click the ruler to snap to.

 You cannot snap to special rulers displayed in green. To snap to a ruler displayed in green, you must first 

make the ruler snappable using one of the following methods.

 You do not need to switch the snapping ruler for rulers other than special rulers.
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Explanation: Ruler [PRO/EX] > Drawing by Snapping to a Ruler > Making Special Rulers Snappable
4 On the ruler, click the icon to make the ruler snappable.
The ruler becomes the snap point when it changes from green to purple.

 The ruler to snap to can also be changed from [Snap] on the Tool Property palette.

 The ruler to snap to can also be changed from [View] menu > "Change Special Ruler Snap [PRO/EX]".

 Multiple special rulers may be displayed in violet when the selected layer has been switched, for example. In 

this case, select the ruler to snap to, and click the icon to make it snappable.

Snap point  switching
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Explanation: Ruler [PRO/EX] > Drawing by Snapping to a Ruler > Snapping Fill/Auto select to Symmetrical Ruler
Snapping Fill/Auto select to Symmetrical Ruler 
When using the [Fill] tool or the [Auto select] tool, you can select areas snapped to the symmetrical ruler.

1 Select the [Fill] tool or [Auto select] tool.
In this example, the [Fill] tool is selected.

2 Open the Sub Tool Detail palette and turn on [Snap to symmetry ruler] under [Fill].

3 On a layer that snaps to the symmetrical ruler, fill an area. The filled area will snap to the
ruler.

Click

The area to fill is snapped to 

the [Symmetrical ruler].
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Object Sub Tool
 Editing a Ruler
You can edit rulers with the [Object] tool, [Correct line] tool, Layer palette or Tool Property palette.

This section describes how to edit rulers with each palette and tool.

Editing with the Object Sub Tool
With the [Object] sub tool, you can move, transform, or rotate a ruler.

Moving a ruler
To move a ruler, proceed as follows.

1 On the Layer palette, select the layer with the ruler you want to move.

2 On the Tool palette, select the [Operation] tool. Select the [Object] sub tool from the Sub
Tool palette.
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Object Sub Tool
3 Move the ruler.
The method to move the ruler varies depending on the ruler type.

Linear ruler, curve ruler, figure ruler or ruler pen

To move the ruler, drag the ruler line or handle around the ruler.

Special ruler (other than the concentric circle ruler)

In the case of special rulers other than the concentric circle ruler, drag the lines the ruler to move it.

 To select a consecutive group of rulers, click the first item, then hold down Shift and select the last item.

 Hold down Shift while dragging the ruler line or handles to move the ruler horizontally, vertically, or along a 45-

degree diagonal angle.
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Object Sub Tool
Special ruler (concentric circle ruler)

The concentric circle ruler can be moved along the central axis or freely.

Dragging the center of the ruler (+) allows you to move it along the central axis.

Dragging on the line or the central axis of the ruler allows you to move it freely.

Central axis

Drag the center of the 

ruler (      ).

Drag the ruler or 

central axis.
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Object Sub Tool
Symmetrical ruler

Dragging on the line of the ruler moves it.
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Object Sub Tool
Transforming a Ruler
Follow these steps to transform a ruler.

1 On the Layer palette, select the layer including the ruler you want to edit.

2 On the Tool palette, select the [Operation] tool. Select the [Object] sub tool from the Sub
Tool palette.

3 Click the ruler to transform.
Handles and control points will appear on the ruler.

If the control points do not appear, change the [Mode] in the Tool Property palette to [Control point and scale/

rotate], then select.

Handle

Control point
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Object Sub Tool
4 Transform the ruler
The method to transform the ruler varies depending on the ruler type.

Linear ruler, curve ruler, figure ruler or ruler pen

Drag the handles and control points to transform the ruler.

(1) Drag a handle to transform the entire ruler.

(2) Drag a control point to only transform the area around the control point.

 If the transformation mode is set to [Free Transform] in the Tool Property palette, you can freely transform the 

ruler by dragging the handles.

 Hold down Shift while dragging a handle during free transformation to move the handle in the direction of the 

frame.

 When scaling, hold down Alt while dragging the handle to scale the ruler around the center of the frame.

 Hold down Shift while dragging a handle to resize the ruler without changing the original ratio.

 You can select multiple control points. For details on how to select, see "Select multiple control points".

 The [Control point] sub tool of the [Correct line] tool allows you to move, add, and delete control points. For 

details on how to use, see "Control point".
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Object Sub Tool
Special rulers (Parallel curve ruler/multiple curve ruler/concentric circle ruler/radial curve)

You can transform the following types of ruler: Parallel curve ruler, Multiple curve ruler, Concentric circle ruler, Radial curve ruler.

To transform a parallel curve ruler, multiple curve ruler, or radial curve ruler, simply drag a control point on the ruler.

To transform a concentric circle ruler, drag a handle on the ruler.

 You can select multiple control points. For details on how to select, see "Select multiple control points".

 The [Control point] sub tool of the [Correct line] tool allows you to move, add, and delete control points. For 

details on how to use, see "Control point".
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Object Sub Tool
Rotating a Ruler
To rotate a ruler, proceed as follows.

1 On the Layer palette, select the layer with the ruler you want to edit.

2 On the Tool palette, select the [Operation] tool. Select the [Object] sub tool from the Sub
Tool palette.

 You can rotate the following types of ruler: Linear ruler, Curve ruler, Figure ruler, Ruler pen, Multiple curve 

ruler, Concentric circle ruler, Symmetrical ruler.

 Rulers made with the following tools can be rotated with keyboard shortcuts: Linear ruler, Curve ruler, Figure 

ruler, Ruler pen. You can configure the shortcut key for rotating rulers in the [Shortcut settings] dialog box. 

For how to configure, see "Shortcut Settings [Windows]". For items that can be configured, see "Optional 

Shortcuts".

 Rotating a ruler by the shortcut key, displays the center of the rotation and rotates the ruler around the center. 

You can move the center of rotation by dragging with the [Object] sub tool.
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Object Sub Tool
3 Click the ruler to transform.
The rotation handle will appear on the ruler.

4 Rotate the ruler.
The method to rotate the ruler varies depending on the ruler type.

Linear ruler, curve ruler, figure ruler or ruler pen

The rotation handle rotates along with the mouse. Dragging the center of rotation rotates the ruler.

For the following rulers, the rotation handle is a different shape: Multiple curve ruler, Concentric circle ruler, and 

Symmetrical ruler.

 To select a consecutive group of rulers, click the first item, then hold down Shift and select the last item.

 Hold down Shift while dragging the rotation handle to rotate the ruler in increments of 45 degrees.
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Object Sub Tool
Parallel ruler

Specify the center of rotation, and drag the rotation handle on the ruler.

(1) Check the center of rotaton (+) and move with the [Object] sub tool if needed.

(2) Drag the rotation handle to rotate the ruler.

Multiple curve ruler

For multiple curve rulers, drag the rotation handle to set how the lines will follow the shape of the ruler.

 To change the angle of the parallel line ruler, select the ruler with the [Object] sub too, open the [Operation of 

transparent part] drop-down box and check [Set direction of parallel line ruler]. Then, drag on the canvas to set 

the direction of the ruler.

 You can adjust the direction of the ruler by specifying the angle in the Tool Property palette.

You can adjust the direction of the ruler by specifying the angle in the Tool Property palette.
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Object Sub Tool
The following figure shows drawing by snapping to the ruler.

Angle of the center of rotation: -90

Angle of the center of rotation: -135

Direction of  drawing parallel lines

Direction of  drawing parallel lines
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Object Sub Tool
Concentric circle ruler

Dragging the rotation handle on the central axis rotates the ruler.

Symmetrical ruler

The rotation handle rotates along with the mouse. Dragging the center of rotation rotates the ruler.

You can adjust the direction of the ruler by specifying the angle in the Tool Property palette.

You can adjust the direction of the ruler by specifying the angle in the Tool Property palette.

Central axis

Center of 
rotation
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Object Sub Tool
Right-click Menu while Using Object Tool [Windows/macOS]
Right-clicking a radial curve ruler, parallel curve ruler, or multiple curve ruler with the [Object] sub tool will open a menu. You can use this 

menu for some operations of the [Control point] sub tool.

 Add control point

 Delete control point

 Switch corner

When using a Tablet/Smartphone, the right-click menu cannot be displayed. To edit control points, use the [Cor-

rect line] tool > [Control point] sub tool.

For details on the operations you can perform, see "Control point".
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Layer Palette
Editing with the Layer Palette
With the Layer palette, you can move all rulers in the current layer to another layer, or delete the rulers. Furthermore, when using the [Move 

layer] tool, you can configure whether to move the rulers along with the drawing area of the currently edited layer, or separately.

Moving all rulers to another layer
Drag the ruler icon displayed on the Layer palette to another layer. All rulers included in the layer are moved to the drag destination.

When using a Smartphone/Tablet, touch your finger or pen to the ruler icon and swipe right, then drag and drop the layer to the desired location.

Deleting All Rulers within a Layer
Drag the ruler icon displayed on the Layer palette and drop to [Delete layer]. All rulers included in the layer are deleted.
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Layer Palette
Link Ruler to Layer
When using the [Move layer] tool, you can configure whether to move the rulers along with the drawing area of the currently edited layer, or 

separately.

Moving the Drawing Area along with Rulers

1 On the Layer palette, select the layer to link to the ruler.

2 Click the left side of the ruler icon to turn on the check mark.

3 Use the [Move layer] tool to drag the canvas.
The selected ruler and the layer will move in the dragged direction.
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Layer Palette
Moving the Drawing Area and Rulers Separately

1 On the Layer palette, click the left side of the ruler icon to turn off the check mark.

2 Click the ruler icon in the Layer palette and use the [Move layer] tool to drag the canvas.
Only the ruler will move in the dragged direction.
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Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Layer Palette
3 Click the layer thumbnail in the Layer palette and use the [Move layer] tool to drag the can-
vas.
Only the layer will move in the dragged direction.
CLIP STUDIO PAINT Instruction Manual 1310



Explanation: Ruler [PRO/EX] > Editing a Ruler > Editing with the Tool Property palette
Configuring a Ruler Range
[Set showing area of ruler] on the Layer palette allows you to configure the snap range of a ruler.

1 In the Layer palette, select the ruler for which to configure the snap range.

2 Configure the snap range in [Set showing area of ruler] on the Layer palette.

Editing with the Tool Property palette
Click a ruler with the [Object] tool to display settings for adjust the ruler position, angle, and so on in the Tool Property palette. The items you 

can configure vary depending on the ruler type. For details, see the Clip Studio Paint Tool Setting Guide.

Show in All Layers The ruler will be snapped to on all raster and vector layers.

Show in Same Folder
The ruler will be snapped to on all raster layers and vector layers in the same folder. When there 

is no layer folder, this becomes the same as [Show whole canvas].

Show Only When Editing 

Target
The ruler will only be snapped to on the current layer.

Link guide to ruler When a ruler layer is moved, the guide lines in that layer move along with it.
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Explanation: Ruler [PRO/EX] > Deleting a Ruler > Deleting All Rulers within a Layer
 Deleting a Ruler
This section describes how to delete a ruler.

Deleting All Rulers within a Layer
Either of the methods below deletes all rulers within a layer.

 On the Layer palette, select the layer from which to delete the ruler. Select the [Layer] menu > [Ruler/Frame] > [Delete ruler] to delete all 

rulers on the layer.

 Drag the ruler icon displayed on the Layer palette and drop to [Delete layer]. All rulers included in the layer are deleted. For details, see 

"Deleting All Rulers within a Layer".

Delete the selected ruler
To delete a selected ruler, proceed as follows.

1 On the Tool palette, select the [Operation] tool. Select the [Object] sub tool from the Sub 
Tool palette.

2 Click the ruler you want to delete, then press the Delete key.
The selected ruler is deleted.

Selecting [Layer] menu > [Ruler/Frame] > [Delete ruler] in step 4 also allows you to delete the ruler. If no ruler is 

selected when deleting with [Delete ruler], all rulers within the currently edited layer will be deleted.
CLIP STUDIO PAINT Instruction Manual 1312



Explanation: Perspective 
ruler [PRO/EX]
This chapter describes how to create a perspective ruler, how to draw snapped to a perspective ruler and how 

to edit a perspective ruler.

 What Is a Perspective Ruler?

 Names and Functions of Parts of a Perspective Ruler

 Creating a Perspective Ruler

 Drawing by Snapping to a Perspective Ruler

 Editing a Perspective Ruler



Explanation: Perspective ruler [PRO/EX]  > What Is a Perspective Ruler?
Explanation: Perspective ruler [PRO/EX]

 What Is a Perspective Ruler?
Select the [Layer] menu > [Ruler/Frame] > [Create Perspective Ruler] to create a ruler for perspective drawing with up
to three vanishing points.

One-point Perspective
A drawing technique where straight lines making up the target objects are drawn to converge on one vanishing point. This is used to emphasize 

depth, such as when drawing a long corridor seen from the front.

Two-point Perspective
A drawing technique with two vanishing points on the same horizon line. Here, straight lines of one of the pairs making up the target objects 

are drawn to converge on the right vanishing point while those of the other are drawn to converge on the left vanishing point. This is used to 

draw an object from an oblique angle.
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Explanation: Perspective ruler [PRO/EX]  > What Is a Perspective Ruler?
Three-point Perspective
A drawing technique with two vanishing points on a horizon line and a third vanishing point either above or below the horizon line. The 

straight lines making up the target objects are drawn so that they converge on their respective vanishing points. This is used to draw a tall build-

ing seen from below, for example.
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Explanation: Perspective ruler [PRO/EX]  > Names and Functions of Parts of a Perspective Ruler
 Names and Functions of Parts of a Perspective Ruler
This section describes the names and functions of each part when a perspective ruler is selected with the [Object] sub
tool.

A. Whole perspective ruler Handle
Allows you to move the whole perspective ruler or switch the snap point.

(1) Move [Whole perspective ruler handle]

Dragging (1) moves the [Whole perspective ruler handle].

(2) Move perspective ruler

Dragging (2) moves the whole perspective ruler.

(3) Switch snap to perspective ruler

Switches the perspective ruler to snap to. When snap to perspective ruler is turned on, you can draw snapped to a perspective ruler.

B. Eye level
A line that represents the height at which the line of vision or camera is located. A horizontal vanishing point is placed at the eye level.

The descriptions below are based on the case of a one-point perspective as an example.

A

B

C

D

EF

G G

H
H
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Explanation: Perspective ruler [PRO/EX]  > Names and Functions of Parts of a Perspective Ruler
C. Line Orthogonal to Eye Level
An auxiliary line orthogonal to the eye level. This line is displayed for [1 point perspective] and [2 points perspective].

D. Handle for Line Orthogonal to Eye Level
When snap to perspective ruler is turned on, allows you to draw orthogonally to the eye level.

E. Eye level Handle
Allows for moving and rotating the eye level.

(1) Move eye level

Dragging (1) moves the eye level.

(2) Rotate eye level

Dragging (2) rotates the eye level.

(3) Switch snap to eye level (One-point perspective)

Switches the snap point to the eye level. When snap to perspective ruler is turned on, you can draw snapped to the eye level. This item is 

displayed only for [1 point perspective].

F. Vanishing Point
Reference point of a perspective drawing.

G. Guide line
Lines spreading out from the vanishing point you can refer to when drawing with a ruler.

H. Guide/Vanishing point Handle
Allows you to operate the guides or the vanishing point.

(1) Move guide

Dragging (1) moves only the guide. The vanishing point does not move.

(2) Move vanishing point

Dragging (2) changes the direction of the guide and the vanishing point moves in that direction.

One-point perspective Two-/Three-point perspective
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Explanation: Perspective ruler [PRO/EX]  > Creating a Perspective Ruler
(3) Switch snap of vanishing point

Switches the snap point to the vanishing point. When snap to perspective ruler is turned on, you can draw snapped to the vanishing point 

of this guide.

 Creating a Perspective Ruler
To create a perspective ruler, proceed as follows.

1 Select the layer
On the Layer palette, select the layer where to create the ruler.

2  Select the command
Select the [Layer] menu > [Ruler/Frame] > [Create Perspective Ruler].

3 Configure the perspective ruler
The [Create Perspective Ruler] dialog box opens. On the dialog, configure the settings of the perspective ruler to create.

(1) Set the type and where to create the perspective ruler.

(2) Click [OK].

4 The perspective ruler is created
Clicking [OK] on the dialog box creates a perspective ruler as configured.
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Explanation: Perspective ruler [PRO/EX] > Drawing by Snapping to a Perspective Ruler > Configuring a Snap Range
[Create perspective ruler] Dialog Box

(1) Type

Configure the type of perspective ruler to create. You can select from [1 point perspective], [2 points perspective] and [3 points perspec-

tive].

(2) Create new layer

Configure where to create the perspective ruler.

When turned on, a layer is created at the bottom of the Layer palette, and the ruler, created there.

When turned off, the ruler is created in the layer being edited.

 Drawing by Snapping to a Perspective Ruler
This section describes how to configure the snap range of a perspective ruler and draw by snapping to the ruler.

Configuring a Snap Range
The snap range of a perspective ruler can be configured on the Layer palette.

On the Layer palette, select the layer with the ruler that you want to adjust, then select the snap range in [Set showing area of ruler].

(1) Show in all layers

The ruler will be snapped to on all raster and vector layers.

(2) Show in same folder

The ruler will be snapped to on all raster layers and vector layers in the same folder. When there is no layer folder, this becomes the same 

as [Show whole canvas].

(3) Show only when editing target

The ruler will only be snapped to on the current layer.

(4) Link guide to ruler

When a ruler layer is moved, the guide lines in that layer move along with it.
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Explanation: Perspective ruler [PRO/EX] > Drawing by Snapping to a Perspective Ruler > Snapping to a Perspective Ruler
Snapping to a Perspective Ruler
This section describes how to snap to a perspective ruler. To configure, you must have the perspective ruler selected with the [Object] sub tool.

.

Switching the Whole Perspective Ruler Snap
Clicking the snap button on the [Whole perspective ruler handle] allows you to turn on/off the snap to the selected perspective ruler.

The colors used here to display the ruler when snap is turned on/off are the default colors. You can change the 

ruler color from [Ruler/Unit] on the [Preferences] dialog box. For details, see "Preferences [Windows]".

You can also switch the snap to the whole ruler by turning on/off [Snap] on the Tool Property palette while the per-

spective ruler is selected with the [Object] sub tool.

Guide line Purple (Snap on) Green (Snap off)

Orthogonal line to eye level Purple (Snap on) Green (Snap off)

Eye level Light blue (Snap on) Blue (Snap off)

Click Click
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Explanation: Perspective ruler [PRO/EX] > Drawing by Snapping to a Perspective Ruler > Snapping to a Perspective Ruler
Snapping to the Vanishing Point
Clicking the snap button on the [Guide line/Vanishing point handle] allows you to turn on/off the snap to the vanishing point.

Turning on the snap allows you to draw lines converging on the vanishing point of the perspective lines.

Guide line Purple (Snap on) Green (Snap off)

Click Click

Vanishing point
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Explanation: Perspective ruler [PRO/EX] > Drawing by Snapping to a Perspective Ruler > Snapping to a Perspective Ruler
Snapping to the Eye Level Direction (Only for One-point Perspective)
Clicking the snap button on the [Eye level handle] allows you to turn on/off the snap to the eye level direction. This snap button is displayed 

only for [1 point perspective].

Turning on the snap allows you to draw snapped to the eye level direction even when drawing in [1 point perspective].

Eye level Light blue (Snap on) Blue (Snap off)

Click Click

Eye level
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Explanation: Perspective ruler [PRO/EX] > Drawing by Snapping to a Perspective Ruler > Snapping to a Perspective Ruler
Snapping to the Line Orthogonal to the Eye Level (Only for One-point and Two-point 
Perspectives)
For [1 point perspective] and [2 points perspective], an orthogonal line to the eye level is displayed. Clicking the snap button on this line allows 

you to turn on/off the snap to the direction orthogonal to the eye level.

Turning on the snap allows you to draw snapped to the orthogonal direction to eye level even when drawing in [1 point perspective] or [2 points 

perspective].

Orthogonal line to eye level Purple (Snap on) Green (Snap off)

Click Click

Eye level
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Explanation: Perspective ruler [PRO/EX] > Drawing by Snapping to a Perspective Ruler > Snapping to a Perspective Ruler
Displaying and Snapping to Grid
You can display equally-spaced grids from the vanishing point and snap to those grids for drawing.

Drawing into a Grid
To draw snapped to a grid, proceed as follows.

1 Show the grid
With the perspective ruler selected, click the [Grid] button on the Tool Property palette. The [Grid] displays.

You can use this feature to draw at regular intervals in a 3D space created using a perspective ruler.

For details on [Grid], see "Grid-related Settings on the Tool Property".
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Explanation: Perspective ruler [PRO/EX] > Drawing by Snapping to a Perspective Ruler > Snapping to a Perspective Ruler
2 Adjust the position of the grid
Drag the [Grid origin] of the perspective ruler to adjust its position.

3 Enable snap
Open the [View] menu to turn on (place check mark to) [Snap to Special Ruler] and [Snap to Grid].

4 Draw in the grid
When you draw on the canvas, the drawing will snap to the grid.

If only [Snap to Grid] is turned on, you will not be able to snap in an area without grid.

Drag
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Explanation: Perspective ruler [PRO/EX] > Drawing by Snapping to a Perspective Ruler > Snapping to a Perspective Ruler
Grid-related Settings on the Tool Property
When perspective ruler is selected with the [Object] sub tool, using the Tool Property palette allows you to show equally-spaced grids (auxil-

iary lines) from the vanishing point. Grid-related settings are as follows.

(1) Grid

Displays equally-spaced (auxiliary lines) from the vanishing point. The grid displayed by each button is different.

XY plane

 Grids may not display depending on where the vanishing point has been placed.

 To snap to the grid, turn on snap by selecting [Snap to Special Ruler] and [Snap to Grid] from the [View] menu.

One-point perspective Two-point perspective Three-point perspective
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Explanation: Perspective ruler [PRO/EX] > Drawing by Snapping to a Perspective Ruler > Snapping to a Perspective Ruler
YZ plane

XZ Plane

(2) Grid size

Specifies the size (distance) between grid lines. The larger the size, the wider is the area where the grid displays.

One-point perspective Two-point perspective Three-point perspective

One-point perspective Two-point perspective Three-point perspective
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Explanation: Perspective ruler [PRO/EX] > Drawing by Snapping to a Perspective Ruler > Snapping to a Perspective Ruler
Changing the Direction while Drawing Snapped to the Perspective Ruler
If [When snapping to perspective ruler, reset drawing direction by returning to start point] is turned on in [Preferences] > [Ruler/Unit], dragging 

to the starting point while drawing snapped to a perspective ruler allows you to change the drawing direction.

Snapping to Figure, Straight Line or Polyline 
[Figure], [Balloon], [Frame Border], and others whose input method is figure, straight line or polyline can be drawn snapped to a perspective 

ruler.

 

For details on settings, see "Preferences [Windows]".

When drawing snapped to a perspective ruler, beware of the following points:

 When snapping [Straight line] or [Polyline] to the grid of a perspective ruler, snap works only when the inter-

section of lines being drawn is along the direction of the perspective ruler. Snap does not work for intersec-

tions that are in an oblique direction.

 [Fix after rotation] is disabled.

 When drawing a figure specifying [Aspect type], [Aspect type] becomes valid only when [Specified ratio] is 

configured. However, [Aspect type] is disabled when snapping to an auxiliary vanishing point.

Drawing starting point

Drag to starting

point.

Direction of

drawing can be 

 changed.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Moving a Perspective Ruler
 Editing a Perspective Ruler
This section describes how to move, rotate and delete a perspective ruler as well as the procedure to fix the eye level.

Moving a Perspective Ruler
The following describes how to move the whole perspective ruler, the eye level, perspective lines and vanishing point. To move, you must have 

the perspective ruler selected with the [Object] sub tool.

Moving the Whole Perspective Ruler
Dragging the large cross (+) on the [Whole perspective ruler handle] moves the whole perspective ruler.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Moving a Perspective Ruler
Moving the Eye Level
Dragging the Eye level circle icon moves the Eye level.

Moving the Vanishing Point
The vanishing point moves when dragged.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Moving a Perspective Ruler
Rotating the Guide Line and Moving the Vanishing Point
Dragging the cross (+) around the [Guide line/Vanishing point handle] rotates the guide lines and moves the vanishing point in that direction.

Dragging while holding down Shift moves the vanishing point to infinity.

Direction of the guide

changes and the vanishing 

 point moves.

Drag.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Moving a Perspective Ruler
Moving the Guide Line
Dragging the (○) icon in the center of the [Guide line/Vanishing point handle] move the guide lines only. The vanishing point does not move.

The vanishing point does not move.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Deleting a Perspective Ruler
Deleting a Perspective Ruler
A perspective ruler can be deleted with the Layer palette, or by pressing the Delete key.

Deleting with the Layer palette
You can delete a perspective ruler by dragging the ruler icon on the Layer palette to the [Delete layer] icon.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Adding/Deleting a Vanishing Point
Deleting with the Delete key
Selecting the perspective ruler with the [Object] sub tool and pressing Delete deletes the perspective ruler.

Adding/Deleting a Vanishing Point
The [Perspective ruler] sub tool of the [Ruler] tool allows you to add or delete a vanishing point.

Add Vanishing Point
To add a vanishing point, select the [Perspective ruler] sub tool and set the process to [Add vanishing point] in the Tool Property palette. 

Beware that for [1 point perspective] rulers and [2 points perspective] rulers, the result may differ depending on the [Change perspective draw-

ing method] setting on the Tool Property palette.

When Change perspective drawing method is OFF
When [Change perspective drawing method] is turned off, allows you to add an auxiliary vanishing point without changing the perspective 

drawing method.

1 Select the sub tool
Select the [Ruler] tool and select [Perspective ruler] from the Sub Tool palette.

The [Change perspective drawing method] setting has no effect on [3 points perspective] rulers. The auxiliary van-

ishing point will be added at the intersection of the guide line.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then selecting [Cre-

ate ruler] > [Perspective ruler] on the Sub Tool palette.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Adding/Deleting a Vanishing Point
2 Configure the tool property
Configure the Tool Property palette as follows.

(1) Set [Add vanishing point] for [Process].

(2) Turn off [Change perspective drawing method].

3 Add the vanishing point
Drag on the canvas and create two guide lines. The auxiliary vanishing point will be added at the intersection of the guide line. The per-

spective drawing method does not change.

Drag on the canvas to 

create two guides.

A vanishing point is added at the 

 intersection of the guides.

The perspective drawing method does not change.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Adding/Deleting a Vanishing Point
When Change perspective drawing method is ON
When [Change perspective drawing method] on the Tool Property palette is turned on, adding a vanishing point to a [1 point perspective] or [2 

points perspective] ruler also changes the perspective drawing method.

 Adding a vanishing point to a one-point perspective ruler changes the ruler to a two-point perspective ruler.

 Adding a vanishing point to a two-point perspective ruler changes the ruler to a three-point perspective ruler.

1 Select the sub tool
Select the [Ruler] tool and select [Perspective ruler] from the Sub Tool palette.

2 Configure the tool property
Configure the Tool Property palette as follows.

(1) Set [Add vanishing point] for [Process].

(2) Turn on [Change perspective drawing method].

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then selecting [Cre-

ate ruler] > [Perspective ruler] on the Sub Tool palette.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Adding/Deleting a Vanishing Point
3 Add the vanishing point
Drag on the canvas and create two guide lines. A vanishing point is added at the intersection of the guide line, and the perspective drawing 

method, changed.

Deleting a Vanishing Point
To delete a vanishing point, select the [Perspective ruler] sub tool and set the process to [Delete vanishing point] in the Tool Property palette.

1 Select the sub tool
Select the [Ruler] tool and select [Perspective ruler] from the Sub Tool palette.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then selecting [Cre-

ate ruler] > [Perspective ruler] on the Sub Tool palette.

Drag on the canvas to 

create two guides.

A vanishing point is added at the

intersection of the guides, changing 

 the perspective drawing method.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Adding/Deleting a Vanishing Point
2 Configure the tool property
In the Tool Property palette, set the process to [Delete vanishing point].

3 Delete the vanishing point
Click the vanishing point or a guide line converging on the vanishing point. The vanishing point is deleted.

Click when the mouse cursor

changes to 　　.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Fix vanishing point
Fix vanishing point
The [Perspective ruler] sub tool of the [Ruler] tool allows you to fix a vanishing point.

1 Select the sub tool
Select the [Ruler] tool and select [Perspective ruler] from the Sub Tool palette.

2 Configure the tool property
In the Tool Property palette, set the process to [Fix vanishing point].

The initial configuration of the sub tools has been changed from Ver.1.5.6. The initial configuration of the sub 

tools has been changed from Ver.1.6.2 on. For those who are used to a previous version of Clip Studio Paint, this 

operation is now performed by selecting the [Figure] tool and then selecting [Create ruler] > [Perspective ruler] on 

the Sub Tool palette.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Adding/Deleting a guide line
3 Fix the vanishing point
Click the vanishing point or a guide line converging on the vanishing point. The vanishing point is fixed.

Adding/Deleting a guide line
The [Perspective ruler] sub tool of the [Ruler] tool allows you to add or delete a guide line.

Add guide line
To add a guide line, select the [Perspective ruler] sub tool and set the process to [Add guide] in the Tool Property palette.

1 Select the sub tool
Select the [Ruler] tool and select [Perspective ruler] from the Sub Tool palette.

To free a fixed vanishing point, click it again.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then selecting [Cre-

ate ruler] > [Perspective ruler] on the Sub Tool palette.

Image of perspective ruler selected with the Object tool.

Click when the mouse cursor

changes to 　　.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Adding/Deleting a guide line
2 Configure the tool property
In the Tool Property palette, set the process to [Add guide].

3 Add the guide line
Drag on the canvas to add the guide line.

0

Dragging on the canvas to create a guide when there are multiple vanishing points allows you to change the orien-

tation of the guide line.

Click
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Adding/Deleting a guide line
Delete guide line
To delete a guide line, select the [Perspective ruler] sub tool and set the process to [Delete guide] in the Tool Property palette.

1 Select the sub tool
Select the [Ruler] tool and select [Perspective ruler] from the Sub Tool palette.

2 Configure the tool property
On the Tool Property palette, set the process to [Delete guide].

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Figure] tool and then selecting [Cre-

ate ruler] > [Perspective ruler] on the Sub Tool palette.
CLIP STUDIO PAINT Instruction Manual 1342



Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Fixing the Eye Level
3 Delete the guide line
Click the guide line to delete.

Fixing the Eye Level
Selecting the perspective ruler with the [Object] sub tool and turning on [Fix eye level] on the Tool Property palette locks the position of the 

[Eye level].

Turning this on moves the vanishing point above eye level as described below.

Click when the mouse cursor

changes to 　　.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Fixing the Eye Level
When the Vanishing Point Is Dragged over the Eye Level
The vanishing point moves over the eye level whose position has been fixed.

When the Vanishing Point Is Moved After Rotating the Guide Line
The vanishing point moves over the eye level whose position has been fixed.

The vanishing point moves over 

the eye level whose position is fixed.

Drag

The vanishing point moves over 

the eye level whose position is fixed.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Rotating Eye Level
Rotating Eye Level
It is possible to rotate the eye level after selecting the perspective ruler with the [Object] sub tool.

Drag the [Eye level handle] to rotate the eye level with the [Move eye level] handle as a center point.

Dragging while holding down Shift allows you to rotate by 45 degrees each time.

Drag
Eye level
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Right-click Menu during Object Tool Use [Windows/macOS]
Right-click Menu during Object Tool Use [Windows/macOS]
Right clicking on a layer with a [Perspective ruler] when the [Object] sub tool of the [Operation] tool is being used shows menu items related to 

[Perspective ruler].

(1) Add vanishing point

Right click on the canvas and select [Add vanishing point] from the menu that displays. A vanishing point will be added at the clicked 

position.

(2) Delete vanishing point

Select the [Vanishing point] with the [Object] sub tool, then right click and select [Delete vanishing point] from the menu that shows. The 

vanishing point is deleted.

(3) Add guide

Select the [Vanishing point] with the [Object] sub tool, then right click and select [Add guide] from the menu that shows. A [Guide line] is 

added to the selected [Vanishing point].

(4) Delete guide

Select the [Handle] of the guide line you want to delete, then right click and select [Delete guide] from the menu that displays. The 

selected [Guide line] is deleted.

(5) Fix vanishing point

Select the [Vanishing point] with the [Object] sub tool, then right click and select [Fix vanishing point] from the menu that shows. The 

vanishing point is fixed.

(6) Infinitize

Select the [Vanishing point] with the [Object] sub tool, then right click and select [Infinitize] from the menu that shows. The vanishing 

point is moved to infinity.

(7) Fix eye level

Right click on the canvas and select [Fix eye level] from the menu that displays. The eye level is fixed.

Menu items related to [Perspective ruler] appear in the right-click menu as well when a [Guide Line] handle is 

selected.

A guide line can be added also when a [Handle] on the guide line is selected. However, the guide line will be added 

overlapped.
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Explanation: Perspective ruler [PRO/EX] > Editing a Perspective Ruler > Right-click Menu during Object Tool Use [Windows/macOS]
(8) Horizontalize eye level

Right click on the canvas and select [Horizontalize eye level] from the menu that displays. The eye level is horizontalized.
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Explanation: Creating and 
Editing Stream Lines and 
Saturated Lines [PRO/EX] 
This chapter describes how to create and edit stream lines and saturated lines.

 What Are Stream Lines and Saturated Lines?

 Creating and Editing a Stream Line

 Creating and Editing a Saturated Line



Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX]  > What Are Stream Lines and Saturated Lines?
Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] 

 What Are Stream Lines and Saturated Lines?
This section provides an overview of stream lines and saturated lines.

Stream line Saturated line
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > What Are Stream Lines and Saturated Lines? > Overview of Stream 
Lines
Overview of Stream Lines
The following is an overview of stream lines.

Drawing a Saturated Line
Stream lines can be drawn using the [Stream line] sub tool of the [Figure] tool. Drawing a stream line creates a [Stream line] layer.

Stream line layer.
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > What Are Stream Lines and Saturated Lines? > Overview of Stream 
Lines
Reference Line and Shape Line
Selecting the [Stream line] layer and changing the tool to [Object] sub tool displays a [Reference line] (blue line) and a [Shape line] (red line).

In Clip Studio Paint, stream lines are drawn by lining up lines of the same shape as the [Shape line] along the [Reference line].

Editing a Saturated Line
Selecting the [Stream line] layer and changing the tool to [Object] sub tool allows you to adjust a drawn stream line.

 You can adjust the stream line when correcting position and shape of the [Reference line] and [Shape line]. Furthermore, you can configure 

the direction in which to draw lines with the same shape as the [Shape line] by dragging the [Center of rotation] of the [Shape line].

 With the Tool Property palette, you can adjust the color, size, and space between each line that comprise the stream line.

The [Reference line] can be added or redrawn even after the stream line is drawn, with the stream line settings (color, size, space between each 

line, and the like) and [Shape line] kept as they are. For details, see "Adding and Redrawing the Reference Line".

Reference line
A line that determines the position of the stream line. It is displayed in blue. Lines with the 

same shape as [Shape line] line up along this line.

Shape line
A line that determines the shape of each of the lines that comprise the stream line. It is dis-

played in red.

Shape line

Reference line
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > What Are Stream Lines and Saturated Lines? > Overview of Satu-
rated Lines
Overview of Saturated Lines
The following is an overview of saturated lines.

Drawing a Saturated Line
Saturated lines can be drawn using the following sub tools:

 [Saturated line] sub tool of the [Figure] tool

 [Flash] sub tool of the [Balloon] tool

Drawing a saturated line creates a [Saturated line] layer.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Text] tool and then selecting [Flash] 

on the Sub Tool palette.

Saturated line layer
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > What Are Stream Lines and Saturated Lines? > Overview of Satu-
rated Lines
Reference Line, Shape Line, and Center Point
Selecting the [Saturated line] layer and changing the tool to [Object] sub tool displays a [Reference line] (blue line), a [Shape line] (red line) 

and the [Center point] (red +).

In Clip Studio Paint, saturated lines are drawn by lining up lines of the same shape as the [Shape line] along the [Reference line], with one of 

the ends converging on the [Center point].

Editing a Saturated Line
Selecting the [Saturated line] layer and changing the tool to [Object] sub tool allows you to adjust the saturated line drawing.

 You can adjust the saturated line when correcting position and shape of the [Reference line] and [Shape line]. Furthermore, you can move 

the [Center point] and set the point of convergence of saturated lines.

 The color, size and space between each line can be adjusted with the Tool Property palette.

The [Reference line] can be added or redrawn even after the saturated line is drawn, with the saturated line settings (color, size, space between 

each line, and the like), as well as the [Shape line] and [Center point] kept as they are. For details, see "Adding and Redrawing the Reference 

Line".

Reference line
A line that determines the position of the saturated line. It is displayed in blue. Lines with the 

same shape as [Shape line] line up along this line.

Shape line
A line that determines the shape of each of the lines that comprise the saturated line. It is dis-

played in red.

Center point A point that determines the point of convergence. It is displayed with a red "+" sign.

Shape line

Center

Reference line
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Stream Line > Creating a Stream Line
 Creating and Editing a Stream Line
This section describes how to create and edit a stream line.

Creating a Stream Line
To create a stream line, proceed as follows.

1 Select the tool
On the Tool palette, select the [Figure] tool.

2 Select the sub tool
On the Sub Tool palette, switch the sub tool group to [Stream line] and select a sub tool.

3 Set line color
With a color palette, configure a color for the stream line.
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Stream Line > Creating a Stream Line
4 Configure the tool property
On the Tool Property palette, adjust the settings for creating stream lines.

5 Draw the stream line
Draw a [Reference line] in the position where you want to draw the stream line. Committing the [Reference line] draws the stream line as 

configured.

On the Tool Property palette, you can configure the thickness, length and spacing of each of the lines that com-

prise the saturated line. For details on the setting items, see "Stream Line", "Drawing Position", and "Drawing 

Interval" in Clip Studio Paint Tool Setting Guide.

How to draw the [Reference line] varies depending on the selected sub tool.
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Stream Line > Editing a Stream Line
Editing a Stream Line
The following describes how to edit a stream line.

Editing a Stream Line Entirely
Selecting the [Stream line layer] and clicking a point where no stream line is drawn displays a guide. Using the handles and control points of 

the guide, adjust the position, orientation, size and the like of the entire stream line.

Guide of the entire stream line
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Stream Line > Editing a Stream Line
Editing the Reference Line
To edit the reference line, proceed as follows.

1 Select the layer
Select the [Stream line] layer.

2 Display the reference line
Change the tool to [Object] sub tool. The [Reference line] (blue line) displays.

3 Edit the reference line
Click the reference line to display the guide lines.

Reference line

Click.

Displays the guide 

of the reference line.
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Stream Line > Editing a Stream Line
Editing the reference line entirely

Operating the handles and control points of the guide allows you to adjust the position, orientation, size and the like of the entire [Refer-

ence line].

Modifying the shape of the reference line

Dragging a control point allows you to transform the shape of the [Reference line].

Guide of the reference line
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Stream Line > Editing a Stream Line
Editing a control point [Windows/macOS]

Select a [Control point] and right click. From the menu that displays, you can [Add control point], [Delete control point] and/or [Switch 

corner].

When using a Tablet/Smartphone, the right-click menu cannot be displayed. To edit the control point, use the [Cor-

rect line] tool > [Control point] sub tool. [Move control points], [Add control point], [Delete control point] and 

[Switch corner] are also possible using the [Control point] sub tool of the [Correct line] tool.

Add control point
Select a [Control point] and right click on the line. Selecting [Add control point] from the menu that dis-

plays allows you to add a [Control point] at the clicked position.

Delete control point Allows you to delete the selected [Control point].

Switch corner
Allows you to toggle the corner of the selected [Control point] between angled and round. The corner tog-

gles between angled corner and round corner on each click.
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Stream Line > Editing a Stream Line
Adding and Redrawing the Reference Line
Drawing a stream line by following the steps below allows you to add or redraw the [Reference line] with the stream line settings (color, size, 

space between each line, and the like) and [Shape line] kept as they are.

1 Select the layer
Select the [Stream line] layer.

2 Select the tool
On the Tool palette, select the [Figure] tool.

3 Select the sub tool
On the Sub Tool palette, switch the sub tool group to [Stream line] and select a sub tool.

4 Configure the tool property
On the Tool Property palette for the stream lines, set the destination layer to [Draw on stream line layer] or [Always create stream line 

layer].

5 Add the stream line
Draw a [Reference line] in the position where you want to draw the stream line.

A [Reference line] is added with the stream line settings (color, size, space between each line, and the like) and [Shape line] kept as they 

are.

Selecting a [Control point] of the [Reference line] with the [Object] sub tool and pressing Delete allows you to 

delete the [Reference line] individually.
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Stream Line > Editing a Stream Line
Editing the Shape Line
To edit the shape line, proceed as follows.

1 Select the layer
Select the [Stream line] layer.

2 Display the shape line
Change the tool to [Object] sub tool. The [Shape line] (red line) displays.

3 Edit the shape line
Click the shape line to display the guide lines.

Shape line

Click.

Displays the guide 

of the shape line.
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Stream Line > Editing a Stream Line
Editing the Shape Line Entirely

Operating the handles and control points of the guide allows you to adjust the position, orientation, size and the like of the entire [Shape 

line].

Modifying the shape of the shape line

Dragging a control point allows you to transform the shape of the [Shape line].

Guide of the shape line
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Stream Line > Editing a Stream Line
Adjusting the direction in which lines are added

Dragging the [Center of rotation] of the [Shape line] allows you to adjust the direction in which to draw lines with the same shape as the 

[Shape line].
CLIP STUDIO PAINT Instruction Manual 1363



Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Stream Line > Editing a Stream Line
Editing a control point [Windows/macOS]

Select a [Control point] and right click. From the menu that displays, you can [Add control point], [Delete control point] and/or [Switch 

corner].

Editing with the Tool Property Palette
Selecting the [Stream line] layer and changing the tool to [Object] sub tool displays settings related to the stream line in the Tool Property pal-

ette.

The Tool Property palette allows you to adjust the color and length of the stream line, the space between each line, and so on.

When using a Tablet/Smartphone, the right-click menu cannot be displayed. To edit the control point, use the [Cor-

rect line] tool > [Control point] sub tool. [Add control point], [Delete control point] and [Switch corner] are also 

possible using the [Control point] sub tool of the [Correct line] tool.

Add control point
Select a [Control point] and right click on the line. Selecting [Add control point] from the menu that dis-

plays allows you to add a [Control point] at the clicked position.

Delete control point Allows you to delete the selected [Control point].

Switch corner
Allows you to toggle the corner of the selected [Control point] between angled and round. The corner tog-

gles between angled corner and round corner on each click.

For details on settings, see Stream Line, Drawing Position, and Drawing Interval in the Clip Studio Paint Tool Set-

ting Guide.
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Saturated Line > Creating a Saturated Line
 Creating and Editing a Saturated Line
This section describes how to create and edit a saturated line.

Creating a Saturated Line
To create a saturated line, proceed as follows.

1 Select the tool
On the Tool palette, select the [Figure] tool.

2 Select the sub tool
Saturated lines can be drawn using the following sub tools:

 [Saturated line] sub tool of the [Figure] tool

 [Flash] sub tool of the [Balloon] tool

In this example, the sub tool group is switched to [Saturated line] on the Sub Tool palette to select the sub tool.

3 Set line color
On a color palette, configure a color for the saturated line.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, this operation is now performed by selecting the [Text] tool and then selecting [Flash] 

on the Sub Tool palette.

Turning on [Saturated line] > [Fill center] on the Sub Tool Detail palette allows you to fill the area enclosed by the 

reference line. For details on settings, see "Saturated Line" in the Clip Studio Paint Tool Setting Guide.
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Saturated Line > Creating a Saturated Line
4 Configure the tool property
On the Tool Property palette, adjust the settings for creating saturated lines.

5 Draw the saturated line
Draw a [Reference line] in the position where you want to draw the saturated line. Committing the [Reference line] draws the saturated 

line as configured.

On the Tool Property palette, you can configure the thickness, length and spacing of each of the lines that com-

prise the saturated line. For details on setting, see Saturated Line, Drawing Position, and Drawing Interval in the 

Clip Studio Paint Tool Setting Guide.

How to draw the [Reference line] varies depending on the selected sub tool.
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Saturated Line > Editing a Saturated Line
Editing a Saturated Line
The following describes how to edit a saturated line.

Editing a Saturated Line Entirely
Selecting the [Saturated line] layer and clicking a point where no saturated line is drawn displays a guide. Using the handles and control points 

of the guide, adjust the position, orientation, size and the like of the entire saturated line.

Editing the Reference Line
To edit the reference line, proceed as follows.

1 Select the layer
Select the [Saturated line] layer.

2 Display the reference line
Change the tool to [Object] sub tool. The [Reference line] (blue line) displays.

Guide of the entire saturated line

Reference line
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Saturated Line > Editing a Saturated Line
3 Edit the reference line
Click the reference line to display the guide lines.

Editing the reference line entirely

Operating the handles and control points of the guide allows you to adjust the position, orientation, size and the like of the entire [Refer-

ence line].

Displays the guide 

of the reference line.
Click.

Guide of the reference line
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Saturated Line > Editing a Saturated Line
Modifying the shape of the reference line

Dragging a control point allows you to transform the shape of the [Reference line].
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Saturated Line > Editing a Saturated Line
Editing a control point

Select a [Control point] and right click. From the menu that displays, you can [Add control point], [Delete control point] and/or [Switch 

corner].

Add control point
Select a [Control point] and right click on the line. Selecting [Add control point] from the menu that dis-

plays allows you to add a [Control point] at the clicked position.

Delete control point Allows you to delete the selected [Control point].

Switch corner
Allows you to toggle the corner of the selected [Control point] between angled and round. The corner tog-

gles between angled corner and round corner on each click.

[Move control points], [Add control point], [Delete control point] and [Switch corner] are also possible using the 

[Control point] sub tool of the [Correct line] tool.
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Saturated Line > Editing a Saturated Line
Adding and Redrawing the Reference Line
Drawing a saturated line by following the procedure below allows you to add or redraw the [Reference line], with the saturated line settings 

(color, size, space between each line, and the like), as well as [Shape line] and [Center point] kept as they are.

1 Select the layer
Select the [Saturated line] layer.

2 Select the tool
On the Tool palette, select the [Figure] tool.

3 Select the sub tool
On the Sub Tool palette, switch the sub tool group to [Saturated line] and select a sub tool.

4 Configure the tool property
In the Tool Property palette, set the [Destination layer] to [Draw on saturated line layer] or [Always create saturated line layer].

5 Add a saturated line
Draw a [Reference line] in the position where you want to draw the saturated line.

The [Reference line] is added with the saturated line settings (color, size, space between each line, and the like), [Shape line] and [Center 

point] kept as they are.

Selecting a [Control point] of the [Reference line] with the [Object] sub tool and pressing Delete allows you to 

delete the [Reference line] individually.
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Saturated Line > Editing a Saturated Line
Editing the Shape Line and Center Point
To edit the shape line and center point, proceed as follows.

1 Select the layer
Select the [Saturated line] layer.

2 Display the shape line and center point
Change the tool to [Object] sub tool. The [Shape lines] (red line) and [Center point] (red +) display.

3 Edit the shape line
Click the shape line to display the guide lines.

Shape line

Center

Click.

Displays the guide 

of the shape line.
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Saturated Line > Editing a Saturated Line
Editing the Shape Line Entirely

Operating the handles and control points of the guide allows you to adjust the position, orientation, size and the like of the entire [Shape 

line].

Editing the Center Point

Dragging the center point (+) allows you to adjust the position of the point of convergence of the saturated line.

Modifying the shape of the shape line

Dragging a control point allows you to transform the shape of the [Shape line].

Guide of the shape line
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Explanation: Creating and Editing Stream Lines and Saturated Lines [PRO/EX] > Creating and Editing a Saturated Line > Editing a Saturated Line
Editing a control point

Select a [Control point] and right click. From the menu that displays, you can [Add control point], [Delete control point] and/or [Switch 

corner].

Editing with the Tool Property Palette
Selecting the [Saturated line] layer and using the [Object] sub tool displays settings related to the saturated line on the Tool Property palette.

The color, size and space between each line can be adjusted with the Tool Property palette.

Add control point
Select a [Control point] and right click on the line. Selecting [Add control point] from the menu that dis-

plays allows you to add a [Control point] at the clicked position.

Delete control point Allows you to delete the selected [Control point].

Switch corner
Allows you to toggle the corner of the selected [Control point] between angled and round. The corner tog-

gles between angled corner and round corner on each click.

[Move control points], [Add control point], [Delete control point] and [Switch corner] are also possible using the 

[Control point] sub tool of the [Correct line] tool.

For details on settings, see Saturated Line, Drawing Position, and Drawing Interval in the Clip Studio Paint Tool 

Setting Guide.
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Explanation: Expression 
Color and Drawing Color
This chapter describes the expression color and drawing color in Clip Studio Paint.

 Expression Color and Drawing Color



Explanation: Expression Color and Drawing Color > Expression Color and Drawing Color > Monochrome (Black, White and Transparent) [PRO/EX]
Explanation: Expression Color and Drawing Color

 Expression Color and Drawing Color
There are three types of expression colors in Clip Studio Paint: monochrome [PRO/EX], gray [PRO/EX] and color. The
drawing colors you can use vary depending on the expression color type.

Monochrome (Black, White and Transparent) [PRO/EX]
Monochrome is an expression color comprising black, white and transparent. It is used for drawing lines (main lines and the like).

Drawing Colors Available for Expression Color Monochrome
When the expression color is monochrome, the drawing colors that can be used depends on the [Expression color] configured on the Layer 

Property palette.

Only black button ON The drawing color is configured as black or transparent.

Only white button ON The drawing color is configured as white or transparent.

Both black and white but-

tons ON
The drawing color is configured as black, white or transparent.

Example of [Monochrome] drawing
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Explanation: Expression Color and Drawing Color > Expression Color and Drawing Color > Monochrome (Black, White and Transparent) [PRO/EX]
Black
Equivalent to black ink. Use to draw black lines or to fill in black.

White
Equivalent to white ink. Use to draw white lines or to fill in white. Parts drawn in white are opaque and keep the drawings intact.

Transparent color
A transparent ink capable of deleting drawings in [Black] or [White] drawn on the same layer when overlapped.
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Explanation: Expression Color and Drawing Color > Expression Color and Drawing Color > Gray [PRO/EX]
Gray [PRO/EX]
Gray is an expression color that has a color depth of 8 bits. Use to draw illustrations in monochrome with light, delicate touches as with ink-

and-wash painting.

Drawing Colors Available for Expression Color Gray
The drawing colors that can be used depends on the [Expression color] configured on the Layer Property palette.

The expression color [Monotone] configured with Ver.1.2.1 or earlier is converted into the following settings.

 Expression color: Gray

 Drawing color: Black to transparent (Only black button ON)

Only black button ON The drawing color is configured as a 256-step gradient from black to transparent.

Only white button ON The drawing color is configured as a 256-step gradient from white to transparent.

Both black and white but-

tons ON
The drawing color is configured as a 256-step gradient from black to white.

Example of [Gray] drawing

Only black button ON

Only white button ON

Both black and white buttons ON
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Explanation: Expression Color and Drawing Color > Expression Color and Drawing Color > Color
When drawn in transparent, the drawn portions are erased in accordance with the opacity.

Color
Color is an expression color that has a color depth of 32 bits. Use to draw illustrations in full color.

Only black button ON (Image filled in black)

Drawn
with
20% 
 transp.

Drawn
with
40% 
 transp.

Drawn
with
60% 
 transp.

Drawn
with
80% 
 transp.

Drawn
with
100% 
 transp.

Only white button ON (Image filled in white)

Both black and white buttons ON 

 (Image filled in black)

Example of [Color] drawing
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Explanation: Expression Color and Drawing Color > Expression Color and Drawing Color > Regarding the Layer Color [PRO/EX]
Regarding the Layer Color [PRO/EX]
[Layer color] on the Layer Property palette allows you to display images in one color. Use to check the content drawn in a particular layer while 

drawing. For example, this is convenient to distinguish the draft and inked drawings.

For details on how to configure, see "Layer Property Palette [PRO/EX]".

Layer color: Off Layer color: On
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Explanation: Operations 
Using Unique Windows 
Features
Clip Studio Paint supports touch functions and the Surface Dial on Windows 8 and later.

This section explains how to use touch features or the Surface Dial with Clip Studio Paint.

 Switching to Screen Optimized for Touch Operations

 Using Touch Operations in Clip Studio Paint

 Using a Surface Dial with Clip Studio Paint



Explanation: Operations Using Unique Windows Features  > Switching to Screen Optimized for Touch Operations
Explanation: Operations Using Unique Windows Features

 Switching to Screen Optimized for Touch Operations
You can switch to the screen optimized for touch operations in Windows 8 and later in the [Preferences] dialog box.
This section describes how to switch to the screen optimized for touch operations.

1 Select the command
From the [File] menu, select [Preferences]. The [Preferences] dialog box opens.

2 Configure the [Preferences] dialog box
Configure on the [Preferences] dialog box.

(1) Click [Interface].

(2) Turn on [Adjust interface for touch operations].

(3) Configure the sizes of buttons and characters in [Interface Scaling].

(4) Click [OK].

3 Quit the application
Close Clip Studio Paint.

Please note that the use of functions related to touch operation is only supported in Windows 8 and 10 .

 Depending on the settings of Windows, there might be some items which are not displayed by the [Large], 

[Default], and [Small] buttons.

 If you are using a touch device without a pen, set [Using tablet service] to [Wintab] in the [Preferences] dialog 

> [Tablet] to switch between touch operation and tool operation when using this software. For details on how 

to switch, see "Switch between tool operations and touch operations when operating the canvas".
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Explanation: Operations Using Unique Windows Features  > Switching to Screen Optimized for Touch Operations
4 The screen is optimized
Start Clip Studio Paint. The screen of Clip Studio Paint has been optimized for touch operations in Windows.
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Explanation: Operations Using Unique Windows Features > Switching to Screen Optimized for Touch Operations > Command Bar
Command Bar
On the Command Bar, there are some items to use the screen optimized for touch operations conveniently.

A. Show menu
Touching the icon displays the Clip Studio Paint menu.

If you click [Show Menu] by the touch pen or mouse, the normal menu is shown.

Command Bar

A B

Click          to return to the menu item one level up.

Click          to close the menu. 
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Explanation: Operations Using Unique Windows Features > Switching to Screen Optimized for Touch Operations > Command Bar
B. Switch between tool operations and touch operations when operating the canvas
You can swipe the screen with one finger to switch between operating the selected tool or performing touch operations by finger.

 When this is turned on, you can swipe the screen with one finger to perform touch operations by finger.

 When this is turned off, you can swipe the screen with one finger to operate the selected tool.

C. Show/hide title bar and menu bar
Tap this icon to show/hide the title bar and menu bar.

For details on touch operations on the canvas, see "Operating the Canvas by Touch Operations".

If [Show canvas tab] is turned off in the menu to the right of [Show/hide title bar and menu bar], the canvas tab will 

be hidden when there is only one canvas open.
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Explanation: Operations Using Unique Windows Features > Using Touch Operations in Clip Studio Paint > Operating the Canvas by Touch Opera-
tions
 Using Touch Operations in Clip Studio Paint
This section describes the type of touch operations used in Clip Studio Paint and how to operate canvas and palette by
touch operations.

Operating the Canvas by Touch Operations
On the screen optimized for touch operations, the below-described touch operations can be performed on the canvas.

Swipe vertically/horizontally by one finger
Swiping vertically/horizontally by one finger on the canvas allows you to execute the functions assigned to [Single Swipe] on the [Modifier 

Key Settings] dialog box. For details on the [Modifier Key Settings] dialog box, see "Modifier key settings [Windows] [PRO/EX]".

This operation can only be performed when [Switch between tool and touch operations when operating the can-

vas] is turned on in [Command Bar]. For details, see "Command Bar".

 Setting [Fingertips] sub tool to [Single swipe]
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Explanation: Operations Using Unique Windows Features > Using Touch Operations in Clip Studio Paint > Operating the Canvas by Touch Opera-
tions
Swipe vertically/horizontally by two fingers
Swiping vertically/horizontally by two fingers on the canvas scrolls the canvas.

Rotate
Rotating on the canvas rotates the canvas.
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Explanation: Operations Using Unique Windows Features > Using Touch Operations in Clip Studio Paint > Operating the Canvas by Touch Opera-
tions
Pinch in/pinch out
Pinching in on the canvas zooms out the canvas view.

Pinching out on the canvas zooms in the canvas view.
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Explanation: Operations Using Unique Windows Features > Using Touch Operations in Clip Studio Paint > Operating the Canvas by Touch Opera-
tions
Press and tap on Navigator Palette
Pressing and tapping an image shown on the Navigator palette, resets the rotation of the canvas and fits the canvas to the screen.
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Explanation: Operations Using Unique Windows Features > Using Touch Operations in Clip Studio Paint > Operating the Page manager Window by 
Touch Operations
Operating the Page manager Window by Touch Operations
On the screen optimized for touch operations, swiping vertically/horizontally in the [Page Manager] window allows you to scroll.

Both swiping vertically/horizontally by one finder and two fingers are allowed.
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Explanation: Operations Using Unique Windows Features > Using Touch Operations in Clip Studio Paint > Operating the Palettes by Touch Oper-
ations
Operating the Palettes by Touch Operations
On the screen optimized for touch operations, the above-described touch operations can be performed on each palette.

Tool Palette
The following touch operations are available on the Tool palette.

Swipe vertically/horizontally
Swiping the tool icon vertically/horizontally, switches the position of the icon.

Sub tool palette
The following touch operations are available on the Sub Tool palette.

Swipe horizontally
Swiping the button of a sub tool horizontally, switches the position of the button.

Tap by two fingers
Tap the Sub Tool palette with two fingers to show or hide the Command Bar.

Tool Property Palette
The following touch operations are available on the Tool Property palette.

Tap by two fingers
Tap the Tool Property palette with two fingers to show or hide the Command Bar and stroke preview.

Sub Tool Detail Palette [PRO/EX]
The following touch operations are available on the Sub Tool Detail palette.

Swipe vertically
Swiping the list of [Brush tip shape] vertically switches the items of the list.

Color Set Palette
The following touch operations are available on the Color Set palette.

Tap by two fingers
Tap the Color Set palette with two fingers to show or hide the Command Bar.

Layer Palette
The following touch operations are available on the Layer palette.

Swipe vertically
 Swiping the eye icon vertically, shows/hides the layer.

 Swiping the selected icon vertically, switches the selected layer.

Swipe horizontally
Swiping the layer horizontally, switches the order of layers.

Tap by two fingers
Tap the Layer palette with two fingers to show or hide the Command Bar and Property Bar.
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Explanation: Operations Using Unique Windows Features > Using Touch Operations in Clip Studio Paint > Operating the Palettes by Touch Oper-
ations
Search layer Palette [PRO/EX]
The following touch operations are available on the Search Layer palette.

Swipe vertically
 Swiping the eye icon vertically, shows/hides the layer.

 Swiping the selected icon vertically, switches the selected layer.

Tap by two fingers
Tap the Search Layer palette with two fingers to show or hide the Command Bar and Property Bar.

Timeline palette
The following touch operations are available on the Timeline palette.

Pinch in/pinch out
Pinching out a frame on the Timeline palette zooms out the view. Pinching in zooms in the view.

Navigator Palette
The following touch operations are available on the Navigator palette.

Pinch in/pinch out
Pinching out an image shown on the Navigator palette, zooms out the view. Pinching in zooms in the view.

Rotate
Rotating an image shown on the Navigator palette, rotates the canvas.

Tap by two fingers
Tap the Navigator palette with two fingers to show or hide the Command Bar.

Press and tap
Pressing and tapping an image shown on the Navigator palette, resets the rotation of the canvas and displays the whole canvas.

Sub View Palette [PRO/EX]
The following touch operations are available on the Sub View palette.

Pinch in/pinch out
Pinching in/out an image shown on the Sub View palette, zooms out/in the display.

Tap by two fingers
Tap the Sub View palette with two fingers to show or hide the Command Bar.

Material Palette
The following touch operations are available on the Material palette.

Swipe horizontally
Swiping [Tree view] horizontally, switches the order of the items in the tree.
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Explanation: Operations Using Unique Windows Features > Using Touch Operations in Clip Studio Paint > Operating the Palettes by Touch Oper-
ations
Auto Action Palette [PRO/EX]
The following touch operations are available on the Auto Action palette.

Swipe horizontally
Swiping [Auto action list] horizontally, switches the order of the items.

Tap by two fingers
Tap the Auto Action palette with two fingers to show or hide the Command Bar.
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Explanation: Operations Using Unique Windows Features > Using a Surface Dial with Clip Studio Paint > Using the Surface Dial Menu
 Using a Surface Dial with Clip Studio Paint
Clip Studio Paint supports operations with the Surface Dial. This section explains how to use the Surface Dial with Clip
Studio Paint.

Using the Surface Dial Menu
Display the specialized Clip Studio Paint menu from the Surface Dial to select a feature.

1 Displaying the Menu
Press and hold the Surface Dial. The menu appears in the display.

2 Selecting a Feature
Rotate the Surface Dial to select the feature you want to use. The selected feature name is displayed in the center of the menu.

Connect your computer to the Surface Dial before using the Surface Dial.

The Surface Dial vibrates each time the selected feature is changed.

Parallel line ruler

UndoUndo
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Explanation: Operations Using Unique Windows Features > Using a Surface Dial with Clip Studio Paint > Using the Surface Dial Menu
3 Executing the Feature
Press the Surface Dial. The menu is hidden and the selected feature is executed.

 For details on how to use each function, see "Using a Surface Dial with Clip Studio Paint".

 To select another feature, press and hold the menu again.

The Menu will be hidden.
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Explanation: Operations Using Unique Windows Features > Using a Surface Dial with Clip Studio Paint > Using a Surface Dial with Clip Studio Paint
Using a Surface Dial with Clip Studio Paint
The operations that can be performed in Clip Studio Paint with the Surface Dial differ depending on the item selected in the menu.

The following features can be used from the Surface Dial menu.

(1) "Scale"

(2) "Rotate Canvas"

(3) "Undo"

(4) "Brush Size"

 (5) "Timeline"

(6) "Parallel line ruler [PRO/EX]"

Scale
If [Zoom In/Out] is selected from the Surface Dial menu, you can scale the canvas up or down. Operations are as follows.

Rotate Canvas
If [Rotate Canvas] is selected from the Surface Dial menu, you can rotate the canvas. Operations are as follows.

Undo
If [Undo] is selected from the Surface Dial menu, you can perform [Undo] or [Redo]. Operations are as follows.

Zoom in Rotate the Surface Dial to the right

Zoom out Rotate the Surface Dial to the left

Fit to Screen Press the Surface Dial

Rotate right Rotate the Surface Dial to the right

Rotate Left Rotate the Surface Dial to the left

Reset Rotate Display Press the Surface Dial

Redo Rotate the Surface Dial to the right

Undo Rotate the Surface Dial to the left

The Surface Dial vibrates with each [Undo] and [Redo] operation.

Parallel line ruler
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Explanation: Operations Using Unique Windows Features > Using a Surface Dial with Clip Studio Paint > Using a Surface Dial with Clip Studio Paint
Brush Size
If [Brush Size] is selected with the Surface Dial, you can change the selected brush size. Operations are as follows.

Timeline
If [Timeline] is selected from the Surface Dial menu, you can play the timeline. Operations are as follows.

Parallel line ruler [PRO/EX]
If [Parallel line ruler] is selected from the Surface Dial menu, you can change the angle of the parallel line ruler on the canvas. Operations are 

as follows.

Increase brush size Rotate the Surface Dial to the right

Reduce brush size Rotate the Surface Dial to the left

When the tool has been switched with the modifier key, Surface Dial operations are applied to the previous tool.

If the drawing tool is selected by tool shift or tail switch, Surface Dial operations are applied to the selected tool.

Go to next frame Rotate the Surface Dial to the right

Go to previous frame Rotate the Surface Dial to the left

Playing and Stopping the Timeline Press the Surface Dial

 Create a parallel line ruler with the [Ruler] tool before performing this operation with that Surface Dial.

 If there are multiple parallel line rulers on the canvas, select the parallel line ruler to be operated using the 

[Object] tool.

Rotate right Rotate the Surface Dial to the right

Rotate Left Rotate the Surface Dial to the left

Making the ruler horizontal or vertical Press the Surface Dial
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How to: Tablet exclusive 
controls [Tablet]
Clip Studio Paint for tablets supports tablet touch gestures.

This section not only explains how to use Clip Studio Paint, but will introduce features unique to the tablet 

version.

 Operations using touch gestures

 Using the edge keyboard



How to: Tablet exclusive controls [Tablet]  > Operations using touch gestures
How to: Tablet exclusive controls [Tablet]

 Operations using touch gestures
This section will explain settings to make better use of touch gestures.

Command Bar
On [Command Bar], there are some items to use the screen optimized for touch operations conveniently.

A. Show menu
Touching the icon displays the Clip Studio Paint menu.

B. Use different tools with fingers and pen
Switch between using the current tool or the tool assigned as a touch gesture when swiping with one finger.

 When turned on, swiping with one finger will operate the tool defined in the [Modifier Key Settings] dialog. The [Hand] tool will be 

assigned by default.

 When this is turned off, you can swipe the screen with one finger to operate the selected tool.

By tapping to the right of the icon, you can access touch gesture settings.

(1) Use different tools with fingers and pen

Switch between using the current tool or the tool assigned as a touch gesture when swiping with one finger.

A B
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How to: Tablet exclusive controls [Tablet] > Operations using touch gestures > Command Bar
(2) Set tool to use with finger

When selected, the [Modifier Key Settings] dialog will be displayed. The tool assigned to touch gestures can be set.

For details on the [Modifier Key Settings] dialog, see "Modifier key settings [Windows] [PRO/EX]". It will be written 

for Windows users, but the Tablets can be set in the same way.
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How to: Tablet exclusive controls [Tablet] > Operations using touch gestures > Command Bar
(3) Touch gesture settings

Selecting this item displays the [Preferences] dialog. The target content of touch gesture operation can be set.
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How to: Tablet exclusive controls [Tablet] > Operations using touch gestures > Operating the canvas with touch gestures
Operating the canvas with touch gestures
In the tablet version's canvas, the following operations can be controlled with touch gestures.

Undo
Two finger tapping undoes the last operation.

Redo
Three finger tapping redoes an undone operation.

Scrolling Across the Canvas
Swiping up and down, left and right on the canvas will scroll the canvas.

Rotating the Canvas
Rotating on the canvas rotates the canvas.

Scaling the canvas
Pinching in on the canvas zooms out the canvas view.

Pinching out on the canvas zooms in the canvas view.

Operating the palette with touch gestures
The following operations can be done with touch gestures on the palette.

Quick Access Palette
The following touch gestures can be used in the Quick Access palette.

Scrolling the palette
You can scroll through the Quick Access palette by swiping with your finger inside the palette.

By changing [Change Order] to [Command + Drag] in the Quick access palette, the same operation can be done with a pen.

Right click operation
Right-click operations can be used by long-pressing anywhere on the Quick Access palette with a finger.

By changing [Change Order] to [Command + Drag] in the Quick access palette, the same operation can be done with a pen.

Tool Palette
The following touch gestures can be used on the Tool palette.

Change tool position
Swiping the tool icon vertically/horizontally, switches the position of the icon.

Several touch gestures may be disabled upon initial activation. To enable touch gesture control, set [Touch ges-

ture] in the [Preferences] dialog. For details on the [Preferences] dialog box, see "Touch gesture".

In the default settings, when [Use different tools with fingers and pen] is turned on, the canvas can be scrolled by 

swiping with one finger. For [Use different tools with fingers and pen], see "Command Bar".
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How to: Tablet exclusive controls [Tablet] > Operations using touch gestures > Operating the palette with touch gestures
Sub tool palette
The following touch gestures can be used on the Sub Tool palette.

Change button position
Swiping the button of a sub tool horizontally, switches the position of the button.

Displays/hides the [Command Bar].
Tap the Sub Tool palette with two fingers to show or hide the Command Bar.

Scrolling the palette
You can scroll through the Sub Tool palette by swiping with your finger inside the palette.

By changing [Change Order] to [Command + Drag] in the Quick access palette, the same operation can be done with a pen.

Right click operation
Right-click operations can be used by long-pressing anywhere on the Sub Tool palette with a finger.

By changing [Change Order] to [Command + Drag] in the Quick access palette, the same operation can be done with a pen.

Tool property Palette
The following touch gestures can be used in the Tool Property palette.

Display/hide the [Command Bar]
Tap the Tool Property palette with two fingers to show or hide the Command Bar and stroke preview.

Scrolling the palette
You can scroll through the Tool Property palette by swiping with your pen inside the palette.

Sub tool detail palette
The following touch gestures can be used in the Sub Tool Detail palette.

Switching the brush tip shape order
Vertically swiping the list of [Brush tip shape] switches the items on the list.

Scrolling the palette
You can scroll through the Sub Tool Detail palette by swiping with your pen inside the palette.

Color Set Palette
The following touch gestures can be used on the Color Set palette.

Show/hide command bar
Tap the Color Set palette with two fingers to show or hide the Command Bar.

Scrolling the palette
You can scroll through the Color Set palette by swiping with your finger inside the palette.

By changing [Change Order] to [Command + Drag] in the Quick access palette, the same operation can be done with a pen.

Right click operation
Right-click operations can be used by long-pressing anywhere on the Color Set palette.

By changing [Change Order] to [Command + Drag] in the Quick access palette, the same operation can be done with a pen.
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How to: Tablet exclusive controls [Tablet] > Operations using touch gestures > Operating the palette with touch gestures
Layer Palette
The following touch gestures can be used on the Layer palette.

Displays/hides the [Command Bar].
Tap the Layer palette with two fingers to show or hide the Command Bar and Property Bar.

Scrolling the palette
You can scroll through the Layer palette by swiping inside the palette.

Right click operation
Right-click operations can be used by long pressing anywhere on the Layer palette.

Layer search palette
The following touch gestures can be used in the Search Layer palette.

Displays/hides the [Command Bar].
Tap the Search Layer palette with two fingers to show or hide the Command Bar and Property Bar.

Scrolling the palette
You can scroll through the Search Layer palette by swiping inside the palette.

Right click operation
Right-click operations can be used by long-pressing anywhere on the Search Layer palette with a finger.

Animation Cels palette
The following touch gestures can be used on the Animation Cels palette.

Displays/hides the [Command Bar].
Tap the Animation Cels palette with two fingers to show or hide the Command Bar and Property Bar.

Scrolling the palette
You can scroll through the Animation Cels palette by swiping inside the palette.

Right click operation
Right-click operations can be used by long-pressing anywhere on the Animation Cels palette.
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How to: Tablet exclusive controls [Tablet] > Operations using touch gestures > Operating the palette with touch gestures
Timeline palette
The following touch gestures can be used on the Timeline palette.

Scaling the timeline
Pinching in the Timeline palette will scale down the timeline display.

Pinching out on the Timeline palette will scale up the timeline display.

Scrolling the timeline
Swiping horizontally and vertically will scroll the timeline.

Scroll through tracks and thumbnails
Swiping the Timeline palette's track or thumbnail will scroll the track or thumbnail.

Right click operation
Right click operations can be used by long pressing anywhere on the Timeline palette's track or thumbnail with a finger.

Right click operations can be used by long pressing anywhere on the Timeline palette's timeline with a finger.

Navigator Palette
By using touch gestures on the Navigator palette, the canvas display can be changed.

Scrolling Across the Canvas
Swiping the Navigator palette vertically/horizontally with two fingers on the canvas will scroll the canvas.

Rotating the Canvas
Rotating the Navigator palette's image preview will rotate the canvas.

Scaling the canvas
Pinching in the Navigator palette's image preview will scale down the canvas display.

Pinching out the Navigator palette's image preview will scale up the canvas display.

Reset display
Three finger tapping the Navigator palette's image preview resets the rotation of the canvas and fits the canvas to the screen.

Show/hide command bar
Tap the Navigator palette with two fingers to show or hide the Command Bar.
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How to: Tablet exclusive controls [Tablet] > Operations using touch gestures > Operating the palette with touch gestures
Sub view palette
The following touch gestures can be used on the Sub View palette.

Scrolling images
Swiping vertically/horizontally on an image in the Sub View palette with two fingers will scroll the image.

Rotating the Canvas
Rotating an image shown on the Sub View palette will rotate the canvas.

Scaling the canvas
Pinching in/out an image shown on the Sub View palette, zooms out/in the display.

Show/hide command bar
Tap the Sub View palette with two fingers to show or hide the Command Bar.

Auto action palette
The following touch gestures can be used in the Auto Action palette.

Show/hide command bar
Tap the Auto Action palette with two fingers to show or hide the Command Bar.

Material Palettes
The following touch gestures can be used on the Material palette.

Show/hide command bar
Tap the Material palette with two fingers to show or hide the Command Bar.

Scroll Material view
Materials can be scrolled by swiping through the list in the Material palette.

Scroll tag view
Tags can be scrolled by swiping in the Material palette's tags.
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How to: Tablet exclusive controls [Tablet] > Using the edge keyboard > Edge keyboard functions
 Using the edge keyboard
The edge keyboard is a function that assists control of Clip Studio Paint. By using the edge keyboard, modifier keys
and shortcuts can be used.

Edge keyboard functions
The following will describe the edge keyboard functions.

When using iPad

(1) ESC

It is equivalent to the Esc key on a keyboard. 

To change how the edge keyboard is shown, go to [Preferences] > [Interface] > [Edge keyboard]. You can choose 

from hiding the keyboard or opening it with a button or swipe gesture. For how to configure, see "Interface".

This explains how to view the edge keyboard by swiping. For how to display the edge keyboard with a button, 

please see "Show/hide edge keyboard".
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How to: Tablet exclusive controls [Tablet] > Using the edge keyboard > Edge keyboard functions
(2) Control

It is equivalent to the Control key on a keyboard. 

(3) Shift

It is equivalent to the Shift key on a keyboard. 

(4) Option

It is equivalent to the Option key on a keyboard. 

(5) Command

It is equivalent to the Command key on a keyboard. 

(6) Space

It is equivalent to the space bar on a keyboard. 

(7) Touch keys

Keys numbered 1-15. The number of displayed buttons depends on the size and direction of the iPad. In this screen, keys up to 10 are dis-

played.

You can register these keys as shortcut keys by using the [Shortcut Settings] screen. Commands and auto actions can be executed just by 

tapping a key.

Display edge keyboard
Swipe from either side of the screen towards the canvas with a finger. The edge keyboard will be displayed at the edge of Clip Studio Paint.

You can open the [Shortcut Settings] dialog by selecting the [CLIP STUDIO PAINT] menu > [Shortcut Settings]. On 

setting details, refer to "Shortcut Settings [Windows]". 

Swipe
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How to: Tablet exclusive controls [Tablet] > Using the edge keyboard > Edge keyboard functions
By swiping a short distance, the edge keyboard will be translucent. In that case, operations can be divided in the following manner.

 The edge keyboard can be operated with fingers.

 Pens such as the Apple Pencil cannot operate the edge keyboard, but can operate overlapping canvases and palettes.

Hide edge keyboard
Align a finger with the edge keyboard and swipe towards the nearest edge. The edge keyboard will be hidden.

If a transparent edge keyboard is accidentally displayed, it can be changed by swiping in the same direction again.

When the swipe is short, the displayed edge keyboard will become transparent. By swiping in the same direction 

again, it can be hidden.

Swipe
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How to: Tablet exclusive controls [Tablet] > Using the edge keyboard > Edge keyboard functions
When using Android/Chromebook

(1) Esc

Equivalent to the Esc key on a keyboard.

(2) Ctrl

Equivalent to the Ctrl key on a keyboard.

(3) Shift

Equivalent to the Shift key on a keyboard.

(4) Alt

Equivalent to the Alt key on a keyboard.

(5) Space

Equivalent to the Space bar on a keyboard.

(6) Touch keys

The number of buttons displayed depends on the size and orientation of the device.

You can register these keys as shortcut keys by using the [Shortcut Settings] screen. Commands and auto actions can be executed just by 

tapping a key.

For details on the items in the [Shortcut Settings] dialog box, see "Shortcut Settings [Windows]".
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How to: Tablet exclusive controls [Tablet] > Using the edge keyboard > Edge keyboard functions
Show/hide edge keyboard
Tapping this shows or hides the edge keyboard.
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How to: Smartphone 
exclusive controls 
[Smartphones]
This section not only explains how to use Clip Studio Paint, but will introduce features unique to the smart-

phone version.

 Clip Studio Paint screen layout

 Smartphone Preparation Recommedations

 Using tools

 Using Menus

 Using Palettes

 Screen customization

 Operations using touch gestures

 Operation using the edge keyboard



How to: Smartphone exclusive controls [Smartphones]  > Clip Studio Paint screen layout
How to: Smartphone exclusive controls [Smartphones]

 Clip Studio Paint screen layout
This section describes the default screen structure of Clip Studio Paint for smartphone.

(1) Timer Bar

This shows at the top of a Clip Studio Paint when a canvas is opened. All functions of Clip Studio Paint are available for one hour per day. 

The Timer Bar does not show after you have purchased the EX or PRO versions.

(2) Menu

Tapping this shows the menu. For details on how to use Menus, see "Using Menus".

(3) Edit Bar

You can select your drawing tool and set its brush size and opacity from here. For details on the functions of the Edit Bar, see"Edit Bar".

Items displayed on the Edit Bar can be set in the [App Settings] menu > [Edit Bar Settings]. For details, see "Edit 

Bar Settings".
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How to: Smartphone exclusive controls [Smartphones]  > Clip Studio Paint screen layout
(4) Canvas View

Tapping this hides everything but the canvas view button and the canvas. Tap it again to return to the previous display. This is useful when 

you want unobstructed access to the canvas.

(5) Palette Bar

Each button on the palette bar corresponds to a different palette. Tapping one shows its palette. A palette allows you to configure a variety 

of settings. The palette bar can store multiple palettes. For details on the functions of each button on the Palette Bar, see "Palette Bar".

(6) Command Bar

Tapping each button allows you to execute a variety of functions. You can customize the icon view by displaying the icon of frequently 

used functions, for example. For details on the functions of each button on the Command Bar, see "Command Bar".

(7) Edge Keyboard Toggle

Tap this to show and hide the edge keyboard.

For information on using the edge keyboard, see"Operation using the edge keyboard".

Items displayed on the Palette Bar can be set in the [App Settings] menu > [Palette Bar Settings]. For details, see 

"Palette Bar Settings".

Items displayed on the Command Bar can be set in the [App Settings] menu > [Command Bar Settings]. For 

details, see "Command Bar Settings".

 Drag the Edge Keyboard Toggle to move it up, down, left, or right on the screen. The Edge Keyboard Toggle 

can be placed anywhere on the right, left, or bottom edge of the screen. However, the Edge Keyboard itself can 

only display on the left or right edge of the screen. When the Edge Keyboard Toggle is placed at the bottom of 

the screen, placing it towards the left will open the Edge Keyboard on the left side of the screen and placing it 

towards the right will open the Edge Keyboard on the right side of the screen.

 The Edge Keyboard Toggle can be hidden in the [Preferences] under [App Settings]. For details, see "Inter-

face". If the Edge Keyboard Toggle is hidden, the edge keyboard cannot be used.
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How to: Smartphone exclusive controls [Smartphones] > Clip Studio Paint screen layout > Edit Bar
Edit Bar
This section describes each of the functions on the Edit Bar from top to bottom.

(1) Tool Switch

This switches between the currently used tool and the eraser.

(2) Sub Tools

These are drawing tools. The [Tappered], [Rectangle], and [Object] are shown when you first start up the app. Tapping a sub tool once 

selects it. Tapping it again opens the sub tool bar where you can change it to a new tool.

Tap the new tool you wish to use from the sub tool bar to select it and tap the icon a second time to go back to the canvas.

For details on how to select a tool, see "Selecting a tool".

The [Eraser] tool is set by default, but you can change the tool you want to switch to via the [Tool switch icon] 

option under [Common settings] on the [Modifier Key Settings] screen. For details, see "Modifier Key Settings".

You can change the number of tools shown on the Edit Bar. For details, see "Edit Bar Settings".
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How to: Smartphone exclusive controls [Smartphones] > Clip Studio Paint screen layout > Edit Bar
(3) Brush Size

Use this slider to set the brush size of drawing tools.

If you don't see the slider, tapping the pixel circle will show it along with a spin button.

If you do see a slider, taping the pixel circle shows the spin button only.

(4) Opacity

Use this slider to set the opacity of drawing tools.

If you don't see the slider, tapping the percent circle will show it along with a spin button.

If you do see a slider, taping the percent circle shows the spin button only.

(5) Color Icons

These icons display the main, sub, and transparent colors. Tap an icon to select its color.

 Tapping the single color icon, shows the [Color Settings] screen where you can change its color.

 Tapping the compound color icon, shows a pop up with the two other single color icons. Tap the first single icon to show the [Color 

Settings] screen where you can change its color. Tapping the transparent color icon will not show the [Color Settings] screen.

Main color This is the color you will use most often.

Sub color

This is the color you will use often after the main color.

If a tool has [Sub color] or [Blend with sub color] in its settings, this color will be used. For example, if 

you specify [Line/Fill] under [Edit tool properties] for the [Figure] tool, the main color will be used for 

the figure’s outline, and the sub color will be used for its filling.

Transparent color Select this icon to use transparent color.

You can change the way the color icons are displayed. For details, see "Edit Bar Settings".
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How to: Smartphone exclusive controls [Smartphones] > Clip Studio Paint screen layout > Palette Bar
Palette Bar
This section describes each of the functions on the Palette Bar from left to right.

(1) Quick Access

Tapping this shows the [Quick Access] palette. The [Quick Access] palette can register frequently used tools, menu commands, auto 

actions, and drawing colors. Registered functions can be used from the [Quick Access] palette. For details, see "Quick Access Palette 

[PRO/EX]".

(2) Layer

Tapping this shows the [Layer] palette. The [Layer] palette allows you to manage layers such as changing their stacking order, blending 

mode, opacity, etc. For details, see "Layer Palette".

(3) Layer Property

Tapping this shows the [Layer Property] palette. The [Layer Property] palette allows you to set a variety of effects and a layer’s expression 

color. For details, see "Layer Property Palette [PRO/EX]".

(4) Tool Property

Tapping this shows the [Tool Property] palette. The [Tool Property] palette allows you to adjust a Sub tool’s settings. For details, see "Tool 

Palette".

(5) Color Wheel 

Tapping this shows the [Color Wheel] palette. The [Color Wheel] palette allows you to select a color from the color wheel. For details, see 

"Color Wheel Palette".

(6) Color Set

Tapping this shows the [Color Set] palette. The [Color Set] palette allows you to select a color from a list of colors. For details, see "Color 

Set Palette".

 For details on palettes , see "Palette".

 Items displayed on the Palette Bar can be set in the [App Settings] menu > [Palette Bar Settings]. For details, 

see "Palette Bar Settings".

 For details on how to use palettes, see "Using Palettes".
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(7) Color History

Tapping this shows the [Color History] palette. The [Color History] palette shows a history of your drawing colors. For details, see "Color 

History Palette [PRO/EX]".

(8) Material

Tapping this shows the [Material] palette. The [Material] palette manages various materials used to create comics and illustrations. For 

details, see "Material Palettes".

Command Bar
This section describes the function of each button on the command bar from left to right.

(1) Close

Closes the current canvas being edited. If you have not yet saved the canvas, a screen asking you if you want to save it will show.

If the page list is showing or you are in the story editor, close them.

(2) Save

Saves the current canvas being edited.

(3) Undo

Undoes the previous operation.

(4) Redo

Redoes the undone operation.

(5) Delete

Deletes everything drawn on a layer. If there is a selected area, it erases everything in the selection.

(6) Scale/Rotate

Scales up/down, rotates, and transforms. If there is a selected area, scales up/down, rotates and transforms the content of the selection.

Items displayed on the Command Bar can be set in the [App Settings] menu > [Command Bar Settings]. For 

details, see "Command Bar Settings".
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(7) Copy

Copies the selected area of a layer to the clipboard. If an object is selected with the [Object] tool, it will be copied to the clipboard. If there 

is no selection at all, the entire layer is copied to the clipboard.

(8) Cut

Cuts the selected area of the layer and copies it to the clipboard, deleting the image from the canvas. If you select an object with the 

[Object] tool, the object will be cut and copied to the clipboard. If there is no selection, the entire layer is copied to the clipboard.

(9) Paste

Adds a layer to the [Layer] palette, and pastes the image to the canvas from the clipboard.

If a Object was copied to the clipboard with the [Object] tool, it will be pasted onto the current layer.
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 Smartphone Preparation Recommedations
Before using Clip Studio Paint, we recommend doing the following:

Adjust pen pressure settings
When using stylus pens with pen pressure support on a Smartphone, or using pen tablets with Android devices, pen pressure sensitivity can be 

adjusted. You can draw with a pen or brush which responds to your pen pressure.

If you are using an iPhone device that supports 3D Touch, you can adjust the pen pressure settings when drawing with your finger.

1 Tap [Menu], then select the [App Settings] menu > [Pen Pressure Settings] to adjust pen 
pressure sensitivity.

2 Adjust the pen pressure sensitivity from the [Adjust pen pressure] pop up screen.

(1) Draw on the canvas with your usual pen pressure, while deliberately increasing and decreasing pen pressure.

(2) Tap [Check adjusted settings].

When using a device without pen pressure, display the [Sub tool detail] palette of the drawing tool you want to 

use, and set [Starting and ending] to make your lines thinner and lighter at both the beginning and end of your 

lines.

 For details on how to select a tool, see "Selecting a tool".

 For details on how to display the [Sub Tool Detail] palette, refer to"Setting up tools".

 For details on the basic functions of the [Sub Tool Detail] palette, refer to"Sub tool detail palette [PRO/EX]".

 For detailed items on the [Sub Tool Details] palette, refer to the "Clip Studio Paint Tool Setting Guide."

If you use a Wacom stylus pen, check "If you use a Wacom stylus pen" before drawing on the canvas. Swipe up on 

the dialog to show options for setting hand position when using a Wacom stylus.
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3 When the [Check adjusted settings] screen appears, you can further adjust the pen pres-
sure sensitivity.

(1) Draw with your usual pen pressure on the canvas. If you are satisfied with the result, proceed to step 3. To further adjust the pen pres-

sure settings, proceed to step 2.

(2) Tap [Stronger] or [Lighter] as needed. Draw on the canvas again, and adjust the pen pressure to your liking.

(3) Click [Complete].

For details on the [Adjust pen pressure] or [Check adjusted settings] screens, see "Pen Pressure Settings [Win-

dows]". In the Windows version, settings are made with the pen, but the options are the same.
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 Using tools
Clip Studio Paint  has a variety of useful tools for creating art. This section describes how to select and set tools.

Selecting a tool
This section shows how to select tools and their sub tools.

1 Tap the button of the selected tool from the edit bar again.

2 This opens the [Select sub tool] screen. From here you can select a tool and a sub tool.

(1) Select a tool from the left side of the screen. In the example above, the [Brush] tool is selected. The Sub tool options on the right 

change according to the selected tool on the left.

(2) Select a sub tool from the right side of the screen. The [Realistic watercolor] tool is then selected. The sub tool options switch accord-

ing to the selected sub tool group.

(3) Select the sub tool. [Soft bleed] is then selected.

(4) Tap [Close].

 For details on the features of each tool, see "Tool List".

 When you tap a selected sub tool from the [Select sub tool] screen for a second time, the [Edit tool properties] 

screen will show and you can set the tool.
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Setting up tools
This section covers refining tools by making tool settings.

Setting the brush size and opacity
The brush size and opacity can be set from the edit bar. For details, see "Edit Bar".

Making detailed tool settings
You can use the both the [Tool Property] palette and [Sub tool detail] palette to make more detailed settings other than than brush size and opac-

ity.

1 Tap [Tool Property] from the palette bar.

2 The [Tool Property] palette will show.
The main settings of the selected sub tool can be set from the [Tool Property] palette. 

If you want to make more detailed settings, please proceed to the next step.

On the [Select sub tool] screen, tap the selected sub tool’s name to show the [Edit tool properties] screen. Here 

you can make the same settings as in the [Tool Property] palette.
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3 Click [Sub Tool Detail], the wrench icon on the bottom right of the [Tool Property] palette.

4 The [Sub Tool Detail] Palette will show.
The [Sub Tool Detail] palette has more setting options for sub tools than the [Tool Property] palette. You can access those options by doing 

the following.

(1) Tap the category name and select a category from the pull-down menu. The options you can set change according to the selected cat-

egory.

(2) These settings are then set to the sub tool.

(3) Tap [×] to close the [Sub Tool Details] palette.

 For details on the functions in the [Tool Property], see "Tool Palette".

 For details on the functions in the [Sub Tool Detail] palette, see"Sub tool palette".

 For details on setting options to each tool, see the Clip Studio Paint Tool Setting Guide. The functions are 

sorted by category.
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Selecting Color
This section covers the various ways to select drawing colors.

Selecting from the Edit Bar
You can select a color by tapping the color icon on the edit bar. To change the color displayed on the color icon, tap the color icon again and 

select a color from the [Color settings] screen. For details on the [Color settings] screen, see "Advanced settings of color Dialog Box".

Selecting Color Palettes
Tap [Color Wheel] or [Color Set] from the palette bar. You can select a color from either of these.

Tapping the compound color icon, shows a pop up with the two other single color icons. Tap the first single icon 

to show the [Color Settings] screen where you can change its color. Tapping the transparent color icon will not 

show the [Color Settings] screen.

 For details on how to use the [Color Wheel] palette, refer to "Color Wheel Palette".

 For details on how to use the [Color Set] palette, refer to "Color Set Palette".
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Using Eyedropper Functions
Long press on the canvas with your finger to switch to the eyedropper.

You can change the tool this switches to via [Long Press] in the [Modifier Key Setting] screen. For details, see 

"Modifier Key Settings".
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 Using Menus
Tapping [Menu] shows the Clip Studio Paint menu screen.

(1) Close

This closes the menu screen. It shows when the top menu is displayed.

(2) Back

Returns to the previous menu. It shows when a submenu is displayed.

(3) Menu name

The menu name is of the last menu you tapped. The name “Menu” shows when you first open the top menu.

(4) Menu commands

Tapping this executes the menu command. If there is a submenu, the submenu displays.

The menu screen closes as soon as a menu command is executed. Menu commands with submenus have [>] displayed on the right end of 

the row.

When the device is in landscape orientation, the main menu and submenu are displayed at the same time.
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 Using Palettes
This section describes how to use palettes on the Smartphone version.

Displaying Palettes
From the palette bar, tap the button of the palette you want to display.

Closing Palettes
To close a displayed palette, tap anywhere outside it.

If there is no palette you want to display on the palette bar, you can add it using the [Palette Bar Settings] screen. 

For details, see "Palette Bar Settings".

 If you want to operate the canvas while a palette is displayed, see"Fixing a Palette to the Screen".

 If you are using the [Sub Tool Details] palette, tap [×] on the palette to close it.
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Fixing a Palette to the Screen
If the palette is fixed to the screen, the palette will not close even if you tap on the canvas. This is useful if you need to see a palette while edit-

ing the canvas.

Tap [Lock/Unlock] to fix or unfix the palette to the screen.

To close a fixed palette without unfixing it, tap the button of the displayed palette from the palette bar at the bottom of the screen.

 For details on how to resize the palette, see."Changing a Palette’s Size"

 If you reduce the size of a palette, you can display multiple palettes at the same time by tapping another pal-

ette’s button in the palette bar.
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Changing a Palette’s Size
You can change the size of palettes that fill the screen.

If your device is in portrait mode
Swipe the resize bar at the top of the pallete up and down to change the size of the palette.

If your device is in landscape mode
Swipe the resize bar on the left of the pallete left and right to change the size of the palette.

If two palettes are displayed at the same time, the size of the fixed palette can not be changed but the pallete on 

top of the fixed pallete can.
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Displaying Palette Menu
Tapping the [Menu Display] at the top of a palette shows that palette’s settings menu.

For details on each menu item, refer to the explanation page for each palette.
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 Screen customization
The Clip Studio Paint screen is fully customizable. You can both change the arrangement of buttons and set buttons
for frequently used functions to always show on the screen.

Layout Settings
The layout of the bars and buttons in Clip Studio Paint can be arranged and set in the [Layout Settings] screen.

1 Tap [Menu] and select [App Settings] menu > [Layout Settings].
This shows the [Layout Settings] screen, which contains a preview of the Clip Studio Paint interface.

 Frames are displayed at the top, bottom, left, right, and in the four corners of the preview. Bars can be placed on the top, bottom, left and 

right frames. Buttons can be placed in the four corner frames.

2 Changing the orientation of your device.
The layout of Clip Studio Paint can store different settings in both vertical and horizontal directions. By changing the device’s orientation, 

you are able to set a layout that matches its orientation. In this example, the device is set in the vertical direction.

Clip Studio Paint's interface allows you to save different settings depending on whether the device is in vertical or 

horizontal orientation.
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3 Tapping the top, bottom, left and right blue frames will display a menu in the middle of the
screen. From the menu, select the option you want placed at the position you tapped.
The selected bar is now placed at the tapped position.

 Regardless of orientation, more than one bar can be displayed next to each other on the shortest side of the 

screen.

 Furthermore, the Palette Bar cannot be placed on the long side of the screen. When arranging bars side by 

side, they cannot be placed outside the blue frames.

 If you do not want to change layout, after the menu is displayed, tap anything other than the menu to close it 

and return to the preview screen.
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4 Tapping the four corner frames will display a menu in the middle of the screen. From the
menu, select the option you want placed at the position you tapped.
The selected button is now placed at the tapped position.

5 Tap the [OK] button on the bottom right of the screen.

Menu buttons cannot be hidden.

 By changing the device’s orientation while in Layout Settings, you are able to set a layout that matches each 

orientation. Your settings before changing the device’s orientation are also retained.

 To return to the initial layout, tap [Restore default layout] on the lower right of the [Layout Settings] screen.
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Palette Bar Settings
The palette bar items can be set from the [Palette Bar Settings] screen.

1 Tap [Menu] and select [App Settings] menu > [Palette Bar Settings].

2 On the [Palette Bar Settings] screen, select the palettes you want on the palette bar.

(1) Tap the palette name to select it.

(2) A palette icon will be added to the palette bar preview.

(3) Tap [OK].

3 This sets a button for the selected palette to the palette bar currently shown on the top of
the screen.
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The Palette Bar Settings Screen

(1) Preview

This is the settings screen where you can see a preview of the Palette Bar. Drag and lift and drop the icon across the palette bar to rearrange 

the display order of the icons.

(2) List

This shows the pallete bar items in a list. You can select a palette that has been added or deleted from the palette bar.

(3) Show/hide icon

Tap to switch between showing and hiding icons.

If the box on the left of the palette name is checked, the palette will show on the palette bar.

(4) Palette Name

This shows the name of the palette.

A preview of the palette bar settings screen displays at the top of the screen. Drag and lift and drop the icon 

across the palette bar to rearrange the display order of the icons.
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(5) Pair Tools

You can set more than one palette to show simultaneously from one icon in the palette bar.

Tapping [Pair Tools] shows the [Pair Tools] screen. Tap the name of the palette you want to show at the same time with the palette you 

selected to pair with it.

A paired tool’s icon shows both palette icons. Tapping it from the palette bar shows both palettes at the same time.

If you do not want to Pair Tools, tap [Cancel].
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(6) Set Icon

This icon shows the palette icons of a paired tool.

(7) Restore default layout

This restores the Palette Bar to its initial state.

Edit Bar Settings
Tap [Menu], then select the [App Settings] menu > [Edit Bar Settings] to set items displayed on the Edit Bar.

The Palette Bar Settings Screen

(1) No. of sub tool icons

This sets the number of sub tools that can be displayed in the edit bar.

(2) Show tool switch icon

This switches between the currently used tool and the eraser.

(3) Show sliders

When turned on, this shows the [Brush Size] and [Opacity] sliders in the edit bar.

If there is not enough space to display the slider, tap the [Brush Size] and [Opacity] buttons, and the slider will pop up.

(4) How to show color icons

This sets how color icons are displayed.

(5) Reverse order of icons on edit bar

When turned on, this reverses the order of the items on the edit bar.
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Command Bar Settings
Tap [Menu], then select the App Settings] menu > [Command Bar Settings] to set items displayed on the Command Bar.

The Command Bar Settings Screen

(1) Preview

This is the settings screen where you can see a preview of the Command Bar.

Drag and drop the icons in the preview to change their order.

 If your screen is in a vertical orientation, drag and lift and drop the icon horizontally across the command bar to rearrange the display 

order of the icons.

 If your screen is in a horizontal orientation, drag and lift and drop the icon vertically along the command bar to rearrange the display 

order of the icons.

(2) Categories

Select the category of the function you want to add to the Command Bar.

Main menu The list's display will switch to the Main menu.

Options
The list display will switch to optional content. Optional content consists of functions and opera-

tions that are not included in the menu and tools.

Tool The list will switch to the next tool.

Auto action The list will switch to the next auto action.

Drawing color
This shows the [Color settings] screen and allows you to select a color. After selecting a color, an 

icon of that color is added to a list. You can select a color from that list as well.
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(3) Add

This adds the selected item in the list to the Command Bar.

 If the icons are arranged horizontally, they will be added to the right of the icon selected in the preview.

 If the icons are arranged vertically, they will be added below the icon selected in the preview.

(4) Settings

This sets the icons arranged in the preview. Displayed items may vary depending on the selected contents.

(5) Delete

This deletes icons from the command bar preview.

(6) List

Shows the [Selected area] function list. From here you can add functions to the [Command Bar]. If [>] is displayed before the item name, 

double tap it to display the lower hierarchy.

(7) Restore default layout

This restores the command bar to its initial state.

If you set too many icons on the command bar and they do not fit on the screen, you can swipe it to see the hidden 

icons.

Main menu
This shows the [Icon settings] screen. For details on the [Icon settings] dialog, see "Icon settings 

dialog".

Options
This shows the [Icon settings] screen. For details on the [Icon settings] dialog, see "Icon settings 

dialog".

Tool
This shows the [Settings of sub tool] screen. For details on the [Settings of sub tool] dialog box, 

see "Sub tool settings dialog".

Auto action
This shows the [Icon settings] screen. For details on the [Icon settings] screen, see "Icon settings 

dialog".

Drawing color
This shows the [Name Settings] screen. For details on the [Name Settings] dialog box, see "Name 

settings dialog".

Images and background colors set for each icon are maintained even after deletion.
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 Operations using touch gestures
This section describes useful functions regarding touch gestures.

Operating the canvas with touch gestures
In the Smartphone version, the following operations can be performed on the canvas with touch gestures.

Undo
Two finger tapping undoes the last operation.

Redo
Three finger tapping redoes an undone operation.

Scrolling Across the Canvas
Swiping up and down, left and right on the canvas will scroll the canvas.

Rotating the Canvas
Rotating on the canvas rotates the canvas.

Scaling the canvas
Pinching in on the canvas zooms out the canvas view.

Pinching out on the canvas zooms in the canvas view.

Manipulating palettes and tools with touch gestures
The following operations can be done with touch gestures on the palette.

Quick Access Palette
The following touch gestures can be used in the [Quick Access] palette.

Scroll palette
The [Quick Access] palette can be scrolled by swiping in the [Quick Access] palette.

By changing [Change Order] to [Command + Drag] in the Quick access palette, the same operation can be done with a pen.

Right click operation
Right click operations can be used by long pressing anywhere on the [Quick Access] palette with a finger.

By changing [Change Order] to [Command + Drag] in the Quick access palette, the same operation can be done with a pen.

Tool Palette
The following touch gestures can be used on the [Tool] palette.

Change tool position
Swiping the tool icon vertically/horizontally, switches the position of the icon.

Right click operation
Press and hold your finger in the [Tool] palette to perform the same operation as right-clicking.

Several touch gestures may be disabled upon initial activation. To enable touch gesture control, set [Touch ges-

ture] in the [Preferences] dialog. For details on the [Preferences] dialog box, see "Touch gesture".
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Sub tool palette
The following touch gestures can be used on the [Tool] palette.

Change button position
Swipe up and down or left and right on the sub tool buttons to swap their positions.

Scroll palette
The [Sub Tool] palette can be scrolled by swiping in the [Quick Access] palette.

By changing [Change Order] to [Command + Drag] in the Quick access palette, the same operation can be done with a pen.

Right click operation
Right click operations can be used by long pressing anywhere on the [Sub Tool] palette with a finger.

By changing [Change Order] to [Command + Drag] in the Quick access palette, the same operation can be done with a pen.

Tool property Palette
The following touch gestures can be used in the [Tool Property] palette.

Scroll palette
Swipe the [Tool Property] palette with your finger to scroll through it. The same applies when swiping with a pen.

Sub tool detail palette
The following touch gestures can be used in the [Sub Tool Detail] palette.

Switching the brush tip shape order
Vertically swiping the list of [Brush tip shape] switches the items on the list.

Scroll palette
Swipe the [Sub Tool Detail] palette with your finger to scroll through it. The same applies when swiping with a pen.

Color Set Palette
The following touch gestures can be used on the [Color Set] palette.

Scroll palette
The [Color Set] palette can be scrolled by swiping in the [Color Set] palette.

By changing [Change Order] to [Command + Drag] in the Quick access palette, the same operation can be done with a pen.

Right click operation
Right click operations can be used by long pressing anywhere on the [Color Set] palette with a finger.

By changing [Change Order] to [Command + Drag] in the Quick access palette, the same operation can be done with a pen.

Layer Palette
The following touch gestures can be used on the [Layer] palette.

Scroll palette
The [Layer] palette can be scrolled by swiping in the [Layer] palette.

Right click operation
Right click operations can be used by long pressing anywhere on the [Layer] palette with a finger.
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Layer search palette
The following touch gestures can be used in the [Search Layer] palette.

Scroll palette
The [Search Layer] palette can be scrolled by swiping in the [Search Layer] palette.

Right click operation
Right click operations can be used by long pressing anywhere on the [Search Layer] palette with a finger.

Animation cels palette
The following touch gestures can be used on the [Animation cels] palette.

Scroll palette
The [Animation cels] palette can be scrolled by swiping in the [Animation cels] palette.

Right click operation
Right click operations can be used by long pressing anywhere on the [Animation cels] palette with a finger.

Timeline palette
The following touch gestures can be used on the [Timeline] palette.

Button display
If the buttons on the [Timeline] palette are not displayed on the screen, swipe on the buttons left or right to scroll through them.

Scale timeline
Pinching in the [Timeline] palette will scale down the timeline display.

Pinching out the [Timeline] palette will Scale up the timeline display.

Scroll timeline
Swiping horizontally and vertically will scroll the timeline.

When the [Timeline Edit] tool is selected, swipe up, down, left and right with two fingers to scroll through the timeline.

Move timeline cells and clips
Select a cell or clip when the [Timeline Edit] tool is selected and swipe to move it.

Swipe with one finger when selecting the [Timeline Edit] tool to perform the same operation as with a mouse.

Scroll through tracks and thumbnails
Swiping the [Timeline] palette's track or thumbnail will scroll the track or thumbnail.

Right click operation
Right click operations can be used by long pressing anywhere on the [Timeline] palette's track or thumbnail with a finger.

Right click operations can be used by long pressing anywhere on the [Timeline] palette's timeline with a finger.
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Navigator Palette
By using touch gestures on the [Navigator] palette, the canvas display can be changed.

Scrolling Across the Canvas
Swiping the [Navigator] palette vertically/horizontally with two fingers on the canvas will scroll the canvas.

Rotating the Canvas
Rotating the [Navigator] palette's image preview will rotate the canvas.

Scaling the canvas
Pinching in the [Navigator] palette's image preview will scale down the canvas display.

Pinching out the [Navigator] palette's image preview will scale up the canvas display.

Reset display
Three finger tapping the [Navigator] palette's image preview resets the rotation of the canvas and fits the canvas to the screen.

Sub view palette
The following touch gestures can be used on the [Sub View] palette.

Scrolling images
Swiping vertically/horizontally on an image in the [Sub View] palette with two fingers will scroll the image.

Rotating the Canvas
Rotating an image shown on the [Sub View] palette will rotate the canvas.

Scaling the canvas
Pinching in/out an image shown on the [Sub View] palette, zooms out/in the display.

Material Palettes
The following touch gestures can be used on the [Material] palette.

Scroll Material view
Materials can be scrolled by swiping in the [material] palette's materials.
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 Operation using the edge keyboard
The edge keyboard is a function that assists control of Clip Studio Paint. By using the edge keyboard, modifier keys
and shortcuts can be used.

Edge keyboard functions
The following will describe the edge keyboard functions.

When using iPhone

(1) ESC

It is equivalent to the Esc key. It is equivalent to a keyboard's Esc key.

(2) control

It is equivalent to the Control key. It is equivalent to a keyboard's Ctrl key.

(3) shift

It is equivalent to the Shift key. It is equivalent to a keyboard's Shift key.

(4) option

It is equivalent to the Option key. It is equivalent to a keyboard's Option key.

(5) command

It is equivalent to the Command key. It is equivalent to a keyboard's Command key.

(6) space

It is equivalent to the space bar. It is equivalent to a keyboard's space bar.

(7) Touch keys

The number of buttons displayed depends on the size and orientation of the iPhone. In this screen, keys up to 10 are displayed.

You can register these keys as shortcut keys by using the [Shortcut Settings] screen. Commands and auto actions can be executed just by 

tapping a key.
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When using Android

(1) Esc

Equivalent to the Esc key on a keyboard.

(2) Ctrl

Equivalent to the Ctrl key on a keyboard.

(3) Shift

Equivalent to the Shift key on a keyboard.

(4) Alt

Equivalent to the Alt key on a keyboard.

(5) Space

Equivalent to the Space bar on a keyboard.

(6) Touch keys

The number of buttons displayed depends on the size and orientation of the device.

You can register these keys as shortcut keys by using the [Shortcut Settings] screen. Commands and auto actions can be executed just by 

tapping a key.

For details on the items in the [Shortcut Settings] dialog box, see "Shortcut Settings [Windows]".

For details on the items in the [Shortcut Settings] dialog box, see "Shortcut Settings [Windows]".
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How to: Smartphone exclusive controls [Smartphones] > Operation using the edge keyboard > Show/hide edge keyboard
Show/hide edge keyboard
Tapping this shows or hides the edge keyboard.

If you are using a Wacom stylus pen, you cannot operate the edge keyboard with it, but you can operate the over-

lapping canvas or palette.
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How to: Galaxy exclusive 
controls [Galaxy]
This section describes features specific to the Galaxy version.

 Features unique to the Galaxy version

 Using Air Actions



How to: Galaxy exclusive controls [Galaxy] > Features unique to the Galaxy version > Using Air Actions
How to: Galaxy exclusive controls [Galaxy]

 Features unique to the Galaxy version
Specifications of the Galaxy version may differ from those of the Android and Chromebook versions. This section
describes features specific to the Galaxy version.

Using Air Actions
On devices that support the S Pen, you can assign air actions to Clip Studio Paint operations. To learn about these settings, see "Using Air 

Actions".

DeX Mode
Clip Studio Paint is compatible with the Galaxy series' DeX mode. It allows you to connect your tablet or smartphone to a monitor or a Wacom 

One and work on an even bigger screen. You can also directly connect it to a computer using a separate dedicated app. Operation may differ 

depending on your device.

Smartphones
When displayed in DeX mode, the specifications change as follows:

 The screen display will change to the same as that of the tablet.

 The items displayed in the selection launcher will change to match that of the tablet. 

 A scroll bar will appear on the canvas and be added to the View menu.

 In the Preferences dialog, [Switch to tablet interface] has been added to [Interface].

 By default, brush and pen cursors are set to the size of the brush tip shape.

 Multiple files can be open at the same time.

Tablets
When displayed in DeX mode, the specifications change as follows:

 By default, a scrollbar will appear on the canvas.

 By default, brush and pen cursors are set to the size of the brush tip shape.

Drawing with pen pressure
On devices that support the S Pen, you can use it to draw with pen pressure. Add weight to lines and take advantage of pressure based shading 

techniques.

You can also draw with pen pressure with a connected Android-compatible Wacom One or Wacom Intuos.

By adjusting pen pressure settings, you can draw with a pen or brush according to your pen pressure.

 You can edit these settings on tablets from the [CLIP STUDIO PAINT] menu > [Pen Pressure Settings].

 For smartphones, from the [App Settings] menu > [Pen Pressure Settings].
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How to: Galaxy exclusive controls [Galaxy] > Using Air Actions > Air Action Settings
 Using Air Actions
If you are using a model that supports S Pen air actions, such as the Galaxy Tab S series, you can use Air Actions to
operate Clip Studio Paint.

Assigning Clip Studio Paint actions to air actions can be done from [Air Action Settings] or [Shortcut Key Settings].

Air Action Settings
Air Action settings assign Clip Studio Paint operations to Galaxy's air actions.

 For tablets, select the [CLIP STUDIO PAINT] menu > [Air Action Settings].

 For smartphones, select the [App Settings] menu > [Air Action Settings].

Air Action Settings dialog box

(1) Air Action Operations

You can assign Clip Studio Paint operations to air actions.

(2) Assigned functions

Clip Studio Paint operations can be selected from the pull-down menu for assigning air actions. As soon as you select an item, the dialog 

box for the selected function will display.

(3) Settings

When Tapping, a dialog box corresponding to the assigned action will appear. You can set detailed operations in this dialog box.

(4) Reset

Tap to return the air action settings to their initial state.

Please refer to your device's settings or help screen or for instructions on how to use custom air action settings.
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How to: Galaxy exclusive controls [Galaxy] > Using Air Actions > Shortcut Settings
Shortcut Settings
You can set air actions from [Shortcut Settings].

 For tablets, select the [CLIP STUDIO PAINT] menu > [Shortcut Settings].

 For smartphones, select the [App Settings] menu > [Shortcut Settings].

Select the item for which you want to set a shortcut to and tap [Edit Shortcut]. Perform the air action you want to assign.

When the air action appears in the item you want to set, tap the screen. Tap [OK] to complete the setup.

For details on the items in the [Shortcut Settings] dialog box, see "Shortcut Settings [Windows]".
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Shortcut list
This chapter provides a list of default Clip Studio Paint shortcuts.

 Shortcuts in all versions of Clip Studio Paint

 Shortcuts Usable during Operation

 Tool Shortcuts

 Menu Shortcuts

 Pop-up palette shortcuts

 Optional Shortcuts

 Others



Shortcut list  > Shortcuts in all versions of Clip Studio Paint
Shortcut list

 Shortcuts in all versions of Clip Studio Paint
Clip Studio Paint common shortcuts are as follows.

For shortcuts, operations in this guide are described based on the Windows version unless otherwise noted. If 

you are using the macOS or the iPad version, please read to the following.

 Replace Alt with Option .

 Replace Ctrl with Command.

Operation as a result of the use of the shortcut Shortcut settings

Switch to previous sub tool , (comma)

Switch to next sub tool . (period)

Hand Space

Rotate Shift + Space

Zoom (scale up)

Ctrl + Space

macOS users: After pressing the space bar,

press Command.

Zoom (scale down) Alt + Space

Switch main color and sub color X

Switch drawing color and transparent color C

Select layer Ctrl + Shift
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Shortcut list > Shortcuts Usable during Operation > When the [Zoom] Tool Is Selected
 Shortcuts Usable during Operation
Shortcuts that can be used while operating a tool are as follows.

When the [Zoom] Tool Is Selected
Shortcuts that can be used when the [Zoom] tool is selected are as follows.

When the [Move] (Rotate) Tool Is Selected
Shortcuts that can be used when the [Move] (Rotate) tool is selected are as follows.

The initial configuration of the sub tools has been changed from Ver.1.6.2. For those who are used to a previous 

version of Clip Studio Paint, the tool configuration in this manual may differ from your previous version. If you 

cannot find a tool, see "Initial Configuration of Tools".

For shortcuts, operations in this guide are described based on the Windows version unless otherwise noted. If 

you are using the macOS or the iPad version, replace the Alt key with the Option key and the Ctrl key with the 

Command key.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common
Scale up Click

Scale down Alt + click

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common Rotate by 45 degrees each time Shift
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Shortcut list > Shortcuts Usable during Operation > When the Object Tool Is Selected
When the Object Tool Is Selected
Shortcuts that can be used when the [Object] tool is selected are as follows.

When the Object Tool (3D Material) Is Selected
The mouse operation when a 3D material is selected with the [Object] tool is as follows.

When Select layer Tool Is Selected
Shortcuts that can be used when the [Select layer] tool is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

During transform

Keep aspect ratio Shift

Scale up/down with reference to the 

center of rotation
Alt

During rotate Rotate by 45 degrees each time Shift

During free transform
Move the handle in the same direction as 

the frame
Shift

During move Fix translation direction Shift

Add to selection Shift

While operating a guide of the 

perspective ruler [PRO/EX]
Infinity Shift

Operating the center point of the image 

material

Fix movement direction of rotation 

center 
Shift

Before operation Eyedropper Alt

Mouse operation
Operation as a result of the mouse opera-

tion

Left click 3D material Select part

Left drag 3D material Move part

Left drag other than 3D material Move camera

Right click part Fix joint

Right click other than 3D material Release all fixed joints

Right drag Move camera back and forth

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Before operation
Add to current selection Shift

Delete from current selection Alt
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Shortcut list > Shortcuts Usable during Operation > When Light Table Tool Is Selected
When Light Table Tool Is Selected
Shortcuts that can be used when the [Light table] tool is selected are as follows.

When Edit timeline Tool Is Selected
Shortcuts that can be used when the [Edit timeline] tool is selected are as follows.

When Move layer Tool Is Selected
Shortcuts that can be used when the [Move layer] tool is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

During rotate

Rotate by specified angle each time Shift

Fix movement direction of rotation cen-

ter
Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Go to previous frame ←

Go to next frame →

Go to previous cel Shift + ←

Go to next cel Shift + →

Go to track above ↑

Go to track below ↓

Specify cel Enter

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Fix translation direction Shift

Duplicate Selection Alt + drag

Duplicate Layer Alt + drag
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Shortcut list > Shortcuts Usable during Operation > When Marquee Tool (Rectangle/Ellipse) Is Selected
When Marquee Tool (Rectangle/Ellipse) Is Selected
Shortcuts that can be used when the [Marquee] tool (Rectangle/Ellipse) is selected are as follows.

When Marquee Tool (Lasso) Is Selected
Shortcuts that can be used when the [Marquee] tool (Lasso) is selected are as follows.

When Selection Tool (Selection pen/Erase selection) Is Selected
Shortcuts that can be used when the [Selection] tool (Selection pen/Erase selection) is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common Interlock selection and image Ctrl + drag

Before operation

Add to current selection Shift

Delete from current selection Alt

Select from current selection Shift + Alt

During creation Keep aspect ratio Shift

During selection drag Fix translation direction Shift

During rotate Rotate by specified angle each time Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common Interlock selection and image Ctrl + drag

Before operation

Add to current selection Shift

Delete from current selection Alt

Select from current selection Shift + Alt

During selection drag Fix translation direction Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common Interlock selection and image Ctrl + drag

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Change brush size Ctrl + Alt + drag

Add to current selection Shift

Delete from current selection Alt

Select from current selection Shift + Alt

During selection drag Fix translation direction Shift
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Shortcut list > Shortcuts Usable during Operation > When Marquee Tool (Shrink selection) Is Selected
When Marquee Tool (Shrink selection) Is Selected
Shortcuts that can be used when the [Marquee] tool (Shrink selection) is selected are as follows.

When Marquee Tool (Polyline) Is Selected
Shortcuts that can be used when the [Marquee] tool (Polyline) is selected are as follows.

When Auto select Tool Is Selected
Shortcuts that can be used when the [Auto select] tool is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common
Interlock selection and image Ctrl + drag

Enable/disable multiple referring 0

Before operation

Add to current selection Shift

Delete from current selection Alt

Select from current selection Shift + Alt

During selection drag Fix translation direction Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Fix Double click

Cancel a last point Right click

Interlock selection and image Ctrl + drag

Cancel Esc

Before operation

Add to current selection Shift

Delete from current selection Alt

Select from current selection Shift + Alt

During creation Fix line angle Shift

During selection drag Fix translation direction Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common
Interlock selection and image Ctrl + drag

Enable/disable multiple referring 0

Before operation

Temporary switch of multiple referring Ctrl

Add to current selection Shift

Delete from current selection Alt

Select from current selection Shift + Alt

During selection drag Fix translation direction Shift
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Shortcut list > Shortcuts Usable during Operation > When [Pen], [Pencil], [Brush], [Airbrush], [Decoration] or [Eraser] Tool Is Selected
When [Pen], [Pencil], [Brush], [Airbrush], [Decoration] or [Eraser] Tool Is Selected
Shortcuts that can be used when the [Pen], [Brush], [Watercolor], [Airbrush], [Decoration] or [Eraser] tool is selected are as follows.

When Pen Tool (Dot pen) Is Selected 
Shortcuts that can be used when the [Pen] tool (Dot pen) is selected are as follows.

For details on the [Pen] tool’s [Dot pen], see "When Pen Tool (Dot pen) Is Selected".

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common
Eyedropper Alt

Object Ctrl

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Increase opacity Ctrl + ]

Reduce opacity Ctrl + [

Change brush size Ctrl + Alt + drag

Draw straight line Shift

Reduce brush density Ctrl + Shift + O

Increase brush density Ctrl + Shift + P

Reduce particle density Ctrl + Shift + K

Increase particle density Ctrl + Shift + L

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common
Eyedropper Alt

Object Ctrl

Before operation Draw straight line Shift
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Shortcut list > Shortcuts Usable during Operation > When Blend Tool (Except Copy stamp) Is Selected
When Blend Tool (Except Copy stamp) Is Selected
Shortcuts that can be used when the [Blend] tool (except copy stamp) is selected are as follows.

When Blend Tool (Copy stamp) Is Selected [PRO/EX]
Shortcuts that can be used when the [Blend] tool (copy stamp) is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common
Eyedropper Alt

Object Ctrl

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Increase opacity Ctrl + ]

Reduce opacity Ctrl + [

Change brush size Ctrl + Alt + drag

Draw straight line Shift

Reduce brush density Ctrl + Shift + O

Increase brush density Ctrl + Shift + P

Reduce particle density Ctrl + Shift + K

Increase particle density Ctrl + Shift + L

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common Object Ctrl

Before operation

Specify reference point Alt

Make (brush size) thicker ]

Make (brush size) thinner [

Increase opacity Ctrl + ]

Reduce opacity Ctrl + [

Change brush size Ctrl + Alt + drag

Draw straight line Shift

Reduce brush density Ctrl + Shift + O

Increase brush density Ctrl + Shift + P

Reduce particle density Ctrl + Shift + K

Increase particle density Ctrl + Shift + L
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Shortcut list > Shortcuts Usable during Operation > When Fill Tool (Refer only to editing layer, Refer other layers, Close and fill) Is Selected
When Fill Tool (Refer only to editing layer, Refer other layers, Close and fill) Is Selected
Shortcuts that can be used when the [Fill] tool (Refer only to editing layer, Refer other layers, Close and fill) is selected are as follows.

When Fill tool (Fill leftover areas) Is Selected
Shortcuts that can be used when the [Fill] tool (Fill leftover areas) is selected are as follows.

When the Gradient Tool (Gradient) Is Selected
Shortcuts that can be used when the [Gradient] tool (Gradient) is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Enable/disable multiple referring 0

Eyedropper Alt

Object Ctrl

Temporary switch of multiple referring Shift

Increase opacity Ctrl + ]

Reduce opacity Ctrl + [

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Enable/disable multiple referring 0

Eyedropper Alt

Object Ctrl

Temporary switch of multiple referring Shift

Make (brush size) thicker ]

Make (brush size) thinner [

Increase opacity Ctrl + ]

Reduce opacity Ctrl + [

Change brush size Ctrl + Alt + drag

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common
Eyedropper Alt

Object Ctrl

During creation
Fix line angle Shift

Keep aspect ratio Shift
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Shortcut list > Shortcuts Usable during Operation > When [Gradient] Tool (Contour line paint) Is Selected
When [Gradient] Tool (Contour line paint) Is Selected
Shortcuts that can be used when the [Gradient] tool (Contour line paint) is selected are as follows.

When Figure Tool (Straight line/Curve) Is Selected
Shortcuts that can be used when the [Figure] tool (Straight line/Curve) is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Enable/disable multiple referring 0

Eyedropper Alt

Object Ctrl

Temporary switch of multiple referring Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Fix line angle Shift

Fix Enter

Cancel Esc

Eyedropper Alt

Object Ctrl

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Increase opacity Ctrl + ]

Reduce opacity Ctrl + [

Change brush size Ctrl + Alt + drag
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Shortcut list > Shortcuts Usable during Operation > When Figure Tool (Continuous curve/Polyline) Is Selected
When Figure Tool (Continuous curve/Polyline) Is Selected
Shortcuts that can be used when the [Figure] tool (Continuous curve/Polyline) is selected are as follows.

When Figure Tool (Rectangle/Ellipse) Is Selected
Shortcuts that can be used when the [Figure] tool (Rectangle/Ellipse) is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Fix Enter

Cancel a last point Delete/Right click

Cancel Esc

Eyedropper Alt

Object Ctrl

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Increase opacity Ctrl + ]

Reduce opacity Ctrl + [

Change brush size Ctrl + Alt + drag

During creation
Rectangle Alt

Fix line angle Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Keep aspect ratio Shift

Fix Enter

Cancel Esc

Eyedropper Alt

Object Ctrl

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Increase opacity Ctrl + ]

Reduce opacity Ctrl + [

Change brush size Ctrl + Alt + drag

During rotate Rotate by specified angle each time Shift
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Shortcut list > Shortcuts Usable during Operation > When Figure Tool (Stream line/Dark saturated line) Is Selected [PRO/EX]
When Figure Tool (Stream line/Dark saturated line) Is Selected [PRO/EX] 
Shortcuts that can be used when the [Figure] tool (Stream line/Dark saturated line) is selected are as follows.

When Figure Tool (Saturated line other than dark) Is Selected [PRO/EX] 
Shortcuts that can be used when the [Figure] tool (Saturated line other than dark) is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Fix Enter

Cancel a last point Delete/Right click

Cancel Esc

Eyedropper Alt

Object Ctrl

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Increase opacity Ctrl + ]

Reduce opacity Ctrl + [

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Keep aspect ratio Shift

Fix Enter

Cancel Esc

Eyedropper Alt

Object Ctrl

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Increase opacity Ctrl + ]

Reduce opacity Ctrl + [

During rotate Rotate by specified angle each time Shift
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Shortcut list > Shortcuts Usable during Operation > When Frame Border Tool (Rectangle frame) Is Selected [PRO/EX]
When Frame Border Tool (Rectangle frame) Is Selected [PRO/EX]
Shortcuts that can be used when the [Frame Border] tool (Rectangle frame) is selected are as follows.

When Frame Border Tool (Polyline frame) Is Selected [PRO/EX]
Shortcuts that can be used when the [Frame Border] tool (Polyline frame) is selected are as follows.

When Frame Border Tool (Cut frame border) Is Selected [PRO/EX]
Shortcuts that can be used when the [Frame Border] tool (Cut frame border) is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Keep aspect ratio Shift

Fix Enter

Cancel Esc

Eyedropper Alt

Object Ctrl

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Change brush size Ctrl + Alt + drag

During rotate Rotate by specified angle each time Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Fix Enter

Cancel a last point Delete/Right click

Cancel Esc

Eyedropper Alt

Object Ctrl

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Change brush size Ctrl + Alt + drag

During creation
Rectangle Alt

Fix line angle Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Object Ctrl

Fix line angle Shift

Rectangle Alt
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Shortcut list > Shortcuts Usable during Operation > When the Ruler Tool (Linear ruler) Is Selected [PRO/EX]
When the Ruler Tool (Linear ruler) Is Selected [PRO/EX]
Shortcuts that can be used when the [Ruler] tool (Linear ruler) is selected are as follows.

When the Ruler Tool (Curve ruler) Is Selected [PRO/EX]
Shortcuts that can be used when the [Ruler] tool (Curve ruler) is selected are as follows.

When the Ruler Tool (Figure ruler) Is Selected [PRO/EX]
Shortcuts that can be used when the [Ruler] tool (Figure ruler) is selected are as follows.

When [Ruler] Tool (Ruler pen) Is Selected [PRO/EX]
Shortcuts that can be used when the [Ruler] tool (Ruler pen) is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Object Ctrl

Fix line angle Shift

Fix Enter

Cancel Esc

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Object Ctrl

Fix line angle Shift

Rectangle Alt

Fix Enter

Cancel Esc

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Object Ctrl

Keep aspect ratio Shift

Fix Enter

Cancel Esc

During rotate Rotate by specified angle each time Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common
Object Ctrl

Draw straight line Shift
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Shortcut list > Shortcuts Usable during Operation > When the Ruler Tool (Special ruler) Is Selected [PRO/EX]
When the Ruler Tool (Special ruler) Is Selected [PRO/EX]
Shortcuts that can be used when the [Ruler] tool (Special ruler) is selected are as follows.

When Ruler Tool (Guide) Is Selected [PRO/EX]
Shortcuts that can be used when the [Ruler] tool (Guide) is selected are as follows.

When the Ruler Tool (Perspective ruler) Is Selected [PRO/EX]
Shortcuts that can be used when the [Ruler] tool (Perspective ruler) is selected are as follows.

When Text Tool Is Selected
Shortcuts that can be used when the [Text] tool is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Object Ctrl

Keep aspect ratio Shift

Rectangle Alt

Fix Enter

Cancel Esc

During rotate Rotate by specified angle each time Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common Object Ctrl

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common Object Ctrl

During creation Fix orientation in steps of 45 degrees Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common
Eyedropper Alt

Object Ctrl
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Shortcut list > Shortcuts Usable during Operation > When Balloon Tool (Ellipse balloon) Is Selected [PRO/EX]
When Balloon Tool (Ellipse balloon) Is Selected [PRO/EX]
Shortcuts that can be used when the [Balloon] tool (Ellipse balloon) is selected are as follows.

When Balloon Tool (Curve balloon) Is Selected [PRO/EX]
Shortcuts that can be used when the [Balloon] tool (Curve balloon) is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Keep aspect ratio Shift

Fix Enter

Cancel Esc

Eyedropper Alt

Object Ctrl

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Change brush size Ctrl + Alt + drag

During rotate Rotate by specified angle each time Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Fix Enter

Cancel a last point Delete/Right click

Cancel Esc

Object Ctrl

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Change brush size Ctrl + Alt + drag

Eyedropper Alt

During creation
Rectangle Alt

Fix line angle Shift
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Shortcut list > Shortcuts Usable during Operation > When Balloon Tool (Balloon pen) Is Selected [PRO/EX]
When Balloon Tool (Balloon pen) Is Selected [PRO/EX]
Shortcuts that can be used when the [Balloon] tool (Balloon pen) is selected are as follows.

When Balloon Tool (Balloon tail/Thought balloon tail) Is Selected [PRO/EX] 
Shortcuts that can be used when the [Balloon] tool (Balloon tail/Thought balloon tail) is selected are as follows.

When Balloon Tool (Flash) Is Selected [PRO/EX]
Shortcuts that can be used when the [Balloon] tool (Flash) is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common
Eyedropper Alt

Object Ctrl

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Change brush size Ctrl + Alt + drag

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Fix Enter

Cancel Esc

Object Ctrl

During creation Rectangle Alt

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Keep aspect ratio Shift

Fix Enter

Cancel Esc

Eyedropper Alt

Object Ctrl

Before operation

Make (brush size) thicker ]

Make (brush size) thinner [

Increase opacity Ctrl + ]

Reduce opacity Ctrl + [

During rotate Rotate by specified angle each time Shift
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Shortcut list > Shortcuts Usable during Operation > When Correct line Tool (Control point) Is Selected [PRO/EX]
When Correct line Tool (Control point) Is Selected [PRO/EX]
Shortcuts that can be used when the [Correct line] tool (Control point) is selected are as follows.

When Correct line Tool (Simplify vector line) Is Selected [PRO/EX]
Shortcuts that can be used when the [Correct line] tool (Simplify vector line) is selected are as follows.

When Correct line Tool (Pinch line) Is Selected [PRO/EX]
Shortcuts that can be used when the [Correct line] tool (Pinch line) is selected are as follows.

When Correct line Tool (Connect vector line) Is Selected [PRO/EX]
Shortcuts that can be used when the [Correct line] tool (Connect vector line) is selected are as follows.

When Correct line Tool (Redraw vector line width) Is Selected [PRO/EX]
Shortcuts that can be used when the [Correct line] tool (Redraw vector line width) is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common

Fix translation direction Shift

Add control point Shift

Delete control point Alt

Switch corner Shift + Alt

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common Object Ctrl

Before operation Change brush size Ctrl + Alt + drag

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common
Object Ctrl

Fix translation direction Shift

Before operation Change pinch effect range Ctrl + Alt + drag

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common Object Ctrl

Before operation Change brush size Ctrl + Alt + drag

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common Object Ctrl

Before operation Change brush size Ctrl + Alt + drag
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Shortcut list > Shortcuts Usable during Operation > When Correct line Tool (Adjust line width) Is Selected [PRO/EX]
When Correct line Tool (Adjust line width) Is Selected [PRO/EX]
Shortcuts that can be used when the [Correct line] tool (Adjust line width) is selected are as follows.

When Correct line Tool (Redraw vector line) Is Selected [PRO/EX]
Shortcuts that can be used when the [Correct line] tool (Redraw vector line width) is selected are as follows.

When the Correct Line Tool (Remove dust) Is Selected [PRO/EX]
Shortcuts that can be used when the [Correct line] tool (Remove dust) is selected are as follows.

When the Correct Line Tool (Fill leftover) Is Selected [PRO/EX]
Shortcuts that can be used when the [Correct line] tool (Fill leftover) is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common Object Ctrl

Before operation Change brush size Ctrl + Alt + drag

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common Object Ctrl

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Before operation

Object Ctrl

Temporary switch of multiple referring Shift

Eyedropper Alt

During area specification Keep aspect ratio Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Before operation

Object Ctrl

Temporary switch of multiple referring Shift

Eyedropper Alt

Change brush size Ctrl + Alt + drag
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Shortcut list > Shortcuts Usable during Operation > When the Correct Line Tool (Select dust) Is Selected [PRO/EX]
When the Correct Line Tool (Select dust) Is Selected [PRO/EX]
Shortcuts that can be used when the [Correct line] tool (Select dust) is selected are as follows.

When Edit Menu > [Transform] Is Selected
Shortcuts that can be used when [Edit] menu > [Transform] is selected are as follows.

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common
Interlock selection and image Ctrl + drag

Enable/disable multiple referring 0

Before operation

Add to current selection Shift

Delete from current selection Alt

Select from current selection Shift + Alt

During selection drag Fix translation direction Shift

Tool status
Operation as a result of the use of the 

shortcut
Shortcut settings

Common
Fix Enter

Cancel Esc

During scale/rotate

Keep aspect ratio Shift

Scale up/down with reference to the cen-

ter of rotation
Alt

Free Transform Ctrl

Fix movement direction of rotation 

center
Shift

During free transform

Scale/Rotate Ctrl

Scale up/down with reference to the cen-

ter of rotation
Alt

Move the handle in the same direction as 

the frame
Shift

Mesh Transformation Fix translation direction Shift

During rotate Rotate by 45 degrees each time Shift

During move Fix translation direction Shift
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Shortcut list > Tool Shortcuts > When Edit Menu > [Transform] Is Selected
 Tool Shortcuts
Shortcuts for tool switching are as follows.
When a key is long pressed, the tool switches during the time the key is pressed.

Tool after switch Key to input

Zoom /

Move (Hand) H

Move (Rotate) R

Operation (Object) O

Operation (Select layer) D

Operations (Light table) L

Operations (Edit timeline) L

Move layer K

Selection M

Auto select W

Eyedropper I

Pen P

Pencil P

Brush B

Airbrush B

Decoration B

Eraser E

Blend J

Fill G

Gradient G

Figure U

Frame border [PRO/EX] U

Ruler [PRO/EX] U

Text T

Balloon [PRO/EX] T

Correct line/Remove dust [PRO/EX] Y
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Shortcut list > Menu Shortcuts > CLIP STUDIO PAINT Menu [macOS/Tablet]
 Menu Shortcuts
Menu shortcuts are as follows.

CLIP STUDIO PAINT Menu [macOS/Tablet]
Clip Studio Paint menu shortcuts are as follows.

 Blank spaces are items where no shortcut is set.

 For shortcuts, operations in this guide are described based on the Windows version unless otherwise noted. If 

you are using the macOS or the iPad version, replace the Alt key with the Option key and the Ctrl key with the 

Command key.

Menu item Shortcut settings

About CLIP STUDIO PAINT [macOS/Tablet]

Version information [macOS/Tablet]

Preferences [macOS/Tablet] Ctrl + K

Shortcut settings [macOS/Tablet] Ctrl + Shift + Alt + K

Modifier key settings [macOS/Tablet] [PRO/EX] Ctrl + Shift + Alt + Y

Command bar settings [macOS/Tablet] [PRO/EX]

Tab-Mate Controller [macOS]

Tab-Mate Controller Settings 

[macOS]

Quick Menu Settings [macOS]

CLIP STUDIO TABMATE 

[macOS]

CLIP STUDIO TABMATE Set-

tings [macOS]

Tool Rotation Settings [macOS]

Pen Pressure Settings [macOS/Tablet] 

Wacom stylus [iPad]

QUMARION [macOS] 

Use QUMARION [macOS] 

Import calibration information 

[macOS] 

Export Calibration information 

[macOS]

Open CLIP STUDIO [macOS/Tablet]

Quit CLIP STUDIO PAINT [macOS] Ctrl + Q
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Shortcut list > Menu Shortcuts > App Settings menu [Smartphone]
App Settings menu [Smartphone]
App Settings menu shortcuts are as follows.

File Menu
File menu shortcuts are as follows.

Menu item Shortcut settings

Preferences Ctrl + K

Command Bar Settings

Palette Bar Settings

Edit Bar Settings

Layout Settings

Shortcut Settings Ctrl + Shift + Alt + K

Modifier Key Settings Ctrl + Shift + Alt + Y

CLIP STUDIO TABMATE [Android]

Pen Pressure Settings

Wacom stylus

Open CLIP STUDIO

Menu item Shortcut settings

New Ctrl + N

Create New from Clipboard [Windows/macOS/iPad/iPhone]

Create new from app clipboard [Android/Chromebook]

Create new from photo library [iPad/iPhone]

Create new from device storage [Android/Chromebook]

Open Ctrl + O

Edit with CLIP STUDIO ACTION

Close Ctrl + W

Save Ctrl + S

Save as

Shift + Alt + S, 

Ctrl + Shift + S, 

Ctrl + Alt + S
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Shortcut list > Menu Shortcuts > File Menu
Save Duplicate 

.clip (CLIP STUDIO FORMAT)

.bmp (BMP)

.jpg (JPEG)

.png (PNG)

.tif (TIFF)

.tga (Targa)

.psb (Photoshop big document)

.psd (Photoshop document)

Revert

Export (Single Layer)

.bmp (BMP)

.jpg (JPEG)

.png (PNG)

.tif (TIFF)

.tga (Targa)

.psb (Photoshop big document)

.psd (Photoshop document)

Flatten and save to device storage [Android/Chromebook]

Export multiple pages [EX] 

.pdf(PDF format)

Batch export

3D preview for binding

Export fanzine printing data

Open exporting destination of 

fanzine printing data [Windows/

macOS]

Export in Kindle format [Win-

dows]

Preview of exported Kindle data 

[Windows]

Open export destination of 

Kindle format [Windows]

Export settings for Kindle for-

mat [Windows]

Export EPUB data

Open export destination of 

EPUB data [Windows/macOS]

Export settings for EPUB data

Menu item Shortcut settings
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Shortcut list > Menu Shortcuts > File Menu
Export animation

Image sequence

Animated GIF

Animated sticker (APNG)

Movie

Export animation cels [EX]

Exposure sheet [EX]

OpenToonz Scene File 

[Windows/macOS] [EX] 

Audio

Export webtoon

Export vectors [PRO/EX]

Timelapse
Record timelapse

Export timelapse

Menu item Shortcut settings
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Shortcut list > Menu Shortcuts > File Menu
Import

Image

Pattern from Image

Create file object 

Movie

3D data

Vector [PRO/EX]

Audio

Batch import [EX]

Pose Scanner (image) 

(Technology preview)

Pose Scanner (camera) [Tablet]

Pose Scanner (photo library) 

[iPad/iPhone]

Pose Scanner (storage) 

[Android/Chromebook]

Camera settings [Tablet]

From photo library [iPad/

iPhone]

From device [Android/iPhine]

Scan [Windows/macOS]

Continuous Scan [Windows/

macOS] [EX]

Select Scan Device [Windows/

macOS]

Exposure sheet [EX]

Batch process [EX]

Print Settings

Print Ctrl + P

Preferences [Windows] Ctrl + K

Shortcut settings [Windows] Ctrl + Shift + Alt + K

Modifier Key Settings [Windows] [PRO/EX] Ctrl + Shift + Alt + Y

Command Bar Settings [Windows] [PRO/EX]

Tab-Mate Controller [Windows]

Tab-Mate Controller Settings 

[Windows]

Quick Menu Settings [Windows]

Menu item Shortcut settings
CLIP STUDIO PAINT Instruction Manual 1478



Shortcut list > Menu Shortcuts > Edit Menu
Edit Menu
Edit menu shortcuts are as follows.

CLIP STUDIO TABMATE 

[Windows]

CLIP STUDIO TABMATE Set-

tings [Windows]

Tool Rotation Settings [Win-

dows]

Pen Pressure Settings [Windows]

Quit CLIP STUDIO PAINT [Windows] Ctrl + Q

File operation/Share [Android/Chromebook]

Quick Share [Tablet/Smartphone]

Menu item Shortcut settings

Undo Ctrl + Z

Redo Ctrl + Y, Ctrl + Shift + Z

Cut Ctrl + X, F2

Copy Ctrl + C, F3

Copy vectors as SVG [PRO/EX]

Paste Ctrl + V, F4

Paste to shown position Ctrl + Shift + V

Delete

Del, Back Space, 

Ctrl + Del, 

Ctrl + Back Space

Delete Outside Selection
Shift + Del, 

Shift + Back Space

Smart Smoothing

Remove tone (Technology pre-

view) [EX]

Delete tones from selected layer

Change tones to grayscale

Fill
Alt + Del,

Alt + Back Space

Advanced Fill [PRO/EX]

Colorize (Technology preview)

Colorize all

Use hint image and colorize

Use more advanced settings

Change color of line to drawing 

Outline Selection [PRO/EX]

Menu item Shortcut settings
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Shortcut list > Menu Shortcuts > Edit Menu
Convert brightness to opacity

Register Material [PRO/EX]

Image

Template

Animation

Tonal correction

Brightness/Contrast

Hue/Saturation/Luminosity Ctrl + U

Posterization [PRO/EX]

Reverse gradient [PRO/EX] Ctrl + I

Level Correction

Tone curve [PRO/EX]

Color balance [PRO/EX]

Binarization [PRO/EX]

Gradient map [PRO/EX]

Transform

Scale/Rotate Ctrl + T

Scale

Center of

Free Transform Ctrl + Shift + T

Distort

Skew

Perspective

Flip Horizontal

Flip Vertical

Mesh Transformation [PRO/EX]

Fix

Cancel

Change Image Resolution

Change Canvas Size

Crop

Rotate/Invert canvas

Rotate by 90 degrees clockwise

Rotate 180

Rotate by 90 Degrees Counter-

clockwise

Flip Horizontal

Flip Vertical

Menu item Shortcut settings
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Shortcut list > Menu Shortcuts > Story Menu [EX]
Story Menu [EX]
Story menu shortcuts are as follows.

Canvas Properties [PRO/EX]

Clear Memory [PRO/EX] History

Obtain screen color [Windows/macOS]

Obtain screen color by hiding windows [Windows/macOS]

Menu item Shortcut settings

Open page 

Open page with new tab 

First Page

Previous page

Next Page

Last Page

Specific Page

Add Page

Add page (Detail)

Import Page

Replace page

Duplicate Page

Delete Page

Combine Pages

Change to Split Pages

Change basic page settings

Change basic work settings

Sort page file names

Page manager

Page manager layout [Windows/

macOS/Tablet]

Tab

Left

Right

Top

Bottom

Auto-scroll

Menu item Shortcut settings
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Shortcut list > Menu Shortcuts > Story Menu [EX]
View
Page-by-page

Webtoon

Webtoon reading direction
Right-to-left

Left-to-right

Binding process

Show binding list

Settings of printing file name

Allow cover pages to be moved

Edit text

Open story editor

New text

Delete text

Apply tool properties to text

Find and Replace

Group work [Windows/macOS]

Update work folder

Reflect change on group work 

data

Show log

Set member for work

Cancel settings of member for 

work

Show member's comment

Cancel change of work folder

Open conflicting file

Resolve confliction

Prepare group work data

Obtain group work data

View settings

Menu item Shortcut settings
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Shortcut list > Menu Shortcuts > Animation menu
Animation menu
Animation menu shortcuts are as follows.

Menu item Shortcut settings

New animation layer

Animation folder

2D camera folder

Audio

New animation cel

Edit track

Deleted

Cut

Copy

Paste

Enable keyframes on this layer

Add keyframe

Switch keyframe to hold interpo-

lation

Switch keyframe to linear inter-

polation

Switch keyframe to smooth 

interpolation

Edit layers with active key-

frames

Delete all keyframes

Specify cels

Batch specify cels

Create all supported cels

Rename in timeline order

Rename in layer order

Select previous cel

Select next cel

Combine clips

Divide clip

Set as first displayed frame

Set as last displayed frame
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Shortcut list > Menu Shortcuts > Animation menu
Animation curve

Graph Editor

Snap to X axis

Snap to Y axis

Unpair handles

Play/Stop

Playback settings

Play in real time

Play all frames

Loop play

Render 2D camera

Render before starting playback

Prefer speed

Prefer quality

Move frame

Go to start

Go to end

Go to previous frame

Go to next frame

Previous keyframe

Next keyframe

Go to specified frame

Go to timeline label

Label

Create timeline label

Delete timeline label

Create track label

Delete track label

Create inbetween track label

Create reverse sheet track label

Menu item Shortcut settings
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Shortcut list > Menu Shortcuts > Animation menu
Timeline

Enable timeline

New timeline

Go to previous timeline

Go to next timeline

Change settings

Change frame rate

Manage timeline

Insert frame

Delete frame

Apply Toei Animation Digital 

Exposure Sheet information to 

current exposure sheet [EX] 

[Windows/iPad]

Load changes to Toei Animation 

Digital Exposure Sheet [EX] 

[Windows/iPad]

Toei Animation Digital 

Exposure Sheet settings [EX] 

[Windows]

Installation path for Toei 

Animation Digital Exposure 

Sheet [EX] [iPad]

Show animation cels

Show edited cel only

Enable onion skin

Onion skin settings

Check cel motion by key input

Check surrounding cels by key 

input

Menu item Shortcut settings
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Shortcut list > Menu Shortcuts > Layer Menu
Layer Menu
Layer menu shortcuts are as follows.

Light table

Enable light table

Fix current animation cel as edit-

ing target

Register selected layer

Select and register file

Register layer copied from 

another canvas

Register onion skin images

Deregister selected image from 

light table

Deregister all images from light 

table

Move canvas to center

Show 2D camera frames

Show camera path

Show all field guides

Menu item Shortcut settings

New Raster Layer Ctrl + Shift + N

New Layer

Raster Layer

Vector Layer [PRO/EX]

Gradient layer[PRO/EX]

Fill in Monochrome Layer 

[PRO/EX]

Tone [PRO/EX]

Frame Border Folder [PRO/EX]

3D Layer [PRO/EX]

Paper

CLIP STUDIO SHARE > Foil 

layer [EX]

Menu item Shortcut settings
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Shortcut list > Menu Shortcuts > Layer Menu
New Correction Layer [PRO/

EX]

Brightness/Contrast

Hue/Saturation/Luminosity

Posterization

Reverse Gradient

Level Correction

Tone Curve

Color balance

Binarization

Gradient map

New Layer Folder

Duplicate Layer

Delete Layer

Create folder and insert layer Ctrl + G

Ungroup Layer Folder Ctrl + Shift + G

Layer mask

Mask Outside Selection

Mask selection

Delete Mask

Apply Mask to Layer

Enable Mask

Show Mask Area 

Link Mask to Layer

Ruler/Frame [PRO/EX]

Selection from Ruler

Delete Ruler

Show Ruler

Link Ruler to Layer

Create Perspective Ruler

Divide frame border equally

Combine frames

Show in All Layers

Show in Same Folder

Show Only When Editing Target

Link guide to ruler 

Menu item Shortcut settings
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Shortcut list > Menu Shortcuts > Layer Menu
File object

Convert layer to file object

Paste as file object

Change file of file object

Open file of file object

Open folder of file object

Update file object

Update all file objects

Layer settings

Set as reference layer

Set as Draft Layer [PRO/EX]

Clip to Layer Below Ctrl + Alt + G

Lock layer

Lock transparent pixels

Show layer

Change Layer Name

Display palette colors in parent 

folder

Display palette colors on canvas

Advanced Settings

Selection from Layer

Create Selection

Add Selection

Delete Selection

Select Overlapping Area

Rasterize

Convert layer [PRO/EX]

LT conversion of layer 

Transfer To Lower Layer

Merge with layer below Ctrl + E

Merge selected layers Shift + Alt + E

Merge visible layers Ctrl + Shift + E

Merge visible to new layer 

Flatten image

Menu item Shortcut settings
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Shortcut list > Menu Shortcuts > Selection Menu
Selection Menu
Selection menu shortcuts are as follows.

Layer Order [PRO/EX]

Top

Up

Down

Bottom

Change Selected Layer [PRO/

EX]

Layer Above Alt + ]

Layer Below Alt + [

Menu item Shortcut settings

Select All Ctrl + A

Deselect Ctrl + D

Reselect Ctrl + Shift + D

Invert selected area
Ctrl + Shift + I, 

Shift + F7

Expand Selected Area

Shrink Selected Area

Blur borders [PRO/EX]

Select Color Gamut [PRO/EX]

Select Overlapping Vectors [PRO/EX]

Select Vectors Within Area [PRO/EX]

Quick Mask [PRO/EX]

Convert to Selection Layer [PRO/EX]

Convert Selection Layer to Selection [PRO/EX]

Menu item Shortcut settings
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Shortcut list > Menu Shortcuts > View Menu
View Menu
View menu shortcuts are as follows.

Menu item Shortcut settings

Rotate/Invert

Reset rotation/inversion 

Reset Rotation

Rotate 90 

Rotate 180 

Rotate 270 

Flip Horizontal 

Flip Vertical 

Rotate Left -

Rotate right ^

Zoom in
Ctrl + ; 

Ctrl + ;

Zoom out
Ctrl + Num - , 

Ctrl + -

100% Ctrl + Alt + 0

200%

Fit to Screen Ctrl + 0

Reset display Ctrl + @

Fit to navigator

Print size

Scroll Bar

Selection Border

Selection Launcher

Selection Launcher Settings [PRO/EX]

Transform launcher

Text launcher

Object Launcher

Grid [PRO/EX]

Ruler [PRO/EX] Ctrl + R

Grid/Ruler Settings [PRO/EX]

Crop mark/Default border [PRO/EX]

Crop mark/Default border settings [PRO/EX]

Story Information [EX]
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Shortcut list > Menu Shortcuts > View Menu
Safety margin [PRO/EX]

On-screen area (Webtoon)

On-screen area settings (webtoon)

Paper

Show Tone Area [PRO/EX] Show Selected Tone Area

Show All Tone Areas

Include Image Material Area

Show playback fps

Snap to Ruler [PRO/EX] Ctrl + 1

Snap to Special Ruler [PRO/EX] Ctrl + 2

Snap to Grid [PRO/EX] Ctrl + 3

Change Special Ruler Snap [PRO/EX] Ctrl + 4

Color profile [PRO/EX]
Preview Settings

Preview

Menu item Shortcut settings
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Shortcut list  > Menu Shortcuts
Filter Menu
Filter menu shortcuts are as follows.

Menu item Shortcut settings

Blur

Blur

Blur (Strong)

Gaussian blur

Smoothing

Radiation blur

Movable blur

Sharpen

Unsharp mask

Sharpen 

Sharpen (Strong) 

Effect

Remove jpeg noise

Artistic

Mosaic

Transform 

Pinch

Ripple

Curved surface

Polar coordinates

ZigZag

Wave

Twirl

Fish-eye lens

Drawing Perlin noise

Correct line
Remove dust

Adjust line width
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Shortcut list  > Menu Shortcuts
Window Menu
Window menu shortcuts are as follows.

Menu item Shortcut settings

Canvas

New Window

Cascade [Windows/macOS]

Tiled

Next canvas
Ctrl + Tab

Control + Tab in macOS

Previous Canvas
Ctrl + Shift + Tab

Control + Tab in macOS

Workspace

Reset to default

Register Workspace [PRO/EX]

Register workspace as material 

[PRO/EX]

Search for workspace material(s) 

[PRO/EX]

Manage Workspace [PRO/EX]

Workspace import settings 

[PRO/EX]

Reload Workspace [PRO/EX]

Command Bar

Quick access [PRO/EX]

Tool

Sub Tool

Tool Property

Brush Size

Sub Tool Detail [PRO/EX]

Color Wheel

Color Slider

Color Set

Intermediate Color [PRO/EX]

Approximate Color [PRO/EX]

Color History [PRO/EX]

Layer

Search Layer [PRO/EX]

Layer Property [PRO/EX]
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Shortcut list > Menu Shortcuts > Window Menu
Animation cels

Timeline

All sides view [EX]

Navigator

Sub View [PRO/EX]

History [PRO/EX]

Auto Action [PRO/EX]

Information

Item bank

Material

Material (1)

Material (2)

Material (3)

Material (4)

Material (5)

Material (6)

Material (7)

Material (8)

Material (9)

Material (10)

Show/Hide All Palettes Tab

Hide Title Bar/Hide Menu Bar Shift + Tab

Always Show Tab in Canvas

Palette dock

Fix the width of palette dock

Display (palette name) as pop-up

Display (palette name) as tab

Menu item Shortcut settings
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Shortcut list > Menu Shortcuts > Help Menu
Help Menu
Help menu shortcuts are as follows.

Menu item Shortcut settings

Show Menu

Training and Tutorials F1

Getting Started

Instruction Manual

Support

About CLIP STUDIO PAINT [Windows]

Version information [Windows]
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Shortcut list > Pop-up palette shortcuts > Help Menu
 Pop-up palette shortcuts
The following shows the shortcuts that can be configured when [Pop-up palette] is selected in [Setting area] in the
[Shortcut settings] dialog box.

 Blank spaces are items where no shortcut is set.

 For shortcuts, operations in this guide are described based on the Windows version unless otherwise noted. If 

you are using the macOS or the iPad version, replace the Alt key with the Option key and the Ctrl key with the 

Command key.

Menu item Shortcut settings

Display/hide pop-up

Quick access

Tool

Sub Tool

Tool Property

Brush Size

Sub Tool Detail

Color Wheel

Color Slider

Color Set

Intermediate Color

Approximate Color

Color History

Layer

Search Layer

Layer Property

Animation cels

Timeline

All sides view

Navigator

Sub View [PRO/EX]

History

Auto action

Information

Item bank

Material (1)

Material (2)
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Shortcut list > Pop-up palette shortcuts > Help Menu
Material (3)

Material (4)

Material (5)

Material (6)

Material (7)

Material (8)

Material (9)

Material (10)

Menu item Shortcut settings
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Shortcut list > Optional Shortcuts > Canvas
 Optional Shortcuts
The following shows the shortcuts that can be configured when [Options] is selected in [Setting area] in the [Shortcut
settings] dialog box.

Canvas
The shortcuts that operate on the [Canvas] window are as follows.

 Blank spaces are items where no shortcut is set.

 For shortcuts, operations in this guide are described based on the Windows version unless otherwise noted. If 

you are using the macOS or the iPad version, replace the Alt key with the Option key and the Ctrl key with the 

Command key.

Operation items Shortcut settings

View

Scroll to left

Scroll to right

Scroll to above

Scroll to down

Ruler [PRO/EX]

Move ruler to left

Move ruler to right

Move ruler to up

Move ruler to down

Rotate ruler clockwise

Rotate ruler counter-clockwise

Scale up ruler

Scale down ruler

Move rotation center of ruler to center of window

Perspective ruler [PRO/EX]

ON/OFF of snap of the first vanishing point

ON/OFF of snap of the second vanishing point

ON/OFF of snap of the third vanishing point

ON/OFF of snap of all vanishing point

Snap only the first vanishing point

Snap only the second vanishing point

Snap only the third first vanishing point

Fix eye level

Horizontalize eye level
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Shortcut list > Optional Shortcuts > Tool property Palette
Tool property Palette
The shortcuts operated on the [Tool Property] palette are as follows.

Operation items Shortcut settings

Brush Size

Reduce brush size

Increase brush size

On/Off of allocating pen pressure to brush size

Ink

Reduce opacity Ctrl + [

Increase opacity Ctrl + ]

Set opacity 10%

Set opacity 20%

Set opacity 30%

Set opacity 40%

Set opacity 50%

Set opacity 60%

Set opacity 70%

Set opacity 80%

Set opacity 90%

Set opacity 100%

Toggle color mixing

Decrease Amount of Paint

Increase Amount of Paint

Decrease Density of Paint

Increase Density of Paint

Decrease Color Stretch

Increase Color Stretch

Anti-aliasing

Set anti-aliasing none

Set anti-aliasing weak

Set anti-aliasing middle

Set anti-aliasing strong

On/Off of anti-aliasing
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Shortcut list > Optional Shortcuts > Tool property Palette
Brush tip

Reduce hardness

Increase hardness

Reduce brush density Ctrl + Shift + O

Increase brush density Ctrl + Shift + P

Set Brush Density to 10%

Set Brush Density to 20%

Set Brush Density to 30%

Set Brush Density to 40%

Set Brush Density to 50%

Set Brush Density to 60%

Set Brush Density to 70%

Set Brush Density to 80%

Set Brush Density to 90%

Set Brush Density to 100%

On/Off of allocating pen pressure to brush density

Decrease Thickness

Increase Thickness

Rotate Counterclockwise

Rotate Clockwise

Spraying effect

Reduce particle size

Increase particle size

Reduce particle density Ctrl + Shift + K

Increase particle density Ctrl + Shift + L

Watercolor edge Toggle watercolor edge

Delete [PRO/EX]

On/Off of erase vector

Set erase vector at touched part

Set erase vector up to intersection

Set erase vector for whole line

Operation items Shortcut settings
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Shortcut list > Optional Shortcuts > Tool property Palette
Correction

Reduce stabilizer

Increase stabilizer

On/Off of post correction

Reduce post correction

Increase post correction

ON/OFF of Vector Magnet

Decrease Vector Magnet

Increase Vector Magnet

Starting and ending

On/Off of allocating starting and ending to brush size

On/Off of allocating starting and ending to brush density

On/Off of starting

On/Off of ending

Anti-overflow Toggle whether crossing lines of reference layer

Selection

Set mode to "New selection"

Set mode to "Add to selection"

Set mode to "Remove from selection"

Set mode to "Select from selection"

Fill

Toggle connected pixels only

On/Off of closing gap

On/Off of scaling area

Figure

On/Off of specifying aspect

On/Off of starting from center

On/Off of rotating after fixed

Reference On/Off of multiple referring 0

Pinch line [PRO/EX]

Reduce pinch level

Increase pinch level

Reduce effect area

Increase effect area

Operation items Shortcut settings
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Shortcut list > Optional Shortcuts > Brush Size Palette
Brush Size Palette
The shortcuts operated on the [Brush size] palette are as follows.

Sub tool palette
The shortcuts operated on the [Sub Tool] palette are as follows.

Layer Property Palette [PRO/EX]
The shortcuts operated on the [Layer Property] palette are as follows.

Quick Access Palette [PRO/EX]
The shortcuts operated on the [Quick Access] palette are as follows.

Operation items Shortcut settings

Select smaller preset than current [

Select larger preset than current ]

Operation items Shortcut settings

Switch to previous sub tool ,

Switch to next sub tool .

Switch to previous sub tool group

Switch to next sub tool group

Lock [PRO/EX]

Reset to default

Save as default

Operation items Shortcut settings

Switch use of border effect

Switch use of line extraction effect [EX]

Switch using binarization with tone

Switch using display of reduce color

Switch using texture map combining

Switch using layer color Ctrl + B

Save as default

Operation items Shortcut settings

Quick access settings
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Shortcut list > Optional Shortcuts > Animation cels palette
Animation cels palette
The shortcuts operated on the [Animation cels] palette are as follows.

Drawing color
The shortcuts operated on the drawing color are as follows.

Touch gesture [Tablet]
The shortcut for setting the touch gestures is as follows.

Edit
The shortcuts operated during editing are as follows.

Operation items Shortcut settings

Enable/disable light table tool

Operation items Shortcut settings

Switch main color and sub color X

Switch drawing color and transparent color C

Switch between main color, sub color, and transparent color

Switch to main color

Switch to sub color

Switch to transparent color

Switch between main color and transparent color

Switch between sub color and transparent color

Switch between main color and sub color

Switch main color to black and sub color to white

Operation items Shortcut settings

Use different tools with fingers and pen

Set tool to use with finger

Touch gesture settings

Operation items Shortcut settings

Cut and paste

Copy and paste
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Shortcut list > Others > Layer
 Others
Other key and mouse operations are as follows.

Layer 
By combining the [Layer] palette with key and/or mouse operations, you can perform layer-related operations.

For shortcuts, operations in this guide are described based on the Windows version unless otherwise noted. If 

you are using the macOS or the iPad version, replace the Alt key with the Option key and the Ctrl key with the 

Command key.

Operation as a result of the use of the shortcut Shortcut settings

Duplicate Layer Alt + drag layer

Selection from Layer

Create Selection

Ctrl + left click layer thumbnail,

Ctrl + left click layer mask thumbnail,

Ctrl + left click ruler icon

Add Selection

Ctrl + Shift + left click layer thumbnail,

Ctrl + Shift + left click layer mask thumbnail,

Ctrl + Shift + left click ruler icon

Delete Selection

Ctrl + Alt + left click layer thumbnail,

Ctrl + Alt + left click layer mask thumbnail,

Ctrl + Alt + left click ruler icon

Select Overlapping Area

Ctrl + Shift + Alt + left click layer thumbnail,

Ctrl + Shift + Alt + left click layer mask thumbnail

Left click,

Ctrl + Shift + Alt + left click ruler icon

Show selected layer only Alt + click [Show/hide layer]

Display [New raster layer] dialog box Alt + click [New raster layer]

Display [New vector layer] dialog box [PRO/EX] Alt + click [New vector layer]

Operation of [Layer] palette varies depending on the content to select.

 To target the layer: Click the layer thumbnail.

 To target the layer mask: Click the layer mask thumbnail.

 To target a ruler: Click the ruler icon.
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Shortcut list > Others > Layer mask
Layer mask 
By combining the [Layer] palette with key and/or mouse operations, you can perform layer mask-related operations.

Ruler [PRO/EX]
By combining the [Layer] palette with key and/or mouse operations, you can perform ruler-related operations.

Operation as a result of the use of the shortcut Shortcut settings

Enable/disable mask Shift + left click mask thumbnail

Show/hide mask area Alt + left click mask thumbnail

Mask selection Alt + left click Create mask

Duplicate mask Alt + drag mask thumbnail

Operation as a result of the use of the shortcut Shortcut settings

Enable/disable ruler Ctrl + Shift + left click ruler icon

Duplicate ruler Alt + drag ruler icon
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